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Scientific Approach: Description of Study Sample and Progress Made 

Objective 1: To characterize, for the first time, cortical bone microstructural changes in a rabbit opioid 
model. 

Activity 1 – Ethics application, animal handling training, animal ordering, acclimation 
Dates: 1 January – 30 April 2019 

Progress: 100% Complete 

A detailed animal protocol (Protocol #: 18-11-12 ARC) was written by Dr. Andronowski and approved by 
The University of Akron Institutional Animal Care and Use Committee (IACUC) on 12/10/2018 
(Appendix I). Due to the substantial time and effort required for devising animal protocols, and in 
conjunction with the IACUC’s monthly meeting schedule, Dr. Andronowski began the protocol writing 
process in October 2018 to ensure the necessary approvals were in place for the beginning of the funding 
period (01/01/2019). In-person training with The University of Akron Research Vivarium (UARV) 
attending veterinarian, Dr. Stanley Dannemiller, in proper ethical care, handling, and use of laboratory 
animals was completed by the PI, Post-doctoral Fellow (Dr. Mary Cole), Graduate Research Assistant 
(Reed Davis), Undergraduate Research Assistant (Adam Schuller), and Tiered Mentoring Students/unpaid 
undergraduate laboratory volunteers (Gina Tubo and Abigail LaMarca) on 03/11/2019 (Appendix II). In-
person Hazardous Substances training was provided by UA Health and Safety representative, Alex Stakleff, 
to Andronowski, Schuller, Davis, Tubo, and LaMarca on 02/01/2019. UARV facility training was also 
provided by vivarium manager, Beth Kenaga, to the above research team members on 02/01/2019, and to 
Cole and LaMarca on 03/11/2019. 

Skeletally mature, 6-month-old (2.3-3.0 kg), male New Zealand White rabbits were ordered from Covance 
Research Products Inc. on 3/19/2019 (Appendix III) and delivered to UARV on 04/16/2019, as per our 
projected timeline (Appendix IV). Male animals were selected to avoid the potential influence of female 
hormone cycles on bone physiology. The rabbits were individually housed in rabbit batteries to allow for 
some interaction, while keeping the animals lodged separately (Appendix V). The rabbits were quarantined 
and habituated to the testing conditions for a two-week period following their arrival at the UARV 
(04/16/2019 – 04/31/2019). The rabbits were randomly divided (using a random number generator) into 
three groups of 7 animals each: morphine, fentanyl, and controls. The control group was further randomly 
divided into saline vehicle (n=3) and transdermal patch groups (n=4). These group sizes match the mean 
numbers employed in previous characterizations of this model for cancellous bone or cortical 
geometry/density1–5. After the acclimation period, the experimental treatments for the opioid groups 
(morphine and fentanyl) began and continued for eight weeks.  

Activity 2 – Animal Dosing 
Dates: 1 May – 26 June 2019 

Progress: 100% Complete 

The proposed opioid dosing levels are consistent with clinical recommendations for analgesia in rabbits 
and were finalized with the UARV veterinarian. The morphine sulfate group received a dose of 3 mg/kg/day 
via subcutaneous injection. The control group was administered saline at a dose of 3 mg/kg/day. A proposed 

2018-DU-BX-0188 Final Technical Report 
October 2021 

This resource was prepared by the author(s) using Federal funds provided by the U.S. 
Department of Justice. Opinions or points of view expressed are those of the author(s) and do not 

necessarily reflect the official position or policies of the U.S. Department of Justice.

3 



 
  

 

      
     

        
    

   
    

          
     

   
  

  
       

          
  

         
    

      
         

     
 

  
        

        
       

   
           

  
         

             
 

  
     

       
             

         
  

     
       

       
         

   
  

 
  

change affecting the delivery of fentanyl from subcutaneous injection to transdermal patch administration 
was proposed by Dr. Andronowski and approved by the IACUC on 04/07/2019 (Appendix VI). According 
to literature published by Foley et al.6 and Jain et al.7 there is demonstrable evidence that transdermal patch 
delivery of fentanyl resulted in a detectable change in bone metrics. We proposed this modification to 
eliminate the lack of consensus in recommended injectable fentanyl dosing from various professional 
consultants, and to reduce risk of accidental exposure during administration of the narcotics. Further, this 
change will address the concerns of the IACUC regarding injections being handled by trainees 
(Undergraduate and Graduate Students) while the Principal Investigator is attending conferences, or if she 
should be sick, or otherwise unable to attend dosing periodically throughout the duration of the study. 

The transdermal patch administration reduced the need to dose the animals each day and instead acted as a 
slow-release delivery agent. A 25-ug/h slow-release transdermal fentanyl patch (Henry Schein Inc.) was 
placed on the dorsum of the rabbits in the interscapular region in the fentanyl experimental group every 
third day, according to manufacturer’s instructions. This size patch and specific dosage was selected based 
on data obtained by Foley et al.6 and Jain et al.7 The patches were adhered via adhesives associated with 
the patch manufacturing. Patches were further secured by applying a medical-grade Tegaderm transparent 
film dressing (used in clinical settings to adhere IVs and heal burns, etc.). A placebo patch (Tegaderm film 
dressing) was placed on each control patch animal in a manner comparable to the experimental animals. 
For a detailed justification of this change from the agency approved experimental plan, please refer to the 
approved VVC Modification (Appendix VI). 

A second proposed change affecting the fentanyl experimental group was initiated that differed from the 
agency approved plan. A VVC Modification was put forward to cover the drug eluting transdermal patches 
(fentanyl) and control patches (Tegaderm) in order to prevent the animals from chewing, removing, and/or 
ingesting these from the interscapular region. The removal of patches by the animals was a common issue 
faced during the experimental component of the study and we were concerned for the well-being of these 
animals. Following consultation with the UARV veterinarian, Dr. Stan Dannemiller, a prescription was 
provided for the use of rabbit jackets (and other wraps) via email on 05/03/2019. The proposed modification 
of rabbit jackets on all treatment and control transdermal patch animals was approved on 05/04/2019 
(Appendix VII). 

All animals further underwent subcutaneous injection with a bone-labelling fluorochrome, calcein, to 
facilitate ex vivo dynamic histomorphometry following euthanasia. Calcein was administered at a level 
10/mg/kg8 after two weeks (days 13 and 14), four weeks (days 27 and 28), six weeks (days 41 and 42), and 
eight weeks9,10 of the opioid regimens. It is important to note that the injection of calcein at this dose level 
is not associated with any undesirable side effects11. The fourth calcein dosing was administered two days 
and one day prior to intraperitoneal injections containing a euthanasia solution, pentobarbital sodium (Fatal-
Plus). The euthanasia solution was delivered in the UARV necropsy suite at a level of 125 mg/kg per animal. 
In-person training with the UARV attending veterinarian, Dr. Stanley Dannemiller, in intraperitoneal 
injections and bilateral pneumothorax for euthanasia was completed by the PI, Post-doctoral Fellow (Dr. 
Mary Cole), Graduate Research Assistant (Reed Davis), Undergraduate Research Assistant (Adam 
Schuller), and Tiered Mentoring Student (Abigail LaMarca) prior to euthanasia on 06/27/2019 (Appendix 
VIII). 
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Overall, Activities 1 and 2 proceeded 100% on track in accordance with our proposed project timeline 
(Appendix IV). 

Objective 2: To optimize 3D micro-CT imaging of remodeling events in an opioid rabbit model. 

Activity 3: Micro-CT imaging and histomorphometry 
Projected Completion Dates: 08/19 – 01/20 

Micro-CT imaging Progress: 100% as per proposed timeline 
Histomorphometry Progress: 100% completed; began January 2020, delayed by COVID-19 pandemic 

Progress: 100% as per proposed revised timeline 

Micro-CT Imaging (ex vivo): The left femur of each rabbit was visualized with non-destructive 3D micro-
CT imaging followed by traditional thin-section histology. Immediately following euthanasia, the left femur 
and tibia were dissected from each animal, wrapped in sterile saline-soaked gauze, and stored in a sample 
tube in a -80° C freezer. The remainder of the animal was sealed in plastic under vacuum and frozen for 
future bone and tissue research. To prepare for micro-CT imaging, all members of the research team have 
completed radiation generating equipment training (RGE Training), as well as two to three sessions of 
individualized, hands-on training for independent operation of the micro-CT instrument. Micro-CT imaging 
was performed using a SkyScan 1172 micro-CT (Bruker Micro-CT) desktop system located in the Surface 
and Optical Analysis Facility within the Polymer Innovation Center at The University of Akron. Since this 
system is shared by users from various departments at The University of Akron, a conservative estimate of 
6-9 months for imaging was estimated (Appendix IV). 

Dr. Andronowski developed and tested a micro-CT scanning protocol using bone tissue samples from her 
concurrent projects. Each femur and tibia were mounted to a brass sample holder via dental wax and secured 
with Parafilm to ensure the sample does not move during scanning. Anterior and Medial sides were marked 
with clay inclusions in a parafilm wrapping that would be visible on the scanned image to orient the sample 
during image analysis. The midshaft diaphysis was imaged at 5.49 µm voxel size (in three stacked sections) 
to allow for detection of the vascular canal network and the presence of BMU cutting cones, signifying 
remodeling activity. The previously optimized micro-CT imaging protocol was applied and includes the 
use of a Hamamatsu 100/250 optical camera to take 1992 projection images spanning 180 degrees of 
rotation at 74 kilovolts (kV) and 134 source current (uA). The population density of vascular pore systems 
was volumetrically assessed within the VOI (pores/mm3). Additional micro-CT parameters included % 
porosity, canal number, canal connectivity density, canal diameter, and canal separation12. 

Conventional histomorphometry was performed to further characterize cortical bone differences among 
groups. The measured section of the left distal femur, which was scanned using micro-CT, was removed in 
a 10 mm section, dehydrated and embedded in methyl methacrylate (MMA) according to a protocol 
developed in the Andronowski Lab (Appendix IX). Frost13 recommends that 50 mm2 of bone be evaluated, 
which requires 2 to 5 serial thin-sections. In our experience, and that of colleagues, evaluating two thin 
sections is adequate to account for the variation in microstructures between sections. A diamond wire saw 
was employed to cut two thin sections (~60 – 90 µm thick) from each embedded block, which were mounted 
on glass slides. Thin sections were visualized on an Olympus BX51 microscope by capturing overlapping 
microscopic images at 200x with brightfield with Differential Interference Contrast (DIC) and the 
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associated cellSens Entry software 1.16 (Olympus). The overlapping microscopic images were stitched 
together into a composite image of the cross-section using Microsoft Image Composite Editor and 
Photoshop 2020. Cross-sectional microscopic images were similarly captured and photomerged at 200x 
using circularly polarized light, and at 100x using fluorescence with a FITC filter cube. After photomerging, 
the DIC, circularly polarized, and fluorescence images were aligned with one another in Photoshop 2020. 
These cross-sections were then concurrently anatomically aligned to match the orientation of the 
corresponding micro-CT data using a 2D slice of the cortical shell extracted from the micro-CT image 
processing workflow. Cross-sectional images were then cleared external to periosteal and endosteal 
borders. The circularly polarized image was used to identify and isolate the remodeling area, which was the 
circumferential intracortical region of secondarily remodeled (Haversian) bone, using the software ORS 
Dragonfly v.4.1 (Object Research Systems, Montréal, Canada). A custom ImageJ toolkit, OsteoFlo, was 
developed by Drs. Cole and Andronowski to semi-automatically extract classifications (e.g., vascular pore 
type, single/double/triple labeled osteons), morphometric parameters (e.g., areal fraction, population 
density, size, and shape parameters), and remodeling parameters (e.g., number of active remodeling centers, 
osteonal mineral apposition rate, osteon wall thickness, activation frequency) from the DIC and 
fluorescence images. These parameters were assessed for whole cross-sections and for anatomical 
quadrants (Anterior, Medial, Posterior, Lateral) within cross-sections. 

Objective 3: Identify if prolonged opioid use is discernable in cortical bone microstructural features used 
in histological age-at-death estimation. 

Activity 4: Data Analysis 
Projected Completion Dates: 02/20 – 06/20 
Revised Completion Dates: 07/21 – 09/21 

Progress: 100% as per proposed revised timeline 

Statistical analyses were accomplished using R statistical software (The R Foundation, v. 4.1.1). Micro-CT 
data, which described the 3D morphometry of vascular pore networks, were assessed using Linear Mixed 
Models (LMM), to control for the repeated measure of using the femur and tibia from the same individuals 
as a random effect. Each morphometric variable was tested for a significant response to the fixed effects of 
drug group, bone type (femur or tibia), and anatomical region. Histological data, which describe the 2D 
morphometry and aspects of remodeling rate and frequency in the femur specifically, were assessed using 
ANOVAs. Each morphometric variable was tested for a significant response to the fixed effects of drug 
group and anatomical region. Appropriate post-hoc analyses tested for significant differences between pairs 
of drug groups and pairs of anatomical regions, and tests for model importance and goodness-of fit (R2, 
effect size, power analyses) were also performed. A significance level of p ≤ 0.05 was used for testing. 

Data analysis proceeded on schedule beginning July 2021, according to the revised project timeline. 
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Activity 5: Manuscript preparation and knowledge dissemination 
Projected Completion Dates: 07/20 – 12/20 
Revised Completion Dates: 07/21 – 09/21 

Progress: 100% as per proposed revised timeline 
Planned Scholarly Product 
Planned scholarly products include manuscript submissions to competitive peer-reviewed scientific 
journals. The results of the proposed application and limitations of this research will be published in journals 
targeting forensic specialists such as forensic anthropologists and archaeologists, missing persons 
detectives, and crime scene personnel. To reach forensic practitioners and the general forensic science 
community, scientific journals will include Journal of Forensic Sciences, Forensic Anthropology, and 
Forensic Science International. 

The proposed work is also of interest to the bone biology and biomedical imaging communities. As such, 
Dr. Andronowski intends to target these groups through discipline specific journals such as the Journal 
of Anatomy, Bone, Micron, and the Anatomical Record. 

Dissemination Strategy 
The ultimate goal of the Andronowski Group is to further understandings of how bone remodeling is related 
to age-related change using high-resolution imaging modalities (e.g., micro-CT and SR micro-CT), while 
simultaneously generating and disseminating new scientific knowledge. To broadly disseminate the 
findings and reach a wide variety of specialists within forensic science and the criminal justice system, law 
enforcement and legal personnel, medical examiners, forensic anthropologists and forensic archaeologists, 
initial results will be presented at the annual American Academy of Forensic Sciences conference. For a 
more targeted audience, results will be presented at the annual Canadian Bone and Joint Conference hosted 
by the University of Western Ontario’s Bone and Joint Institute. These conferences bring together experts 
from across disciplines committed to interdisciplinary and high-impact research related to bone-affecting 
conditions and their treatment. 

In addition, Dr. Andronowski routinely travels to the Canadian Light Source (CLS) synchrotron facility 
located on The University of Saskatchewan campus to run synchrotron imaging experiments and 
collaborate on other research projects. She will further disseminate the information learned through this 
venue and reach a number of bone imaging specialists and musculoskeletal researchers in the Department 
of Anatomy, Physiology, and Pharmacology. Lab members Dr. Andronowski, Dr. Cole, Reed Davis, and 
Gina Tubo traveled to the CLS in August 2019 and December 2019 for experimental beam time on a 
concurrent project. Further planned synchrotron experiments were on hold from April 2020 – June 2021. 
The Andronowski Lab was able to travel to CLS once again in September 2021 for imaging time related to 
various other research projects. 

A manuscript documenting the findings from Activities 1 and 2 titled ‘Rabbits (Oryctolagus cuniculus) as 
a Model System for Longitudinal Experimental Opioid Treatments: Implications for Orthopedic and 
Biomedical Research’ was published in a special issue in the journal Osteology (Appendix X). All members 
of the research team contributed. Additional manuscripts describing micro-CT and histology results, and 
the associated software packages developed for this software, are currently in preparation. Further 
manuscript preparations and data dissemination proceeded on schedule as per the revised project timeline. 
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Activity 6: Project management (Andronowski) 
Projected Completion Dates: 01/19 – 09/21 

Progress: 100% complete as per proposed timeline 

The current study was managed through the Department of Biology at The University of Akron. The 
Principal Investigator (Dr. Andronowski) provided overall project direction and coordination, 
contributed to methods and data review. Andronowski prepared quarterly and semi-annual reports to the 
Office of Justice Programs (OJP), conference abstracts, and data for journal submissions and other forms 
of dissemination. She was further responsible for overall project management and coordination. Dr. 
Andronowski trained and supervised a Post-doctoral Fellow (Dr. Mary Cole), Graduate Research 
Assistant (Reed Davis), Undergraduate Research Assistant (Adam Schuller), and Tiered Mentoring 
Undergraduate Students (Gina Tubo, Abigail LaMarca, and Josh Taylor) at The University of Akron, 
certified that milestones were met, and ensured the timely submission of quarterly and semi-annual 
reports to OJP. 

Project management proceeded on schedule with 100% completion at of the end of the no-cost extension 
(08/31/2021).

 II.            ACCOMPLISHMENTS 

2.1. What are the major goals and objectives of the project? 

The purpose of the project, as stated in the approved application, is to develop a longitudinal model for 
studying the effects of prolonged drug exposure, specifically opioids, on cortical bone remodeling in an 
animal — the rabbit — which remodels its cortical bone in a manner comparable to humans. The ultimate 
goal is to describe how analgesic drugs, particularly morphine and fentanyl, affect microscopic structures 
of cortical bone used in histological age estimation methods in forensic anthropology. The current work is 
highly important and culturally relevant as the misuse and addiction to opioids (and synthetic opioids) is a 
serious public health crisis nationwide. Given the limited data available related to the longitudinal 
impact of opioid abuse on bone remodeling, this study is working to improve the applicability of 
histological age-estimation methods and improve scientific standards within the field of forensic 
anthropology. The implications are critical given that many of the skeletal remains examined by forensic 
anthropologists come from marginalized backgrounds with substance abuse issues and overall poor health. 
Thus, histological methods developed on healthy cases may prove ineffective in the analysis of such 
individuals. 

To address this overarching goal, Dr. Andronowski developed and implemented a high resolution three-
dimensional (3D) imaging model capable of tracking cortical bone remodeling events to serve as a platform 
for assessing the effects of morphine and fentanyl on Basic Multicellular Unit (BMU) activity. As BMUs 
are clusters of cells that essentially “tunnel” through bone tissues to enact repair and remodeling, they are 
excellent biomarkers of bone microstructural changes. Their activity, however, has been rarely monitored 
histologically and high-resolution imaging techniques offer a new avenue for understanding their spatio-
temporal behavior. The use of high-resolution micro-CT imaging enables a scale of analysis that will allow 
two central research questions to be addressed: 1) What are the effects of prolonged morphine and 
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fentanyl use on cortical bone remodeling? Will cortical bone microstructure vary randomly with respect to 
opioid use, or will it be correlated? 2) Are the effects of prolonged opioid use discernable in cortical bone 
microstructural features used in histological age-at-death estimation? 

The current project has three primary objectives to: 1) characterize, for the first time, cortical bone 
microstructural changes in a rabbit opioid model, 2) optimize 3D micro-Computed Tomography (micro-
CT or µCT) based imaging of remodeling events in a rabbit model, and 3) identify if prolonged opioid use 
is discernable in cortical bone microstructural features used in histological age-at-death estimation. Their 
status within the proposed timeline and the scientific approach employed is detailed. Appendix IV further 
provides a visual representation of the revised project timeline, outlines completed activities, and milestones 
for the animal procedures and overall study. 

The initial administrative and experimental phases of this project were reported in the semi-annual report 
submitted in July 2019. This involved the completion of Activity 1 (Ethics application for IACUC, animal 
handling training, animal ordering and acclimation) and Activity 2 (Animal dosing) as described in the 
original project timeline. The first objective, encompassing Activities 1 and 2 per the project timeline, was 
100% completed during the first reporting period ending 06/31/19. In the subsequent period (07/01/19 – 
12/31/19), all micro-CT imaging related to Activity 3 was completed as projected in the original project 
timeline. For reporting period (01/01/20 – 06/30/20), micro-CT image processing and statistical analyses 
related to Activity 4 were completed according to the revised project timeline as described below. During 
the reporting period (07/01/20 – 12/31/20), tasks related to the histomorphometry experiments of Activity 
3 were completed including methyl methacrylate (MMA) embedding, microscopic slide preparation, digital 
annotation of the sections, and histological analysis protocol development. For the reporting period 
(01/01/21 – 06/30/21), preparations for histological analyses and data analysis related to the histology 
experiments of Activity 3 were completed. Under the no-cost extension, tasks related to Activity 4 and 5 
concerning histomorphometric data analysis, manuscript drafts, and knowledge dissemination were 
finalized. 

2.2. What was accomplished under these goals? 

2.2.1. Major Activities 

Objective 1: To characterize, for the first time, cortical bone microstructural changes in a rabbit opioid 
model. 

Activity 1 – Ethics application, animal handling training, animal ordering, acclimation 
Dates: 1 January – 30 April 2019 

Progress: 100% Complete 

A detailed animal protocol (Protocol #: 18-11-12 ARC) was written by Dr. Andronowski and approved by 
The University of Akron Institutional Animal Care and Use Committee (IACUC) committee on 12/10/2018 
(Appendix I). In-person training with The University of Akron Research Vivarium (UARV) attending 
veterinarian, Dr. Stanley Dannemiller, in proper ethical care, handling, and use of laboratory animals was 
completed by the PI, Post-doctoral Fellow (Dr. Mary Cole), Graduate Research Assistant (Reed Davis), 
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and Undergraduate Research Assistant (Adam Schuller) on 03/11/2019 (Appendix II). In-person 
Hazardous Substances training was provided by UA Health and Safety representative, Alex Stakleff, to 
Andronowski, Schuller, and Davis on 02/01/2019. UARV facility training was also provided by vivarium 
manager, Beth Kenaga, to the above research team members on 02/01/2019, and to Cole and LaMarca on 
03/11/2019. 

Project supplies and consumables were ordered in preparation for the arrival of the live rabbits and their 
experimental treatments. These items included (but are not limited to): enrichment toys, syringes/needles 
for administration of pharmaceutical agents, and water bottles and food troughs. We also purchased the 
pharmaceutical agents (morphine sulphate and fentanyl) through the UARV. 

Activity 2 – Animal Dosing 
Dates: 1 May – 26 June 2019 

Progress: 100% Complete 

The Animal Dosing phase (Activity 2) began 05/01/2019 following the two-week acclimation period. The 
rabbits were consistently dosed in order from the least potent experimental agent (saline) to the most potent 
(fentanyl), thus following the regimen of control, morphine, and fentanyl groups. Each individual subject 
was randomly assigned to a group of seven rabbits following acclimation in order to eliminate observable 
difference within or between groups for the experimental portion of the study. This ensured that any 
significant distinctions in bone micromorphology following the dosing period can be attributed to 
experimental manipulation. Within the control group, animals were randomly assigned to either the saline 
injection subgroup (n=3) or the transdermal patch control counterpart (n=4). In the control group, the saline 
injection subgroup rabbits were administered a subcutaneous bolus of saline, equal in volume to what the 
animal would receive if it were being dosed with morphine, through injection at the interscapular region. 
The patch control subgroup was treated by applying a quarter-sized amount of topical 20% isopropyl 
myristate in sterile saline (a skin softening agent) followed by an adhesive Tegaderm patch on the 
interscapular region. Morphine group rabbits were dosed with a subcutaneous bolus of morphine sulphate 
at 3 mg/kg/day injected at the interscapular region. Fentanyl group rabbits were dosed through application 
of 25 mcg/h transdermal fentanyl to bare skin at the interscapular region covered by a larger adhesive 
Tegaderm patch. All rabbits were shaved with Oster electric clippers using a 10-blade to remove the initial 
bulk of hair and a 40-blade to clip the finely-textured undercoat as needed. Injection of saline or morphine 
sulphate occurred every day between 8:00 and 11:00 A.M. while novel patch application followed a 72-
hour dosing regimen, with application every third day. If the animal was observed to have removed its 
experimental treatment, a new transdermal fentanyl patch and/or adhesive Tegaderm covering was applied. 
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Objective 2: To optimize 3D micro-CT imaging of remodeling events in an opioid rabbit model. 

Activity 3: Micro-CT imaging and histomorphometry 
Projected Completion Dates: 08/19 – 04/20 

Micro-CT imaging Progress: 100% as per proposed timeline 
Histomorphometry Progress: 100% completed as per revised project timeline; began January 2020 

(delayed by COVID-19 pandemic) 

Micro-CT Imaging (ex vivo): Immediately following euthanasia, the left femur and tibia were dissected 
from each animal, wrapped in sterile saline-soaked gauze, and stored in a sample tube in a -20° C freezer. 
The remainder of the animal was sealed in plastic under vacuum and frozen in a -80° C freezer for future 
bone and tissue research. To prepare for micro-CT imaging, all members of the research team completed 
radiation generating equipment training (RGE Training), as well as two to three sessions of individualized, 
hands-on training for independent operation of the micro-CT instrument. Micro-CT imaging was performed 
using a SkyScan 1172 micro-CT (Bruker Micro-CT) desktop system located in the Surface and Optical 
Analysis Facility within the National Polymer Innovation Center (NPIC) at The University of Akron. Since 
this system is shared by users from various departments at The University of Akron, a conservative estimate 
of 6-9 months for imaging was estimated and carried out. Imaging was completed by Dr. Andronowski, Dr. 
Cole, and Reed Davis. For all 21 rabbits, micro-CT scans were captured at the midshaft femur, midshaft 
tibia, and proximal tibio-fibula. Tibial midshaft imaging was completed to assess interskeletal variability 
among porosity parameters in respect to the femoral midshaft. The proximal tibio-fibula data will provide 
further data on changes to trabecular bone morphology due to opioid exposure.      

Dr. Andronowski developed and tested a micro-CT scanning protocol using bone tissue samples from her 
concurrent projects. Each femur and tibia was mounted to a brass sample holder via dental wax and secured 
with Parafilm to ensure the sample did not move during scanning. A previously optimized micro-CT 
imaging protocol was applied and included the use of a Hamamatsu 100/250 optical camera to take 1992 
projection images spanning 180 degrees of rotation at 74 kilovolts (kV). 

To set scan parameters, all extracted femora and tibiae were measured for length, with rabbit #4 possessing 
the largest femur and tibia. Specimens from this animal were chosen for preliminary imaging to ensure that 
all remaining femora and tibiae fit within the gantry and Field of View (FOV) of the µCT system. To 
optimize resolution, the midshaft femur of rabbit #4 was visualized at voxel sizes of 4.57 µm, 7.45 µm, and 
9.93 µm. The maximum resolution of 4.57 µm was chosen because it closely accommodated the femoral 
midshaft within the FOV. The minimum resolution of 9.93 µm reflects previous recommendations of at 
least 10 µm resolution for visualizing human cortical pore networks to maintain structural parameters14. A 
lower resolution (e.g., 9.93 µm) can visualize a greater length of bone, but structures such as cortical pores 
will not be as well resolved. The resulting X-ray projections were reconstructed into tomographic cross-
sectional slices using Nrecon software (Bruker). An image processing workflow developed by Dr. Cole 
extracted the cortical pore network for the three-dimensional (3D) visualization and morphometric 
quantification. We found that the larger voxel sizes (7.45 µm and 9.93 µm) generated substantial image 
noise that could not be easily distinguished from smaller pores through image processing. Three-
dimensional visualization of pore networks showed a substantial reduction in the pore systems 
reconstructed at 7.45 µm and 9.93 µm, compared to 4.57 µm. Specifically, pore networks visible at 4.57 
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µm covered the entire cross-sectional thickness as expected, while pore networks visible at 7.45 µm and 
9.93 µm were largely restricted to the expanded pore systems adjacent to the endosteum (Figure 1). 
Accordingly, a higher resolution increased the number of pore systems with at least two segments, from 
403 systems at 9.93 µm, to 1,178 systems at 7.45 µm, to 2,210 systems at 4.57 µm. 

Figure 1: Cortical pore networks from the femur decrease in visibility and cross-sectional coverage at lower 
micro-CT imaging resolutions. Color scale represents local pore thickness. Scale bar is 1000 µm. 
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Figure 2: Cortical pore networks from femora (left) and tibiae (right) from each group, with micro-CT 
imaging resolution set at 5.49 µm. Color scale represents local pore thickness. Scale bar is 1000 µm. 
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During reporting period 07/01/19 – 12/31/19, all femoral and tibial midshafts (n = 42) were imaged at 5.49 
µm resolution (Figure 2) as this was the highest resolution where all samples consistently fit within the 
FOV. This scan resolution visualizes a bone length of 7.318 mm. At lower resolutions (e.g., 4.57 µm) larger 
femoral or tibial midshafts could not be reliably positioned wholly within the FOV. Femora and tibiae were 
prepared and scanned according to the protocol described in the attached Appendix XI entitled “Rabbit 
Opioid SkyScan µCT SOP”. Due to length, the tibio-fibula could not stand fully upright on the SkyScan 
stage within the gantry. Thus, the distal end of each tibio-fibula was removed using an Isomet Saw to reduce 
bone length to 87 mm, which could fit within the SkyScan gantry. Femora were scanned at the midshaft, 
while tibio-fibulae were scanned at the midshaft of the isolated tibia prior to its merging with the fibula. 
Additionally, all proximal tibio-fibulae (n = 21) were scanned at a resolution of 10.98 µm, which was the 
maximum resolution that could consistently fit this region fully within the FOV. This scan resolution 
visualizes a bone length of 14.636 mm. Scans of the proximal tibio-fibula were used for analysis of 
trabecular architecture by Graduate Assistant, Reed Davis, in the upcoming study periods (Figure 3). In all 
scans, anterior and medial clay inclusions were inserted within the bone’s Parafilm wrapping to mark 
anatomical orientation for the subsequent tomographic reconstructions. 

Figure 3: Trabecular architecture visible from inferior (top) and medial (bottom) views of the proximal left 
tibia from a control patch rabbit. Color scale corresponds to volume thickness. Scale bar is 1000 µm. 
An image processing workflow was developed by Dr. Cole to extract the cortical pore network from femoral 
and tibial midshaft scans. This workflow is automatically processed through custom macros written for 
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ImageJ (NIH) and CTAnalyser (Bruker) as described in the attached Appendix XII “Rabbit Opioid µCT 
Image Processing SOP”. In brief, this workflow involves tomographic reconstruction, anatomical 
orientation, longitudinal alignment, extraction of total area and cortical area masks, and low-contrast filter 
extraction of the pore network. Pore morphometric variables, broadly associated with pore density, volume, 
connectivity, and orientation, are assessed within the boundaries of the cortical area mask using 
CTAnalyser. These morphometric variables are reported both for the aggregate pore network and for 
individual pore systems. CTAnalyser also reports variables associated with the cross-sectional geometry of 
the cortical area, using the total area mask as the region of interest. 

Dr. Cole developed an additional macro for ImageJ that divides each cortical area mask into anterior, 
posterior, medial, and lateral regional quadrants using the section centroid. When a given regional mask is 
loaded as the region of interest for a pore network in CTAnalyser, the reported morphometry is limited to 
that region. These data will facilitate analysis of regional variation in pore distribution and morphometry, 
which may be associated with the drug treatment group. This regional image processing workflow is 
described in the attached Appendix XIII “Femur and Tibia Quadrant Regional Processing SOP”. As 
regional quadrants artificially truncate cortical bone and pore network branching at their boundaries, cross-
sectional geometry was not carried out for regional comparisons. All specialized image processing macros 
developed for this project are contained in Appendices XIV – XV “CTAnalyser Macros” and “ImageJ 
Macros”. 

During reporting period 01/01/20 – 06/30/20, skeletonization analysis of the binarized pore network was 
carried out to examine the branching patterns of pore systems. The Auto-Skeleton module of Amira 6.4.0 
was employed, as described in the attached Appendix XVI “Skeletonization SOP”. Skeletonization data 
collection was performed by undergraduate student Kassidy Wilson for her undergraduate honors thesis, 
with assistance from Drs. Andronowski and Cole. 

During reporting period 07/01/20 – 12/31/20, we made significant process on the histomorphometry 
component of Activity 3. This phase, described below, began on target in January 2020 as proposed in the 
original project timeline. Due to the COVID-19 pandemic, however, this component of the project was 
slowed and a no-cost extension was filed. An explanation and revised plan for the histomorphometry 
experiments is presented below. 

Description of Extenuating Circumstances Leading to Delays in Histomorphometry Experiments 

On 03/11/2020, the World Health Organization declared the novel coronavirus outbreak (COVID-19) a 
global pandemic. As a result, The University of Akron cancelled in-person classes that day and in-person 
lab work was ordered to cease immediately. As per our project timeline, our research team was preparing 
rabbit femoral bone thin-sections for dynamic histomorphometry (Activity 3.4). This process involved daily 
lab work that included bone dehydration, methyl methacrylate (MMA) infiltration and curing, sectioning 
via the in-house Well Diamond Wire Saw, and slide mounting. The stalling of in-lab operations and the 
shutdown of The University of Akron halted the progress of Activity 3.4 indefinitely. 

The governor of Ohio declared a “Stay-at-Home” order on 03/23/2020 which was extended through 
06/04/2020. On 05/21/2020, The University of Akron administration announced a ‘Researcher Return to 
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Work’ initiative and Principal Investigators were invited to create individual Return to Work plans for their 
groups for review by administrators and unit heads. The document Dr. Andronowski created (Appendix 
XVII: “Researcher Return to Work”) outlined the guidelines and expectations of Andronowski Lab 
members for a safe return to lab activities during the ongoing COVID-19 pandemic. On 06/08/2020, the 
plan was approved with restrictions related to limits on laboratory personnel numbers and office use and 
occupancy, the implementation of shift work, and personal protective equipment requirements. 

Due to current social/physical distancing guidelines requiring separation distances of 6 feet or more, no 
more than 2-3 individuals are permitted in Dr. Andronowski’s main lab space at any given time. Lab 
procedures requiring more than one person in close proximity are to be minimized as much as possible. 
Due to disruptions in supply chains, the ordering and delivery of consumables, stains, PPE, and lab 
equipment has also been significantly slowed leading to experiment delays. As a result, our bone 
histomorphometry specimen preparation and the subsequent analyses has been slowed. 

A detailed timeline narrative and implementation timeline (Appendix XVIII: “Projected MMA Timeline”) 
have been prepared that outline the revised trajectory for Activities 3.4 and 4.2 in line with our lab safety 
guidelines. As of 08/31/2021, we are on schedule with the revised project timeline, submitted our first paper 
from the project for publication, and are finishing additional manuscript drafts for submission. 

Conventional histomorphometry was performed to further characterize cortical bone differences among 
groups. Each member of the research team has experience with the traditional histological preparation of 
bone tissue, having applied it to other research projects. Our embedding and sectioning protocol was 
developed and tested by Drs. Andronowski and Cole on pig ribs and on Mini Rex rabbit femora and tibiae 
mid-shafts. The specimens were dehydrated and embedded in MMA according to a protocol developed by 
the Andronowski Lab (Appendix IX: “MMA Embedding SOP”). A precision diamond wire saw (Well 
Wire Saws, Norcross, GA) was employed to cut two transverse cross-sections, followed by sequential 
longitudinal sections, that were ~ 60 – 90 µm thick. Frost13 recommends that 50 mm2 of bone be evaluated, 
which requires 2 to 5 serial sections. In our experience, evaluating two thin- sections is adequate to account 
for the variation in microstructures between sections. The thin-sections were mounted on glass slides, cover 
slipped, and dried. The finished slides were imaged using an Olympus BX51 fluorescence microscope fitted 
with Differential Interference Contrast (DIC). Digital brightfield microscopic images were captured at 200x 
magnification and DIC using the associated cellSens Entry software 1.16 (Olympus) and stitched together 
into a composite image of the section using Microsoft Image Composite Editor and Photoshop 2020. 
Circularly polarized light images were further captured at 200x for each slide to aid in distinguishing osteon 
boundaries. Finally, images of each slide were captured at 100x under fluorescence using a FITC filter cube 
for visualization of the calcein labels. The microscopic imaging and digital stitching produced DIC, 
circularly polarized, and fluorescent image of each complete cross-section. 

During 08/20 of reporting period (06/30/20 – 12/31/20), thin-section mounting and microscopic imaging 
testing began and was completed by 09/20. Microscopic imaging of the prepared cross-sections began in 
09/20 with the assistance of Undergraduate Research Assistant, Joshua Taylor. Protocol development was 
initiated following traditional histomorphometric parameters outlined in Jaworski and Lok15. The 
microscope and the cellSens Entry software scales were calibrated prior to the evaluation of thin-sections. 
Standard nomenclature for histological variables was followed16 during protocol development. 
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Histomorphometric parameters relating to histological age-estimation are described in Appendix XIX: 
Histomorphometric Variables. 

On 01/21, photomerging of the DIC brightfield, circularly polarized, and fluorescent images was initiated. 
This aspect was primarily conducted by Graduate Research Assistant, Joshua Taylor. In 02/21, Taylor 
trained and supervised two undergraduate students to assist. Upon completion, the analytical focus shifted 
to overlaying the images in Adobe Photoshop v.23.0.0 (Adobe, San Jose, California). This allowed for the 
DIC, circularly polarized, and fluorescence images from the same slide to be oriented identically and with 
matching coordinates for all microstructural features. Subsequently, these images were anatomically 
oriented in Adobe Photoshop in alignment with a binarized outline of the cortical bone cross-section from 
the previously processed micro-CT images of each sample. All images were oriented in a clockwise manner 
from the top of the image: Anterior, Medial, Posterior, Lateral (Figure 4). Finally, the areas of each image 
were cleared outside the periosteal border and within the endosteal border, using the Wand Tool and 
Freehand Selection Tool in ImageJ (Figure 5). 

Figure 4: Circularly polarized image (left) and fluorescence image (right) aligned with DIC image in Figure 
5, Sample 1LF_85µm. 
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Figure 5: DIC image before (left) and after (right) clearing the endosteal border, Sample 1LF_85µm. 

Dr. Cole recruited the assistance of an additional undergraduate student to aid in the isolation of the 
remodeling area of all polarized images using the software Dragonfly. The remodeling area was exported 
both as a binarized image TIFF file, and as a region of interest (ROI) file for import into ImageJ (Figure 
6). Final preparation for histomorphometric analysis was completed by 06/21. 

Figure 6: Circularly polarized image (left) and DIC image (right) with remodeling area selected (red), 
Sample 1LF_85µm. 
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During the 01/01/21 – 06/30/21 reporting period, Dr. Cole developed custom ImageJ macros for the 
automated extraction, manual correction, and automated regional subdivision and morphometric analysis 
of cortical pores from DIC images. Macros for extraction, manual correction, and analysis of osteons were 
developed during the 06/30/2021 – 08/31/2021 reporting period. The combined software toolkit for ImageJ 
was named “OsteoFlo” (Figure 7). 

Figure 7: The OsteoFlo toolkit interface loaded in ImageJ. 

ImageJ macros for pore analysis included the following: 

DIC Pre-Processing (Fully Automated): The DIC image is evenly illuminated through application of a 
high pass filter, contrast enhancement, and background subtraction. This macro removes variation in sample 
illumination over the cross-section caused by photomerging artifacts (Figure 8). 
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Figure 8: DIC image before (left) and after (right) pre-processing for Sample 1LF_85µm. 

Pore Extractor (Fully Automated): The user loads the pre-processed DIC image and the remodeling area 
region of interest (ROI), which was previously extracted from circularly polarized images. Within this 
remodeling area ROI, probable pore ROIs are extracted from the DIC image using an Intermodes auto-
threshold, particle size and circularity thresholding, and binary closing. The user can inspect the proposed 
selections and modify the particle size and circularity thresholds before extraction. Pores are extracted 
within the remodeling area ROI, which is known to experience secondary bone remodeling during life, as 
indicated by the Haversian (secondary) bone visible on the circularly polarized image. This ROI restriction 
excludes the periosteal and endosteal areas of primary bone containing the cortical pores of primary osteons, 
which are formed during initial growth. 

Pore Modifier (Manual): Automatically selected pore ROIs exported by Pore Extractor are manually 
inspected and edited (Figure 9) using custom keyboard shortcuts that facilitate manual pore selection and 
image navigation. These shortcuts include: 

• One-click access to ImageJ tools, including the Wand Tool, Wand Tool Options (for pixel 
brightness tolerance adjustment), Freehand Selection Tool, Zoom Tool, Scrolling Tool, and 
Selection Brush Tool 

• Toggling ROI labels and ROI selections on and off as image overlays 
• Resetting the Wand Tool tolerance to zero 
• Splitting joined ROIs after separation with the Selection Brush Tool 
• Filling enlarged ROIs after border expansion with the Selection Brush Tool 
• Decreasing or increasing Selection Brush Tool size by factors of 5 pixels 
• Reverting an ROI to its original shape after manual modification 
• Auto-saving the current ROI set to the user’s file system 

Due to its Auto-Save function, Pore Modifier may be run repeatedly on the same ROI set, spreading the 
manual correction over multiple user sessions for particularly large images. 
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Figure 9: Automatically extracted pores (left, red) exported by Pore Extractor and manually modified pores 
(right, green) exported by Pore Modifier, Sample 1LF_85µm. 

Pore Analyzer (Fully Automated): Anatomical quadrants are defined on each cross-section by extracting 
the total area (a filled binary mask of the bone inside the periosteal border), finding its centroid in BoneJ, 
and drawing a line through this centroid to the top and bottom of the image. This line is then rotated 45 
degrees, and then 90 degrees, to define the dividing lines between Anterior, Medial, Posterior, and Lateral 
anatomical quadrants. These anatomical quadrants are extracted as separate ROIs and as binary images 
from the cortical area image. Finalized pore ROIs located within each anatomical quadrant are assigned to 
that quadrant. Pore ROIs located on the border between anatomical quadrants are assigned to whichever 
quadrant contains a larger fraction of that pore area (Figure 10). 
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Figure 10: Pores colorized by anatomical quadrant: Anterior (red), Medial (yellow), Posterior (green), 
Lateral (blue), Sample 1LF_85µm. 
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Finalized pore ROIs are further classified as cortical or trabecularized based on proximity to the marrow 
cavity versus minimum diameter. Proximity to the marrow cavity is accomplished by extracting a binary 
image of the marrow cavity and generating a Euclidean Distance Map (EDM) of this image. Each pixel 
distance from the marrow cavity is defined as an increasing pixel brightness value, which in a 16-bit system 
ranges from 0 pixels (absolute black) to 65,536 pixels (absolute white) away from the marrow cavity in any 
direction. Pore ROIs are superimposed on the EDM image, and the minimum gray value of each pore ROI 
is automatically measured, which corresponds to their proximity to the marrow cavity in pixel units. 
Minimum diameter is also automatically measured for each pore ROI as minimum Feret (caliper) diameter. 
If minimum pore diameter exceeds its proximity to the marrow cavity, then the pore is classified as 
“trabecularized”; otherwise, the pore is classified as “cortical.” 

Summary pore morphometry is calculated for all pores in aggregate and for each pore type (total, cortical, 
and trabecularized) and within each region (Anterior, Medial, Lateral, Posterior), including percent 
porosity, pore density, and mean pore size and shape descriptors. The macro exports a table of these 
summary statistics, and a table of measurements for individual pore ROIs, including their regional and pore 
type classification. 

ImageJ macros for osteon analysis included the following: 

Osteon Extraction (Fully Automated): The fluorescence image is loaded, along with the ROI for the 
remodeling area. Local contrast enhancement is applied to emphasize calcein labeling in the fluorescence 
image (Figure 11). Spaces external to the remodeling area are then cleared. Osteon borders are extracted 
using a global Intermodes threshold, followed by removal of bright outliers less than 10 pixels. Osteon 
borders are sealed using Euclidean Distance Map opening, through ten cycles, from the BioVoxxel Toolbox 
plugin for ImageJ. Osteon “rings” representing discrete calcein labels are extracted by subtracting the 
background, which removes faint fluorescence between rings. Rings are then binarized using an auto local 
threshold with a Phansalkar algorithm for low-contrast images, and bright outliers less than 5 pixels are 
removed through four cycles. The enhanced fluorescence image, binarized osteon borders, and binarized 
osteon rings are exported as separate TIFF images (Figure 12). An ROI set of osteon borders is also 
exported as a zip file. 
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Figure 11: Fluorescence image for Sample 1LF_85µm before (left) and after (right) local contrast 
enhancement to emphasize calcein labeling. 

Figure 12: Osteon borders (left) and osteon “rings” (right) representing discrete calcein labels exported for 
Sample 1LF_85µm.  
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Osteon Border Correction (Manual): This macro allows the user to split connected osteons, seal open 
osteon borders, add any missed osteons, and delete any image noise selected by the automated osteon border 
extraction. The original DIC image, the contrast-enhanced fluorescence image, and the ROI set of 
unmodified osteon borders are loaded. The DIC image is superimposed on the fluorescence image at 75% 
opacity so that calcein labels and osteon cement lines can be viewed simultaneously. The osteon border 
ROI set is then superimposed for the user to inspect and modify (Figure 13). The same shortcut utilities in 
Pore Modifier are available here, including wand selection, selection brush tool modification, freehand 
selection, ROI label toggling, split/fill/revert functions for ROIs, and auto-saving (Figure 14). The macro 
exports the user-modified ROI set of osteon borders, and a corrected binarized mask of osteon borders 
(Figure 15). 
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Figure 13: Unmodified osteon borders (red) superimposed on fluorescence image and DIC image at 75% 
opacity for Sample 1LF_85µm. 
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Figure 15: Osteon borders automatically extracted (left) and manually modified (right) for keyboard 
shortcut utilities for Sample 1LF_85µm. 

Osteon Type (Fully Automated): This macro categorizes osteons by anatomical region and calcein label 
type (partially labeled forming osteon, single/double/triple labeled complete osteon), in addition to 
detecting the placement of calcein labels and vascular pores to calculate osteon mineral apposition rate 
(On.MAR) and osteon wall thickness (W.Th), respectively. The preprocessed DIC image, the osteon 
“rings” image, and corrected osteon border ROIs are loaded. To categorize osteons by anatomical region 
(Anterior, Medial, Posterior, Lateral), the quadrants are drawn using the same mechanism as Pore Analyzer. 
Each region is flattened at 255 pixel brightness (absolute white) and extracted separately. For each region, 
the osteon border ROIs are loaded and their pixel brightness is measured. Osteons located fully within a 
region will have a mean pixel brightness of 255. Osteons located on the border between regions are 
classified with the region that has the higher mean pixel brightness, which indicates that a larger fraction 
of the osteon area falls within that region (Figure 16). 

Figure 16: Pores located on regional borders have an intermediate pixel brightness (1 - 254) in two regions. 
These pores are classified with the region that has the higher pixel brightness value, indicating that a larger 
fraction of the pore area is located in that region. Pores located fully within a given region have a pixel 
brightness of 255 for that region and a pixel brightness of 0 for all other regions. 
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Figure 17: Regional quadrants drawn on the total area binarized image, with the ROI set of osteon borders 
colorized by region classification superimposed for Sample 1LF_85µm. 

2018-DU-BX-0188 Final Technical Report 
October 2021 

This resource was prepared by the author(s) using Federal funds provided by the U.S. 
Department of Justice. Opinions or points of view expressed are those of the author(s) and do not 

necessarily reflect the official position or policies of the U.S. Department of Justice.

29 





 
  

 

 
         

       
 

 

Figure 19: Osteon “ring” image for Sample 1LF_85µm, with an overlay of osteon border ROIs 
automatically colorized by type as forming (blue), single-labeled (green), double-labeled (red), and triple-
labeled (yellow). 
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Label spacing (osteon mineral apposition rate, or On.MAR) is also measured between the first and second 
ring for double-labeled osteons, and between both the first and second and the second and third for triple-
labeled osteons. X and Y coordinates for each end of the label spacing line are saved to an aggregate data 
table for each osteon. The distance between these labels is measured as the distance between the peak edges 
on the intensity profile along the osteon major axis (Figure 20). The label spacing in pixels and µm is also 
saved to this data table. 

Figure 20: Red dots denote coordinates for label spacing between the first and second rings for both double-
labeled (left) and triple-labeled (right) osteons. Green dots denote coordinates for label spacing between 
the second and third rings for triple labeled (right) osteons. 

The macro additionally measures osteon wall thickness as the maximum distance of the osteon’s vascular 
pore from any point on the osteon border. First, a pixel brightness intensity profile is extracted both along 
the major axis and the minor axis of an ellipse fitted to the osteon border. For both intensity profiles, the 
two most central peaks (e.g., the innermost label around the pore) are identified, and coordinates at their 
absolute center are extracted to represent the probable centroid of the pore. If the intensity profile has 0 or 
1 peaks, meaning that the ellipse axis passes through a partial label or no labels, then the center of the ellipse 
axis is used to estimate the pore centroid location. Since the probable pore centroid is extracted for both the 
minor and major axis of the osteon border ellipse, the coordinates are chosen if they fall closer to the central 
point of that ellipse (Figure 21). The coordinates of the probable pore centroid are saved to an aggregate 
data table for each osteon. 

2018-DU-BX-0188 Final Technical Report 
October 2021 

This resource was prepared by the author(s) using Federal funds provided by the U.S. 
Department of Justice. Opinions or points of view expressed are those of the author(s) and do not 

necessarily reflect the official position or policies of the U.S. Department of Justice.

32 





 
  

 

    
    

    
       

       
      

        
       

     
  

     
          

      
          

          
       

      
   

Osteon Type Correction (Manual): Automated osteon type classification, label identification, and pore 
centroid identification may be misdirected by noise or by incomplete osteon labeling. The user must 
manually inspect these components to ensure accuracy. The original DIC image, the contrast-enhanced 
fluorescence image, and the csv file and ROI set of osteon type classifications are loaded. As in the Osteon 
Border Correction macro, the DIC image is superimposed on the fluorescence image at 75% opacity so that 
calcein labels and vascular pores can be viewed simultaneously. The ROI set of osteon borders, colorized 
by type, is superimposed on this image. Coordinates are also added as point overlays for the label spacing 
(red = inner labels, green = outer labels) and pore centroids (cyan). Keyboard shortcut utilities were 
developed for this macro, including an auto-save utility for the ROI set and csv file, and shortcuts to 
reclassify osteon type and manually place label spacing and pore centroid coordinates. Reclassified osteon 
types are updated with an asterisk on the label and a color change to the new type designation. Labels and 
pore centroids are converted from solid dot overlays to hollow dot overlays if they are manually modified 
(Figure 24). This assists the user in tracking ROIs that have already been corrected. Label spacing 
(On.MAR) and osteon wall thickness (W.Th) are recalculated after manual placement. After the user 
completes manual correction, the macro exports the final ROI set of osteon borders, colorized by osteon 
type (Figure 25), in addition to the finalized csv file of aggregate osteon morphometry, including region 
classification, type classification, label spacing, osteon wall thickness, and size and shape descriptors. The 
macro also exports the DIC image + fluorescence image and the osteon “rings” image with the label and 
pore centroid coordinates superimposed as overlays, as a record of the final modifications. 
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Figure 25: Osteon border ROIs before (left) and after (right) manual osteon type correction, superimposed 
on fluorescence image and DIC image at 75% opacity for sample 1LF_85um. Osteon ROIs are colorized 
by type as forming (blue), single-labeled (green), double-labeled (red), and triple-labeled (yellow). 

Mineralizing Surface (Fully Automated): This macro calculates the percentage of the total area perimeter 
(bone surface or BS) that is calcein labeled as a mineralizing surface (MS). Both the periosteal surface 
(Ps.MS/BS) and the endosteal surface (Es.MS/BS) are assessed. The files loaded include the contrast-
enhanced fluorescence image exported by Osteon Border Extraction, the binarized total area and marrow 
area masks and ROIs exported by Pore Extractor, and the remodeling area ROI. The intracortical region 
with labeled osteons is subtracted from the fluorescence image by clearing inside the remodeling area ROI. 
Then, the periosteal and endosteal labels are automatically binarized using a global Huang threshold. To 
assess Ps.MS/BS, the total area perimeter is extracted from the total area ROI file, and shrunk by a user-
selected value (default = 50 pixels) to intersect with the calcein labeled region just below the periosteum. 
The user may adjust this shrinkage value for the total area ROI until intersection with binarized labels is 
satisfactory (Figure 26). Then, the number of labeled pixels is quantified along this perimeter, and 
compared to the number of pixels that compose the total area perimeter – the ratio of which is Ps.MS/BS. 
A similar process is used to assess Es.MS/BS. The marrow area perimeter is extracted from the marrow 
area ROI file, and expanded by a user-selected value (default = 50 pixels) to intersect with the binarized 
image of the calcein-labeled endosteum. The number of labeled pixels is quantified along this perimeter, 
and compared to the number of pixels that compose the marrow area perimeter – the ratio of which is 
Es.MS/BS. The export from this macro is a csv file containing Ps.MS/BS and Es.MS/BS values. 
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Figure 26: Total area and marrow area ROIs (red) for Sample 1LF_85µm, shrunk and expanded by 50 
pixels, respectively, to intersect with the binarized periosteal and endosteal labels. Ps.MS/BS was 98.4%, 
while Es.MS/BS was 64.6%. 

Resorption Cavities: This macro isolates resorption spaces (Rs.N) inside the remodeling area that are not 
fluorescently labeled, and are therefore not categorized as “forming osteons”, but do fall into the aggregate 
category of active remodeling centers (a.Rm.Cr). Rs.N are also used in the calculation of the ratio of labeled 
osteons to resorption spaces. Files loaded for this macro include the original DIC image, the contrast-
enhanced fluorescence image, the corrected osteon border image, and the corrected ROI set of vascular 
pores. The table of individual pore measurements exported by Pore Analyzer is also loaded to sort pores by 
their previously determined regional classification. As in the Osteon Border Correction macro, the DIC 
image is superimposed on the fluorescence image at 75% opacity so that any fluorescent labeling of vascular 
pores can be visualized. Pore ROIs are removed if they intersect at least 2/3 of their area with osteon borders 
(and thus are likely to be fluorescently labeled). Probable resorption spaces are isolated from the remaining 
pore ROIs by sorting all pore areas into histogram bins. The majority of pores are uniformly small in size 
and fall into the first histogram bin. These pore ROIs are outlined in blue. All larger pores are identified as 
probable resorption spaces and are colored red (Figure 27). The user inspects these designations and can 
flip them using a keyboard shortcut. After manual approval, the number of unlabeled resorption spaces 
(Rs.N) is exported as a csv file, with rows for the whole bone and for each anatomical region.  
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Figure 27: Unlabeled pore spaces for Sample 1LF_85µm, confirmed after user inspection as non-resorption 
spaces (blue) and resorption spaces (red). 
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Objective 3: Identify if prolonged opioid use is discernible in cortical bone microstructural features used 
in histological age-at-death estimation. 

Activity 4: Data Analysis 
Projected Completion Dates: 02/20 – 06/20 

Actual Completion Dates: 07/20 – 12/20 
Progress: 100% as per revised timeline 

Micro-CT Data Analysis 

Statistical Model Design 

Pore systems were extracted, and their 3D morphometry analyzed using a custom ImageJ and CTAnalyser 
workflow. Descriptive statistics of mean, median, and standard deviation were generated for each 
morphometric variable with package dplyr. Descriptive statistics were generated by grouping Bone, Drug 
Group, and Bone * Drug Group for whole-bone comparisons, and by Region, Drug Group, and Region * 
Drug Group for anatomical quadrant comparisons (Appendix XX: “Micro-CT Descriptive Statistics”).  

Aggregate pore morphometry variables were assessed in R (The R Foundation, v. 4.1.1) using a Linear 
Mixed Model (LMM) with the formula Morphometric Variable ~ Bone Type * Drug Group + (1|Sample). 
Within the femur and tibia individually, regional comparisons between Anterior, Posterior, Medial, and 
Lateral quadrants were conducted with the formula Morphometric Variable ~ Bone Region * Drug Group 
+ (1|Sample). Morphometric variables were scaled and centered. LMM were tested for each morphometric 
variable with the lmer function within the package lme4. The LMM output is an estimate (β) of the mean, 
standard error (SE), confidence interval, t statistic, and a p-value for the test statistic computed with 
Satterthwaite's method for degrees of freedom. Estimates are also reported for the estimate, standard error, 
percentage of residual variance (ICC), and significant effect attributed to the random effect of Sample. 
Linear mixed model fixed and random effects, post-hoc tests for all significant fixed effects, and directional 
trends for all morphometric variables are included for aggregate porosity (Appendix XXI: “Micro-CT 
Linear Mixed Model for Aggregate Porosity”), femoral regions (Appendix XXII: “Micro-CT Linear 
Mixed Model for Femoral Regions”), and tibial regions (Appendix XXIII: “Micro-CT Linear Mixed 
Model for Tibial Regions”). 

Model fit was assessed with diagnostic plots (fitted vs. residuals plot, residual boxplot, random effect 
dotplots, QQ plot, scale-location plot) as well as a Shapiro-Wilk test for normality of residuals and a 
Levene’s test for Homogeneity of Variance. If residuals were not normally distributed (p < 0.05), 
morphometric variables were transformed with Tukey’s Ladder of Powers with package rcompanion. This 
function loops through lambda (Λ) exponents and transforms the data using the lambda that maximizes the 
W statistic of the Shapiro-Wilk test. The LMM was then re-run on the transformed morphometric variable 
with package lme4, and diagnostic plots and tests were re-assessed. Following this initial modeling, p-
values generated by the LMM model were checked against p-values generated by a generalized linear mixed 
model fitted with a Markov Chain Monte Carlo (MCMC) approach, to draw on the high accuracy of 
Bayesian modeling. We used package MCMCglmm with a parameter-expanded prior and 60,000 iterations. 
To assess LMM model fit, both Akaike information criterion (AIC) and Bayesian information criterion 
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(BIC) are reported. Additionally, the variance in the morphometric variable explained by the LMM was 
assessed with a pseudo R2 from package MuMIn. Marginal R2 is the variance explained by fixed factors, 
while Conditional R2 is the variance explained by the entire model, including fixed factors and random 
effects. Markov Chain Monte Carlo model fit was assessed based on effective sample size and traces of the 
fixed factors and random effects. 

For models that detected significant differences (p < 0.05) for fixed factors, post-hoc analyses were carried 
out to better understand the magnitude and importance of these differences. Package emmeans generated 
estimated marginal means to determine significant differences between factor levels for fixed factors. Effect 
size of each significant post-hoc comparison was quantified with Cohen’s d from function lme.dscore 
within package EMAtools. Cohen’s d is the absolute value of the difference between group means divided 
by the average of their standard deviations, such that a Cohen’s d of 1 corresponds to a single standard 
deviation between the means of the compared groups. Effect size thresholds are quantified as small (d = 
0.2), medium (d = 0.5), or large (d=0.8). Finally, a retrospective power analysis for each fixed factor was 
conducted with package simr. To examine all directional trends, estimated marginal means were also used 
to determine the relationship between all levels of each fixed factor, regardless of their significance. 

Results: Whole-Bone Analysis 

A concise summary of findings from whole-bone and regional analysis of the femur and tibia is available 
in Section 2.2.3: Significant Results. 

Opioid exposure inverts the Control group’s patterning of higher total porosity in the femur and lower total 
porosity in the tibia. This suggests that opioid treatment desensitizes skeletal elements to localized 
mechanical demands, which control intraskeletal variation in pore morphometry in healthy animals. 

Whole Bone Analysis: Bone Effects 

The rabbit femur has significantly thicker, larger diameter, larger volume, and larger surface area pores, 
compared to the rabbit tibia. The standard deviations of pore thickness and pore separation are also 
significantly larger, indicating a wider range of pore sizes. These enlarged pore systems result in 
significantly higher percentages of open porosity and a larger intersection surface, meaning convergence 
of pore systems with periosteal or endosteal borders. Skeletonization analysis indicated that the total and 
mean lengths of individual pore systems are significantly higher in the femur, compared to the tibia. 
Femoral pore systems are also more highly branched, with a significantly higher mean and maximum 
number of nodes and number of terminal nodes, and maximum number of segments within pore systems. 

The rabbit tibia has significantly smaller, more numerous, and more densely populated pores that are more 
longitudinally aligned, compared to the rabbit femur. This produces a significantly higher percentage of 
closed porosity, as pore systems are not as convergent with cortical borders. In terms of cross-sectional 
geometry, the tibia has a larger relative cortical volume, total and cortical surface area, and average minor 
axis breadth compared to the femur. 
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Considering all drug treatment groups, there is no net significant effect on Total Porosity (%) from either 
the increased size and branching of femoral pore systems, or the increased population density of tibial pore 
systems. Further analysis of the Bone * Drug Treatment Group interaction, discussed below, indicates that 
femoral pore patterning produces a significantly higher Total Porosity (%) within Control group rabbits. 
Drug treatment, however, inverts this intraskeletal patterning, removing this effect from Bone as a fixed 
factor. 

While information on comparative loading in the rabbit femur versus the tibia is sparse17, a study by 
Yamada and colleagues18 suggests that the rabbit tibia experiences higher residual stress than the femur. 
Residual stress is the stress experienced by bone tissue absent of external force, due to the inherent structure 
of the tissue and its mechanical properties. The authors found that osteon population density (OPD) was 
increased under higher residual stress, and that the anterior and posterior tibia had a higher combined OPD 
than the anterior and posterior femur. High OPD has been associated with a higher frequency of targeted 
remodeling to repair the microdamage more frequently incurred under high strain19,20. However, high strain 
also inhibits bone resorption, and is known to limit the size of osteons in cross-section21–23. The expected 
pore morphometry for a more highly stressed tibia is an increased density of pores that are smaller in size, 
which we observed in our study. The rabbit tibia is also known to be stronger than the femur, as 
demonstrated by the higher force required to fracture the tibia24. Pores concentrate stress and are target sites 
for fracture initiation and propagation25. The enlarged pore systems in the rabbit femur may contribute to 
its observed lower force to fracture, relative to the rabbit tibia.  

Whole Bone Analysis: Drug Treatment Group Effects 

Drug treatment restricts the overall diameter and volume of aggregate pore systems in both the femur and 
tibia. Control group rabbits exceed drug treatment group rabbits (Control > Morphine > Fentanyl) in 
morphometric variables that describe aggregate pore size (Mean and Standard Deviation of Pore 
Thickness), as well as mean size of individual pore systems (Average Pore Volume, Mean Pore System 
Total Volume, Pore Segment Mean Radius). Only the Control > Fentanyl comparison reaches significance 
(p < 0.05). Pore Surface : Pore Volume follows the inverse pattern (Fentanyl > Morphine > Control), which 
may be due to increased truncation. When the femur and tibia are examined individually in the interaction 
contrast (Bone | Group), both bones retain this trend (Control > Morphine > Fentanyl) for aggregate pore 
size. When the mean size of individual pore systems is examined, however, Morphine rabbits exceed 
Control group rabbits (Morphine > Control > Fentanyl) in the tibia, while retaining the original patterning 
in the femur. Consequently, in the tibia specifically, Morphine treatment enlarges individual pore systems. 

Whole Bone Analysis: Bone * Drug Treatment Group Interaction Effects 

As seen in the fixed factor Bone, the tibia favors small, dense pore systems while the femur favors large, 
less densely populated, more highly branched pore systems. Neither bone has higher total porosity or 
aggregate pore volume when drug treatment groups are combined. Intraskeletal differences, however, 
appear when the femur and tibia are contrasted within each drug group using the interaction contrast Group 
| Bone. When restricted to Control rabbits, the femur develops significantly higher Total Porosity (%) and 
Pore Volume, compared to the tibia. The Control femur also displays significantly higher maximum values 
for pore system branching (Total Length, Number of Nodes, Terminal Nodes). Control rabbits additionally 
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retain the overall Bone effects of significantly higher Open Porosity (%) and size and branching of 
individual pore systems (Total Pore Network Volume, Average Pore Volume, Mean Pore System Total 
Length, Mean Pore System Terminal Nodes), compared to the tibia. Drug treatment, however, silences this 
significant intraskeletal variability. For Fentanyl and Morphine group rabbits, there is no significant 
difference between the Femur and Tibia in these same morphometric variables, even though the direction 
of the trend is the same (Femur > Tibia). Pore Volume goes furthest by inverting this trend, with an 
insignificant shift to Femur < Tibia in both Fentanyl and Morphine rabbits. Overall, drug treatment appears 
to equalize the porosity, pore size, and branching complexity of the femur and tibia, removing the 
significantly increased femoral porosity that exists in Control rabbits. 

Drug treatment minimizes this intraskeletal variation both by reducing femoral porosity and increasing 
tibial porosity. This effect is visible in 3D reconstruction (Figure 2). The Bone | Group interaction contrast 
shows the effects of drug treatment on the femur and tibia individually. As before, in the femur, Control 
groups have significantly higher Total Porosity (%) and Open Porosity (%), in addition to significantly 
higher metrics of aggregate volume (Pore Volume, Total Pore Network Volume) and size and branching of 
individual pore systems (Pore Segment Mean Radius, Mean Pore System Total Length, Mean Pore System 
Terminal Nodes), compared to drug treatment groups (Control > Morphine > Fentanyl). Descriptive 
statistics indicate that femoral mean values for each of these variables are decreased in Morphine and 
Fentanyl rabbits, compared to Controls. Conversely, in the tibia, drug treatment increases these same pore 
measurements. Morphine is elevated above Control group rabbits (Morphine > Control > Fentanyl) in the 
tibia for Open Porosity (%), Average Pore Volume, Pore Segment Mean Radius, Total Pore Network 
Volume, and Mean Pore System Total Length. Both Morphine and Fentanyl are elevated above Control 
group rabbits (Morphine > Fentanyl > Control) for Total Porosity (%), aggregate Pore Volume, and Mean 
Pore System Terminal Nodes. Only the femoral trends, however, (Control > Fentanyl and Control > 
Morphine) reach significance (p < 0.05). Our results confirm that the overall effect of reduced femoral 
porosity and increased tibial porosity is to equalize intraskeletal porosity under drug treatment. 

Results: Regional Analysis: Femur 

Regional Analysis: Femur: Region Effects 

In the rabbit femur, the high porosity derived from larger pore size is localized in the Medial and Posterior 
quadrants, as observed in 3D visualization (Figure 2). High pore density is localized in Medial and Lateral 
quadrants. The relatively smaller pore size in the Lateral quadrant, however, prevents it from accruing high 
overall porosity. 

The Medial quadrant, followed without significant difference by the Posterior quadrant, contains the highest 
Total Porosity (%), Open Porosity (%), and Connectivity Density. Cortical Fractal Dimension and Pore 
Fractal Dimension, which signify more patterned spatial distribution, are highest medially, followed with 
significant difference by the Posterior quadrant. Similarly, the Posterior quadrant, followed without 
significant difference by the Medial quadrant, contains the largest pores by aggregate and individual 
measurements (Number of Open Pores, Pore Volume, Pore Surface, Pore Thickness, Connectivity, Average 
Pore Volume). In all comparisons, Anterior and Lateral quadrants have significantly lower percent porosity 
and pore size. 
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The Medial quadrant, followed without significant difference by the Lateral quadrant, displays increased 
pore density of all pore types (total, open, closed). Closed Porosity (%) is also highest medially, followed 
with significant difference by the Lateral quadrant. Pore Surface: Pore Volume is highest laterally, followed 
with significant difference by the Medial quadrant. 

The Anterior quadrant shows significantly increased Pore Separation (mean and standard deviation), 
because it also significantly exceeds all except the Posterior region in Cortical Volume, and thus pore 
systems are more widespread. 

Our findings are consistent with literature on rabbit knee joint biomechanics. During hopping, initial 
hindlimb contact causes the ground reaction force (GRF) to pass Anterior and Lateral to the knee joint. 
Intersegmental axial knee force also increases sharply during this initial hindlimb contact, peaking at 40% 
of body weight between 15-25% of the stance trajectory17. The relatively lower mechanical loading 
experienced by Medial and Posterior regions of the rabbit femur is more permissive to bone resorption23,26, 
creating the significantly higher percent porosity and larger pore size that we observed in those regions. We 
further observed a significantly higher pore density in both Medial and Lateral quadrants of the rabbit 
femur. High pore density combined with high porosity and large pore size in the Medial quadrant is 
consistent with stochastic remodeling, which is elevated under lower mechanical strain for routine turnover 
of old bone27. High pore density combined with low porosity and small pore size in the Lateral quadrant is 
consistent with targeted remodeling, which occurs in a limited radius (~100 µm) for repair of loading-
induced microcracks28. 

Regional Analysis: Femur: Drug Treatment Group Effects 

The pattern Control > Morphine > Fentanyl is seen for variables related to increased pore size (Pore 
Thickness Mean and Standard Deviation) and convergence with cortical borders (Open Porosity (%), 
Intersection Surface), with the Control > Fentanyl comparison reaching significance. 

Regional Analysis: Femur: Region * Drug Treatment Group Effects 

Comparable to the whole bone analysis, drug treatment tends to silence the regional variability observed in 
the Control group. The Group | Region interaction contrast examines regional comparisons within each 
drug treatment group. The significant regional differences seen in Control rabbits are insignificant for 
certain variables in Fentanyl rabbits (Open Porosity %) and for both Fentanyl and Morphine rabbits (Total 
Porosity %, Average Pore Volume, Intersection Surface). If drug treatment can reduce sensitivity to 
mechanical control of pore formation at the whole bone level, it further appears to reduce sensitivity to 
regional mechanical loading within the femoral cross-section.     

The reduced porosity associated with drug treatment seen in femoral whole-bone analysis is concentrated 
in Anterior and Medial regions. The Region | Group contrast examines drug treatment group differences 
within each region. For Total Porosity (%), the Control group rabbits only significantly exceed drug 
treatment rabbits in the Medial quadrant, although all quadrants display this pattern (Control > Morphine > 
Fentanyl). Similarly, for Open Porosity (%), this pattern is significant medially (Control > Fentanyl) and 
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anteriorly (Control > Fentanyl and Control > Morphine). For the inverse patterning of Pore Surface: Pore 
Volume (Fentanyl > Morphine > Control), Medial and Anterior quadrants show a significant Fentanyl > 
Control difference. 

Results: Regional Analysis: Tibia 

Regional Analysis: Tibia: Region Effects 

Regional porosity patterning in the rabbit tibia reflects that of the femur. The Medial and Posterior quadrants 
again show high percent porosity. Also, as in the femur, both the Medial and Lateral quadrants favor high 
pore density, but the relatively smaller pore size in the Lateral quadrant prevents it from accruing high 
overall porosity. Two trends distinguish the tibia from the femur. Unlike the femur, large pore size is 
restricted to the Posterior quadrant of the tibia, while the Medial quadrant draws its high porosity from high 
pore density. Also, the tibia shifts the absolute number of pores and connectivity metrics from the Medial 
and Posterior quadrants to the Anterior quadrant, but there is no net effect on porosity or pore density 
patterning due to the large Anterior quadrant volume. 

The Medial quadrant, followed by the Posterior quadrant, contains the highest metrics of spatial complexity 
(Cortical Fractal Dimension, Pore Fractal Dimension, Pore Surface : Cortical Volume. Similarly, the 
Posterior quadrant, followed by the Medial quadrant, contains the highest percentages of all types of 
porosity (Closed, Open, Total), and several other metrics (Pore Volume, Intersection Surface). 

The Posterior quadrant dominates metrics of pore size (Pore Thickness, Pore Thickness Standard Deviation, 
Average Pore Volume / Surface / Thickness / Major Pore Diameter). It also shares a high Degree of 
Anisotropy with the Anterior quadrant. 

The Medial quadrant, followed by the Lateral quadrant, displays increased open pore density and Pore 
Tb.N., a proxy of total pore density. The Lateral quadrant, followed by the Medial quadrant, has 
significantly higher closed and total pore density than other quadrants. 

The Anterior quadrant has the highest number of pores (closed, open, total), the highest connectivity and 
connectivity density, and the highest Pore Surface. These metrics are highest in the Medial and Posterior 
quadrants in the femur. However, as in the femur, the Anterior quadrant spreads its pore systems through a 
larger Cortical Volume, maximizing Pore Separation Mean and Standard Deviation. Consequently, the 
Anterior quadrant does not reach a high percent porosity or pore density. 

Our findings are consistent with literature on rabbit knee joint biomechanics. As with the rabbit femur, the 
Anterior and Lateral regions experience higher mechanical loading by an adjacent ground reaction force 
(GRF) during initial hindlimb contact while hopping17. The higher porosity that we observed in Medial and 
Posterior quadrants is consistent with their relatively lower mechanical loading. As with the rabbit femur, 
the high pore density and high porosity of the Medial tibial quadrant is consistent with stochastic 
remodeling, while the high pore density and low porosity of the Lateral tibial quadrant is consistent with 
targeted remodeling. 
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Regional Analysis: Tibia: Drug Treatment Group Effects 

Unlike the femur, there are no overall drug treatment group effects on pore morphometry. 

Regional Analysis: Tibia: Region Effects 

As in the femoral regional analysis and the whole bone analysis, drug treatment tends to silence the regional 
variability seen in the Control group. A unique tibial effect is the additional elevation of porosity anteriorly 
(Fentanyl) and pore density laterally (Fentanyl and Morphine). This supports the whole-bone analysis 
finding that drug treatment increases porosity in the tibia, contributing to the overall loss of intraskeletal 
variability in porosity.  

The Group | Region interaction contrast examines regional comparisons within each drug treatment group. 
As in the femur, drug treatment removes significant intra-regional comparisons that exist in Control group 
tibiae for a variety of pore metrics. The loss of regional variability, with no distinct regional elevation to 
compensate, is generally seen in metrics or proxies of pore size for Fentanyl rabbits (Pore Thickness, Pore 
Surface : Cortical Volume), Morphine rabbits (Number of Open Pores), or both groups (Average Major 
Pore Diameter). An additional effect seen in the tibia is that Fentanyl group rabbits tend to increase anterior 
porosity while diminishing significant differences between other regions for a number of morphometric 
variables (Open Porosity (%), Total Porosity (%), Pore Volume, Pore Surface, Intersection Surface, 
Number of Objects, Connectivity Density). This anterior porosity increase can be clearly observed in the 
3D visualization of a Fentanyl rabbit tibia (Figure 2). Both Morphine and Fentanyl rabbits also elevate 
lateral pore density (closed and total) at the expense of other regional variability. Finally, drug treatment 
represses pore system complexity posteriorly for Fentanyl group rabbits (Pore Tb.N, Pore Fractal 
Dimension) and anteriorly for Morphine group rabbits (Pore Surface : Cortical Volume, Pore Fractal 
Dimension). 

The Region | Group contrast examines drug treatment group differences within each region. Whole bone 
analysis suggests that drug treatment reduces aggregate Pore Thickness in the femur and tibia, although the 
size of individual pore systems may be increased in the tibia. In the femur, decreased Pore Thickness is a 
group level effect that is consistent across all regions (Control > Morphine > Fentanyl). In the tibia, 
however, only the Posterior quadrant displays this patterning (Control > Morphine > Fentanyl), and only 
Control > Fentanyl is significant. All other quadrants conversely show elevated Pore Thickness with drug 
treatment (Morphine > Fentanyl > Control). This may help explain how individual pore systems can be 
larger, but overall mean Pore Thickness is significantly smaller with drug treatment. Aggregate Pore 
Volume has a sole significant contrast of Morphine > Fentanyl in the Posterior region. 

The sensitivity of Anterior and Lateral quadrants to drug treatment is consistent with the literature. Yamane 
and colleagues29 found that osteoporosis induced by parathyroid hormone administration developed 
porosity preferentially in tibial regions corresponding to our Anterior and Lateral quadrants.  

Following only 8 weeks of opioid administration, our ongoing rabbit study confirms our hypothesis that 
opioids significantly alter bone porosity and pore morphometry, producing substantial alterations to 
bone microarchitecture. 
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Data analysis of the micro-CT imaging phase of the project proceeded on schedule beginning February 
2020. This timeline was not impacted by the COVID-19 pandemic as statistical workflows could be 
employed remotely. Histological sample processing and imaging were completed on 11/20. The protocol 
for histological analysis of pore and osteon spaces was developed during the subsequent reporting period. 
Data analysis of histological images has been completed. Drafting manuscript submissions will follow per 
the proposed revised timeline. 

Femoral Histological Data Analysis 

Morphometric Variable Calculations 

The OsteoFlo toolkit automatically exports values for each section’s cross-sectional geometry and 
mineralizing surface (Ps.MS/BS and Es.MS/BS). Vascular percent porosity, pore counts, and mean pore 
size and shape morphometry are also automatically exported. Finally, automatic exports for each osteon 
type include counts, mean inter-label distance, mean wall thickness, and size and shape morphometry. 

Population densities were calculated for vascular pores and for each osteon type, which included total 
osteons (T.On), complete (calcein-labeled) osteons (C.On), forming osteons (F.On), single-labeled osteons 
(sL.On), double-labeled osteons (dL.On), triple-labeled osteons (tL.On), unlabeled resorption cavities 
(Rs.N), and active remodeling centers (T.On + Rs.N) (a.Rm.Cr). Osteon population densities for each 
osteon type were calculated by dividing the osteon type separately by the cortical area (e.g., T.On.OPD.CA) 
and by the remodeling area (e.g., T.On.OPD.RA). 

Additional values were calculated to characterize remodeling rate, following Dr. Andronowski’s previous 
work published in Harrison et al. 202030. This study had three calcein administrations, while Harrison et 
al. 202030 had two calcein administrations. Therefore, our calculations were modified to accommodate our 
study’s triple-labeled osteons, and to characterize any differences between labeling periods 1-2 and 2-3. 
Our calculations included: 

• Ratio of labeled osteons versus resorption cavities (T.On / Rs.N) 
• Osteonal mineral apposition rate (On.MAR, μm/day), calculated as the inter-label distance divided 

by the labeling period (14 days). Several calculations were explored to determine whether this 
variable and dependent variables changed over the experimental period. 

o On.MAR.dL – calculated from dL.On only 
o On.MAR.I – calculated from the mean distance of inner labels of dL.On and tL.ON 
o On.MAR.C – calculated from the mean distance of both inner labels (dL.On and tL.On) 

and outer labels (tL.On) 
• Osteon formation time (σf, days), calculated as wall thickness divided by On.MAR. We calculated 

this variable using wall thickness for complete osteons (W.Th.C) divided by each calculation of 
On.MAR. 

o σf dL = W.Th.C / On.MAR.I.dL 
o σf I = W.Th.C / On.MAR.I 
o σf C = W.Th.C / On.MAR.C 
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• Activation frequency (Ac.f, #/mm2/year), calculated as complete (sL.On + dL.On + tL.On) osteon 
population density (C.On.OPD.CA) divided by σf, multiplied by 365 days/year. We calculated this 
variable for value of osteon formation time derived from each calculation of On.MAR. 

o Ac.F.I.dL ((C.On.OPD.CA/ σf dL)*365) 
o Ac.F.I ((C.On.OPD.CA/ σf I)*365) 
o Ac.F.I.dL ((C.On.OPD.CA/ σf C)*365) 

Descriptive statistics of mean, median, and standard deviation were generated for each morphometric 
variable in R (The R Foundation, v. 4.1.1) with package dplyr. Descriptive statistics were generated by 
Drug Group for whole-bone comparisons, and by Region and Region * Drug Group for anatomical quadrant 
comparisons (Appendix XXIV: “Femoral Histology Descriptive Statistics”). 

Statistical Model Design: Whole Femur 

Aggregate variables for cross-sectional geometry, mineralizing surface, vascular pore morphometry, and 
osteon pore morphometry were assessed in R (The R Foundation, v. 4.1.1) using an ANOVA from the stats 
package with the formula Morphometric Variable ~ Drug Group. The ANOVA output is the degrees of 
freedom (df), sum of squares, mean squares, F-statistic, and p-value. Model fit was assessed with diagnostic 
plots (fitted vs. residuals plot, QQ plot) as well as a Shapiro-Wilk test for normality of residuals and a 
Levene’s test for Homogeneity of Variance. If residuals were not normally distributed or were 
heteroskedastic (p < 0.05), morphometric variables were transformed with Tukey’s Ladder of Powers with 
package rcompanion. This function loops through lambda (Λ) exponents and transforms the data using the 
lambda that maximizes the W statistic of the Shapiro-Wilk test. The ANOVA was then re-run on the 
transformed morphometric, and diagnostic plots and tests were re-assessed. If the residuals remained non-
normal or heteroskedastic, the model was tested using a non-parametric Kruskal-Wallis Rank Sum Test 
from the stats package. 

For models that detected significant differences (p < 0.05) for Drug Group, post-hoc analyses were carried 
out to determine which pairwise differences were significant and assess model goodness-of-fit. For 
morphometric variables assessed with ANOVA, pairwise comparisons were performed using a Tukey 
Honest Significant Differences (Tukey HSD) test from the stat package. The output of this test includes an 
estimate for the differences in observed means, upper and lower confidence intervals, and a p-value adjusted 
for multiple comparisons. Package sjstats gave partial eta squared (ηp

2), which describes the percentage of 
variance in the morphometric variable derived from the Drug Treatment group, and partial omega squared 
(ωp²), which provides an effect size for Drug Treatment group that is unbiased for small sample sizes (0.01 
= Very Small, 0.06 = Small, 0.14 = Medium, >0.14 = Large). A retrospective power analysis was obtained 
the partial omega squared effect size using package userfriendlyscience. For models assessed with Kruskal-
Wallis, pairwise comparisons were obtained from a Dunn test with a Bonferroni correction for multiple 
comparisons from package rstatix. Eta-squared was obtained from package rstatix, and a retrospective 
power analysis was carried out using package MultNonParam. 

The ANOVA tables, post-hoc results, and directional trends are included in Appendix XXV: “Histology 
ANOVA for Whole-Section Femur”. 
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Statistical Model Design: Regional Femur 

Regional distribution of cross-sectional geometry, mineralizing surface, vascular pore morphometry, and 
osteon pore morphometry was assessed in R (The R Foundation, v. 4.1.1) using a Linear Mixed Model 
(LMM). This model was chosen to account for the random effect of sample ID in the repeated measurement 
of different anatomical regions. The LMM formula was Morphometric Variable ~ Region * Drug Group + 
(1|Sample). We used the same LMM statistical workflow that we developed for regional and drug treatment 
group comparisons for micro-CT samples. 

The LMM tables, post-hoc results, and directional trends are included in Appendix XXVI: “Histology 
Linear Mixed Model for Regional Femur”. 

Results: Whole Femur Analysis 

A concise summary of findings from whole-bone and regional analysis of the femur is available in Section 
2.2.3: Significant Results. 

Whole-section analysis of the femur found that intracortical remodeling was significantly elevated in 
morphine rabbits and significantly reduced in fentanyl rabbits, compared to controls. Regional analysis of 
the femur found that population density and mean size were depressed Laterally for vascular pores and 
osteon types. The interaction between Region and Drug Group demonstrated that drug treatment 
significantly dysregulates regional patterning, particularly along the Medial-Lateral axis compared to the 
Anterior-Posterior axis. This regional dysregulation was also observed in micro-CT of vascular pore 
morphometry in the rabbit femur. 

Whole Femur Analysis: Drug Treatment Group Effects 

No significant variation between drug treatment groups was observed in cross-sectional geometry, 
periosteal or endosteal labeling, or any aspect of vascular porosity, including percent porosity, pore density, 
or pore morphometry. Additionally, no significant differences were observed between drug treatment 
groups in osteon morphometry, osteon formation time, or activation frequency.  

Drug treatment groups did significantly differ in osteon type counts and population densities. This 
invariably followed the pattern Morphine > Control > Fentanyl, with Morphine > Fentanyl always reaching 
significance and Morphine > Control sometimes approaching significance. Although the same pattern 
(Morphine > Control > Fentanyl) was observed for activation frequency, these comparisons do not reach 
significance for an elevation in Morphine group remodeling rate. However, Morphine group rabbits do 
reach significance over Fentanyl group rabbits for % Remodeling Area (ηp

2 = 32.2%, power = 60.3%) 
suggesting that Morphine group elevated osteon counts and population densities are due to their expansion 
of the remodeling region within the cortex. 

The Morphine > Fentanyl significant post-hoc comparison was observed for osteon counts of total osteons 
(approaches significance; ηp

2 = 37.7%, power = 98.4%), complete (single/double/triple labeled) osteons 
(approaches significance; ηp

2 = 35.3%, power = 97.3%), double-labeled osteons (ηp
2 = 56.3%, power = 
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99.7%), and active remodeling centers (unlabeled Rs.N + total osteons) (Morphine > Fentanyl and 
Morphine > Control both approach significance; ηp

2 = 35.8%, power = 97.6%). 

The Morphine > Fentanyl significant post-hoc comparison was observed for osteon population densities 
of total osteons (approaches significance; ηp

2 = 49.4%, power = 97.9%), complete (single/double/triple 
labeled) osteons (approaches significance; ηp

2 = 36.5%, power = 97.9%), and active remodeling centers 
(unlabeled Rs.N + total osteons) (Morphine > Fentanyl and Morphine > Control both approach significance; 
ηp

2 = 49.1%, power = 97.6%). 

Additionally, the mean outer label distance for triple-labeled osteons approached significance for Morphine 
> Fentanyl and Control > Fentanyl (ηp

2 = 50.8%, power = 98.5%). 

Results: Regional Femur Analysis 

Regional Femur Analysis: Regional Effects 

Regional analyses found that the Lateral quadrant of the femur had significantly lower values for 
remodeling area fraction, vascular percent porosity and pore density, osteon type counts and population 
densities, pore and osteon type mean areas, and all calculations of activation frequency. Conversely, the 
Lateral quadrant of the femur is significantly elevated in aspects of osteon circularity, compared to other 
quadrants. This suggests that the frequency and extent of secondary remodeling is suppressed in the Lateral 
quadrant, compared to other quadrants, particularly the Posterior quadrant. This finding is consistent with 
our micro-CT results, which found significantly reduced porosity and pore size in the Lateral quadrant of 
the rabbit femur. Again, Lateral repression of remodeling may stem from its high mechanical loading by 
the adjacent ground reaction force. 

While our micro-CT results found significantly elevated pore density in the Medial and Lateral quadrants, 
our histological results found that the Anterior, Posterior, and Medial quadrants all significantly exceeded 
the Lateral quadrant in pore density. This difference may stem from measuring pores throughout the cortex 
in micro-CT, but only within the remodeling area in histological analysis. Significant regional trends 
included the following patterns: 

Significant Lateral Region Depression 

Anterior > Lateral 
• sL.On/CA (sL.On.OPD.CA) 

Posterior > Lateral 
• tL.On Count 
• sL.On Mean Area 

Medial > Lateral 
• Mean pore area 
• Mean pore perimeter 
• Mean Pore Min Feret Diameter 

Anterior > Lateral 
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• Mean pore circularity 
• Mean pore roundness 

Anterior and Posterior > Lateral 
• C.On Count 
• sL.On Count 
• F.On/CA (F.On.OPD.CA) 
• Ac.F.I.dL 
• Ac.F.I 
• Ac.F.C 

Medial, Posterior > Lateral 
• T.On Mean Area 
• C.On Mean Area 

Anterior, Medial, Posterior > Lateral 
• Percent porosity 
• Pore density CA 
• dL.On Count 
• F.On Mean Area 
• dL.On Mean Area 
• a.Rm.Cr/CA (a.Rm.Cr.OPD.CA) 
• T.On/CA (T.On.OPD.CA) 
• C.On/CA (C.On.OPD.CA) 
• dL.On/CA (dL.On.OPD.CA) 

Anterior and Posterior > Lateral and Medial 
• Cortical Area 

Posterior > Anterior, Medial, Lateral + Anterior > Lateral 
• Remodeling Area 
• RA/CA 

Anterior, Medial, Posterior > Lateral + Posterior > Medial 
• Total pore number 
• Total pore area 
• Total osteon count 
• Forming osteon count 

Significant Lateral Region Elevation 

Lateral > Medial, Anterior 
• Mean pore aspect ratio 

Lateral > Medial, Posterior 
• T.On Mean Circularity 
• T.On Mean Solidity 
• C.On Mean Circularity 
• dL.On Mean Circularity 

Lateral > Anterior, Medial, Posterior 
• C.On Mean Solidity 
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Regional Femur Analysis: Drug Group Effects  

Isolated from the regional effect, Drug Group showed significant Morphine > Fentanyl patterning for a 
subset of the variables identified in the whole-bone analysis: 

• RA/CA 
• C.On/CA (C.On.OPD.CA) 
• dL.On Count 
• dL.On/CA (dL.On.OPD.CA) 
• tL.On Mean Outer Label 

Regional Femur Analysis: Regional Effects Within Drug Groups 

Our post-hoc analyses assessed the regional patterning within each drug treatment group individually. As 
seen in the micro-CT results, drug treatment significantly dysregulates regional patterning of remodeling-
derived microstructures, compared to controls. Morphine and Fentanyl group rabbits lost some significant 
regional patterns seen in Controls, and gained certain significant regional patterns not seen in Controls. 
These deviations almost always altered the morphometry along the Anterior-Posterior axis compared to the 
Medial-Lateral axis. Gain of significant regional variation was more common in Fentanyl group rabbits 
than Morphine group rabbits. 

Regional Differences Lost Compared to Controls 

Forming Osteon Count 
• Anterior > Medial: lost by Morphine and Fentanyl 
• Posterior > Medial: lost by Fentanyl 

sL.On Count 
• Anterior > Medial: lost by Morphine and Fentanyl 
• Posterior > Medial: lost by Fentanyl 

C.On Mean Wall Thickness 
• Medial > Lateral: lost by Morphine and Fentanyl 

dL.On Mean Wall Thickness 
• Anterior, Medial, Posterior > Lateral: lost by Morphine and Fentanyl 

C.On Mean Area 
• Anterior, Medial > Lateral: lost by Morphine and Fentanyl 

F.On Mean Aspect Ratio: 
• Medial > Anterior: lost by Morphine and Fentanyl 

sL.On/CA (sL.On.OPD.CA) 
• Anterior > Medial: lost by Morphine and Fentanyl 

sL.On/RA (sL.On.OPD.RA) 
• Anterior and Lateral > Medial: lost by Morphine and Fentanyl 

Regional Differences Gained Compared to Controls 

F.On Count 
• Medial > Lateral: gained by Fentanyl 

sL.On Count 
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• Medial > Lateral: gained by Morphine and Fentanyl 
• Posterior > Lateral: Morphine and Fentanyl 

Unlabeled Resorption Space Count (Rs.N) 
• Anterior and Posterior > Lateral: gained by Fentanyl 
• Posterior > Medial: gained by Fentanyl 

C.On Mean Wall Thickness 
• Medial > Lateral, Anterior: gained by Morphine 

sL.On Mean Wall Thickness 
• Posterior, Anterior > Lateral: gained by Fentanyl 
• Posterior, Medial > Anterior: gained by Morphine 

tL.On Mean Wall Thickness  
• Medial > Anterior: gained by Morphine 

C.On Mean Aspect Ratio 
• Medial > Lateral and Posterior: gained by Fentanyl 

F.On Mean Aspect Ratio 
• Posterior > Anterior, Lateral: gained by Fentanyl 

sL.On Mean Area 
• Anterior > Lateral: gained by Fentanyl 
• Posterior > Medial and Lateral: gained by Fentanyl 
• Medial > Anterior: gained by Morphine 

sL.On Mean Solidity 
• Anterior > Lateral: gained by Fentanyl 

dL.On Mean Aspect Ratio 
• Medial > Posterior: gained by Fentanyl 

dL.On Mean Roundness 
• Posterior > Medial: gained by Fentanyl 

dL.On Mean Solidity 
• Lateral > Medial and Posterior: gained by Fentanyl 

sL.On/CA (sL.On.OPD.CA) 
• Anterior and Medial > Lateral: gained by Fentanyl 

Rs.N/CA (Rs.N.OPD.CA) 
• Posterior > Lateral: gained by Fentanyl 

a.Rm.Cr/RA (a.Rm.Cr.OPD.RA) 
• Anterior, Medial, Posterior > Lateral: gained by Fentanyl 

T.On/RA (T.On.OPD.RA) 
• Anterior and Medial > Lateral: gained by Fentanyl 

sL.On/RA (sL.On.OPD.RA) 
• Anterior and Medial > Lateral: gained by Fentanyl 

Rs.N/RA (Rs.N.OPD.RA) 
• Anterior and Posterior > Lateral: gained by Fentanyl 

Osteon Formation Time (W.Th.C / On.MAR.I.dL) 
• Lateral > Medial: gained by Fentanyl 
• Medial > Anterior: gained by Morphine 

Osteon Formation Time (W.Th.C / On.MAR.I) 
• Medial > Anterior: gained by Morphine 

Osteon Formation Time (W.Th.C / On.MAR.C) 
• Lateral > Anterior and Medial: gained by Fentanyl 
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Regional Femur Analysis: Drug Group Effects Within Regions 

Our post-hoc analyses assessed differences between drug treatment groups within each individual region. 
Differences between drug treatment groups in osteon type morphometry were concentrated in Medial and 
Lateral regions. For aspects of osteon morphometry associated with resorption spaces (F.On Count, Rs.N), 
the Posterior region additionally showed drug treatment group differences. This is consistent with its 
elevated percent porosity and pore size seen in both micro-CT and histological results. 

Regional Drug Treatment Group Patterns 

Morphine > Fentanyl 
• F.On Count: Lateral and Posterior 
• sL.On Mean Wall Thickness: Lateral and Medial 
• tL.On Mean Wall Thickness: Medial 
• sL.On Mean Solidity: Lateral 
• a.Rm.Cr/RA (a.Rm.Cr.OPD.RA): Lateral 

Morphine > Control 
• F.On Count: Medial and Posterior 
• tL.On Mean Wall Thickness: Medial 

Fentanyl > Control 
• sL.On Count: Medial 
• dL.On Mean Wall Thickness: Lateral 
• Unlabeled Resorption Space Count (Rs.N): Posterior 
• sL.On/CA (sL.On.OPD.CA): Medial 
• sL.On/RA (sL.On.OPD.RA): Medial 
• Osteon Formation Time (W.Th.C / On.MAR.I): Lateral 
• Osteon Formation Time (W.Th.C / On.MAR.C): Lateral 

Control > Fentanyl 
• sL.On Mean Wall Thickness: Lateral 
• C.On Mean Area: Medial 
• sL.On Mean Area: Medial 
• sL.On Mean Solidity: Lateral 
• dL.On Mean Solidity: Anterior and Lateral 
• a.Rm.Cr/RA (a.Rm.Cr.OPD.RA): Lateral 
• T.On/RA (T.On.OPD.RA): Lateral 

Control > Morphine 
• C.On Mean Area: Anterior 
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Activity 5: Manuscript preparation and knowledge dissemination 
Projected Completion Dates: 07/20 – 12/20 
Revised Completion Dates: 06/21 – 09/21 

Progress: 100% as per proposed revised timeline 

Planned Scholarly Product 

Planned scholarly products include manuscript submissions to competitive peer-reviewed scientific 
journals. The results of the proposed application and limitations of this research will be published in journals 
targeting forensic specialists such as forensic anthropologists and archaeologists, missing persons 
detectives, and crime scene personnel. To reach forensic practitioners and the general forensic science 
community, scientific journals will include Journal of Forensic Sciences, Forensic Anthropology, and 
Forensic Science International. 

The proposed work is also of interest to the bone biology and biomedical imaging communities. As such, 
Dr. Andronowski intends to target these groups through discipline specific journals such as the Journal 
of Anatomy, Bone, Journal of Bone and Mineral Research, Micron, and the Anatomical Record. 

Dissemination Strategy 
The ultimate goal of the Andronowski Group is to further understandings of how bone remodeling is related 
to age-related change using high-resolution imaging modalities (e.g., micro-CT and SR micro-CT), while 
simultaneously generating and disseminating new scientific knowledge. To broadly disseminate the 
findings and reach a wide variety of specialists within forensic science and the criminal justice system, law 
enforcement and legal personnel, medical examiners, forensic anthropologists and forensic archaeologists, 
initial results will be presented at the annual American Academy of Forensic Sciences Annual Scientific 
Meeting. For a more targeted audience, results will be presented at the annual Canadian Bone and Joint 
Conference hosted by the University of Western Ontario’s Bone and Joint Institute or the American Society 
for Bone and Mineral Research Annual Meeting. These conferences bring together experts from across 
disciplines committed to interdisciplinary and high-impact research related to bone-affecting conditions 
and their treatment. 

In addition, Dr. Andronowski routinely travels to the Canadian Light Source (CLS) synchrotron facility 
located on The University of Saskatchewan campus to run synchrotron imaging experiments and 
collaborate on other research projects. She will further disseminate the information learned through this 
venue and reach a number of bone imaging specialists and musculoskeletal researchers in the Department 
of Anatomy, Physiology, and Pharmacology. Lab members Dr. Andronowski, Dr. Cole, Reed Davis, and 
Gina Tubo traveled to the CLS in August 2019 and December 2019 for imaging experiments related to a 
concurrent project. Due to the COVID-19 pandemic and associated restrictions to international travel, 
further planned synchrotron experiments were on hold from April 2020 – June 2021.The Andronowski Lab 
was able to travel to CLS once again in September 2021 for imaging time related to various other research 
projects. 

Additional manuscript preparations and data dissemination continue to be underway.  
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A manuscript documenting the findings from Activities 1 and 2 titled ‘Rabbits (Oryctolagus cuniculus) as 
a Model System for Longitudinal Experimental Opioid Treatments: Implications for Orthopedic and 
Biomedical Research’ was recently published in a special issue in the journal Osteology (Appendix X). All 
members of the research team contributed. Additional manuscripts describing micro-CT and histology 
results, and the associated software packages developed for this software, are currently in preparation. 

Activity 6: Project management (Andronowski) 
Projected Completion Dates: 01/01/19 – Present 

Progress: 100% complete as per proposed revised timeline 

The study was managed through the Department of Biology at The University of Akron. The Principal 
Investigator (Dr. Andronowski) provided overall project direction and coordination, contributed to 
methods and data review. Andronowski prepared quarterly and semi-annual reports to the Office of 
Justice Programs (OJP), and continues to prepare conference abstracts, and data for journal submissions 
and other forms of dissemination. She was further responsible for overall project management and 
coordination. Dr. Andronowski trained and supervised a Post-doctoral Fellow (Dr. Mary Cole), Graduate 
Research Assistant (Reed Davis), Undergraduate Research Assistant (Adam Schuller), and Tiered 
Mentoring Undergraduate Students (Gina Tubo, Abigail LaMarca, and Josh Taylor) at The University of 
Akron, and certified that milestones were met, and ensured the timely submission of quarterly and semi-
annual reports to OJP. 

Project management proceeded as per the revised schedule with 100% completion as of the end of the 
no-cost extension, 08/31/21. 

2.2.2. Specific Objectives 

Nothing to report. 

2.2.3. Significant Results, including Major Findings, Developments, or Conclusions 

During the experimental dosing period (05/19 – 06/19), our research team developed more specific standard 
operating procedures for patch application to rabbits. Initially, the fentanyl group and the Tegaderm 
adhesive patch control rabbits were administered the patch with no additional covering. Following the first 
few days of treatment, the rabbits were able to remove their experimental manipulations, either by 
scratching with the hind limb or removal via the teeth. This complication was unanticipated given the prior 
literature. We procured mesh rabbit jackets from the attending veterinarian to cover the patch application 
site. In addition, one rabbit was fitted with a cloth-covered foam collar to counter excessive chewing of the 
jacket. Certain other rabbits further chewed the mesh surrounding the forelimb openings of the jackets, and 
in these cases, the research team applied veterinary bandage wrap beneath the jacket to reduce friction 
against the fur/skin of the animals. The adhesive from the fentanyl patches further left a residue on the 
rabbits’ skin. After a thorough literature review and discussions with the attending veterinarian, our team 
initiated the use of petroleum jelly and/or triple antibiotic ointment to soften the remaining adhesive and 
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treat any abrasions that resulted from an animal’s attempt to remove the restraint jacket, veterinary bandage 
wrap, or patch with hind limb scratching. This tailored operating protocol will benefit future rabbit research 
by the Andronowski Lab and other research groups. 

During reporting period ending 12/31/19, our research team developed specific standard operating 
procedures and image processing workflows for the 3D imaging of cortical bone porosity and trabecular 
architecture (Appendices I-III). Drs. Cole and Andronowski further developed custom macros for the 
image analysis programs ImageJ and CTAnalyser (Appendices XIV - XV). These scripts automatically 
extract low-contrast cortical pore spaces from micro-CT images, create masks of cortical area and total area 
to serve as regions of interest, and define morphometric measurements for pore morphometry and cross-
sectional geometry. Dr. Cole also developed a macro for ImageJ that divides cortical area masks into 
Anterior, Posterior, Medial, and Lateral regional quadrants using the section centroid. These data will 
facilitate analysis of regional variation in pore distribution and geometry, which may be associated with 
drug treatment group. Drs. Cole and Andronowski further developed statistical workflows for R that fully 
automate linear mixed model analyses, post-hoc testing, and graphic display. 

These tailored operating protocols will benefit future desktop bone imaging research by the Andronowski 
Lab and other research groups. 

For the reporting period (01/01/20 – 06/30/20), micro-CT image processing and statistical analyses related 
to Activity 4 were completed according to the revised project timeline. A concise summary of the micro-
CT findings from whole-bone and regional analysis of the femur and tibia are outlined below. 

For the reporting period (07/01/20 – 12/31/20), tasks related to the histomorphometry experiments of 
Activity 3 were completed including methyl methacrylate (MMA) embedding, microscopic slide 
preparation, digital annotation of thin-sections, and histological analysis protocol development. 

During reporting period (01/01/21 – 06/30/21), tasks concerning the analysis of the histomorphometric 
experiments of Activity 3 were completed including photomerging, overlaying, and anatomical orientation 
of the histological images. Protocols were developed and implemented to automate extraction and analysis 
of cortical pores from histological images and reduce inter-observer error. 

During the no-cost extension (06/30/21 – 08/31/21), all histological images were analyzed and statistical 
results were computed. An initial manuscript was prepared, submitted, and subsequently published 
(Appendix X). Preparation of other manuscripts are underway and will be submitted to peer-reviewed 
journal articles upon completion. 

Major Findings from Micro-CT Analysis: 

An 8-week course of Morphine and Fentanyl drug treatment is sufficient to remove the significant 
intraskeletal variability (Femur > Tibia) in porosity, pore size, and pore system branching complexity seen 
in Control rabbits. This occurs through both femoral decreases in percent porosity (Anterior and Medial) 
and pore size (all regions), and through tibial increases in percent porosity (Anterior) and pore density 
(Lateral) in response to drug treatment. 
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Key Findings from Whole-Bone Analysis 

Bone Effects: The rabbit femur preferentially develops pore systems that are significantly thicker, larger 
in diameter and volume, and more highly branched. The rabbit tibia preferentially develops pore systems 
that are smaller, more densely populated, and more longitudinally oriented. 

Drug Treatment Group Effects: Morphine and Fentanyl treatment produces significantly thinner and 
smaller volume pore systems compared to Controls in both the femur and tibia. There is an elevation of 
individual pore system mean radius and volume in the Morphine-treated tibia. 

Bone * Group Interaction Effects: In Control rabbits, the femur develops significantly higher total percent 
porosity and pore volume, while retaining the significant elevation of pore size and branching complexity 
seen in the Bone effect. This significant intraskeletal variation, however, disappears with Morphine and 
Fentanyl drug treatment. This is due both to decreased femoral mean values and increased tibial mean 
values of these morphometric measurements. Drug treatment physiologically dysregulates the normal 
mechanical control that determines the divergent pore patterning of the healthy femur and tibia. 

Key Findings from Femoral Regional Analysis 

Region Effects: Across all groups, Medial and Posterior quadrants have significantly higher percent 
porosity and larger pore size. Medial and Lateral quadrants have significantly higher pore density, but 
Lateral quadrant pores are too small to accrue high percent porosity. 

Drug Treatment Group Effects: As seen in the whole bone analysis, Control group rabbits exceed 
Morphine and Fentanyl rabbits overall in pore size and pore convergence with cortical borders. Reduced 
femoral porosity observed in the whole-bone analysis is concentrated in anterior and medial regions. 

Region * Group Interaction Effects: As seen in the whole bone analysis, drug treatment silences regional 
variability in aggregate porosity measurements. 

Key Findings from Tibial Regional Analysis 

Region Effects: The regional patterning in the femur is reflected in the tibia. Across all groups, Medial and 
Posterior quadrants have significantly higher percent porosity. Posterior quadrants maximize pore size. 
Medial and Lateral quadrants have significantly higher pore density, but Lateral quadrant pores are too 
small to accrue high percent porosity. While pore systems are most numerous and highly connected in the 
Anterior quadrant, the higher pore separation in a larger cortical volume prevents the Anterior quadrant 
from maximizing porosity or pore density. 

Drug Treatment Group Effects: Unlike the femur, the tibia has no overall drug treatment group effects 
on pore morphometry. 

Region * Group Interaction Effects: As seen in the whole bone analysis, drug treatment silences regional 
variability in metrics of pore size, percent porosity, pore density, and pore system complexity. Additionally, 
drug treatment significantly increases percent porosity in anterior regions (Fentanyl) and pore density in 
lateral regions (Fentanyl and Morphine). 
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Major Findings from Histological Analysis: 

Drug treatment significantly dysregulates the density of microstructural products of remodeling and their 
regional distribution. Osteon population density can be both elevated (Morphine) and reduced (Fentanyl) 
by drug treatment, compared to controls. Regional dysregulation by drug treatment typically affects 
distribution of morphometric variables along the Anterior-Posterior axis compared to the Medial-Lateral 
axis. 

Key Findings from Whole-Section Analysis 

Osteon type counts and population densities were significantly elevated for Morphine group rabbits and 
significantly reduced for Fentanyl group rabbits, compared to controls. No significant differences between 
drug treatment groups were observed for cross-sectional geometry, periosteal or endosteal labeling, or any 
aspect of vascular porosity. 

Key Findings from Regional Analysis 

Region Effects: The Lateral quadrant showed a significant reduction in many microstructural products of 
remodeling, including remodeling area fraction, vascular percent porosity and pore density, osteon type 
counts and population densities, pore and osteon type mean areas, and all calculations of activation 
frequency. This may be due to the high loading of the Lateral quadrant by the ground reaction force during 
hopping.  

Drug Treatment Group Effects: Significant elevation of Morphine group rabbits over Fentanyl group 
rabbits was observed for a subset of the osteon count and population density variables observed in the 
whole-section analysis. 

Region*Group Interaction Effects: Morphine and Fentanyl group rabbits displayed significant 
dysregulation of regional patterning, with numerous losses and gains of regional patterns compared to 
Controls. Gain or loss of regional patterning almost always affected Anterior-Posterior axis patterning 
compared to Medial-Lateral axis patterning. Gain of significant regional patterning was more common in 
Fentanyl group rabbits.  

2.2.4. Key Outcomes or Other Achievements 

Nothing to report. 

2.3. What opportunities for training and professional development has the project provided? 

2.3.1. Professional Communities 

Dr. Andronowski strives to provide both her advisees and colleagues with opportunities to share emergent 
methodological and technological innovations. In particular, starting in July 2018, she drew on her 
professional network of histologically-focused biological anthropologists to organize an invited poster 
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symposium at the 88th Annual Meeting of the American Association of Physical Anthropologists (AAPA). 
The resulting symposium, “Recent Advancements in the Analysis of Bone Microstructure”, was accepted 
and held at the annual meeting on March 28th, 2019 in Cleveland, Ohio, and was chaired by Dr. 
Andronowski. This session brought together thirteen laboratories from five countries, all focusing on new 
technological approaches for the 3D visualization of bone tissue histomorphometry. 

Dr. Andronowski, Reed Davis and Gina Tubo attended the Annual Meeting of the AAPA in Cleveland, 
OH, where Davis and Tubo gave a poster presentation along with Dr. Andronowski. This was an invaluable 
experience for Davis and Tubo as both will be entering career fields where presenting research and 
professional networking is a requirement. This was Tubo’s first academic conference and professional 
poster presentation. Dr. Cole also gave a poster presentation in this invited symposium, presenting 
preliminary results from her dissertation research. As the AAPA annual meetings rarely include symposia 
specifically dedicated to histological techniques, this was a unique opportunity to discuss the future of the 
discipline as a unified group. 

Davis further presented a poster at the Annual Scientific Meeting of the American Academy of Forensic 
Sciences (AAFS), and a 3-minute flash talk about his research at The University of Akron Integrated 
Bioscience Retreat, where he received the highest presentation award. 

Drs. Andronowski and Cole presented a scientific poster in the Toxicology Section at the AAFS 2020 
Annual Scientific Meeting titled ‘Longitudinal Transdermal Fentanyl Compared with Morphine Sulfate 
Treatments in a Rabbit (Oryctolagus cuniculus) Model System: Impacts on Behavior and Health’. This 
work outlined drug administration complications and associated behavioral effects encountered during 
experimental animal dosing of Activities 1 and 2. Additional research team members including Davis, Tubo, 
LaMarca, and Schuller assisted in the preparation of the poster and associated graphics for presentation. 
This experience provided both graduate and undergraduate members of the Andronowski Lab with 
experience in disseminating scientific findings to a diverse group of forensic scientists. 

Dr. Andronowski presented a virtual scientific poster and associated recorded talk in the Anthropology 
Section at the AAFS 2021 Annual Scientific Meeting titled ‘Longitudinal Effects of Prolonged Opioid Use 
on Cortical Bone Remodeling in a Rabbit Model: Part I – Intraskeletal Variability and Regional Differences 
Detected via micro-CT’. This presentation introduced a novel longitudinal model for studying the effects 
of prolonged opioid exposure on cortical bone remodeling in the rabbit, with a focus on the 3D micro-CT 
findings related to Activity 3. Additional research team members including Cole, Davis, Schuller, Tubo, 
LaMarca, and Taylor assisted in the preparation of the poster and associated graphics for presentation. This 
experience provided both graduate and undergraduate members of the Andronowski Lab with experience 
in disseminating scientific findings to a diverse group of forensic scientists. 

Drs. Cole and Andronowski prepared a second virtual scientific poster presentation for dissemination in the 
Anthropology Section at the AAFS 2021 Annual Scientific Meeting titled ‘Automated Techniques for 
Cortical Bone Histological Variable Segmentation and Image Enhancement’. The presentation described a 
collection of novel automated techniques utilized to enhance, segment, and analyze micro-computed 
tomography (PCT), synchrotron radiation-based micro-CT (SRPCT), and confocal microscopy datasets. 
Additional team members, Davis and Taylor assisted in poster preparation. This experience provided both 
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graduate and undergraduate members of the Andronowski Lab with experience in disseminating scientific 
findings to a diverse group of forensic scientists. 

In August 2021, Dr. Andronowski submitted an abstract for oral presentation in the Anthropology Section 
at the AAFS 2022, entitled “Longitudinal Effects of Prolonged Opioid Use on Cortical Bone Remodeling 
in a Rabbit Model: Part II – Intraskeletal Histological Variability and Regional Differences”. Additional 
research team members included Cole, Davis, Schuller, Tubo, and Taylor. This presentation will describe 
results from the histological analysis portion of this project, including the effect of drug treatment on 
vascular pore and osteon morphometry, and remodeling activity. 

Drs. Cole and Andronowski submitted a second abstract as a poster to the Anthropology Section at the 
AAFS 2022, entitled “OsteoFlo: A Fiji/ImageJ Toolkit for Semi-Automated Identification and 
Characterization of Fluorescently Labeled Secondary Osteons”. Additional research team members 
included Taylor and Medhat Hassan. This presentation will describe the OsteoFlo software developed for 
histological analysis for this project. 

Both presentations were accepted for presentation and will be delivered at the AAFS 2022 Annual Scientific 
Meeting at the Washington State Convention Center in Seattle, Washington from February 21 – 25, 2022. 

2.3.2. Training 

Through consistent involvement in this project, undergraduate and graduate student team members gained 
instructional and practical experience in animal experimental treatments, dissection, sample preparation, 
micro-CT and microscopic imaging, and project management. 

Animal handling, husbandry, and experimental treatments 
Research team members received technical training and practical experience with animal husbandry, 
handling, and experimental treatments during Activities 1 and 2. All individuals completed CITI training 
modules including: 1) ‘Working with the IACUC’, and 2) ‘Working with Rabbits in Research Settings’ 
(Appendix XXVII). The researchers further completed in-person animal handling training with Dr. Stanley 
Dannemiller, the attending veterinarian. Animal handling experiences included rabbit transportation, 
exercise, and provision of enrichment toys and food. Researchers also gained experience in performing 
animal health checks that included monitoring fecal and urine output, diet, appearance, and behavior. 
Animal care included the application of veterinary bandage wrapping and mesh rabbit jackets to encourage 
fentanyl patch adherence (Appendix VII), applying antibiotic ointment when prescribed by the 
veterinarian, and clipping fur to facilitate injection and patch application. Animal experimental treatments 
included the preparation of injectable reagents (e.g., calcein), transdermal patch administration, and 
subcutaneous injections. Lastly, members of the research team gained experience in the administration of 
euthanasia though intraperitoneal injection and bilateral pneumothorax following hands-on training with 
Dr. Dannemiller. 

Rabbit Dissection 
Animal dissection, following the experimental portion of the study, allowed researchers to refine their 
knowledge of vertebrate anatomy, hone their dissection techniques, and reinforce the proper protocol for 
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sterilizing dissection tools and surfaces. Researchers further gained experience in harvesting bone samples 
(specifically tibiae, fibulae, and femora) while preserving animal soft tissues. Preparation of samples for 
micro-CT scanning and traditional microscopy provided experience with these basic laboratory skills for 
the emerging researchers in the Andronowski Lab. 

Bone sample procurement and preparation 
As a part of the Andronowski Lab, future health professionals and biomedical researchers gain practical 
cadaveric dissection skills through bone tissue harvesting trips. Through Dr. Andronowski’s professional 
network, several local medical schools allow sampling of long bones from anatomy lab cadavers for 
histological analyses. Participating in these experiences provides trainees with early exposure to cadaveric 
dissection, specifically the appearance of tissues in situ and the unique textures of fresh and embalmed 
tissues. This exposure has been particularly beneficial to the undergraduate students, many of whom will 
be attending professional school. Through Dr. Andronowski’s connection to The University of Tennessee 
Knoxville’s Forensic Anthropology Center, Dr. Andronowski and former Undergraduate Research 
Assistant Adam Schuller visited the Anthropology Research Facility (ARF) to collect soil samples for an 
ongoing research project. This was an invaluable opportunity for students to observe and network with 
forensic anthropology professionals outside of The University of Akron. 

Micro-Computed Tomography Visualization 
Three-dimensional visualization of bone microstructure is a significant component of the proposed 
analyses. Scanning was primarily performed by Dr. Cole, Reed Davis, and Dr. Andronowski. Dr. 
Andronowski has extensive experience with the SkyScan 1172 micro-CT instrument from prior post-
doctoral and faculty research and was additionally trained on protocols specific to the Surface and Optical 
Analysis Facility within the National Polymer Innovation Center at The University of Akron. Dr. Cole has 
previous SkyScan 1172 experience from graduate research and was trained for independent operation of 
the scanner on 6/18/19 and 6/20/19 by the instrumentation scientist, Dr. Andrew Knoll. Reed Davis was 
trained for independent use on 6/14/19 and 6/19/19. 

Three-dimensional visualization software transforms the angular X-ray projections acquired during micro-
CT imaging into a stack of (2D) image slices and a 3D reconstruction of the scanned object. Image 
processing software further extracts features of interest, such as cortical pore networks, and reports their 
structural geometric measurements. Dr. Andronowski, Dr. Cole, and Reed Davis have significant prior 
research experience with micro-CT and image processing software such as NRecon, CTAnalyser, ImageJ 
and AMIRA, including developing automated image processing workflows. They have gained further 
experience in the development of new workflows through this project, especially through dissemination to 
other lab members and collaborators. Reed Davis and Gina Tubo were trained in implementation of the 
image processing protocols (Appendices XII – XIII) following development by Drs. Andronowski and 
Cole. An undergraduate student researcher, Kassidy Wilson, was trained in implementation of the 
Skeletonization image processing protocol (Appendix XVI) for completion of an undergraduate honors 
thesis. 

Davis implemented the devised image processing protocols and expanded his 3D image processing 
experience by beginning work on a related project examining the effects of morphine and fentanyl on the 
trabeculae of the proximal tibia. Davis imaged all rabbit proximal tibiae using the SkyScan 1172 housed in 
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the National Polymer Innovation Center. Davis worked closely with Drs. Andronowski and Cole to 
determine best practices for 3D imaging, image processing, and data analyses. Davis’ previous bone-related 
research has focused predominately on cortical bone. This project allowed him to expand his knowledge of 
trabecular bone for a more complete understanding of bone microarchitecture. Davis further adapted 
workflows for use with trabecular bone in image processing software (e.g., NRecon, CTAnalyser) and is 
working to train undergraduate members of the Andronowski Lab in the use of these protocols. 

Reagent preparation (e.g., Calcein) 
Undergraduate and graduate student researchers gained additional practical experience in fluorochrome 
reagent (calcein) preparation for visualizing longitudinal bone remodeling. Researchers ensured that the 
calcein was prepared according to protocol (Appendix XXVIII) in a dark room and that it exhibited the 
proper pH level. Preparing the calcein allowed researchers to work with laboratory equipment such as a 
balance, pH probe, and inverter. 

Histological Sample Processing, Imaging, and Analysis 
Undergraduate and graduate student researchers were trained on the preparation of bone tissue samples for 
histological analysis, including Isomet sectioning, dehydration, MMA embedding, diamond wire saw 
sectioning, and thin-section mounting. The trainees also received instruction on microscopic imaging with 
brightfield (DIC), circular polarization, and fluorescence using cellSens image capture software. Students 
further gained experience in photomerge reconstruction of multiple adjacent microscopic images into cross-
sectional images using Microsoft Image Composite Editor and Adobe Photoshop, sample orientation in 
Adobe Photoshop, and image pre-processing for automated image analysis in ImageJ. Dr. Cole further 
expanded her software development skills in Javascript-based ImageJ macro language through 
development of the OsteoFlo software package, and in the R language for statistical computing in 
developing fully automated statistical analysis. 

Consumables/equipment ordering/data management 
Researchers maintained detailed logs throughout the experimental portion of the project that included 
information regarding animal care schedules, animal health, enrichment foods, exercise, and experimental 
treatments (Appendix XXIX). The research team refined critical data management skills and were able to 
communicate information among group members and UARV staff while creating thorough documents to 
monitor how the project was progressing. The logs were important for project collaboration, resource 
tracking, and keeping all project members informed on day-to-day tasks. 

Dr. Andronowski, Reed Davis, and Dr. Cole maintained the project budget and ordering of consumables. 
Davis created and maintained an up-to-date interactive spreadsheet to keep track of expenditures and 
remaining available budget. 

2.3.3. Mentoring 

Post-Doctoral Mentoring and Collaboration 
Dr. Cole joined the Andronowski Lab as a Post-doctoral fellow in part to observe Dr. Andronowski’s early 
career activities. Such enterprises include making professional connections for sample acquisition, start-up 
and management of a new laboratory, advising graduate and undergraduate educational trajectories, and 
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performing the unique service activities required of faculty both within and beyond the university. By 
observing and participating in these activities, Dr. Cole improved the soft skills and management techniques 
necessary to navigate her own potential career in academic research. Additionally, Dr. Cole had 
opportunities to pursue research and publish with Andronowski Lab members and collaborators, expanding 
her immediate professional network beyond her master’s and doctoral institution (The Ohio State 
University). New technical skills acquired by Dr. Cole through this project included animal husbandry, 
animal experimental treatment and synchrotron radiation micro-computed tomography. These skills have 
allowed Dr. Cole to extend the methodological scope of her future research. She continues to collaborate 
with the Andronowski Lab on dissemination of the results of this project in presentations and publications. 

Graduate Mentoring and Collaboration 
Reed Davis joined the Andronowski Lab as a doctoral student in Fall 2018. In order to be better prepared 
for post-doctoral employment, Davis gained experience in publishing scientific literature, managing a 
laboratory, and advising of undergraduate students. Davis also gained experience presenting original 
research at scientific conferences. From this project, Davis has learned animal husbandry, animal 
experimental manipulation, and desktop micro-CT imaging and analysis. These skills have allowed Davis 
to be better equipped for a career in academic research. 

Undergraduate Mentoring 
Reed Davis acted as graduate student mentor to three undergraduate students involved in this project, 
specifically Gina Tubo, Abigail LaMarca, and Joshua Taylor as part of The University of Akron’s Tiered 
Mentoring Program (discussed below). This opportunity allowed Davis to gain experience as a mentor and 
teacher which will be most valuable to him as he prepares for a career in higher education and/or research. 

During reporting period 01/01/20 – 06/30/20, skeletonization data collection was performed by 
undergraduate student Kassidy Wilson for her undergraduate honors thesis. This opportunity allowed 
Wilson to gain experience with micro-CT image processing, data analysis, and statistical workflows. Her 
research experience in the Andronowski Lab will better prepare Wilson for a career in biomedical research. 

During reporting period 06/30/2020 – 12/31/20, undergraduate student Joshua Taylor was trained in MMA 
embedding protocols (Appendix IX) and microscopic imaging using DIC, polarized light, and fluorescence 
settings (Appendix XXX). These training opportunities allowed Taylor to gain experience with a newly 
developed MMA embedding protocol developed by our group, microscopic image analysis, and 
photomerging protocols (Appendix XXXI) using software programs such as Microsoft Image Composite 
Editor, Photoshop 2020, and ImageJ. 

During reporting period (01/01/21 – 06/30/21), Joshua Taylor trained two undergraduate students to assist 
in photomerging histological images. The process provided the undergraduate students with invaluable 
experience in image processing and employing critical problem-solving skills. With the assistance of Dr. 
Cole’s SOP (Appendix XXXI), Taylor overlayed, anatomically oriented, and subtracted the background 
of the histological images. This provided Taylor with experience using software programs and employing 
protocols related to histological analysis. Dr. Cole further trained an additional undergraduate student to 
isolate the remodeling area of polarized images. This student used multiple image analysis software 
packages and utilized an SOP (Appendix XXXII) created by Dr. Cole to create compatible file types with 
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each program. This experience provided the trainee with additional experience working with histological 
samples in various programs that will assist in their future endeavors. Additionally, a macro and SOP 
(Appendix XXXIII) were created by Dr. Cole and utilized by Taylor to extract the cortical area of the 
histological images. 

During the no-cost extension period, Dr. Cole analyzed the histological images utilizing OsteoFlo, a macro 
toolkit developed for ImageJ. Dr. Cole’s macros are detailed in 2.2.1. Major Activities. Cole computed the 
statistics for the histological images using R (The R Foundation, v.4.1.1). All team members are currently 
contributing to manuscript preparation. 

Tiered Mentoring 
The Tiered Mentoring program at The University of Akron facilitates supervised undergraduate laboratory 
research. This program was re-implemented in the summer of 2018. The first student employed in this 
program was Gina Tubo. Tubo formerly worked under the direct supervision of doctoral student Reed 
Davis. Throughout the summer and fall of 2018, Tubo gained the experience required to handle tasks related 
to this project. These skills included bone sample processing (maceration, sectioning, grinding, and 
polishing), the use of fluorescent stains, preparation of slides for microscopy, and the use of computer 
software for 3D reconstruction of produced images (Image J, NRecon, CTAnalyser, and AMIRA). Further, 
as a part of this process, Tubo was trained in confocal microscopy and has become a user of a Leica TCS 
SPE Laser Scanning confocal microscope instrument with motorized galvo-z-stage, 488, 532, and 635nm 
solid state lasers and LASX software for image acquisition and 3D modeling. 

The overall objective of the Tiered Mentoring program is to promote continued undergraduate research. 
Thus, a new Tiered Mentoring fellow, Abigail LaMarca, joined the Andronowski Lab in January 2019. 
Under the guidance of both Tubo and Davis, LaMarca learned the required skills to analyze the bone 
specimens procured from the study. The Tiered Mentoring program has further introduced Abigail to 
scientific journal writing, grant proposal preparation, and report writing. She has also become more 
competent in the critical evaluation of scientific articles as a result of the program. 

2.4. How were the results disseminated to communities of interest? 

The scientific rationale behind the project as described in the approved application was presented at the 
American Academy of Forensic Sciences 71st Annual Meeting, Baltimore, MD, February 20th, 2019. 
Dr. Andronowski presented this invited talk for the Society of Forensic Anthropologists titled ‘Investigating 
the Longitudinal Effects of Prolonged Opioid Use on Cortical Bone Remodeling’. 

A poster presentation relating to Activities 1 and 2 titled ‘Longitudinal Transdermal Fentanyl Compared 
with Morphine Sulfate Treatments in a Rabbit (Oryctolagus cuniculus) Model System: Impacts on Behavior 
and Health’ was given for the Toxicology section at the American Academy of Forensic Sciences 72nd 

Annual Meeting on 19 February 2020. The goals of this presentation were to: (1) describe the longitudinal 
effects of systemic opioids, particularly fentanyl and morphine sulfate, on behavioral and physiologic 
parameters, and (2) demonstrate the long-term use of transdermal fentanyl patches in the management of 
analgesia in a rabbit model system. 
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Dr. Andronowski presented a virtual scientific poster and associated recorded talk in the Anthropology 
Section at the AAFS 2021 Annual Scientific Meeting titled ‘Longitudinal Effects of Prolonged Opioid Use 
on Cortical Bone Remodeling in a Rabbit Model: Part I – Intraskeletal Variability and Regional Differences 
Detected via micro-CT’. The goals of this presentation were to 1) characterize, for the first time, 3D cortical 
bone microstructural changes in a rabbit opioid model, and 2) demonstrate intraskeletal and regional effects 
in the rabbit femur and tibia due to opioid exposure. 

Drs. Cole and Andronowski presented a second scientific poster for virtual dissemination in the 
Anthropology Section at the AAFS 2021 Annual Scientific Meeting titled ‘Automated Techniques for 
Cortical Bone Histological Variable Segmentation and Image Enhancement’. The primary goal of the 
presentation was to introduce novel automated techniques that produce reliable and repeatable results for 
various high resolution imaging modalities. Auxiliary goals were to 1) reduce noise and artifacts, 2) 
standardizing variable analysis, 3) reduce inter-observer error, and 4) use open-source software for macro 
development and standard operating procedures. 

In August 2021, Dr. Andronowski submitted an abstract for oral presentation in the Anthropology Section 
at the AAFS 2022 Annual Scientific Meeting, titled “Longitudinal Effects of Prolonged Opioid Use on 
Cortical Bone Remodeling in a Rabbit Model: Part II – Intraskeletal Histological Variability and Regional 
Differences”. This presentation will describe histological results from this project. Drs. Cole and 
Andronowski submitted an additional abstract for poster presentation in the Anthropology Section at the 
AAFS 2022 Annual Scientific Meeting, titled “OsteoFlo: A Fiji/ImageJ Toolkit for Semi-Automated 
Identification and Characterization of Fluorescently Labeled Secondary Osteons”. This presentation will 
describe the utilities provided by the OsteoFlo software. Both presentations were accepted for dissemination 
at the AAFS 2022 Annual Scientific Meeting. 

A manuscript documenting the findings from Activities 1 and 2 titled ‘Rabbits (Oryctolagus cuniculus) as 
a Model System for Longitudinal Experimental Opioid Treatments: Implications for Orthopedic and 
Biomedical Research’ was recently published in a special issue in the journal Osteology. All members of 
the research team contributed. 

2.5. What do you plan to do during the next reporting period to accomplish the goals and objectives?

 Nothing to report. 

2.6. Publications, conference papers, and presentations 

Dr. Andronowski presented an invited talk for the Society of Forensic Anthropologists, titled ‘Investigating 
the Longitudinal Effects of Prolonged Opioid Use on Cortical Bone Remodeling’ at the American Academy 
of Forensic Sciences Annual Meeting in Baltimore, MD, on 20 February 2019. 

This seminar detailed the scientific rationale behind the project as described in the approved application. 
Dr. Andronowski explained the limitations of employing murine model systems to the study of cortical 
bone turnover and emphasized the use of rabbits as the smallest traditionally used laboratory animals with 
well-defined cortical remodeling comparable to humans. The implications of the current work for forensic 
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practitioners were highlighted, including an emphasis on how life history variables (e.g., drug/alcohol use) 
can affect bone remodeling and in turn have serious implications for histological age estimation methods 
in the field of forensic anthropology. 

A presentation relating to Activities 1 and 2 titled ‘Longitudinal Transdermal Fentanyl Compared with 
Morphine Sulfate Treatments in a Rabbit (Oryctolagus cuniculus) Model System: Impacts on Behavior and 
Health’ was accepted for the American Academy of Forensic Sciences 72nd Annual Meeting, Anaheim, CA 
in the Toxicology section. The presentation was given on 19 February 2020. The goals of this presentation 
were to: (1) describe the longitudinal effects of systemic opioids, particularly fentanyl and morphine sulfate, 
on behavioral and physiologic parameters, and (2) demonstrate the long-term use of transdermal fentanyl 
patches in the management of analgesia in a rabbit model system. 

A virtual scientific poster and associated recorded talk related to Activity 3 and 4 titled ‘Longitudinal 
Effects of Prolonged Opioid Use on Cortical Bone Remodeling in a Rabbit Model: Part I – Intraskeletal 
Variability and Regional Differences Detected via micro-CT’ was presented in the Anthropology Section 
at the AAFS 2021 Annual Scientific Meeting. The goals of this presentation were to 1) characterize, 
for the first time, 3D cortical bone microstructural changes in a rabbit opioid model, and 2) 
demonstrate intraskeletal and regional effects in the rabbit femur and tibia due to opioid exposure. 

A second scientific presentation related to Activity 4 was accepted for virtual dissemination in the 
Anthropology Section at the AAFS 2021 Annual Scientific Meeting titled ‘Automated Techniques for 
Cortical Bone Histological Variable Segmentation and Image Enhancement’. The primary goal of the 
presentation was to introduce novel automated techniques that produce reliable and repeatable results for 
various high resolution imaging modalities. Auxiliary goals were to 1) reduce noise and artifacts, 2) 
standardizing variable analysis, 3) reduce inter-observer error, and 4) use open-source software for macro 
development and standard operating procedures. 

In August 2021, Dr. Andronowski submitted an abstract for oral presentation in the Anthropology Section 
at the AAFS 2022 Annual Scientific Meeting, titled “Longitudinal Effects of Prolonged Opioid Use on 
Cortical Bone Remodeling in a Rabbit Model: Part II – Intraskeletal Histological Variability and Regional 
Differences”. This presentation will describe histological results from this project. Drs. Cole and 
Andronowski submitted an additional abstract for poster presentation in the Anthropology Section at the 
AAFS 2022 Annual Scientific Meeting, titled “OsteoFlo: A Fiji/ImageJ Toolkit for Semi-Automated 
Identification and Characterization of Fluorescently Labeled Secondary Osteons”. This presentation will 
describe the utilities provided by the OsteoFlo software. Both presentations were accepted for dissemination 
at the AAFS 2022 Annual Scientific Meeting. 

A manuscript documenting the findings from Activities 1 and 2 titled ‘Rabbits (Oryctolagus cuniculus) as 
a Model System for Longitudinal Experimental Opioid Treatments: Implications for Orthopedic and 
Biomedical Research’ was submitted and accepted to a special issue in the journal Osteology. All members 
of the research team contributed. 
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2.7. Website(s) or other Internet site(s) 

The following media outlets and Internet sites highlighted the current study and announced the awarding 
of funding. Results of the research activities or a discussion of the live animal component of the study were 
not disseminated in any of the below articles. 

Feb. 2019 Press Release: 'New study funded by NIJ research grant to focus on opioid     
addiction's effects on bones'. Published on Digitaljournal.com. Released: 
2/4/2019 URL. 

Press Release: 'Skeleton keys: Scientist to study effects of opioid addiction on 
bone.' published on ForensicMag.com. Released: 2/4/2019. 

Article: 'Forensic anthropologist says opioid use may make identifying skeletal 
remains more difficult' published on Ohio.com. Released: 2/3/2019. 

Jan. 2019          Article: 'Opioid addiction effects on bones is subject of NIJ research grant' 
published on EurekAlert.org. Released: 1/29/2019. URL. 

Press Release: The University of Akron, Media Communications. 'Skeleton Keys: 
'Scientist to study effects of opioid addiction on bones'. 1/29/2019. URL. 

2.8. Other products 

Canadian Light Source Synchrotron Proposal for Experimental Time 

Dr. Andronowski submitted a research proposal for experimental time (e.g., ‘beam time’) for a related 
project at the Canadian Light Source (CLS) National Synchrotron Facility in February 2020. This follow-
up study proposes examining opioid effects on bone at the powerful synchrotron imaging level, where sub-
micron resolution can be achieved. Synchrotron imaging can visualize structures within cortical bone that 
are too small to be detected by desktop micro-CT imaging. For example, the 3D trajectory of osteon cement 
lines used in histological age-at-death estimation, and the 3D morphometry of cortical pore networks and 
osteocyte lacunae used as markers of bone fragility can be evaluated using this technology.  

Our objectives were to: 1) further identify pathological changes to cortical bone microstructure with 
prolonged opioid use in a rabbit model, and 2) quantify differences in standard cortical bone microstructural 
parameters (e.g., osteocyte lacunar volume and density) among treatment and control groups. We 
hypothesized that: 1) cortical porosity in the experimental groups will exceed that of controls, and 2) a 
decrease in osteocyte lacunar density will be observed in the experimental opioid groups. 
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The proposed study supplements our ongoing work and sets the stage for the next phase of the research 
program, evaluating osteopenia/osteoporosis associated with opioid use in human ribs and femora from a 
larger sample of modern autopsy cases. 

Beam time proposals were reviewed in May 2020 and our submission was scored favorably for the awarding 
of experimental beam time. Due to the COVID-19 pandemic, however, all synchrotron experiments were 
on hold from April 2020 to July 2021. The Andronowski Lab was able to travel to CLS once again in 
September 2021 for imaging time related to various other research projects. During this experimental run, 
the team imaged 202 bone samples for various ongoing research projects. 

Software or NetWare 

The following image processing macros were developed by Drs. Cole and Andronowski for extraction and 
morphometric analysis of cortical pore networks from micro-CT images. The detailed code for these macros 
is available in Appendices XIV and XV. 

CTAnalyser Macros 
▪ “TA Extractor” – Extracts a mask of total area from the grayscale micro-CT image for centerline 

skeletonization and subsequent longitudinal orientation 
▪ “ROI and TA Extractor” – After longitudinal orientation, extracts a mask of total area and a mask 

of cortical area to serve as regions of interest (ROI) for pore extraction and morphometric analysis 
▪ “Pore Morphometry” – Acquires morphometric measurements from cortical pore networks on 

whole cross-sections; also generates binary image stacks of despeckled pore networks and 
grayscale image stacks of pore thickness and pore separation 

▪ “Regional Pore Morphometry” – Same functions as “Pore Morphometry”, but limited to a given 
anatomical region of interest (Anterior, Posterior, Medial, Lateral) 

▪ “Cross-Sectional Geometry” – Extracts cross-sectional geometric measurements from the cortical 
area image stack, using the total area image stack as a mask 

ImageJ Macros 
▪ “Adaptive Thresholding” – Applies a low-contrast, local thresholding Phansalkar algorithm to the 

grayscale micro-CT image, extracting the cortical pore network as a binary image stack, and 
excluding external noise by using the cortical area image stack as a mask 

▪ “Skeleton Save” – Automatically runs and saves the Skeletonization 3D plugin on the total area 
mask, converting it to a centerline skeleton image stack 

▪ “Femur Quadrants / Tibia Quadrants” – Using the cortical area image stack as an input, finds the 
centroid with the Slice Geometry plugin, and then rotates a line through this centroid to generate 
image stacks of masks representing the Anterior, Posterior, Medial, and Lateral anatomical regions 
of each cross-section. A given regional mask can be used as the region of interest (ROI) in the 
Regional Pore Morphometry macro to restrict morphometric analysis of the pore network to that 
anatomical region. 

▪ “DIC Preprocessing” – The DIC image is evenly illuminated through application of a high pass 
filter, contrast enhancement, and background subtraction. Cross-sectional geometry (total, cortical, 
and marrow areas) are also extracted as binary images and as ROI files. 
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▪ “DIC Pore Extractor” – Probable pore ROIs are extracted from the DIC image within the 
remodeling area ROI using an Intermodes auto-threshold, particle size and circularity thresholding, 
and binary closing. 

▪ “DIC Pore Modifier” – Pore ROIs are manually edited using custom keyboard shortcuts, including 
auto-saving. 

▪ “DIC Pore Analyzer” – Pore ROIs are classified as cortical or trabecular based on proximity to the 
marrow cavity versus minimum diameter. Pores are also regionally subdivided between anatomical 
quadrants (Anterior, Medial, Lateral, Posterior) calculated using the total area centroid. Summary 
pore morphometry is calculated for each pore type within each region, including percent porosity, 
pore density, and mean pore size and shape descriptors. 

▪ “Osteon Extraction” - Probable osteon border ROIs are extracted using local contrast enhancement, 
histogram equalization, an Intermodes auto-threshold, and binary opening. Fluorescent rings within 
osteons representing calcein labels are extracted as a binary image using background subtraction 
and an auto local Phansalkar threshold. 

▪ “Osteon Border Correction” - Osteon border ROIs are manually edited using custom keyboard 
shortcuts, including osteon splitting and expansion. 

▪ “Osteon Type” - Osteon border ROIs are regionally assigned as in Pore Analyzer. An ellipse is 
fitted over each ROI, and its major axis is superimposed on the binary image of its calcein labels. 
An intensity profile along this major axis displays peaks that correspond to the number and spacing 
of calcein label intersection. This intensity profile is used to guess osteon type (forming, single, 
double, or triple labeled), mineral apposition rate (On.Mar), which is the distance between two 
consecutive calcein labels, and osteon wall thickness (W.Th), which is the distance from the pore 
centroid to the osteon border. 

▪ “Osteon Type Correction” - Osteon border ROIs are colored by guessed osteon type, and 
coordinates for guessed On.Mar spacing and W.Th pore centroids are superimposed as overlays. 
Custom keyboard shortcuts quickly change osteon type and re-locate coordinates for On.Mar and 
W.Th. Summary morphometry is automatically calculated for each region, including osteon type 
counts, corrected On.Mar and W.Th, and mean size and shape descriptors. 

▪ “Mineralizing Surface” - The ratio of labeled to unlabeled bone on the periosteal (Ps.MS/BS) and 
endosteal (Es.MS/BS) surfaces is calculated as the number of white pixels intersected by the bone 
surface perimeter. 

▪ “Resorption Cavities” - Probable unlabeled resorption cavities are identified as pore ROIs that do 
not intersect with osteon borders and fall above the lowest histogram bin value for pore size. Users 
can manually change this classification. 

III. PARTICIPANTS AND OTHER COLLABORATING ORGANIZATIONS: WHO HAS   
BEEN INVOLVED? 

3.1. What individuals have worked on this project? 

Name: Janna M. Andronowski 
Project Role: Principal Investigator 
Nearest person month worked: 31 (01/01/2019 – 08/30/2021) 
Contribution to Project: Conceptualization; Project design; Methodology; Project 
Administration/Management; Supply/Equipment ordering; Budgeting; Supervision of all trainees; Animal 
handling; Animal experimental treatments; OJP Reporting; micro-CT protocol development and imaging. 
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Funding Support: UA Faculty, 9-month salary; 1-month summer salary (2018-DU-BX-0188). 
State, U.S. territory, and/or country of residence: Ohio, USA 
Collaborated with individual in foreign country: No 

Name: Mary E. Cole 
Project Role: Post-Doctoral Fellow 
Nearest person month worked: 26 (06/01/2019 – 08/30/2021) 
Contribution to Project: Animal handling; Animal experimental treatments; Graduate and undergraduate 
supervision; micro-CT and histological protocol development and imaging; histological sample processing; 
scripting image analysis, statistical programming. 
Funding Support: UA Post-doctoral Fellow, 100% time (2018-DU-BX-0188) 
State, U.S. territory, and/or country of residence: Ohio, USA 
Collaborated with individual in foreign country: No 

Name: Reed A. Davis 
Project Role: Graduate Student (Research Assistant) 
Nearest person month worked: 31 (01/01/2019 - 08/30/2021) 
Contribution to Project: Budgeting; Supervision of undergraduate trainees; Animal handling; Animal 
experimental treatments; micro-CT protocol development and imaging. 
Funding Support: UA Graduate Student, 50% time (2018-DU-BX-0188) 
State, U.S. territory, and/or country of residence: Ohio, USA 
Collaborated with individual in foreign country: No 

Name: Adam J. Schuller 
Project Role: Undergraduate Research Assistant 
Nearest person month worked: 7 (01/01/2019 - 8/01/2019) 
Contribution to Project: Animal handling; Animal experimental treatments; Sample collection. 
Funding Support: UA Undergraduate Research Assistant, 20% time (2018-DU-BX-0188) 
State, U.S. territory, and/or country of residence: Ohio, USA 
Collaborated with individual in foreign country: No 

Name: Gina R. Tubo 
Project Role: Undergraduate Student 
Nearest person month worked: 18 (01/01/2019 - 6/30/2020) 
Contribution to Project: Animal handling; Animal experimental treatments; Tiered mentoring 
supervision. 
Funding Support: UA Undergraduate Research Assistant, 20% time (2018-DU-BX-0188) 
State, U.S. territory, and/or country of residence: Ohio, USA 
Collaborated with individual in foreign country: No 

Name: Abigail R. LaMarca 
Project Role: Undergraduate Student 
Nearest person month worked: 31 (01/01/2019 – 08/30/2021) 
Contribution to Project: Animal handling; Animal experimental treatments; Sample processing.  
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Funding Support: N/A 
State, U.S. territory, and/or country of residence: Ohio, USA 
Collaborated with individual in foreign country: No 

Name: Joshua T. Taylor 
Project Role: Undergraduate Student 
Nearest person month worked: 15 (07/01/2020 - 08/30/2021) 
Contribution to Project: MMA embedding; Microscopic imaging; Photomerging.  
Funding Support: UA Undergraduate Research Assistant, 20% time (2018-DU-BX-0188) 
State, U.S. territory, and/or country of residence: Ohio, USA 
Collaborated with individual in foreign country: No 

3.2. Has there been a change in the active other support of the PD/PI(s) or senior/key personnel since 
the last reporting period?

 Nothing to report. 

3.3. What other organizations have been involved as partners? 

Organization Name: Surface and Optical Analysis Facility 
Location of Organization: Polymer Innovation Center, The University of Akron, Room 212 
Partner’s contribution to project: Facilities: Access to SkyScan 1172 laboratory micro-CT instrument 
for bone imaging as described in section 2.2.1. 
More detail on partner and contribution: Domestic 

Organization Name: The University of Akron Research Vivarium 
Location of Organization: Auburn Science and Engineering Center, The University of Akron, Room 212 
Partner’s contribution to project: Facilities: Animal facility where rabbits were housed for the duration 
of the study. 
More detail on partner and contribution: Domestic 

3.4. Have other collaborators or contacts been involved? 

Nothing to report. 

IV.          IMPACT: What was the impact of the project? How has it contributed? 

4.1. What was the impact on the development of the principal discipline(s) of the project? 

During the reporting period (01/01/19 – 06/30/19), experimental activities were focused on animal 
habituation, husbandry, and experimental treatment. This is the first study to explore cortical 
histomorphometry in an opioid rabbit model. Rabbits are the smallest traditionally used laboratory animals 
with well-defined cortical remodeling comparable to humans10. As a result, rabbits have been used as a 
model system for studying central canal size and the vascular network of cortical bone31–33. We optimized 
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an experimental protocol for dosing rabbits both with injections and transdermal patch application, keeping 
detailed records of rabbit behavior in response to these treatments. Going forward, forensic anthropologists 
and skeletal biologists more generally may be encouraged to use rabbit models to study the isolated effects 
of physiological, mechanical, or pathological treatments on bone tissue histomorphometry. Biomedical 
researchers may also consider the suitability of rabbit research over the more traditional murine models, 
who exhibit little to no cortical remodeling over the lifespan34–38. The expertise developed by our lab 
members in these techniques will also facilitate future rabbit model research by the Andronowski Lab and 
its collaborators. 

During the reporting period (06/30/19 – 12/31/19), activities were focused on the bone imaging phase of 
the project via micro-CT. Our research team developed more specific standard operating procedures and 
image processing workflows for the three-dimensional imaging of cortical bone porosity. We have 
developed and optimized protocols for characterizing the cortical pore network using the software packages 
ImageJ, CTAnalyser, and AMIRA, as described in the approved proposal. Lab members further gained 
experience with R, the statistical computing software proposed for the analysis, through preliminary 
projects. The expertise developed by our lab members in these techniques will facilitate future bone imaging 
research by the Andronowski Lab and its collaborators. 

During reporting period (06/30/20 – 12/31/2020), activities were focused on the histomorphometry phase 
of Activity 3. Our research team developed more specific standard operating procedures and data analysis 
workflows for microscopic imaging and the assessment of opioid-induced changes. We are working to 
develop and optimize protocols for characterizing microscopic parameters using the software package 
ImageJ, as described in the approved proposal. Lab members further gained experience with the MMA 
embedding protocol developed by our group, microscopic imaging, and related photomerging tasks. The 
expertise developed by our lab members in these techniques will facilitate future bone imaging research by 
the Andronowski Lab and its collaborators. 

During reporting period (01/01/2021 – 06/30/2021), activities focused on histomorphometry and data 
analysis of Activity 3 and 4. Histological image analysis included photomerging, overlaying, and orienting 
all histological images. The images were further processed by extracting total cortical area, remodeling 
area. Macros were developed to extract and analyze pores and osteons from the histological images. Lab 
members gained invaluable experience in image processing and macro development. The macros developed 
will advance future research in bone imaging by the Andronowski Lab and its collaborators. 

During the no-cost extension, activities focused on data analysis of histomorphometric data and manuscript 
drafts. Our research team implemented the macros developed in the previous period to analyze the 
histological images. Lab members used R for statistical analysis of the histological data. The research team 
contributed to manuscript drafts and poster presentation abstracts/talks to disseminate the results. This 
provided members of the research team with experience in statistical software and knowledge dissemination 
through manuscripts and poster presentations. 
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4.2. What was the impact on other disciplines? 

This project characterizes bone tissue microstructure by combining traditional 2D histology with 3D 
visualization through micro-computed tomography (micro-CT). Micro-CT data for this project was 
collected and Andronowski Lab members developed image processing workflows for refining and 
analyzing these data. Protocols have been developed for characterizing the cortical pore network using the 
software packages ImageJ, CTAnalyser, AMIRA, and Dragonfly, as described in the approved proposal. 
Lab members further gained experience with R, the statistical computing software proposed for the analysis, 
through preliminary projects. 

The devised 3D imaging processing workflows have been applied to desktop micro-CT scans of bear third 
metacarpals, and synchrotron radiation micro-CT scans of human midshaft femoral cores. The bear 
metacarpal project was presented at the American Academy of Forensic Sciences 2019 Annual Scientific 
meeting by Reed Davis and Dr. Andronowski and the manuscript was published in September 2019 in the 
Journal of Forensic Radiology and Imaging. 

A manuscript titled ‘A Sectioning, Coring, and Image Processing Guide for High-Throughput Cortical Bone 
Sample Procurement and Analysis for Synchrotron micro-CT’ was published in the Journal of Visualized 
Experiments for the femoral coring protocol in June 2020. Researchers applying micro-CT to bone tissue, 
and to organic or inorganic porous substances more generally, can replicate this image processing workflow 
in their own analyses. 

Drs. Andronowski and Cole published a manuscript titled “Current and emerging histomorphometric and 
imaging techniques for assessing age-at-death and cortical bone quality” in Wiley Interdisciplinary Reviews 
(WIREs) Forensic Science in October 2020. This manuscript described traditional 2D histological 
approaches to age-at-death estimation and histomorphometric quantification, along with emerging 3D 
techniques, such as the micro-CT image analysis workflow developed for this project. 

Drs. Andronowski and Cole, along with colleagues from Northeast Ohio Medical University (NEOMED), 
applied the 3D image processing workflows developed for this project to synchrotron radiation micro-CT 
scans of femora and humeri from various bat species, finding interspecies and intraskeletal consistency in 
3D vascular pore morphometry. They disseminated this research in a manuscript titled “Intraskeletal 
consistency in patterns of vascularity within bat limb bones”, published in The Anatomical Record in June 
2021. 

Drs. Andronowski and Cole and research team members presented conference presentations stemming from 
this research at the American Academy of Forensic Sciences (AAFS) Annual Scientific Meetings in 2020, 
2021, and have abstracts accepted for 2022. These meetings reach a broad audience in the forensic sciences, 
including pathologists, medical examiners, and other forensic professionals. 

A manuscript documenting the findings from Activities 1 and 2 titled ‘Rabbits (Oryctolagus cuniculus) as 
a Model System for Longitudinal Experimental Opioid Treatments: Implications for Orthopedic and 
Biomedical Research’ was published in a special issue in the journal Osteology. All members of the 
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research team contributed. Additional manuscripts describing micro-CT and histology results, and the 
associated software packages developed for this software, are currently in preparation. 

4.3. What was the impact on the development of human resources? 

This project provided fellowship support for a Post-doctoral fellow, a Graduate Research Assistant, and an 
Undergraduate Research Assistant. Additionally, one undergraduate student participated in a volunteer 
capacity. Animal research experience increased the competitiveness of medical school applications for the 
undergraduate volunteers. LaMarca further received two credits related to the summer undergraduate 
research experience “3100: 497: Biological Problems”, quantified as nine research hours per week, per 
credit. 

All researchers involved in the study received formal training in animal research ethics (CITI Training), 
vivarium use (UARV Training) rabbit handling (NEOMED Training) and working with radiation-
generating equipment (RGE Training and SkyScan 1172 micro-CT Training). Informal education in animal 
handling, experimental dosing, euthanasia, and dissection was afforded by routine involvement of all lab 
members with daily rabbit care and treatment. Additionally, undergraduate and graduate researchers in the 
Andronowski Lab routinely engaged in typical histology laboratory tasks, such as handling biohazardous 
materials, sample cleaning, histological slide preparation, light transmission and confocal microscopy, and 
image analysis. Familiarity with these fundamental laboratory techniques will prepare junior lab members 
for future research or medical careers. Lab members Reed Davis and Gina Tubo additionally gained 
experience with preparing and presenting research results at national conferences. The work done by 
graduate student Reed Davis on this project will comprise a substantial portion of his dissertation. 

For the first reporting period (01/01/2019 – 06/30/2019), research activities were focused on animal 
husbandry and experimental treatments. The hands-on design of this study required these researchers to 
perform daily activities commonly relegated to UARV staff, including animal enrichment (daily feeding 
and thrice-weekly exercise), health checks, experimental dosing through injection and patch placement, and 
completion of associated documentation of these activities. By engaging with the animals every day, 
researchers were able to quickly notice and resolve experimental difficulties, such as specific animals 
removing patches, or exhibiting the early stages of health issues. Additionally, researchers became familiar 
with the behavioral habits of each animal, providing environmental insight that may help explain individual 
differences in bone microstructure during the data analysis phase. This experimental familiarity will also 
be essential in accurate communication of methodology during formal and informal data dissemination, 
facilitating replication of future research. 

Near the end of the first reporting period, participants gained technical experience in the euthanasia of 
research animals under the direction of Dr. Stanley Dannemiller, followed by gross dissection for bone 
tissue procurement. Additionally, researchers employed by this project gained lab management and project 
management experience, such as ethics training for animal research, purchasing and budgeting supplies, 
experimental troubleshooting and modification, and experimental documentation. As all experimental 
treatments were performed in groups of two or more researchers, participants also gained team-building 
and communicative skills related to caring for and experimentally dosing the animals. 
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For reporting period (06/30/19 – 12/31/19), research activities were focused on the 3D bone imaging phase 
(Activity 3). Dr. Andronowski, Dr. Cole, and Reed Davis optimized micro-CT imaging settings for the 
midshaft femur and tibia and the proximal tibio-fibula by testing a range of imaging resolutions. Dr. Cole 
and Reed Davis gained substantial experience with sample mounting and micro-CT imaging of 63 discrete 
bone regions, comprised of the midshaft femora, tibiae, and proximal tibio-fibulae from 21 rabbits. Dr. Cole 
expanded her coding experience through the development of image processing workflows in ImageJ and 
CTAnalyser, and automated statistical workflows in R. Reed Davis and Gina Tubo were also trained in the 
implementation of these image processing workflows. 

Dr. Andronowski, Dr. Cole, and Taylor optimized microscopic imaging settings for thin-sections of the 
mid-shaft femur by troubleshooting a range of settings. Dr. Cole expanded her coding experience through 
the development of image processing workflows in ImageJ, and automated statistical workflows in R. Reed 
Davis and Joshua Taylor were further trained in the implementation of these image processing workflows. 

For the previous reporting period (01/01/21 – 06/30/21), Dr. Cole and Taylor applied histological analysis 
techniques to femoral thin-sections. Taylor learned different techniques and applications of various 
programs including Microsoft Image Composite Editor (ICE), ImageJ, and Photoshop for histological 
analysis. Dr. Cole further expanded her coding experience through numerous macro developments for 
image processing in ImageJ. Taylor was trained to apply these workflows to the histological images. 

During the no-cost extension, activities focused on data analysis of histomorphometric data and manuscript 
drafts. Dr. Cole implemented the macros developed in the previous period to analyze the histological 
images. Dr. Cole further used R for analysis of the histological data. The research team contributed to 
manuscript drafts and poster presentations to disseminate the results. This provided Dr. Cole with further 
experience in macro development and statistical computing. All research members gained increased 
experience in knowledge dissemination through manuscript preparation and poster presentations. 

All research participants are at varying stages of an educational trajectory leading either to advanced health 
professions or academic/industrial biological research. By gaining experience with all levels of 
experimental design, from planning through implementation, this project improved the performance and 
retention of these researchers in their future health or research careers. Additionally, Dr. Andronowski was 
well suited to advise the three female members of her research team on unique challenges and opportunities 
they may face as women in early career STEM fields. 

4.4. What was the impact on teaching and educational experiences? 

Dr. Andronowski is the founder and campus advisor for The University of Akron’s Biological 
Anthropology and Human Anatomy Student Organization (BAHA). BAHA membership is open to both 
undergraduate and graduate students in any discipline, and provides members with anatomical and 
anthropological educational experiences, outreach opportunities, and career guidance. Previous educational 
experiences include participating in human cadaveric dissections in Dr. Andronowski’s Human Anatomy 
laboratory and visiting the Cuyahoga County Medical Examiner’s Office for an autopsy demonstration. 
Outreach events hosted by BAHA have included cadaver experiences for Barberton High School 
Advancement to Nursing program students and the UA Neuroscience Club. Additionally, BAHA members 
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have provided hands-on forensic anthropology demonstrations during three Cleveland Museum of Natural 
History’s “Think and Drink with the Extinct” events. The Andronowski Lab is committed to continuing 
public outreach both within and beyond the university. 

4.5. What was the impact on physical, institutional, and information resources that form 
infrastructure? 

4.5.1. Improvements to Physical Facilities in the UARV 

In preparation for the live animal portion of the project (Activities 1 and 2), improvements to the physical 
facilities in the UARV were needed. The following jobs were completed in Room 212 (or affected Room 
212) where the rabbits were housed: 

1. Installed temporary air conditioner in Room 212. 
2. Calibrated all of the Metastats (Metasys thermostats) in the entire UARV. 
3. Repaired the chiller located on the roof servicing the UARV air handler. 
4. Verified air flow and adjusted dampers servicing Room 212. 
5. Verified operation of the humidifier control valve servicing Room 212. 
6. Replaced the sink fixture in Room 212 (former sink was rusty). 
7. Sealed around the edges of all of electrical outlets as these were leaking air. 
8. Installed door sweeps in Room 212 to minimize air infiltration. 
9. Installed a temporary humidity, temperature, and flood monitoring system (AVTECH) in the room 

to alert researchers of potential fluctuations in housing conditions. 

There were additional facilities issues in the UARV facility that required attention prior to the arrival of the 
rabbits. These included: 

1. Ceiling repairs were completed in the cage washer room (Room 112). 
2. Replaced the door seals on the cage washer. 
3. Installed a cover on a communication/electrical box in the cage washer storage room (Room 114). 
4. Sealed around all of the floor level return grills on the second floor. 
5. Installed an exhaust diffuser in the potable water storage room (Room 210). 
6. Upgraded the electrical outlets to eliminate extension cords in two other rooms in the 

UARV 
7. Improved door seals around the elevator to reduce air infiltration in the UARV. 

By spearheading the above maintenance to the UARV, this project improved experimental conditions both 
for its own animals and for concurrent and future UARV users. 

4.6. What was the impact on technology transfer? 

Nothing significant occurred during this reporting period. Study results and methodological innovations 
will be transferred through peer-reviewed journal publications, and through presentations at conferences 
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such as the annual meetings of the American Academy of Forensic Sciences, the Canadian Bone and Joint 
Conference, and/or the American Society for Bone and Mineral Research. 

4.7. What was the impact on society beyond science and technology? 

Nothing significant occurred during this reporting period. Given the widespread and accelerating rate of 
opioid overdoses in the United States, it is critical to tailor forensic techniques to accurately build a 
biological profile. This project is working to adjust traditional histological aging methods to accommodate 
chronic opioid users and will seek to identify unique bone microstructural presentations that may signify 
opioid use. By refining the image processing and analysis methods required for this analysis, this project 
will also increase accessibility of these methods to forensic and academic institutions. 

4.8. What was the impact on society beyond science and technology? 

Nothing significant occurred during this reporting period. Given the widespread and accelerating rate of 
opioid overdoses in the United States, it is critical to tailor forensic techniques to accurately build a 
biological profile. This project is working to adjust traditional histological aging methods to accommodate 
chronic opioid users and will seek to identify unique bone microstructural presentations that may signify 
opioid use. By refining the image processing and analysis methods required for this analysis, this project 
will also increase accessibility of these methods to forensic and academic institutions. 

4.9. What percentage of the award’s budget was spent in foreign country(ies)? 

Nothing to report. 

V.            CHANGES/PROBLEMS 

5.1. Changes in approach and reasons for change 

A proposed change affecting the delivery of fentanyl from subcutaneous injection to transdermal patch 
administration was proposed by Dr. Andronowski and a VVC Modification was approved by the IACUC 
on 04/07/2019 (Appendix VI). The details of this change in experimental vehicle administration are 
outlined in section 2.1. 

A second proposed change affecting the fentanyl experimental group was initiated that differed from the 
agency approved plan. A VVC Modification (Appendix VII) was put forward to cover the drug eluting 
transdermal patches (fentanyl) and control patches (Tegaderm) in order to prevent the animals from 
chewing, removing, and/or ingesting these from the subscapular region. The details of this change related 
to jackets and other patch coverings is outlined in section 2.1. 

5.2. Actual or anticipated problems or delays and actions or plans to resolve them 

5.2.1. Actual Delays 

2018-DU-BX-0188 Final Technical Report 
October 2021 

This resource was prepared by the author(s) using Federal funds provided by the U.S. 
Department of Justice. Opinions or points of view expressed are those of the author(s) and do not 

necessarily reflect the official position or policies of the U.S. Department of Justice.

77 



 
  

 

  
     

   
    

 
  

        
 

   
       

       
  

      
     

        
   

       
  

 
   

      
      

    
     

       
  

  
 

 
   

     
           

         
     

    
   

 
   

           
      

      
        

      
     

Due to a delay in the creation of the Post-doctoral Fellow position by The University of Akron’s Human 
Resources department, the prospective candidates were unable to interview until late January/February 
2019. Dr. Andronowski’s NIJ-appointed grant manager, Mr. Theodore Robinson, was notified of the hiring 
delay on 02/08/2019. 

Dr. Andronowski recruited a most suitable Post-doctoral Fellow candidate, Dr. Mary Cole. Dr. Cole has 
graduate experience in dissection and preparation of human and animal bone tissue samples for traditional 
brightfield microscopy, confocal microscopy, and micro-CT. She is also proficient with the analytical 
software proposed for the data generated by this project, including CTAnalyser, ImageJ, R, SPSS, and SAS. 
The recruitment process involved an informal interview at The Ohio State University (1/4/19) and a formal 
interview with a research presentation by Dr. Cole at the University of Akron (1/25/19). Dr. Cole accepted 
the position on 2/14/19. Dr. Cole was working towards completion of her doctoral degree in Anthropology 
(Biological) at The Ohio State University, with a dissertation defense date of 05/15/2019. Her dissertation 
was funded by the National Institute of Justice Graduate Research Fellowship in Science, Technology, 
Engineering, and Math (Award #2017-MU-CX-0009). In order to complete the data collection and analysis 
proposed in this grant, as well as the dissertation defense and revisions, Dr. Cole requested that her official 
start-date be adjusted to 06/03/2019 as per her contract. 

To expedite Dr. Cole’s capacity to fully participate in the project, Dr. Andronowski arranged for several 
training sessions ahead of the start date. This included completion of a UARV Packet and Health 
Assessment to acquire UARV access (3/4/19), CITI Lab Safety Training (3/6/19), NEOMED rabbit 
handling training (3/11/19), UARV training (3/11/19), diamond wire saw installation and training (4/3/19), 
and all preliminary Human Resources documentation (3/11/19). Due to this advanced training, Dr. Cole 
was able to access UARV and Andronowski Lab facilities and participate in animal handling and 
experimental treatments beginning on the start-date of the position. 

Regardless of the later start-date of Dr. Cole, the project timeline proceeded as scheduled without delay. 

On 03/11/2020, the World Health Organization declared the novel coronavirus outbreak (COVID-19) a 
global pandemic. As a result, The University of Akron cancelled in-person classes that day and in-person 
lab work was ordered to cease immediately. As per our project timeline, our research team was preparing 
rabbit femoral bone thin-sections for dynamic histomorphometry (Activity 3.4). This process involved daily 
lab work that included bone dehydration, methyl methacrylate (MMA) infiltration and curing, sectioning 
via the in-house Well Diamond Wire Saw, and slide mounting. The stalling of in-lab operations and the 
shutdown of The University of Akron halted the progress of Activity 3.4 indefinitely. 

On 05/21/2020, The University of Akron administration announced a ‘Researcher Return to Work’ 
initiative and Principal Investigators were invited to create individual Return to Work plans for their groups 
for review by administrators and unit heads. The document Dr. Andronowski created (Appendix XVII) 
outlined the guidelines and expectations of Andronowski Lab members for a safe return to lab activities 
during the ongoing COVID-19 pandemic. On 8 June 2020, the plan was approved with restrictions related 
to limits on laboratory personnel numbers and office use and occupancy, the implementation of shift work, 
and personal protective equipment requirements. Due to current social/physical distancing guidelines 
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recommending separation distances of 6 feet or more, no more than 2-3 individuals are permitted in Dr. 
Andronowski’s main lab space at any given time. Lab procedures requiring more than one person in close 
proximity are to be minimized as much as possible. As a result, our bone histomorphometry specimen 
preparation and the subsequent analyses were anticipated to be slowed. A detailed timeline narrative and 
summary table (Appendix XVIII) have been prepared that outline the revised trajectory for Activities 3.4 
and 4.2 in line with our lab safety guidelines. As of 06/30/20, we were on schedule with the revised timeline. 

The planned in-lab training for junior research team members could no longer be carried out face-to-face 
with the social/physical distancing requirements. Drs. Andronowski and Cole filmed a video of the MMA 
embedding protocol and step-by-step guides for the imaging and analysis of bone thin-sections to virtually 
train the junior research team members. 

5.2.2. Anticipated Delays 

In using a complex instrument such as the SkyScan 1172 micro-CT laboratory system, there was a chance 
that the X-ray source could die, or other instrument issues may arise that delay machine use. Luckily, no 
required maintenance or equipment failure occurred during our study. 

5.3. Changes that had a significant impact on expenditures 

Delay in hiring Dr. Cole due to finishing her doctoral dissertation as described in section 5.2.1. 
Approximately $23,000 of her salary needs to be redistributed, though no Budget Modification GANs were 
submitted during this reporting period. 

Due to the hiring delay and COVID-19 pandemic, submitted an eight-month no-cost extension to complete 
the delayed histomorphometry portion of the project and allow Dr. Cole to complete her full two-year post-
doctoral term. The unused grant funds associated with the post-doctoral fellowship from 01/01/19 to 
06/02/19 were available for this extension. This extension allowed Dr. Cole to remain fully engaged with 
manuscript submission and review stemming from this project. 

5.4. Significant changes in use or care of human subjects, vertebrate animals, biohazards, and/or 
select agents 

The details of two changes pertaining to vertebrate animal care are outlined in sections 2.1. and 5.1. 

5.5. Change of primary performance site location from that originally proposed 

Nothing to report. 

VI. BUDGETARY INFORMATION 

Supplies and consumables associated with Activities 1 and 2 were purchased during the first reporting 
period (01/01/2019 – 06/30/2019). Certain costs proposed in the approved application were deemed 
unnecessary due to more cost-effective alternatives being available from other sources. For example, cage 
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battery housing for the animals was rented from a local university (Cleveland State University) instead of 
purchasing new batteries from a laboratory supply company. 

Supplies and consumables associated with Activity 3 were purchased during this reporting period. Certain 
costs proposed in the approved application were deemed unnecessary due to more cost-effective alternatives 
being available from other sources. No Budget Modification GANs were submitted over the course of the 
project. 

VII.  PROJECT OUTCOMES 

7.1. What were the outcomes of the award? 

The ultimate goal of this project for forensic anthropology is the refinement of histological age-at-death 
estimation in the context of widespread chronic opioid use. This project will further contribute to our 
understanding of basic bone biology more generally by describing changes in bone tissue microstructure 
both over time (longitudinally) and in 3D space. Due to historical reliance on 2D imaging, the 3D geometry 
of bone microstructure is not well defined, especially in relation to aging, modified physiology, and 
pathology39. Tracking these changes and individual variations in bone microstructure is also biomedically 
important for understanding what makes bones weak, when they are at risk of fracture, and how these 
complications of poor bone quality may be prevented. 

Forensic anthropologists typically develop histological methods using human cadaveric samples. 
Biological human variation, differences in life history, and limitation to a single time point can introduce 
uncertainty into the accuracy and applicability of these methods. The design of the current project, 
employing a rabbit model as an animal proxy of human cortical remodeling, allowed us to control more 
tightly both for individual variation and the parameters of drug use. Examining these more isolated effects 
of chronic opioid use should aid forensic anthropologists in discerning which histological pathologies in 
humans result from drug use, and which may be related to life history co-morbidities (e.g., poor nutrition, 
exposure to communicable disease through needle sharing, and/or chronic stress)40–42. Given the rising 
prescription of opioids for chronic pain relief, it is essential to determine how chronic drug use on its own 
modifies forensic techniques, even when these lifestyle co-morbidities are absent. 
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Covance Res
310 Swamp B
Denver PA 17
Tax ID: 23-18

earch Products Inc. 
ridge Road
517 
86521 

INVOICE Invoice: 
Invoice Date: 
Payment Terms:
Due Date: 
Page:
Billing Currency: 

Order Number: 
Ship Date: 

1080076475 
Apr/18/2019

NET 30 
May/18/2019

1 of 1 
USD 

RB00018057 
Apr/12/2019 

Bill To: 1007320 
UNIVERSITY OF AKRON 
ATTN: CHARLOTTE
302 BUCHTEL COMMON 
AKRON OH 44325-6214 
UNITED STATES 

LABELLE 

Ship To: 1007320 
UNIVERSITY OF AKRON 
CONTACT: CHARLOTTE LABELLE 
235 CARROLL ST 
AKRON OH 44325 
UNITED STATES 

Original Invoice
Line Quantity Unit Amt Gross Amount 

Shipping Information:
Customer PO: 
Billing Contact Name:
Billing Inquiry Phone: 

CRP TRUCK 
CREDIT CARD 

Jill Garant 
608-310-2957 

Net Amount 

Appendix III: Covance Rabbit Order Receipt 

1 21.00 267.67 5,621.07 5,621.07
NZ-5060MM 5.0-6.0 mos-Male-NZW 
21 Male NZW Rabbits DOB Lot 10/20/18 tattoos provided by client write DOB on container and provide a neat D DOB and WT list with shipment 

2 
GEL 

21.00 0.00 
Gelled Water 

0.00 0.00 

3 
TATTOO-RB 

21.00 11.51 
Tattoo-Rabbit 

241.71 241.71 

4 
BOX-RABBIT-

21.00 
SPACE 

18.76 393.96 
Rabbit Shipping Space 

393.96 

5 
ODS 

1.00 529.36 529.36 
Shipping Charge-Truck 

529.36 

Total Pretax Amount: 6,786.10 
Amount Due: 6,786.10 USD 

Invoice Notes 
Morning Delivery -Deliver 4/16/19, Beth Kenaga 330-972-5845, Quote 00063365-2, PO 181112, CREDIT CARD Ending (0480) 

Order Entered By: Gitke,Scott John 

Please remit with invoice number to: 
Primary Remittance Address: Wire Account Details: Courier Address: 
Covance Research Products Inc. Wells Fargo Bank N.A. LabCorp - Covance
PO Box 2485 ABA. No. 121000248 Lockbox Operations
Burlington, NC 27216 Acct. No. 4244842209 1225 Jay Lane

Graham, NC 27253 
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Appendix VI: VVC for Transdermal Patches 

THE UNIVERSITY OF AKRON 

MEMORANDUM 

TO: Janna Andronowski 

CC: IACUC@uakron.edu 

FROM: Beth Kenaga, IACUC Administrator 

DATE: April 7, 2019 

SUBJECT: APPROVAL NOTICE OF VVC MODIFICATION – ADD Fentanyl Patches 
Protocol: 18-11-12 ARC 
Titled:  Longitudinal effect of prolonged opioid use on cortical bone remodeling 
in a ribbit model 

Your modification to the above protocol was reviewed and approved by The University of 
Akron’s Institutional Animal Care and Use Committee (IACUC) VVC review process on April 
5, 2019. 

A copy of this form will be filed with your protocol in the Research Office.  If you have any 
questions, please contact Beth Kenaga, IACAUC Administrator, at 330-972-5845 or via email at 
bkenaga@uakron.edu. 

Beth Kenaga 

IACUC Administrator 

The University of Akron operates under the Public Health Service (PHS) Assurance number A3870-01. 

This resource was prepared by the author(s) using Federal funds provided by the U.S. 
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For IACUC Use Only 

Category: C Special Considerations: Fentanyl Patches  Protocol Number: 18-11-12 ARC 

VVC MODIFICATION - REQUEST TO USE ANIMALS 

Date of Veterinary Consultation: 4/5/2019 

Protocol Number: #18-11-12 ARC 

Protocol Title: Longitudinal Effects of Prolonged Opioid Use on Cortical Bone Remodeling in a Rabbit 
Model 

1. CHANGES IN DURATION, FREQUENCY, TYPE, OR NUMBER OF PROCEDURES 
PERFORMED ON AN ANIMAL N/A: 
Describe any proposed procedural changes or additions involving living animals & include a 
justification for the change. If none are proposed, then mark N/A and move to next section. 

1A. Describe the training/experience of each protocol participant as it relates to the new 
procedure(s) listed above. N/A 

2. CHANGES IN ANESTHESIA, ANALGESIA, SEDATION OR EXPERIMENTAL 
SUBSTANCES N/A: 
Describe any proposed procedural changes or additions involving living animals & include a 
justification for the change. If none are proposed, then mark N/A and move to next section. 

The proposed change will affect the method of delivery of the experimental pharmacologic agents 
(morphine and fentanyl). According to literature published by Foley et al. (2001) and Jain et al. (2018) 
there is demonstrable evidence that transdermal patch delivery of fentanyl resulted in a detectable 
change in bone metrics, which we are seeking to measure. We have proposed this modification to 
eliminate the lack of consensus in recommended fentanyl dosing from various professional consultants, 
and to reduce risk of accidental exposure during administration of the narcotics. Further, this change 
will address the concerns of the IACUC regarding injections being handled by trainees (undergraduate 
and graduate students) for the more dangerous of the two pharmacologic agents while the Principal 
Investigator is attending conferences, or if she should be sick, or otherwise unable to attend dosing 
periodically throughout the duration of the study. 

The transdermal patch administration will also reduce the need to dose the animals every other day and 
will instead act as a slow-release delivery agent and allow for the discarding of the patches and novel 
administration every third day.  
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For IACUC Use Only 

Category: C Special Considerations: Fentanyl Patches  Protocol Number: 18-11-12 ARC 

Hair will be removed via clipping prior to the application of the transdermal patches. The rabbits will 
be contained in a European style rat housing tub with a pad on the flooring to prevent the rabbits from 
slipping. This will prevent injury to rabbit or experimenter while performing the clipping, which will 
take place against the way the fur normally lays. A 25-ug/h slow release fentanyl patch will be placed 
over the intrascapular region. on the animals in the experimental groups. This size patch and specific 
dosage was chosen based on data obtained by Foley et al. (2001) and Jain et al. (2018). The patches 
will be adhered via adhesives associated with the patch manufacturing. Patches will further be secured 
by medical-grade adhesive tape (Tegaderm) around the patch edges. A placebo patch will be placed on 
the control animals with an adhesive and medical-grade tape comparable to the patches applied to the 
experimental animals. All animals will be checked daily for any skin irritation associated with hair 
clipping/patch and tape adhesives. The research team will also ensure the patches are adhering to the 
animals daily. If a patch is coming loose, new medical-grade tape will be applied to secure any loose 
edges. In the event that there is a patch discovered to have come completely loose from one of the 
rabbits, UARV staff should alert Dr. Andronowski or someone listed as a point of contact for the study 
from her lab group so that the deviation from the protocol can be logged and a new patch can be 
administered. If the patch is within a distance which may be reached by the rabbit, such as on the cage 
floor, the UARV staff may remove this from the cage wearing gloves and place in a location away 
from the rabbits where this event can be documented by the research team who will dispose of the 
patch accordingly.  

No fewer than two researchers will be present when dosing the rabbits in order to prevent any risk of 
misuse of the narcotics. In the unlikely event that only one researcher is available at a dosing time due 
to illness or unforseen circumstance, they must be supervised by either the PI or Post-doctoral Fellow 
when dosing the animals. There will be a log book associated with each drug and doses/wastes (e.g., 
folding of a patch) will be recorded as a form of inventory control. These log sheets will be routinely 
inspected by the PI and/or UARV supervisor. 

The researchers will wear cotton lab coats (to provide an extra layer of protection from scratches), 
disposable plastic gowns, and cut-proof gloves when handling the rabbits as well as wearing 
examination gloves while applying/disposing of the patches. 

Patches will be disposed of in an approved biohazard container immediately after dosing or if there is 
premature loss of adhesive property during the dosing period. 

The secondary proposed change will be the return of the original route of administration for the 
morphine treatment. After extensive review of the literature and exhaustive search of pharmaceutical 
ordering companies, there does not appear to be a commercially available slow-release patch for the 
delivery of morphine. The return to this dosing method would mean dosing by subcutaneous injection 
in the tent of the skin located between the shoulder blades every other day for 8 weeks. The morphine 
sulfate group will receive a dose of 3mg/kg/day and the control group will experience a saline dose of 
3mg/kg/day. The morphine agent will be pharmaceutical grade. 

Two individuals from the lab team will be tasked with dosing by injection every second day using safe 
manual restraint and a laboratory table which will provide support. Those individuals handling the 
pharmacologic agent will wear cut-resistant gloves during injections as a secondary safety precaution. 
The proposed dosing level is consistent with clinical recommendations and this was finalized with the 
former UARV veterinarian, Dr. Walter Horne. 
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Category: C Special Considerations: Fentanyl Patches  Protocol Number: 18-11-12 ARC 

3. CHANGES IN METHODS OF EUTHANASIA N/A: 
Describe any proposed procedural changes or additions involving living animals & include a 
justification for the change. If none are proposed, then mark N/A and move to next section. 

To clarify the protocol, the secondary means of confirmation of successful euthanasia event shall be 
with the use of bilateral thoracotomy. This will be performed after the test for remaining consciousness 
with toe/tail pinches to observe any flinch reflex reaction as well as after the primary means of 
euthanasia (administration of Fatal-Plus or equivalent) has been successfully completed as described in 
the original protocol. 

4. CHEMICAL/COMPOUND ADMINISTRATION TO LIVE ANIMALS 
If the Modification Request involves the administration of any chemicals to animals that were 
not described in the original protocol, then complete the following. 

Are all of the chemicals (e.g., test compounds, receptor agonists/antagonists, labeling 
compounds, anesthetics, analgesics, euthanasia agents, etc.) administered to live animals 
commercially available pharmaceutical preparations intended for animal or human use? 

Yes: No: 

If not, then complete the following for each product. 
Identify the chemical/compound and describe how it is prepared and stored to assure 
appropriate purity, sterility and suitability for administration to animals. Indicate the shelf life of 
the prepared product. 
N/A 

Are all of the chemicals/compounds listed above pharmaceutical grade?Yes: No: 
If not, then list them and provide a justification for not using a pharmaceutical grade 
preparation. 
N/A 

5. VVC MODIFICATION APPROVAL 

Approval of the protocol modification is indicated by the signature of the institution-specific 
individual identified below. The individual signing confirms that he/she has reviewed the 
modification and finds it to be in compliance with applicable animal care and use regulations 
and institutional policies. 

Approval Signature: 

*See Attachment Date ___4/5/2019 
Attending Veterinarian 
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Category: C Special Considerations: Fentanyl Patches  Protocol Number: 18-11-12 ARC 

INVESTIGATOR SIGNATURE 

I request the above described modifications to my previously approved “Request to Use 
Animals”. I acknowledge that all assurances listed in the original “Request to Use Animals” 
remain in effect. 

Principal Investigator: 

Name: Janna M. Andronowski 

Signature ________________________________ Date: ______________________ 

OR 

Co-Investigator: 

Name: 

Signature ________________________________ Date: ______________________ 
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Kenaga,Beth A 

From: Stanley Dannemiller <sdannemiller@neomed.edu> 
Sent: Friday, April 5, 2019 12:03 PM 
To: Kenaga,Beth A; Andronowski,Janna Michelle 
Subject: RE: Revised VVC and issues with morphine ordering 

Hi Beth & Janna: 

I have reviewed the VVC modification for protocol 18‐11‐12 ARC and approve it as re‐submitted. 

Stan 

From: Kenaga,Beth A <bkenaga@uakron.edu> 
Sent: Friday, April 5, 2019 11:45 AM 
To: Stanley Dannemiller <sdannemiller@neomed.edu> 
Subject: FW: Revised VVC and issues with morphine ordering 

fyi 

From: Andronowski,Janna Michelle  
Sent: Thursday, April 4, 2019 3:39 PM 
To: 'Stanley Dannemiller' <sdannemiller@neomed.edu> 
Cc: Adam Schuller <ajs289@zips.uakron.edu>; rad115@zips.uakron.edu; Kenaga,Beth A <bkenaga@uakron.edu>; Gina 
Tubo <grt13@zips.uakron.edu> 
Subject: Revised VVC and issues with morphine ordering 

Hi Stan, 

I wanted to reach out with some updates as we have been having issues relating to the drug ordering for 
morphine. 

Firstly, after extensive review of the literature and calling/corresponding with numerous 
pharmaceutical companies, there does not appear to be a commercially available slow‐release patch for the 
delivery of morphine. As such, we have revised the VVC to reflect the original drug administration plan. The 
return to this dosing method would mean dosing by subcutaneous injection in the tent of the skin located 
between the shoulder blades every other day for the 8 weeks. Can you review the attached VVC and let me 
know if you have suggestions/amendments to make? 
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Appendix VIII: Euthanasia 
Training Confirmation 

From: Stanley Dannemiller <sdannemiller@neomed.edu> 
Sent: Friday, June 28, 2019 11:46 AM 
To: Andronowski,Janna Michelle <jandronowski@uakron.edu> 
Cc: Kenaga,Beth A <bkenaga@uakron.edu> 
Subject: Training of Dr. Andronowski and staff for rabbit euthanasia (Protocol #18-11-12 ARC) 

Dear Dr Andronowski & Beth: 

On June 27, 2019 I performed training for staff listed below on IP injec�on of Fatal Plus for euthanasia and 
crea�on of bilateral pneumothorax to assure death in rabbits on Protocol # 18-11-12 ARC.  The rabbits 
demonstrated no signs of pain or distress when the drug was administered.  Staff provided training were: 

Janna Andronowski, Ph.D. – PI for protocol 
Mary Cole, Ph.D. - Post-doctoral fellow 
Reed Davis,  - Ph.D. graduate student 
Adam Schuller, undergraduate student 
Abigail LaMarca, undergraduate student 

All of the staff trained demonstrated their capability to perform the IP injec�on and create a pneumothorax to my 
sa�sfac�on. Please contact me if there are any ques�ons regarding this training. 

Stan 

Stanley D. Dannemiller, DVM, MS, DACLAM
  Director, Comparative Medicine Unit 

Northeast Ohio Medical University 

4209 St. Rt. 44 | PO Box 95 | Rootstown, Ohio 44272 

v 330.325.6558 | f 330.325.5918 | e sdannemiller@neomed.edu 
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Appendix IX: MMA Embedding SOP 

Monday (Day 1) – 70% EtOH on tube rotator 
Batch 1: 10 mL/tube x 10 samples = 100 mL of 70% ethanol 
Batch 2: 10 mL/tube x 11 samples = 110 mL of 70% ethanol 

Tuesday (Day 2) – 95% EtOH on tube rotator 
Batch 1: 10 mL/tube x 10 samples = 100 mL 

95 mL of 100% ethanol + 5 mL distilled water 
Batch 2: 10 mL/tube x 11 samples = 110 mL 

104.5 mL of 100% ethanol + 5.5 mL distilled water 

Wednesday (Day 3) – 95% EtOH on tube rotator 
Batch 1: 10 mL/tube x 10 samples = 100 mL 

95 mL of 100% ethanol + 5 mL distilled water 
Batch 2: 10 mL/tube x 11 samples = 110 mL 

104.5 mL of 100% ethanol + 5.5 mL distilled water 

Thursday (Day 4) – 100% EtOH on tube rotator 
Batch 1: 10 mL/tube x 10 samples = 100 mL of 100% ethanol 
Batch 2: 10 mL/tube x 11 samples = 110 mL of 100% ethanol 

Friday (Day 5) – 100% EtOH – Leave Weekend on tube rotator 
Batch 1: 10 mL/tube x 10 samples = 100 mL of 100% ethanol 
Batch 2: 10 mL/tube x 11 samples = 110 mL of 100% ethanol 
Dehydrate all MMA in calcium chloride pellets 

Batch 1: 490.8 mL = 491 mL MMA 
245.5 mg Ca = 0.246 g Ca 
Batch 2: 539.4 mL = 540 mL MMA 
270 mg Ca = 0.270 g Ca 

Monday (Day 6) – 100% EtOH on tube rotator + Make MMA III bases 
Batch 1: 10 mL/tube x 10 samples = 100 mL of 100% ethanol 
Batch 2: 10 mL/tube x 11 samples = 110 mL of 100% ethanol 
Make MMA I and set on stirrer overnight (100% MMA and 1% BP) 

Batch 1: 15 mL/tube x 10 samples = 150 mL MMA I 
150 mL MMA + 1.5 g BP 
Batch 2: 15 mL/tube x 11 samples = 165 mL MMA I 
165 mL MMA + 1.65 g BP 

Make MMA II and set on stirrer overnight (96% MMA + 4% DP + 1.5% BP) 
Batch 1: 15 mL x 10 samples = 150 mL MMA II 
144 mL MMA + 6 mL DP + 2.25 g BP 
Batch 2: 15 mL x 10 samples = 165 mL MMA I 
158.4 mL MMA + 6.6 mL DP + 2.475 g BP 

Make MMA III for bases and set on stirrer overnight (96% MMA + 4% DP + 2.5% BP) 
Batch 1 Bases: 10 samples at 5 mL per base + extra safety base = 55 mL MMA III + InFill = 15 
mL x 10 samples = 150 mL MMA II = 205 mL MMA III 
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196.8 mL MMA + 8.2 mL DP + 5.125 g BP 
Batch 2 Bases: 11 samples at 5 mL per base + extra safety base = 60 mL MMA III + InFill = 

15 mL x 11 samples = 165 mL MMA I = 225 mL MMA III 
216 mL MMA + 9 mL DP + 5.625 g BP 

Tuesday (Day 7) – Make MMA III Bases in film canisters 
Pour bases (one per sample + one extra) of 5 mL each of MMA III 

Vacuum at 25 Hg for 2 hours with foil caps 
Cap and put in 37 C waterbath (put in and then turn on waterbath) for two days 

Bones remain in ethanol 

Wednesday (Day 8) – Put bones in MMA I in film canisters 
Drain ethanol and put bones in film canisters with 15 mL each of MMA I 

Vacuum at 25 Hg for 24 hours with foil caps 
MMA III bases remain in waterbath (do not open!) 

Thursday (Day 9) – Put bones in MMA II in film canisters 
Take MMA III bases out of waterbath after 48 hours and set on bench to cure one day 
Drain MMA I and put bone in film canisters with 15 mL each of MMA II 

Vacuum at 25 Hg for 24 hours with foil caps 

Friday (Day 10): Put bones in MMA III in film canisters on cured bases 
Drain MMA II and put bones in cured base film canisters with 15 mL each of MMA III 

Vacuum at 25 Hg for 2 hours with foil caps 
Cap and put in 37 C waterbath (put in and then turn on waterbath) 

Saturday – Sunday (Days 10 – 11): 
MMA III curing in waterbath 

Monday (Day 12): 
Take MMA III out of waterbath and set on bench to cure one day 

Tuesday (Day 13): 
Samples should be cured and ready for sectioning 
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for chronic pain management. Three meta-analyses demonstrated reduced side effects 
with transdermal fentanyl compared to sustained release oral-morphine [7–9]. Although 
efficacious in providing post-operative analgesia, a more recent review highlighted the 
detrimental effects with prolonged opioid exposure [10]. Pre-operative opioid use has been 
linked to negative post-operative outcomes, including the need for early total knee arthro-
plasty revision [11]. Not only is premature revision often required, but pre-operative opioid 
abuse may further lead to reduced effectiveness of opioid-induced analgesia following 
total joint arthroplasty [12]. 

Despite being commonly prescribed following orthopedic procedures, the overall ef-
fect of opioids at the cellular level of cortical bone remains understudied. Characterization 
of subcellular events requires the application of histological techniques that prevent analy-
ses in living patients. This necessitates the use of animal models which mimic human bone 
remodeling in a controlled, reproducible environment. Previous researchers have explored 
the effects of opioid administration in small rodents, primarily to elucidate the impact of 
opioids on central neural pathways [13–16]. Domestic New Zealand White (NZW) rabbits 
(Oryctolagus cuniculus), however, demonstrate the potential to more accurately model hu-
man cortical bone dynamics [17]. Comparable to humans, rabbits display spontaneous 
cortical bone remodeling, whereas smaller laboratory animals (e.g., rodents) retain primary 
canals throughout their lives and exhibit little to no cortical bone remodeling [17–20]. As 
such, rabbits have been employed as a model organism in orthopedic research, including 
post-operative infection [21–23], orthopedic implants [24–27], and joint injury [28–33]. 

Despite well-documented use of opioids for post-operative pain in orthopedic pro-
cedures, and the extensive use of rabbits in orthopedic relevant research, the potential 
impact of opioid exposure on rabbit behavior and health remains understudied. Previous 
work has examined the effect of observer presence on rabbit behavior in a post-operative 
setting using morphine and tramadol hydrochloride as analgesics [34]. Other research 
has evaluated the use of fentanyl transdermal patch application in post-operative pain 
management in rabbits [35,36]. These studies, however, do not assess rabbit behavior and 
the efficacy of the transdermal delivery system over time. To that end, we present data from 
a longitudinal proof-of-principle study assessing the practicality of transdermal patches 
for rabbits in long-term opioid exposure experiments. Our overarching objectives were to 
(1) demonstrate the long-term use of injectable morphine sulfate and transdermal fentanyl 
patches in a rabbit model system, (2) examine the behavior of rabbits exposed to extended 
opioid regimens, and (3) test the hypothesis that NZW rabbits are an appropriate animal 
model system for studying the prolonged effects of opioid exposure on bone turnover for 
use in orthopedic comparative medicine. 

2. Materials and Methods 

A detailed animal protocol (18-11-12 ARC) was approved by The University of Akron 
Institutional Animal Care and Use Committee (IACUC). All research team members com-
pleted in-person training with The University of Akron Research Vivarium (UARV) attend-
ing veterinarian in proper ethical care, handling, euthanasia, and use of laboratory animals. 

2.1. Animals 

Skeletally mature, healthy, 6-month-old (2.3–3.0 kg), male NZW rabbits (Oryctolagus 
cuniculus; n = 21) were acquired from Covance Research Products Inc. (Denver, PA, USA). 
Rabbits were individually housed in stainless steel rabbit batteries with perforated plastic 
floor inserts that allowed for limited visual interaction between animals, while keeping the 
animals lodged separately. Rabbits were fed Harlan Teklad Global High Fiber Rabbit Diet 
(Envigo, Madison, WI, USA) (150 g/day) and water was provided ad libitum by way of 
hard plastic water bottles. Enrichment foods (e.g., spinach, dried fruits, papaya tablets) 
were provided daily, and enrichment devices (e.g., rattles, jingle balls, flexi-keys) were 
provided in rabbit batteries and exercise pens and changed weekly. Rabbits were placed 
in floor-based exercise pens three times weekly for a 45 min period to allow for normal 
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postural changes (e.g., hindlimb stretching, running). The housing room was maintained 
at 61 �F to 70 �F (16 �C to 21 �C), at 30% to 70% humidity, and on a 12:12/h light:dark cycle. 
The rabbits were quarantined and habituated to the testing conditions for a two-week 
period prior to experimental treatments. 

2.2. Experimental Design 

Using a random number generator, the rabbits were divided into three groups of seven 
animals each: morphine, fentanyl, and controls. The control group was further randomly 
divided into saline vehicle (n = 3) and transdermal sham patch groups (n = 4). These group 
sizes were based on the mean numbers employed in previous characterizations of this 
model for cancellous bone or cortical geometry/density [37–41]. After the acclimation 
period, experimental treatments were applied to control and opioid groups (morphine and 
fentanyl) for eight weeks. The proposed opioid dosing levels are consistent with clinical 
recommendations for analgesia in rabbits and were finalized with the UARV veterinarian. 
Drug dose was calculated based on individual rabbit weight (kg), measured at the start of 
each week. The morphine sulfate group received a dose of 3 mg/kg/day via subcutaneous 
bolus injection. The saline vehicle control group was administered saline at a dose of 
3 mg/kg/day also via subcutaneous injection. 

Transdermal fentanyl patches acted as a slow-release delivery agent and reduced the 
dosing frequency from daily to every third day. The dorsum of each fentanyl-group rabbit 
was shaved to remove fur, and a 25 µg/h slow-release transdermal fentanyl patch (Henry 
Schein Inc., Melville, NY, USA) was placed on the interscapular region, according to the 
manufacturer’s instructions. Patch size and specific dosage were selected based on data 
obtained by Foley et al. [42] and Jain et al. [35] The patches were affixed via adhesives 
associated with the patch manufacturing. Patches were further secured by applying a 
medical-grade Tegaderm™ (3M, Maplewood, MN, USA) transparent film dressing, used in 
clinical settings to cover IV insertion sites and burns. A 2% isopropyl myristate softening 
solution was applied to the skin of control patch animals and placebo patches (Tegaderm™ 
transparent film dressing) [43]. Rabbit jackets (Lomir Biomedical, Malone, NY, USA) 
were used to cover fentanyl and control transdermal patches (Tegaderm™) to prevent the 
animals from chewing, removing, or ingesting these from the interscapular region. 

2.3. Data Collection 

Daily observations were recorded and scored at consistent time points throughout 
the experiment. These records detailed normalcy, or acute changes, in fecal output, food 
consumption, appearance, and behavior. All animals were weighed weekly. 

2.4. Statistical Analysis 

Statistical analyses were performed in R version 3.6.1 (5 July 2019) (The R Foundation 
for Statistical Computing). To analyze statistical differences between drug treatment 
groups, fecal output (normal, slightly low, low, very low) and food consumption levels (full, 
moderate, low) were coded numerically. Jacket use (yes/no) was also coded numerically 
for use as a covariate. Analysis was restricted to the experimental drug treatment period, 
following acclimation. 

3. Results 

Fecal output was numerically coded as Normal = 1, Slightly Low = 2, Low = 3, 
and Very Low = 4 following comparable fecal output scoring descriptions as outlined in 
Weaver et al. [44]. Food consumption was numerically coded as Full = 1, Moderate = 2, and 
Low = 3. Mean fecal output per animal decreased from fentanyl (mean = 1.24, SD = 0.305) 
to control (mean = 1.26, SD = 0.216) to morphine groups (mean = 1.33, SD = 0.151). Mean 
food consumption per animal decreased from control (mean = 1.32, SD = 0.204) to fentanyl 
(mean = 1.49, SD = 0.362) to morphine groups (mean = 1.81, SD = 0.251). 
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Non-jacketed animals included all morphine group rabbits (n = 7) and saline control 
group rabbits (n = 3). Non-jacketed animals had lower mean fecal output (mean = 1.33 
SD = 0.283) than jacketed animals (mean = 1.23, SD = 0.152). Similarly, non-jacketed 
animals had lower mean food consumption (mean = 1.68, SD = 0.382) than jacketed animals 
(mean = 1.41, SD = 0.249). These trends may reflect the lowest fecal output and food 
consumption of morphine group rabbits, which comprise 70% of non-jacketed animals. 

Graphic representation of food consumption and fecal output (Figure 1) suggested 
that these two variables were correlated. Pearson’s correlations were used, as a Shapiro-
Wilk test indicated that all drug groups were normally distributed in both mean fecal 
output (Control: W = 0.928, p = 0.532; Morphine: W = 0.865, p = 0.167; Fentanyl: W = 0.905, 
p = 0.365) and mean food consumption (Control: W = 0.910, p = 0.394; Morphine: W = 0.927, 
p = 0.527; Fentanyl: W = 0.913, p = 0.420). Fecal output and food consumption were strongly 
(r = 0.5–1.0) and significantly (p < 0.05) correlated for all drug groups (Control: r = 0.821, 
p = 0.034; Morphine: r = 0.901, p = 0.006; Fentanyl: r = 0.857, p = 0.024). 

Figure 1. Correlation between mean food consumption (solid green line) and mean fecal output (solid brown line). Data 

points indicate food consumption (green) and fecal output (brown) for individual animals. Study timepoints include drug 

treatment initiation (red vertical line) and subsequent calcein injections (green vertical lines). For morphine rabbits, mean 

food consumption is depressed relative to mean fecal output between the drug treatment start date and the third injection. 

A one-way ANCOVA indicated that fecal output was not significantly impacted by 
either the main effect of drug treatment group (F(2, 17) = 0.286, p = 0.755, ⌘p2 = 0.033, 
power = 0.095) or the co-variate of jacketing (F(1, 17) = 0.451, p = 0.767, ⌘p2 = 0.511, 
power = 0.103). ANCOVA was suitable for this analysis as a Shapiro-Wilk test indicated 
that residuals were normally distributed (W = 0.930, p = 0.211). A Levene’s test confirmed 
homogeneity of variances (F = 0.877, p = 0.433). 

The main effect of drug treatment group did have a significant effect on food con-
sumption, as indicated by a one-way ANCOVA (F(2, 17) = 5.441, p = 0.0149, ⌘p2 = 0.390, 
power = 0.841). A retrospective power analysis confirmed that our drug treatment group 
size (n = 7) exceeds the per-group sample size (n = 6.14) needed to obtain the observed 
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effect size (Cohen’s f = 0.8) at the recommended 0.80 power Mean food consumption 
followed the pattern Control > Fentanyl > Morphine. Post-hoc analyses with Tukey’s 
HSD indicated that differences in mean food consumption reached statistical significance 
only for the Control > Morphine pairwise comparison (p = 0.012). Food consumption did 
not significantly differ between control and fentanyl groups (p = 0.501) or fentanyl and 
morphine groups (p = 0.118). The co-variate of jacketing had no significant effect on food 
consumption (F(1, 17) = 0.177, p = 0.680, ⌘p2 = 0.010, power = 0.07) (Figure 2). 

Figure 2. Non-significant differences between jacketed (dark blue) and non-jacketed (light blue) animals in both fecal 
output and food consumption. Study timepoints include drug treatment initiation (red vertical line) and subsequent calcein 

injections (green vertical lines). 

ANCOVA was suitable for this analysis as a Shapiro-Wilk test indicated that residuals 
were normally distributed (W = 0.958, p = 0.474) and a Levene’s test confirmed homogeneity 
of variances (F = 1.611, p = 0.227). The injection route of analgesic administration further 
appeared less stressful for the animals qualitatively when compared to fentanyl rabbits. 
Yet, the morphine sulfate injections consistently resulted in severe sedation within the first 
hour following dosing. 

4. Discussion 

Here, we provide a novel longitudinal perspective on opioid delivery in a rabbit animal 
model via transdermal fentanyl patch application for experimental research. Prior studies 
have reported limited concomitant effects of short-term use. Foley and colleagues [42] eval-
uated the efficacy of transdermal fentanyl patch administration in NZW rabbits. Animals 
were treated with fentanyl patches for one patch application cycle (72-h). Skin irritation 
was noted by the authors [42]; however, it was largely attributed to shaving the animals’ fur 
for patch application. More recently, Mirschberger and colleagues [36] examined the use of 
transdermal fentanyl patches in rabbits on three different patch locations in the context 
of post-operative pain management. Their group reported that the neck and outer ear 
surface were the best options for transdermal patch placement. Their experimental period 
was 120-h and the authors reported associated erythema and animals attempting patch 
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removal. Ultimately, the authors concluded that transdermal patches are an acute and 
effective delivery route for pharmacologic analgesics. Additionally, Jain and colleagues [35] 
examined how opioid administration delays recovery and bone healing following spinal 
fusion surgery in a rabbit model. In this study, animals were treated with transdermal 
fentanyl patches for 10 weeks (four weeks pre-operatively and six weeks post-operatively). 
No information was reported regarding subject skin condition in relation to treatment 
with transdermal fentanyl patches. Although transdermal fentanyl patches have been 
documented as an effective pain relief agent in such clinical settings, we report novel 
side effects correlated with prolonged use which have implications for efficacy in the 
laboratory setting. 

4.1. Skin Irritation Resulting from Prolonged Patch Application 

Long-term transdermal fentanyl patch treatment presented several qualitative chal-
lenges for overall rabbit health and experimental facilitation by lab personnel. Specifically, 
rabbit chewing, and removal of transdermal patches had to be countered with patch 
re-application, telemetry jackets and VetWrap™ (3M, Maplewood, MN, USA; Figure 3). 
Grooming restrictions and excessive chewing behaviors were imposed by the coverings. 
These limitations, combined with a strong adhesive associated with the fentanyl patches, 
resulted in notably irritated, flaky, and bruised patch application sites compared to the 
other groups (Figure 4). Surrounding fur was further matted and compressed (Figure 5). 

While transdermal patches did not require daily application, this mode of drug 
delivery incited the need for daily patch checks and preventative measures to counter 
chewing behavior and skin irritation. Initially following patch application, certain rabbits 
began chewing the patch and dressings, and exhibited marked grooming surrounding the 
associated skin and fur. Fentanyl group rabbits were more commonly observed displaying 
such behaviors, compared to control group rabbits with only Tegaderm™ patch treatment. 
This difference may be due to the increased adhesive residue left behind by the fentanyl 
patch or a differential behavioral response associated with opioid delivery. 

Figure 3. Fentanyl patch rabbit with applied VetWrap™ to prevent treatment patch chewing 

and manipulation. 
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unzip and remove the jackets on multiple occasions but did not attempt to remove or ingest 
the patch. 

Jackets that rubbed against the patch application sites were observed to lift the Tega-
derm™ dressings and loosen the patches’ adhesive edges. When jacket removal or patch 
loosening was observed, the back and chest of the rabbit were wrapped with VetWrap™ to 
prevent patch manipulation. Rabbits commonly attempted to pull the VetWrap™ from un-
derneath the jacket and chew it open, with fentanyl rabbits spending significant portions of 
their observation time continually chewing/pulling the jackets and underlying VetWrap™. 
These behaviors required repeated replacement of jackets that were chewed beyond repair. 
By the study’s end, patch presence and adherence needed to be checked daily, negating the 
time-saving qualities of applying a slow-release patch versus daily subcutaneous injection. 

Additionally, fentanyl group rabbits commonly developed contusions or abrasions 
after a series of patch removal events (Figure 6). Compared to the Tegaderm™ dressing, the 
fentanyl patch adhered very tightly to the skin and was difficult to remove when associated 
with adjacent fur or areas of new fur growth. Over the 72-h patch cycle, adhesive residue 
became tightly bound to the skin. These adhesive deposits could not be easily removed 
from bare skin and required the underlying hair follicles to grow out enough to allow for 
removal with clippers. Consequently, we typically adjusted patch placement immediately 
laterally, rostrally, or caudally to the original application site to avoid existing bruising, 
erythema, or adhesive buildup Restraining an increasingly irritated rabbit was difficult 
and time-consuming during the process of patch removal, fur clipping, patch re-application, 
antibacterial ointment application to contusions, VetWrap™ application, and jacketing. 

Figure 6. A representative example of skin irritation and contusions from prolonged use of trans-
dermal fentanyl patch placement. (A) displays patch placement with Tegaderm™ covering applied. 
(B) shows the same animal with the fentanyl patch removed. Note the adhesive residue and matted 

fur from previous patch placement in the superior portion of both figures. 

4.2. Opioid Effects on Fecal Output and Food Consumption 

Analysis of fecal output revealed no significant influences from drug treatment or 
jacket use. The common side-effect of constipation from chronic opioid use [45] was 
not observed in morphine or fentanyl treatment groups, compared to controls. Food 
consumption was significantly impacted by the drug treatment, with morphine group 
rabbits consuming significantly less food on average than control or fentanyl group rabbits. 
Morphine group rabbits experienced a qualitative change in activity within the first hour 
after dosing, appearing sedated and sedentary, which was attributed to the subcutaneous 
delivery of the bolus. Since all rabbits were fed daily with base and enrichment foods 
following dosing, sedation during the initial delivery of new food may have reduced overall 
food consumption for morphine group rabbits. Fecal output and food consumption were 
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strongly and significantly correlated. Control group and fentanyl group rabbits maintained 
this correlation throughout the study. Graphic visualization (Figure 1) indicated that 
morphine group rabbits dropped in mean food consumption, relative to mean fecal output, 
after the drug treatment start date. Mean food consumption, however, increased over 
this depressed period, suggesting that morphine group rabbits became acclimated to the 
sedative effect over the course of the study. Mean fecal output and food consumption are 
aligned for morphine group rabbits. 

Although fentanyl group rabbits were acutely agitated by the application of jackets, 
collars, VetWrap™ (3M), and tightly adhered patches, these devices did not significantly 
affect their food consumption or fecal output in comparison to controls. Notably, jacket use 
also had no significant effect on fecal output or food consumption across jacketed control 
and fentanyl group rabbits. 

Certain animals across each opioid group presented with acute anorexia, which was 
associated with abnormally low fecal output. No direct causes of anorexia were identified 
apart from one rabbit who sustained a laceration of the lower gingiva and was treated with 
a chlorohexidine rinse. All animals exhibiting this trend regained normal gastrointestinal 
motility within one week of onset. 

4.3. Limitations 

Longitudinal blood collection was not conducted to assess plasma opioid concentra-
tion at different timepoints throughout the dosing period. Regular blood draws would 
have increased stress for the animals due to the employment of rabbit restrainers and 
were discouraged by attending veterinarians given the stress behaviors witnessed. This 
exclusion presents challenges for determining the circulating level of opioid in the blood 
of the animal. Consequently, the experimental dose was based on literature from pre-
existing studies where acute opioid delivery was assessed in similar rabbit models with 
established success [42]. In addition, our study did not employ quantitative measures for 
determining food consumption or fecal output (e.g., obtaining weights of these variables). 
Daily observations were performed and recorded, however, by a consistent technician team 
with extensive rabbit husbandry experience. These observations were further consistent 
with previously published scoring descriptions provided by Weaver et al. [44]. It is also 
important to note that animals may have obtained higher doses of opioids via subcuta-
neous injection due to difficulties with jacket compliance in the fentanyl group. As such, 
a promising area for future experimentation may involve the administration of opioids 
via osmotic pumps [46]. While likely not capable of spanning the longitudinal duration of 
this study, a revised administration route may prevent a low-maintenance alternative to 
slow-release transdermal patch application. 

4.4. Bone Remodeling and Transdermal Fentanyl Patches 

To better characterize the effects of chronic opioid use on bone remodeling, rabbits 
offer a promising model system as they are the smallest traditionally used laboratory 
animals with well-defined cortical remodeling [17]. As a result, rabbits have been used 
as experimental animals for studying central canal size and the vascular network of 
cortical bone [18,19]. Bone remodeling can be highly influenced by mechanical loading 
properties (including force strength, frequency, duration), resulting in increases in bone 
deposition [47]. While there are documented differences in mechanical loading properties 
following chronic opioid administration [48], it is critical to note that restrictions imposed 
via jackets, VetWrapTM, and pillow collar can influence bone remodeling, as evidenced 
by behavioral changes in canine studies [49]. Thus, researchers must remain consistent in 
strategic interventions to prevent patch removal across treatment and control groups. It 
is possible that the extrapolation of these data to the context of the greater literature may 
result in inconsistencies for jacketed, patch administration animals. This evidence further 
supports our recommendation to refrain from using transdermal patches for longitudinal 
opioid delivery in a rabbit model in the context of bone research. 
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5. Conclusions 

Rabbits have served as model organisms to test the efficacy of prophylactic antibiotics 
following surgery [21–23], new biocompatible implants and hardware [24–28], and to 
mimic bone and tendon pathological states [28–32]. These studies highlight the benefit 
of the use of rabbits in comparative research to explore novel therapeutic methods in the 
orthopedic field. The literature, however, fails to consider the practical use of rabbits as a 
model organism when administered opioid analgesics. Although the use of transdermal 
fentanyl patches for rabbit analgesia may be preferred in an acute clinical setting, this 
delivery method is not feasible for long-term pain relief or opioid delivery in a laboratory 
context. In the current study, all animals subjected to transdermal fentanyl patch application 
consistently displayed erythema and continuously attempted to remove patches, which 
resulted in acute animal stress and an increased time commitment for lab personnel. In 
contrast, the morphine sulfate injection group did not demonstrate detrimental changes in 
fur appearance or overall health, though these animals consumed less food throughout 
the study. There were no significant effects of opioid administration on fecal output, with 
morphine group rabbits regaining normal correlation with food and fecal output for the last 
fourth of the experimental period. The observed sedative side-effects of the subcutaneous 
delivery of a larger opioid dose could have implications for individuals hoping to assess 
metabolic performance or other time-sensitive metrics. With the drawbacks associated with 
transdermal patch opioid administration, we suggest that orthopedic researchers employ 
an alternative administration route when conducting longitudinal opioid studies. In future 
work, we plan to evaluate the prolonged impact of longitudinal fentanyl administration 
via subcutaneous injection on bone turnover in a rabbit model system, while controlling for 
indirect confounding effects of opioid exposure including caloric intake, hormonal effects, 
and exercise regimens. 
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Appendix XI: Rabbit Opioid SkyScan PCT SOP 

Cutting Tibia 

1. Thaw the tibia inside the tube the day before the scan by moving it from the freezer to the 
refrigerator. Alternatively, set out the tibia in the chemical hood for approximately 30 minutes. 

2. Put on proper PPE – double gloves, lab coat, goggles. You may want a face shield or mask during 
the waterpik portion to prevent splashback. 

3. Unwrap tibia 

4. Use the calipers to measure 87 from proximal end to the distal shaft. Mark this circumference on 
the bone 

5. Set up the isomet and sharpen the larger 8 inch blade if this has not been done recently 

6. Clamp bone in the small chuck and cut off the distal end at this line. 

7. Wash out the inside of the bone with the waterpik inside the sink. A tube of fat will likely fall out 
of the marrow cavity 

8. Wrap bone as indicated below 

9. Rewrap the cut distal end in the saline soaked gauze and replace in the tube 

10. Spray the outside of the tube, isomet surface, chuck, isomet blade, water pik, inside of the sink, 
and your working surface with 10% bleach and dry with a paper towel, or use a Clorox wipe to 
sterilize. 

11. Place wrapped tibia in a plastic sample bag with the tube alongside to maintain provenience. 

12. If you are scanning the next day, place tibia in the refrigerator. If you are scanning in several 
days, freeze the tibia. 

Wrapping and Orientation Markers 

1. Pre-cut your parafilm 
a. You will need approximately four squares and two double-squares of parafilm per bone 
b. Stretch the parafilm thin between your fingers before wrapping. As you wrap, pull the 

parafilm taut and press it down onto the bone to adhere it to previous layers. 

2. Wrap the proximal end using a single square of parafilm. Repeat for the cut distal end. 
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3. Wrap the shaft using a double-square of stretched parafilm. Wrap one end of the bone, and then 
proceed in a diagonal wrapping manner to reach and wrap the other end of the bone. Repeat this 
process with the second double-square of stretched parafilm. 

4. Make sure there are no exposed tissue regions or leakage – if water is drawn out of the bone 
during scanning through a leak, the bone may move. 

5. Spray the outside of the parafilm with 10% bleach (in the spray bottle by the grinder sink) and dry 
with paper towels. Or use Clorox wipes to sterilize the external surface of the parafilm-wrapped 
bone. 

a. You also need to sterilize the outside of the tube, your working surface, and any tools 
used on this unfixed tissue 

b. Change your gloves before proceeding 

6. Select a foam “A” and place it upside down just under the tibial crest. Fill the triangular hole in 
the “A” with modeling clay or sticky tack.  

7. Select a foam “M” and place it upside down on the medial side of the bone, directly adjacent to 
and at the same level as the foam “A”. Fill the triangular divot in the “M” with modeling clay or 
sticky tack. You will need to squish the sides of the “M” to get it to fit on the medial side. 

8. Cover the letters with a half-square of stretched parafilm to hold them in place. 

9. It is recommended to draw the outline of the tibial diaphysis on the outside of the parafilm with 
Sharpie, so that it is easier to position. 

10. Place the wrapped bone and the tube in a plastic sample bag to transport to the microCT 

Turning On the Micro-CT 

1. Turn on SkyScan 1172 machine using the ‘ignition’ key on the right side. Turn the key to the 
middle then to the right. 

2. Open the software on the computer, Skyscan 1172 shortcut. 
o Select yes 

3. Select the hazard/radiation symbol (yellow) and wait 15 minutes for the X-ray tube to warm up 

4. While the tube is warming up, prepare sample on the machine platform with dental wax and wrap 
the bottom in parafilm. 

a. Use dental wax to fully plug the smaller stage. The tibia needs to sit just above the metal 
rim on a platform made of dental wax. 

b. You will need to invert the tibia so that the proximal end is on the stage and the distal 
(cut) end points up 

c. Cover the proximal end of the tibia with dental wax and press the dental wax down onto 
and around the edges of the stage. 
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d. For proximal end scans: Center the entire proximal end on the stage over the central 
peg below the stage 

e. For diaphyseal scans: Center the diaphysis on the stage over the central peg below the 
stage. The fibular region will likely hang somewhat off the stage, so reinforce it with 
dental wax underneath. The entire bone will also be tilted off its central axis so that the 
tibial diaphysis alone is vertically oriented over the central peg. 

f. Wrap the dental wax base in a stretched square of parafilm. Check and re-position the 
tibial orientation after wrapping as it may have moved. 

Alignment (Once Per Day) 

1. Select Options tab→Select Ctrl+Alt+Shift+S to make grayed out options (Acquisition 
Mode/Alignment) appear 

2. Make sure no filters applied 

3. Select open door button and insert taller calibration peg, then close the door 

4. Click the TV button to make the alignment peg appear on screen 

5. Options→ Alignment → Yes 
• Machine will run the alignment automatically. It may say “Not Responding”. When 

responding, the scanner will place hash marks on the alignment peg’s anatomical center 
and rotate the stage 360° 

6. If the scanner asks if you want to compensate for misalignment by camera movement, click Yes 

7. Remove alignment pin 

Flatfield Correction 

1. Options → Preferences → Uncheck the two boxes to the right of flatfield 
a. The two boxes to the right of median filter should be checked 

2. Click voltage symbol (') to set at 74 kV. Source current should be 134 uA. 
a. To achieve this combination, uncheck the box to keep power maximized 
b. You can use the arrow keys to adjust voltage/current stepwise if you click on the button 

next to the voltage/current 

3. TV button (Live View) 

4. Right click to bring up average current measurement on screen 

5. Adjust filters at the bottom of the screen 
a. Filter: Al 0.5 mm ÅWill auto-change voltage, so check it 
b. Image pixel size: 

i. 5.5 um for diaphysis (will change to 5.49) 
ii. 11 um for proximal end (will change to 10.99) 
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c. Camera size: Medium Camera, 2000 columns x 1300 rows 
d. The vertical stage position does not need to be constant 

6. Let current average drop to a60% +/- 2 
5. Options→Acquisition Modes 

o Acquire bright + dark for current mode = OK 
o Use central positioning 
o Turn off xrays after acquiring 
o Don’t modify any other settings 

Sample Positioning 

1. Put in sample 

2. TV button (Live View) 

3. Options → Preferences → Check two boxes to the right of flatfield again 

4. Double click on height at the bottom tab to raise the sample into the field of view (FOV) 
a. Place the clay markers at the bottom of the FOV for the tibia scans 
b. Can increase resolution to zoom out and see if centered 
c. Check orientation by rotating to 90° and 180° 

i. Recommended 10° increments if you are unsure whether it is out of the FOV 
ii. You may need to move the sample down slightly to a slimmer region, but keep 

majority of clay markers in the FOV 
d. Open door and reorient sample if its longest width does not fit within the FOV 
e. Check voltage and resolution each time you open the door – the system may reset it 

Scan Setup 

1. Options → Preferences: Make sure the two boxes to the right of Flatfield and to the right of 
Median Filter are checked 

2. Options→Acquisition (from Cooper Lab SOP) 
• Rotation Step (deg)=0.200 
• Frame Averaging=ON (4) 
• Random Movement=OFF (0) 
• Use 360 Rotation=NO 
• Camera Offset=OFF 

3. From lab SOP: 
o Modify file path and prefix - Browse→Select file→new folder→rename file 
o Xray off after scanning 
o Uncheck open door after scan 
o Uncheck partial width 

4. Check voltage, pixel size, filter, camera size to see if they changed 
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5. Right click the screen to show gray levels. Wait a minute for them to stabilize. Stabilization may 
take long if the door was open for a long time. 

6. Select blue arrow “recycle” button and begin scan 

7. Log out manually or remotely on FOM near end of start time! 

2018-DU-BX-0188 Final Technical Report 
October 2021 

This resource was prepared by the author(s) using Federal funds provided by the U.S. 
Department of Justice. Opinions or points of view expressed are those of the author(s) and do not 

necessarily reflect the official position or policies of the U.S. Department of Justice.

157 



 
 

   

 
 

 
 

  
   

     
    
   

  
   
    
 

   
  
  
   

  
  
  

   
   

 
    
  
  
  

   
  
  
  
    

 
      

   
   

    
  

  
  

 
   

   

Appendix XII: Rabbit Opioid PCT Image Processing SOP 

NRecon 

NRecon converts the microCT acquisitions (projections) into cross-sectional slices called reconstructions. 

1. Click on the NRecon shortcut on the Desktop 
a. The GPUReconServer will pop up. You can minimize this window.  

2. Open dataset… should pop up. If not, click the folder at the upper left hand corner of dataviewer. 
3. Click on the first projection from your micro-CT acquisition 
4. Under Output: 

a. Uncheck Use ROI 
b. Uncheck Scales ON 
c. Destination: Browse and create a new folder called “Recon” 
d. File format: BMP(8) 

5. Under Advanced: No changes needed. Defaults should be: 
a. Smoothing kernel: Gaussian 
b. Uncheck Undersample 
c. Uncheck Defect pixel masking 

6. Under Settings 
a. Check Smoothing: 1 
b. Check Misalignment Compensation 

i. Typically this estimation is close to correct. You can manually adjust the arrows 
up and down to move the image so that the right and left edges align as closely as 
possible. 

c. Uncheck Object larger than field of view 
d. Check Ring artifacts: 10 
e. Check Beam Hardening: 30% 
f. CS rotation (deg): 0.00 

7. Under Start → Fine Tuning 
a. Select Post-Alignment 
b. Number of Trials = 5 
c. Parameter Step = 0.5 
d. Click Start and five images will be generated under Output. You can switch between 

them using the arrow keys on the top toolbar, and zoom in and out using the magnifying 
glasses on the top toolbar. 

i. Select the image that minimizes overlapping or shadowing at the edges of larger 
pores. Try to maximize the number of small, round pores that are visible. 

ii. If you cannot see the porosity, click Output. Click Auto. Move the right-side bar 
closer to the histogram peaks. This will increase brightness. 

e. The Alignment for your chosen image appears in the very bottom border of NRecon 
under “Fine-tune(PA:)” Make sure that this is also selected under Settings: Alignment. 

i. Copy the Alignment value into the Google Sheets document under NRecon 
Alignment 

8. Adjust the histogram under Output by clicking Auto. The resulting image will be dim! We will 
adjust this more accurately in ImageJ later. 
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9. Under Start, click Start to begin processing. 

Anatomical Tomo Rotation 

The reconstructed images will be referred to as “tomo” (tomographic) images throughout this guide. We 
want to orient the image so that anterior is up and medial to the right of each image slice. Clay markers 
have been included with the micro-CT scan to indicate anterior and medial orientation. We will rotate the 
image in DataViewer. 

1. In File Explorer, open the new Recon folder 
a. Move the spr projection and the text file to a new subfolder “Files” so that they do not 

disrupt image processing 
2. Load the tomo files from the reconstruction in Dataviewer 

a. Click the DataViewer shortcut on the desktop 
b. Click the folder in the top left corner 
c. In the popup window, navigate to the “Recon” folder and click the first image file in the 

folder 
d. Change “Open As” dropdown box to “3D View” 
e. Do not check the Resize box 
f. Click Open 

3. Click View → Rotate/Shift Operations → Rotate 180 degrees 
a. Wait a moment for the image to rotate. On the transaxial (lower left) cross-sectional 

image, one clay marker should be approximately on the top and the other clay marker 
should be approximately on the right. 

4. Click in the approximate center of the marrow cavity on the transaxial (lower left) image to move 
the crosshairs to that location 

5. Rotate the transaxial (lower left) cross-sectional image by holding down Ctrl and clicking and 
dragging the mouse cursor 

a. To get a better view of the clay markers, move the Z-level of the transaxial cross-section. 
i. Or click in the coronal (top) or sagittal (lower right) windows to reposition the 

cross-hairs on a thicker part of the clay marker 
b. For the tibia, the anterior clay marker is on the pointed end (tibial crest). Rotate the 

transaxial image until the middle of the anterior clay marker intersects with the vertical 
line of the crosshairs. 

c. You may need to reposition the crosshairs in the center of the marrow cavity by clicking. 
d. The horizontal line of the crosshairs should approximately intersect the medial clay 

marker on the right side. However, it may not be in the center of the medial clay marker. 
6. Click View → Rotate/Shift Operations → Rotate to Any Orientation 

a. The Image Rotation window will pop up 
b. Copy the values for Alpha, Beta, and Gamma into the Google Sheets file under Tomo 

Alpha, Tomo Beta, and Tomo Gamma, respectively 
i. Tomo Alpha should always be 270 

ii. Tomo Beta should always be 180 
iii. Tomo Gamma will be variable as it is the transaxial rotation value 

c. Click Cancel in the Image Rotation window 
7. Save the rotated image stack using Actions → Save → Transaxial (X-Y) Images as Dataset 
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a. Two popups will warn you that the image is rotated and that output will be 8-bit. Click 
OK for both. 

b. Save in a new folder “Anatomical Tomo” as type (8bit)BMP(*.bmp) 

Femur: Tomo file before (left) and after (right) anatomical rotation. 
Note that the linea aspera often points more to the left. Anterior is at the top of the transaxial 

image, and medial is at the right. 

Tibia: Tomo file before (left) and after (right) anatomical rotation. 
Note that the anterior clay marker (top) sits on the tibial crest. Anterior is at the top of the 

transaxial image, and medial is at the right. 

TA Extraction 

Now that the tomo files are oriented anatomically in a cross-sectional sense, they must also be adjusted 
vertically. We will orient the filled total area (TA) mask of the tomo image stack, which we first extract in 
Batman, which is the batch manager for CTAnalyser. This uses a custom macro I made for this purpose. 
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1. Navigate to the new Anatomical Tomo folder. The first and (sometimes) last image file are partial 
cross-sections due to the slight rotation. Move the partial cross-sections and the text file to a new 
subfolder called “Partial” 

2. Click the Batman shortcut on the Desktop 
3. Click Import. Navigate to Local Disk (D:) → Rabbit Opioid Scans Backup → CTan Macros →

TAExtractor.ctt. Click Open and the macro will load. 
4. Click Add. Open the Anatomical Tomo folder. Click the first image. Click Open. 

a. Do not check the box to resize the image 
b. You can load multiple Anatomical Tomo image stacks if you have several ready to go. 

Click Add for each image stack and they will line up to batch process. 
5. Click the arrow next to Properties → Change Pixel Size. Make sure the pixel size is 5.49426 um 

for All Datasets. 
6. Make sure the boxes are checked next to all of the loaded Anatomical Tomo files 
7. Click Start and the macro will run on its own. 

c. The Anatomical Tomo folder will receive a subfolder labeled TA 

Femur: Anatomical Tomo file (left) and TA mask (right) created by CTan macro 
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Tibia: Anatomical Tomo file (left) and TA mask (right) created by CTan macro 

Skeletonization 

Due to the curved nature of the femoral shaft and the imperfect manual positioning in the micro-CT, the 
shaft is not completely vertical within the field of view. We want to rotate the shaft segment to its most 
vertical orientation so that pore orientations relative to the longitudinal axis will be correct. We do this by 
skeletonizing the TA image stack, vertically orienting the skeleton, and then using the same vertical 
orientation for the anatomical tomo image stack. This procedure is based on Behrooz et al. 2017. This 
protocol runs through a macro that prompts the user to select the output folder and open the image stack. 
The protocol automatically skeletonizes TA, dilates it three times for visibility, and saves it in the user-
selected output folder. 

1. Open ImageJ 
2. Install the Skeleton Save macro 

a. Open Plugins → Macros → Install, which will pop up the macros filter 
b. Click Skeleton Save.ijm then Open 

3. Click Plugins → Macros → Skeleton Save 
4. In the popup Select_Output, navigate to the Anatomical Tomo folder 

a. Create a new subfolder “Skeleton” 
b. Enter the Skeleton folder 
c. Click Select 

5. You will be prompted to open Image Sequence 
a. Navigate to the TA folder, and enter it so that the TA images appear. 
b. Click the first TA image 
c. Click Open 

6. The Sequence Options window will open. 
a. Make sure Sort Names Numerically is checked 
b. Don’t check any other boxes, and make sure Use Virtual Stack is not checked 
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c. Click OK 
7. Allow the macro to run on its own 

a. Warning: This procedure has many thinning iterations and will take approximately half a 
day to run. You can run multiple skeletonizations in separate ImageJ windows. However, 
the more you have open, the longer each procedure will take. 

8. Load the completed skeleton in DataViewer 
a. Click the DataViewer shortcut on the desktop 
b. Click the folder in the top left corner 
c. In the popup window, navigate to the “Skeleton” folder and click the first image file in 

the folder 
d. Change “Open As” dropdown box to “3D View” 
e. Do not check the Resize box 
f. Click Open 

9. Enter pixel sizes in the User Input popup window: 5.49426 um for both X and Y pixel size 
10. Re-orient the skeleton longitudinally 

a. In the transaxial window (lower left), use the cursor to click on a bright dot. You may 
have to scroll through the slices using the “Z” position on the toolbar to the left 

b. The skeleton should appear in the coronal (top) and sagittal (lower right) windows 
c. Hold down Ctrl on the keyboard and click in the coronal (top) window. 

i. Still holding down Ctrl, move the mouse to rotate the skeleton until it is aligned 
with the vertical bar. You can click inside the coronal window to reposition the 
vertical bar. 

d.  Hold down Ctrl on the keyboard and click in the sagittal (bottom right) window. 
i. Still holding down Ctrl, move the mouse to rotate the skeleton until it is aligned 

with the vertical bar. You can click inside the sagittal window to reposition the 
vertical bar. 

11. Find the revised coordinates of the rotated skeleton 
a. In DataViewer, click View → Rotate/Shift Operations → Rotate to Any Orientation 

i. The Image Rotation window will pop up 
b. Copy the values for Alpha, Beta, and Gamma into the Google Sheets file under TA 

Alpha, TA Beta, and TA Gamma, respectively 
c. Click Cancel in the Image Rotation window 

12. Rotate the anatomical tomo files to match the skeleton orientation 
a. In DataViewer, click the folder in the top left corner 
b. In the popup window, navigate to the “Anatomical Tomo” folder and click the first image 

file of the tomo sequence in the folder 
c. Change “Open As” dropdown box to “3D View” 
d. Do not check the Resize box 
e. Click Open 
f. In DataViewer, click View → Rotate/Shift Operations → Rotate to Any Orientation 

i. The Image Rotation window will pop up 
g. Enter the values for TA Alpha, TA Beta, and TA Gamma that you copied from the 

skeleton 
i. A popup will warn you that 3D values will be loaded from the memory buffer. 

Click OK. 
h. Click OK and the Anatomical Tomo image will rotate to its most vertical orientation 
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i. Save the rotated image stack using Actions → Save → Transaxial (X-Y) Images as 
Dataset 

i. Two popups will warn you that the image is rotated and that output will be 8-bit. 
Click OK for both. 

ii. Save in a new folder “Centerline Anatomical Tomo” as type (8bit)BMP(*.bmp) 
13. Remove partial anatomical tomo files 

a. Near the top and bottom of the anatomical tomo file stack, cross-sections will be cut off 
by the image rotation. Move these to a folder called “Partial” 

i. Also move the text file created by DataViewer to this folder 
b. If you cannot clearly see if a file is cut off, click and drag the Centerline Anatomical 

Tomo folder from File Explorer into ImageJ. Or click File → Open → Image Sequence 
and click on the first image file in the Centerline Anatomical Tomo folder. 

i. Check the box “Use Virtual Stack” and click Yes. 
ii.  Scroll through the image stack to see which files are partial. Note their file 

numbers so you now which images to move. 
c. Record the start and end file numbers in the Google Sheets document under Tomo Start 

and Tomo End. Number of slices will calculate automatically. 

TA Skeleton Before (Left) and After (Right) Vertical Rotation 
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Anatomical Tomo Before (Left) and After (Right) Vertical Rotation 

ROI and TA Extraction 

In order to calculate percent porosity, we need a region of interest (ROI) mask of the cortex. We will 
extract this from the centerline anatomical tomo image in Batman. This macro will also extract the 
correctly oriented TA, which we will use to calculate relative cortical area later. 

1. Click the Batman shortcut on the Desktop 
2. Click Import. Navigate to Local Disk (D:) → Rabbit Opioid Scans Backup → CTan Macros 
→ ROIandTAExtractor.ctt. Click Open and the macro will load. 

3. Click Add. Open the Centerline Anatomical Tomo folder. Click the first image. Click Open. 
a. Do not check the box to resize the image 
b. You can load multiple Centerline Anatomical Tomo image stacks if you have several 

ready to go. Click Add for each image stack and they will line up to batch process. 
4. Click the arrow next to Properties → Change Pixel Size. Make sure the pixel size is 5.49426 

um for All Datasets. 
5. Make sure the boxes are checked next to all of the loaded Centerline Anatomical Tomo files 
6. Click Start and the macro will run on its own. 

a. The Centerline Anatomical Tomo folder will receive subfolders labeled ROI and TA 
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Femur: The centerline anatomical tomo file (left) and the cortical area ROI (center) and TA mask 
(left) created by the custom CTan macro 

Tibia: The centerline anatomical tomo file (left) and the cortical area ROI (center) and TA mask 
(left) created by the custom CTan macro 

Porosity Extraction 

We extract the pores from the centerline anatomical tomo image using histogram enhancement followed 
by local (neighborhood) thresholding with a low-contrast Phasalkar filter. This is a custom macro I made 
that runs automatically. The required inputs are the centerline anatomical tomo image and its ROI mask, 
which is used to eliminate noise outside of the cortex. 

1. Within the Centerline Anatomical Tomo folder, move the tomo images to a subfolder “Tomo”. 
This will make them easier to find during the macro prompts. Exclude the Batman output files. 

2. Open ImageJ from the Desktop shortcut.  
3. Open Plugins → Macros → Install, which will pop up the macros filter 
4. Click Adaptive Thresholding.ijm then Open 
5. Click Plugins → Macros → Adaptive Thresholding 
6. In the popup Select_Tomo_Images, navigate to your Centerline Anatomical Tomo folder and 

enter the Tomo subfolder. 
a. Click Select 
b. Note: You will not see any images appear 
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7. In the popup Select_ROIs, navigate to your Centerline Anatomical Tomo folder and enter the 
ROI subfolder. 

a. Click Select 
b. Note: You will not see any images appear 

8. In the popup Select_Output, navigate to your Centerline Anatomical Tomo folder and click the 
New Folder icon (folder with a starburst). 

a. Create a new subfolder “Pores” 
b. Enter the Pores folder 
c. Click Select 

9. The macro will run automatically. It will pop up a threshold window. You can view progress by 
looking at the Pores folder in File Explorer, where the extracted pore images will appear. 

10. You can run multiple pore extractions simultaneously, but they must be in separate ImageJ 
windows. 

Femur: The centerline anatomical tomo file (left) and the extracted porosity (right) 
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Tibia: The centerline anatomical tomo file (left) and the extracted porosity (right) 

Pore Morphometry 

A custom macro for Batman runs 3D pore morphometry on the porous cortex (bone = white, pores = 
black) to extract porosity, and on the isolated pores (bone = black, pores = white) to extract summed and 
individual object pore morphometry. The output is a summary morphometry .csv file, and individual 
object morphometry .csv file, and folders containing grayscale images representing trabecular thickness, 
trabecular separation, and individual object size. 

1. Click the Batman shortcut on the Desktop 
2. Click Import. Navigate to Local Disk (D:) → Rabbit Opioid Scans Backup → CTan Macros →

PoreMorphometry8-27-2019.ctt. Click Open and the macro will load. 
3. Click Add. Open the Pores folder. Click the first image. Click Open. 

a. Do not check the box to resize the image 
4. Click the down arrow next to Add. In the popup menu, select Load ROI. 

a. Navigate to the ROI subfolder of Centerline Anatomical Tomo 
b. On the lower right dropdown menu, change ROI files (.roi) to Bitmap files (.bmp). The 

list of ROIs should appear. 
c. Click the first image on the list, then Open 
d. You will be warned that the ROI will be monochrome. Click OK. 

5. You can load multiple Pores and matched ROIs in this manner. 
6. Click the arrow next to Properties → Change Pixel Size. Make sure the pixel size is 5.49426 um 

for All Datasets. Note that pixel size must typically be changed at this point, because the 
resolution data is lost through ImageJ processing. 

7. Make sure the boxes are checked next to all loaded Pores files 
8. Click Start and the macro will run on its own. 
9. The macro should output: 

a. A _.batman file containing summary pore data 
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b. A _i3d file containing individual pore data 
c. TBTH: Image stack of trabecular thickness 
d. TBSP: Image stack of trabecular separation 
e. Individual Objects by Size: Image stack 
f. Note: The three image stacks use grayscale coding of the lowest values (approximate to 

black) so they will not be very visible on the actual image. However, they can be seen 
clearly in Dragonfly or Amira. 

Pore Morphometry Data Transfer 

Open the spreadsheet file in D:/Rabbit Opioid Scans Backup/Statistics/Excel Spreadsheets -
Colored/Total Pore Statistics – 100 um Despeckling 

In the _.batman file, the first set of results represents porosity measurements of black pores on white 
bone. 

Copy the following data from the first “Morphometry Results” vertical column to the boxes listed under 
“From First Vertical Column”. These headers are highlighted in blue. 

• Fractal dimension 
• Number of closed pores 
• Closed porosity (percent) 
• Open porosity (percent) 
• Total porosity (percent) 

The second set of results represents individual pore measurements of white pores on black space. 

Copy the following data from the second “3D Analysis Summary” horizontal row to the boxes listed 
under “From Second Horizontal Row”. These headers are highlighted in yellow. 

• Tissue volume 
• Bone volume 
• Percent bone volume 
• Tissue surface 
• Bone surface 
• Intersection surface 
• Bone surface / volume ratio 
• Bone surface density 
• Trabecular thickness 
• Trabecular separation 
• Trabecular number 
• Degree of anisotropy (note – divide the numbers into DA1 and DA2 (parenthetical)) 
• Fractal dimension 
• Number of objects 
• Euler number 
• Connectivity 
• Connectivity density 
• Standard deviation of trabecular thickness 
• Standard deviation of trabecular separation 
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All other morphometry measurements (under the “Calculated” heading in green) are automatically 
calculated based on the data entered. Pull down the corner of the above columns to continue this 
calculation. 

Cross-Sectional Geometry 

A custom macro for Batman runs 2D and 3D morphometry on the cortical area (ROI) with the total area 
(TA) as a mask to extract cross-sectional geometry (2D morphometry) and relative cortical volume 
(BV/TV from 3D morphometry) 

1. Click the Batman shortcut on the Desktop 
2. Click Import. Navigate to Local Disk (D:) → Rabbit Opioid Scans Backup → CTan Macros →

CrossSectionalGeometry9-9-2019.ctt. Click Open and the macro will load. 
3. Click Add. Open the ROI folder from within Centerline Anatomical Tomo. Click the first image. 

Click Open. 
a. Do not check the box to resize the image 

4. Click the down arrow next to Add. In the popup menu, select Load ROI. 
a. Navigate to the TA subfolder of Centerline Anatomical Tomo 
b. On the lower right dropdown menu, change ROI files (.roi) to Bitmap files (.bmp). The 

list of TA images should appear. 
c. Click the first image on the list, then Open 
d. You will be warned that the ROI will be monochrome. Click OK. 

5. You can load multiple ROIs and matched TAs in this manner. 
6. Click the arrow next to Properties → Change Pixel Size. Make sure the pixel size is 5.49426 um 

for All Datasets. 
7. Make sure the boxes are checked next to all loaded ROI files 
8. Click Start and the macro will run on its own. 
9. The macro should output: 

a. A _.batman file containing summary cross-sectional data for 2D and 3D morphometry 
b. A 2D analysis summary line in the Cross-Sectional Geometry .csv folder under the 

Statistics folder in Rabbit Opioid Scans Backup 
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Appendix XIII: Femur and Tibia Quadrant Regional Processing SOP 

Region Extraction 

1. Open ImageJ from the Desktop shortcut.  
2. First time you use that session of ImageJ Only: BoneJ always opens an orientation window 

that apparently cannot be closed from inside a macro. This will crash all subsequent attempts to 
open BoneJ from a macro. When you open a new ImageJ window, you must “burn” a BoneJ 
session to prevent this 

a. Open a single random ROI image in ImageJ by dragging and dropping it only ImageJ 
from File Explorer, or by using File → Open 

b. Click Plugins → BoneJ → Slice Geometry 
c. Immediately Cancel the Options Window 
d. Close the Orientation window 
e. Close the Image 
f. Now you are free of the orientation bug! You can skip this step if you run a subsequent 

region extraction in this same ImageJ session. 
3. Open Plugins → Macros → Install, which will pop up the macros filter 
4. Click Femur Quadrants.ijm (for the femur) or Tibia Quadrants.ijm (for the tibia) then Open 
5. Click Plugins → Macros → Femur Quadrants (or Tibia Quadrants) 
6. In the BoneJ Usage popup, click OK 
7. In the popup Select_Cortical_ROI, navigate to:Local Disk (D:) → Rabbit Opioid Scans Backup 
→ [Choose the next femur to run] → Anatomical Rotation → Centerline Anatomical Tomo →
ROI 

a. Click Select 
b. Note: You will not see any images appear 

8. In the popup Select_Output_Directory, navigate to your Centerline Anatomical Tomo folder and 
click the New Folder icon (folder with a starburst). 

a. Create a new subfolder “Region ROI” 
b. Enter the Region ROI folder 
c. Click Select 

9. The macro will run automatically. It will pop up a threshold window and a results window – you 
can move these around but do not close them. You can view progress by looking at the Region 
ROI folder in File Explorer, where the extracted ROI regions will appear. 

10. The outputs into the new Region ROI folder are ROI masks: 
a. Anterior ROI 
b. Lateral ROI 
c. Medial ROI 
d. Posterior ROI 
e. Drawn Octants – shows the drawn lines of the four quadrants 

Pore Morphometry 

10. Click the Batman shortcut on the Desktop 
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11. Click Import. Navigate to: Local Disk (D:) → Rabbit Opioid Scans Backup → CTan Macros →
RegionalPoreMorphometry10-7-2019.ctt. 

a. Click Open and the macro will load. 
12. Click Add. Navigate to an existing pore output in: Local Disk (D:) → Rabbit Opioid Scans 

Backup → [Choose the next femur to run] → Anatomical Rotation → Centerline Anatomical 
Tomo → Pores 

a. Click the first image. Click Open. 
b. Do not check the box to resize the image 

13. Click the down arrow next to Add. In the popup menu, select Load ROI. Navigate to: 

Local Disk (D:) → Rabbit Opioid Scans Backup → [Choose the next femur to run] → Anatomical 
Rotation → Centerline Anatomical Tomo → Region ROI 

a. Select one of the Regional ROI subfolders (e.g. Anterior ROI) and click Open 
b. On the lower right dropdown menu, change ROI files (.roi) to Bitmap files (.bmp). The 

list of ROIs should appear. 
c. Click the first image on the list, then Open 
d. You will be warned that the ROI will be monochrome. Click OK. 

14. You can load multiple Pores and Regional ROIs in this manner. For example, load the same Pores 
set four times. Then load Anterior, Posterior, Medial, and Lateral ROIs separately as ROIs 

15. Click the arrow next to Properties → Change Pixel Size. Make sure the pixel size is 5.49426 um 
for All Datasets. Note that pixel size must typically be changed at this point, because the 
resolution data is lost through ImageJ processing. 

16. Make sure the boxes are checked next to all loaded Pores files 
17. Click Start and the macro will run on its own. 
18. The macro should output the following inside the Pores folder: 

a. A _.batman file containing summary pore data 
b. A _i3d file containing individual pore data 
c. TBTH: Image stack of trabecular thickness 
d. TBSP: Image stack of trabecular separation 
e. Individual Objects by Size: Image stack 
f. Note: The three image stacks use grayscale coding of the lowest values (approximate to 

black) so they will not be very visible on the actual image. However, they can be seen 
clearly in Dragonfly or Amira. 

19. If you loaded more than one ROI for the same pore set: Each output will be numbered 
according to the order of the runs [e.g. TBTH, TBTH(1), TBTH(2)]. 

a. If you are not sure which is which, check the order of the runs associated text file that 
ends in .batman. The name of the ROI will be listed in the first line. 

i. Alternatively open a despeckled pore image in that numbered folder and check 
whether it is Anterior (top), Medial (right), Posterior (bottom), or Lateral (left) 

b. Move each set of outputs into its own subfolder (e.g. Anterior Pores) 
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-----------------------------------------------------------------

-----------------------------------------------------------------

-----------------------------------------------------------------

-----------------------------------------------------------------

-----------------------------------------------------------------

-----------------------------------------------------------------

-----------------------------------------------------------------

Appendix XIV: CTAnalyser Macros 

TA Extractor 

Description: Extracts a mask of total area from the grayscale micro-CT image for centerline 
skeletonization and subsequent longitudinal orientation 

Workflow: 

Thresholding (2D space) 
Mode  Two-dimensional (Otsu method) 
Kernel  Round 
Radius 1 
Background  Dark 

Despeckle 
Type: Sweep (3D space) 
Remove: all exept the largest object 
Apply to: Image 

ROI shrink-wrap 
Mode : Shrink-wrap (3D space) 

Morphological operations 
Type: Erosion (3D space) 
Kernel: Round 
Radius:  2 
Apply to: Region of Interest 

Morphological operations 
Type: Dilation (3D space) 
Kernel: Round 
Radius:  2 
Apply to: Region of Interest 

Morphological operations 
Type: Closing (2D space) 
Kernel: Round 
Radius:  30 
Apply to: Region of Interest 

Morphological operations 
Type: Erosion (3D space) 
Kernel: Round 
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-----------------------------------------------------------------

-----------------------------------------------------------------

-----------------------------------------------------------------

-----------------------------------------------------------------

-----------------------------------------------------------------

-----------------------------------------------------------------

-----------------------------------------------------------------

-----------------------------------------------------------------

Radius:  2 
Apply to: Region of Interest 

Save bitmaps (only ROI) 
File format: bmp 

ROI and TA Extractor 

Description: After longitudinal orientation, extracts a mask of total area and a mask of cortical area to 
serve as regions of interest (ROI) for pore extraction and morphometric analysis 

Workflow: 

Thresholding (2D space) 
Mode  Two-dimensional (Otsu method) 
Kernel  Round 
Radius 1 
Background  Dark 

Despeckle 
Type: Sweep (3D space) 
Remove: all exept the largest object 
Apply to: Image 

ROI shrink-wrap 
Mode : Shrink-wrap (3D space) 

Morphological operations 
Type: Erosion (3D space) 
Kernel: Round 
Radius:  2 
Apply to: Region of Interest 

Morphological operations 
Type: Dilation (3D space) 
Kernel: Round 
Radius:  2 
Apply to: Region of Interest 

Morphological operations 
Type: Closing (2D space) 
Kernel: Round 
Radius:  30 
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-----------------------------------------------------------------

-----------------------------------------------------------------

-----------------------------------------------------------------

-----------------------------------------------------------------

-----------------------------------------------------------------

Apply to: Region of Interest 

Morphological operations 
Type: Erosion (3D space) 
Kernel: Round 
Radius:  2 
Apply to: Region of Interest 

Save bitmaps (only ROI) 
File format: bmp 

Despeckle 
Type: Remove pores (2D space) 
Detected by: by image borders 
Apply to: Region of Interest 

Save bitmaps (only ROI) 
File format: bmp 

Pore Morphometry 

Pore Morphometry Description: Acquires morphometric measurements from cortical pore networks on 
whole cross-sections; also generates binary image stacks of despeckled pore networks and grayscale 
image stacks of pore thickness and pore separation 

Regional Pore Morphometry Description: Same functions as “Pore Morphometry”, but limited to a 
given anatomical region of interest (Anterior, Posterior, Medial, Lateral) 

Workflow: 
-----------------------------------------------------------------
Thresholding 
Mode Global 
Lower grey threshold 
Upper grey threshold 

1 
255 

-----------------------------------------------------------------
Despeckle 
Type: Remove white speckles (3D space) 
Volume : less than 100 voxels 
Apply to: Image 
-----------------------------------------------------------------
Thresholding 
Mode Global 
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-----------------------------------------------------------------

Lower grey threshold 0 
Upper grey threshold 254 

3D analysis 
MORPHOMETRY RESULTS 

Description Abbreviation Unit 

Fractal dimension FD 
Number of closed pores 
Closed porosity (percent) 
Open porosity (percent) 
Total porosity (percent) 

Po.N(cl) 
Po(cl) 
Po(op) 
Po(tot) 

% 
% 
% 

---------------------------------------------------
Thresholding 
Mode Global 
Lower grey threshold 
Upper grey threshold 
-----------------------------------------------------------------

0 
254 

Save bitmaps (only image) 
File format: bmp 
-----------------------------------------------------------------
3D analysis 
MORPHOMETRY RESULTS 

Description Abbreviation Unit 

Tissue volume TV U^3 
Bone volume BV U^3 
Percent bone volume 
Tissue surface 

BV/TV 
TS 

% 
U^2 

Bone surface BS U^2 
Intersection surface i.S U^2 
Bone surface / volume ratio 
Bone surface density 
Trabecular thickness 

BS/BV 
BS/TV 
Tb.Th 

1/U 
1/U 
U 

Trabecular separation 
Trabecular number 
Degree of anisotropy 
Fractal dimension 

Tb.Sp 
Tb.N 
DA 
FD 

U 
1/U 

Number of objects 
Euler number 

Obj.N 
Eu.N 

Connectivity 
Connectivity density 
Standard deviation of trabecular thickness 

Conn 
Conn.Dn 
SD(Tb.Th) 

1/U^3 
U 
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-----------------------------------------------------------------

Standard deviation of trabecular 
separation SD(Tb.Sp) U 

Individual object analysis (3D space) 

Description Abbreviation Unit 
Object volume Obj.V um^3 
Object surface Obj.S um^2 
Volume of pores Po.V um^3 
Surface of pores Po.S um^2 
Porosity Po % 
Number of pores Po.N 
Centroid x Crd.X um 
Centroid y Crd.Y um 
Centroid z Crd.Z um 
Moment of inertia (x) MMI(x) um^5 
Moment of inertia (y) MMI(y) um^5 
Moment of inertia (z) MMI(z) um^5 
Polar Moment of inertia MMI(polar) um^5 
Radius of gyration (x) Gr.R(x) um 
Radius of gyration (y) Gr.R(y) um 
Radius of gyration (z) Gr.R(z) um 
Polar Radius of gyration Gr.R(polar) um 
Product of inertia (xy) Pr.In(xy) um^5 
Product of inertia (xz) Pr.In(xz) um^5 
Product of inertia (yz) Pr.In(yz) um^5 
Orientation theta Or(theta) ° 
Orientation phi Or(phi) ° 
Structure model index SMI 
Structure thickness St.Th um 
Equivalent rod length ERL um 
Major diameter Maj.Dm um 
Volume-equivalent sphere diameter ESDv um 
Surface-equivalent sphere diameter ESDs um 
Sauter diameter Sau.Dm um 
Sphericity Sph 
Mean density Dens Index 
Maximum density Dens(max) Index 
Surface convexity index SCv.I 1/um 
Euler number Eu.N 
Connectivity Conn 
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-------------------------------------------------------

-----------------------------------------------------------------

-----------------------------------------------------------------

Legend of color-coded images: 
Index 
ESDv (um) 
Save bitmaps (clipboard) 

Cross-Sectional Geometry 

Description: Extracts cross-sectional geometric measurements from the cortical area image stack, using 
the total area image stack as a mask 

Workflow: 

Thresholding 
Mode  Global 
Lower grey threshold 1 
Upper grey threshold 255 

2D analysis 
Summary 2D data 

Description Abbreviation Unit 

Tissue volume TV um^3 
Bone volume BV um^3 
Percent bone volume BV/TV % 
Tissue surface TS um^2 
Peripheral tissue surface TS(per) um^2 
Bone surface BS um^2 
Peripheral bone surface BS(per) um^2 
Bone surface / volume ratio BS/BV 1/um 
Mean total crossectional tissue area T.Ar um^2 
Mean total crossectional tissue perimeter T.Pm um 
Mean total crossectional bone area B.Ar um^2 
Mean total crossectional bone perimeter B.Pm um 
Average moment of inertia (x) Av.MMI(x) um^4 
Average moment of inertia (y) Av.MMI(y) um^4 
Mean polar moment of inertia MMI(polar) um^4 
Average principal moment of inertia 
(max) Av.MMI(max) um^4 
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Average principal moment of inertia 
(min) Av.MMI(min) um^4 
Mean eccentricity Ecc 
Crossectional thickness Cs.Th um 
Centroid (x) Crd.X um 
Centroid (y) Crd.Y um 
Centroid (z) Crd.Z um 
Mean fractal dimension FD 
Total intersection surface i.S um^2 
Percent intersection surface i.S/TS(per) % 
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Appendix XV: ImageJ Macros 

Adaptive Thresholding 

Description: Applies a low-contrast, local thresholding Phansalkar algorithm to the grayscale micro-CT 
image, extracting the cortical pore network as a binary image stack, and excluding external noise by using 
the cortical area image stack as a mask 

Workflow: 

macro "Adaptive Thresholding"{ 
setBatchMode(true); 

dir1= getDirectory("Select_Tomo_Images"); 
list1= getFileList(dir1); 

dir2= getDirectory("Select_ROIs"); 
list2= getFileList(dir2); 

dir3= getDirectory("Select_Output"); 

while (nImages>0) { 
          selectImage(nImages);
          close(); } 

//Clear any past results 

run("Clear Results"); 

//Image loop 

for (i=0; i<lengthOf(list1); i++){ 

//Open the pore image and threshold 

open(dir1+list1[i]); 

tomo=getTitle(); 

selectImage(tomo); 

run("8-bit"); 
run("Enhance Contrast...", "saturated=0.3 normalize"); 
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run("8-bit"); 
run("Gaussian Blur...", "sigma=1"); 

run("8-bit"); 
run("Auto Local Threshold", "method=Phansalkar radius=15 parameter_1=0 parameter_2=0 white"); 

//Invert tomo 

selectImage(tomo); 
run("8-bit"); 
run("Invert"); 
tomo=getTitle(); 

//Open ROI and use as mask 

open(dir2+list2[i]); 

roi=getTitle(); 

imageCalculator("AND create", tomo,roi); 

out=getTitle(); 

selectImage(out); 

setAutoThreshold("Default dark"); 
run("Threshold..."); 
setThreshold(1, 255); 
setOption("BlackBackground", true); 
run("Convert to Mask"); 

selectImage(out); 

run("8-bit"); 
run("Close-"); 
run("Fill Holes"); 

saveAs("bmp", dir3 + tomo); 

//Close all open images 

while (nImages>0) { 
selectImage(nImages);

          close(); }}} 
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Skeleton Save 

Description: Automatically runs and saves the Skeletonization 3D plugin on the total area mask, 
converting it to a centerline skeleton image stack 

Workflow: 

macro "Skeleton Save"{ 
setBatchMode(true); 

out= getDirectory("Select_Output"); 

run("Image Sequence..."); 
orig=getTitle(); 

selectWindow(orig); 

run("Skeletonise"); 

selectWindow(orig); 
close(); 

skel=getTitle(); 

selectWindow(skel); 

//3x Dilate 

run("Dilate", "stack"); 

run("Dilate", "stack"); 

run("Dilate", "stack"); 

selectImage(skel); 

run("Image Sequence... ", "format=BMP name=Skeleton start=0001 save=out"); 

while (nImages>0) { 
          selectImage(nImages);
          close(); 
}} 
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Femur Quadrants / Tibia Quadrants 

Description: Using the cortical area image stack as an input, finds the centroid with the Slice Geometry 
plugin, and then rotates a line through this centroid to generate image stacks of masks representing the 
Anterior, Posterior, Medial, and Lateral anatomical regions of each cross-section. A given regional mask 
can be used as the region of interest (ROI) in the Regional Pore Morphometry macro to restrict 
morphometric analysis of the pore network to that anatomical region. 

Workflow: 

macro "Femur Quadrants"{ 
setBatchMode(true); 

//Pop up BoneJ Usage Legacy and prompt user for OK 

run("BoneJ Usage (Legacy)"); 

//Clear any past results 

run("Clear Results"); 

//Set background color to black for clearing regions 

setBackgroundColor(0, 0, 0); 

//Set input directories to prompt user to load cortical ROI stack 

dir1= getDirectory("Select_Cortical_ROI"); 
list1= getFileList(dir1); 

//Make an output directory 

dir2= getDirectory("Select_Output_Directory"); 

//Make output subdirectories 

regiondraw=dir2+"/Drawn Octants/"; 
File.makeDirectory(regiondraw); 

regionA=dir2+"/Anterior ROI/"; 
File.makeDirectory(regionA); 

regionM=dir2+"/Medial ROI/"; 
File.makeDirectory(regionM); 
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regionP=dir2+"/Posterior ROI/"; 
File.makeDirectory(regionP); 

regionL=dir2+"/Lateral ROI/"; 
File.makeDirectory(regionL); 

//Burner Slice Geometry 

open(dir1+list1[1]); 
run("Slice Geometry", "bone=femur bone_min=1 bone_max=255 slope=0.0000 y_intercept=0"); 
close(); 
run("Clear Results"); 

//Loop Start 

for (i=0; i<lengthOf(list1); i++){ 

//Open the cortical mask image 

open(dir1+list1[i]); 
orig=list1[i]; 

imgname=getTitle(); 

//Remove scale 

run("Set Scale...", "distance=0"); 

//Clear results 
run("Clear Results"); 

//Run BoneJ Slice Geometry 

run("Slice Geometry", "bone=femur bone_min=1 bone_max=255 slope=0.0000 y_intercept=0"); 

//Save slice geometry centroid X value 

cX=getResult("X cent. (pixels)",0); 
cY=getResult("Y cent. (pixels)",0); 

//Draw a line through the centroid to the top and bottom of the image 

w = getWidth(); 
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h = getHeight(); 

selectImage(orig); 

//Coordinates for centroid to top of image 
//makeLine(cX, 0, cX, h); 

//Rotation code based off of: https://stackoverflow.com/questions/14842090/rotate-line-around-center-
point-given-two-vertices 
//Starting coordinates are as follows 
//x = cX 
//y = 0 
//Add -1000 to Y to extend beyond borders 
//cx = cX 
//cy = cY 

//Rotate 45 degrees counterclockwise to AL line 

a = 45 * PI / 180; 

xAL = (  (cX - cX) * cos(a) + (-1000 - cY) * sin(a) ) + cX; 
yAL = ( -(cX - cX) * sin(a) + (-1000 - cY) * cos(a) ) + cY; 

//Rotate 135 degrees counterclockwise to PL line 

a = 135 * PI / 180; 

xPL = ( (cX - cX) * cos(a) + (-1000 - cY) * sin(a) ) + cX; 
yPL = ( -(cX - cX) * sin(a) + (-1000 - cY) * cos(a) ) + cY; 

//Rotate 225 degrees counterclockwise to PM line 

a = 225 * PI / 180; 

xPM = (  (cX - cX) * cos(a) + (-1000 - cY) * sin(a) ) + cX; 
yPM = ( -(cX - cX) * sin(a) + (-1000 - cY) * cos(a) ) + cY; 

//Rotate 315 degrees counterclockwise to AM line 

a = 315 * PI / 180; 

xAM = (  (cX - cX) * cos(a) + (-1000 - cY) * sin(a) ) + cX; 
yAM = ( -(cX - cX) * sin(a) + (-1000 - cY) * cos(a) ) + cY; 
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//Duplicate image and draw lines 

selectImage(orig); run("Duplicate...", "title=[Drawn]"); 
drawoct="Drawn"; 

selectImage(drawoct); 

makeLine(cX, cY, xAL, yAL); 
run("Draw"); 
makeLine(cX, cY, xPL, yPL); 
run("Draw"); 
makeLine(cX, cY, xPM, yPM); 
run("Draw"); 
makeLine(cX, cY, xAM, yAM); 
run("Draw"); 

saveAs("bmp", regiondraw + imgname); 
close(); 

//Duplicate image and draw anterior quadrant 

selectImage(orig); 
run("Duplicate...", "title=[Temp Octant]"); 
tempoct="Temp Octant"; 

makePolygon(xAM,yAM,xAL,yAL,cX,cY); 

setBackgroundColor(0, 0, 0); 
run("Clear Outside"); 

setAutoThreshold("Default dark"); 
run("Threshold..."); 
setThreshold(1,255); 
setOption("BlackBackground", true); 
run("Convert to Mask"); 

saveAs("bmp", regionA + imgname); 

close(); 

//Duplicate image and draw lateral quadrant 

selectImage(orig); 
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run("Duplicate...", "title=[Temp Octant]"); 
tempoct="Temp Octant"; 

makePolygon(xAL,yAL,xPL,yPL,cX,cY); 

setBackgroundColor(0, 0, 0); 
run("Clear Outside"); 

setAutoThreshold("Default dark"); 
run("Threshold..."); 
setThreshold(1,255); 
setOption("BlackBackground", true); 
run("Convert to Mask"); 

saveAs("bmp", regionL + imgname); 

close(); 

//Duplicate image and draw posterior quadrant 

selectImage(orig); 
run("Duplicate...", "title=[Temp Octant]"); 
tempoct="Temp Octant"; 

makePolygon(xPL,yPL,xPM,yPM,cX,cY); 

setBackgroundColor(0, 0, 0); 
run("Clear Outside"); 

setAutoThreshold("Default dark"); 
run("Threshold..."); 
setThreshold(1,255); 
setOption("BlackBackground", true); 
run("Convert to Mask"); 

saveAs("bmp", regionP + imgname); 

close(); 

//Duplicate image and draw posterior quadrant 

selectImage(orig); 
run("Duplicate...", "title=[Temp Octant]"); 
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tempoct="Temp Octant"; 

makePolygon(xPM,yPM,xAM,yAM,cX,cY); 

setBackgroundColor(0, 0, 0); 
run("Clear Outside"); 

setAutoThreshold("Default dark"); 
run("Threshold..."); 
setThreshold(1,255); 
setOption("BlackBackground", true); 
run("Convert to Mask"); 

saveAs("bmp", regionM + imgname); 

close(); 

//Close original image 

selectImage(orig); 
close(); 

} 
} 
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Appendix XVI: Skeletonization SOP 

General Avizo Tips 

You can save your project view using File → Save Project As →Minimize Project Size → OK → Save 
as type Amira Project (*.hx). When you open this file in Amira, all of your code will re-run. 
Or choose Minimize Project Computation to save all of the backup files so you do not have to rerun code 
(requires more space) 
To delete an object in the Project View field, drag it to the Trash Can, or click Delete on the keyboard 

To organize your Project View nicely, click the Reorder Project View   button at the top 

Extract Despeckled Pore File 

Navigate to Desktop → Kassidy Skeletonization → Rabbit Femora 
Select one of the 7zip Pore Files. Right-click → 7zip → Open Archive 
In the opened 7zip archive, navigate to Pores → Total Pores 
Click on the Despeckled Pores Folder (it should turn blue) 
Click “Extract” in the top toolbar 
In the Copy popup, click OK 
Despeckled Pores will extract to the main Rabbit Femora Folder 
Right click → Rename 
Rename it with Number_Femur_Despeckled 
E.g. 01_Femur_Despeckled 
Load File in Amira 

Double-click the Amira 6.4.0. icon on the Desktop 
Open Blank Project 
Open Data (Green button in upper left hand corner) 
Navigate to Desktop → Kassidy Skeletonization → Rabbit Femora → The extracted despeckled pore file 
In the popup, click the top file in the folder. Scroll to the bottom. Hold down shift and click the bottom 
file in the folder. All of the files in the folder should now be highlighted. Click Open. 
Amira should pop up an “Out of Core Data” popup. If not, check the Amira icon on the bottom of the 
window – it may be hidden behind Amira. 
Select “Read complete volume into memory” 
Do not check Run Batch 
Click OK 
Image Read Parameters should pop up. 
Channel conversion: Channel 1 
You can change the object name if you like, or leave it as default 
Original Coordinate Units: micrometer 
Define: Voxel Size 
Min coord: 0 0 0 
Voxel size: 5.494265.494265.49426 
Uncheck Read as multiple files 
Click OK 
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Sometimes you accidentally load only one slice. To make sure the volume loaded in 3D, you can click the 
green object file that popped up when you loaded the image, then select “Volren” 
Use the hand tool at the top of the toolbar to rotate the 3D image 
Use the four-way arrow tool to move the 3D image laterally or up and down within the field of view 
Use the magnifying glass to zoom in and out 

Setting Up Auto-Skeleton 

Right-click the green object file that popped up when you loaded the image. If you changed the file name, 
it will have your chosen name. 
Right-click will pop up a menu of functions. 
Navigate to Image Processing → Skeletonization → Auto-Skeleton → Create 
OR you can search for Auto Skeleton in the toolbar on the popup 
Auto-Skeleton Properties 
Data = Name of your loaded image stack 
Filament type = Bright on Dark 
Threshold = 1 (or can leave as default, since all pixels in this image are 254 pixel brightness) 
Preview = Off (saves time) 
Smoothing = ON 
Smooth = 0.5 
Attach to Data = 0.25 
Number of Iterations = 10 
Click on the arrow next to Output Options 
Create Objects: Uncheck All 
Show Spatial Graph: Check 
Click Apply and the Auto-Skeleton will run. It may take several hours to run. 
Try to not touch Amira during this time or run any other programs. It may say it is Not Responding, but it 
is still running. If it pops up an error, choose “Wait for Program to Respond”. The screen may become 
grayed out. 

Exporting LineSet and Statistics 

Saving Spatial Graph: Right click the .SptGraph object created by Auto Skeleton 
Click on Export Data As… which looks like a folder with a yellow arrow 
In the popup Export Data As, change Save As Type to “AmiraMesh Spatial Graph (*am)” 
Navigate to your Number_Femur_Despeckled folder and click New Folder, which you will name 
“Skeletonization Files” 
Save the SptGraph ibject in your new Skeletonization Files folder 
We will use the LineSet data to run Isaac Pratt’s code eventually 
Creating LineSet: Right click the .SptGraph object 
In the functions menu, select Convert → Spatial Graph to Line Set → Create → Apply 
Saving LineSet: Right click on the .SptGraph-LS object created 
Click on Export Data As… which looks like a folder with a yellow arrow 
In the popup Export Data As, change Save As Type to “LineSet(*lineset) 
Change the save location to your Number_Femur_Despeckled → Skeletonization Files folder and click 
Save 
We will use the LineSet data to run Isaac Pratt’s code eventually 
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Creating Statistics: To export statistics, right click the .SptGraph object created by Auto Skeleton 
In the functions menu, select Measure and Analyze → Spatial Graph Statistics 🡪 Create 
In Spatial Graph Statistics Properties: 
Data: Your SptGraph object 
Output: Spreadsheet 
Click Apply 
This creates a .statistics object 
Saving Statistics: Right click on the .statistics object 
Click on Export Data As… which looks like a folder with a yellow arrow 
In the popup Export Data As, change Save As Type to “CSV (*csv)” 
Change the save location to your Number_Femur_Despeckled 🡪 Skeletonization Files folder and click 
Save 
You can open the .csv file in Excel to get summary statistics and individual segment statistics 

Adjusting Visualization 
Click on the Amira 6.4.0 icon to open Amira 
File → Open Project 

Open your Amira Spatial Graph Image Template 
File → Open Data → Open the SptGraph object you want to visualize 
Right-click on the SptGraph green object 🡪 Display 🡪 Spatial Graph View 🡪 Create 
Click the Spatial Graph View so its Properties appear 

Data: Spt.Graph object 
Node = OFF 
Segment = ON 
Segment Style 
Uncheck Lines and Points 
Check Tubes 
Tube Scale = Thickness 
Tube Scale Factor = 1.4 
Segment Coloring = Thickness 
Segment Colormap 
Edit → physics_VolRend_1to81.am 
Make sure the left value is 1 and the right value is 81. If this alters the colormap, you will need 
to adjust the annotation as seen below. 
Edit → Options → Uncheck everything by clicking on it 
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Orient the object as you like using the top toolbar. I like to do a ½ tilt view so you can see both the sides 
and the top. 

Click the Orthographic projection button so the eye is staring straight lines:  This makes the 
scale bar accurate. 

Click the XY button at the top toolbar to view the image from above: 
Use the hand tool to grab the bottom of the skeletonized image and tilt it up slightly so that the 

side can be seen: 

Use the arrow tool to move the image laterally within the field so it is centered if needed: 
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A ½ tilt view of a femur. Note the enlarged colormap and scale bar to allow tiling of the image. 

If You Need to Adjust or Create a Scale 

To create a NEW scalebar, right click in the Project View area (not on a particular box) 
Create Object → Scalebars → Create from the drop down menu 

Click the yellow Scalebars object and replicate these settings. Change Font using the Select button. Note 
that the scale bar will look unusually big – this is because we are taking an enlarged tiled image. 
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If You Need to Adjust or Create a Colormap 

To create a NEW colormap, right click on the physics_VolRend_1to81.am green object. Select Annotate 
→ Colormap Legend → Create 
Click the yellow Scalebars object and replicate these settings. Note that the colormap will look 
unusually big – this is because we are taking an enlarged tiled image. 
The most likely scenario is that adjusting the values for the colormap will alter the custom text. In that 
case, copy the following into the Custom Text box: 

1/"1" 41/"41" 77/"81" 
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Taking the Image 

Click on the camera icon on the top toolbar: 
In the Snapshot popup: 

Output: to File 
Uncheck Offscreen 
Options: Render tiles 4 x 4 
Antialias 1 
Uncheck Capture All viewers 
File options:
 Browse to change the Filename to the folder where you want to output the images. I have put 
them into C:\Users\FROST\Desktop\Kassidy Skeletonization\Images 
Add an image name like Number_Bone 
Change Save as type to TIF (*tif) 
Format: TIF, rgb 
Uncheck Auto-Save Project 

Click OK and the image will render. Check the image using ImageJ 

2018-DU-BX-0188 Final Technical Report 
October 2021 

This resource was prepared by the author(s) using Federal funds provided by the U.S. 
Department of Justice. Opinions or points of view expressed are those of the author(s) and do not 

necessarily reflect the official position or policies of the U.S. Department of Justice.

195 



 
 

 
 
 
 
 
 
 
 
 
 
 
 

2018-DU-BX-0188 Final Technical Report 
October 2021 

This resource was prepared by the author(s) using Federal funds provided by the U.S. 
Department of Justice. Opinions or points of view expressed are those of the author(s) and do not 

necessarily reflect the official position or policies of the U.S. Department of Justice.

196 



 
 

 
  

 
Final Image (Cropped) 
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Cropping and Color Bar Title in ImageJ 

Note: You can also just do this in Microsoft Word 
The color bar is based on the maximum pore radius (81 um) of the sample with the largest pore thickness, 
20 Tibia. We need to add a title to the color bar in ImageJ or in Word. It cannot be done in Amira because 
the tiling mechanism of the screenshot causes the color bar title to overlap with the colorbar itself. 
Cropping: 
Open ImageJ from the desktop. 
Open your image with File � Open 
Use the rectangle tool to draw a box of the desired size around the image 
Image � Crop 

Adding Color Bar Title 
Modify the font using Edit � Options � Fonts 

Font = Arial 
Style = Bold 
Size = 60 
Click Close 

Select the Text tool (looks like a letter A) 
Draw a box under the color bar. Type Pore Radius (um) 
After typing, you can move the box around by clicking and dragging to position it better 
To merge the text with the image, type Ctrl + D on the keyboard, or click Edit � Draw 
Save the image using File � Save As � Tiff. I recommend you save it using a new name so you also have 
the original image. 

Aggregating Data in Excel 

Note: Descriptions of each statistics can be found in Amira under Help� User’s Guide and search for 
Spatial Graph Statistics 
Open the .statistics csv file in Excel 
Copy the line of numbers under Graph Summary to your Master Skeletonization Spreadsheet 
Right click → Insert four times to add four lines above the Graph Statistics section. 

Note: These are the summed values of the 
Type Mean, Median, Max, and Min in the added four rows in the first column (A) 
In the second column, to the right of Mean, type =AVERAGE( 

Click the first numeric box (to the right of Graph0), under Number of Segments 
On the keyboard, press Ctrl + Shift + Down Arrow. This will skip to the bottom of the column 
Type the close parentheses ) 
This should move you back up to the top of the page and calculate the average for Number of 
Segments 
To get the means of the rest of the Graph Statistics, click the Mean numeric box you just filled in. 
A dot should appear in the lower right corner. Click on the dot and drag it to the last Graph 
Statistics column (Isolated Nodes). This should fill in the means for all the Graph Statistics 

Repeat step 5 for the other statistics: 
=MEDIAN( 
=MAX( 
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=MIN( 
Important: The Graph Summary “mean length” and “mean radius” are calculated from the individual 
segments (you can see this if you perform the statistics on the Segment Statistics section at the bottom of 
the page). The “mean length” and “mean radius” you will calculate are based on the individual pore 
systems, which are composed of multiple segments. Therefore, these variables will not match. I have 
clarified “Segment Mean Length” and “Pore System Mean Length” on the master spreadsheet. 

I have also modified the names of the other columns a bit to be clearer. You can change the 
variable names in the master spreadsheet to whatever makes sense to you, or whatever fits best on 
your statistics readout. You might need to make up abbreviations for a nice statistics graph 
readout. 
Some of the means will also be applied to means. For example, the Mean Pore System Mean 
Length is the average of all pore system mean lengths. The Mean Pore System Total Length is the 
average of all pore system total lengths. 

To copy a strip of values (e.g. means) to the master spreadsheet, click and drag to highlight the row, then 
right click → Copy or Ctrl+C on the keyboard 

On the master spreadsheet, right click in the first mean value box and click the image of the 
clipboard with 123. This will paste the numeric values. If you copy and paste with Ctrl+V, you 
will get an error because it is trying to copy the formula. 

Note: As there are many fragments, mean and median values of some numeric quantities (e.g. 
intermediate nodes, terminal nodes) may be zero. Minimum values may also be 1 or 0. If all individuals 
have the same number (e.g. intermediate nodes = 0), don’t bother running stats on this variable.  You may 
be able to toss out of lot of these types of variables, but calculate them for now to see if there is any 
variation between individuals. 
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Appendix XVII: Researcher Return to Work 

Andronowski Research Group: Researcher Return to Work Plan – COVID-19  
Dr. Janna M. Andronowski – Office: ASEC 306, Laboratory: ASEC B228 

This document is designed to outline the guidelines and expectations of Andronowski Lab members for a 
safe return to lab activities during the ongoing COVID-19 pandemic. All group members must understand 
the information in this manual regarding the guidelines that have been mandated by The University of 
Akron to prevent the spread of the Coronavirus (COVID-19) both on campus and in the greater community. 
Guidelines regarding how we will employ a safe return to lab work are outlined below. 

Remote and On-Campus Work 

Laboratory members must voluntarily agree to support Dr. Andronowski and her research on a “need to be 
there” basis. This guidance is not intended to replace work that can be done remotely. All group meetings, 
individual meetings, and project discussions will continue to be conducted remotely. Face masks must be 
worn when in the same room as others, daily disinfecting must be conducted, and social/physical distancing 
must be maintained. Laboratory and office occupancy should be held only to the necessary minimum. 

Limits on Laboratory Personnel Numbers 

Current social/physical distancing guidelines recommend separation distances of 6 feet or more. No more 
than 2-3 individuals are permitted to be in the B228 main lab space at any given time. Any work in the back 
rooms is limited to one person at a time. Lab procedures requiring more than one person in close proximity 
will be minimized as much as possible. If more than one person is required in less than a 100 square foot 
area, the individuals involved must wear PPE (masks, gloves, and eye protection) and treat each other as if 
they have COVID-19 but are asymptomatic. 

Signage will be posted on the lab doors (outside doors to the hallway) identifying all approved personnel 
for B228. 

Implementation of Shifts 

Lab shift schedules will be utilized in order to ensure social distancing requirements. We will employ the 
TimeTree app to schedule and change shifts. Our weekly schedule must be shared with Dr. Weeks each 
Monday morning. 

Randomized ‘spot checks’ of the lab will be performed once or twice per week to ensure that the safety 
guidelines identified herein are being followed. 

Documentation of Biology lab checks can be found here: 
https://docs.google.com/spreadsheets/d/11 BdDCQlQ2TtDhLEOnjk bi0pFtkDZkP1XOo QbLI/edit?u 
sp=sharing 
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Limits on Office Use and Occupancy 

As noted above, office work should continue to take place at remote locations (e.g., at home). For those 
engaged in laboratory work, and for rare research tasks requiring access to individual offices, office 
occupation should be limited to one person. Doors must remain closed when offices are occupied. For office 
spaces larger than 200 sq.ft., exceptions may be possible, but need to be pre-approved by the Provost in 
conjunction with Vice Presidents, Deans or Department Chairs. 

Personal Protective Equipment (PPE) Requirements 

Safety is of utmost importance to the Andronowski Lab. Proper safety protocols are an extremely important 
aspect of working in a biology lab, especially in this modified research environment. Face masks are 
required in all common areas (hallways, restrooms, break areas). Face masks must be worn in public and 
any time there is more than one person in a given space, including times of brief interaction between co-
workers or friends. This rule is applicable anytime another person is within six feet.  Masks should also be 
worn in the main lab space, even if working alone, to minimize contamination. Employees working alone 
in their offices, however, do not need to wear a mask. No one-on-one meetings or group meetings are to be 
held in individual offices, and the door should remain closed. 

All shared work areas (desktop, keyboards, chairs, etc.) and equipment needs to be cleaned and disinfected 
before and after each use. 

Keep the lab tidy – clean up any messes or spills (use the spill kit if necessary) and put any items not in use 
back in storage. Do not let cardboard accumulate in the lab – place it in the hallway outside the lab and 
label with ‘Trash’. It will be picked up by custodial staff. 

Recommended PPE and Sanitizing Practices 

Required PPE: Face masks are required in common spaces. Gloves and eye protection to be worn in the lab 
if within 100 feet of others. Normal required PPE for lab experiments (e.g., lab coats). 

Sanitizing Practices: Wash hands upon arrival and prior to departure. Clean and disinfect all shared work 
surfaces and equipment (e.g., with disinfectant wipes or equivalent) before and after each visit. 

Minimize contamination by removing gloves and lab coats before entering office areas, break rooms, or 
the hallway. If you are transporting chemicals, use a secondary container and the lab cart rather than wearing 
gloves. There are grey pails for large (4 L) bottles or even small bottles, and a green lab cart for other items. 

Your used glassware should be thoroughly washed as soon as possible after use – plan to do dishes on a 
daily basis. All dishes should first be scrubbed with soap and water and then soaked in the base bath (if 
necessary). 

No food or drink in the lab. This includes water bottles/coffee to avoid contamination when masks are 
removed. Beverages and snacks can be enjoyed in the large common area on B level, etc. 
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___________________________________________________________________________________ 

Working Alone 

You should not be working alone in the laboratory after hours. There are some cases, however, where you 
have to conduct research on evenings and weekends. Please fill in the TimeTree schedule accordingly. If 
you have to work on evenings and weekends, ask another designated lab member if they will be in as well. 
If you have to work alone, please do not use certain laboratory equipment (e.g., mill-drill press, Well 
Diamond Wire Saw, Grinder/Polisher, IsoMet saw) or conduct potentially dangerous procedures (e.g., using 
harsh chemicals). You also must be in contact with Dr. Andronowski or a senior and competent member of 
the group by texting or telephone every hour. When you leave the lab, let your contact person know that 
you have safely left the lab and are finished with your experiments. This is to ensure that emergency 
response personnel or campus security can be requested in the event of an accident. 

Note: Certain aspects of this protocol is based on The University of Akron and NEOMED’s policies for 
safe return to work. 

By signing, I _____________________________________ (print name) certify that I understand the 
safety information provided in this document by Dr. Andronowski and The University of Akron. 

__________________________ (Signature) 

__________________________ (Date) 
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Appendix XVIII: Projected MMA Timeline 

Week Isomet Dehydrate MMA 
Diamond 

Saw 
Microscope 

Imaging 
Image 

Analysis 
Other 

6/1 – 6/5 Test 
6/8 – 6/12 Test 

6/15 – 6/19 
Batch 

1 
Test 

6/22 – 6/26 Batch 1 
6/29 – 7/3 Batch 1A 
7/6 – 7/10 Batch 1B 

7/13 – 7/17 
Batch 

2A 
Batch 2A Batch 1A 

7/20 – 7/24 
Batch 

2B 
Batch 2B Batch 2A Batch 1B 

Microscopic 
Imaging Training 

7/27 – 7/31 
Batch 

2C 
Batch 2C Batch 2B Batch 2A 

Microscopic 
Imaging Training 

8/3 – 8/7 Batch 2C Batch 2B Batch 1 
Analysis Protocol 

Development 

8/10 – 8/14 Batch 2C Batch 1 
Analysis Protocol 

Development 

8/17 – 8/21 Batch 1 
Analysis Protocol 

Development 
8/24 – 8/28 Batch 1 
8/31 – 9/4 Batch 1 
9/7 – 9/11 Batch 1 

9/14 – 9/18 Batch 1 
9/21 – 9/25 Batch 1 
9/28 – 10/2 Batch 1 
10/5 – 19/9 Batch 1 

10/12 – 10/16 Batch 1 
10/19 – 10/23 Batch 1 
10/26 – 10/30 Batch 2 

11/2 – 11/6 Batch 2 
11/9 – 11/13 Batch 2 

11/16 – 11/20 Batch 2 
11/23 – 11/27 Thanksgiving Break 
11/30 – 12/4 Batch 2 
12/7 – 12/11 Batch 2 

12/14 – 12/18 Batch 2 
12/21 – 12/24 Batch 2 

12/25 – 1/1 
Christmas / New 

Years 
1/4 – 1/8 Batch 2 

1/11 – 1/15 Batch 2 
Digital Image 

Analysis Training 
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1/18 – 1/22 Batch 2 Batch 1 
1/25 – 1/29 Batch 2 Batch 1 

2/1 – 2/5 Batch 1 
2/8 – 2/12 Batch 1 

2/15 – 2/19 Batch 1 
2/22 – 2/26 Batch 1 

3/1 – 3/5 Batch 1 
3/8 – 3/12 Batch 1 

3/15 – 3/19 Batch 2 
3/22 – 3/26 Batch 2 
3/29 – 4/2 Batch 2 
4/5 – 4/9 Batch 2 

4/12 – 4/16 Batch 2 
4/19 – 4/23 Batch 2 
4/26 – 4/30 Batch 2 

5/3 – 5/7 Batch 2 
May 2021 Statistics 

June 2021 

Statistics; Draft 
Publications;  
AAFS 2021 

Meeting 

July 2021 
Finalize and Submit 

Publications 

August 2021 
Prepare and Submit 

Final NIJ Report 

MMA Timeline Narrative 2020 -2021 

General Parameters for Batches of 10-11 Samples: 

Slidemaking: 9 weeks (4-weeks dehydration, 5-weeks MMA infiltration and curing, 5-weeks Diamond 
Wire Saw sectioning and mounting, overlapping steps in each week). 

Imaging: Two slides per individual * Three views per slide (brightfield, polarized, fluorescence)  = 6 
cross-sections imaged per individual. Assume 2 hours imaging and photomerging per slide at 200x or 12 
hours for all six cross-sections per individual. For a batch of 10 individuals, assume 120 hours total. If an 
individual uses the scope two hours per day, five days per week, this will take 12 weeks for a single batch 
of 10 individuals. 

Analysis: Most likely, people will analyze one sample per day depending on density of features. This will 
include point counts, manual circling of osteons, and potentially some manual or automated component to 
fluorescence imaging. Since each individual has two slides, assume four days per sample for analysis, or 
8 weeks per batch of 10 samples. 

June 2020: Preliminary Slidemaking Test with Mini Rex Rabbits 

Week 1 (6/1 – 6/5): Test rabbit dehydration sequence 
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Week 2 (6/8 – 6/12): Test rabbit MMA infiltration and waterbath curing 

Week 3 (6/15 – 6/19): Test rabbit diamond wire saw testing; Batch 1 (#1 – #10) isomet sectioning 

Week 4 (6/22 – 6/26): Batch 1 dehydration sequence 

July 2020: Batch 1 and 2 Processing 

Week 1 (6/29 – 7/3): Batch 1A MMA infiltration and waterbath curing 

Week 2 (7/6 – 7/10): Batch 1B MMA infiltration and waterbath curing 

Week 3 (7/13 – 7/17): Batch 1 diamond wire saw and mounting begins; Batch 2A (#11 – 14) isomet 
sectioning; Batch 2A dehydration sequence; Batch 1A diamond wire saw 

Week 4 (7/20 – 7/24): Batch 2B (#15 – 18) isomet sectioning; Batch 2B dehydration sequence; Batch 2A 
MMA infiltration and waterbath curing; Batch 1B diamond wire saw; Microscopic imaging training 

Week 5 (7/27 – 7/31): Batch 2C (#19 – 21) isomet sectioning; Batch 2C dehydration sequence; Batch 2B 
MMA infiltration and waterbath curing; Batch 2A diamond wire saw; Microscopic imaging training 

August 2020: Batch 2 Processing and Batch 1 Imaging 

Week 1 (8/3 – 8/7): Batch 2C MMA infiltration and waterbath curing; Batch 2B diamond wire saw; 
Analysis protocol development; Microscopic imaging of Batch 1 begins 

Week 2 (8/10 – 8/14): Batch 2C diamond wire saw; Analysis protocol development; Microscopic 
imaging of Batch 1 continues 

Week 3 (8/17 – 8/21): Analysis protocol development; Microscopic imaging of Batch 1 continues 

Week 4 (8/24 – 8/28): Microscopic imaging of Batch 1 continues 

September 2020: Batch 1 Imaging 

Week 1 (8/31 – 9/4): Microscopic imaging of Batch 1 continues 

Week 2 (9/7 – 9/11): Microscopic imaging of Batch 1 continues 

Week 3 (9/14 – 9/18): Microscopic imaging of Batch 1 continues 

Week 4(9/21 – 9/25): Microscopic imaging of Batch 1 continues 

October 2020: Batch 1 and Batch 2 Imaging 

Week 1 (9/28 – 10/2): Microscopic imaging of Batch 1 continues 

Week 2 (10/5 – 19/9): Microscopic imaging of Batch 1 continues 

Week 3 (10/12 – 10/16): Microscopic imaging of Batch 1 continues 

Week 4 (10/19 – 10/23): Microscopic imaging of Batch 1 completed 

Week 5 (10/26 – 10/30): Microscopic imaging of Batch 2 begins 

November 2020: Batch 2 Imaging 

Week 1 (11/2 – 11/6): Microscopic imaging of Batch 2 continues 
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Week 2 (11/9 – 11/13): Microscopic imaging of Batch 2 continues 

Week 3 (11/16 – 11/20): Microscopic imaging of Batch 2 continues 

Week 4 (11/23 – 11/27): Thanksgiving Break 

December 2020: Batch 2 Imaging 

Week 1 (11/30 – 12/4): Microscopic imaging of Batch 2 continues 

Week 2 (12/7 – 12/11): Microscopic imaging of Batch 2 continues 

Week 3 (12/14 – 12/18): Microscopic imaging of Batch 2 continues 

Week 4 (12/21 – 12/24): Microscopic imaging of Batch 2 continues 

Week 4.5 - 5 (12/25 – 1/1): Christmas / New Years 

January 2021: Batch 2 Imaging 

Week 1 (1/4 – 1/8): Microscopic imaging of Batch 2 continues 

Week 2 (1/11 – 1/15): Microscopic imaging of Batch 2 continues 

Week 3 (1/18 – 1/22): Microscopic imaging of Batch 2 continues; Image analysis of Batch 1 begins 

Week 4 (1/25 – 1/29): Microscopic imaging of Batch 2 continues; Image analysis of Batch 1 continues 

February 2021: 

Week 1 (2/1 – 2/5): Image analysis of Batch 1 continues 

Week 2 (2/8 – 2/12): Image analysis of Batch 1 continues 

Week 3 (2/15 – 2/19): Image analysis of Batch 1 continues 

Week 4 (2/22 – 2/26): Image analysis of Batch 1 continues 

March 2021: 

Week 1 (3/1 – 3/5): Image analysis of Batch 1 continues 

Week 2 (3/8 – 3/12): Image analysis of Batch 1 completed 

Week 3 (3/15 – 3/19): Image analysis of Batch 2 begins 

Week 4 (3/22 – 3/26): Image analysis of Batch 2 continues 

Week 5 (3/29 – 4/2): Image analysis of Batch 2 continues 

April 2021: 

Week 1 (4/5 – 4/9): Image analysis of Batch 2 continues 

Week 2 (4/12 – 4/16): Image analysis of Batch 2 continues 

Week 3 (4/19 – 4/23): Image analysis of Batch 2 continues 

Week 4 (4/26 – 4/30): Image analysis of Batch 2 continues 
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May 2021: Batch 2 Imaging; Statistics 

Week 1 (5/3 – 5/7): Image analysis of Batch 2 completed 

June 2021: Statistics; Draft Publications; AAFS 2021 Meeting 

July 2021: Finalize and Submit Publications 

August 2021: Prepare and Submit Final NIJ Report 
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Appendix XIX: Histomorphometric Variables 

● Periosteal / Endosteal Measurements 
o Mineralizing surface per bone surface calculated as (dLS + sLS/2)/BS on the endosteal 

(Es.MS/BS, %) and periosteal (Ps.MS/BS, %) surfaces. 
● Cross-sectional geometry measurements 

o Uncorrected Area Measurements 
▪ Cortical Area (CA) 
▪ Marrow Area (MA) 
▪ Total Area (TA) 
▪ Remodeling Area (RA) 

o Relative Area Measurements 
▪ %Ct.Ar (CA/TA) 
▪ %Ma.Ar (MA/TA) 
▪ %RA.Ar (RA/TA) 

o Regional % RA.Ar (RA in each region / Regional Area) 
o Estimates of maximal and minimal bending (second moments of area, Imax, Imin, mm4) 
o Torsional stiffness (torsional section modulus, Zpol, mm3) 

● Means for all porosity and pore shape descriptor variables 
o Total and Regional 
o All pores, cortical pores, and trabecularized pores 

▪ % Porosity 
▪ Pore Density 
▪ Mean Pore Area 
▪ Mean Pore Perimeter 
▪ Mean Pore Circularity 
▪ Mean Pore Aspect Ratio 
▪ Mean Pore Roundness 
▪ Mean Pore Solidity 

● Means for osteon area and shape descriptors 
o Total, total by type, regional, region by type means 

▪ Mean Osteon Area 
▪ Mean Osteon Perimeter 
▪ Mean Osteon Circularity 
▪ Mean Osteon Aspect Ratio 
▪ Mean Osteon Roundness 
▪ Mean Osteon Solidity 

● Intracortical remodeling activity – Counts of single labeled osteons (sL.On), double labeled 
osteons (dL.On), and resorption cavities (Rs.N) 

▪ Total and Regional 
o OPD: Normalize to cortical area (sL.On/Ct.Ar, dL.On/Ct.Ar, and Rs.N/Ct.Ar, mm−2) 

▪ Total and Regional 
o Ratio of labeled osteons versus resorption cavities ((sL.On+dL.On)/Rs.N) 

▪ In cross‐sections where Rs.N was zero, a denominator of 1 was used to maximize 
the inclusion of data 
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▪ Total and Regional 
● Activation frequency - calculated as Ac.f = ((sL.On+dL.On)/Ct.Ar)/σf (#/mm2/year), where σf, 

the osteon formation time, was calculated as W.Th/On.MAR 
o W.Th = osteon wall thickness 
o On.Mar = mineral apposition rate – the distance between two consecutive osteonal 

calcein labels, divided by the labeling period 
● Overall remodeling activity (not normalized to osteon formation time): 

o Active remodeling centers (a.Rm.Cr, mm−2) as the sum of resorption spaces and labeled 
osteons normalized to Ct.Ar: (sL.On+dL.On+Rs.N)/Ct.Ar. 
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Appendix XX: Micro-CT Descriptive Statistics 

Aggregate Porosity by Bone 

Statistic 

Femur Tibia 

Mean Median SD Mean Median SD 

Avg.Ecc 0.635 0.637 0.0326 0.621 0.621 0.0342 

Avg.Imax 1.6E+14 1.61E+14 2.42E+13 1.65E+14 1.64E+14 2.31E+13 

Avg.Imin 9.43E+13 9.4E+13 1.07E+13 1.01E+14 1.02E+14 1.28E+13 

Avg.Maj.Por.D 133 133 13.1 132 130 9.18 

Avg.Orient.Phi 173 174 6.67 194 196 6.2 

Avg.Orient.Theta 38.9 38.6 3.85 41.2 41.8 3.2 

Avg.Pol.MI 2.54E+14 2.55E+14 3.41E+13 2.66E+14 2.62E+14 3.49E+13 

Avg.Por.Sph 0.6 0.6 0.00585 0.597 0.596 0.00521 

Avg.Por.Surf 21000 20400 4620 17700 17500 2370 

Avg.Por.Th 18.2 18.2 0.331 17.9 17.9 0.208 

Avg.Por.Vol 158000 154000 63000 108000 100000 26600 

Bone Surface 4.46E+08 4.16E+08 1.33E+08 4.68E+08 4.97E+08 1.41E+08 

CA 1.57E+11 1.59E+11 1.15E+10 1.62E+11 1.63E+11 1.42E+10 

CA.Surf 3.46E+08 3.46E+08 1.51E+07 3.57E+08 3.65E+08 1.86E+07 

Closed Pore Density 118 117 30.4 149 138 45.9 

Closed Porosity (%) 0.587 0.602 0.132 0.836 0.856 0.237 

Connectivity 4920 4900 2930 5820 5040 2730 

Connectivity density 30.5 30 18.6 36.7 30 16.5 

Cortical Fractal 2.41 2.39 0.0695 2.43 2.44 0.0741 

Cortical Surface 3.26E+08 3.26E+08 1.39E+07 3.32E+08 3.39E+08 1.70E+07 

Cortical Volume 1.57E+11 1.59E+11 1.15E+10 1.62E+11 1.63E+11 1.41E+10 

CS.Th 1180 1190 81 1200 1200 77.7 

Degree of Anisotropy 0.388 0.378 0.055 0.42 0.418 0.0419 

Euler number 16600 15300 5220 21000 20100 6530 

Intersection Surface 2.96E+06 3.06E+06 1.15E+06 1.72E+06 1.62E+06 5.79E+05 

Max Pore System Branching Nodes 1830 1050 2090 793 631 829 

Max Pore System Mean Length 1360 1210 473 1750 1560 577 

Max Pore System Mean Radius 32.4 32.4 8.03 34.4 36.2 9.95 

Max Pore System Number of Nodes 3090 1860 3520 1280 954 1370 

Max Pore System Number of 
Segments 

3480 2030 3970 1470 1150 1560 

Max Pore System Terminal Nodes 1250 750 1440 492 322 547 

Max Pore System Total Length 3.47E+05 2.49E+05 3.93E+05 1.37E+05 9.93E+04 1.32E+05 

Max Pore System Total Volume 4.02E+08 1.64E+08 6.51E+08 6.45E+07 4.17E+07 5.22E+07 

Mean Pore System Branching Nodes 0.662 0.623 0.282 0.52 0.541 0.122 
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Mean Pore System Mean Length 98.7 97.4 12.2 93.1 90.9 6.69 

Mean Pore System Mean Radius 3.61 3.6 0.0877 3.53 3.53 0.0716 

Mean Pore System Number of Nodes 3.13 3.03 0.429 2.88 2.91 0.19 

Mean Pore System Number of 
Segments 

2.26 2.15 0.516 1.98 2.02 0.223 

Mean Pore System Terminal Nodes 2.47 2.44 0.152 2.36 2.37 0.0716 

Mean Pore System Total Length 226 222 41.5 194 190 21 

Mean Pore System Total Volume 72700 57000 56200 31100 29600 12700 

Med.Maj.Por.D 93.5 92.5 5.96 89.5 89.2 2.22 

Med.Orient.Phi 163 169 13.9 218 221 9.63 

Med.Orient.Theta 33.6 33.2 6.06 37.6 38.4 4.79 

Med.Por.Vol 27300 27200 1330 26800 26600 932 

Med.Pore.Sph 0.604 0.604 0.00539 0.602 0.601 0.00591 

Med.Pore.Surf 7110 7100 272 7050 7020 210 

Med.Pore.Th 18.1 18.1 0.253 17.8 17.9 0.26 

Median Pore System Mean Length 79.1 78.3 6.77 74.7 73.9 2.59 

Median Pore System Mean Radius 3.29 3.29 0.0619 3.24 3.26 0.0479 

Median Pore System Total Length 84.9 84.2 6.01 81.3 80.9 2.39 

Median Pore System Total Volume 3060 3110 315 2840 2820 163 

Min Pore System Mean Length 24.2 24.5 1.66 23.2 23.4 2.39 

Min Pore System Total Length 25.1 25.1 1.13 24.5 24.6 1.04 

Min Pore System Total Volume 618 620 24.7 616 618 21.2 

Number Closed Pores 18700 17700 5500 24200 22300 8190 

Number of Total Pores 21500 20400 5950 26800 25000 8860 

Number Open Pores 2740 2510 527 2580 2550 717 

Open Pore Density 17.4 16.4 2.83 15.9 14.8 4.18 

Open Porosity (%) 1.5 1.33 0.763 0.9 0.781 0.298 

Perif.CA.Surf 2.66E+08 2.67E+08 1.17E+07 2.68E+08 2.69E+08 1.37E+07 

Perif.TA.Surf 1.61E+08 1.62E+08 6.05E+06 1.64E+08 1.67E+08 7.83E+06 

Pore Density 136 135 32.7 165 153 49.8 

Pore Fractal 2.19 2.17 0.101 2.21 2.24 0.114 

Pore Segment Mean Length 102 98.6 15.9 98.9 94.8 11.4 

Pore Segment Mean Radius 6.13 5.84 1.1 4.76 4.72 0.467 

Pore Separation 316 323 51.7 287 288 41.7 

Pore Surface:Cortical Volume 0.00281 0.00263 0.000745 0.00288 0.00292 0.000791 

Pore Surface:PoreVolume 0.142 0.141 0.025 0.168 0.165 0.0194 

Pore Tb.N 0.000452 0.000463 0.00012 0.000529 0.000512 0.00015 

Pore Thickness 46.9 42.3 16.1 33.2 33.5 6.02 

Pore Volume 3.30E+09 3.23E+09 1.35E+09 2.81E+09 2.81E+09 8.56E+08 

RCS 0.00221 0.00218 0.000133 0.00222 0.00223 0.000123 

RCV 57.4 57.9 3.29 59.6 59.2 3.01 

SD Pore Separation 131 138 31.2 107 107 15.7 
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SD Pore Thickness 36.2 30.7 17 22.5 22.7 5.6 

TA 2.75E+11 2.77E+11 1.83E+10 2.71E+11 2.74E+11 2.16E+10 

TA.Surf 2.59E+08 2.61E+08 1.22E+07 2.71E+08 2.74E+08 1.37E+07 

Total Number of Pore Segments 39300 37900 13700 42800 39000 16100 

Total Number of Pore Systems 17400 16100 4780 21300 19700 6990 

Total Pore Network Length 3.90E+06 3.66E+06 1.15E+06 4.12E+06 4.40E+06 1.28E+06 

Total Pore Network Volume 1.21E+09 8.61E+08 9.55E+08 6.33E+08 5.23E+08 2.56E+08 

Total Porosity (%) 2.08 1.96 0.797 1.73 1.73 0.475 
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Aggregate Porosity by Drug Treatment Group 

Statistic 

Control Fentanyl 
Morphine 

Mean Median SD Mean Median SD Mean Median SD 

Avg.Ecc 0.636148 0.638978 0.036712 0.623715 0.625973 0.034284 0.623968 0.620252 0.031233 

Avg.Imax 1.59E+14 1.62E+14 2.14E+13 1.62E+14 1.63E+14 2.35E+13 1.67E+14 1.67E+14 2.64E+13 

Avg.Imin 9.38E+13 9.87E+13 1.24E+13 9.79E+13 9.50E+13 1.17E+13 1.01E+14 1.04E+14 1.21E+13 

Avg.Maj.Por.D 135.4328 134.665 10.437 130.4114 126.5861 12.20651 131.5644 131.3765 11.03398 

Avg.Orient.Phi 183.8362 182.326 11.92037 182.1381 182.3352 15.80249 184.1632 183.8948 10.11979 

Avg.Orient.Theta 39.91016 39.60321 4.160933 40.43178 41.31279 3.712449 39.87882 39.02917 3.367299 

Avg.Pol.MI 2.52E+14 2.55E+14 3.23E+13 2.6E+14 2.60E+14 3.41E+13 2.67E+14 2.74E+14 3.8E+13 

Avg.Por.Sph 0.598092 0.598827 0.006276 0.598056 0.594784 0.006484 0.599018 0.599582 0.004301 

Avg.Por.Surf 20937.35 20711.07 3994.201 17762.61 16787.98 2410.062 19355.17 17740.05 4798.839 

Avg.Por.Th 18.09654 18.07341 0.319948 17.97126 18.02239 0.230789 18.04158 18.00837 0.3627 

Avg.Por.Vol 156550.8 151502.2 58212.53 109531.4 100465.4 30369.36 133002.9 107812.5 60677.18 

Bone Surface 4.56E+08 4.77E+08 1.44E+08 4.56E+08 4.65E+08 1.22E+08 4.58E+08 4.22E+08 1.5E+08 

CA 1.56E+11 1.58E+11 1.33E+10 1.61E+11 1.61E+11 1.47E+10 1.62E+11 1.64E+11 1.08E+10 

CA.Surf 3.49E+08 3.47E+08 1.59E+07 3.51E+08 3.54E+08 1.73E+07 3.56E+08 3.61E+08 2.04E+07 

Closed Pore Density 124.6836 122.795 42.87304 143.8457 129.675 40.01202 131.9557 124.345 42.03771 

Closed Porosity (%) 0.66682 0.644957 0.238742 0.728133 0.709141 0.212048 0.739053 0.698785 0.24225 

Connectivity 5200.357 4526 3377.933 5553.357 5347 2794.798 5359.5 4879 2447.602 

Connectivity density 32.85714 30 22.33609 34.28571 30 16.50841 33.57143 30 14.46861 

Cortical Fractal 2.416269 2.419051 0.078361 2.423845 2.416498 0.061199 2.412575 2.391277 0.080192 

Cortical Surface 3.26E+08 3.26E+08 14497503 3.28E+08 3.33E+08 14725227 3.33E+08 3.39E+08 18135630 

Cortical Volume 1.56E+11 1.57E+11 1.32E+10 1.61E+11 1.61E+11 1.46E+10 1.62E+11 1.64E+11 1.07E+10 

CS.Th 1175.823 1166.327 97.61926 1206.311 1196.355 89.14783 1198.696 1198.413 41.74714 

Degree of Anisotropy 0.407107 0.41482 0.047927 0.396555 0.393718 0.056547 0.40917 0.415283 0.050911 

Euler number 16753.79 16847 5136.923 20688.64 17979.5 6941.721 18828.86 16727 6349.512 
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Intersection Surface 2687337 2373810 1392119 2147167 1858801 904014 2188131 1819857 922043.4 

Max Pore System Branching Nodes 1631.786 1223.5 1934.832 902.9286 658.5 847.388 1402.357 817.5 1974.698 

Max Pore System Mean Length 1549.013 1428.842 466.9438 1491.793 1497.542 493.4139 1622.046 1418.72 711.827 

Max Pore System Mean Radius 34.54153 32.51605 7.123643 30.16035 29.9185 9.613187 35.49835 36.08188 9.697697 

Max Pore System Number of Nodes 2731.643 2103 3179.629 1467.143 1009 1287.163 2352.786 1337.5 3454.648 

Max Pore System Number of Segments 3084.429 2340 3643.944 1685.429 1197.5 1554.636 2654.357 1552 3800.931 

Max Pore System Terminal Nodes 1099.857 725.5 1254.426 570.0714 389 447.6864 950.9286 445.5 1484.673 

Max Pore System Total Length 306714.1 230394 324946.6 158814.5 105540.8 117934.7 259546.2 148867.4 409792.8 

Max Pore System Total Volume 4.07E+08 1.40E+08 7.56E+08 1.13E+08 4.46E+07 1.53E+08 1.80E+08 9.57E+07 3.18E+08 

Mean Pore System Branching Nodes 0.641197 0.58316 0.304911 0.55514 0.530713 0.192876 0.576814 0.634032 0.16527 

Mean Pore System Mean Length 97.7021 93.48934 10.51914 95.20872 90.57769 11.38345 94.82954 93.63808 8.711479 

Mean Pore System Mean Radius 3.585289 3.585042 0.078087 3.543849 3.544988 0.07705 3.583227 3.566061 0.104218 

Mean Pore System Number of Nodes 3.0947 3.002794 0.470774 2.94567 2.891761 0.287912 2.974822 3.048027 0.268017 

Mean Pore System Number of Segments 2.213731 2.1168 0.560052 2.05056 2.000784 0.35283 2.08572 2.182725 0.306565 

Mean Pore System Terminal Nodes 2.453503 2.433137 0.171278 2.39053 2.361278 0.098166 2.398008 2.399619 0.109597 

Mean Pore System Total Length 224.475 218.3498 40.24087 198.9967 196.0155 23.94564 206.8579 199.0303 39.66212 

Mean Pore System Total Volume 73476.95 52168.97 64250.68 34987.85 31835.91 22554.44 47287.03 35946.46 32084.62 

Med.Maj.Por.D 91.80073 89.71967 4.916869 91.32858 89.27042 5.723148 91.31844 90.61023 4.286601 

Med.Orient.Phi 191.0923 190.7201 28.27197 188.9688 192.3822 37.30396 192.5736 190.654 25.91855 

Med.Orient.Theta 35.67227 35.46339 6.475035 36.14122 37.46409 5.658605 35.06225 34.00327 5.503787 

Med.Por.Vol 26991.61 26768.25 1057.406 27049.51 26996.3 1217.301 27041.73 26809.71 1295.849 

Med.Pore.Sph 0.603038 0.604234 0.006528 0.602752 0.599093 0.006417 0.603697 0.604452 0.004229 

Med.Pore.Surf 7072.387 7032.164 228.631 7091.25 7114.477 261.2735 7073.842 7041.587 252.9123 

Med.Pore.Th 18.01792 18.05207 0.282429 17.91444 18.01489 0.285778 17.98979 18.00092 0.311777 

Median Pore System Mean Length 77.45663 76.05039 5.624598 76.73146 74.1589 6.366114 76.53023 76.25973 4.819167 

Median Pore System Mean Radius 3.266341 3.263471 0.05152 3.261294 3.258058 0.050637 3.267708 3.261214 0.07418 

Median Pore System Total Length 83.51142 81.53205 4.568035 83.08809 81.62389 5.97615 82.62487 81.85128 4.209824 

Median Pore System Total Volume 2964.498 2899.235 253.67 2938.278 2875.092 287.0528 2944.041 2880.688 288.3502 

Min Pore System Mean Length 23.12487 23.33685 2.233748 23.31144 23.95517 2.37392 24.57464 24.73971 1.362512 

Min Pore System Total Length 24.38023 24.3568 1.146507 24.87407 24.98697 0.941736 25.08895 25.46202 1.200903 
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Min Pore System Total Volume 617.4219 618.967 28.94808 615.4297 616.2354 20.90335 618.7285 622.1925 18.76684 

Number Closed Pores 19398.86 19118.5 6435.06 23461.86 20172 8071.889 21543 19923 7632.757 

Number of objects 21954.14 21493.5 6825.283 26242 22919 8643.661 24188.36 22027 8176.99 

Number Open Pores 2555.286 2530.5 502.2113 2780.143 2821.5 656.4014 2645.357 2466 726.6014 

Open Pore Density 16.50357 15.85 3.609438 17.17857 17.18 3.147062 16.315 15.1 4.182787 

Open Porosity (%) 1.500608 1.384746 0.8349 0.964882 0.882883 0.301652 1.142188 1.063898 0.615702 

Perif.CA.Surf 2.65E+08 2.67E+08 1.24E+07 2.66E+08 2.69E+08 1.05E+07 2.70E+08 2.75E+08 1.50E+07 

Perif.TA.Surf 1.61E+08 1.62E+08 6.25E+06 1.62E+08 1.63E+08 6.86E+06 1.64E+08 1.66E+08 8.42E+06 

Pore Density 141.1871 138.8 45.65355 161.025 146.98 42.45907 148.2729 137.375 44.92263 

Pore Fractal 2.19811 2.20631 0.120745 2.211281 2.221823 0.088779 2.197372 2.173235 0.116776 

Pore Segment Mean Length 103.5061 101.4978 14.4784 98.58273 92.94501 14.97442 99.3866 97.06824 12.14204 

Pore Segment Mean Radius 5.915659 5.680023 1.31056 5.012047 4.857272 0.795456 5.411118 5.218703 0.962005 

Pore Separation 300.7096 290.2501 49.40502 296.3338 289.3665 43.5727 306.3603 308.896 55.39753 

Pore Surface:Cortical Volume 0.002923 0.002855 0.000891 0.002808 0.002841 0.000585 0.002799 0.002627 0.00082 

Pore Surface:PoreVolume 0.141985 0.141258 0.025822 0.167649 0.166593 0.022517 0.154698 0.15937 0.023817 

Pore Tb.N 0.000473 0.000465 0.000146 0.000514 0.000542 0.000142 0.000484 0.000465 0.000139 

Pore Thickness 47.01922 41.72279 18.81741 34.4534 32.59451 9.667331 38.64613 37.82341 8.412029 

Pore Volume 3.38E+09 3.43E+09 1.43E+09 2.73E+09 2.75E+09 6.52E+08 3.06E+09 2.97E+09 1.21E+09 

RCS 0.002247 0.002269 0.000159 0.002194 0.00219 0.000138 0.002199 0.002185 6.41E-05 

RCV 58.18628 58.62999 4.256754 58.95844 59.18785 3.045703 58.25999 58.52213 2.611991 

SD Pore Separation 116.4013 113.6197 26.20997 118.8709 112.012 29.22194 121.3316 114.4687 28.14616 

SD Pore Thickness 35.55706 27.41297 19.84536 24.70519 23.08394 11.03015 27.88241 28.16256 7.976469 

TA 2.68E+11 2.70E+11 1.97E+10 2.72E+11 2.76E+11 1.71E+10 2.78E+11 2.83E+11 2.24E+10 

TA.Surf 2.62E+08 2.64E+08 1.22E+07 2.65E+08 2.67E+08 1.40E+07 2.68E+08 2.72E+08 1.61E+07 

Total Number of Pore Segments 39557 40648.5 15894.93 43042.21 40723 14861.78 40596.43 35368.5 14690.23 

Total Number of Pore Systems 17632.5 16983.5 5351.771 21037.57 18991 6875.583 19384 17472.5 6385.505 

Total Pore Network Length 3935536 4048173 1222309 4125308 4130599 1160391 3963347 3526643 1311963 

Total Pore Network Volume 1.25E+09 1.07E+09 1.11E+09 6.59E+08 5.59E+08 3.08E+08 8.58E+08 8.05E+08 5.07E+08 

Total Porosity (%) 2.157467 2.109555 0.857079 1.686125 1.715845 0.324543 1.872641 1.909647 0.682214 
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Aggregate Porosity by Bone and Drug Treatment Group 

Group Control 

Bone 
Femur 

Tibia 

Statistic Mean Median SD Mean Median SD 

Avg.Ecc 0.645 0.641 0.0217 0.627 0.63 0.0477 

Avg.Imax 1.61E+14 1.71E+14 2.39E+13 1.56E+14 1.61E+14 2.03E+13 

Avg.Imin 9.36E+13 9.75E+13 1.22E+13 9.39E+13 9.98E+13 1.35E+13 

Avg.Maj.Por.D 136 133 13.3 135 135 7.68 

Avg.Orient.Phi 174 175 6.47 194 195 6.58 

Avg.Orient.Theta 38.6 38.6 5.3 41.2 41.4 2.38 

Avg.Pol.MI 2.55E+14 2.68E+14 3.56E+13 2.5E+14 2.47E+14 3.14E+13 

Avg.Por.Sph 0.599 0.6 0.00592 0.597 0.597 0.00698 

Avg.Por.Surf 23900 23800 3190 18000 17500 1960 

Avg.Por.Th 18.3 18.3 0.34 17.9 18 0.225 

Avg.Por.Vol 201000 198000 47400 112000 112000 20400 

Bone Surface 4.98E+08 5.23E+08 1.33E+08 4.15E+08 3.39E+08 1.52E+08 

CA 1.56E+11 1.59E+11 1.39E+10 1.56E+11 1.56E+11 1.38E+10 

CA.Surf 3.46E+08 3.44E+08 1.57E+07 3.51E+08 3.53E+08 1.69E+07 

Closed Pore Density 116 121 28.8 134 124 54.4 

Closed Porosity (%) 0.58 0.643 0.118 0.754 0.649 0.303 
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Connectivity 5480 5100 3730 4920 4120 3260 

Connectivity Density 32.9 30 23.6 32.9 30 22.9 

Cortical Fractal 2.43 2.46 0.0645 2.4 2.39 0.0937 

Cortical Surface 3.26E+08 3.25E+08 1.45E+07 3.27E+08 3.29E+08 1.56E+07 

Cortical Volume 1.56E+11 1.59E+11 1.39E+10 1.56E+11 1.56E+11 1.37E+10 

CS.Th 1170 1210 116 1180 1160 84.9 

Degree of Anistropy 0.396 0.378 0.0575 0.418 0.436 0.0373 

Euler number 15300 15300 4490 18200 17000 5680 

Intersection Surface 3670000 3340000 1290000 1710000 1600000 526000 

Max Pore System Branching Nodes 2620 1360 2310 641 214 683 

Max Pore System Mean Length 1450 1210 494 1640 1470 456 

Max Pore System Mean Radius 32.6 32.4 5.65 36.5 36.2 8.29 

Max Pore System Number of Nodes 4430 2160 3740 1040 362 1110 

Max Pore System Number of Segments 4980 2490 4340 1190 406 1260 

Max Pore System Terminal Nodes 1800 939 1440 397 148 436 

Max Pore System Total Length 491000 276000 362000 123000 44400 136000 

Max Pore System Total Volume 7.46E+08 4.77E+08 9.84E+08 6.92E+07 3.68E+07 6.77E+07 

Mean Pore System Branching Nodes 0.791 0.709 0.358 0.491 0.541 0.143 

Mean Pore System Mean Length 100 93.8 13 95.2 93.1 7.55 

Mean Pore System Mean Radius 3.62 3.63 0.0763 3.55 3.56 0.0632 

Mean Pore System Number of Nodes 3.35 3.25 0.521 2.84 2.91 0.231 

Mean Pore System Number of 
Segments 

2.5 2.36 0.644 1.93 2.02 0.265 

Mean Pore System Terminal Nodes 2.56 2.54 0.167 2.35 2.37 0.0913 

Mean Pore System Total Length 253 248 34.7 196 190 20.2 

Mean Pore System Total Volume 114000 83900 70900 33100 33300 10100 

Med.Maj.Por.D 94 89.7 6.16 89.6 89.5 1.7 

Med.Orient.Phi 167 173 15.9 215 217 9.89 

Med.Orient.Theta 33.5 33.7 8.23 37.8 38.2 3.53 

Med.Por.Vol 27400 27200 1100 26600 26500 921 
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Med.Pore.Sph 0.603 0.605 0.00526 0.603 0.602 0.00803 

Med.Pore.Surf 7130 7100 222 7020 6980 238 

Med.Pore.Th 18.1 18.1 0.274 17.9 18 0.253 

Median Pore System Mean Length 79.6 76.2 7.22 75.3 74.3 2.44 

Median Pore System Mean Radius 3.29 3.27 0.056 3.25 3.26 0.04 

Median Pore System Total Length 85.6 81.6 5.73 81.5 81.3 1.63 

Median Pore System Total Volume 3090 2900 310 2840 2800 94.5 

Min Pore System Mean Length 23.7 23.4 1.47 22.5 23.3 2.78 

Min Pore System Total Length 24.2 24.9 1.2 24.5 23.8 1.16 

Min Pore System Total Volume 617 615 32.8 617 620 27.2 

Number Closed Pores 18100 20000 4620 20700 18200 8030 

Number of objects 20800 23000 4870 23100 20200 8610 

Number Open Pores 2720 2910 281 2390 2300 637 

Open Pore Density 17.5 18.2 2.05 15.5 14.2 4.66 

Open Porosity (%) 2.09 1.71 0.747 0.907 0.747 0.362 

Perif.CA.Surf 2.67E+08 2.63E+08 1.31E+07 2.64E+08 2.68E+08 1.27E+07 

Perif.TA.Surf 1.60E+08 1.62E+08 6.33E+06 1.62E+08 1.63E+08 6.62E+06 

Pore Density 133 139 30.2 149 138 58.8 

Pore Fractal 2.23 2.26 0.0937 2.17 2.16 0.145 

Pore Segment Mean Length 104 98.2 17.4 103 105 12.2 

Pore Segment Mean Radius 7.03 6.88 0.8 4.8 4.77 0.4 

Pore Separation 301 284 48.6 300 296 54.1 

Pore Surface:Cortical Volume 0.00317 0.00328 0.000765 0.00267 0.00232 0.000996 

Pore Surface:PoreVolume 0.121 0.122 0.0151 0.163 0.162 0.0145 

Pore Tb.N 0.000471 0.000466 0.000126 0.000475 0.000431 0.000174 

Pore Thickness 59.2 51.1 19.9 34.8 33.5 4.77 

Pore Volume 4.17E+09 3.72E+09 1.39E+09 2.58E+09 2.16E+09 1E+09 

RCS 0.00223 0.00214 0.000194 0.00226 0.00228 0.000128 

RCV 57.1 58.1 4.56 59.3 58.9 3.95 

SD Pore Separation 127 116 29.4 106 110 19.6 
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SD Pore Thickness 46.5 38.2 23.8 24.7 23.3 3.15 

TA 2.74E+11 2.71E+11 1.87E+10 2.63E+11 2.68E+11 2.05E+10 

TA.Surf 2.59E+08 2.58E+08 1.26E+07 2.65E+08 2.66E+08 1.20E+07 

Total Number of Pore Segments 42600 44900 15100 36500 28500 17300 

Total Number of Pore Systems 16800 18000 3770 18400 15900 6810 

Total Pore Network Length 4260000 4400000 1110000 3610000 2980000 1330000 

Total Pore Network Volume 1.88E+09 1.57E+09 1.28E+09 6.17E+08 5.18E+08 3.06E+08 

Total Porosity (%) 2.66 2.33 0.804 1.65 1.39 0.594 

Group 
Fentanyl Morphine 

Bone 
Femur Tibia Femur Tibia 

Statistic Mean Median SD Mean Median SD Mean Median SD Mean Median SD 

Avg.Ecc 0.636 0.643 0.0373 0.611 0.606 0.0278 0.625 0.619 0.0379 0.623 0.621 0.0259 

Avg.Imax 1.58E+14 1.61E+14 2.24E+13 1.65E+14 1.64E+14 2.59E+13 1.6E+14 1.53E+14 2.96E+13 1.74E+14 1.83E+14 2.27E+13 

Avg.Imin 9.34E+13 9.4E+13 8.94E+12 1.02E+14 1E+14 1.29E+13 9.6E+13 9.68E+13 1.23E+13 1.06E+14 1.09E+14 1.06E+13 

Avg.Maj.Por.D 131 132 14 130 126 11.2 131 133 13.6 132 130 8.82 

Avg.Orient.Phi 168 167 5.67 196 198 6.85 176 177 5.91 192 191 5.4 

Avg.Orient.Theta 39.7 40.4 3.64 41.2 42 3.9 38.5 37.4 2.66 41.2 41.8 3.63 

Avg.Pol.MI 2.52E+14 2.55E+14 2.99E+13 2.68E+14 2.6E+14 3.86E+13 2.55E+14 2.46E+14 4.13E+13 2.8E+14 2.92E+14 3.29E+13 

Avg.Por.Sph 0.599 0.595 0.00763 0.597 0.594 0.00562 0.602 0.601 0.00384 0.596 0.596 0.00308 

Avg.Por.Surf 18800 19200 2180 16700 15700 2310 20300 17200 6330 18400 18000 2790 
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Avg.Por.Th 18.1 18.1 0.205 17.9 17.8 0.24 18.2 18.2 0.426 17.9 17.8 0.182 

Avg.Por.Vol 123000 113000 33100 96400 92400 22400 150000 112000 78400 116000 103000 34400 

Bone Surface 4.23E+08 4.16E+08 9.72E+07 4.90E+08 5.38E+08 1.42E+08 4.17E+08 3.95E+08 1.65E+08 4.99E+08 4.49E+08 1.33E+08 

CA 1.59E+11 1.52E+11 1.19E+10 1.63E+11 1.63E+11 1.78E+10 1.57E+11 1.61E+11 1.02E+10 1.67E+11 1.68E+11 9.71E+09 

CA.Surf 3.44E+08 3.47E+08 1.17E+07 3.57E+08 3.66E+08 2.02E+07 3.47E+08 3.51E+08 1.93E+07 3.64E+08 3.65E+08 1.92E+07 

Closed Pore Density 125 117 28.9 163 171 42.6 114 106 36.7 149 138 42.1 

Closed Porosity (%) 0.604 0.565 0.135 0.852 0.856 0.208 0.575 0.564 0.16 0.903 0.914 0.197 

Connectivity 5030 4980 3110 6080 6320 2570 4260 4720 2020 6460 6510 2460 

Connectivity density 31.4 30 20.4 37.1 30 12.5 27.1 30 12.5 40 40 14.1 

Cortical Fractal 2.4 2.4 0.0507 2.45 2.46 0.0668 2.38 2.37 0.0906 2.44 2.4 0.062 

Cortical Surface 3.24E+08 3.28E+08 1.05E+07 3.32E+08 3.41E+08 1.79E+07 3.27E+08 3.30E+08 1.80E+07 3.38E+08 3.41E+08 1.77E+07 

Cortical Volume 1.59E+11 1.52E+11 1.19E+10 1.62E+11 1.63E+11 1.76E+10 1.57E+11 1.61E+11 1.02E+10 1.67E+11 1.68E+11 9.47E+09 

CS.Th 1200 1190 81.3 1210 1210 103 1180 1190 36.7 1220 1230 33.5 

Degree of Anistropy 0.366 0.353 0.0524 0.427 0.418 0.0445 0.403 0.421 0.056 0.416 0.409 0.0488 

Euler number 17800 15700 5750 23600 26400 7180 16600 14400 5840 21100 20100 6420 

Intersection Surface 2500000 2540000 1000000 1790000 1800000 684000 2710000 3060000 923000 1670000 1760000 603000 

Max Pore System 
Branching Nodes 

1190 953 1110 613 631 340 1680 665 2600 1130 994 1230 

Max Pore System 
Mean Length 

1350 1290 577 1630 1560 383 1280 1210 388 1970 1810 819 

Max Pore System 
Mean Radius 

27.8 28.7 6.5 32.6 37.6 12 36.8 37.2 9.6 34.2 30.8 10.4 

Max Pore System 
Number of Nodes 

1960 1690 1670 970 954 477 2870 1100 4580 1840 1580 2060 

Max Pore System 
Number of 
Segments 

2250 1830 2040 1130 1150 600 3200 1240 5020 2110 1910 2330 

Max Pore System 
Terminal Nodes 

771 733 561 369 322 159 1190 432 1990 711 459 835 

Max Pore System 
Total Length 

211000 200000 148000 107000 99300 43200 339000 119000 561000 180000 179000 186000 

Max Pore System 
Total Volume 

1.73E+08 1.16E+08 2.01E+08 5.21E+07 4.17E+07 4.19E+07 2.88E+08 9.63E+07 4.35E+08 7.23E+07 9.50E+07 4.98E+07 
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Mean Pore System 
Branching Nodes 

0.615 0.536 0.259 0.495 0.525 0.0716 0.579 0.623 0.201 0.575 0.645 0.138 

Mean Pore System 
Mean Length 

97.5 94.9 14.6 92.9 89.3 7.46 98.4 98.7 10.3 91.2 90.9 5.2 

Mean Pore System 
Mean Radius 

3.57 3.58 0.0614 3.52 3.49 0.0848 3.63 3.61 0.118 3.54 3.55 0.0724 

Mean Pore System 
Number of Nodes 

3.05 2.92 0.375 2.84 2.89 0.12 2.99 3.02 0.338 2.96 3.08 0.203 

Mean Pore System 
Number of 
Segments 

2.17 2.02 0.469 1.93 1.99 0.135 2.1 2.15 0.378 2.07 2.21 0.246 

Mean Pore System 
Terminal Nodes 

2.43 2.38 0.117 2.35 2.35 0.0539 2.41 2.39 0.144 2.38 2.4 0.0691 

Mean Pore System 
Total Length 

210 221 20 188 178 23.4 214 191 53.3 199 203 20.8 

Mean Pore System 
Total Volume 

44700 33900 28000 25300 23600 9900 59500 45200 40000 35000 29600 16700 

Med.Maj.Por.D 93.1 92.5 7.37 89.6 89.2 3.11 93.4 93.6 5.05 89.2 88.6 1.93 

Med.Orient.Phi 154 152 12.5 223 225 9.14 169 172 9.63 216 213 9 

Med.Orient.Theta 34.8 35.7 5.76 37.5 38.5 5.64 32.5 30.6 4.32 37.6 38.4 5.66 

Med.Por.Vol 27200 27900 1410 26900 26600 1070 27200 27100 1650 26900 26700 922 

Med.Pore.Sph 0.604 0.599 0.00732 0.602 0.599 0.00586 0.606 0.605 0.00334 0.602 0.599 0.00406 

Med.Pore.Surf 7120 7280 307 7070 7030 228 7080 7070 320 7070 7020 190 

Med.Pore.Th 18.1 18.1 0.169 17.8 17.7 0.316 18.1 18.2 0.324 17.8 17.9 0.229 

Median Pore System 
Mean Length 

78.6 76.9 8.29 74.8 73.7 3.28 79 78.7 5.59 74 73 2.16 

Median Pore System 
Mean Radius 

3.27 3.29 0.0426 3.25 3.25 0.0589 3.3 3.31 0.0864 3.24 3.22 0.0499 

Median Pore System 
Total Length 

84.6 85.8 7.8 81.6 81.5 3.37 84.5 84.2 5.11 80.8 80.3 2.13 

Median Pore System 
Total Volume 

3020 3110 338 2860 2870 223 3060 3120 344 2830 2760 171 

Min Pore System 
Mean Length 

23.7 24.5 1.87 22.9 23.4 2.88 25 25.6 1.52 24.2 24.6 1.15 

Min Pore System 
Total Length 

25.2 25.1 0.862 24.6 24.9 0.993 25.9 26.1 0.649 24.3 24.6 1.1 
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Min Pore System 
Total Volume 

611 595 25 620 616 16.6 627 624 13.6 611 611 20.7 

Number Closed 
Pores 

20000 17700 6050 26900 31800 8790 18100 15800 6300 25000 22600 7650 

Number of objects 22800 20400 6580 29700 34900 9540 20800 18300 6940 27600 25000 8390 

Number Open Pores 2760 2500 539 2800 3000 801 2750 2510 745 2540 2420 752 

Open Pore Density 17.3 16.4 2.31 17.1 18.2 4.01 17.4 15.2 4.14 15.2 14.8 4.24 

Open Porosity (%) 1.09 1.08 0.308 0.837 0.758 0.254 1.33 1.04 0.805 0.957 1.09 0.304 

Perif.CA.Surf 2.65E+08 2.68E+08 7.67E+06 2.68E+08 2.74E+08 1.32E+07 2.67E+08 2.70E+08 1.50E+07 2.73E+08 2.76E+08 1.56E+07 

Perif.TA.Surf 1.60E+08 1.61E+08 4.42E+06 1.64E+08 1.68E+08 8.59E+06 1.61E+08 1.62E+08 7.88E+06 1.67E+08 1.69E+08 8.29E+06 

Pore Density 142 135 31.1 180 186 46.1 132 121 40.1 165 153 46.2 

Pore Fractal 2.19 2.16 0.0686 2.23 2.27 0.106 2.16 2.16 0.135 2.23 2.18 0.09 

Pore Segment Mean 
Length 

99.9 94.1 18.2 97.3 91.8 12.3 102 100 14.2 96.7 94.7 10 

Pore Segment Mean 
Radius 

5.45 5.28 0.892 4.58 4.55 0.369 5.91 5.67 1.02 4.91 4.83 0.604 

Pore Separation 315 303 43.9 278 267 37.4 331 346 64 282 303 33.6 

Pore Surface: 
Cortical Volume 

0.00264 0.00245 0.000446 0.00297 0.00301 0.000692 0.00262 0.00245 0.000914 0.00298 0.00263 0.000737 

Pore Surface: 
PoreVolume 

0.158 0.163 0.0231 0.177 0.178 0.0191 0.145 0.153 0.0222 0.164 0.165 0.0231 

Pore Tb.N 0.000457 0.000435 0.000108 0.000572 0.000614 0.000156 0.000427 0.00039 0.000139 0.000542 0.000473 0.000122 

Pore Thickness 38.5 33.7 11.5 30.4 30.1 5.59 42.9 40.9 7.59 34.4 34.6 7.26 

Pore Volume 2.7E+09 2.68E+09 6.12E+08 2.75E+09 2.81E+09 7.38E+08 3.04E+09 2.57E+09 1.55E+09 3.09E+09 3.46E+09 8.59E+08 

RCS 0.00218 0.00219 0.000115 0.00221 0.00219 0.000166 0.00222 0.00218 7.65E-05 0.00218 0.00219 4.94E-05 

RCV 58.1 58.6 2.76 59.8 59.5 3.27 56.9 56.8 2.62 59.6 59.3 1.92 

SD Pore Separation 130 119 35.5 108 99.1 17.8 136 151 32.5 106 103 11.1 

SD Pore Thickness 29.8 24.9 13.1 19.6 20.8 5.7 32.5 30.7 6.48 23.3 24.2 6.82 

TA 2.73E+11 2.77E+11 1.39E+10 2.71E+11 2.74E+11 2.1E+10 2.77E+11 2.79E+11 2.38E+10 2.8E+11 2.87E+11 2.27E+10 

TA.Surf 2.58E+08 2.61E+08 1.00E+07 2.71E+08 2.77E+08 1.52E+07 2.60E+08 2.61E+08 1.54E+07 2.76E+08 2.79E+08 1.37E+07 

Total Number of 
Pore Segments 

39700 37600 13900 46400 51900 16100 35600 31600 13200 45600 35900 15400 
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Total Number of 
Pore Systems 

18400 16100 5400 23700 27700 7520 16900 14700 5570 21900 19700 6550 

Total Pore Network 
Length 

3830000 3540000 988000 4420000 4800000 1320000 3610000 3420000 1400000 4320000 3590000 1210000 

Total Pore Network 
Volume 

7.64E+08 7.09E+08 3.85E+08 5.55E+08 5.12E+08 1.77E+08 9.89E+08 8.07E+08 6.64E+08 7.27E+08 8.02E+08 2.77E+08 

Total Porosity (%) 1.69 1.81 0.296 1.68 1.55 0.375 1.89 1.6 0.88 1.85 2.02 0.483 

Descriptive Statistics: Femoral Regions 

Femoral Porosity by Region 

Statistic 

Anterior 
Lateral 

Medial 
Posterior 

Mean Median SD Mean Median SD Mean Median SD Mean Median SD 

Pore Surface 4.83E+10 1.10E+08 1.25E+11 3.47E+10 8.20E+07 9.20E+10 4.31E+10 1.22E+08 1.10E+11 5.14E+10 1.29E+08 1.29E+11 

Closed Pore 
Density 

96.4 102 48.8 103 102 53 132 147 65.8 87.4 91.4 43.3 

Closed 
Porosity (%) 

0.49 0.494 0.136 0.572 0.589 0.148 0.691 0.718 0.186 0.558 0.581 0.117 

Connectivity 1140 1140 676 1050 883 789 1320 1280 710 1470 1330 942 

Connectivity 
density 

19.5 20 12.8 25.2 30 21.8 28.6 30 19.8 26.7 30 18.8 

Cortical 
Fractal 

2.34 2.33 0.0819 2.36 2.36 0.0724 2.43 2.42 0.0643 2.39 2.37 0.057 

Cortical 
Surface 

3.52E+10 1.03E+08 8.81E+10 3.05E+10 9.12E+07 7.64E+10 3.13E+10 9.25E+07 7.84E+10 3.76E+10 1.08E+08 9.42E+10 

Cortical 
Volume 

7.86E+14 4.51E+10 1.97E+15 5.59E+14 3.20E+10 1.40E+15 5.84E+14 3.55E+10 1.47E+15 7.71E+14 4.50E+10 1.94E+15 

Degree of 
Anisotropy 

0.391 0.374 0.0666 0.322 0.287 0.0806 0.451 0.456 0.0641 0.422 0.42 0.0629 

Euler 
number 

4700 4360 1510 3760 3290 1280 4960 4370 1640 4010 3720 1280 

Intersection 
Surface 

4.42E+08 9.33E+05 1.16E+09 4.20E+08 9.67E+05 1.10E+09 3.56E+08 1.04E+06 9.34E+08 4.28E+08 1.17E+06 1.10E+09 
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Avg. Pore 
Major 

diameter 
976 127 2170 1250 129 2370 1250 135 2390 1110 141 2450 

Number 
Closed Pores 

4890 4750 1500 3890 3440 1300 5260 4840 1630 4390 4180 1190 

Number of 
Pores 

5840 5720 1670 4800 4150 1540 6280 5930 1820 5490 5140 1410 

Number 
Open Pores 

946 924 194 911 873 264 1020 948 224 1090 999 237 

Pore surface 9.82E+06 1.89E+04 2.49E+07 9.73E+06 1.68E+04 2.10E+07 1.05E+07 2.01E+04 2.25E+07 1.04E+07 2.32E+04 2.62E+07 

Pore volume 5.14E+09 1.43E+05 1.41E+10 3.60E+09 9.70E+04 8.03E+09 4.40E+09 1.35E+05 9.55E+09 4.50E+09 1.74E+05 1.16E+10 

Open Pore 
Density 

18.3 18.6 8.57 24.1 26.2 11.8 25.4 28.1 11.8 21.3 23 9.95 

Open 
Porosity (%) 

1.39 1.11 1.24 1.03 0.796 0.572 1.9 1.96 0.914 1.7 1.75 0.7 

Avg. Pore 
Orientation 

phi 
136 135 11.6 173 173 6.18 165 166 9.33 205 204 11.4 

Avg. Pore 
Orientation 

theta 
39.2 38.7 3.46 44.9 45.9 4.3 33.2 33.6 4.09 40.4 39.1 4.89 

Pore Density 115 119 56.9 127 131 64.3 157 178 76.9 109 114 53 

Pore Fractal 2.1 2.11 0.127 2.1 2.11 0.131 2.22 2.2 0.0903 2.15 2.13 0.0908 

Pore 
Separation 

2910 390 6480 2480 304 5530 2150 276 4770 2390 312 5260 

Pore 
Surface: 
Cortical 
Volume 

0.00198 0.00204 0.00113 0.0022 0.00236 0.00116 0.00293 0.00299 0.00146 0.00246 0.00258 0.00121 

Pore 
Surface: 

PoreVolume 
0.133 0.138 0.0625 0.152 0.183 0.0646 0.123 0.139 0.0581 0.118 0.129 0.0516 

Pore Tb.N 0.000331 0.000333 0.00018 0.000419 0.000457 0.000225 0.000467 0.000509 0.000246 0.000408 0.000443 0.000201 

2018-DU-BX-0188 Final Technical Report 
October 2021 

This resource was prepared by the author(s) using Federal funds provided by the U.S. 
Department of Justice. Opinions or points of view expressed are those of the author(s) and do not 

necessarily reflect the official position or policies of the U.S. Department of Justice.

224 



 
 

 
             

 
 

            

 
             

 
 

            

             

              

 

  

 
  

 
 

         

           

            

            

          

           

          

          

          

           

          

           

            

           

          

           

Pore 
Thickness 

552 43.2 1500 354 29.2 821 392 48 879 387 44.4 867 

Pore 
Volume 

2.64E+13 7.17E+08 7.78E+13 1.31E+13 4.92E+08 3.52E+13 1.69E+13 9.50E+08 4.39E+13 2.17E+13 9.98E+08 5.46E+13 

SD Pore 
Separation 

1360 167 3110 953 116 2130 841 109 1890 898 110 2010 

SD Pore 
Thickness 

379 30.2 1090 248 21.3 590 286 31.7 667 234 31.9 509 

Sphericity 0.614 0.612 0.00677 0.602 0.602 0.00576 0.607 0.61 0.00953 0.598 0.597 0.00713 

Total 
Porosity (%) 1.87 1.59 1.26 1.59 1.43 0.65 2.58 2.57 0.92 2.25 2.21 0.72 

Femoral Porosity by Drug Treatment Group 

Statistic 
Control Fentanyl Morphine 

Mean Median SD Mean Median SD Mean Median SD 

Pore Surface 9.38E+10 1.42E+08 1.58E+11 1.06E+08 99700000 29700000 3.92E+10 1.04E+08 9.84E+10 

Closed Pore Density 85 90.9 63.7 125 117 37.2 104 106 54.9 

Closed Porosity (%) 0.576 0.593 0.161 0.593 0.548 0.162 0.563 0.558 0.172 

Connectivity 1390 1140 934 1270 1180 832 1080 1030 548 

Connectivity density 17.9 15 15.5 32.1 30 21.1 25 30 16.4 

Cortical Fractal 2.4 2.4 0.0752 2.38 2.37 0.0589 2.36 2.36 0.0885 

Cortical Surface 6.62E+10 1.03E+08 1.07E+11 9.79E+07 9.85E+07 8.25E+06 3.47E+10 9.99E+07 8.66E+10 

Cortical Volume 1.35E+15 4.39E+10 2.21E+15 3.97E+10 4.14E+10 6.55E+09 6.73E+14 4.08E+10 1.70E+15 

Degree of Anisotropy 0.405 0.421 0.0866 0.376 0.37 0.0783 0.408 0.402 0.0835 

Euler number 4060 3750 1220 4670 4170 1650 4350 3800 1560 

Intersection Surface 8.37E+08 1.53E+06 1.44E+09 8.32E+05 7.39E+05 3.36E+05 3.97E+08 8.47E+05 1.00E+09 

Avg. Pore Major diameter 1800 146 2690 508 128 1390 1130 130 2520 

Number Closed Pores 4450 4710 1250 4930 4550 1590 4450 4220 1590 

Number of Pores 5440 5790 1390 5940 5560 1790 5430 5060 1820 

Number Open Pores 990 986 175 1010 935 253 977 889 280 
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Pore surface 1.69E+07 2.37E+04 2.79E+07 3.25E+06 1.88E+04 1.19E+07 1.02E+07 1.72E+04 2.55E+07 

Pore volume 7.29E+09 2.08E+05 1.36E+10 1.35E+09 1.15E+05 5.07E+09 4.59E+09 1.15E+05 1.16E+10 

Open Pore Density 18.9 23.3 13 25.8 24.1 6.31 22.1 22.3 11.2 

Open Porosity (%) 2.06 2.09 1.08 1.11 1.08 0.477 1.35 1.02 0.907 

Avg. Pore Orientation phi 170 172 27.6 166 164 24.4 173 173 27.8 

Avg. Pore Orientation theta 39.2 39.1 6.62 40.1 39.3 6.03 39 38.3 5.1 

Pore Density 104 116 76.1 151 141 42.3 126 130 65.4 

Pore Fractal 2.18 2.2 0.125 2.14 2.13 0.0849 2.12 2.12 0.14 

Pore Separation 4540 308 7050 307 304 55.5 2590 333 5680 

Pore Surface:Cortical 
Volume 

0.00225 0.00257 0.00162 0.00268 0.00255 0.000653 0.00226 0.00221 0.00134 

Pore Surface:PoreVolume 0.0955 0.117 0.0644 0.163 0.16 0.0278 0.136 0.148 0.0606 

Pore Tb.N 0.000361 0.000414 0.000264 0.000479 0.000449 0.000138 0.000379 0.00036 0.000216 

Pore Thickness 829 56.4 1470 36.9 34.3 13.3 398 41 899 

Pore Volume 4.09E+13 1.12E+09 7.88E+13 6.74E+08 6.75E+08 2.35E+08 1.76E+13 6.15E+08 4.51E+13 

SD Pore Separation 1870 109 3040 120 116 37.8 1050 127 2340 

SD Pore Thickness 604 39.3 1110 26.5 24.7 12.7 230 30.4 503 

Sphericity 0.605 0.604 0.00993 0.604 0.601 0.0109 0.607 0.607 0.00631 

Total Porosity (%) 2.62 2.63 1.11 1.69 1.63 0.501 1.9 1.64 0.983 
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Femoral Porosity by Region and Drug Treatment Group 

Group Control 

Region Anterior 
Lateral Medial 

Posterior 

Statistic Mean Median SD Mean Median SD Mean Median SD Mean Median SD 

Pore Surface 1.03E+11 1.36E+08 1.84E+11 7.12E+10 8.89E+07 1.33E+11 9.30E+10 1.49E+08 1.61E+11 1.08E+11 1.67E+08 1.85E+11 

Closed Pore Density 76.4 80.1 57.7 83.6 86 67.6 109 144 80.5 71.3 78.5 53.8 

Closed Porosity (%) 0.482 0.494 0.109 0.567 0.599 0.176 0.713 0.736 0.172 0.542 0.581 0.104 

Connectivity 1310 1150 938 1070 883 989 1490 1380 879 1670 1540 1030 

Connectivity density 14.3 10 12.7 15.7 10 14 21.4 20 19.5 20 20 17.3 

Cortical Fractal 2.37 2.39 0.0691 2.37 2.39 0.0927 2.46 2.48 0.0601 2.41 2.43 0.0405 

Cortical Surface 6.95E+10 1.04E+08 1.19E+11 5.98E+10 9.01E+07 1.02E+11 6.15E+10 9.16E+07 1.05E+11 7.39E+10 1.08E+08 1.26E+11 

Cortical Volume 1.58E+15 4.68E+10 2.71E+15 1.13E+15 3.19E+10 1.92E+15 1.17E+15 3.55E+10 1.99E+15 1.53E+15 4.57E+10 2.62E+15 

Degree of 
Anisotropy 

0.425 0.424 0.0617 0.313 0.305 0.0914 0.451 0.434 0.0644 0.431 0.435 0.0624 

Euler number 4270 4030 1340 3580 3140 1110 4620 4930 1270 3760 3550 1140 

Intersection Surface 9.36E+08 1.04E+06 1.71E+09 8.98E+08 9.71E+05 1.62E+09 7.20E+08 1.64E+06 1.33E+09 7.93E+08 1.51E+06 1.40E+09 

Avg. Pore Major 
diameter 1700 133 2710 1740 146 2740 1740 137 2750 2000 159 3160 

Number Closed 
Pores 

4640 5010 1260 3760 4570 1370 5070 4960 1170 4340 4400 1050 

Number of Pores 5580 5950 1420 4650 5540 1560 6110 5990 1260 5430 5630 1180 

Number Open Pores 941 937 160 888 954 188 1040 1020 120 1100 1140 179 

Pore surface 1.89E+07 2.19E+04 3.28E+07 1.34E+07 1.88E+04 2.33E+07 1.58E+07 2.20E+04 2.73E+07 1.96E+07 2.91E+04 3.35E+07 

Pore volume 1.09E+10 2.08E+05 2.12E+10 4.73E+09 1.13E+05 8.40E+09 5.98E+09 1.85E+05 1.07E+10 7.57E+09 2.44E+05 1.30E+10 

Open Pore Density 15.6 19.6 11.1 19.9 23 14.1 22.5 29.1 15.8 17.6 23.8 12.3 

Open Porosity (%) 2.25 1.68 1.62 1.17 0.75 0.784 2.58 2.62 0.756 2.23 2.19 0.312 

Avg. Pore 
Orientation phi 135 132 12.7 173 173 3.83 167 167 10.4 206 204 13.1 
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Avg. Pore 
Orientation theta 

38.1 38.7 4.12 45.2 44.5 5.71 33.4 33.6 4.98 40.1 39.1 6.19 

Pore Density 92 96.8 68.7 103 108 81.1 131 169 95.6 88.9 102 65.7 

Pore Fractal 2.15 2.18 0.107 2.1 2.13 0.177 2.26 2.29 0.0841 2.19 2.21 0.0606 

Pore Separation 5430 390 8880 4620 318 7580 3870 243 6260 4250 304 6820 

Pore 
Surface:Cortical 

Volume 
0.00193 0.00212 0.00141 0.00185 0.00203 0.00147 0.00286 0.00372 0.00205 0.00235 0.00261 0.00164 

Pore 
Surface:PoreVolum 

e 
0.0875 0.113 0.0596 0.124 0.167 0.0836 0.086 0.112 0.0606 0.0843 0.118 0.0562 

Pore Tb.N 0.0003 0.000338 0.00022 0.000339 0.000382 0.000268 0.000437 0.00062 0.000333 0.000369 0.000445 0.000267 

Pore Thickness 1250 58.9 2400 669 31.9 1110 734 57.9 1190 669 55.5 1050 

Pore Volume 6.13E+13 1.13E+09 1.25E+14 2.55E+13 4.92E+08 4.92E+13 3.52E+13 1.11E+09 6.32E+13 4.17E+13 1.35E+09 7.12E+13 

SD Pore Separation 2650 163 4430 1780 102 2900 1530 100 2540 1520 109 2450 

SD Pore Thickness 895 40.8 1800 513 21.3 870 581 40.4 1000 427 38.5 663 

Sphericity 0.616 0.615 0.00556 0.602 0.604 0.00625 0.606 0.603 0.00922 0.596 0.596 0.00655 

Total Porosity (%) 2.71 2.13 1.61 1.73 1.35 0.919 3.27 3.13 0.758 2.76 2.83 0.378 

Group 
Fentanyl 

Region 
Anterior Lateral Medial Posterior 

Statistic Mean Median SD Mean Median SD Mean Median SD Mean Median SD 

Pore Surface 9.93E+07 9.64E+07 2.69E+07 8.81E+07 7.88E+07 2.79E+07 1.10E+08 9.82E+07 2.47E+07 1.26E+08 1.15E+08 3.09E+07 

Closed Pore Density 115 109 28.3 124 111 32.7 162 148 38.7 100 91.4 20.7 

Closed Porosity (%) 0.501 0.499 0.133 0.571 0.527 0.128 0.736 0.718 0.195 0.566 0.541 0.102 

Connectivity 1060 1130 644 1160 995 942 1220 1280 565 1630 1580 1130 
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Connectivity density 24.3 20 14 35.7 30 30.5 34.3 30 17.2 34.3 30 22.3 

Cortical Fractal 2.33 2.34 0.0625 2.37 2.35 0.0558 2.42 2.42 0.0454 2.38 2.37 0.0421 

Cortical Surface 1.02E+08 1.01E+08 3.59E+06 9.08E+07 9.12E+07 5.87E+06 9.18E+07 9.25E+07 3.84E+06 1.07E+08 1.08E+08 4.64E+06 

Cortical Volume 4.55E+10 4.37E+10 3.68E+09 3.32E+10 3.20E+10 3.17E+09 3.51E+10 3.42E+10 3.54E+09 4.49E+10 4.32E+10 3.30E+09 

Degree of 
Anisotropy 

0.373 0.362 0.0777 0.304 0.278 0.0645 0.428 0.392 0.0702 0.399 0.39 0.051 

Euler number 5140 4410 1510 3940 3400 1400 5590 5170 1970 4020 3820 1320 

Intersection Surface 7.41E+05 5.61E+05 4.08E+05 9.15E+05 9.67E+05 3.50E+05 7.52E+05 6.73E+05 3.53E+05 9.18E+05 9.59E+05 2.44E+05 

Avg. Pore Major 
diameter 

122 121 13.7 928 124 2120 844 136 1890 137 132 15.6 

Number Closed 
Pores 5270 4750 1630 4150 3440 1400 5760 4760 1920 4530 4180 1110 

Number of Pores 6200 5720 1790 5100 4150 1700 6810 5710 2160 5650 5140 1360 

Number Open Pores 931 924 184 949 862 317 1050 948 253 1110 1050 253 

Pore surface 1.62E+04 1.59E+04 3.23E+03 6.35E+06 1.83E+04 1.68E+07 6.61E+06 1.66E+04 1.75E+07 2.24E+04 2.24E+04 2.62E+03 

Pore volume 1.05E+05 8.86E+04 3.92E+04 2.13E+09 9.77E+04 5.65E+09 3.27E+09 1.08E+05 8.64E+09 1.58E+05 1.49E+05 3.34E+04 

Open Pore Density 20.4 19.2 3.07 28.4 26.9 7.92 29.8 30.4 4.83 24.7 23 4.72 

Open Porosity (%) 0.861 0.789 0.344 0.933 0.796 0.361 1.26 1.23 0.633 1.39 1.54 0.386 

Avg. Pore 
Orientation phi 

135 136 11.6 169 171 7.68 162 159 8.25 197 197 10.4 

Avg. Pore 
Orientation theta 

39.4 38.1 3.17 46 46.1 1.79 32.9 34.4 4.54 42.1 44.5 4.84 

Pore Density 135 131 30.6 152 134 40.1 192 178 42.9 125 114 25.3 

Pore Fractal 2.09 2.09 0.0876 2.11 2.07 0.089 2.21 2.18 0.0605 2.15 2.11 0.0669 

Pore Separation 356 342 67.5 301 304 39.9 265 248 39.6 307 318 36.1 

Pore Surface: 
Cortical Volume 

0.00216 0.0021 0.000472 0.00265 0.00236 0.000789 0.00312 0.00295 0.000488 0.00279 0.00258 0.000537 

Pore Surface: 
PoreVolume 

0.164 0.179 0.0295 0.178 0.185 0.0216 0.165 0.167 0.0349 0.145 0.148 0.0164 

Pore Tb.N 0.000383 0.000372 0.000101 0.000518 0.000457 0.000175 0.00053 0.000509 0.000134 0.000486 0.000444 0.000103 

Pore Thickness 36.6 31.3 12 29.7 26.8 6.36 40.7 32.5 22 40.4 38.9 6.17 

Pore Volume 6.22E+08 6.87E+08 1.80E+08 4.96E+08 4.37E+08 1.42E+08 6.98E+08 5.99E+08 2.34E+08 8.82E+08 9.54E+08 2.25E+08 

SD Pore Separation 151 136 46 112 105 24.2 99.3 80.7 32.9 118 116 31.4 
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SD Pore Thickness 27.4 23.6 13.1 19.2 20.2 6.12 31.8 25.1 20.2 27.8 27.7 3.92 

Sphericity 0.615 0.61 0.00818 0.601 0.6 0.00566 0.605 0.599 0.0132 0.596 0.592 0.00635 

Total Porosity (%) 1.36 1.48 0.352 1.5 1.43 0.423 1.98 1.92 0.566 1.95 2 0.399 

Group Morphine 

Region 
Anterior Lateral Medial Posterior 

Statistic Mean Median SD Mean Median SD Mean Median SD Mean Median SD 

Pore Surface 4.17E+10 8.72E+07 1.10E+11 3.29E+10 9.07E+07 8.69E+10 3.61E+10 1.22E+08 9.52E+10 4.60E+10 1.04E+08 1.21E+11 

Closed Pore 
Density 

98.2 100 54.1 101 102 52.6 125 136 68.6 90.6 98.6 49.1 

Closed 
Porosity (%) 

0.486 0.425 0.18 0.579 0.589 0.162 0.623 0.598 0.197 0.565 0.61 0.155 

Connectivity 1030 1040 416 904 843 410 1260 1150 733 1120 1100 628 

Connectivity 
density 

20 20 11.5 24.3 30 15.1 30 30 23.1 25.7 30 16.2 

Cortical 
Fractal 

2.31 2.29 0.11 2.35 2.36 0.0751 2.41 2.4 0.0805 2.37 2.36 0.0781 

Cortical 
Surface 

3.59E+10 1.03E+08 9.48E+10 3.16E+10 9.12E+07 8.35E+10 3.24E+10 9.37E+07 8.54E+10 3.88E+10 1.09E+08 1.02E+11 

Cortical 
Volume 

7.74E+14 4.50E+10 2.05E+15 5.50E+14 3.34E+10 1.46E+15 5.87E+14 3.60E+10 1.55E+15 7.80E+14 4.41E+10 2.06E+15 

Degree of 
Anisotropy 

0.374 0.36 0.0536 0.349 0.335 0.0884 0.475 0.486 0.0577 0.436 0.437 0.0757 

Euler 
number 

4700 4170 1740 3760 2930 1460 4670 4360 1670 4270 3660 1510 

Intersection 
Surface 

3.88E+08 7.81E+05 1.03E+09 3.62E+08 9.19E+05 9.56E+08 3.48E+08 1.04E+06 9.17E+08 4.91E+08 9.08E+05 1.30E+09 
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Avg. Pore 
Major 

diameter 
1110 117 2620 1070 129 2500 1160 125 2740 1200 139 2830 

Number 
Closed Pores 

4770 4200 1740 3770 3170 1280 4960 4620 1820 4310 3840 1530 

Number of 
Pores 

5730 4970 1960 4660 4010 1570 5940 5530 2080 5380 4830 1810 

Number 
Open Pores 

965 871 256 896 873 307 977 899 292 1070 995 300 

Pore surface 1.06E+07 1.45E+04 2.79E+07 9.42E+06 1.64E+04 2.49E+07 9.16E+06 1.87E+04 2.42E+07 1.16E+07 1.74E+04 3.06E+07 

Pore volume 4.54E+09 8.65E+04 1.20E+10 3.94E+09 8.86E+04 1.04E+10 3.95E+09 1.34E+05 1.04E+10 5.92E+09 1.17E+05 1.57E+10 

Open Pore 
Density 

18.7 18.5 9.9 24.2 26.2 12.6 23.8 25 12.5 21.7 22.5 11.3 

Open 
Porosity (%) 1.07 0.6 1.06 0.971 0.924 0.555 1.88 1.99 0.888 1.48 1.05 0.941 

Avg. Pore 
Orientation 

phi 
138 135 12 175 175 5.58 167 173 9.53 211 212 6.13 

Avg. Pore 
Orientation 

theta 
40.1 39.8 3.2 43.5 45.6 4.69 33.3 33 3.21 39.1 38.8 3.51 

Pore Density 117 119 63.7 126 131 64.7 148 163 80.4 112 122 60.1 

Pore Fractal 2.06 2.05 0.172 2.08 2.11 0.131 2.2 2.18 0.117 2.12 2.09 0.126 

Pore 
Separation 

2940 411 6790 2500 320 5790 2320 280 5380 2600 322 6040 

Pore 
Surface: 
Cortical 
Volume 

0.00186 0.00156 0.00141 0.00211 0.00246 0.00112 0.00282 0.003 0.00161 0.00225 0.0023 0.00131 

Pore 
Surface: 

Pore Volume 
0.147 0.173 0.0694 0.155 0.185 0.0688 0.117 0.139 0.0519 0.126 0.149 0.0566 

Pore Tb.N 0.000311 0.000293 0.000211 0.0004 0.000482 0.000216 0.000435 0.000371 0.000256 0.000369 0.000364 0.000206 

Pore 
Thickness 

375 34.6 897 363 29.2 883 401 48 933 451 43.4 1080 

Pore Volume 1.79E+13 5.25E+08 4.72E+13 1.37E+13 5.67E+08 3.63E+13 1.56E+13 9.22E+08 4.12E+13 2.34E+13 7.35E+08 6.20E+13 
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SD Pore 
Separation 

1280 186 2980 968 124 2260 897 114 2070 1060 114 2500 

SD Pore 
Thickness 

215 27.2 499 212 20.9 507 246 35.1 551 248 34.7 574 

Sphericity 0.611 0.611 0.0062 0.604 0.604 0.00574 0.61 0.61 0.00517 0.604 0.604 0.00597 

Total 
Porosity (%) 

1.55 1.12 1.17 1.54 1.61 0.605 2.49 2.57 0.981 2.03 1.67 0.974 

Descriptive Statistics: Tibial Regions 

Tibial Porosity by Region 

Statistic 

Anterior Lateral Medial Posterior 

Mean Median SD Mean Median SD Mean Median SD Mean Median SD 

Pore 
Surface 

1.39E+08 1.33E+08 4.97E+07 9.29E+07 9.73E+07 3.11E+07 1.10E+08 1.01E+08 3.63E+07 1.27E+08 1.17E+08 3.95E+07 

Closed 
Pore 

Density 
138 124 55.6 170 170 55 158 152 39.3 127 116 41 

Closed 
Porosity 

(%) 
0.74 0.764 0.264 0.768 0.839 0.276 0.855 0.825 0.228 0.871 0.834 0.25 

Connectivit 
y 

2030 2000 1050 1180 1120 625 1300 1210 597 1340 1110 707 

Connectivit 
y density 

41 40 21.4 32.9 30 17.9 37.1 30 17.4 30.5 30 17.5 

Cortical 
Fractal 2.39 2.38 0.0813 2.4 2.41 0.0807 2.42 2.42 0.0646 2.4 2.4 0.0696 

Cortical 
Surface 

1.11E+08 1.12E+08 6.79E+06 9.68E+07 9.79E+07 4.39E+06 9.14E+07 9.26E+07 4.07E+06 1.06E+08 1.06E+08 7.40E+06 

Cortical 
Volume 

4.87E+10 4.92E+10 4.93E+09 3.49E+10 3.52E+10 2.27E+09 3.51E+10 3.61E+10 3.72E+09 4.28E+10 4.22E+10 4.81E+09 

Degree of 
Anisotropy 

0.455 0.438 0.0502 0.392 0.388 0.0427 0.43 0.435 0.049 0.46 0.468 0.0619 

Euler 
number 5910 5730 2420 5670 6220 1870 5220 4850 1230 5090 4590 1640 
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Intersection 
Surface 

6.17E+05 6.25E+05 3.40E+05 3.94E+05 3.66E+05 1.41E+05 7.29E+05 6.93E+05 2.97E+05 7.81E+05 7.64E+05 2.99E+05 

Avg. Pore 
Major 

diameter 
131 129 12.1 121 118 6.25 126 123 9.37 140 140 13.2 

Number 
Closed 
Pores 

6830 5900 2930 5970 5970 2080 5540 5040 1410 5460 4780 1960 

Number of 
Pores 

7940 6920 3300 6850 7220 2360 6520 6040 1680 6430 5670 2200 

Number 
Open Pores 

1110 1030 391 884 876 306 976 912 293 964 926 258 

Pore 
surface 

1.80E+04 1.74E+04 3.35E+03 1.36E+04 1.34E+04 1.36E+03 1.67E+04 1.64E+04 2.91E+03 2.03E+04 1.92E+04 4.23E+03 

Pore 
volume 

1.13E+05 1.02E+05 3.90E+04 6.91E+04 6.63E+04 1.31E+04 9.70E+04 9.56E+04 2.55E+04 1.42E+05 1.24E+05 5.51E+04 

Open Pore 
Density 

22.7 22 7.53 25.2 24.4 8.48 27.9 26.2 8.72 22.5 21 5.77 

Open 
Porosity 

(%) 
0.988 0.96 0.441 0.562 0.578 0.161 0.949 0.859 0.464 1.14 1.21 0.474 

Avg. Pore 
Orientation 

phi 
196 197 6.32 192 193 8 184 185 7.84 190 190 8.55 

Avg. Pore 
Orientation 

theta 
43.4 43.8 3.93 45.2 45.3 3.33 39.1 38.8 3.65 36.6 36.6 3 

Pore 
Density 

161 146 62.9 195 195 62.8 186 177 47.3 149 139 46.2 

Pore 
Fractal 

2.16 2.15 0.132 2.14 2.17 0.142 2.2 2.2 0.106 2.17 2.17 0.114 

Pore 
Separation 

303 306 51 268 264 51.3 264 268 33.8 286 287 42.4 

Pore 
Surface: 
Cortical 
Volume 

0.00282 0.00256 0.00094 0.00265 0.00268 0.000831 0.00311 0.00296 0.000924 0.00295 0.00278 0.000825 
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Pore 
Surface: 

Pore 
Volume 

0.167 0.17 0.0222 0.2 0.203 0.0146 0.177 0.177 0.0189 0.152 0.151 0.0275 

Pore Tb.N 0.000534 0.000485 0.000165 0.000542 0.000554 0.000177 0.000594 0.000534 0.000184 0.000526 0.000509 0.000143 

Pore 
Thickness 

32.2 31.6 6.06 24.8 24.1 3.8 30.4 30.5 5.76 38.6 37.3 9.64 

Pore 
Volume 

8.44E+08 8.03E+08 3.27E+08 4.65E+08 4.94E+08 1.47E+08 6.37E+08 6.14E+08 2.45E+08 8.62E+08 8.12E+08 3.19E+08 

SD Pore 
Separation 

117 115 19.7 84.6 81.9 19.1 92 92.9 13.9 106 102 21.2 

SD Pore 
Thickness 

19.9 21.1 4.56 14 14.2 4.73 20.3 19.9 6.22 25.5 26.6 7.24 

Sphericity 0.597 0.597 0.00464 0.605 0.603 0.00741 0.603 0.604 0.00591 0.605 0.605 0.00532 

Total 
Porosity 

(%) 
1.72 1.67 0.627 1.33 1.4 0.398 1.79 1.72 0.606 2 1.99 0.65 

Tibial Porosity by Drug Treatment Group 

Statistic 

Control Fentanyl Morphine 

Mean Median SD Mean Median SD Mean Median SD 

Pore Surface 1.04E+08 9.57E+07 4.42E+07 1.23E+08 1.19E+08 4.19E+07 1.25E+08 1.11E+08 4.01E+07 

Closed Pore Density 134 121 56.1 162 160 46.6 150 147 45.5 

Closed Porosity (%) 0.729 0.666 0.301 0.831 0.836 0.225 0.865 0.862 0.226 

Connectivity 1240 1010 855 1530 1440 838 1630 1390 750 

Connectivity density 31.1 20 22.8 36.1 40 16.4 38.9 40 15.9 

Cortical Fractal 2.38 2.37 0.0878 2.42 2.43 0.0663 2.41 2.4 0.0607 

Cortical Surface 9.91E+07 9.75E+07 9.10E+06 1.01E+08 9.90E+07 1.01E+07 1.03E+08 1.01E+08 9.19E+06 

Cortical Volume 3.89E+10 3.79E+10 6.60E+09 4.06E+10 3.91E+10 7.63E+09 4.17E+10 3.89E+10 6.86E+09 

Degree of Anisotropy 0.437 0.444 0.0616 0.432 0.427 0.0537 0.433 0.43 0.0585 
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Euler number 4750 4510 1630 6140 6540 1970 5510 5450 1700 

Intersection Surface 6.09E+05 5.67E+05 3.15E+05 6.26E+05 6.03E+05 3.36E+05 6.56E+05 6.32E+05 2.95E+05 

Avg. Pore Major diameter 132 130 12.7 127 125 12.3 129 124 13 

Number Closed Pores 5090 4540 2070 6610 6960 2340 6150 5780 1940 

Number of Pores 5990 5280 2370 7670 8100 2660 7140 6600 2200 

Number Open Pores 906 827 327 1050 1070 344 992 932 283 

Pore surface 1.74E+04 1.65E+04 3.81E+03 1.62E+04 1.51E+04 3.38E+03 1.79E+04 1.74E+04 4.45E+03 

Pore volume 1.08E+05 9.26E+04 4.39E+04 9.36E+04 7.95E+04 3.59E+04 1.13E+05 1.06E+05 5.21E+04 

Open Pore Density 23.8 20.8 9.45 25.9 25.1 7.23 24.1 24.1 6.87 

Open Porosity (%) 0.914 0.745 0.515 0.837 0.703 0.394 0.978 0.906 0.446 

Avg. Pore Orientation phi 190 190 9.33 193 196 9 189 188 7.62 

Avg. Pore Orientation theta 41.2 41.5 4.39 41 40.8 5.21 41.1 40.5 5.06 

Pore Density 157 139 64.7 188 184 53 174 168 51.7 

Pore Fractal 2.12 2.11 0.148 2.18 2.22 0.116 2.19 2.17 0.0941 

Pore Separation 294 289 56.8 272 263 41.1 275 270 40.1 

Pore Surface:Cortical 
Volume 

0.00268 0.00246 0.00106 0.00297 0.00312 0.000743 0.00299 0.00266 0.000804 

Pore Surface:PoreVolume 0.17 0.177 0.0269 0.182 0.189 0.0257 0.169 0.168 0.0279 

Pore Tb.N 0.000497 0.00046 0.00019 0.00059 0.000635 0.000163 0.00056 0.000513 0.000136 

Pore Thickness 32.7 30.7 8.47 29 27 7.28 32.8 32.1 8.5 

Pore Volume 6.45E+08 5.61E+08 3.32E+08 6.88E+08 6.31E+08 2.76E+08 7.72E+08 6.40E+08 3.21E+08 

SD Pore Separation 99.9 100 23.1 102 97.1 22.4 98 93.3 21.9 

SD Pore Thickness 21.3 21.1 6.73 17.4 16.5 6.43 21.1 22.2 7.34 

Sphericity 0.603 0.603 0.00765 0.603 0.601 0.00706 0.602 0.602 0.00494 

Total Porosity (%) 1.64 1.42 0.725 1.66 1.62 0.49 1.83 1.7 0.624 

Tibial Porosity by Region and Drug Treatment Group 

Group Control 
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Region 
Anterior Lateral Medial Posterior 

Statistic Mean Median SD Mean Median SD Mean Median SD Mean Median SD 

Pore Surface 1.20E+08 1.03E+08 5.88E+07 7.74E+07 7.16E+07 2.96E+07 9.92E+07 7.76E+07 4.30E+07 1.19E+08 1.17E+08 3.48E+07 

Closed Pore Density 125 101 71.3 144 126 57.1 155 146 52.8 110 96.7 40.5 

Closed Porosity (%) 0.656 0.54 0.332 0.63 0.575 0.285 0.805 0.67 0.335 0.824 0.795 0.261 

Connectivity 1630 1170 1180 1020 734 837 1150 1210 645 1160 960 725 

Connectivity density 34.3 20 27.6 28.6 20 24.1 34.3 30 23 27.1 20 20.6 

Cortical Fractal 2.36 2.33 0.107 2.36 2.36 0.0887 2.4 2.37 0.0891 2.39 2.39 0.0763 

Cortical Surface 1.09E+08 1.10E+08 6.98E+06 9.52E+07 9.44E+07 4.22E+06 8.99E+07 8.83E+07 3.75E+06 1.03E+08 1.04E+08 7.25E+06 

Cortical Volume 4.63E+10 4.69E+10 4.14E+09 3.44E+10 3.45E+10 2.32E+09 3.34E+10 3.12E+10 4.57E+09 4.14E+10 4.13E+10 4.62E+09 

Degree of 
Anisotropy 

0.451 0.457 0.0432 0.38 0.388 0.0424 0.432 0.444 0.0482 0.485 0.497 0.066 

Euler number 5180 4410 2400 4670 4560 1580 4910 4810 1350 4250 4470 1130 

Intersection Surface 5.24E+05 5.00E+05 1.64E+05 3.30E+05 3.43E+05 5.86E+04 7.49E+05 6.93E+05 2.80E+05 8.31E+05 7.09E+05 3.98E+05 

Avg. Pore Major 
diameter 137 138 11.4 123 123 7.73 123 123 5.13 145 146 9.84 

Number Closed 
Pores 

5780 4540 3120 4930 4550 2000 5100 4560 1530 4540 4290 1510 

Number of Pores 6810 5450 3510 5690 5270 2230 6060 5360 1890 5410 5140 1740 

Number Open Pores 1040 906 402 756 703 248 958 804 384 876 850 244 

Pore surface 1.77E+04 1.81E+04 1.60E+03 1.37E+04 1.38E+04 1.56E+03 1.60E+04 1.47E+04 2.98E+03 2.21E+04 2.26E+04 2.75E+03 

Pore volume 1.05E+05 1.10E+05 1.66E+04 7.03E+04 6.77E+04 1.19E+04 9.29E+04 7.93E+04 2.78E+04 1.66E+05 1.63E+05 4.08E+04 

Open Pore Density 22.5 20.2 9.55 22 21.4 7.26 29.2 26.4 12.9 21.4 19.9 6.85 

Open Porosity (%) 0.892 0.777 0.49 0.519 0.511 0.167 0.931 0.772 0.578 1.31 1.31 0.469 

Avg. Pore 
Orientation phi 197 197 8.95 193 195 8.14 182 186 8.22 189 190 6.47 

Avg. Pore 
Orientation theta 

44 44.1 2.45 45.4 46 2.13 38.9 38.8 3.07 36.5 36.6 2.31 

Pore Density 148 122 80.6 166 146 63.8 184 171 65.1 132 119 47 

Pore Fractal 2.11 2.07 0.175 2.07 2.08 0.157 2.16 2.13 0.145 2.15 2.17 0.127 
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Pore Separation 318 331 68.5 291 282 61.1 272 280 50.6 294 296 48.1 

Pore Surface: 
Cortical Volume 

0.00259 0.00213 0.00132 0.00225 0.00213 0.000842 0.00298 0.00255 0.00124 0.00288 0.00299 0.000856 

Pore Surface: 
PoreVolume 

0.171 0.168 0.0143 0.196 0.203 0.0106 0.177 0.178 0.0216 0.137 0.139 0.018 

Pore Tb.N 0.000488 0.000425 0.000216 0.000448 0.000422 0.000158 0.000561 0.000495 0.000249 0.000492 0.000499 0.000145 

Pore Thickness 30.8 31.2 4.48 25.5 25 1.76 31.2 30.3 7.04 43.4 41 6.98 

Pore Volume 7.17E+08 6.39E+08 3.74E+08 3.94E+08 3.98E+08 1.44E+08 5.83E+08 4.37E+08 3.06E+08 8.87E+08 8.90E+08 2.98E+08 

SD Pore Separation 115 120 23 89.7 87.1 23.8 91.2 98.8 14.3 104 106 24.7 

SD Pore Thickness 19.3 21.1 4.38 15.5 15.4 3.38 21.3 21.7 7.12 28.9 27 3.48 

Sphericity 0.598 0.598 0.00564 0.607 0.609 0.00837 0.603 0.604 0.00913 0.604 0.605 0.00488 

Total Porosity (%) 1.54 1.32 0.789 1.15 1.19 0.409 1.73 1.44 0.792 2.13 2.13 0.605 

Group 
Fentanyl 

Region 
Anterior Lateral Medial Posterior 

Statistic Mean Median SD Mean Median SD Mean Median SD Mean Median SD 

Pore Surface 1.57E+08 1.82E+08 4.49E+07 1.00E+08 1.10E+08 3.89E+07 1.14E+08 1.19E+08 2.67E+07 1.19E+08 1.16E+08 3.95E+07 

Closed Pore 
Density 

158 160 48.5 183 193 60.6 166 160 33.5 139 157 38 

Closed 
Porosity (%) 0.796 0.835 0.227 0.836 0.889 0.329 0.885 0.825 0.164 0.807 0.769 0.186 

Connectivity 2370 2330 1030 1230 1430 611 1280 1190 395 1240 1430 681 

Connectivity 
density 

47.1 40 19.8 34.3 40 16.2 35.7 40 9.76 27.1 30 15 

Cortical 
Fractal 2.42 2.45 0.0636 2.41 2.46 0.0958 2.43 2.44 0.0357 2.39 2.4 0.0665 

Cortical 
Surface 

1.11E+08 1.14E+08 7.79E+06 9.66E+07 9.74E+07 4.63E+06 9.12E+07 9.24E+07 4.87E+06 1.07E+08 1.09E+08 8.56E+06 

Cortical 
Volume 

4.94E+10 5.02E+10 6.32E+09 3.46E+10 3.61E+10 2.81E+09 3.57E+10 3.68E+10 3.77E+09 4.27E+10 4.22E+10 5.82E+09 

Degree of 
Anisotropy 

0.461 0.438 0.0514 0.402 0.403 0.049 0.431 0.417 0.0478 0.436 0.456 0.0601 
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Euler number 6910 7390 2600 6190 6520 2240 5660 5810 1210 5800 6560 1760 

Intersection 
Surface 

8.02E+05 6.83E+05 5.12E+05 3.96E+05 4.43E+05 1.81E+05 6.94E+05 6.43E+05 2.63E+05 6.13E+05 6.20E+05 2.02E+05 

Avg. Pore 
Major 

diameter 
127 129 11.1 121 118 6.6 127 124 13.1 134 132 15.3 

Number 
Closed Pores 

8000 9320 3000 6450 7200 2450 5930 5990 1360 6070 7040 2130 

Number of 
Pores 

9280 10800 3430 7420 8110 2800 6940 6830 1560 7040 8110 2370 

Number Open 
Pores 

1270 1390 437 966 1190 382 1010 997 230 972 1070 258 

Pore surface 1.78E+04 1.60E+04 4.35E+03 1.34E+04 1.36E+04 9.22E+02 1.66E+04 1.47E+04 3.46E+03 1.72E+04 1.65E+04 2.50E+03 

Pore volume 1.13E+05 9.37E+04 5.21E+04 6.52E+04 6.63E+04 6.50E+03 9.13E+04 7.67E+04 2.72E+04 1.04E+05 1.08E+05 2.74E+04 

Open Pore 
Density 

25.3 23.7 6.9 27.6 32.1 10.5 28.1 26.2 5.68 22.5 24.2 4.64 

Open 
Porosity (%) 1.13 0.973 0.516 0.546 0.578 0.154 0.842 0.678 0.32 0.832 0.731 0.329 

Avg. Pore 
Orientation 

phi 
198 200 4.47 194 193 4.62 188 186 9.76 192 198 13 

Avg. Pore 
Orientation 

theta 
43.5 43.9 5.29 44.7 45.8 3.63 39 37.4 4.18 37 37 4.11 

Pore Density 184 183 55.2 211 230 70 194 183 38.2 162 178 42 

Pore Fractal 2.21 2.25 0.0975 2.16 2.23 0.17 2.22 2.24 0.0637 2.15 2.16 0.116 

Pore 
Separation 

283 265 44.5 259 230 58.2 261 260 14.3 285 271 36.8 

Pore Surface: 
Cortical 
Volume 

0.00314 0.00316 0.000684 0.00285 0.00322 0.000994 0.00315 0.00347 0.000567 0.00275 0.00275 0.000748 

Pore Surface: 
PoreVolume 

0.168 0.174 0.028 0.206 0.208 0.0102 0.185 0.192 0.0171 0.17 0.176 0.0261 

Pore Tb.N 0.000607 0.000645 0.000146 0.000609 0.000709 0.000218 0.000628 0.00069 0.000129 0.000515 0.000525 0.00016 

Pore 
Thickness 

32.2 28.8 7.66 22.9 22.2 2.01 27.5 27.4 3.86 33.3 29.8 9.06 
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Pore Volume 9.49E+08 9.39E+08 3.06E+08 4.82E+08 5.44E+08 1.78E+08 6.20E+08 6.14E+08 1.69E+08 7.01E+08 6.60E+08 2.34E+08 

SD Pore 
Separation 

114 102 25 84.4 76 20.8 98.8 94.6 15.7 109 100 18.6 

SD Pore 
Thickness 

19.3 17.3 4.56 11.2 10.1 2.61 17.1 19.7 4.61 21.9 20.5 8 

Sphericity 0.597 0.595 0.00466 0.604 0.599 0.00896 0.603 0.604 0.00419 0.607 0.606 0.00664 

Total Porosity 
(%) 

1.92 1.8 0.582 1.38 1.47 0.453 1.72 1.72 0.372 1.63 1.56 0.471 

Group 
Morphine 

Region 
Anterior Lateral Medial Posterior 

Statistic Mean Median SD Mean Median SD Mean Median SD Mean Median SD 

Pore Surface 1.38E+08 1.33E+08 4.40E+07 1.01E+08 9.73E+07 2.01E+07 1.17E+08 9.48E+07 4.01E+07 1.43E+08 1.54E+08 4.45E+07 

Closed Pore 
Density 

132 122 46.4 183 170 43.9 154 152 33.5 130 116 44.9 

Closed 
Porosity (%) 0.769 0.866 0.238 0.838 0.839 0.178 0.873 0.859 0.174 0.981 1.05 0.29 

Connectivity 2100 2000 930 1310 1270 420 1480 1340 742 1620 1310 732 

Connectivity 
density 

41.4 40 16.8 35.7 40 14 41.4 30 18.6 37.1 30 17 

Cortical 
Fractal 

2.38 2.35 0.0638 2.42 2.41 0.0425 2.43 2.42 0.0645 2.42 2.4 0.072 

Cortical 
Surface 

1.12E+08 1.13E+08 6.04E+06 9.86E+07 1.00E+08 4.32E+06 9.30E+07 9.35E+07 3.43E+06 1.08E+08 1.07E+08 6.04E+06 

Cortical 
Volume 

5.05E+10 5.11E+10 3.60E+09 3.57E+10 3.52E+10 1.63E+09 3.63E+10 3.61E+10 2.32E+09 4.42E+10 4.46E+10 4.19E+09 
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Degree of 
Anisotropy 

0.453 0.438 0.0619 0.393 0.382 0.0401 0.427 0.434 0.0583 0.459 0.447 0.0582 

Euler number 5630 5730 2270 6150 6220 1550 5080 4750 1170 5200 4590 1790 

Intersection 
Surface 

5.24E+05 4.16E+05 1.89E+05 4.56E+05 4.24E+05 1.45E+05 7.43E+05 6.99E+05 3.79E+05 9.01E+05 9.14E+05 2.16E+05 

Avg. Pore 
Major 

diameter 
130 127 13.3 118 118 3.7 127 120 9.35 141 140 13.3 

Number 
Closed Pores 

6690 6000 2620 6520 6490 1570 5600 4960 1430 5780 4730 2120 

Number of 
Pores 

7720 6920 2940 7450 7470 1840 6560 5870 1710 6820 5670 2390 

Number 
Open Pores 

1030 922 335 929 980 273 965 912 292 1040 941 281 

Pore surface 1.85E+04 1.74E+04 3.93E+03 1.38E+04 1.30E+04 1.66E+03 1.77E+04 1.74E+04 2.35E+03 2.17E+04 2.01E+04 5.35E+03 

Pore volume 1.19E+05 1.11E+05 4.43E+04 7.17E+04 6.56E+04 1.90E+04 1.07E+05 9.80E+04 2.20E+04 1.56E+05 1.19E+05 7.19E+04 

Open Pore 
Density 

20.3 18.8 5.94 26 25.7 7.55 26.5 26 7.21 23.7 23 6.29 

Open 
Porosity (%) 

0.944 0.96 0.325 0.622 0.654 0.168 1.07 0.962 0.498 1.27 1.26 0.503 

Avg. Pore 
Orientation 

phi 
194 193 5 190 193 10.8 183 183 4.63 189 187 4.87 

Avg. Pore 
Orientation 

theta 
42.9 42.2 4.1 45.4 44.7 4.34 39.5 39.9 4.17 36.4 35.9 2.76 

Pore Density 152 141 52.2 209 195 51.3 180 177 40.5 154 139 50.8 

Pore Fractal 2.15 2.1 0.104 2.18 2.17 0.0716 2.21 2.19 0.0996 2.2 2.2 0.107 

Pore 
Separation 

309 330 35.1 253 264 26.2 259 268 30.7 278 296 46.5 

Pore Surface: 
Cortical 
Volume 

0.00271 0.00256 0.000743 0.00283 0.00268 0.000577 0.00321 0.00296 0.000977 0.00322 0.00316 0.000914 

Pore Surface: 
PoreVolume 

0.163 0.158 0.0249 0.196 0.199 0.0204 0.168 0.167 0.0162 0.15 0.16 0.0296 

Pore Tb.N 0.000507 0.000481 0.000117 0.000569 0.000565 0.000125 0.000592 0.000534 0.000178 0.000571 0.000549 0.000134 
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Pore 
Thickness 

33.5 33.8 6.29 26 24.9 5.88 32.6 32.6 5.47 39.2 35.6 10.9 

Pore Volume 8.67E+08 8.03E+08 3.00E+08 5.18E+08 5.78E+08 1.02E+08 7.07E+08 6.21E+08 2.62E+08 9.98E+08 1.09E+09 3.78E+08 

SD Pore 
Separation 

122 118 10 79.6 75.7 12.7 86.1 89.9 9.89 105 102 22.8 

SD Pore 
Thickness 

21 22.3 5.23 15.4 15 6.48 22.4 23.5 6.2 25.7 24.6 8.39 

Sphericity 0.597 0.597 0.00422 0.604 0.604 0.00493 0.603 0.604 0.00389 0.603 0.603 0.00395 

Total 
Porosity (%) 1.71 1.67 0.515 1.45 1.67 0.307 1.94 1.74 0.651 2.24 2.27 0.76 
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Appendix XXI: Micro-CT Linear Mixed Model for Aggregate Porosity 

Aggregate Porosity: LMM Fixed Effects and Random Effects 

Cortical 
Fractal 

Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.156 -0.324 0.308 0 1 0.994 

Bone1 -0.173 0.156 -0.499 0.148 -1.1 0.277 0.278 

Group1 -0.018 0.221 -0.475 0.402 -0.0812 0.936 0.933 

Group2 0.0871 0.221 -0.362 0.535 0.394 0.696 0.691 

Bone1:Group1 0.348 0.221 -0.0767 0.815 1.57 0.125 0.118 

Bone1:Group2 -0.126 0.221 -0.533 0.311 -0.57 0.572 0.571 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0 0 0 0.854 0 1 R2M/R2C 
0.0874 / 
0.0874 

Residual 1.03 1.01 0.639 1.19 100 NA AIC/BIC 139 / 153 
Number 

Closed Pores 
Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.158 -0.32 0.305 0 1 1 

Bone1 -0.368 0.134 -0.662 -0.0967 -2.75 0.0133 * 0.0144 * 

Group1 -0.279 0.224 -0.7 0.197 -1.25 0.229 0.238 

Group2 0.269 0.224 -0.206 0.684 1.2 0.245 0.251 

Bone1:Group1 0.192 0.189 -0.198 0.597 1.01 0.324 0.334 

Bone1:Group2 -0.0925 0.189 -0.437 0.329 -0.489 0.631 0.625 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) 

p-value Sig. 
Model 
Test 

Model Fit 

Sample 0.149 0.386 0 0.849 16.5 0.48 R2M/R2C 0.188 / 0.322 

Residual 0.752 0.867 0.54 1.07 83.5 NA AIC/BIC 134 / 148 
Number Open 

Pores 
Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.179 -0.358 0.365 0 1 0.961 

Bone1 0.127 0.139 -0.148 0.397 0.918 0.371 0.361 

Group1 -0.168 0.253 -0.63 0.354 -0.661 0.517 0.536 

Group2 0.191 0.253 -0.272 0.695 0.755 0.46 0.479 

Bone1:Group1 0.132 0.196 -0.238 0.543 0.676 0.508 0.525 

Bone1:Group2 -0.166 0.196 -0.552 0.207 -0.85 0.407 0.415 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.271 0.52 0 0.988 25.1 0.279 R2M/R2C 
0.0483 / 

0.288 

Residual 0.806 0.898 0.592 1.1 74.9 AIC/BIC 140 / 154 
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Closed Pore 
Density 

Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.149 -0.29 0.271 0 1 0.972 

Bone1 -0.364 0.149 -0.646 -0.0561 -2.45 0.0193 * 0.0196 * 

Group1 -0.213 0.21 -0.593 0.207 -1.01 0.318 0.339 

Group2 0.25 0.21 -0.161 0.668 1.19 0.242 0.282 

Bone1:Group1 0.146 0.21 -0.305 0.577 0.694 0.492 0.476 

Bone1:Group2 -0.0887 0.21 -0.512 0.331 -0.422 0.676 0.658 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0 0 0 0.786 0 1 R2M/R2C 0.166 / 0.166 

Residual 0.929 0.964 0.634 1.14 100 AIC/BIC 136 / 150 
Open Pore 

Density 
Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.176 -0.322 0.364 0 1 0.984 

Bone1 0.203 0.14 -0.103 0.483 1.45 0.164 0.161 

Group1 -0.045 0.249 -0.52 0.426 -0.181 0.858 0.867 

Group2 0.142 0.249 -0.369 0.651 0.573 0.574 0.573 

Bone1:Group1 0.0723 0.198 -0.303 0.483 0.365 0.719 0.712 

Bone1:Group2 -0.174 0.198 -0.547 0.241 -0.876 0.393 0.397 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) 

p-value Sig. 
Model 
Test 

Model Fit 

Sample 0.237 0.486 0 1.03 22.3 0.338 R2M/R2C 0.0609 / 0.27 

Residual 0.824 0.908 0.588 1.1 77.7 AIC/BIC 140 / 153 
Closed 

Porosity (%) Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.139 -0.288 0.29 0 1 0.992 

Bone1 -0.548 0.127 -0.768 -0.309 -4.3 
0.00043 

2 
*** 0.000175 *** 

Group1 -0.195 0.196 -0.571 0.179 -0.996 0.333 0.355 

Group2 0.0737 0.196 -0.318 0.465 0.376 0.712 0.745 

Bone1:Group1 0.166 0.18 -0.193 0.52 0.923 0.368 0.35 

Bone1:Group2 0.00464 0.18 -0.346 0.347 0.0258 0.98 0.995 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) 

p-value Sig. 
Model 
Test 

Model Fit 

Sample 0.0633 0.252 0 0.734 8.51 0.718 R2M/R2C 0.318 / 0.376 

Residual 0.681 0.825 0.53 1.01 91.5 AIC/BIC 128 / 142 
Open Porosity 

(%) Lambda = -0.25 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.146 -0.266 0.289 0 1 0.994 
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Bone1 0.463 0.11 0.23 0.678 4.21 
0.00052 

6 
*** 0.000175 *** 

Group1 0.373 0.206 -0.00582 0.77 1.81 0.0871 . 0.101 

Group2 -0.271 0.206 -0.686 0.154 -1.31 0.206 0.204 

Bone1:Group1 0.413 0.156 0.118 0.729 2.65 0.0162 * 0.0116 * 

Bone1:Group2 -0.176 0.156 -0.494 0.108 -1.13 0.273 0.273 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) 

p-value Sig. 
Model 
Test 

Model Fit 

Sample 0.193 0.439 0 0.817 27.5 0.234 R2M/R2C 0.354 / 0.532 

Residual 0.508 0.713 0.47 0.891 72.5 AIC/BIC 122 / 136 
Total Porosity 

(%) Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.142 -0.266 0.299 0 1 1 

Bone1 0.263 0.138 0.000684 0.579 1.91 0.0725 . 0.0582 . 

Group1 0.375 0.201 -0.0527 0.776 1.86 0.0788 . 0.0947 . 

Group2 -0.326 0.201 -0.682 0.0549 -1.62 0.122 0.132 

Bone1:Group1 0.486 0.195 0.103 0.842 2.5 0.0225 * 0.0158 * 

Bone1:Group2 -0.256 0.195 -0.618 0.123 -1.32 0.205 0.196 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.0262 0.162 0 0.736 3.18 0.892 R2M/R2C 0.252 / 0.276 

Residual 0.797 0.893 0.58 1.05 96.8 AIC/BIC 131 / 145 
Cortical 
Volume 

Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.203 -0.41 0.411 0 1 0.983 

Bone1 -0.166 0.0878 -0.331 0.0221 -1.89 0.0745 . 0.0737 . 

Group1 -0.276 0.287 -0.855 0.289 -0.961 0.349 0.358 

Group2 0.0892 0.287 -0.495 0.722 0.31 0.76 0.786 

Bone1:Group1 0.188 0.124 -0.064 0.43 1.51 0.148 0.16 

Bone1:Group2 0.0217 0.124 -0.197 0.259 0.175 0.863 0.875 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) 

p-value Sig. 
Model 
Test 

Model Fit 

Sample 0.706 0.84 0.523 1.27 68.6 
0.00072 

1 
*** R2M/R2C 

0.0855 / 
0.713 

Residual 0.324 0.569 0.359 0.699 31.4 AIC/BIC 128 / 142 

Pore Volume Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.151 -0.291 0.293 0 1 0.993 

Bone1 0.215 0.14 -0.0651 0.492 1.54 0.141 0.122 

Group1 0.28 0.213 -0.146 0.719 1.31 0.206 0.227 

Group2 -0.287 0.213 -0.724 0.164 -1.35 0.195 0.219 

Bone1:Group1 0.478 0.198 0.0587 0.844 2.42 0.0265 * 0.013 * 
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Bone1:Group2 -0.239 0.198 -0.618 0.129 -1.21 0.242 0.216 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) 

p-value Sig. 
Model 
Test 

Model Fit 

Sample 0.0675 0.26 0 0.767 7.59 0.747 R2M/R2C 0.198 / 0.259 

Residual 0.822 0.906 0.594 1.08 92.4 AIC/BIC 134 / 148 

Total Porosity Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.142 -0.276 0.287 0 1 0.988 

Bone1 0.263 0.138 -0.0174 0.523 1.91 0.0728 . 0.0537 . 

Group1 0.375 0.201 -0.027 0.789 1.86 0.0789 . 0.107 

Group2 -0.326 0.201 -0.781 0.0817 -1.62 0.122 0.149 

Bone1:Group1 0.486 0.195 0.101 0.883 2.5 0.0225 * 0.0109 * 

Bone1:Group2 -0.256 0.195 -0.63 0.105 -1.31 0.205 0.182 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.0262 0.162 0 0.768 3.18 0.892 R2M/R2C 0.252 / 0.275 

Residual 0.797 0.893 0.565 1.06 96.8 AIC/BIC 131 / 145 
Cortical 
Surface 

Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.186 -0.4 0.34 0 1 0.994 

Bone1 -0.214 0.119 -0.446 0.00228 -1.79 0.09 . 0.093 . 

Group1 -0.183 0.263 -0.712 0.351 -0.693 0.497 0.511 

Group2 -0.0489 0.263 -0.55 0.517 -0.186 0.855 0.847 

Bone1:Group1 0.193 0.169 -0.179 0.515 1.14 0.268 0.294 

Bone1:Group2 -0.0423 0.169 -0.342 0.338 -0.251 0.805 0.825 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.429 0.655 0.283 1.12 41.8 0.0629 . R2M/R2C 0.0874 / 
0.469 

Residual 0.597 0.773 0.5 0.957 58.2 AIC/BIC 136 / 150 

Pore Surface Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.165 -0.327 0.348 0 1 1 

Bone1 -0.0801 0.15 -0.415 0.224 -0.536 0.599 0.579 

Group1 -0.00255 0.234 -0.447 0.446 -0.0109 0.991 0.984 

Group2 -0.00515 0.234 -0.478 0.402 -0.022 0.983 0.98 

Bone1:Group1 0.387 0.212 0.0225 0.822 1.83 0.0836 . 0.067 . 

Bone1:Group2 -0.167 0.212 -0.618 0.246 -0.79 0.44 0.431 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.104 0.322 0 0.882 9.94 0.672 R2M/R2C 
0.0745 / 

0.167 

Residual 0.939 0.969 0.609 1.15 90.1 AIC/BIC 140 / 154 
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Intersection 
Surface 

Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.131 -0.256 0.265 0 1 0.985 

Bone1 0.563 0.116 0.314 0.791 4.84 
0.00013 

1 
*** 0.000351 *** 

Group1 0.316 0.185 -0.0527 0.683 1.71 0.104 0.113 

Group2 -0.176 0.185 -0.566 0.16 -0.956 0.352 0.366 

Bone1:Group1 0.33 0.165 0.0377 0.659 2.01 0.06 . 0.0547 . 

Bone1:Group2 -0.239 0.165 -0.554 0.0605 -1.45 0.163 0.156 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.0734 0.271 0 0.699 11.4 0.627 R2M/R2C 0.404 / 0.472 

Residual 0.569 0.754 0.463 0.915 88.6 AIC/BIC 122 / 136 
Pore Surface: 
PoreVolume 

Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.131 -0.257 0.252 0 1 0.997 

Bone1 -0.508 0.105 -0.721 -0.309 -4.83 
0.00013 

4 
*** 0.000175 *** 

Group1 -0.496 0.185 -0.884 -0.117 -2.68 0.0153 * 0.0172 * 

Group2 0.499 0.185 0.124 0.846 2.69 0.0148 * 0.0204 * 

Bone1:Group1 -0.298 0.149 -0.605 0.006 -2 0.0607 . 0.0561 . 

Bone1:Group2 0.151 0.149 -0.145 0.469 1.01 0.325 0.321 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.128 0.358 0 0.767 21.6 0.354 R2M/R2C 0.447 / 0.566 

Residual 0.465 0.682 0.435 0.831 78.4 AIC/BIC 119 / 133 
Pore Surface: 

Cortical 
Volume 

Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.158 -0.283 0.321 0 1 0.976 

Bone1 -0.0428 0.158 -0.35 0.254 -0.271 0.788 0.775 

Group1 0.104 0.224 -0.343 0.465 0.467 0.643 0.667 

Group2 -0.0466 0.224 -0.475 0.418 -0.208 0.836 0.852 

Bone1:Group1 0.372 0.224 -0.0977 0.825 1.66 0.105 0.0902 . 

Bone1:Group2 -0.174 0.224 -0.639 0.26 -0.777 0.442 0.432 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0 0 0 0.821 0 1 R2M/R2C 
0.0694 / 
0.0694 

Residual 1.05 1.02 0.647 1.22 100 AIC/BIC 140 / 154 
Pore 

Thickness 
Lambda = -1 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 
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Intercept 0 0.121 -0.213 0.251 0 1 0.978 

Bone1 0.543 0.116 0.329 0.78 4.69 
0.00018 

3 
*** 0.000175 *** 

Group1 0.474 0.172 0.161 0.822 2.76 0.0128 * 0.0175 * 

Group2 -0.487 0.172 -0.819 -0.15 -2.84 0.0109 * 0.0175 * 

Bone1:Group1 0.201 0.164 -0.0891 0.511 1.23 0.236 0.219 

Bone1:Group2 -0.104 0.164 -0.447 0.215 -0.632 0.535 0.524 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.027 0.164 0 0.633 4.57 0.846 R2M/R2C 0.449 / 0.474 

Residual 0.564 0.751 0.493 0.895 95.4 AIC/BIC 120 / 134 
Pore 

Separation 
Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.152 -0.327 0.266 0 1 0.98 

Bone1 0.299 0.152 0.00573 0.588 1.97 0.0571 . 0.0509 . 

Group1 -0.00874 0.215 -0.45 0.439 -0.0405 0.968 0.975 

Group2 -0.0987 0.215 -0.523 0.337 -0.458 0.65 0.668 

Bone1:Group1 -0.287 0.215 -0.735 0.108 -1.33 0.191 0.176 

Bone1:Group2 0.0789 0.215 -0.333 0.519 0.366 0.716 0.708 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0 0 0 0.787 0 1 R2M/R2C 0.129 / 0.129 

Residual 0.975 0.987 0.607 1.15 100 AIC/BIC 137 / 151 

Pore Tb.N Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.154 -0.311 0.287 0 1 0.976 

Bone1 -0.277 0.154 -0.565 -0.0123 -1.81 0.0793 . 0.0793 . 

Group1 -0.124 0.217 -0.56 0.348 -0.57 0.572 0.588 

Group2 0.17 0.217 -0.308 0.611 0.783 0.439 0.473 

Bone1:Group1 0.264 0.217 -0.131 0.675 1.22 0.232 0.22 

Bone1:Group2 -0.131 0.217 -0.564 0.291 -0.603 0.55 0.532 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0 0 0 0.769 0 1 R2M/R2C 0.116 / 0.116 

Residual 0.99 0.995 0.635 1.16 100 AIC/BIC 138 / 152 
Degree of 

Anisotropy 
Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.158 -0.308 0.353 0 1 0.986 

Bone1 -0.314 0.144 -0.653 -0.03 -2.17 0.0433 * 0.0344 * 

Group1 0.0555 0.223 -0.418 0.487 0.249 0.806 0.826 

Group2 -0.152 0.223 -0.525 0.294 -0.68 0.505 0.541 

Bone1:Group1 0.101 0.204 -0.322 0.542 0.494 0.627 0.622 
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Bone1:Group2 -0.29 0.204 -0.694 0.11 -1.42 0.173 0.153 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) 

p-value Sig. 
Model 
Test 

Model Fit 

Sample 0.0834 0.289 0 0.831 8.7 0.712 R2M/R2C 0.141 / 0.216 

Residual 0.876 0.936 0.561 1.12 91.3 AIC/BIC 137 / 151 

Pore Fractal Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.158 -0.314 0.302 0 1 0.979 

Bone1 -0.0984 0.158 -0.401 0.187 -0.624 0.537 0.522 

Group1 -0.0387 0.223 -0.453 0.382 -0.173 0.863 0.876 

Group2 0.0842 0.223 -0.344 0.517 0.378 0.708 0.716 

Bone1:Group1 0.362 0.223 -0.0449 0.793 1.62 0.113 0.101 

Bone1:Group2 -0.117 0.223 -0.56 0.371 -0.525 0.603 0.59 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0 0 0 0.823 0 1 R2M/R2C 
0.0739 / 
0.0739 

Residual 1.04 1.02 0.67 1.22 100 AIC/BIC 140 / 154 
Number of 

Pores 
Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.161 -0.304 0.325 0 1 0.994 

Bone1 -0.334 0.135 -0.607 -0.0645 -2.47 0.0237 * 0.0196 * 

Group1 -0.274 0.228 -0.771 0.211 -1.2 0.245 0.261 

Group2 0.267 0.228 -0.181 0.715 1.17 0.258 0.271 

Bone1:Group1 0.19 0.191 -0.181 0.592 0.995 0.333 0.324 

Bone1:Group2 -0.0998 0.191 -0.467 0.287 -0.522 0.608 0.599 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) 

p-value Sig. 
Model 
Test 

Model Fit 

Sample 0.162 0.403 0 0.88 17.4 0.456 R2M/R2C 0.164 / 0.31 

Residual 0.768 0.876 0.548 1.11 82.6 AIC/BIC 135 / 149 

Pore Density Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.152 -0.332 0.285 0 1 0.995 

Bone1 -0.326 0.15 -0.636 -0.0175 -2.17 0.0439 * 0.0323 * 

Group1 -0.204 0.215 -0.645 0.18 -0.946 0.357 0.383 

Group2 0.247 0.215 -0.187 0.687 1.14 0.267 0.32 

Bone1:Group1 0.143 0.213 -0.306 0.566 0.673 0.51 0.489 

Bone1:Group2 -0.0975 0.213 -0.481 0.299 -0.459 0.652 0.651 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.0124 0.111 0 0.78 1.29 0.956 R2M/R2C 0.139 / 0.15 

Residual 0.95 0.974 0.658 1.18 98.7 AIC/BIC 137 / 151 

Euler number Lambda = None 
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Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.16 -0.333 0.308 0 1 0.991 

Bone1 -0.352 0.132 -0.603 -0.0993 -2.67 0.0158 * 0.0119 * 

Group1 -0.32 0.227 -0.793 0.0853 -1.41 0.174 0.173 

Group2 0.309 0.227 -0.132 0.75 1.36 0.19 0.193 

Bone1:Group1 0.124 0.187 -0.251 0.497 0.666 0.514 0.5 

Bone1:Group2 -0.114 0.187 -0.504 0.271 -0.608 0.551 0.526 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) 

p-value Sig. 
Model 
Test 

Model Fit 

Sample 0.173 0.416 0 0.926 19.1 0.414 R2M/R2C 0.184 / 0.34 

Residual 0.733 0.856 0.553 1.06 80.9 AIC/BIC 134 / 148 

Connectivity Lambda = 0.375 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.158 -0.331 0.31 0 1 0.996 

Bone1 -0.183 0.158 -0.522 0.142 -1.16 0.253 0.233 

Group1 -0.105 0.223 -0.62 0.316 -0.468 0.642 0.66 

Group2 0.073 0.223 -0.39 0.462 0.327 0.746 0.753 

Bone1:Group1 0.255 0.223 -0.203 0.652 1.14 0.261 0.232 

Bone1:Group2 -0.035 0.223 -0.418 0.388 -0.156 0.877 0.863 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0 0 0 0.806 0 1 R2M/R2C 
0.0706 / 
0.0706 

Residual 1.05 1.02 0.625 1.25 100 AIC/BIC 140 / 154 
Connectivity 

density 
Lambda = 0.425 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.159 -0.321 0.363 0 1 0.992 

Bone1 -0.209 0.159 -0.53 0.0902 -1.32 0.195 0.175 

Group1 -0.104 0.224 -0.534 0.308 -0.464 0.645 0.662 

Group2 0.0573 0.224 -0.356 0.54 0.256 0.8 0.806 

Bone1:Group1 0.192 0.224 -0.237 0.627 0.857 0.397 0.398 

Bone1:Group2 -0.0204 0.224 -0.417 0.445 -0.0912 0.928 0.932 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) 

p-value Sig. 
Model 
Test 

Model Fit 

Sample 0 0 0 0.786 0 1 R2M/R2C 
0.0649 / 
0.0649 

Residual 1.06 1.03 0.656 1.24 100 AIC/BIC 141 / 155 
SD Pore 

Thickness 
Lambda = -0.375 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.124 -0.253 0.203 0 1 0.978 

Bone1 0.549 0.124 0.299 0.803 4.44 
0.00008 

1 
*** 0.000175 *** 

Group1 0.431 0.175 0.0797 0.774 2.46 0.0186 * 0.0291 * 
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Group2 -0.424 0.175 -0.77 -0.104 -2.42 0.0205 * 0.0305 * 

Bone1:Group1 0.0714 0.175 -0.273 0.38 0.408 0.686 0.68 

Bone1:Group2 -0.0102 0.175 -0.339 0.335 -0.0581 0.954 0.961 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0 0 0 0.626 0 1 R2M/R2C 0.405 / 0.405 

Residual 0.642 0.801 0.526 0.942 100 AIC/BIC 126 / 140 
SD Pore 

Separation 
Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.146 -0.277 0.264 0 1 0.996 

Bone1 0.441 0.146 0.154 0.731 3.02 0.00468 ** 0.00456 ** 

Group1 -0.0904 0.207 -0.518 0.343 -0.437 0.664 0.689 

Group2 0.000108 0.207 -0.405 0.438 
0.00052 

3 
1 0.994 

Bone1:Group1 -0.0694 0.207 -0.475 0.365 -0.336 0.739 0.736 

Bone1:Group2 -0.0456 0.207 -0.463 0.362 -0.221 0.827 0.827 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0 0 0 0.739 0 1 R2M/R2C 0.191 / 0.191 

Residual 0.898 0.948 0.61 1.11 100 AIC/BIC 135 / 148 

Avg.Por.Vol Lambda = -1.075 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.146 -0.272 0.263 0 1 0.96 

Bone1 0.468 0.1 0.279 0.661 4.66 
0.00019 

3 
*** 0.000175 *** 

Group1 0.49 0.206 0.0767 0.905 2.38 0.0285 * 0.0333 * 

Group2 -0.459 0.206 -0.895 -0.0589 -2.23 0.039 * 0.0344 * 

Bone1:Group1 0.277 0.142 -0.0114 0.549 1.95 0.0665 . 0.0691 . 

Bone1:Group2 -0.0528 0.142 -0.331 0.266 -0.372 0.714 0.734 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.234 0.484 0.18 0.861 35.6 0.118 R2M/R2C 0.392 / 0.608 

Residual 0.423 0.65 0.421 0.799 64.4 AIC/BIC 122 / 135 

Avg.Por.Surf Lambda = -2.1 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.158 -0.313 0.306 0 1 0.995 

Bone1 0.394 0.103 0.187 0.58 3.81 0.00129 ** 0.000702 *** 

Group1 0.457 0.224 -0.00106 0.855 2.04 0.0558 . 0.0635 . 

Group2 -0.38 0.224 -0.767 0.11 -1.7 0.107 0.112 

Bone1:Group1 0.29 0.146 -0.0111 0.568 1.98 0.0631 . 0.0618 . 

Bone1:Group2 0.0131 0.146 -0.268 0.288 0.0898 0.929 0.93 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) 

p-value Sig. 
Model 
Test 

Model Fit 
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Sample 0.3 0.548 0.18 0.943 40 0.0763 . R2M/R2C 0.313 / 0.588 

Residual 0.45 0.671 0.434 0.828 60 AIC/BIC 125 / 139 
Avg. Pore 

Orientation 
Theta 

Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.156 -0.312 0.287 0 1 0.995 

Bone1 -0.309 0.156 -0.632 -0.012 -1.98 0.0549 . 0.0516 . 

Group1 -0.0444 0.22 -0.489 0.357 -0.202 0.841 0.837 

Group2 0.0974 0.22 -0.335 0.515 0.443 0.661 0.663 

Bone1:Group1 -0.0398 0.22 -0.478 0.365 -0.181 0.858 0.866 

Bone1:Group2 0.0998 0.22 -0.345 0.516 0.454 0.653 0.68 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) 

p-value Sig. 
Model 
Test 

Model Fit 

Sample 0 0 0 0.801 0 1 R2M/R2C 0.0958 / 
0.0958 

Residual 1.02 1.01 0.647 1.2 100 AIC/BIC 139 / 153 
Avg. Pore 

Orientation 
Phi 

Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.0758 -0.143 0.156 0 1 0.977 

Bone1 -0.852 0.0758 -1.01 -0.694 -11.2 0 *** 0.000175 *** 

Group1 0.0364 0.107 -0.16 0.226 0.34 0.736 0.764 

Group2 -0.0989 0.107 -0.316 0.125 -0.922 0.363 0.403 

Bone1:Group1 0.0731 0.107 -0.142 0.266 0.682 0.5 0.504 

Bone1:Group2 -0.27 0.107 -0.498 -0.0598 -2.51 0.0166 * 0.0144 * 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) 

p-value Sig. 
Model 
Test 

Model Fit 

Sample 0 0 0 0.412 0 1 R2M/R2C 0.765 / 0.765 

Residual 0.242 0.491 0.317 0.578 100 AIC/BIC 87.2 / 101 

Avg.Por.Th Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.143 -0.269 0.311 0 1 0.992 

Bone1 0.447 0.143 0.182 0.758 3.14 0.00341 ** 0.00316 ** 

Group1 0.196 0.202 -0.203 0.606 0.973 0.337 0.374 

Group2 -0.213 0.202 -0.593 0.197 -1.06 0.298 0.341 

Bone1:Group1 0.0566 0.202 -0.314 0.48 0.281 0.781 0.777 

Bone1:Group2 -0.176 0.202 -0.571 0.207 -0.875 0.388 0.375 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0 0 0 0.728 0 1 R2M/R2C 0.227 / 0.227 

Residual 0.854 0.924 0.596 1.15 100 AIC/BIC 133 / 147 
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Avg. Pore 
Major 

Diameter 
Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.161 -0.308 0.305 0 1 0.965 

Bone1 0.0234 0.161 -0.328 0.348 0.145 0.886 0.89 

Group1 0.265 0.228 -0.183 0.728 1.16 0.253 0.265 

Group2 -0.184 0.228 -0.587 0.292 -0.806 0.425 0.459 

Bone1:Group1 -0.0144 0.228 -0.511 0.417 -0.0631 0.95 0.94 

Bone1:Group2 0.0455 0.228 -0.435 0.508 0.2 0.843 0.833 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0 0 0 0.847 0 1 R2M/R2C 0.0348 / 
0.0348 

Residual 1.09 1.05 0.645 1.23 100 AIC/BIC 142 / 156 

Sphericity Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.157 -0.289 0.335 0 1 0.995 

Bone1 0.244 0.157 -0.0536 0.554 1.56 0.128 0.112 

Group1 -0.0525 0.222 -0.481 0.425 -0.237 0.814 0.845 

Group2 -0.0589 0.222 -0.508 0.363 -0.265 0.792 0.792 

Bone1:Group1 -0.101 0.222 -0.54 0.377 -0.455 0.652 0.646 

Bone1:Group2 -0.117 0.222 -0.546 0.344 -0.527 0.602 0.567 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0 0 0 0.784 0 1 R2M/R2C 
0.0815 / 
0.0815 

Residual 1.03 1.02 0.646 1.2 100 AIC/BIC 140 / 154 

TA Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.195 -0.391 0.384 0 1 0.994 

Bone1 0.0793 0.111 -0.142 0.338 0.714 0.484 0.484 

Group1 -0.235 0.275 -0.796 0.325 -0.855 0.404 0.395 

Group2 -0.0372 0.275 -0.641 0.481 -0.135 0.894 0.888 

Bone1:Group1 0.195 0.157 -0.116 0.509 1.24 0.231 0.248 

Bone1:Group2 -0.0252 0.157 -0.313 0.289 -0.161 0.874 0.89 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.536 0.732 0.389 1.18 50.9 0.0202 * R2M/R2C 0.0657 / 
0.541 

Residual 0.518 0.72 0.457 0.879 49.1 AIC/BIC 135 / 149 

CA Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.203 -0.414 0.408 0 1 0.991 
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Bone1 -0.169 0.0882 -0.329 0.00436 -1.92 0.0714 . 0.0744 . 

Group1 -0.274 0.287 -0.82 0.321 -0.953 0.353 0.349 

Group2 0.09 0.287 -0.513 0.669 0.313 0.758 0.746 

Bone1:Group1 0.186 0.125 -0.0515 0.418 1.49 0.154 0.154 

Bone1:Group2 0.0202 0.125 -0.228 0.279 0.162 0.873 0.86 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.703 0.839 0.488 1.26 68.3 
0.00077 

8 
*** R2M/R2C 0.0849 / 0.71 

Residual 0.327 0.572 0.365 0.709 31.7 AIC/BIC 128 / 142 

RCV Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.184 -0.35 0.439 0 1 0.994 

Bone1 -0.336 0.116 -0.593 -0.11 -2.91 0.00931 ** 0.0109 * 

Group1 -0.0851 0.26 -0.582 0.429 -0.327 0.747 0.769 

Group2 0.148 0.26 -0.374 0.629 0.569 0.576 0.596 

Bone1:Group1 0.00198 0.163 -0.326 0.324 0.0121 0.99 0.989 

Bone1:Group2 0.0694 0.163 -0.271 0.373 0.425 0.676 0.666 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.43 0.655 0.234 1.07 43.4 0.0527 . R2M/R2C 0.117 / 0.5 

Residual 0.561 0.749 0.473 0.947 56.6 AIC/BIC 134 / 148 

TA.Surf Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.179 -0.373 0.387 0 1 0.991 

Bone1 -0.401 0.102 -0.615 -0.196 -3.91 0.00101 ** 0.00175 ** 

Group1 -0.191 0.254 -0.713 0.296 -0.753 0.461 0.454 

Group2 -0.0206 0.254 -0.538 0.474 -0.0813 0.936 0.929 

Bone1:Group1 0.192 0.145 -0.0993 0.47 1.32 0.202 0.212 

Bone1:Group2 -0.0446 0.145 -0.317 0.236 -0.308 0.762 0.766 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.456 0.676 0.406 1.1 50.9 0.0201 * R2M/R2C 0.192 / 0.603 

Residual 0.44 0.663 0.43 0.814 49.1 AIC/BIC 129 / 143 

Perif.TA.Surf Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.179 -0.325 0.301 0 1 0.985 

Bone1 -0.261 0.125 -0.532 0.00629 -2.08 0.0516 . 0.0582 . 

Group1 -0.199 0.253 -0.654 0.269 -0.788 0.441 0.449 

Group2 -0.0237 0.253 -0.514 0.435 -0.0938 0.926 0.927 

Bone1:Group1 0.182 0.177 -0.2 0.506 1.03 0.317 0.317 

Bone1:Group2 -0.00772 0.177 -0.361 0.368 -0.0436 0.966 0.979 
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Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.342 0.585 0.155 1.06 34.2 0.135 R2M/R2C 0.109 / 0.414 

Residual 0.658 0.811 0.52 1.01 65.8 AIC/BIC 136 / 150 

CA.Surf Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.18 -0.388 0.375 0 1 0.988 

Bone1 -0.325 0.117 -0.557 -0.0797 -2.78 0.0124 * 0.013 * 

Group1 -0.168 0.254 -0.632 0.343 -0.663 0.516 0.528 

Group2 -0.0504 0.254 -0.549 0.435 -0.199 0.845 0.813 

Bone1:Group1 0.183 0.165 -0.11 0.511 1.11 0.284 0.3 

Bone1:Group2 -0.0449 0.165 -0.336 0.314 -0.271 0.789 0.781 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) 

p-value Sig. 
Model 
Test 

Model Fit 

Sample 0.389 0.624 0.298 1.06 40.4 0.0734 . R2M/R2C 0.137 / 0.486 

Residual 0.575 0.758 0.489 0.941 59.6 AIC/BIC 134 / 148 

Perif.CA.Surf Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.185 -0.361 0.356 0 1 0.985 

Bone1 -0.0898 0.132 -0.355 0.164 -0.682 0.504 0.501 

Group1 -0.139 0.261 -0.65 0.371 -0.534 0.6 0.589 

Group2 -0.0842 0.261 -0.584 0.434 -0.323 0.751 0.739 

Bone1:Group1 0.175 0.186 -0.186 0.588 0.94 0.36 0.371 

Bone1:Group2 -0.0356 0.186 -0.409 0.303 -0.191 0.85 0.839 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.352 0.594 0.0841 1.05 32.6 0.155 R2M/R2C 
0.0459 / 

0.357 

Residual 0.727 0.853 0.528 1.06 67.4 AIC/BIC 139 / 153 

RCS Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.206 -0.463 0.393 0 1 0.992 

Bone1 -0.0524 0.0942 -0.241 0.145 -0.557 0.585 0.586 

Group1 0.267 0.291 -0.309 0.877 0.917 0.371 0.398 

Group2 -0.153 0.291 -0.733 0.437 -0.526 0.605 0.611 

Bone1:Group1 -0.0865 0.133 -0.346 0.167 -0.65 0.524 0.544 

Bone1:Group2 -0.0955 0.133 -0.353 0.17 -0.717 0.483 0.481 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.702 0.838 0.543 1.29 65.3 0.00156 ** R2M/R2C 0.05 / 0.67 

Residual 0.373 0.611 0.373 0.78 34.7 AIC/BIC 131 / 145 

Avg.Pol.MI Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 
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Intercept 0 0.195 -0.378 0.331 0 1 0.986 

Bone1 -0.171 0.105 -0.363 0.0353 -1.63 0.121 0.127 

Group1 -0.217 0.276 -0.762 0.297 -0.784 0.443 0.441 

Group2 -0.00206 0.276 -0.593 0.491 
-

0.00747 
0.994 0.992 

Bone1:Group1 0.235 0.148 -0.0767 0.518 1.58 0.131 0.143 

Bone1:Group2 -0.0544 0.148 -0.335 0.252 -0.367 0.718 0.729 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.572 0.756 0.392 1.18 55.4 0.0102 * R2M/R2C 
0.0827 / 

0.591 

Residual 0.461 0.679 0.431 0.845 44.6 AIC/BIC 133 / 147 

Avg.Imax Lambda = 1.275 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.193 -0.38 0.395 0 1 0.991 

Bone1 -0.115 0.116 -0.318 0.108 -0.986 0.337 0.335 

Group1 -0.165 0.273 -0.69 0.372 -0.606 0.552 0.556 

Group2 -0.0263 0.273 -0.58 0.476 -0.0963 0.924 0.921 

Bone1:Group1 0.22 0.164 -0.0752 0.526 1.34 0.198 0.214 

Bone1:Group2 -0.0307 0.164 -0.36 0.291 -0.187 0.854 0.846 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.499 0.706 0.282 1.16 46.8 0.0348 * R2M/R2C 0.0571 / 
0.499 

Residual 0.566 0.753 0.475 0.938 53.2 AIC/BIC 136 / 150 

Avg.Imin Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.189 -0.362 0.354 0 1 0.973 

Bone1 -0.263 0.099 -0.466 -0.0848 -2.65 0.0162 * 0.0165 * 

Group1 -0.309 0.267 -0.861 0.184 -1.16 0.262 0.265 

Group2 0.0348 0.267 -0.491 0.587 0.13 0.898 0.888 

Bone1:Group1 0.248 0.14 -0.0249 0.509 1.77 0.0935 . 0.1 

Bone1:Group2 -0.112 0.14 -0.376 0.158 -0.797 0.436 0.42 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.544 0.737 0.421 1.2 56.9 0.00795 ** R2M/R2C 0.144 / 0.631 

Residual 0.412 0.642 0.41 0.793 43.1 AIC/BIC 130 / 144 

Avg.Ecc Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.156 -0.287 0.324 0 1 0.985 

Bone1 0.218 0.156 -0.0936 0.529 1.39 0.172 0.167 

Group1 0.243 0.221 -0.139 0.694 1.1 0.279 0.292 

Group2 -0.125 0.221 -0.589 0.311 -0.567 0.575 0.603 

Bone1:Group1 0.0416 0.221 -0.4 0.471 0.188 0.852 0.849 
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Bone1:Group2 0.159 0.221 -0.313 0.572 0.723 0.475 0.478 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) 

p-value Sig. 
Model 
Test 

Model Fit 

Sample 0 0 0 0.831 0 1 R2M/R2C 0.0905 / 
0.0905 

Residual 1.02 1.01 0.625 1.18 100 AIC/BIC 139 / 153 

CS.Th Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.207 -0.426 0.399 0 1 0.998 

Bone1 -0.133 0.0906 -0.298 0.0596 -1.47 0.158 0.171 

Group1 -0.225 0.292 -0.802 0.295 -0.768 0.452 0.447 

Group2 0.16 0.292 -0.364 0.788 0.549 0.59 0.606 

Bone1:Group1 0.112 0.128 -0.154 0.357 0.874 0.394 0.395 

Bone1:Group2 0.0533 0.128 -0.209 0.315 0.416 0.682 0.69 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.726 0.852 0.564 1.27 67.8 
0.00086 

8 
*** R2M/R2C 

0.0533 / 
0.695 

Residual 0.344 0.587 0.383 0.723 32.2 AIC/BIC 130 / 144 
Total Number 

of Pore 
Systems 

Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.162 -0.355 0.304 0 1 0.983 

Bone1 -0.318 0.136 -0.572 -0.0414 -2.33 0.0314 * 0.0246 * 

Group1 -0.275 0.229 -0.707 0.237 -1.2 0.245 0.251 

Group2 0.27 0.229 -0.24 0.758 1.18 0.254 0.272 

Bone1:Group1 0.191 0.193 -0.176 0.594 0.993 0.334 0.326 

Bone1:Group2 -0.111 0.193 -0.468 0.277 -0.575 0.573 0.558 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.163 0.403 0 0.889 17.3 0.461 R2M/R2C 0.155 / 0.301 

Residual 0.779 0.883 0.541 1.08 82.7 AIC/BIC 136 / 150 

Total Number 
of Pore 

Segments 
Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.164 -0.344 0.301 0 1 0.984 

Bone1 -0.117 0.151 -0.417 0.191 -0.77 0.451 0.437 

Group1 -0.102 0.232 -0.493 0.32 -0.437 0.667 0.687 

Group2 0.133 0.232 -0.303 0.615 0.573 0.574 0.6 

Bone1:Group1 0.324 0.214 -0.116 0.712 1.51 0.147 0.135 

Bone1:Group2 -0.107 0.214 -0.49 0.302 -0.5 0.623 0.594 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 
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Sample 0.0858 0.293 0 0.878 8.19 0.728 R2M/R2C 
0.0707 / 

0.147 

Residual 0.962 0.981 0.637 1.2 91.8 AIC/BIC 140 / 154 
Pore Segment 
Mean Length 

Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.161 -0.319 0.334 0 1 0.998 

Bone1 0.113 0.161 -0.207 0.432 0.699 0.489 0.494 

Group1 0.219 0.228 -0.215 0.648 0.962 0.342 0.387 

Group2 -0.139 0.228 -0.61 0.344 -0.609 0.546 0.594 

Bone1:Group1 -0.0676 0.228 -0.559 0.405 -0.297 0.769 0.754 

Bone1:Group2 -0.0188 0.228 -0.454 0.437 -0.0824 0.935 0.952 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0 0 0 0.833 0 1 R2M/R2C 
0.0374 / 
0.0374 

Residual 1.09 1.04 0.664 1.25 100 AIC/BIC 142 / 155 
Pore Segment 
Mean Radius 

Lambda = -2.225 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.123 -0.283 0.253 0 1 0.998 

Bone1 0.659 0.0845 0.499 0.837 7.8 3E-07 *** 0.000175 *** 

Group1 0.372 0.174 0.0266 0.715 2.13 0.0471 * 0.0481 * 

Group2 -0.4 0.174 -0.718 -0.0268 -2.29 0.0342 * 0.0404 * 

Bone1:Group1 0.282 0.119 0.019 0.495 2.36 0.0299 * 0.0298 * 

Bone1:Group2 -0.136 0.119 -0.377 0.0975 -1.14 0.27 0.276 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) 

p-value Sig. 
Model 
Test 

Model Fit 

Sample 0.17 0.412 0.106 0.702 36.1 0.113 R2M/R2C 0.556 / 0.716 

Residual 0.3 0.548 0.34 0.688 63.9 AIC/BIC 108 / 122 
Total Pore 
Network 
Volume 

Lambda = -0.325 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.148 -0.299 0.29 0 1 0.996 

Bone1 0.42 0.112 0.181 0.636 3.73 0.00152 ** 0.000702 *** 

Group1 0.351 0.209 -0.047 0.776 1.68 0.111 0.11 

Group2 -0.318 0.209 -0.686 0.111 -1.52 0.145 0.153 

Bone1:Group1 0.453 0.159 0.118 0.776 2.85 0.0107 * 0.0112 * 

Bone1:Group2 -0.184 0.159 -0.482 0.156 -1.15 0.263 0.259 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.194 0.441 0 0.844 26.8 0.247 R2M/R2C 0.334 / 0.512 

Residual 0.531 0.729 0.484 0.889 73.2 AIC/BIC 126 / 140 
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Total Pore 
Network 
Length 

Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.167 -0.298 0.349 0 1 0.995 

Bone1 -0.0902 0.149 -0.379 0.203 -0.606 0.552 0.572 

Group1 -0.0602 0.236 -0.532 0.376 -0.255 0.801 0.815 

Group2 0.0972 0.236 -0.38 0.564 0.413 0.685 0.701 

Bone1:Group1 0.359 0.211 -0.0468 0.761 1.7 0.105 0.102 

Bone1:Group2 -0.154 0.211 -0.639 0.274 -0.733 0.473 0.437 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.117 0.342 0 0.883 11.2 0.635 R2M/R2C 0.0707 / 
0.174 

Residual 0.931 0.965 0.585 1.17 88.8 AIC/BIC 140 / 154 
Mean Pore 

System 
Number of 
Segments 

Lambda = -1.525 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.156 -0.3 0.345 0 1 0.996 

Bone1 0.286 0.142 -0.0132 0.563 2.01 0.0592 . 0.0554 . 

Group1 0.148 0.221 -0.269 0.552 0.67 0.512 0.546 

Group2 -0.13 0.221 -0.579 0.337 -0.587 0.564 0.593 

Bone1:Group1 0.371 0.201 -0.0459 0.792 1.85 0.0809 . 0.0789 . 

Bone1:Group2 -0.0551 0.201 -0.424 0.36 -0.275 0.787 0.772 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.0903 0.3 0 0.856 9.66 0.681 R2M/R2C 0.161 / 0.242 

Residual 0.845 0.919 0.566 1.1 90.3 AIC/BIC 134 / 148 
Mean Pore 

System Mean 
Length 

Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.156 -0.296 0.285 0 1 0.995 

Bone1 0.276 0.156 0.0172 0.588 1.76 0.0862 . 0.0877 . 

Group1 0.177 0.221 -0.307 0.572 0.801 0.428 0.444 

Group2 -0.0698 0.221 -0.506 0.416 -0.316 0.754 0.751 

Bone1:Group1 -0.0309 0.221 -0.493 0.387 -0.14 0.89 0.888 

Bone1:Group2 -0.0506 0.221 -0.463 0.353 -0.229 0.82 0.828 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0 0 0 0.802 0 1 R2M/R2C 0.0869 / 
0.0869 

Residual 1.03 1.01 0.662 1.19 100 AIC/BIC 139 / 153 
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Mean Pore 
System Mean 

Radius 
Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.151 -0.297 0.296 0 1 0.989 

Bone1 0.421 0.136 0.139 0.68 3.09 0.00635 ** 0.00526 ** 

Group1 0.166 0.214 -0.232 0.591 0.776 0.448 0.465 

Group2 -0.308 0.214 -0.746 0.116 -1.44 0.167 0.18 

Bone1:Group1 0.0163 0.193 -0.354 0.403 0.0847 0.933 0.921 

Bone1:Group2 -0.0942 0.193 -0.47 0.283 -0.488 0.631 0.62 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.0904 0.301 0 0.834 10.4 0.659 R2M/R2C 0.213 / 0.295 

Residual 0.78 0.883 0.558 1.08 89.6 AIC/BIC 133 / 147 
Mean Pore 

System Total 
Volume 

Lambda = -0.45 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.13 -0.241 0.262 0 1 0.993 

Bone1 0.548 0.102 0.371 0.775 5.36 
4.32E-

05 
*** 0.000175 *** 

Group1 0.48 0.184 0.117 0.825 2.61 0.0177 * 0.0172 * 

Group2 -0.468 0.184 -0.862 -0.109 -2.55 0.0202 * 0.0277 * 

Bone1:Group1 0.256 0.145 0.000674 0.555 1.77 0.094 . 0.087 . 

Bone1:Group2 -0.0885 0.145 -0.411 0.212 -0.612 0.548 0.532 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.135 0.368 0 0.726 23.5 0.311 R2M/R2C 0.463 / 0.589 

Residual 0.439 0.663 0.419 0.825 76.5 AIC/BIC 122 / 136 
Mean Pore 

System Total 
Length 

Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.15 -0.318 0.268 0 1 0.986 

Bone1 0.435 0.113 0.211 0.638 3.86 0.00115 ** 0.000702 *** 

Group1 0.397 0.213 -0.026 0.822 1.87 0.0784 . 0.0818 . 

Group2 -0.307 0.213 -0.684 0.0835 -1.44 0.166 0.168 

Bone1:Group1 0.352 0.16 0.049 0.679 2.21 0.0407 * 0.0435 * 

Bone1:Group2 -0.125 0.16 -0.434 0.17 -0.781 0.445 0.432 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.208 0.456 0 0.87 28 0.226 R2M/R2C 0.319 / 0.51 

Residual 0.535 0.731 0.481 0.915 72 AIC/BIC 126 / 140 
Mean Pore 

System 
Lambda = -2.975 
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Number of 
Nodes 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.156 -0.293 0.347 0 1 0.991 

Bone1 0.319 0.136 0.027 0.569 2.35 0.0307 * 0.0225 * 

Group1 0.171 0.221 -0.238 0.575 0.774 0.449 0.462 

Group2 -0.134 0.221 -0.528 0.307 -0.606 0.552 0.551 

Bone1:Group1 0.384 0.192 0.0213 0.747 2 0.0611 . 0.0575 . 

Bone1:Group2 -0.0537 0.192 -0.449 0.338 -0.279 0.783 0.789 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.125 0.353 0 0.904 13.9 0.554 R2M/R2C 0.188 / 0.301 

Residual 0.776 0.881 0.56 1.05 86.1 AIC/BIC 133 / 147 
Mean Pore 

System 
Terminal 

Nodes 

Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.143 -0.292 0.262 0 1 0.986 

Bone1 0.425 0.127 0.185 0.683 3.35 0.00358 ** 0.00386 ** 

Group1 0.303 0.203 -0.0654 0.665 1.49 0.152 0.169 

Group2 -0.18 0.203 -0.596 0.177 -0.889 0.386 0.405 

Bone1:Group1 0.405 0.179 0.037 0.759 2.26 0.0366 * 0.0298 * 

Bone1:Group2 -0.0939 0.179 -0.443 0.281 -0.524 0.607 0.575 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.0944 0.307 0 0.8 12.3 0.602 R2M/R2C 0.296 / 0.383 

Residual 0.675 0.822 0.538 0.993 87.7 AIC/BIC 129 / 143 
Mean Pore 

System 
Branching 

Nodes 

Lambda = -0.35 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.157 -0.276 0.312 0 1 0.994 

Bone1 0.256 0.145 -0.0172 0.522 1.77 0.0944 . 0.0825 . 

Group1 0.134 0.222 -0.279 0.558 0.605 0.553 0.57 

Group2 -0.126 0.222 -0.53 0.352 -0.566 0.578 0.579 

Bone1:Group1 0.369 0.205 -0.0198 0.744 1.8 0.0889 . 0.0705 . 

Bone1:Group2 -0.0594 0.205 -0.466 0.346 -0.289 0.776 0.773 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.0744 0.273 0 0.801 7.76 0.741 R2M/R2C 0.142 / 0.209 

Residual 0.883 0.94 0.582 1.15 92.2 AIC/BIC 135 / 149 
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Median Pore 
System Mean 

Length 
Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.15 -0.261 0.336 0 1 0.998 

Bone1 0.392 0.15 0.0854 0.696 2.61 0.0133 * 0.0105 * 

Group1 0.0998 0.213 -0.295 0.524 0.469 0.642 0.665 

Group2 -0.0317 0.213 -0.48 0.417 -0.149 0.883 0.899 

Bone1:Group1 -0.00935 0.213 -0.403 0.423 -0.0439 0.965 0.975 

Bone1:Group2 -0.0486 0.213 -0.521 0.407 -0.228 0.821 0.816 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0 0 0 0.749 0 1 R2M/R2C 0.148 / 0.148 

Residual 0.951 0.975 0.638 1.16 100 AIC/BIC 137 / 150 
Median Pore 
System Mean 

Radius 
Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.156 -0.303 0.294 0 1 0.994 

Bone1 0.347 0.148 0.0698 0.62 2.34 0.0313 * 0.0256 * 

Group1 0.021 0.221 -0.431 0.448 0.095 0.925 0.941 

Group2 -0.0655 0.221 -0.535 0.414 -0.296 0.771 0.797 

Bone1:Group1 0.0108 0.21 -0.432 0.414 0.0515 0.959 0.967 

Bone1:Group2 -0.162 0.21 -0.56 0.229 -0.772 0.45 0.432 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.0513 0.226 0 0.833 5.25 0.824 R2M/R2C 0.127 / 0.173 

Residual 0.926 0.962 0.626 1.17 94.7 AIC/BIC 137 / 151 
Median Pore 
System Total 

Volume 
Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.152 -0.307 0.31 0 1 0.994 

Bone1 0.393 0.149 0.0784 0.691 2.64 0.0166 * 0.013 * 

Group1 0.0576 0.215 -0.368 0.512 0.267 0.792 0.798 

Group2 -0.0395 0.215 -0.461 0.412 -0.183 0.857 0.858 

Bone1:Group1 0.0556 0.21 -0.356 0.465 0.264 0.795 0.789 

Bone1:Group2 -0.1 0.21 -0.546 0.294 -0.475 0.64 0.647 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.0223 0.149 0 0.789 2.35 0.921 R2M/R2C 0.148 / 0.168 

Residual 0.929 0.964 0.594 1.14 97.7 AIC/BIC 137 / 150 
Median Pore 
System Total 

Length 
Lambda = None 
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Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.152 -0.334 0.281 0 1 0.985 

Bone1 0.367 0.152 0.096 0.66 2.41 0.0211 * 0.0151 * 

Group1 0.0897 0.215 -0.337 0.51 0.417 0.679 0.718 

Group2 0.00273 0.215 -0.416 0.402 0.0127 0.99 0.981 

Bone1:Group1 0.052 0.215 -0.35 0.504 0.242 0.81 0.8 

Bone1:Group2 -0.0601 0.215 -0.502 0.354 -0.279 0.782 0.768 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) 

p-value Sig. 
Model 
Test 

Model Fit 

Sample 0 0 0 0.782 0 1 R2M/R2C 0.13 / 0.13 

Residual 0.973 0.986 0.624 1.17 100 AIC/BIC 137 / 151 
Max Pore 

System 
Number of 
Segments 

Lambda = 0.025 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.145 -0.323 0.293 0 1 0.994 

Bone1 0.352 0.145 0.043 0.643 2.43 0.0201 * 0.0204 * 

Group1 0.117 0.205 -0.262 0.471 0.573 0.57 0.621 

Group2 -0.0304 0.205 -0.404 0.378 -0.149 0.883 0.899 

Bone1:Group1 0.412 0.205 -0.0169 0.815 2.01 0.0517 . 0.0512 . 

Bone1:Group2 -0.114 0.205 -0.552 0.296 -0.555 0.583 0.575 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0 0 0 0.748 0 1 R2M/R2C 0.205 / 0.205 

Residual 0.88 0.938 0.595 1.11 100 AIC/BIC 136 / 150 
Max Pore 

System Mean 
Length 

Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.15 -0.272 0.322 0 1 0.984 

Bone1 -0.348 0.15 -0.621 -0.0707 -2.33 0.0258 * 0.0239 * 

Group1 -0.00947 0.212 -0.462 0.376 -0.0447 0.965 0.982 

Group2 -0.112 0.212 -0.534 0.307 -0.53 0.599 0.608 

Bone1:Group1 0.179 0.212 -0.247 0.599 0.845 0.404 0.384 

Bone1:Group2 0.0916 0.212 -0.301 0.496 0.432 0.668 0.655 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0 0 0 0.764 0 1 R2M/R2C 0.155 / 0.155 

Residual 0.942 0.971 0.613 1.18 100 AIC/BIC 136 / 150 
Max Pore 

System Mean 
Radius 

Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.155 -0.319 0.32 0 1 0.994 
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Bone1 -0.113 0.155 -0.398 0.201 -0.732 0.469 0.454 

Group1 0.127 0.219 -0.355 0.559 0.581 0.565 0.594 

Group2 -0.361 0.219 -0.758 0.0908 -1.65 0.108 0.142 

Bone1:Group1 -0.108 0.219 -0.516 0.309 -0.494 0.624 0.6 

Bone1:Group2 -0.155 0.219 -0.565 0.277 -0.707 0.484 0.455 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0 0 0 0.786 0 1 R2M/R2C 0.105 / 0.105 

Residual 1.01 1 0.64 1.21 100 AIC/BIC 139 / 152 
Max Pore 

System Total 
Volume 

Lambda = -0.15 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.143 -0.293 0.298 0 1 0.991 

Bone1 0.515 0.118 0.294 0.753 4.37 
0.00036 

9 
*** 0.000175 *** 

Group1 0.287 0.203 -0.0812 0.709 1.41 0.175 0.184 

Group2 -0.182 0.203 -0.547 0.224 -0.898 0.381 0.405 

Bone1:Group1 0.315 0.167 -0.0145 0.643 1.89 0.0748 . 0.0674 . 

Bone1:Group2 -0.157 0.167 -0.52 0.157 -0.942 0.359 0.348 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.14 0.374 0 0.775 19.3 0.407 R2M/R2C 0.336 / 0.464 

Residual 0.583 0.763 0.478 0.947 80.7 AIC/BIC 132 / 146 
Max Pore 

System Total 
Length 

Lambda = -0.025 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.142 -0.288 0.271 0 1 0.994 

Bone1 0.372 0.142 0.112 0.676 2.62 0.0129 * 0.0109 * 

Group1 0.179 0.201 -0.246 0.581 0.889 0.38 0.409 

Group2 -0.0387 0.201 -0.504 0.346 -0.192 0.848 0.834 

Bone1:Group1 0.415 0.201 0.00426 0.855 2.06 0.0463 * 0.0453 * 

Bone1:Group2 -0.123 0.201 -0.57 0.241 -0.612 0.545 0.535 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0 0 0 0.718 0 1 R2M/R2C 0.23 / 0.23 

Residual 0.85 0.922 0.6 1.08 100 AIC/BIC 135 / 149 
Max Pore 

System 
Number of 

Nodes 

Lambda = 0 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.144 -0.289 0.284 0 1 0.999 

Bone1 0.36 0.144 0.0511 0.632 2.51 0.0169 * 0.0228 * 
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Group1 0.119 0.203 -0.263 0.494 0.585 0.562 0.575 

Group2 -0.0227 0.203 -0.42 0.364 -0.112 0.912 0.911 

Bone1:Group1 0.419 0.203 0.0184 0.789 2.06 0.0468 * 0.0428 * 

Bone1:Group2 -0.113 0.203 -0.488 0.293 -0.557 0.581 0.6 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0 0 0 0.723 0 1 R2M/R2C 0.215 / 0.215 

Residual 0.869 0.932 0.614 1.11 100 AIC/BIC 136 / 150 
Max Pore 

System 
Terminal 

Nodes 

Lambda = -0.025 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.142 -0.294 0.314 0 1 0.996 

Bone1 0.38 0.142 0.0804 0.638 2.69 0.0109 * 0.0109 * 

Group1 0.129 0.2 -0.28 0.505 0.646 0.522 0.532 

Group2 -0.0162 0.2 -0.382 0.381 -0.0811 0.936 0.945 

Bone1:Group1 0.43 0.2 0.0457 0.82 2.15 0.0385 * 0.0393 * 

Bone1:Group2 -0.11 0.2 -0.519 0.265 -0.551 0.585 0.592 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0 0 0 0.729 0 1 R2M/R2C 0.236 / 0.236 

Residual 0.842 0.918 0.563 1.09 100 AIC/BIC 135 / 149 
Max Pore 

System 
Branching 

Nodes 

Lambda = 0.025 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.145 -0.28 0.315 0 1 0.993 

Bone1 0.345 0.145 0.0853 0.621 2.37 0.023 * 0.0228 * 

Group1 0.112 0.206 -0.292 0.495 0.545 0.589 0.629 

Group2 -0.0284 0.206 -0.503 0.397 -0.138 0.891 0.891 

Bone1:Group1 0.41 0.206 -0.0598 0.808 2 0.0536 . 0.0523 . 

Bone1:Group2 -0.117 0.206 -0.53 0.266 -0.568 0.573 0.563 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0 0 0 0.739 0 1 R2M/R2C 0.199 / 0.199 

Residual 0.888 0.942 0.576 1.13 100 AIC/BIC 136 / 150 
Min Pore 

System Mean 
Length 

Lambda = 6.075 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.151 -0.31 0.316 0 1 0.996 

Bone1 0.221 0.151 -0.0696 0.517 1.47 0.151 0.146 

Group1 -0.289 0.213 -0.735 0.106 -1.36 0.184 0.219 
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Group2 -0.157 0.213 -0.587 0.267 -0.736 0.467 0.489 

Bone1:Group1 -0.00074 0.213 -0.403 0.432 
-

0.00344 
0.997 0.989 

Bone1:Group2 -0.0943 0.213 -0.571 0.378 -0.442 0.661 0.651 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0 0 0 0.759 0 1 R2M/R2C 0.144 / 0.144 

Residual 0.955 0.977 0.598 1.16 100 AIC/BIC 137 / 151 
Min Pore 

System Total 
Volume 

Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.163 -0.319 0.31 0 1 0.983 

Bone1 0.0515 0.157 -0.307 0.369 0.329 0.746 0.761 

Group1 0.01 0.23 -0.433 0.454 0.0437 0.966 0.977 

Group2 -0.0775 0.23 -0.549 0.415 -0.337 0.74 0.766 

Bone1:Group1 -0.0532 0.222 -0.444 0.402 -0.24 0.813 0.808 

Bone1:Group2 -0.248 0.222 -0.656 0.146 -1.12 0.279 0.241 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.0403 0.201 0 0.837 3.76 0.873 R2M/R2C 
0.0523 / 

0.088 

Residual 1.03 1.02 0.635 1.24 96.2 AIC/BIC 141 / 155 
Min Pore 

System Total 
Length 

Lambda = 7.175 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

Intercept 0 0.14 -0.291 0.295 0 1 0.998 

Bone1 0.295 0.134 0.039 0.554 2.21 0.0405 * 0.0309 * 

Group1 -0.358 0.198 -0.754 0.0808 -1.81 0.0876 . 0.105 

Group2 0.0451 0.198 -0.365 0.399 0.227 0.823 0.823 

Bone1:Group1 -0.436 0.189 -0.79 -0.0668 -2.3 0.0333 * 0.0253 * 

Bone1:Group2 -0.0347 0.189 -0.401 0.386 -0.184 0.856 0.839 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.0366 0.191 0 0.743 4.64 0.844 R2M/R2C 0.281 / 0.315 

Residual 0.751 0.867 0.557 1.03 95.4 AIC/BIC 131 / 145 

Aggregate Porosity: Post-Hoc Tests for Significant Fixed Effects 

Number Closed 
Pores 

Interaction 
Contrast Comparison p-value Sig. 

Cohen's 
D 

Effect Group Power 

Bone Femur < Tibia 0.0133 * 0.848 Large 37% 
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Closed Pore 
Density 

Interaction 
Contrast Comparison p-value Sig. 

Cohen's 
D 

Effect Group Power 

Bone Femur < Tibia 0.0247 * 0.756 Medium 33% 

Closed Porosity 
(%) 

Interaction 
Contrast 

Comparison p-value Sig. Cohen's 
D 

Effect Group Power 

Bone Femur < Tibia 0.000432 *** 1.33 Large 30% 

Open Porosity (%) Interaction 
Contrast 

Comparison p-value Sig. Cohen's 
D 

Effect Group Power 

Bone Femur > Tibia 0.000526 *** 1.3 Large 65% 

Bone | Group Femur Control > Fentanyl 0.000852 *** 2.16 Large 39% 

Bone | Group Femur Control > Morphine 0.00845 ** 1.66 Large 

Bone | Group Femur Fentanyl < Morphine 0.399 0.507 Medium 

Bone | Group Tibia Control > Fentanyl 0.8 0.152 Small 

Bone | Group Tibia Control < Morphine 0.857 0.108 Small 

Bone | Group Tibia Fentanyl < Morphine 0.666 0.259 Medium 

Group | Bone Control Femur > Tibia 0.000309 *** 2.57 Large 

Group | Bone Fentanyl Femur > Tibia 0.351 0.552 Medium 

Group | Bone Morphine Femur > Tibia 0.182 0.801 Large 

Pore Volume 
Interaction 

Contrast 
Comparison p-value Sig. Cohen's 

D 
Effect Group Power 

Bone | Group Femur Control > Fentanyl 0.00519 ** 1.62 Large 39% 

Bone | Group Femur Control > Morphine 0.0243 * 1.28 Large 

Bone | Group Femur Fentanyl < Morphine 0.536 0.34 Medium 

Bone | Group Tibia Control < Fentanyl 0.932 0.0469 Small 

Bone | Group Tibia Control < Morphine 0.549 0.328 Medium 

Bone | Group Tibia Fentanyl < Morphine 0.608 0.281 Medium 

Group | Bone Control Femur > Tibia 0.00566 ** 1.68 Large 

Group | Bone Fentanyl Femur > Tibia 0.978 0.0147 Small 

Group | Bone Morphine Femur > Tibia 0.893 0.0731 Small 

Pore Volume 
Interaction 

Contrast 
Comparison p-value Sig. Cohen's 

D 
Effect Group Power 

Bone | Group Femur Control > Fentanyl 0.0153 * 1.42 Large 43% 

Bone | Group Femur Control > Morphine 0.0574 . 1.09 Large 

Bone | Group Femur Fentanyl < Morphine 0.563 0.325 Medium 

Bone | Group Tibia Control < Fentanyl 0.767 0.166 Small 

Bone | Group Tibia Control < Morphine 0.384 0.49 Medium 

Bone | Group Tibia Fentanyl < Morphine 0.563 0.325 Medium 

Group | Bone Control Femur > Tibia 0.0104 * 1.53 Large 

Group | Bone Fentanyl Femur < Tibia 0.922 0.0529 Small 

Group | Bone Morphine Femur < Tibia 0.923 0.0526 Small 

Total Porosity (%) Interaction 
Contrast 

Comparison p-value Sig. Cohen's 
D 

Effect Group Power 

Bone | Group Femur Control > Fentanyl 0.0052 ** 1.62 Large 48% 

Bone | Group Femur Control > Morphine 0.0243 * 1.28 Large 

2018-DU-BX-0188 Final Technical Report 
October 2021 

This resource was prepared by the author(s) using Federal funds provided by the U.S. 
Department of Justice. Opinions or points of view expressed are those of the author(s) and do not 

necessarily reflect the official position or policies of the U.S. Department of Justice.

266 



 
 

           

           

           

           

           

           

           
 

 
 

 
   

 
  

         
 

 
 

       

         

         

         

         

  
 

       

         

         

         

         
 

 
 

 
   

 
  

         

  
 

       

         

   
 

   
 

  

         
         

   
 

   
 

  

         

   
 

   
 

  

         

         

         

         
 

 
 

 
   

 
  

         

 
 

 
      

Bone | Group Femur Fentanyl < Morphine 0.536 0.34 Medium 

Bone | Group Tibia Control < Fentanyl 0.932 0.0469 Small 

Bone | Group Tibia Control < Morphine 0.549 0.329 Medium 

Bone | Group Tibia Fentanyl < Morphine 0.607 0.282 Medium 

Group | Bone Control Femur > Tibia 0.00568 ** 1.68 Large 

Group | Bone Fentanyl Femur > Tibia 0.979 0.0142 Small 

Group | Bone Morphine Femur > Tibia 0.894 0.0721 Small 
Intersection 

Surface 
Interaction 

Contrast 
Comparison p-value Sig. 

Cohen's 
D 

Effect Group Power 

Bone Femur > Tibia 0.000131 *** 1.49 Large 44% 

Pore Surface: 
PoreVolume 

Interaction 
Contrast Comparison p-value Sig. 

Cohen's 
D 

Effect Group Power 

Bone Femur < Tibia 0.000134 *** 1.49 Large 71% 

Group Control < Fentanyl 0.0161 * 1.46 Large 95% 

Group Control < Morphine 0.298 0.723 Medium 

Group Fentanyl > Morphine 0.286 0.737 Medium 

Pore Thickness 
Interaction 

Contrast Comparison p-value Sig. 
Cohen's 

D 
Effect Group Power 

Bone Femur > Tibia 0.000183 *** 1.45 Large 60% 

Group Control > Fentanyl 0.0122 * 1.28 Large 92% 

Group Control > Morphine 0.291 0.615 Medium 

Group Fentanyl < Morpine 0.24 0.665 Medium 

Degree of 
Anisotropy 

Interaction 
Contrast 

Comparison p-value Sig. 
Cohen's 

D 
Effect Group Power 

Bone Femur < Tibia 0.0433 * 0.671 Medium 31% 

Number of Pores 
Interaction 

Contrast Comparison p-value Sig. 
Cohen's 

D 
Effect Group Power 

Bone Femur < Tibia 0.0237 * 0.763 Medium 34% 

Pore Density 
Interaction 

Contrast 
Comparison p-value Sig. Cohen's 

D 
Effect Group Power 

Bone Femur < Tibia 0.0439 * 0.669 Medium 35% 

Group Control < Fentanyl 0.465 0.462 Medium 46% 

Euler number 
Interaction 

Contrast 
Comparison p-value Sig. Cohen's 

D 
Effect Group Power 

Bone Femur < Tibia 0.0158 * 0.823 Large 34% 

SD Pore Thickness 
Interaction 

Contrast 
Comparison p-value Sig. Cohen's 

D 
Effect Group Power 

Bone Femur > Tibia 0.000314 *** 1.37 Large 50% 

Group Control > Fentanyl 0.0289 * 1.07 Large 89% 

Group Control > Morphine 0.339 0.547 Medium 

Group Fentanyl < Morpine 0.374 0.52 Medium 

SD Pore 
Separation 

Interaction 
Contrast 

Comparison p-value Sig. Cohen's 
D 

Effect Group Power 

Bone Femur > Tibia 0.00742 ** 0.931 Large 20% 

Avg.Por.Vol 
Interaction 
Contrast 

Comparison p-value Sig. Cohen's D Effect Group Power 
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Bone Femur > Tibia 0.000193 *** 1.44 Large 68% 

Group Control > Fentanyl 0.0403 * 1.46 Large 87% 

Group Control > Morphine 0.331 0.803 Large 

Group Fentanyl < Morpine 0.47 0.656 Medium 

Avg.Por.Surf Interaction 
Contrast 

Comparison p-value Sig. Cohen's 
D 

Effect Group Power 

Bone Femur > Tibia 0.00129 ** 1.18 Large 61% 

Avg. Pore 
Orientation Phi 

Interaction 
Contrast Comparison p-value Sig. 

Cohen's 
D 

Effect Group Power 

Bone Femur < Tibia 0 *** 3.47 Large 53% 

Avg.Por.Th 
Interaction 

Contrast Comparison p-value Sig. 
Cohen's 

D 
Effect Group Power 

Bone Femur > Tibia 0.00572 ** 0.968 Large 37% 

RCV 
Interaction 

Contrast 
Comparison p-value Sig. Cohen's 

D 
Effect Group Power 

Bone Femur < Tibia 0.00931 ** 0.899 Large 25% 

TA.Surf 
Interaction 

Contrast 
Comparison p-value Sig. 

Cohen's 
D 

Effect Group Power 

Bone Femur < Tibia 0.00101 ** 1.21 Large 35% 

CA.Surf 
Interaction 

Contrast Comparison p-value Sig. 
Cohen's 

D 
Effect Group Power 

Bone Femur < Tibia 0.0124 * 0.857 Large 23% 

Avg.Imin 
Interaction 

Contrast 
Comparison p-value Sig. Cohen's 

D 
Effect Group Power 

Bone Femur < Tibia 0.0162 * 0.819 Large 45% 

Total Number of 
Pore Systems 

Interaction 
Contrast 

Comparison p-value Sig. 
Cohen's 

D 
Effect Group Power 

Bone Femur < Tibia 0.031425 * 0.720102 Medium 35% 

Pore Segment 
Mean Radius 

Interaction 
Contrast Comparison p-value Sig. 

Cohen's 
D 

Effect Group Power 

Bone Femur > Tibia 3.50E-07 *** 2.407654 Large 73% 

Group Control > Fentanyl 0.04981 * 1.409326 Large 100% 

Group Control > Morphine 0.504106 0.627802 Medium 

Group Fentanyl < Morpine 0.353775 0.781523 Medium 

Bone | Group Femur Control > Fentanyl 0.000238 *** 2.672798 Large 29% 

Bone | Group Femur Control > Morphine 0.006577 ** 1.884795 Large 

Bone | Group Femur Fentanyl < Morphine 0.234608 0.788003 Medium 

Bone | Group Tibia Control > Fentanyl 0.576536 0.367231 Medium 

Bone | Group Tibia Control < Morphine 0.775328 0.187364 Small 

Bone | Group Tibia Fentanyl < Morphine 0.400398 0.554595 Medium 

Group | Bone Control Femur > Tibia 3.55E-06 *** 3.764053 Large 

Group | Bone Fentanyl Femur > Tibia 0.020201 * 1.458486 Large 

Group | Bone Morphine Femur > Tibia 0.008469 ** 1.691894 Large 

Total Pore 
Network Volume 

Interaction 
Contrast 

Comparison p-value Sig. Cohen's 
D 

Effect Group Power 

Bone Femur > Tibia 0.001524 ** 1.151886 Large 68% 
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Bone | Group Femur Control > Fentanyl 0.00217 ** 2.051248 Large 43% 

Bone | Group Femur Control > Morphine 0.012273 * 1.637725 Large 

Bone | Group Femur Fentanyl < Morphine 0.509775 0.413522 Medium 

Bone | Group Tibia Control > Fentanyl 0.855749 0.113718 Small 

Bone | Group Tibia Control < Morphine 0.747517 0.201475 Medium 

Bone | Group Tibia Fentanyl < Morphine 0.614905 0.315193 Medium 

Group | Bone Control Femur > Tibia 0.001516 ** 2.319733 Large 

Group | Bone Fentanyl Femur > Tibia 0.546003 0.382203 Medium 

Group | Bone Morphine Femur > Tibia 0.449148 0.480533 Medium 

Mean Pore System 
Mean Radius 

Interaction 
Contrast 

Comparison p-value Sig. Cohen's 
D 

Effect Group Power 

Bone Femur > Tibia 0.006352 ** 0.952796 Large 29% 

Mean Pore System 
Total Volume 

Interaction 
Contrast 

Comparison p-value Sig. 
Cohen's 

D 
Effect Group Power 

Bone Femur > Tibia 4.32E-05 *** 1.653104 Large 67% 

Group Control > Fentanyl 0.020983 * 1.430039 Large 97% 

Group Control > Morphine 0.295187 0.741263 Medium 

Group Fentanyl < Morpine 0.345254 0.688776 Medium 

Mean Pore System 
Total Length 

Interaction 
Contrast 

Comparison p-value Sig. Cohen's 
D 

Effect Group Power 

Bone Femur > Tibia 0.001147 ** 1.191205 Large 51% 

Bone | Group Femur Control > Fentanyl 0.015064 * 1.614312 Large 39% 

Bone | Group Femur Control > Morphine 0.026937 * 1.457699 Large 

Bone | Group Femur Fentanyl < Morphine 0.805153 0.156612 Small 

Bone | Group Tibia Control > Fentanyl 0.624741 0.310963 Medium 

Bone | Group Tibia Control < Morphine 0.84209 0.126459 Small 

Bone | Group Tibia Fentanyl < Morphine 0.492179 0.437422 Medium 

Group | Bone Control Femur > Tibia 0.000787 *** 2.153708 Large 

Group | Bone Fentanyl Femur > Tibia 0.129047 0.850359 Large 

Group | Bone Morphine Femur > Tibia 0.300721 0.569549 Medium 

Mean Pore System 
Number of Nodes 

Interaction 
Contrast 

Comparison p-value Sig. Cohen's 
D 

Effect Group Power 

Bone Femur > Tibia 0.030667 * 0.723806 Medium 44% 

Mean Pore System 
Termil Nodes 

Interaction 
Contrast 

Comparison p-value Sig. 
Cohen's 

D 
Effect Group Power 

Bone Femur > Tibia 0.003576 ** 1.033408 Large 47% 

Bone | Group Femur Control > Fentanyl 0.043425 * 1.195219 Large 41% 

Bone | Group Femur Control > Morphine 0.020066 * 1.389401 Large 

Bone | Group Femur Fentanyl > Morphine 0.735649 0.194183 Small 

Bone | Group Tibia Control < Fentanyl 0.973906 0.018798 Small 

Bone | Group Tibia Control < Morphine 0.540509 0.352672 Medium 

Bone | Group Tibia Fentanyl < Morphine 0.562197 0.333874 Medium 

Group | Bone Control Femur > Tibia 0.001381 ** 2.018771 Large 
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Group | Bone Fentanyl Femur > Tibia 0.149527 0.804755 Large 

Group | Bone Morphine Femur > Tibia 0.611004 0.276698 Medium 

Median Pore 
System Mean 

Length 

Interaction 
Contrast Comparison p-value Sig. 

Cohen's 
D 

Effect Group Power 

Bone Femur > Tibia 0.017895 * 0.804045 Large 26% 

Median Pore 
System Mean 

Radius 

Interaction 
Contrast Comparison p-value Sig. 

Cohen's 
D 

Effect Group Power 

Bone Femur > Tibia 0.031273 * 0.720836 Medium 23% 

Median Pore 
System Total 

Volume 

Interaction 
Contrast 

Comparison p-value Sig. Cohen's 
D 

Effect Group Power 

Bone Femur > Tibia 0.01655 * 0.815484 Large 24% 

Median Pore 
System Total 

Length 

Interaction 
Contrast 

Comparison p-value Sig. Cohen's 
D 

Effect Group Power 

Bone Femur > Tibia 0.026798 * 0.744142 Medium 21% 

Max Pore System 
Number of 
Segments 

Interaction 
Contrast 

Comparison p-value Sig. Cohen's 
D 

Effect Group Power 

Bone Femur > Tibia 0.025713 * 0.75034 Medium 30% 

Max Pore System 
Mean Length 

Interaction 
Contrast 

Comparison p-value Sig. Cohen's 
D 

Effect Group Power 

Bone Femur < Tibia 0.031941 * 0.717627 Medium 25% 

Max Pore System 
Total Volume 

Interaction 
Contrast 

Comparison p-value Sig. Cohen's 
D 

Effect Group Power 

Bone Femur > Tibia 0.000369 *** 1.348645 Large 46% 

Max Pore System 
Total Length 

Interaction 
Contrast Comparison p-value Sig. 

Cohen's 
D 

Effect Group Power 

Bone Femur > Tibia 0.017456 * 0.807687 Large 47% 

Bone | Group Femur Control > Fentanyl 0.084335 . 0.985105 Large 52% 

Bone | Group Femur Control > Morphine 0.341606 0.534829 Medium 

Bone | Group Femur Fentanyl < Morphine 0.422481 0.450276 Medium 

Bone | Group Tibia Control > Fentanyl 0.92094 0.055466 Small 

Bone | Group Tibia Control < Morphine 0.716695 0.202972 Medium 

Bone | Group Tibia Fentanyl < Morphine 0.644239 0.258438 Medium 

Group | Bone Control Femur > Tibia 0.031323 * 1.295815 Large 

Group | Bone Fentanyl Femur > Tibia 0.517715 0.366176 Medium 

Group | Bone Morphine Femur > Tibia 0.327975 0.558014 Medium 

Max Pore System 
Number of Nodes 

Interaction 
Contrast 

Comparison p-value Sig. 
Cohen's 

D 
Effect Group Power 

Bone Femur > Tibia 0.02206 * 0.773177 Medium 44% 

Bone | Group Femur Control > Fentanyl 0.095758 . 0.945244 Large 38% 

Bone | Group Femur Control > Morphine 0.286483 0.597842 Medium 

Bone | Group Femur Fentanyl < Morphine 0.533518 0.347402 Medium 
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Bone | Group Tibia Control > Fentanyl 0.962482 0.026174 Small 

Bone | Group Tibia Control < Morphine 0.582185 0.306796 Medium 

Bone | Group Tibia Fentanyl < Morphine 0.550567 0.33297 Medium 

Group | Bone Control Femur > Tibia 0.030085 * 1.301206 Large 

Group | Bone Fentanyl Femur > Tibia 0.498041 0.382136 Medium 

Group | Bone Morphine Femur > Tibia 0.482171 0.396568 Medium 

Max Pore System 
Termil Nodes 

Interaction 
Contrast Comparison p-value Sig. 

Cohen's 
D 

Effect Group Power 

Bone Femur > Tibia 0.015082 * 0.829026 Large 40% 

Bone | Group Femur Control > Fentanyl 0.087546 . 0.980888 Large 42% 

Bone | Group Femur Control > Morphine 0.304631 0.581629 Medium 

Bone | Group Femur Fentanyl < Morphine 0.479299 0.399259 Medium 

Bone | Group Tibia Control > Fentanyl 0.961649 0.027043 Small 

Bone | Group Tibia Control < Morphine 0.596565 0.298289 Medium 

Bone | Group Tibia Fentanyl < Morphine 0.563857 0.325332 Medium 

Group | Bone Control Femur > Tibia 0.027807 * 1.33666 Large 

Group | Bone Fentanyl Femur > Tibia 0.501806 0.382815 Medium 

Group | Bone Morphine Femur > Tibia 0.424168 0.456742 Medium 

Max Pore System 
Branching Nodes 

Interaction 
Contrast 

Comparison p-value Sig. 
Cohen's 

D 
Effect Group Power 

Bone Femur > Tibia 0.028917 * 0.732685 Medium 35% 

Min Pore System 
Total Length 

Interaction 
Contrast Comparison p-value Sig. 

Cohen's 
D 

Effect Group Power 

Bone Femur > Tibia 0.040481 * 0.681317 Medium 68% 

Bone | Group Femur Control < Fentanyl 0.089226 . 0.977197 Large 49% 

Bone | Group Femur Control < Morphine 0.003851 ** 1.729126 Large 

Bone | Group Femur Fentanyl < Morphine 0.187328 0.751929 Medium 

Bone | Group Tibia Control < Fentanyl 0.937998 0.043817 Small 

Bone | Group Tibia Control > Morphine 0.640017 0.263838 Medium 

Bone | Group Tibia Fentanyl > Morphine 0.585725 0.307655 Medium 

Group | Bone Control Femur < Tibia 0.531914 0.34029 Medium 

Group | Bone Fentanyl Femur > Tibia 0.281251 0.59309 Medium 

Group | Bone Morphine Femur > Tibia 0.006241 ** 1.652674 Large 

Aggregate Porosity: All Directional Trends 

Cortical Fractal Trends 

Bone Tibia > Femur 

Group Fentanyl > Control > Morphine 

Region | Group Femur Control > Fentanyl > Morphine 

Region | Group Tibia Fentanyl > Morphine > Control 

Group | Bone Control Femur > Tibia 

Group | Bone Fentanyl Tibia > Femur 
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Group | Bone Morphine Tibia > Femur 

Number Closed Pores Trends 

Bone Tibia > Femur 

Group Fentanyl > Morphine > Control 

Region | Group Femur Fentanyl > Control > Morphine 

Region | Group Tibia Fentanyl > Morphine > Control 

Group | Bone Control Tibia > Femur 

Group | Bone Fentanyl Tibia > Femur 

Group | Bone Morphine Tibia > Femur 

Number Open Pores Trends 

Bone Femur > Tibia 

Group Fentanyl > Morphine > Control 

Region | Group Femur Fentanyl > Morphine > Control 

Region | Group Tibia Fentanyl > Morphine > Control 

Group | Bone Control Femur > Tibia 

Group | Bone Fentanyl Tibia > Femur 

Group | Bone Morphine Femur > Tibia 

Closed Pore Density Trends 

Bone Tibia > Femur 

Group Fentanyl > Morphine > Control 

Region | Group Femur Fentanyl > Control > Morphine 

Region | Group Tibia Fentanyl > Morphine > Control 

Group | Bone Control Tibia > Femur 

Group | Bone Fentanyl Tibia > Femur 

Group | Bone Morphine Tibia > Femur 

Open Pore Density Trends 

Bone Femur > Tibia 

Group Fentanyl > Control > Morphine 

Region | Group Femur Control > Morphine > Fentanyl 

Region | Group Tibia Fentanyl > Control > Morphine 

Group | Bone Control Femur > Tibia 

Group | Bone Fentanyl Femur > Tibia 

Group | Bone Morphine Femur > Tibia 

Closed Porosity (%) Trends 

Bone Tibia > Femur 

Group Morphine > Fentanyl > Control 

Region | Group Femur Fentanyl > Control > Morphine 

Region | Group Tibia Morphine > Fentanyl > Control 

Group | Bone Control Tibia > Femur 

Group | Bone Fentanyl Tibia > Femur 

Group | Bone Morphine Tibia > Femur 
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Open Porosity (%) Trends 

Bone Femur > Tibia 

Group Control > Morphine > Fentanyl 

Region | Group Femur Control > Morphine > Fentanyl 

Region | Group Tibia Morphine > Control > Fentanyl 

Group | Bone Control Femur > Tibia 

Group | Bone Fentanyl Femur > Tibia 

Group | Bone Morphine Femur > Tibia 

Total Porosity (%) Trends 

Bone Femur > Tibia 

Group Control > Morphine > Fentanyl 

Region | Group Femur Control > Morphine > Fentanyl 

Region | Group Tibia Morphine > Fentanyl > Control 

Group | Bone Control Femur > Tibia 

Group | Bone Fentanyl Femur > Tibia 

Group | Bone Morphine Femur > Tibia 

Cortical Volume Trends 

Bone Tibia > Femur 

Group Morphine > Fentanyl > Control 

Region | Group Femur Fentanyl > Morphine > Control 

Region | Group Tibia Morphine > Fentanyl > Control 

Group | Bone Control Femur > Tibia 

Group | Bone Fentanyl Tibia > Femur 

Group | Bone Morphine Tibia > Femur 

Pore Volume Trends 

Bone Femur > Tibia 

Group Control > Morphine > Fentanyl 

Region | Group Femur Control > Morphine > Fentanyl 

Region | Group Tibia Morphine > Fentanyl > Control 

Group | Bone Control Femur > Tibia 

Group | Bone Fentanyl Tibia > Femur 

Group | Bone Morphine Tibia > Femur 

Cortical Surface Trends 

Bone Tibia > Femur 

Group Morphine > Fentanyl > Control 

Region | Group Femur Morphine > Control > Fentanyl 

Region | Group Tibia Morphine > Fentanyl > Control 

Group | Bone Control Tibia > Femur 

Group | Bone Fentanyl Tibia > Femur 

Group | Bone Morphine Tibia > Femur 

Pore Surface Trends 
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Bone Tibia > Femur 

Group Morphine > Control > Fentanyl 

Region | Group Femur Control > Fentanyl > Morphine 

Region | Group Tibia Morphine > Fentanyl > Control 

Group | Bone Control Femur > Tibia 

Group | Bone Fentanyl Tibia > Femur 

Group | Bone Morphine Tibia > Femur 

Intersection Surface Trends 

Bone Femur > Tibia 

Group Control > Morphine > Fentanyl 

Region | Group Femur Control > Morphine > Fentanyl 

Region | Group Tibia Fentanyl > Control > Morphine 

Group | Bone Control Femur > Tibia 

Group | Bone Fentanyl Femur > Tibia 

Group | Bone Morphine Femur > Tibia 

Pore Surface: PoreVolume Trends 

Bone Tibia > Femur 

Group Fentanyl > Morphine > Control 

Region | Group Femur Fentanyl > Morphine > Control 

Region | Group Tibia Fentanyl > Morphine > Control 

Group | Bone Control Tibia > Femur 

Group | Bone Fentanyl Tibia > Femur 

Group | Bone Morphine Tibia > Femur 

Pore Surface: Cortical Volume Trends 

Bone Tibia > Femur 

Group Control > Fentanyl > Morphine 

Region | Group Femur Control > Fentanyl > Morphine 

Region | Group Tibia Morphine > Fentanyl > Control 

Group | Bone Control Femur > Tibia 

Group | Bone Fentanyl Tibia > Femur 

Group | Bone Morphine Tibia > Femur 

Pore Thickness Trends 

Bone Femur > Tibia 

Group Control > Morphine > Fentanyl 

Region | Group Femur Control > Morphine > Fentanyl 

Region | Group Tibia Control > Morphine > Fentanyl 

Group | Bone Control Femur > Tibia 

Group | Bone Fentanyl Femur > Tibia 

Group | Bone Morphine Femur > Tibia 

Pore Separation Trends 

Bone Femur > Tibia 
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Group Morphine > Control > Fentanyl 

Region | Group Femur Morphine > Fentanyl > Control 

Region | Group Tibia Control > Morphine > Fentanyl 

Group | Bone Control Femur > Tibia 

Group | Bone Fentanyl Femur > Tibia 

Group | Bone Morphine Femur > Tibia 

Pore Tb.N Trends 

Bone Tibia > Femur 

Group Fentanyl > Morphine > Control 

Region | Group Femur Control > Fentanyl > Morphine 

Region | Group Tibia Fentanyl > Morphine > Control 

Group | Bone Control Tibia > Femur 

Group | Bone Fentanyl Tibia > Femur 

Group | Bone Morphine Tibia > Femur 

Degree of Anisotropy Trends 

Bone Tibia > Femur 

Group Morphine > Control > Fentanyl 

Region | Group Femur Morphine > Control > Fentanyl 

Region | Group Tibia Fentanyl > Control > Morphine 

Group | Bone Control Tibia > Femur 

Group | Bone Fentanyl Tibia > Femur 

Group | Bone Morphine Tibia > Femur 

Pore Fractal Trends 

Bone Tibia > Femur 

Group Fentanyl > Control > Morphine 

Region | Group Femur Control > Fentanyl > Morphine 

Region | Group Tibia Fentanyl > Morphine > Control 

Group | Bone Control Femur > Tibia 

Group | Bone Fentanyl Tibia > Femur 

Group | Bone Morphine Tibia > Femur 

Number of Pores Trends 

Bone Tibia > Femur 

Group Fentanyl > Morphine > Control 

Region | Group Femur Fentanyl > Morphine > Control 

Region | Group Tibia Fentanyl > Morphine > Control 

Group | Bone Control Tibia > Femur 

Group | Bone Fentanyl Tibia > Femur 

Group | Bone Morphine Tibia > Femur 

Pore Density Trends 

Bone Tibia > Femur 

Group Fentanyl > Morphine > Control 
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Region | Group Femur Fentanyl > Control > Morphine 

Region | Group Tibia Fentanyl > Morphine > Control 

Group | Bone Control Tibia > Femur 

Group | Bone Fentanyl Tibia > Femur 

Group | Bone Morphine Tibia > Femur 

Euler number Trends 

Bone Tibia > Femur 

Group Fentanyl > Morphine > Control 

Region | Group Femur Fentanyl > Morphine > Control 

Region | Group Tibia Fentanyl > Morphine > Control 

Group | Bone Control Tibia > Femur 

Group | Bone Fentanyl Tibia > Femur 

Group | Bone Morphine Tibia > Femur 

Connectivity Trends 

Bone Tibia > Femur 

Group Fentanyl > Morphine > Control 

Region | Group Femur Control > Fentanyl > Morphine 

Region | Group Tibia Morphine > Fentanyl > Control 

Group | Bone Control Femur > Tibia 

Group | Bone Fentanyl Tibia > Femur 

Group | Bone Morphine Tibia > Femur 

Connectivity density Trends 

Bone Tibia > Femur 

Group Fentanyl > Morphine > Control 

Region | Group Femur Control > Fentanyl > Morphine 

Region | Group Tibia Morphine > Fentanyl > Control 

Group | Bone Control Femur > Tibia 

Group | Bone Fentanyl Tibia > Femur 

Group | Bone Morphine Tibia > Femur 

SD Pore Thickness Trends 

Bone Femur > Tibia 

Group Control > Morphine > Fentanyl 

Region | Group Femur Control > Morphine > Fentanyl 

Region | Group Tibia Control > Morphine > Fentanyl 

Group | Bone Control Femur > Tibia 
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Appendix XXII: Micro-CT Linear Mixed Model for Femoral Regions 

Femoral Regions: LMM Fixed Effects and Random Effects 

Cortical Fractal Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.189 -0.387 0.343 0 1 0.976 

Region1 -0.544 0.073 -0.703 -0.4 -7.45 0 *** 0.000175 *** 

Region2 -0.206 0.073 -0.35 -0.0559 -2.83 0.00658 ** 0.00596 ** 

Region3 0.649 0.073 0.502 0.797 8.89 0 *** 0.000175 *** 

Group1 0.277 0.267 -0.325 0.828 1.04 0.313 0.313 

Group2 -0.0295 0.267 -0.554 0.5 -0.111 0.913 0.904 

Region1:Group1 0.086 0.103 -0.105 0.288 0.833 0.409 0.392 

Region2:Group1 -0.251 0.103 -0.45 -0.0647 -2.43 0.0183 * 0.0165 * 

Region3:Group1 0.102 0.103 -0.095 0.311 0.989 0.327 0.335 

Region1:Group2 -0.0311 0.103 -0.242 0.17 -0.301 0.765 0.728 

Region2:Group2 0.119 0.103 -0.0841 0.327 1.15 0.256 0.243 

Region3:Group2 -0.0466 0.103 -0.235 0.15 -0.452 0.653 0.661 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.712 0.844 0.599 1.23 82.7 1.95E-17 *** R2M/R2C 0.227 / 0.866 

Residual 0.149 0.386 0.307 0.448 17.3 AIC/BIC 190 / 224 
Number Closed 

Pores 
Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.206 -0.361 0.371 0 1 0.978 

Region1 0.191 0.064 0.0669 0.311 2.98 0.00428 ** 0.00386 ** 

Region2 -0.485 0.064 -0.606 -0.348 -7.57 0 *** 0.000175 *** 

Region3 0.44 0.064 0.318 0.571 6.88 0 *** 0.000175 *** 

Group1 -0.107 0.292 -0.644 0.456 -0.367 0.718 0.715 

Group2 0.214 0.292 -0.395 0.699 0.734 0.473 0.499 

Region1:Group1 -0.0632 0.0905 -0.249 0.0987 -0.699 0.488 0.487 

Region2:Group1 0.017 0.0905 -0.149 0.197 0.188 0.851 0.836 

Region3:Group1 -0.0219 0.0905 -0.188 0.162 -0.242 0.81 0.793 

Region1:Group2 0.0393 0.0905 -0.146 0.218 0.434 0.666 0.666 

Region2:Group2 -0.0391 0.0905 -0.232 0.125 -0.432 0.667 0.676 

Region3:Group2 0.12 0.0905 -0.0579 0.298 1.32 0.191 0.178 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.864 0.93 0.658 1.35 88.3 6.71E-22 *** R2M/R2C 0.133 / 0.899 

Residual 0.115 0.339 0.27 0.395 11.7 AIC/BIC 179 / 213 
Number Open 

Pores 
Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 
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(Intercept) 0 0.209 -0.434 0.433 0 1 0.989 

Region1 -0.198 0.0755 -0.337 -0.0465 -2.62 0.0114 * 0.0123 * 

Region2 -0.344 0.0755 -0.48 -0.209 -4.55 3.11E-05 *** 0.000175 *** 

Region3 0.117 0.0755 -0.0382 0.276 1.55 0.127 0.137 

Group1 -0.0102 0.296 -0.601 0.568 -0.0345 0.973 0.972 

Group2 0.0767 0.296 -0.512 0.708 0.259 0.798 0.803 

Region1:Group1 -0.0104 0.107 -0.211 0.206 -0.0974 0.923 0.942 

Region2:Group1 -0.0857 0.107 -0.281 0.11 -0.802 0.426 0.42 

Region3:Group1 0.0757 0.107 -0.134 0.29 0.708 0.482 0.465 

Region1:Group2 -0.137 0.107 -0.349 0.0645 -1.28 0.205 0.205 

Region2:Group2 0.0844 0.107 -0.117 0.273 0.79 0.433 0.452 

Region3:Group2 0.041 0.107 -0.152 0.282 0.384 0.703 0.707 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.879 0.938 0.648 1.4 84.6 8.69E-19 *** R2M/R2C 0.0868 / 0.86 

Residual 0.16 0.4 0.311 0.463 15.4 AIC/BIC 197 / 231 
Closed Pore 

Density 
Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.205 -0.403 0.417 0 1 0.988 

Region1 -0.15 0.0506 -0.253 -0.048 -2.96 0.00457 ** 0.00526 ** 

Region2 -0.031 0.0506 -0.13 0.066 -0.613 0.542 0.528 

Region3 0.494 0.0506 0.398 0.586 9.77 0 *** 0.000175 *** 

Group1 -0.357 0.289 -0.933 0.204 -1.23 0.233 0.259 

Group2 0.375 0.289 -0.201 0.902 1.3 0.212 0.232 

Region1:Group1 -0.00731 0.0715 -0.149 0.136 -0.102 0.919 0.911 

Region2:Group1 0.00537 0.0715 -0.137 0.154 0.0751 0.94 0.926 

Region3:Group1 -0.0624 0.0715 -0.194 0.0932 -0.872 0.387 0.393 

Region1:Group2 -0.0417 0.0715 -0.183 0.0894 -0.583 0.563 0.561 

Region2:Group2 0.00396 0.0715 -0.127 0.139 0.0553 0.956 0.949 

Region3:Group2 0.177 0.0715 0.0259 0.328 2.47 0.0167 * 0.0144 * 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.862 0.928 0.676 1.33 92.3 8.92E-27 *** R2M/R2C 0.169 / 0.936 

Residual 0.0716 0.268 0.21 0.312 7.67 AIC/BIC 153 / 187 

Open Pore Density Lambda = 1.675 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.2 -0.412 0.37 0 1 0.989 

Region1 -0.483 0.0757 -0.628 -0.334 -6.39 0 *** 0.000175 *** 

Region2 0.236 0.0757 0.0888 0.391 3.11 0.00295 ** 0.00421 ** 

Region3 0.381 0.0757 0.217 0.534 5.04 5.6E-06 *** 0.000175 *** 

Group1 -0.247 0.283 -0.821 0.262 -0.875 0.393 0.413 

288 
2018-DU-BX-0188 Final Technical Report 
October 2021 

This resource was prepared by the author(s) using Federal funds provided by the U.S. 
Department of Justice. Opinions or points of view expressed are those of the author(s) and do not 

necessarily reflect the official position or policies of the U.S. Department of Justice.



 
 

          

          

          

          

          

          

          

      
 

  
 

 

         

        
  

    

           

          

          

          

          

          

          

          

          

          

          

          

          

      
 

  
 

 

         

         

      

           

          

          

          

          

          

          

          

          

          

          

Group2 0.258 0.283 -0.272 0.836 0.912 0.374 0.394 

Region1:Group1 0.09 0.107 -0.0954 0.305 0.841 0.404 0.407 

Region2:Group1 -0.125 0.107 -0.336 0.0753 -1.17 0.247 0.239 

Region3:Group1 0.0785 0.107 -0.138 0.275 0.733 0.467 0.468 

Region1:Group2 -0.169 0.107 -0.385 0.0204 -1.58 0.119 0.105 

Region2:Group2 0.104 0.107 -0.125 0.312 0.972 0.335 0.316 

Region3:Group2 0.0912 0.107 -0.123 0.332 0.852 0.398 0.396 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) 

p-value Sig. 
Model 
Test 

Model Fit 

Sample 0.799 0.894 0.638 1.27 83.3 7.62E-18 *** R2M/R2C 0.149 / 0.858 

Residual 0.16 0.4 0.316 0.459 16.7 AIC/BIC 158 / 192 
Closed Porosity 

(%) Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.181 -0.349 0.399 0 1 0.977 

Region1 -0.537 0.0998 -0.737 -0.344 -5.37 1.7E-06 *** 0.000175 *** 

Region2 -0.0338 0.0998 -0.226 0.166 -0.338 0.736 0.739 

Region3 0.692 0.0998 0.499 0.884 6.93 0 *** 0.000175 *** 

Group1 -0.01 0.256 -0.476 0.586 -0.0391 0.969 0.971 

Group2 0.0975 0.256 -0.413 0.552 0.381 0.708 0.735 

Region1:Group1 -0.0379 0.141 -0.339 0.276 -0.268 0.79 0.788 

Region2:Group1 -0.0232 0.141 -0.313 0.294 -0.165 0.87 0.866 

Region3:Group1 0.146 0.141 -0.143 0.408 1.03 0.306 0.307 

Region1:Group2 -0.029 0.141 -0.335 0.227 -0.205 0.838 0.844 

Region2:Group2 -0.105 0.141 -0.333 0.215 -0.745 0.459 0.474 

Region3:Group2 0.182 0.141 -0.108 0.449 1.29 0.204 0.193 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.617 0.786 0.512 1.15 68.9 5.95E-11 *** R2M/R2C 0.199 / 0.751 

Residual 0.279 0.528 0.42 0.612 31.1 AIC/BIC 222 / 256 

Open Porosity (%) Lambda = 0.125 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.149 -0.289 0.313 0 1 0.973 

Region1 -0.287 0.102 -0.477 -0.0733 -2.81 0.00691 ** 0.00772 ** 

Region2 -0.522 0.102 -0.721 -0.311 -5.1 4.4E-06 *** 0.000175 *** 

Region3 0.478 0.102 0.257 0.679 4.68 1.96E-05 *** 0.000175 *** 

Group1 0.579 0.211 0.192 0.998 2.75 0.0132 * 0.0144 * 

Group2 -0.353 0.211 -0.763 0.0425 -1.67 0.112 0.11 

Region1:Group1 0.38 0.145 0.0923 0.652 2.63 0.0111 * 0.0119 * 

Region2:Group1 -0.428 0.145 -0.716 -0.146 -2.96 0.00456 ** 0.00842 ** 

Region3:Group1 0.0477 0.145 -0.269 0.307 0.33 0.743 0.753 

Region1:Group2 -0.104 0.145 -0.404 0.193 -0.717 0.476 0.474 
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Region2:Group2 0.296 0.145 0.0236 0.548 2.05 0.0456 * 0.0495 * 

Region3:Group2 -0.29 0.145 -0.54 -0.00811 -2.01 0.0496 * 0.053 . 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.393 0.627 0.41 0.93 57.4 1.21E-07 *** R2M/R2C 0.372 / 0.732 

Residual 0.292 0.541 0.428 0.631 42.6 AIC/BIC 229 / 263 

Total Porosity (%) Lambda = 0.15 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.157 -0.288 0.318 0 1 0.993 

Region1 -0.329 0.0972 -0.511 -0.136 -3.38 0.00133 ** 0.000702 *** 

Region2 -0.498 0.0972 -0.681 -0.306 -5.13 4.1E-06 *** 0.000175 *** 

Region3 0.557 0.0972 0.364 0.741 5.73 5E-07 *** 0.000175 *** 

Group1 0.537 0.222 0.0282 0.977 2.42 0.0262 * 0.033 * 

Group2 -0.312 0.222 -0.759 0.108 -1.41 0.176 0.177 

Region1:Group1 0.353 0.137 0.0993 0.611 2.57 0.013 * 0.0112 * 

Region2:Group1 -0.429 0.137 -0.708 -0.16 -3.12 0.00291 ** 0.00351 ** 

Region3:Group1 0.0714 0.137 -0.193 0.327 0.519 0.606 0.606 

Region1:Group2 -0.119 0.137 -0.4 0.124 -0.865 0.391 0.386 

Region2:Group2 0.263 0.137 0.00255 0.536 1.91 0.0613 . 0.0618 . 

Region3:Group2 -0.208 0.137 -0.429 0.0327 -1.51 0.137 0.146 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.449 0.67 0.455 0.986 62.9 4.27E-09 *** R2M/R2C 0.348 / 0.758 

Residual 0.265 0.514 0.413 0.588 37.1 AIC/BIC 224 / 258 

Cortical Volume Lambda = -2.475 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.173 -0.331 0.317 0 1 0.993 

Region1 0.569 0.0764 0.417 0.73 7.45 0 *** 0.000175 *** 

Region2 -0.775 0.0764 -0.945 -0.627 -10.1 0 *** 0.000175 *** 

Region3 -0.313 0.0764 -0.45 -0.161 -4.09 0.000145 *** 0.000175 *** 

Group1 0.138 0.245 -0.311 0.595 0.564 0.58 0.592 

Group2 -0.171 0.245 -0.665 0.313 -0.698 0.494 0.51 

Region1:Group1 -0.0152 0.108 -0.245 0.202 -0.14 0.889 0.9 

Region2:Group1 -0.0466 0.108 -0.27 0.166 -0.431 0.668 0.665 

Region3:Group1 0.0399 0.108 -0.169 0.247 0.369 0.713 0.713 

Region1:Group2 0.0627 0.108 -0.138 0.29 0.58 0.564 0.565 

Region2:Group2 0.000676 0.108 -0.2 0.226 0.00625 0.995 0.996 

Region3:Group2 -0.145 0.108 -0.364 0.0732 -1.34 0.186 0.18 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.587 0.766 0.554 1.11 78.2 7.21E-15 *** R2M/R2C 0.317 / 0.851 

Residual 0.164 0.404 0.32 0.467 21.8 AIC/BIC 112 / 146 
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Pore Volume Lambda = -0.7 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.186 -0.388 0.362 0 1 0.995 

Region1 -0.0886 0.0791 -0.246 0.0615 -1.12 0.268 0.266 

Region2 -0.517 0.0791 -0.679 -0.384 -6.53 0 *** 0.000175 *** 

Region3 0.268 0.0791 0.118 0.426 3.39 0.00132 ** 0.000702 *** 

Group1 0.48 0.263 0.0096 0.999 1.82 0.0851 . 0.0933 . 

Group2 -0.298 0.263 -0.853 0.179 -1.13 0.273 0.301 

Region1:Group1 0.217 0.112 -0.00953 0.434 1.94 0.0572 . 0.0646 . 

Region2:Group1 -0.219 0.112 -0.458 0.00602 -1.95 0.0559 . 0.0586 . 

Region3:Group1 0.0149 0.112 -0.23 0.225 0.133 0.894 0.878 

Region1:Group2 -0.0147 0.112 -0.233 0.201 -0.132 0.896 0.888 

Region2:Group2 0.119 0.112 -0.107 0.363 1.07 0.291 0.286 

Region3:Group2 -0.17 0.112 -0.411 0.0405 -1.52 0.135 0.139 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.685 0.828 0.604 1.15 79.6 1.28E-15 *** R2M/R2C 0.228 / 0.843 

Residual 0.175 0.419 0.336 0.488 20.4 AIC/BIC 204 / 238 

Cortical Surface Lambda = -5.525 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.17 -0.361 0.364 0 1 0.991 

Region1 0.394 0.0797 0.244 0.541 4.94 7.9E-06 *** 0.000175 *** 

Region2 -0.624 0.0797 -0.792 -0.475 -7.83 0 *** 0.000175 *** 

Region3 -0.48 0.0797 -0.628 -0.312 -6.02 2E-07 *** 0.000175 *** 

Group1 0.198 0.24 -0.332 0.673 0.826 0.419 0.431 

Group2 -0.213 0.24 -0.654 0.271 -0.888 0.386 0.393 

Region1:Group1 0.0204 0.113 -0.187 0.272 0.181 0.857 0.841 

Region2:Group1 0.0423 0.113 -0.177 0.251 0.375 0.709 0.708 

Region3:Group1 -0.0097 0.113 -0.229 0.22 -0.086 0.932 0.909 

Region1:Group2 0.0934 0.113 -0.13 0.33 0.828 0.411 0.397 

Region2:Group2 -0.136 0.113 -0.359 0.0495 -1.21 0.232 0.239 

Region3:Group2 -0.0578 0.113 -0.273 0.165 -0.513 0.61 0.59 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.561 0.749 0.536 1.08 75.9 9.35E-14 *** R2M/R2C 0.327 / 0.838 

Residual 0.178 0.422 0.335 0.497 24.1 AIC/BIC 49.6 / 83.6 

Pore Surface Lambda = -0.875 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.204 -0.417 0.394 0 1 0.981 

Region1 -0.0802 0.0689 -0.216 0.058 -1.16 0.249 0.233 

Region2 -0.421 0.0689 -0.541 -0.291 -6.11 1E-07 *** 0.000175 *** 

Region3 0.22 0.0689 0.0782 0.362 3.19 0.00237 ** 0.0014 ** 
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Group1 0.37 0.288 -0.201 0.913 1.29 0.215 0.232 

Group2 -0.209 0.288 -0.786 0.329 -0.727 0.476 0.488 

Region1:Group1 0.155 0.0974 -0.0308 0.332 1.59 0.117 0.111 

Region2:Group1 -0.191 0.0974 -0.39 -0.00122 -1.96 0.0554 . 0.0502 . 

Region3:Group1 0.0138 0.0974 -0.15 0.229 0.141 0.888 0.887 

Region1:Group2 -0.0284 0.0974 -0.217 0.156 -0.292 0.771 0.774 

Region2:Group2 0.0933 0.0974 -0.105 0.298 0.958 0.342 0.35 

Region3:Group2 -0.098 0.0974 -0.309 0.0875 -1.01 0.319 0.319 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.837 0.915 0.639 1.32 86.3 4.12E-20 *** R2M/R2C 0.14 / 0.882 

Residual 0.133 0.364 0.286 0.419 13.7 AIC/BIC 124 / 158 
Intersection 

Surface 
Lambda = -1 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.18 -0.37 0.374 0 1 0.993 

Region1 -0.196 0.08 -0.365 -0.0245 -2.45 0.0177 * 0.0158 * 

Region2 -0.0195 0.08 -0.172 0.147 -0.243 0.809 0.807 

Region3 0.0259 0.08 -0.136 0.169 0.324 0.747 0.744 

Group1 0.636 0.255 0.184 1.11 2.49 0.0226 * 0.0274 * 

Group2 -0.551 0.255 -1.07 -0.101 -2.16 0.0443 * 0.046 * 

Region1:Group1 0.192 0.113 -0.018 0.412 1.69 0.0961 . 0.0947 . 

Region2:Group1 -0.245 0.113 -0.433 -0.0319 -2.17 0.0345 * 0.0295 * 

Region3:Group1 0.102 0.113 -0.105 0.324 0.901 0.371 0.348 

Region1:Group2 -0.22 0.113 -0.446 0.0306 -1.94 0.0575 . 0.0593 . 

Region2:Group2 0.257 0.113 0.0325 0.461 2.27 0.0273 * 0.0309 * 

Region3:Group2 -0.233 0.113 -0.439 -0.0164 -2.06 0.0445 * 0.0432 * 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.639 0.799 0.519 1.17 78.1 8.38E-15 *** R2M/R2C 0.262 / 0.838 

Residual 0.179 0.423 0.335 0.494 21.9 AIC/BIC 86.1 / 120 
Pore Surface: 
PoreVolume 

Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.192 -0.39 0.397 0 1 0.981 

Region1 0.0231 0.0528 -0.0794 0.126 0.437 0.664 0.651 

Region2 0.349 0.0528 0.241 0.444 6.6 0 *** 0.000175 *** 

Region3 -0.148 0.0528 -0.256 -0.0379 -2.81 0.00694 ** 0.00842 ** 

Group1 -0.603 0.271 -1.14 -0.107 -2.22 0.0394 * 0.034 * 

Group2 0.526 0.271 -0.084 1.03 1.94 0.0684 . 0.0695 . 

Region1:Group1 -0.157 0.0747 -0.295 -0.00311 -2.11 0.0399 * 0.0393 * 

Region2:Group1 0.134 0.0747 -0.0229 0.27 1.79 0.0792 . 0.0842 . 

Region3:Group1 -0.0113 0.0747 -0.141 0.14 -0.151 0.881 0.891 
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Region1:Group2 0.000198 0.0747 -0.16 0.16 0.00265 0.998 0.986 

Region2:Group2 -0.0953 0.0747 -0.25 0.0529 -1.28 0.208 0.21 

Region3:Group2 0.176 0.0747 0.0182 0.321 2.35 0.0223 * 0.0246 * 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.753 0.868 0.638 1.29 90.6 1.98E-24 *** R2M/R2C 0.251 / 0.93 

Residual 0.0781 0.28 0.223 0.325 9.4 AIC/BIC 155 / 189 
Pore Surface: 

Cortical Volume 
Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.212 -0.382 0.393 0 1 0.981 

Region1 -0.322 0.0628 -0.444 -0.198 -5.13 0.000004 *** 0.000175 *** 

Region2 -0.151 0.0628 -0.294 -0.0176 -2.41 0.0196 * 0.0204 * 

Region3 0.421 0.0628 0.303 0.542 6.7 0 *** 0.000175 *** 

Group1 -0.116 0.3 -0.714 0.498 -0.386 0.704 0.702 

Group2 0.223 0.3 -0.407 0.784 0.744 0.467 0.484 

Region1:Group1 0.0748 0.0888 -0.109 0.26 0.842 0.403 0.402 

Region2:Group1 -0.162 0.0888 -0.328 0.012 -1.82 0.074 . 0.0747 . 

Region3:Group1 0.0608 0.0888 -0.105 0.221 0.685 0.496 0.519 

Region1:Group2 -0.0831 0.0888 -0.229 0.0937 -0.935 0.354 0.35 

Region2:Group2 0.128 0.0888 -0.0497 0.303 1.44 0.157 0.144 

Region3:Group2 -0.0778 0.0888 -0.245 0.107 -0.876 0.385 0.402 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.917 0.958 0.687 1.38 89.3 6.89E-23 *** R2M/R2C 0.0958 / 0.903 

Residual 0.11 0.332 0.257 0.388 10.7 AIC/BIC 178 / 212 

Pore Thickness Lambda = -1.625 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.155 -0.324 0.286 0 1 0.993 

Region1 0.000935 0.0857 -0.169 0.182 0.0109 0.991 0.989 

Region2 -0.662 0.0857 -0.831 -0.486 -7.72 0 *** 0.000175 *** 

Region3 0.301 0.0857 0.135 0.477 3.52 0.000896 *** 0.00105 ** 

Group1 0.617 0.219 0.156 1.06 2.82 0.0113 * 0.0144 * 

Group2 -0.572 0.219 -1.04 -0.188 -2.61 0.0176 * 0.02 * 

Region1:Group1 0.228 0.121 -0.00446 0.474 1.88 0.0651 . 0.0667 . 

Region2:Group1 -0.0632 0.121 -0.309 0.187 -0.521 0.605 0.605 

Region3:Group1 -0.0662 0.121 -0.317 0.182 -0.546 0.587 0.587 

Region1:Group2 0.00632 0.121 -0.233 0.257 0.0521 0.959 0.941 

Region2:Group2 0.0509 0.121 -0.191 0.268 0.42 0.676 0.699 

Region3:Group2 -0.216 0.121 -0.489 0.0383 -1.78 0.081 . 0.0825 . 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) 

p-value Sig. 
Model 
Test 

Model Fit 

Sample 0.451 0.672 0.448 0.985 68.7 6.80E-11 *** R2M/R2C 0.395 / 0.811 
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Residual 0.206 0.454 0.359 0.526 31.3 AIC/BIC 200 / 234 

Pore Separation Lambda = -2.175 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.206 -0.387 0.363 0 1 0.994 

Region1 0.42 0.0688 0.292 0.558 6.11 1E-07 *** 0.000175 *** 

Region2 0.0393 0.0688 -0.0999 0.172 0.571 0.57 0.573 

Region3 -0.521 0.0688 -0.656 -0.388 -7.57 0 *** 0.000175 *** 

Group1 0.0781 0.292 -0.487 0.661 0.268 0.792 0.792 

Group2 -0.18 0.292 -0.783 0.335 -0.618 0.544 0.539 

Region1:Group1 0.0379 0.0973 -0.162 0.225 0.39 0.698 0.698 

Region2:Group1 0.0821 0.0973 -0.101 0.283 0.844 0.403 0.426 

Region3:Group1 -0.138 0.0973 -0.318 0.0516 -1.42 0.162 0.161 

Region1:Group2 0.0674 0.0973 -0.11 0.234 0.693 0.491 0.491 

Region2:Group2 -0.0344 0.0973 -0.233 0.154 -0.353 0.725 0.746 

Region3:Group2 -0.0653 0.0973 -0.257 0.128 -0.671 0.505 0.493 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.86 0.927 0.661 1.32 86.7 2.10E-20 *** R2M/R2C 0.123 / 0.883 

Residual 0.132 0.364 0.295 0.425 13.3 AIC/BIC 88.4 / 122 

Pore Tb.N Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.211 -0.424 0.428 0 1 0.999 

Region1 -0.347 0.0645 -0.487 -0.218 -5.38 1.6E-06 *** 0.000175 *** 

Region2 0.0579 0.0645 -0.0855 0.182 0.898 0.373 0.378 

Region3 0.283 0.0645 0.156 0.412 4.38 5.44E-05 *** 0.000175 *** 

Group1 -0.209 0.298 -0.825 0.341 -0.7 0.493 0.514 

Group2 0.336 0.298 -0.265 0.897 1.13 0.274 0.298 

Region1:Group1 0.0654 0.0913 -0.114 0.245 0.717 0.477 0.483 

Region2:Group1 -0.163 0.0913 -0.344 0.00695 -1.78 0.08 . 0.0754 . 

Region3:Group1 0.0694 0.0913 -0.116 0.253 0.761 0.45 0.444 

Region1:Group2 -0.0979 0.0913 -0.274 0.108 -1.07 0.288 0.308 

Region2:Group2 0.122 0.0913 -0.0449 0.292 1.34 0.187 0.192 

Region3:Group2 -0.0488 0.0913 -0.228 0.136 -0.535 0.595 0.601 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.903 0.95 0.662 1.35 88.6 3.59E-22 *** R2M/R2C 0.102 / 0.897 

Residual 0.117 0.341 0.273 0.397 11.4 AIC/BIC 180 / 214 
Degree of 

Anisotropy 
Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.162 -0.353 0.335 0 1 0.999 

Region1 -0.0695 0.0824 -0.214 0.0901 -0.843 0.403 0.382 
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Region2 -0.897 0.0824 -1.07 -0.735 -10.9 0 *** 0.000175 *** 

Region3 0.661 0.0824 0.502 0.846 8.01 0 *** 0.000175 *** 

Group1 0.103 0.229 -0.325 0.651 0.448 0.66 0.667 

Group2 -0.247 0.229 -0.713 0.174 -1.08 0.296 0.309 

Region1:Group1 0.31 0.117 0.076 0.533 2.66 0.0104 * 0.0119 * 

Region2:Group1 -0.207 0.117 -0.422 0.014 -1.77 0.0819 . 0.0884 . 

Region3:Group1 -0.109 0.117 -0.351 0.108 -0.933 0.355 0.371 

Region1:Group2 0.0347 0.117 -0.186 0.273 0.297 0.767 0.768 

Region2:Group2 0.0296 0.117 -0.189 0.268 0.254 0.8 0.807 

Region3:Group2 -0.0329 0.117 -0.258 0.199 -0.282 0.779 0.777 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.505 0.71 0.479 1.04 72.6 2.41E-12 *** R2M/R2C 0.364 / 0.826 

Residual 0.19 0.436 0.344 0.51 27.4 AIC/BIC 197 / 231 

Pore Fractal Lambda = 4.475 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.191 -0.356 0.375 0 1 0.987 

Region1 -0.341 0.0754 -0.5 -0.191 -4.52 3.42E-05 *** 0.000175 *** 

Region2 -0.377 0.0754 -0.527 -0.222 -5 6.4E-06 *** 0.000175 *** 

Region3 0.67 0.0754 0.518 0.815 8.88 0 *** 0.000175 *** 

Group1 0.286 0.27 -0.195 0.833 1.06 0.303 0.33 

Group2 -0.0734 0.27 -0.595 0.462 -0.272 0.788 0.815 

Region1:Group1 0.0922 0.107 -0.103 0.303 0.864 0.391 0.387 

Region2:Group1 -0.234 0.107 -0.465 0.00137 -2.2 0.0322 * 0.0347 * 

Region3:Group1 0.094 0.107 -0.147 0.284 0.881 0.382 0.394 

Region1:Group2 -0.0489 0.107 -0.272 0.161 -0.459 0.648 0.625 

Region2:Group2 0.138 0.107 -0.0778 0.343 1.3 0.201 0.201 

Region3:Group2 -0.0904 0.107 -0.271 0.165 -0.847 0.401 0.404 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.724 0.851 0.629 1.24 82 5.45E-17 *** R2M/R2C 0.209 / 0.857 

Residual 0.159 0.399 0.329 0.46 18 AIC/BIC 199 / 234 

Number of Pores Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.21 -0.506 0.394 0 1 0.997 

Region1 0.141 0.0598 0.016 0.257 2.35 0.0224 * 0.0253 * 

Region2 -0.477 0.0598 -0.585 -0.359 -7.97 0 *** 0.000175 *** 

Region3 0.405 0.0598 0.294 0.521 6.78 0 *** 0.000175 *** 

Group1 -0.096 0.297 -0.687 0.425 -0.323 0.751 0.761 

Group2 0.2 0.297 -0.391 0.831 0.672 0.51 0.511 

Region1:Group1 -0.0573 0.0846 -0.211 0.121 -0.678 0.501 0.473 

Region2:Group1 0.0029 0.0846 -0.158 0.157 0.0343 0.973 0.945 
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Region3:Group1 -0.00862 0.0846 -0.183 0.153 -0.102 0.919 0.916 

Region1:Group2 0.0153 0.0846 -0.161 0.17 0.181 0.857 0.828 

Region2:Group2 -0.0226 0.0846 -0.197 0.135 -0.267 0.79 0.773 

Region3:Group2 0.112 0.0846 -0.0288 0.286 1.32 0.192 0.187 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.903 0.95 0.677 1.4 90 9.63E-24 *** R2M/R2C 0.114 / 0.912 

Residual 0.1 0.316 0.248 0.364 9.98 AIC/BIC 172 / 206 

Pore Density Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.207 -0.426 0.383 0 1 0.988 

Region1 -0.188 0.0475 -0.278 -0.0928 -3.96 0.000222 *** 0.000351 *** 

Region2 0.00231 0.0475 -0.103 0.0945 0.0485 0.961 0.972 

Region3 0.465 0.0475 0.366 0.564 9.79 0 *** 0.000175 *** 

Group1 -0.354 0.293 -0.908 0.218 -1.21 0.242 0.274 

Group2 0.371 0.293 -0.214 0.926 1.27 0.221 0.243 

Region1:Group1 0.00536 0.0672 -0.129 0.144 0.0797 0.937 0.962 

Region2:Group1 -0.00926 0.0672 -0.142 0.127 -0.138 0.891 0.899 

Region3:Group1 -0.0449 0.0672 -0.169 0.0782 -0.668 0.507 0.528 

Region1:Group2 -0.0568 0.0672 -0.199 0.0652 -0.844 0.402 0.417 

Region2:Group2 0.014 0.0672 -0.119 0.157 0.208 0.836 0.842 

Region3:Group2 0.163 0.0672 0.049 0.29 2.42 0.019 * 0.0193 * 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.884 0.94 0.69 1.35 93.3 2.20E-28 *** R2M/R2C 0.158 / 0.944 

Residual 0.0633 0.252 0.198 0.289 6.68 AIC/BIC 147 / 181 

Euler number Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.205 -0.424 0.417 0 1 1 

Region1 0.231 0.0674 0.0935 0.367 3.42 0.00119 ** 0.000702 *** 

Region2 -0.403 0.0674 -0.54 -0.271 -5.98 2E-07 *** 0.000175 *** 

Region3 0.403 0.0674 0.269 0.541 5.98 2E-07 *** 0.000175 *** 

Group1 -0.202 0.29 -0.804 0.346 -0.699 0.494 0.512 

Group2 0.208 0.29 -0.353 0.791 0.72 0.481 0.494 

Region1:Group1 -0.0872 0.0953 -0.256 0.0837 -0.915 0.364 0.366 

Region2:Group1 0.0826 0.0953 -0.0907 0.27 0.867 0.39 0.383 

Region3:Group1 -0.0273 0.0953 -0.193 0.16 -0.286 0.776 0.785 

Region1:Group2 0.0823 0.0953 -0.119 0.262 0.864 0.392 0.407 

Region2:Group2 -0.0887 0.0953 -0.274 0.0976 -0.93 0.356 0.361 

Region3:Group2 0.213 0.0953 0.0195 0.388 2.23 0.0298 * 0.0316 * 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 
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Sample 0.849 0.921 0.673 1.26 87 1.11E-20 *** R2M/R2C 0.136 / 0.887 

Residual 0.127 0.357 0.283 0.425 13 AIC/BIC 184 / 218 

Connectivity Lambda = 0.25 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.216 -0.38 0.423 0 1 0.991 

Region1 -0.111 0.0652 -0.226 0.0121 -1.7 0.0947 . 0.0895 . 

Region2 -0.299 0.0652 -0.421 -0.169 -4.58 2.78E-05 *** 0.000175 *** 

Region3 0.145 0.0652 0.00796 0.269 2.23 0.0301 * 0.0358 * 

Group1 0.118 0.305 -0.517 0.73 0.386 0.704 0.705 

Group2 0.0325 0.305 -0.54 0.657 0.107 0.916 0.941 

Region1:Group1 0.0317 0.0922 -0.143 0.189 0.344 0.732 0.728 

Region2:Group1 -0.181 0.0922 -0.354 -0.0017 -1.96 0.0554 . 0.053 . 

Region3:Group1 0.0425 0.0922 -0.129 0.224 0.461 0.646 0.641 

Region1:Group2 -0.123 0.0922 -0.324 0.0537 -1.34 0.187 0.186 

Region2:Group2 0.125 0.0922 -0.0532 0.315 1.35 0.182 0.176 

Region3:Group2 -0.123 0.0922 -0.292 0.0463 -1.34 0.187 0.193 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.946 0.973 0.716 1.37 88.8 1.94E-22 *** R2M/R2C 0.0669 / 0.896 

Residual 0.119 0.345 0.275 0.4 11.2 AIC/BIC 201 / 235 
Connectivity 

density 
Lambda = 0.725 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.206 -0.412 0.441 0 1 0.996 

Region1 -0.259 0.0676 -0.396 -0.129 -3.84 0.000328 *** 0.000702 *** 

Region2 -0.00238 0.0676 -0.14 0.133 -0.0353 0.972 0.953 

Region3 0.174 0.0676 0.0461 0.313 2.57 0.0129 * 0.0144 * 

Group1 -0.415 0.291 -1.03 0.133 -1.43 0.171 0.187 

Group2 0.402 0.291 -0.194 0.986 1.38 0.185 0.191 

Region1:Group1 0.0785 0.0956 -0.103 0.257 0.821 0.415 0.395 

Region2:Group1 -0.105 0.0956 -0.29 0.08 -1.1 0.278 0.26 

Region3:Group1 0.00146 0.0956 -0.191 0.195 0.0153 0.988 0.983 

Region1:Group2 -0.103 0.0956 -0.287 0.078 -1.08 0.287 0.274 

Region2:Group2 0.129 0.0956 -0.0694 0.307 1.35 0.183 0.18 

Region3:Group2 -0.0467 0.0956 -0.248 0.138 -0.489 0.627 0.628 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) 

p-value Sig. 
Model 
Test 

Model Fit 

Sample 0.859 0.927 0.616 1.36 87 9.63E-21 *** R2M/R2C 0.127 / 0.887 

Residual 0.128 0.358 0.286 0.413 13 AIC/BIC 206 / 240 

SD Pore Thickness Lambda = -1.075 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.161 -0.318 0.323 0 1 0.993 
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Region1 0.0673 0.0923 -0.122 0.277 0.729 0.469 0.481 

Region2 -0.648 0.0923 -0.825 -0.466 -7.02 0 *** 0.000175 *** 

Region3 0.318 0.0923 0.142 0.486 3.45 0.00111 ** 0.00211 ** 

Group1 0.546 0.227 0.0701 1.03 2.4 0.0272 * 0.0302 * 

Group2 -0.575 0.227 -1.03 -0.105 -2.53 0.0209 * 0.0253 * 

Region1:Group1 0.128 0.131 -0.101 0.406 0.978 0.332 0.341 

Region2:Group1 0.0749 0.131 -0.195 0.305 0.574 0.569 0.57 

Region3:Group1 -0.112 0.131 -0.358 0.154 -0.857 0.395 0.403 

Region1:Group2 0.0301 0.131 -0.209 0.279 0.231 0.819 0.79 

Region2:Group2 -0.156 0.131 -0.407 0.112 -1.19 0.238 0.255 

Region3:Group2 -0.0141 0.131 -0.276 0.251 -0.108 0.914 0.891 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.482 0.694 0.495 1.02 66.9 2.70E-10 *** R2M/R2C 0.342 / 0.782 

Residual 0.239 0.489 0.4 0.559 33.1 AIC/BIC 206 / 240 
SD Pore 

Separation 
Lambda = -1.375 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.2 -0.396 0.391 0 1 1 

Region1 0.451 0.0852 0.29 0.625 5.29 2.3E-06 *** 0.000175 *** 

Region2 -0.0635 0.0852 -0.23 0.103 -0.745 0.46 0.437 

Region3 -0.399 0.0852 -0.564 -0.226 -4.68 1.95E-05 *** 0.000175 *** 

Group1 0.113 0.283 -0.495 0.705 0.4 0.694 0.723 

Group2 -0.222 0.283 -0.781 0.357 -0.785 0.443 0.451 

Region1:Group1 0.06 0.121 -0.197 0.314 0.498 0.621 0.631 

Region2:Group1 0.0533 0.121 -0.186 0.303 0.442 0.66 0.656 

Region3:Group1 -0.202 0.121 -0.436 0.045 -1.67 0.1 0.102 

Region1:Group2 0.077 0.121 -0.146 0.343 0.639 0.526 0.512 

Region2:Group2 0.0418 0.121 -0.177 0.29 0.347 0.73 0.766 

Region3:Group2 -0.145 0.121 -0.399 0.0842 -1.2 0.234 0.225 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.79 0.889 0.617 1.29 79.5 1.45E-15 *** R2M/R2C 0.122 / 0.82 

Residual 0.203 0.451 0.366 0.525 20.5 AIC/BIC 149 / 183 

Pore volume Lambda = -1.075 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.166 -0.353 0.31 0 1 0.999 

Region1 -0.272 0.0991 -0.487 -0.0952 -2.74 0.00825 ** 0.00912 ** 

Region2 -0.297 0.0991 -0.486 -0.104 -3 0.00413 ** 0.00596 ** 

Region3 0.143 0.0991 -0.0499 0.357 1.44 0.156 0.173 

Group1 0.59 0.235 0.089 1.05 2.51 0.0218 * 0.0239 * 

Group2 -0.373 0.235 -0.882 0.116 -1.59 0.13 0.14 
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Region1:Group1 0.37 0.14 0.0898 0.641 2.64 0.0108 * 0.0102 * 

Region2:Group1 -0.272 0.14 -0.566 0.0167 -1.94 0.0577 . 0.0519 . 

Region3:Group1 0.0115 0.14 -0.266 0.271 0.082 0.935 0.947 

Region1:Group2 -0.0985 0.14 -0.402 0.204 -0.703 0.485 0.485 

Region2:Group2 0.239 0.14 -0.0615 0.503 1.7 0.0943 . 0.0891 . 

Region3:Group2 -0.291 0.14 -0.567 0.00195 -2.08 0.0424 * 0.0474 * 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.511 0.715 0.517 1.08 65 1.04E-09 *** R2M/R2C 0.289 / 0.751 

Residual 0.275 0.524 0.415 0.615 35 AIC/BIC 208 / 242 

Pore surface Lambda = -1.725 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.172 -0.355 0.336 0 1 0.993 

Region1 -0.384 0.1 -0.585 -0.197 -3.84 0.000325 *** 0.000175 *** 

Region2 -0.111 0.1 -0.297 0.11 -1.11 0.271 0.276 

Region3 0.0595 0.1 -0.137 0.246 0.595 0.554 0.576 

Group1 0.543 0.243 0.0725 1.06 2.23 0.0385 * 0.0375 * 

Group2 -0.283 0.243 -0.765 0.2 -1.17 0.259 0.275 

Region1:Group1 0.38 0.141 0.123 0.654 2.69 0.00952 ** 0.00877 ** 

Region2:Group1 -0.282 0.141 -0.582 -0.00711 -1.99 0.0513 . 0.0568 . 

Region3:Group1 0.00438 0.141 -0.271 0.291 0.0309 0.975 0.976 

Region1:Group2 -0.138 0.141 -0.418 0.157 -0.978 0.333 0.32 

Region2:Group2 0.219 0.141 -0.0495 0.513 1.55 0.127 0.127 

Region3:Group2 -0.221 0.141 -0.512 0.0711 -1.56 0.124 0.135 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) 

p-value Sig. 
Model 
Test 

Model Fit 

Sample 0.551 0.742 0.493 1.09 66.3 4.15E-10 *** R2M/R2C 0.251 / 0.748 

Residual 0.28 0.529 0.424 0.612 33.7 AIC/BIC 167 / 201 
Avg. Pore 

Orientation theta 
Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.138 -0.248 0.28 0 1 0.999 

Region1 -0.0396 0.0809 -0.202 0.13 -0.489 0.627 0.606 

Region2 0.925 0.0809 0.768 1.08 11.4 0 *** 0.000175 *** 

Region3 -1.06 0.0809 -1.21 -0.894 -13.1 0 *** 0.000175 *** 

Group1 -0.038 0.196 -0.382 0.353 -0.194 0.848 0.839 

Group2 0.113 0.196 -0.261 0.488 0.576 0.571 0.578 

Region1:Group1 -0.152 0.114 -0.388 0.0638 -1.33 0.189 0.189 

Region2:Group1 0.0948 0.114 -0.12 0.311 0.829 0.411 0.408 

Region3:Group1 0.0701 0.114 -0.159 0.29 0.612 0.543 0.541 

Region1:Group2 -0.0794 0.114 -0.3 0.172 -0.694 0.491 0.5 

Region2:Group2 0.0721 0.114 -0.152 0.292 0.63 0.531 0.538 
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Region3:Group2 -0.165 0.114 -0.383 0.046 -1.44 0.156 0.163 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) 

p-value Sig. 
Model 
Test 

Model Fit 

Sample 0.356 0.596 0.406 0.865 66 5.18E-10 *** R2M/R2C 0.497 / 0.829 

Residual 0.183 0.428 0.343 0.494 34 AIC/BIC 190 / 224 
Avg. Pore 

Orientation phi Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.0448 -0.0822 0.0855 0 1 0.985 

Region1 -1.27 0.0662 -1.41 -1.14 -19.2 0 *** 0.000175 *** 

Region2 0.11 0.0662 -0.0206 0.231 1.67 0.101 0.0905 . 

Region3 -0.164 0.0662 -0.293 -0.0307 -2.47 0.0166 * 0.0151 * 

Group1 0.0269 0.0633 -0.0986 0.154 0.425 0.676 0.662 

Group2 -0.151 0.0633 -0.279 -0.0321 -2.38 0.0286 * 0.0298 * 

Region1:Group1 -0.0604 0.0936 -0.247 0.138 -0.645 0.522 0.519 

Region2:Group1 -0.00035 0.0936 -0.2 0.193 
-

0.00373 
0.997 0.997 

Region3:Group1 0.0414 0.0936 -0.135 0.25 0.442 0.66 0.677 

Region1:Group2 0.103 0.0936 -0.0936 0.292 1.1 0.277 0.274 

Region2:Group2 0.0219 0.0936 -0.16 0.207 0.234 0.816 0.823 

Region3:Group2 0.0122 0.0936 -0.157 0.195 0.13 0.897 0.894 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.0114 0.107 0 0.249 8.5 0.4 R2M/R2C 0.868 / 0.879 

Residual 0.123 0.35 0.284 0.403 91.5 AIC/BIC 127 / 161 
Avg. Pore Major 

diameter 
Lambda = -3.7 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.197 -0.404 0.38 0 1 0.999 

Region1 -0.38 0.082 -0.55 -0.209 -4.63 2.32E-05 *** 0.000175 *** 

Region2 0.0963 0.082 -0.0633 0.248 1.17 0.246 0.236 

Region3 -0.0395 0.082 -0.191 0.131 -0.482 0.632 0.638 

Group1 0.418 0.279 -0.134 0.996 1.5 0.151 0.167 

Group2 -0.196 0.279 -0.74 0.344 -0.703 0.491 0.527 

Region1:Group1 0.188 0.116 -0.0284 0.41 1.62 0.112 0.109 

Region2:Group1 -0.14 0.116 -0.357 0.0923 -1.21 0.232 0.247 

Region3:Group1 0.0132 0.116 -0.228 0.233 0.114 0.909 0.914 

Region1:Group2 -0.168 0.116 -0.416 0.0701 -1.45 0.153 0.154 

Region2:Group2 0.0518 0.116 -0.167 0.271 0.447 0.657 0.649 

Region3:Group2 0.159 0.116 -0.0566 0.387 1.37 0.177 0.16 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.77 0.878 0.665 1.25 80.4 5.02E-16 *** R2M/R2C 0.149 / 0.833 

Residual 0.188 0.434 0.34 0.511 19.6 AIC/BIC 168 / 202 
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Sphericity Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.136 -0.297 0.272 0 1 0.994 

Region1 0.894 0.107 0.67 1.1 8.36 0 *** 0.000175 *** 

Region2 -0.306 0.107 -0.504 -0.0789 -2.86 0.00598 ** 0.00632 ** 

Region3 0.172 0.107 -0.0452 0.379 1.61 0.113 0.111 

Group1 -0.0627 0.192 -0.43 0.292 -0.327 0.748 0.74 

Group2 -0.134 0.192 -0.483 0.239 -0.696 0.495 0.495 

Region1:Group1 0.277 0.151 0.00358 0.562 1.83 0.0726 . 0.0674 . 

Region2:Group1 -0.0196 0.151 -0.305 0.279 -0.129 0.898 0.896 

Region3:Group1 -0.0377 0.151 -0.3 0.241 -0.249 0.804 0.81 

Region1:Group2 0.248 0.151 -0.0435 0.527 1.64 0.107 0.103 

Region2:Group2 0.0064 0.151 -0.293 0.358 0.0423 0.966 0.978 

Region3:Group2 -0.0899 0.151 -0.387 0.225 -0.594 0.555 0.564 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.307 0.554 0.355 0.834 49 7.52E-06 *** R2M/R2C 0.421 / 0.704 

Residual 0.32 0.566 0.455 0.664 51 AIC/BIC 219 / 253 

Femoral Regions: Post-Hoc Tests for Significant Fixed Effects 

Cortical Fractal 
Interaction 

Contrast 
Comparison p-value Sig. Cohen's D 

Effect 
Group 

Power 

Region Anterior < Lateral 0.0319 * 0.874 Large 35% 

Region Anterior < Medial 0 *** 3.09 Large 

Region Anterior < Posterior 8.5E-06 *** 1.67 Large 

Region Lateral < Medial 0 *** 2.21 Large 

Region Lateral < Posterior 0.059 . 0.797 Medium 

Region Medial > Posterior 0.000152 *** 1.42 Large 

Region | Group Anterior Control > Fentanyl 0.402 1.1 Large 44% 

Region | Group Anterior Control > Morphine 0.193 1.72 Large 

Region | Group Anterior Fentanyl > Morphine 0.63 0.626 Medium 

Region | Group Lateral Control < Fentanyl 0.899 0.164 Small 

Region | Group Lateral Control > Morphine 0.779 0.364 Medium 

Region | Group Lateral Fentanyl > Morphine 0.685 0.528 Medium 

Region | Group Medial Control > Fentanyl 0.368 1.18 Large 

Region | Group Medial Control > Morphine 0.182 1.77 Large 

Region | Group Medial Fentanyl > Morphine 0.652 0.587 Medium 

Region | Group Posterior Control > Fentanyl 0.416 1.06 Large 

Region | Group Posterior Control > Morphine 0.231 1.58 Large 

Region | Group Posterior Fentanyl > Morphine 0.691 0.516 Medium 

Group | Region Control Anterior < Lateral 0.998 0.00127 Small 
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Group | Region Control Anterior < Medial 3E-07 *** 3.13 Large 

Group | Region Control Anterior < Posterior 0.0039 ** 1.61 Large 

Group | Region Control Lateral < Medial 3E-07 *** 3.13 Large 

Group | Region Control Lateral < Posterior 0.00392 ** 1.61 Large 

Group | Region Control Medial > Posterior 0.00634 ** 1.52 Large 

Group | Region Fentanyl Anterior < Lateral 0.0219 * 1.26 Large 

Group | Region Fentanyl Anterior < Medial 5E-07 *** 3.05 Large 

Group | Region Fentanyl Anterior < Posterior 0.00327 ** 1.65 Large 

Group | Region Fentanyl Lateral < Medial 0.00151 ** 1.79 Large 

Group | Region Fentanyl Lateral < Posterior 0.476 0.383 Medium 

Group | Region Fentanyl Medial > Posterior 0.0112 * 1.4 Large 

Group | Region Morphine Anterior < Lateral 0.0139 * 1.36 Large 

Group | Region Morphine Anterior < Medial 4E-07 *** 3.09 Large 

Group | Region Morphine Anterior < Posterior 0.0018 ** 1.76 Large 

Group | Region Morphine Lateral < Medial 0.0021 ** 1.73 Large 

Group | Region Morphine Lateral < Posterior 0.462 0.396 Medium 

Group | Region Morphine Medial > Posterior 0.0158 * 1.33 Large 

Number Closed 
Pores 

Interaction 
Contrast Comparison p-value Sig. Cohen's D 

Effect 
Group 

Power 

Region Anterior > Lateral 2E-07 *** 1.99 Large 25% 

Region Anterior < Medial 0.0924 . 0.736 Medium 

Region Anterior > Posterior 0.0112 * 0.995 Large 

Region Lateral < Medial 0 *** 2.73 Large 

Region Lateral < Posterior 0.0108 * 0.999 Large 

Region Medial > Posterior 4.2E-06 *** 1.73 Large 

Number Open Pores 
Interaction 

Contrast 
Comparison p-value Sig. Cohen's D 

Effect 
Group 

Power 

Region Anterior > Lateral 0.641 0.365 Medium 27% 

Region Anterior < Medial 0.0629 . 0.788 Medium 

Region Anterior < Posterior 3.23E-05 *** 1.56 Large 

Region Lateral < Medial 0.00249 ** 1.15 Large 

Region Lateral < Posterior 4E-07 *** 1.92 Large 

Region Medial < Posterior 0.0733 . 0.768 Medium 

Closed Pore Density 
Interaction 

Contrast Comparison p-value Sig. Cohen's D 
Effect 
Group 

Power 

Region Anterior < Lateral 0.483 0.443 Medium 48% 

Region Anterior < Medial 0 *** 2.41 Large 

Region Anterior > Posterior 0.207 0.612 Medium 

Region Lateral < Medial 3E-07 *** 1.96 Large 

Region Lateral > Posterior 0.00639 ** 1.06 Large 

Region Medial > Posterior 0 *** 3.02 Large 

Region | Group Anterior Control < Fentanyl 0.191 2.61 Large 46% 
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Region | Group Anterior Control < Morphine 0.452 1.48 Large 

Region | Group Anterior Fentanyl > Morphine 0.565 1.13 Large 

Region | Group Lateral Control < Fentanyl 0.172 2.73 Large 

Region | Group Lateral Control < Morphine 0.536 1.21 Large 

Region | Group Lateral Fentanyl > Morphine 0.441 1.52 Large 

Region | Group Medial Control < Fentanyl 0.0744 . 3.63 Large 

Region | Group Medial Control < Morphine 0.583 1.08 Large 

Region | Group Medial Fentanyl > Morphine 0.2 2.55 Large 

Region | Group Posterior Control < Fentanyl 0.318 1.98 Large 

Region | Group Posterior Control < Morphine 0.505 1.31 Large 

Region | Group Posterior Fentanyl > Morphine 0.733 0.669 Medium 

Group | Region Control Anterior < Lateral 0.363 0.491 Medium 

Group | Region Control Anterior < Medial 0.000133 *** 2.2 Large 

Group | Region Control Anterior > Posterior 0.522 0.345 Medium 

Group | Region Control Lateral < Medial 0.00232 ** 1.71 Large 

Group | Region Control Lateral > Posterior 0.124 0.835 Large 

Group | Region Control Medial > Posterior 1.49E-05 *** 2.54 Large 

Group | Region Fentanyl Anterior < Lateral 0.256 0.614 Medium 

Group | Region Fentanyl Anterior < Medial 2E-07 *** 3.22 Large 

Group | Region Fentanyl Anterior > Posterior 0.0734 . 0.976 Large 

Group | Region Fentanyl Lateral < Medial 9.8E-06 *** 2.61 Large 

Group | Region Fentanyl Lateral > Posterior 0.00439 ** 1.59 Large 

Group | Region Fentanyl Medial > Posterior 0 *** 4.2 Large 

Group | Region Morphine Anterior < Lateral 0.675 0.225 Medium 

Group | Region Morphine Anterior < Medial 0.00144 ** 1.8 Large 

Group | Region Morphine Anterior > Posterior 0.338 0.517 Medium 

Group | Region Morphine Lateral < Medial 0.00485 ** 1.57 Large 

Group | Region Morphine Lateral > Posterior 0.171 0.742 Medium 

Group | Region Morphine Medial > Posterior 0.000066 *** 2.31 Large 

Open Pore Density 
Interaction 

Contrast Comparison p-value Sig. Cohen's D 
Effect 
Group 

Power 

Region Anterior < Lateral 0.000002 *** 1.8 Large 31% 

Region Anterior < Medial 0 *** 2.16 Large 

Region Anterior < Posterior 0.0321 * 0.873 Large 

Region Lateral < Medial 0.644 0.363 Medium 

Region Lateral > Posterior 0.0213 * 0.922 Large 

Region Medial > Posterior 0.000637 *** 1.29 Large 

Closed Porosity (%) Interaction 
Contrast 

Comparison p-value Sig. Cohen's D 
Effect 
Group 

Power 

Region Anterior < Lateral 0.0165 * 0.952 Large 32% 

Region Anterior < Medial 0 *** 2.32 Large 

Region Anterior < Posterior 0.0639 . 0.786 Medium 
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Region Lateral < Medial 0.000248 *** 1.37 Large 

Region Lateral > Posterior 0.95 0.166 Small 

Region Medial > Posterior 3.92E-05 *** 1.54 Large 

Open Porosity (%) Interaction 
Contrast 

Comparison p-value Sig. Cohen's D 
Effect 
Group 

Power 

Region Anterior > Lateral 0.502 0.434 Medium 71% 

Region Anterior < Medial 0.000156 *** 1.42 Large 

Region Anterior < Posterior 0.00278 ** 1.14 Large 

Region Lateral < Medial 0.000001 *** 1.85 Large 

Region Lateral < Posterior 2.58E-05 *** 1.58 Large 

Region Medial > Posterior 0.812 0.274 Medium 

Group Control > Fentanyl 0.0499 * 1.72 Large 99% 

Group Control > Morphine 0.0968 . 1.49 Large 

Group Fentanyl < Morpine 0.937 0.233 Medium 

Region | Group Anterior Control > Fentanyl 0.0026 ** 2.72 Large 40% 

Region | Group Anterior Control > Morphine 0.00966 ** 2.31 Large 

Region | Group Anterior Fentanyl < Morphine 0.624 0.419 Medium 

Region | Group Lateral Control > Fentanyl 0.579 0.475 Medium 

Region | Group Lateral Control > Morphine 0.64 0.4 Medium 

Region | Group Lateral Fentanyl < Morphine 0.93 0.0752 Small 

Region | Group Medial Control > Fentanyl 0.00384 ** 2.6 Large 

Region | Group Medial Control > Morphine 0.113 1.37 Large 

Region | Group Medial Fentanyl < Morphine 0.156 1.23 Large 

Region | Group Posterior Control > Fentanyl 0.0572 . 1.66 Large 

Region | Group Posterior Control > Morphine 0.0883 . 1.48 Large 

Region | Group Posterior Fentanyl < Morphine 0.834 0.179 Small 

Group | Region Control Anterior > Lateral 0.000852 *** 2.11 Large 

Group | Region Control Anterior < Medial 0.277 0.655 Medium 

Group | Region Control Anterior > Posterior 0.971 0.0221 Small 

Group | Region Control Lateral < Medial 2.34E-05 *** 2.76 Large 

Group | Region Control Lateral < Posterior 0.000955 *** 2.09 Large 

Group | Region Control Medial > Posterior 0.261 0.677 Medium 

Group | Region Fentanyl Anterior < Lateral 0.814 0.141 Small 

Group | Region Fentanyl Anterior < Medial 0.199 0.777 Medium 

Group | Region Fentanyl Anterior < Posterior 0.0869 . 1.04 Large 

Group | Region Fentanyl Lateral < Medial 0.292 0.635 Medium 

Group | Region Fentanyl Lateral < Posterior 0.138 0.899 Large 

Group | Region Fentanyl Medial < Posterior 0.66 0.264 Medium 

Group | Region Morphine Anterior > Lateral 0.736 0.202 Medium 

Group | Region Morphine Anterior < Medial 0.0103 * 1.59 Large 

Group | Region Morphine Anterior < Posterior 0.185 0.801 Large 

Group | Region Morphine Lateral < Medial 0.00411 ** 1.79 Large 
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Group | Region Morphine Lateral < Posterior 0.0985 . 1 Large 

Group | Region Morphine Medial > Posterior 0.194 0.785 Medium 

Total Porosity (%) Interaction 
Contrast 

Comparison p-value Sig. Cohen's D 
Effect 
Group 

Power 

Region Anterior > Lateral 0.996 0.0705 Small 70% 

Region Anterior < Medial 5E-07 *** 1.91 Large 

Region Anterior < Posterior 0.000567 *** 1.3 Large 

Region Lateral < Medial 2E-07 *** 1.98 Large 

Region Lateral < Posterior 0.000266 *** 1.37 Large 

Region Medial > Posterior 0.205 0.614 Medium 

Group Control > Fentanyl 0.169 1.4 Large 100% 

Group Control > Morphine 0.135 1.49 Large 

Group Fentanyl > Morphine 0.991 0.0969 Small 

Region | Group Anterior Control > Fentanyl 1 0 Small 44% 

Region | Group Anterior Control > Morphine 1 0 Small 

Region | Group Anterior Fentanyl < Morphine 1 0 Small 

Region | Group Lateral Control > Fentanyl 1 0 Small 

Region | Group Lateral Control > Morphine 1 0 Small 

Region | Group Lateral Fentanyl < Morphine 1 0 Small 

Region | Group Medial Control > Fentanyl 0.0167 * 2.51 Large 

Region | Group Medial Control > Morphine 0.0167 * 2.51 Large 

Region | Group Medial Fentanyl < Morphine 1 0 Small 

Region | Group Posterior Control > Fentanyl 1 0 Small 

Region | Group Posterior Control > Morphine 1 0 Small 

Region | Group Posterior Fentanyl < Morphine 1 0 Small 

Group | Region Control Anterior > Lateral 1 0 Small 

Group | Region Control Anterior < Medial 0.0176 * 2.51 Large 

Group | Region Control Anterior < Posterior 1 0 Small 

Group | Region Control Lateral < Medial 0.0176 * 2.51 Large 

Group | Region Control Lateral < Posterior 1 0 Small 

Group | Region Control Medial > Posterior 0.0176 * 2.51 Large 

Group | Region Fentanyl Anterior < Lateral 1 0 Small 

Group | Region Fentanyl Anterior < Medial 1 0 Small 

Group | Region Fentanyl Anterior < Posterior 1 0 Small 

Group | Region Fentanyl Lateral < Medial 1 0 Small 

Group | Region Fentanyl Lateral < Posterior 1 0 Small 

Group | Region Fentanyl Medial < Posterior 1 0 Small 

Group | Region Morphine Anterior < Lateral 1 0 Small 

Group | Region Morphine Anterior < Medial 1 0 Small 

Group | Region Morphine Anterior < Posterior 1 0 Small 

Group | Region Morphine Lateral < Medial 1 0 Small 

Group | Region Morphine Lateral < Posterior 1 0 Small 
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Group | Region Morphine Medial > Posterior 1 0 Small 

Cortical Volume 
Interaction 

Contrast 
Comparison p-value Sig. Cohen's D 

Effect 
Group 

Power 

Region Anterior > Lateral 0 *** 3.33 Large 18% 

Region Anterior > Medial 0 *** 2.18 Large 

Region Anterior > Posterior 0.977 0.126 Small 

Region Lateral < Medial 0.0027 ** 1.14 Large 

Region Lateral < Posterior 0 *** 3.2 Large 

Region Medial < Posterior 1E-07 *** 2.05 Large 

Pore Volume Interaction 
Contrast 

Comparison p-value Sig. Cohen's D 
Effect 
Group 

Power 

Region Anterior > Lateral 0.00871 ** 1.02 Large 43% 

Region Anterior < Medial 0.0382 * 0.852 Large 

Region Anterior < Posterior 0.00914 ** 1.02 Large 

Region Lateral < Medial 8E-07 *** 1.87 Large 

Region Lateral < Posterior 1E-07 *** 2.04 Large 

Region Medial < Posterior 0.95 0.165 Small 

Cortical Surface 
Interaction 

Contrast 
Comparison p-value Sig. Cohen's D 

Effect 
Group 

Power 

Region Anterior > Lateral 0 *** 2.41 Large 29% 

Region Anterior > Medial 1E-07 *** 2.07 Large 

Region Anterior < Posterior 0.0836 . 0.75 Medium 

Region Lateral < Medial 0.686 0.342 Medium 

Region Lateral < Posterior 0 *** 3.16 Large 

Region Medial < Posterior 0 *** 2.82 Large 

Pore Surface 
Interaction 

Contrast Comparison p-value Sig. Cohen's D 
Effect 
Group 

Power 

Region Anterior > Lateral 0.0192 * 0.934 Large 49% 

Region Anterior < Medial 0.0481 * 0.823 Large 

Region Anterior < Posterior 0.0115 * 0.992 Large 

Region Lateral < Medial 3.1E-06 *** 1.76 Large 

Region Lateral < Posterior 4E-07 *** 1.93 Large 

Region Medial < Posterior 0.947 0.169 Small 

Intersection Surface 
Interaction 

Contrast 
Comparison p-value Sig. Cohen's D 

Effect 
Group 

Power 

Region Anterior < Lateral 0.536 0.417 Medium 75% 

Region Anterior < Medial 0.335 0.524 Medium 

Region Anterior < Posterior 0.0237 * 0.91 Large 

Region Lateral < Medial 0.985 0.107 Small 

Region Lateral < Posterior 0.388 0.493 Medium 

Region Medial < Posterior 0.598 0.386 Medium 

Group Control > Fentanyl 0.0381 * 2.81 Large 72% 

Group Control > Morphine 0.259 1.7 Large 
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Group Fentanyl < Morpine 0.552 1.1 Large 

Region | Group Anterior Control > Fentanyl 0.119 2.09 Large 47% 

Region | Group Anterior Control > Morphine 0.351 1.22 Large 

Region | Group Anterior Fentanyl < Morphine 0.507 0.866 Large 

Region | Group Lateral Control > Fentanyl 0.134 2 Large 

Region | Group Lateral Control > Morphine 0.361 1.2 Large 

Region | Group Lateral Fentanyl < Morphine 0.536 0.807 Large 

Region | Group Medial Control > Fentanyl 0.224 1.61 Large 

Region | Group Medial Control > Morphine 0.523 0.833 Large 

Region | Group Medial Fentanyl < Morphine 0.552 0.775 Medium 

Region | Group Posterior Control > Fentanyl 0.183 1.77 Large 

Region | Group Posterior Control > Morphine 0.604 0.675 Medium 

Region | Group Posterior Fentanyl < Morphine 0.403 1.09 Large 

Group | Region Control Anterior > Lateral 0.635 0.0849 Small 

Group | Region Control Anterior > Medial 0.00888 ** 0.482 Medium 

Group | Region Control Anterior > Posterior 0.0769 . 0.32 Medium 

Group | Region Control Lateral > Medial 0.0294 * 0.397 Medium 

Group | Region Control Lateral > Posterior 0.191 0.235 Medium 

Group | Region Control Medial < Posterior 0.366 0.162 Small 

Group | Region Fentanyl Anterior < Lateral 0.998 0.000389 Small 

Group | Region Fentanyl Anterior < Medial 1 2.44E-05 Small 

Group | Region Fentanyl Anterior < Posterior 0.998 0.000394 Small 

Group | Region Fentanyl Lateral > Medial 0.998 0.000365 Small 

Group | Region Fentanyl Lateral < Posterior 1 4.7E-06 Small 

Group | Region Fentanyl Medial < Posterior 0.998 0.00037 Small 

Group | Region Morphine Anterior > Lateral 0.743 0.0585 Small 

Group | Region Morphine Anterior > Medial 0.611 0.0908 Small 

Group | Region Morphine Anterior < Posterior 0.203 0.229 Medium 

Group | Region Morphine Lateral > Medial 0.856 0.0323 Small 

Group | Region Morphine Lateral < Posterior 0.112 0.287 Medium 

Group | Region Morphine Medial < Posterior 0.0776 . 0.319 Medium 

Pore Surface: 
PoreVolume 

Interaction 
Contrast 

Comparison p-value Sig. Cohen's D 
Effect 
Group 

Power 

Region Anterior < Lateral 0.00221 ** 1.16 Large 67% 

Region Anterior > Medial 0.206 0.613 Medium 

Region Anterior > Posterior 0.03 * 0.882 Large 

Region Lateral > Medial 2.4E-06 *** 1.78 Large 

Region Lateral > Posterior 1E-07 *** 2.05 Large 

Region Medial > Posterior 0.82 0.269 Medium 

Group Control < Fentanyl 0.0671 . 4.04 Large 100% 

Group Control < Morphine 0.34 2.43 Large 

Group Fentanyl > Morphine 0.613 1.61 Large 
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Region | Group Anterior Control < Fentanyl 0.0154 * 4.6 Large 49% 

Region | Group Anterior Control < Morphine 0.0543 . 3.56 Large 

Region | Group Anterior Fentanyl > Morphine 0.555 1.05 Large 

Region | Group Lateral Control < Fentanyl 0.0792 . 3.22 Large 

Region | Group Lateral Control < Morphine 0.31 1.81 Large 

Region | Group Lateral Fentanyl > Morphine 0.43 1.4 Large 

Region | Group Medial Control < Fentanyl 0.0135 * 4.71 Large 

Region | Group Medial Control < Morphine 0.293 1.88 Large 

Region | Group Medial Fentanyl > Morphine 0.12 2.82 Large 

Region | Group Posterior Control < Fentanyl 0.0502 . 3.62 Large 

Region | Group Posterior Control < Morphine 0.172 2.47 Large 

Region | Group Posterior Fentanyl > Morphine 0.515 1.15 Large 

Group | Region Control Anterior < Lateral 0.000128 *** 2.21 Large 

Group | Region Control Anterior > Medial 0.866 0.0906 Small 

Group | Region Control Anterior > Posterior 0.718 0.194 Small 

Group | Region Control Lateral > Medial 7.31E-05 *** 2.3 Large 

Group | Region Control Lateral > Posterior 0.000038 *** 2.4 Large 

Group | Region Control Medial > Posterior 0.848 0.103 Small 

Group | Region Fentanyl Anterior < Lateral 0.13 0.823 Large 

Group | Region Fentanyl Anterior < Medial 0.978 0.015 Small 

Group | Region Fentanyl Anterior > Posterior 0.0328 * 1.17 Large 

Group | Region Fentanyl Lateral > Medial 0.137 0.808 Large 

Group | Region Fentanyl Lateral > Posterior 0.000461 *** 1.99 Large 

Group | Region Fentanyl Medial > Posterior 0.0307 * 1.19 Large 

Group | Region Morphine Anterior < Lateral 0.388 0.465 Medium 

Group | Region Morphine Anterior > Medial 0.00172 ** 1.76 Large 

Group | Region Morphine Anterior > Posterior 0.0201 * 1.28 Large 

Group | Region Morphine Lateral > Medial 0.000111 *** 2.23 Large 

Group | Region Morphine Lateral > Posterior 0.0019 ** 1.75 Large 

Group | Region Morphine Medial < Posterior 0.37 0.483 Medium 

Pore Surface: 
Cortical Volume 

Interaction 
Contrast Comparison p-value Sig. Cohen's D 

Effect 
Group 

Power 

Region Anterior < Lateral 0.349 0.516 Medium 26% 

Region Anterior < Medial 0 *** 2.24 Large 

Region Anterior < Posterior 0.00317 ** 1.13 Large 

Region Lateral < Medial 4.7E-06 *** 1.72 Large 

Region Lateral < Posterior 0.206 0.613 Medium 

Region Medial > Posterior 0.00385 ** 1.11 Large 

Pore Thickness 
Interaction 

Contrast 
Comparison p-value Sig. Cohen's D 

Effect 
Group 

Power 

Region Anterior > Lateral 9.38E-05 *** 1.46 Large 74% 

Region Anterior < Medial 0.152 0.662 Medium 
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Region Anterior < Posterior 0.0617 . 0.791 Medium 

Region Lateral < Medial 0 *** 2.12 Large 

Region Lateral < Posterior 0 *** 2.25 Large 

Region Medial < Posterior 0.976 0.128 Small 

Group Control > Fentanyl 0.015 * 2.62 Large 100% 

Group Control > Morphine 0.215 1.46 Large 

Group Fentanyl < Morpine 0.367 1.16 Large 

Pore Separation 
Interaction 

Contrast 
Comparison p-value Sig. Cohen's D 

Effect 
Group 

Power 

Region Anterior > Lateral 0.007 ** 1.05 Large 29% 

Region Anterior > Medial 0 *** 2.58 Large 

Region Anterior > Posterior 0.0123 * 0.985 Large 

Region Lateral > Medial 3.92E-05 *** 1.54 Large 

Region Lateral < Posterior 0.997 0.0612 Small 

Region Medial < Posterior 1.94E-05 *** 1.6 Large 

Pore Tb.N 
Interaction 

Contrast 
Comparison p-value Sig. Cohen's D 

Effect 
Group 

Power 

Region Anterior < Lateral 0.00177 ** 1.19 Large 30% 

Region Anterior < Medial 1.1E-06 *** 1.85 Large 

Region Anterior < Posterior 0.00768 ** 1.04 Large 

Region Lateral < Medial 0.155 0.659 Medium 

Region Lateral > Posterior 0.961 0.151 Small 

Region Medial > Posterior 0.0535 . 0.809 Large 

Degree of 
Anisotropy 

Interaction 
Contrast 

Comparison p-value Sig. Cohen's D 
Effect 
Group 

Power 

Region Anterior > Lateral 6E-07 *** 1.9 Large 53% 

Region Anterior < Medial 8.2E-06 *** 1.67 Large 

Region Anterior < Posterior 0.0361 * 0.859 Large 

Region Lateral < Medial 0 *** 3.57 Large 

Region Lateral < Posterior 0 *** 2.75 Large 

Region Medial > Posterior 0.0513 . 0.815 Large 

Region | Group Anterior Control > Fentanyl 0.172 1.43 Large 39% 

Region | Group Anterior Control > Morphine 0.18 1.4 Large 

Region | Group Anterior Fentanyl < Morphine 0.978 0.0283 Small 

Region | Group Lateral Control > Fentanyl 0.801 0.26 Medium 

Region | Group Lateral Control < Morphine 0.348 0.975 Large 

Region | Group Lateral Fentanyl < Morphine 0.237 1.23 Large 

Region | Group Medial Control > Fentanyl 0.544 0.628 Medium 

Region | Group Medial Control < Morphine 0.518 0.669 Medium 

Region | Group Medial Fentanyl < Morphine 0.215 1.3 Large 

Region | Group Posterior Control > Fentanyl 0.393 0.887 Large 

Region | Group Posterior Control < Morphine 0.892 0.14 Small 
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Region | Group Posterior Fentanyl < Morphine 0.323 1.03 Large 

Group | Region Control Anterior > Lateral 4E-07 *** 3.08 Large 

Group | Region Control Anterior < Medial 0.187 0.715 Medium 

Group | Region Control Anterior < Posterior 0.762 0.163 Small 

Group | Region Control Lateral < Medial 0 *** 3.79 Large 

Group | Region Control Lateral < Posterior 1E-07 *** 3.24 Large 

Group | Region Control Medial > Posterior 0.307 0.552 Medium 

Group | Region Fentanyl Anterior > Lateral 0.000763 *** 1.91 Large 

Group | Region Fentanyl Anterior < Medial 0.00632 ** 1.52 Large 

Group | Region Fentanyl Anterior < Posterior 0.191 0.708 Medium 

Group | Region Fentanyl Lateral < Medial 0 *** 3.43 Large 

Group | Region Fentanyl Lateral < Posterior 9.4E-06 *** 2.62 Large 

Group | Region Fentanyl Medial > Posterior 0.135 0.811 Large 

Group | Region Morphine Anterior > Lateral 0.195 0.701 Medium 

Group | Region Morphine Anterior < Medial 0.000003 *** 2.79 Large 

Group | Region Morphine Anterior < Posterior 0.00235 ** 1.71 Large 

Group | Region Morphine Lateral < Medial 0 *** 3.49 Large 

Group | Region Morphine Lateral < Posterior 3.61E-05 *** 2.41 Large 

Group | Region Morphine Medial > Posterior 0.0481 * 1.08 Large 

Pore Fractal 
Interaction 

Contrast 
Comparison p-value Sig. Cohen's D 

Effect 
Group 

Power 

Region Anterior > Lateral 0.991 0.0907 Small 35% 

Region Anterior < Medial 0 *** 2.53 Large 

Region Anterior < Posterior 0.0134 * 0.975 Large 

Region Lateral < Medial 0 *** 2.62 Large 

Region Lateral < Posterior 0.00581 ** 1.07 Large 

Region Medial > Posterior 3.19E-05 *** 1.56 Large 

Region | Group Anterior Control > Fentanyl 0.356 1.19 Large 50% 

Region | Group Anterior Control > Morphine 0.15 1.88 Large 

Region | Group Anterior Fentanyl > Morphine 0.591 0.687 Medium 

Region | Group Lateral Control < Fentanyl 0.783 0.351 Medium 

Region | Group Lateral Control > Morphine 0.851 0.239 Medium 

Region | Group Lateral Fentanyl > Morphine 0.644 0.59 Medium 

Region | Group Medial Control > Fentanyl 0.396 1.09 Large 

Region | Group Medial Control > Morphine 0.297 1.35 Large 

Region | Group Medial Fentanyl > Morphine 0.841 0.256 Medium 

Region | Group Posterior Control > Fentanyl 0.459 0.948 Large 

Region | Group Posterior Control > Morphine 0.224 1.57 Large 

Region | Group Posterior Fentanyl > Morphine 0.625 0.625 Medium 

Group | Region Control Anterior > Lateral 0.0451 * 1.16 Large 

Group | Region Control Anterior < Medial 0.000199 *** 2.26 Large 

Group | Region Control Anterior < Posterior 0.118 0.898 Large 
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Group | Region Control Lateral < Medial 1E-07 *** 3.42 Large 

Group | Region Control Lateral < Posterior 0.000612 *** 2.06 Large 

Group | Region Control Medial > Posterior 0.0196 * 1.36 Large 

Group | Region Fentanyl Anterior < Lateral 0.506 0.379 Medium 

Group | Region Fentanyl Anterior < Medial 0.000113 *** 2.35 Large 

Group | Region Fentanyl Anterior < Posterior 0.0493 * 1.14 Large 

Group | Region Fentanyl Lateral < Medial 0.000954 *** 1.98 Large 

Group | Region Fentanyl Lateral < Posterior 0.185 0.758 Medium 

Group | Region Fentanyl Medial > Posterior 0.0357 * 1.22 Large 

Group | Region Morphine Anterior < Lateral 0.403 0.476 Medium 

Group | Region Morphine Anterior < Medial 8.2E-06 *** 2.79 Large 

Group | Region Morphine Anterior < Posterior 0.0384 * 1.2 Large 

Group | Region Morphine Lateral < Medial 0.000146 *** 2.31 Large 

Group | Region Morphine Lateral < Posterior 0.206 0.723 Medium 

Group | Region Morphine Medial > Posterior 0.00694 ** 1.59 Large 

Number of Pores 
Interaction 

Contrast 
Comparison p-value Sig. Cohen's D 

Effect 
Group 

Power 

Region Anterior > Lateral 3E-07 *** 1.95 Large 23% 

Region Anterior < Medial 0.0432 * 0.837 Large 

Region Anterior > Posterior 0.151 0.663 Medium 

Region Lateral < Medial 0 *** 2.79 Large 

Region Lateral < Posterior 0.000614 *** 1.29 Large 

Region Medial > Posterior 6.12E-05 *** 1.5 Large 

Pore Density 
Interaction 

Contrast Comparison p-value Sig. Cohen's D 
Effect 
Group 

Power 

Region Anterior < Lateral 0.0792 . 0.757 Medium 42% 

Region Anterior < Medial 0 *** 2.6 Large 

Region Anterior > Posterior 0.644 0.363 Medium 

Region Lateral < Medial 1.1E-06 *** 1.84 Large 

Region Lateral > Posterior 0.00343 ** 1.12 Large 

Region Medial > Posterior 0 *** 2.96 Large 

Region | Group Anterior Control < Fentanyl 0.217 2.64 Large 39% 

Region | Group Anterior Control < Morphine 0.471 1.52 Large 

Region | Group Anterior Fentanyl > Morphine 0.595 1.12 Large 

Region | Group Lateral Control < Fentanyl 0.166 2.98 Large 

Region | Group Lateral Control < Morphine 0.52 1.36 Large 

Region | Group Lateral Fentanyl > Morphine 0.442 1.62 Large 

Region | Group Medial Control < Fentanyl 0.0881 . 3.71 Large 

Region | Group Medial Control < Morphine 0.618 1.05 Large 

Region | Group Medial Fentanyl > Morphine 0.213 2.66 Large 

Region | Group Posterior Control < Fentanyl 0.297 2.21 Large 

Region | Group Posterior Control < Morphine 0.499 1.43 Large 
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Region | Group Posterior Fentanyl > Morphine 0.707 0.788 Medium 

Group | Region Control Anterior < Lateral 0.196 0.699 Medium 

Group | Region Control Anterior < Medial 3.83E-05 *** 2.4 Large 

Group | Region Control Anterior > Posterior 0.723 0.19 Small 

Group | Region Control Lateral < Medial 0.00245 ** 1.7 Large 

Group | Region Control Lateral > Posterior 0.102 0.889 Large 

Group | Region Control Medial > Posterior 1.12E-05 *** 2.59 Large 

Group | Region Fentanyl Anterior < Lateral 0.0573 . 1.04 Large 

Group | Region Fentanyl Anterior < Medial 0 *** 3.47 Large 

Group | Region Fentanyl Anterior > Posterior 0.256 0.614 Medium 

Group | Region Fentanyl Lateral < Medial 3.09E-05 *** 2.43 Large 

Group | Region Fentanyl Lateral > Posterior 0.00316 ** 1.65 Large 

Group | Region Fentanyl Medial > Posterior 0 *** 4.08 Large 

Group | Region Morphine Anterior < Lateral 0.322 0.534 Medium 

Group | Region Morphine Anterior < Medial 0.000686 *** 1.93 Large 

Group | Region Morphine Anterior > Posterior 0.596 0.285 Medium 

Group | Region Morphine Lateral < Medial 0.0119 * 1.39 Large 

Group | Region Morphine Lateral > Posterior 0.131 0.819 Large 

Group | Region Morphine Medial > Posterior 0.000124 *** 2.21 Large 

Euler number 
Interaction 

Contrast 
Comparison p-value Sig. Cohen's D 

Effect 
Group 

Power 

Region Anterior > Lateral 2.4E-06 *** 1.78 Large 47% 

Region Anterior < Medial 0.405 0.484 Medium 

Region Anterior > Posterior 0.000582 *** 1.29 Large 

Region Lateral < Medial 0 *** 2.26 Large 

Region Lateral < Posterior 0.406 0.484 Medium 

Region Medial > Posterior 2.4E-06 *** 1.78 Large 

Region | Group Anterior Control < Fentanyl 0.284 1.63 Large 35% 

Region | Group Anterior Control < Morphine 0.591 0.808 Large 

Region | Group Anterior Fentanyl > Morphine 0.586 0.819 Large 

Region | Group Lateral Control < Fentanyl 0.655 0.672 Medium 

Region | Group Lateral Control < Morphine 0.823 0.335 Medium 

Region | Group Lateral Fentanyl > Morphine 0.823 0.336 Medium 

Region | Group Medial Control < Fentanyl 0.231 1.82 Large 

Region | Group Medial Control < Morphine 0.943 0.107 Small 

Region | Group Medial Fentanyl > Morphine 0.258 1.72 Large 

Region | Group Posterior Control < Fentanyl 0.747 0.484 Medium 

Region | Group Posterior Control < Morphine 0.528 0.95 Large 

Region | Group Posterior Fentanyl < Morphine 0.756 0.466 Medium 

Group | Region Control Anterior > Lateral 0.0182 * 1.3 Large 

Group | Region Control Anterior < Medial 0.228 0.652 Medium 

Group | Region Control Anterior > Posterior 0.0781 . 0.96 Large 
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Group | Region Control Lateral < Medial 0.000585 *** 1.95 Large 

Group | Region Control Lateral < Posterior 0.526 0.341 Medium 

Group | Region Control Medial > Posterior 0.00391 ** 1.61 Large 

Group | Region Fentanyl Anterior > Lateral 9.33E-05 *** 2.26 Large 

Group | Region Fentanyl Anterior < Medial 0.118 0.849 Large 

Group | Region Fentanyl Anterior > Posterior 0.00024 *** 2.1 Large 

Group | Region Fentanyl Lateral < Medial 3E-07 *** 3.11 Large 

Group | Region Fentanyl Lateral < Posterior 0.775 0.154 Small 

Group | Region Fentanyl Medial > Posterior 0.000001 *** 2.95 Large 

Group | Region Morphine Anterior > Lateral 0.00162 ** 1.77 Large 

Group | Region Morphine Anterior > Medial 0.926 0.0497 Small 

Group | Region Morphine Anterior > Posterior 0.132 0.818 Large 

Group | Region Morphine Lateral < Medial 0.00213 ** 1.72 Large 

Group | Region Morphine Lateral < Posterior 0.0794 . 0.956 Large 

Group | Region Morphine Medial > Posterior 0.156 0.769 Medium 

Connectivity 
Interaction 

Contrast 
Comparison p-value Sig. Cohen's D 

Effect 
Group 

Power 

Region Anterior > Lateral 0.302 0.544 Medium 43% 

Region Anterior < Medial 0.088 . 0.743 Medium 

Region Anterior < Posterior 0.00472 ** 1.09 Large 

Region Lateral < Medial 0.000628 *** 1.29 Large 

Region Lateral < Posterior 1.35E-05 *** 1.63 Large 

Region Medial < Posterior 0.681 0.345 Medium 

Connectivity density 
Interaction 

Contrast Comparison p-value Sig. Cohen's D 
Effect 
Group 

Power 

Region Anterior < Lateral 0.104 0.719 Medium 29% 

Region Anterior < Medial 0.00137 ** 1.21 Large 

Region Anterior < Posterior 0.0139 * 0.971 Large 

Region Lateral < Medial 0.389 0.493 Medium 

Region Lateral < Posterior 0.846 0.252 Medium 

Region Medial > Posterior 0.863 0.241 Medium 

SD Pore Thickness 
Interaction 

Contrast 
Comparison p-value Sig. Cohen's D 

Effect 
Group 

Power 

Region Anterior > Lateral 9.02E-05 *** 1.46 Large 56% 

Region Anterior < Medial 0.353 0.513 Medium 

Region Anterior < Posterior 0.569 0.4 Medium 

Region Lateral < Medial 2E-07 *** 1.98 Large 

Region Lateral < Posterior 9E-07 *** 1.87 Large 

Region Medial > Posterior 0.983 0.113 Small 

Group Control > Fentanyl 0.0274 * 2.3 Large 98% 

Group Control > Morphine 0.406 1.06 Large 

Group Fentanyl < Morpine 0.299 1.24 Large 
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SD Pore Separation 
Interaction 

Contrast Comparison p-value Sig. Cohen's D 
Effect 
Group 

Power 

Region Anterior > Lateral 0.00282 ** 1.14 Large 47% 

Region Anterior > Medial 7E-07 *** 1.88 Large 

Region Anterior > Posterior 0.0137 * 0.973 Large 

Region Lateral > Medial 0.087 . 0.744 Medium 

Region Lateral < Posterior 0.948 0.167 Small 

Region Medial < Posterior 0.0234 * 0.911 Large 

Avg.Por.Vol Interaction 
Contrast 

Comparison p-value Sig. Cohen's D 
Effect 
Group 

Power 

Region Anterior > Lateral 0.999 0.0478 Small 77% 

Region Anterior < Medial 0.0619 . 0.79 Medium 

Region Anterior < Posterior 0.000392 *** 1.33 Large 

Region Lateral < Medial 0.0427 * 0.838 Large 

Region Lateral < Posterior 0.000234 *** 1.38 Large 

Region Medial < Posterior 0.308 0.541 Medium 

Group Control > Fentanyl 0.0719 . 1.84 Large 95% 

Group Control > Morphine 0.145 1.54 Large 

Group Fentanyl < Morpine 0.923 0.296 Medium 

Region | Group Anterior Control > Fentanyl 0.0833 . 1.91 Large 35% 

Region | Group Anterior Control > Morphine 0.303 1.11 Large 

Region | Group Anterior Fentanyl < Morphine 0.458 0.796 Medium 

Region | Group Lateral Control > Fentanyl 0.67 0.454 Medium 

Region | Group Lateral Control > Morphine 0.897 0.138 Small 

Region | Group Lateral Fentanyl < Morphine 0.767 0.316 Medium 

Region | Group Medial Control > Fentanyl 0.656 0.475 Medium 

Region | Group Medial Control > Morphine 0.739 0.356 Medium 

Region | Group Medial Fentanyl < Morphine 0.911 0.119 Small 

Region | Group Posterior Control > Fentanyl 0.22 1.33 Large 

Region | Group Posterior Control > Morphine 0.786 0.289 Medium 

Region | Group Posterior Fentanyl < Morphine 0.335 1.04 Large 

Group | Region Control Anterior > Lateral 0.02 * 1.08 Large 

Group | Region Control Anterior > Medial 0.0614 . 0.858 Large 

Group | Region Control Anterior > Posterior 0.203 0.579 Medium 

Group | Region Control Lateral < Medial 0.628 0.219 Medium 

Group | Region Control Lateral < Posterior 0.272 0.498 Medium 

Group | Region Control Medial < Posterior 0.537 0.279 Medium 

Group | Region Fentanyl Anterior < Lateral 0.409 0.374 Medium 

Group | Region Fentanyl Anterior < Medial 0.208 0.572 Medium 

Group | Region Fentanyl Anterior < Posterior 1 9.3E-06 Small 

Group | Region Fentanyl Lateral < Medial 0.66 0.198 Small 

Group | Region Fentanyl Lateral > Posterior 0.409 0.374 Medium 
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Group | Region Fentanyl Medial > Posterior 0.208 0.572 Medium 

Group | Region Morphine Anterior > Lateral 0.815 0.105 Small 

Group | Region Morphine Anterior > Medial 0.817 0.104 Small 

Group | Region Morphine Anterior < Posterior 0.592 0.242 Medium 

Group | Region Morphine Lateral < Medial 0.998 0.00108 Small 

Group | Region Morphine Lateral < Posterior 0.443 0.347 Medium 

Group | Region Morphine Medial < Posterior 0.444 0.346 Medium 

Avg.Por.Surf 
Interaction 

Contrast 
Comparison p-value Sig. Cohen's D 

Effect 
Group 

Power 

Region Anterior < Lateral 0.349 0.516 Medium 57% 

Region Anterior < Medial 0.0427 * 0.838 Large 

Region Anterior < Posterior 3.48E-05 *** 1.55 Large 

Region Lateral < Medial 0.724 0.323 Medium 

Region Lateral < Posterior 0.00787 ** 1.03 Large 

Region Medial < Posterior 0.11 0.711 Medium 

Group Control > Fentanyl 0.151 1.56 Large 91% 

Group Control > Morphine 0.166 1.52 Large 

Group Fentanyl < Morpine 0.998 0.0449 Small 

Region | Group Anterior Control > Fentanyl 0.159 1.53 Large 47% 

Region | Group Anterior Control > Morphine 0.526 0.676 Medium 

Region | Group Anterior Fentanyl < Morphine 0.423 0.856 Large 

Region | Group Lateral Control > Fentanyl 0.59 0.573 Medium 

Region | Group Lateral Control > Morphine 0.76 0.324 Medium 

Region | Group Lateral Fentanyl < Morphine 0.814 0.249 Medium 

Region | Group Medial Control > Fentanyl 0.486 0.743 Medium 

Region | Group Medial Control > Morphine 0.614 0.536 Medium 

Region | Group Medial Fentanyl < Morphine 0.845 0.207 Medium 

Region | Group Posterior Control > Fentanyl 0.145 1.59 Large 

Region | Group Posterior Control > Morphine 0.543 0.648 Medium 

Region | Group Posterior Fentanyl < Morphine 0.38 0.938 Large 

Group | Region Control Anterior > Lateral 0.146 0.444 Medium 

Group | Region Control Anterior > Medial 0.404 0.253 Medium 

Group | Region Control Anterior < Posterior 0.853 0.056 Small 

Group | Region Control Lateral < Medial 0.527 0.191 Small 

Group | Region Control Lateral < Posterior 0.102 0.5 Medium 

Group | Region Control Medial < Posterior 0.309 0.309 Medium 

Group | Region Fentanyl Anterior < Lateral 0.093 . 0.514 Medium 

Group | Region Fentanyl Anterior < Medial 0.0807 . 0.535 Medium 

Group | Region Fentanyl Anterior < Posterior 0.999 0.000501 Small 

Group | Region Fentanyl Lateral < Medial 0.944 0.021 Small 

Group | Region Fentanyl Lateral > Posterior 0.0933 . 0.514 Medium 

Group | Region Fentanyl Medial > Posterior 0.081 . 0.535 Medium 
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Group | Region Morphine Anterior > Lateral 0.76 0.0924 Small 

Group | Region Morphine Anterior > Medial 0.707 0.114 Small 

Group | Region Morphine Anterior < Posterior 0.783 0.0834 Small 

Group | Region Morphine Lateral > Medial 0.944 0.0212 Small 

Group | Region Morphine Lateral < Posterior 0.561 0.176 Small 

Group | Region Morphine Medial < Posterior 0.515 0.197 Small 

Avg.Orient.Theta 
Interaction 

Contrast Comparison p-value Sig. Cohen's D 
Effect 
Group 

Power 

Region Anterior < Lateral 0 *** 2.25 Large 36% 

Region Anterior > Medial 0 *** 2.38 Large 

Region Anterior < Posterior 0.386 0.494 Medium 

Region Lateral > Medial 0 *** 4.63 Large 

Region Lateral > Posterior 3.1E-06 *** 1.76 Large 

Region Medial < Posterior 0 *** 2.87 Large 

Avg.Orient.Phi Interaction 
Contrast 

Comparison p-value Sig. Cohen's D 
Effect 
Group 

Power 

Region Anterior < Lateral 0 *** 3.95 Large 50% 

Region Anterior < Medial 0 *** 3.17 Large 

Region Anterior < Posterior 0 *** 7.42 Large 

Region Lateral > Medial 0.0657 . 0.782 Medium 

Region Lateral < Posterior 0 *** 3.47 Large 

Region Medial < Posterior 0 *** 4.26 Large 

Group Control > Fentanyl 0.264 0.507 Medium 100% 

Group Control < Morphine 0.658 0.276 Medium 

Group Fentanyl < Morpine 0.0553 . 0.783 Medium 

Avg.Maj.Por.D 
Interaction 

Contrast 
Comparison p-value Sig. Cohen's D 

Effect 
Group 

Power 

Region Anterior < Lateral 0.00428 ** 1.1 Large 29% 

Region Anterior < Medial 0.0647 . 0.785 Medium 

Region Anterior < Posterior 1.54E-05 *** 1.62 Large 

Region Lateral > Medial 0.742 0.313 Medium 

Region Lateral < Posterior 0.337 0.523 Medium 

Region Medial < Posterior 0.0435 * 0.836 Large 

Sphericity 
Interaction 

Contrast Comparison p-value Sig. Cohen's D 
Effect 
Group 

Power 

Region Anterior > Lateral 0 *** 2.12 Large 54% 

Region Anterior > Medial 0.000713 *** 1.27 Large 

Region Anterior > Posterior 0 *** 2.92 Large 

Region Lateral < Medial 0.0402 * 0.846 Large 

Region Lateral > Posterior 0.0564 . 0.803 Large 

Region Medial > Posterior 1.11E-05 *** 1.65 Large 
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Femoral Regions: All Directional Trends 

Cortical Fractal Trends 

Region Medial > Posterior > Lateral > Anterior 

Group Control > Fentanyl > Morphine 

Region | Group Anterior Control > Fentanyl > Morphine 

Region | Group Lateral Fentanyl > Control > Morphine 

Region | Group Medial Control > Fentanyl > Morphine 

Region | Group Posterior Control > Fentanyl > Morphine 

Group | Region Control Medial > Posterior > Lateral > Anterior 

Group | Region Fentanyl Medial > Posterior > Lateral > Anterior 

Group | Region Morphine Medial > Posterior > Lateral > Anterior 

Number Closed Pores Trends 

Region Medial > Anterior > Posterior > Lateral 

Group Fentanyl > Control > Morphine 

Region | Group Anterior Fentanyl > Morphine > Control 

Region | Group Lateral Fentanyl > Morphine > Control 

Region | Group Medial Fentanyl > Control > Morphine 

Region | Group Posterior Fentanyl > Control > Morphine 

Group | Region Control Medial > Anterior > Posterior > Lateral 

Group | Region Fentanyl Medial > Anterior > Posterior > Lateral 

Group | Region Morphine Medial > Anterior > Posterior > Lateral 

Number Open Pores Trends 

Region Posterior > Medial > Anterior > Lateral 

Group Fentanyl > Control > Morphine 

Region | Group Anterior Morphine > Control > Fentanyl 

Region | Group Lateral Fentanyl > Morphine > Control 

Region | Group Medial Fentanyl > Control > Morphine 

Region | Group Posterior Fentanyl > Control > Morphine 

Group | Region Control Posterior > Medial > Anterior > Lateral 

Group | Region Fentanyl Posterior > Medial > Lateral > Anterior 

Group | Region Morphine Posterior > Medial > Anterior > Lateral 

Closed Pore Density Trends 

Region Medial > Lateral > Anterior > Posterior 

Group Fentanyl > Morphine > Control 

Region | Group Anterior Fentanyl > Morphine > Control 
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Region | Group Lateral Fentanyl > Morphine > Control 

Region | Group Medial Fentanyl > Morphine > Control 

Region | Group Posterior Fentanyl > Morphine > Control 

Group | Region Control Medial > Lateral > Anterior > Posterior 

Group | Region Fentanyl Medial > Lateral > Anterior > Posterior 

Group | Region Morphine Medial > Lateral > Anterior > Posterior 

Open Pore Density Trends 

Region Medial > Lateral > Posterior > Anterior 

Group Fentanyl > Morphine > Control 

Region | Group Anterior Fentanyl > Morphine > Control 

Region | Group Lateral Fentanyl > Morphine > Control 

Region | Group Medial Fentanyl > Morphine > Control 

Region | Group Posterior Fentanyl > Morphine > Control 

Group | Region Control Medial > Lateral > Posterior > Anterior 

Group | Region Fentanyl Medial > Lateral > Posterior > Anterior 

Group | Region Morphine Lateral > Medial > Posterior > Anterior 

Closed Porosity (%) Trends 

Region Medial > Lateral > Posterior > Anterior 

Group Fentanyl > Control > Morphine 

Region | Group Anterior Fentanyl > Morphine > Control 

Region | Group Lateral Morphine > Fentanyl > Control 

Region | Group Medial Fentanyl > Control > Morphine 

Region | Group Posterior Fentanyl > Morphine > Control 

Group | Region Control Medial > Lateral > Posterior > Anterior 

Group | Region Fentanyl Medial > Lateral > Posterior > Anterior 

Group | Region Morphine Medial > Lateral > Posterior > Anterior 

Open Porosity (%) Trends 

Region Medial > Posterior > Anterior > Lateral 

Group Control > Morphine > Fentanyl 

Region | Group Anterior Control > Morphine > Fentanyl 

Region | Group Lateral Control > Morphine > Fentanyl 

Region | Group Medial Control > Morphine > Fentanyl 

Region | Group Posterior Control > Morphine > Fentanyl 

Group | Region Control Medial > Anterior > Posterior > Lateral 

Group | Region Fentanyl Posterior > Medial > Lateral > Anterior 

Group | Region Morphine Medial > Posterior > Anterior > Lateral 

Total Porosity (%) Trends 

Region Medial > Posterior > Anterior > Lateral 

Group Control > Fentanyl > Morphine 

Region | Group Anterior Control > Morphine > Fentanyl 

Region | Group Lateral Control > Morphine > Fentanyl 
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Region | Group Medial Control > Morphine > Fentanyl 

Region | Group Posterior Control > Morphine > Fentanyl 

Group | Region Control Medial > Posterior > Anterior > Lateral 

Group | Region Fentanyl Posterior > Medial > Lateral > Anterior 

Group | Region Morphine Medial > Posterior > Lateral > Anterior 

Cortical Volume Trends 

Region Anterior > Posterior > Medial > Lateral 

Group Control > Morphine > Fentanyl 

Region | Group Anterior Control > Morphine > Fentanyl 

Region | Group Lateral Control > Morphine > Fentanyl 

Region | Group Medial Control > Morphine > Fentanyl 

Region | Group Posterior Control > Morphine > Fentanyl 

Group | Region Control Anterior > Posterior > Medial > Lateral 

Group | Region Fentanyl Anterior > Posterior > Medial > Lateral 

Group | Region Morphine Posterior > Anterior > Medial > Lateral 

Pore Volume Trends 

Region Posterior > Medial > Anterior > Lateral 

Group Control > Morphine > Fentanyl 

Region | Group Anterior Control > Morphine > Fentanyl 

Region | Group Lateral Control > Morphine > Fentanyl 

Region | Group Medial Control > Morphine > Fentanyl 

Region | Group Posterior Control > Morphine > Fentanyl 

Group | Region Control Anterior > Posterior > Medial > Lateral 

Group | Region Fentanyl Posterior > Medial > Anterior > Lateral 

Group | Region Morphine Posterior > Anterior > Medial > Lateral 

Cortical Surface Trends 

Region Posterior > Anterior > Medial > Lateral 

Group Control > Morphine > Fentanyl 

Region | Group Anterior Control > Morphine > Fentanyl 

Region | Group Lateral Control > Morphine > Fentanyl 

Region | Group Medial Control > Morphine > Fentanyl 

Region | Group Posterior Control > Morphine > Fentanyl 

Group | Region Control Posterior > Anterior > Medial > Lateral 

Group | Region Fentanyl Posterior > Anterior > Medial > Lateral 

Group | Region Morphine Posterior > Anterior > Medial > Lateral 

Pore Surface Trends 

Region Posterior > Medial > Anterior > Lateral 

Group Control > Morphine > Fentanyl 

Region | Group Anterior Control > Morphine > Fentanyl 

Region | Group Lateral Control > Morphine > Fentanyl 

Region | Group Medial Control > Morphine > Fentanyl 

2018-DU-BX-0188 Final Technical Report 
October 2021 

This resource was prepared by the author(s) using Federal funds provided by the U.S. 
Department of Justice. Opinions or points of view expressed are those of the author(s) and do not 

necessarily reflect the official position or policies of the U.S. Department of Justice.

319 



 
 

        

         

        

         

   

      

      

        

        

        

        

        

        

         

   

      

      

        

        

        

        

        

         

        

   

      

      

       

        

       

       

        

        

        

   

      

      

        

        

        

        

Region | Group Posterior Control > Morphine > Fentanyl 

Group | Region Control Posterior > Anterior > Medial > Lateral 

Group | Region Fentanyl Posterior > Medial > Anterior > Lateral 

Group | Region Morphine Posterior > Anterior > Medial > Lateral 

Intersection Surface Trends 

Region Posterior > Medial > Lateral > Anterior 

Group Control > Morphine > Fentanyl 

Region | Group Anterior Control > Morphine > Fentanyl 

Region | Group Lateral Control > Morphine > Fentanyl 

Region | Group Medial Control > Morphine > Fentanyl 

Region | Group Posterior Control > Morphine > Fentanyl 

Group | Region Control Anterior > Lateral > Posterior > Medial 

Group | Region Fentanyl Posterior > Lateral > Medial > Anterior 

Group | Region Morphine Posterior > Anterior > Lateral > Medial 

Pore Surface:PoreVolume Trends 

Region Lateral > Anterior > Medial > Posterior 

Group Fentanyl > Morphine > Control 

Region | Group Anterior Fentanyl > Morphine > Control 

Region | Group Lateral Fentanyl > Morphine > Control 

Region | Group Medial Fentanyl > Morphine > Control 

Region | Group Posterior Fentanyl > Morphine > Control 

Group | Region Control Lateral > Anterior > Medial > Posterior 

Group | Region Fentanyl Lateral > Medial > Anterior > Posterior 

Group | Region Morphine Lateral > Anterior > Posterior > Medial 

Pore Surface:Cortical Volume Trends 

Region Medial > Posterior > Lateral > Anterior 

Group Fentanyl > Morphine > Control 

Region | Group Anterior Fentanyl > Control > Morphine 

Region | Group Lateral Fentanyl > Morphine > Control 

Region | Group Medial Fentanyl > Control > Morphine 

Region | Group Posterior Fentanyl > Control > Morphine 

Group | Region Control Medial > Posterior > Anterior > Lateral 

Group | Region Fentanyl Medial > Posterior > Lateral > Anterior 

Group | Region Morphine Medial > Posterior > Lateral > Anterior 

Pore Thickness Trends 

Region Posterior > Medial > Anterior > Lateral 

Group Control > Morphine > Fentanyl 

Region | Group Anterior Control > Morphine > Fentanyl 

Region | Group Lateral Control > Morphine > Fentanyl 

Region | Group Medial Control > Morphine > Fentanyl 

Region | Group Posterior Control > Morphine > Fentanyl 
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Group | Region Control Anterior > Medial > Lateral > Posterior 

Group | Region Fentanyl Medial > Posterior > Anterior > Lateral 

Group | Region Morphine Posterior > Medial > Anterior > Lateral 

Pore Separation Trends 

Region Anterior > Posterior > Lateral > Medial 

Group Morphine > Control > Fentanyl 

Region | Group Anterior Control > Morphine > Fentanyl 

Region | Group Lateral Control > Morphine > Fentanyl 

Region | Group Medial Control > Morphine > Fentanyl 

Region | Group Posterior Control > Morphine > Fentanyl 

Group | Region Control Anterior > Lateral > Posterior > Medial 

Group | Region Fentanyl Anterior > Posterior > Lateral > Medial 

Group | Region Morphine Anterior > Posterior > Lateral > Medial 

Pore Tb.N Trends 

Region Medial > Lateral > Posterior > Anterior 

Group Fentanyl > Morphine > Control 

Region | Group Anterior Fentanyl > Morphine > Control 

Region | Group Lateral Fentanyl > Morphine > Control 

Region | Group Medial Fentanyl > Control > Morphine 

Region | Group Posterior Fentanyl > Morphine > Control 

Group | Region Control Medial > Posterior > Lateral > Anterior 

Group | Region Fentanyl Medial > Lateral > Posterior > Anterior 

Group | Region Morphine Medial > Lateral > Posterior > Anterior 

Degree of Anisotropy Trends 

Region Medial > Posterior > Anterior > Lateral 

Group Morphine > Control > Fentanyl 

Region | Group Anterior Control > Morphine > Fentanyl 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Morphine > Control > Fentanyl 

Region | Group Posterior Morphine > Control > Fentanyl 

Group | Region Control Medial > Posterior > Anterior > Lateral 

Group | Region Fentanyl Medial > Posterior > Anterior > Lateral 

Group | Region Morphine Medial > Posterior > Anterior > Lateral 

Pore Fractal Trends 

Region Medial > Posterior > Anterior > Lateral 

Group Control > Fentanyl > Morphine 

Region | Group Anterior Control > Fentanyl > Morphine 

Region | Group Lateral Fentanyl > Control > Morphine 

Region | Group Medial Control > Fentanyl > Morphine 

Region | Group Posterior Control > Fentanyl > Morphine 

Group | Region Control Medial > Posterior > Anterior > Lateral 
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Group | Region Fentanyl Medial > Posterior > Lateral > Anterior 

Group | Region Morphine Medial > Posterior > Lateral > Anterior 

Number of Pores Trends 

Region Medial > Anterior > Posterior > Lateral 

Group Fentanyl > Control > Morphine 

Region | Group Anterior Fentanyl > Morphine > Control 

Region | Group Lateral Fentanyl > Morphine > Control 

Region | Group Medial Fentanyl > Control > Morphine 

Region | Group Posterior Fentanyl > Control > Morphine 

Group | Region Control Medial > Anterior > Posterior > Lateral 

Group | Region Fentanyl Medial > Anterior > Posterior > Lateral 

Group | Region Morphine Medial > Anterior > Posterior > Lateral 

Pore Density Trends 

Region Medial > Lateral > Anterior > Posterior 

Group Fentanyl > Morphine > Control 

Region | Group Anterior Fentanyl > Morphine > Control 

Region | Group Lateral Fentanyl > Morphine > Control 

Region | Group Medial Fentanyl > Morphine > Control 

Region | Group Posterior Fentanyl > Morphine > Control 

Group | Region Control Medial > Lateral > Anterior > Posterior 

Group | Region Fentanyl Medial > Lateral > Anterior > Posterior 

Group | Region Morphine Medial > Lateral > Anterior > Posterior 

Euler number Trends 

Region Medial > Anterior > Posterior > Lateral 

Group Fentanyl > Morphine > Control 

Region | Group Anterior Fentanyl > Morphine > Control 

Region | Group Lateral Fentanyl > Morphine > Control 

Region | Group Medial Fentanyl > Morphine > Control 

Region | Group Posterior Morphine > Fentanyl > Control 

Group | Region Control Medial > Anterior > Posterior > Lateral 

Group | Region Fentanyl Medial > Anterior > Posterior > Lateral 

Group | Region Morphine Anterior > Medial > Posterior > Lateral 

Connectivity Trends 

Region Posterior > Medial > Anterior > Lateral 

Group Control > Fentanyl > Morphine 

Region | Group Anterior Control > Fentanyl > Morphine 

Region | Group Lateral Fentanyl > Control > Morphine 

Region | Group Medial Control > Morphine > Fentanyl 

Region | Group Posterior Control > Fentanyl > Morphine 

Group | Region Control Posterior > Medial > Anterior > Lateral 

Group | Region Fentanyl Posterior > Medial > Lateral > Anterior 
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Group | Region Morphine Medial > Posterior > Anterior > Lateral 

Connectivity density Trends 

Region Medial > Posterior > Lateral > Anterior 

Group Fentanyl > Morphine > Control 

Region | Group Anterior Fentanyl > Morphine > Control 

Region | Group Lateral Fentanyl > Morphine > Control 

Region | Group Medial Fentanyl > Morphine > Control 

Region | Group Posterior Fentanyl > Morphine > Control 

Group | Region Control Medial > Posterior > Lateral > Anterior 

Group | Region Fentanyl Lateral > Medial > Posterior > Anterior 

Group | Region Morphine Medial > Posterior > Lateral > Anterior 

SD Pore Thickness Trends 

Region Medial > Posterior > Anterior > Lateral 

Group Control > Morphine > Fentanyl 

Region | Group Anterior Control > Morphine > Fentanyl 

Region | Group Lateral Control > Morphine > Fentanyl 

Region | Group Medial Control > Morphine > Fentanyl 

Region | Group Posterior Control > Morphine > Fentanyl 

Group | Region Control Anterior > Medial > Lateral > Posterior 

Group | Region Fentanyl Medial > Posterior > Anterior > Lateral 

Group | Region Morphine Posterior > Medial > Anterior > Lateral 

SD Pore Separation Trends 

Region Anterior > Posterior > Lateral > Medial 

Group Control > Morphine > Fentanyl 

Region | Group Anterior Control > Morphine > Fentanyl 

Region | Group Lateral Control > Morphine > Fentanyl 

Region | Group Medial Control > Morphine > Fentanyl 

Region | Group Posterior Control > Morphine > Fentanyl 

Group | Region Control Anterior > Lateral > Medial > Posterior 

Group | Region Fentanyl Anterior > Posterior > Lateral > Medial 

Group | Region Morphine Anterior > Posterior > Lateral > Medial 

Avg. Por. Vol. Trends 

Region Posterior > Medial > Anterior > Lateral 

Group Control > Morphine > Fentanyl 

Region | Group Anterior Control > Morphine > Fentanyl 

Region | Group Lateral Control > Morphine > Fentanyl 

Region | Group Medial Control > Morphine > Fentanyl 

Region | Group Posterior Control > Morphine > Fentanyl 

Group | Region Control Anterior > Posterior > Medial > Lateral 

Group | Region Fentanyl Medial > Lateral > Posterior > Anterior 

Group | Region Morphine Posterior > Anterior > Medial > Lateral 
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Avg. Por. Surf Trends 

Region Posterior > Medial > Lateral > Anterior 

Group Control > Morphine > Fentanyl 

Region | Group Anterior Control > Morphine > Fentanyl 

Region | Group Lateral Control > Morphine > Fentanyl 

Region | Group Medial Control > Morphine > Fentanyl 

Region | Group Posterior Control > Morphine > Fentanyl 

Group | Region Control Posterior > Anterior > Medial > Lateral 

Group | Region Fentanyl Medial > Lateral > Posterior > Anterior 

Group | Region Morphine Posterior > Anterior > Lateral > Medial 

Avg. Orientation theta Trends 

Region Lateral > Posterior > Anterior > Medial 

Group Fentanyl > Control > Morphine 

Region | Group Anterior Morphine > Fentanyl > Control 

Region | Group Lateral Fentanyl > Control > Morphine 

Region | Group Medial Control > Morphine > Fentanyl 

Region | Group Posterior Fentanyl > Control > Morphine 

Group | Region Control Lateral > Posterior > Anterior > Medial 

Group | Region Fentanyl Lateral > Posterior > Anterior > Medial 

Group | Region Morphine Lateral > Anterior > Posterior > Medial 

Avg. Orientation phi Trends 

Region Posterior > Lateral > Medial > Anterior 

Group Morphine > Control > Fentanyl 

Region | Group Anterior Morphine > Control > Fentanyl 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Morphine > Control > Fentanyl 

Region | Group Posterior Morphine > Control > Fentanyl 

Group | Region Control Posterior > Lateral > Medial > Anterior 

Group | Region Fentanyl Posterior > Lateral > Medial > Anterior 

Group | Region Morphine Posterior > Lateral > Medial > Anterior 

Avg. Major Pore diameter Trends 

Region Posterior > Lateral > Medial > Anterior 

Group Control > Fentanyl > Morphine 

Region | Group Anterior Control > Morphine > Fentanyl 

Region | Group Lateral Control > Morphine > Fentanyl 

Region | Group Medial Control > Morphine > Fentanyl 

Region | Group Posterior Control > Morphine > Fentanyl 

Group | Region Control Posterior > Medial > Lateral > Anterior 

Group | Region Fentanyl Lateral > Medial > Posterior > Anterior 

Group | Region Morphine Posterior > Medial > Anterior > Lateral 

Sphericity Trends 
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Region Anterior > Medial > Lateral > Posterior 

Group Morphine > Control > Fentanyl 

Region | Group Anterior Control > Fentanyl > Morphine 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Morphine > Control > Fentanyl 

Region | Group Posterior Morphine > Control > Fentanyl 

Group | Region Control Anterior > Medial > Lateral > Posterior 

Group | Region Fentanyl Anterior > Medial > Lateral > Posterior 

Group | Region Morphine Anterior > Medial > Lateral > Posterior 
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Appendix XXIII: Micro-CT Linear Mixed Model for Tibial Regions 

Tibial Regions: LMM Fixed Effects and Random Effects 

Cortical 
Fractal 

Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.203 -0.366 0.386 0 1 0.993 

Region1 -0.163 0.0887 -0.32 0.0184 -1.84 0.0711 . 0.0712 . 

Region2 -0.0466 0.0887 -0.201 0.124 -0.525 0.602 0.581 

Region3 0.237 0.0887 0.0593 0.402 2.67 0.0099 ** 0.00772 ** 

Group1 -0.336 0.287 -0.885 0.245 -1.17 0.257 0.254 

Group2 0.188 0.287 -0.388 0.8 0.655 0.521 0.545 

Region1:Group1 -0.0467 0.125 -0.325 0.197 -0.372 0.711 0.704 

Region2:Group1 -0.208 0.125 -0.464 0.0717 -1.66 0.102 0.102 

Region3:Group1 0.102 0.125 -0.152 0.363 0.81 0.421 0.418 

Region1:Group2 0.283 0.125 0.027 0.53 2.26 0.0282 * 0.0309 * 

Region2:Group2 0.0324 0.125 -0.207 0.286 0.258 0.798 0.818 

Region3:Group2 -0.0482 0.125 -0.308 0.187 -0.384 0.702 0.704 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.808 0.899 0.636 1.33 78.6 4.66E-15 *** R2M/R2C 0.0946 / 0.806 

Residual 0.22 0.469 0.371 0.542 21.4 AIC/BIC 213 / 247 
Number Closed 

Pores 
Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.2 -0.394 0.36 0 1 0.999 

Region1 0.399 0.0778 0.247 0.552 5.13 0.000004 *** 0.000175 *** 

Region2 0.00882 0.0778 -0.123 0.163 0.113 0.91 0.918 

Region3 -0.185 0.0778 -0.319 -0.0421 -2.38 0.0207 * 0.0204 * 

Group1 -0.394 0.282 -0.94 0.125 -1.39 0.18 0.187 

Group2 0.303 0.282 -0.183 0.901 1.07 0.298 0.317 

Region1:Group1 -0.0835 0.11 -0.299 0.121 -0.759 0.451 0.451 

Region2:Group1 -0.0801 0.11 -0.319 0.133 -0.728 0.47 0.479 

Region3:Group1 0.192 0.11 -0.0484 0.426 1.75 0.086 . 0.094 . 

Region1:Group2 0.234 0.11 0.0156 0.45 2.13 0.0377 * 0.0386 * 

Region2:Group2 -0.0825 0.11 -0.27 0.125 -0.75 0.457 0.455 

Region3:Group2 -0.126 0.11 -0.345 0.0966 -1.14 0.258 0.273 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.795 0.892 0.621 1.29 82.4 2.79E-17 *** R2M/R2C 0.145 / 0.85 

Residual 0.169 0.412 0.328 0.474 17.6 AIC/BIC 199 / 233 
Number Open 

Pores 
Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 
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(Intercept) 0 0.202 -0.403 0.412 0 1 0.998 

Region1 0.401 0.0834 0.247 0.552 4.81 1.25E-05 *** 0.000175 *** 

Region2 -0.314 0.0834 -0.467 -0.158 -3.76 0.000418 *** 0.000175 *** 

Region3 -0.0248 0.0834 -0.192 0.144 -0.298 0.767 0.786 

Group1 -0.243 0.285 -0.806 0.337 -0.85 0.406 0.396 

Group2 0.219 0.285 -0.348 0.75 0.766 0.454 0.46 

Region1:Group1 0.000371 0.118 -0.213 0.243 
0.0031 

5 
0.998 0.994 

Region2:Group1 -0.155 0.118 -0.423 0.0687 -1.31 0.195 0.199 

Region3:Group1 0.185 0.118 -0.0415 0.433 1.57 0.122 0.124 

Region1:Group2 0.283 0.118 0.0359 0.515 2.4 0.0197 * 0.0175 * 

Region2:Group2 0.0371 0.118 -0.213 0.271 0.314 0.755 0.761 

Region3:Group2 -0.127 0.118 -0.356 0.106 -1.07 0.288 0.286 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.806 0.898 0.636 1.3 80.6 3.85E-16 *** R2M/R2C 0.116 / 0.828 

Residual 0.195 0.441 0.349 0.512 19.4 AIC/BIC 207 / 241 
Closed Pore 

Density 
Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.197 -0.441 0.395 0 1 0.998 

Region1 -0.197 0.0771 -0.337 -0.0532 -2.55 0.0135 * 0.0133 * 

Region2 0.429 0.0771 0.289 0.585 5.56 9E-07 *** 0.000175 *** 

Region3 0.198 0.0771 0.0586 0.348 2.56 0.0131 * 0.0147 * 

Group1 -0.291 0.278 -0.873 0.281 -1.05 0.309 0.313 

Group2 0.266 0.278 -0.277 0.8 0.955 0.352 0.358 

Region1:Group1 0.0292 0.109 -0.169 0.245 0.268 0.79 0.789 

Region2:Group1 -0.23 0.109 -0.45 -0.0307 -2.11 0.0395 * 0.0474 * 

Region3:Group1 0.231 0.109 0.00349 0.442 2.12 0.0388 * 0.0389 * 

Region1:Group2 0.132 0.109 -0.0705 0.327 1.21 0.232 0.22 

Region2:Group2 0.00379 0.109 -0.218 0.22 0.0347 0.972 0.972 

Region3:Group2 -0.115 0.109 -0.321 0.105 -1.05 0.297 0.285 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.773 0.879 0.629 1.28 82.3 3.55E-17 *** R2M/R2C 0.165 / 0.852 

Residual 0.167 0.408 0.322 0.473 17.7 AIC/BIC 197 / 231 
Open Pore 

Density 
Lambda = -0.225 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.2 -0.387 0.402 0 1 0.999 

Region1 -0.259 0.0903 -0.443 -0.0912 -2.87 0.00581 ** 0.00456 ** 

Region2 0.0458 0.0903 -0.125 0.247 0.507 0.614 0.626 

Region3 0.422 0.0903 0.24 0.611 4.68 0.00002 *** 0.000175 *** 

327 
2018-DU-BX-0188 Final Technical Report 
October 2021 

This resource was prepared by the author(s) using Federal funds provided by the U.S. 
Department of Justice. Opinions or points of view expressed are those of the author(s) and do not 

necessarily reflect the official position or policies of the U.S. Department of Justice.



 
 

          

          

          

          

          

          

          

          

      
 

  
 

 

         

         
  

 
   

           

          

          

          

          

          

          

          

          

          

          

          

          

           

         

         
  

    

           

          

          

          

          

          

          

          

          

          

Group1 -0.161 0.283 -0.826 0.431 -0.568 0.577 0.572 

Group2 0.188 0.283 -0.393 0.71 0.665 0.515 0.512 

Region1:Group1 0.0826 0.128 -0.171 0.339 0.647 0.52 0.509 

Region2:Group1 -0.215 0.128 -0.446 0.039 -1.68 0.0988 . 0.0923 . 

Region3:Group1 0.165 0.128 -0.0983 0.402 1.29 0.203 0.212 

Region1:Group2 0.213 0.128 -0.0217 0.456 1.67 0.101 0.0926 . 

Region2:Group2 0.0132 0.128 -0.203 0.283 0.104 0.918 0.925 

Region3:Group2 -0.0694 0.128 -0.312 0.179 -0.543 0.589 0.587 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.783 0.885 0.623 1.27 77.4 1.81E-14 *** R2M/R2C 0.108 / 0.798 

Residual 0.229 0.478 0.379 0.559 22.6 AIC/BIC 218 / 252 
Closed Porosity 

(%) 
Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.198 -0.437 0.397 0 1 0.991 

Region1 -0.265 0.0942 -0.438 -0.0921 -2.81 0.00688 ** 0.00421 ** 

Region2 -0.157 0.0942 -0.349 0.0149 -1.67 0.1 0.105 

Region3 0.18 0.0942 -0.00342 0.345 1.91 0.062 . 0.0726 . 

Group1 -0.309 0.28 -0.86 0.173 -1.11 0.283 0.289 

Group2 0.087 0.28 -0.564 0.608 0.311 0.759 0.764 

Region1:Group1 -0.0186 0.133 -0.274 0.274 -0.14 0.889 0.889 

Region2:Group1 -0.227 0.133 -0.502 0.0208 -1.7 0.094 . 0.0951 . 

Region3:Group1 0.117 0.133 -0.124 0.383 0.88 0.383 0.388 

Region1:Group2 0.128 0.133 -0.14 0.394 0.96 0.341 0.338 

Region2:Group2 0.176 0.133 -0.0671 0.445 1.32 0.191 0.18 

Region3:Group2 0.0312 0.133 -0.25 0.318 0.234 0.816 0.819 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.759 0.871 0.594 1.27 75.3 1.69E-13 *** R2M/R2C 0.111 / 0.781 

Residual 0.248 0.498 0.403 0.573 24.7 AIC/BIC 219 / 253 
Open Porosity 

(%) Lambda = -0.125 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.155 -0.297 0.32 0 1 0.988 

Region1 0.223 0.11 0.0122 0.442 2.02 0.0485 * 0.054 . 

Region2 -0.853 0.11 -1.08 -0.626 -7.73 0 *** 0.000175 *** 

Region3 0.114 0.11 -0.121 0.334 1.03 0.305 0.322 

Group1 -0.0699 0.219 -0.48 0.378 -0.32 0.753 0.755 

Group2 -0.112 0.219 -0.526 0.299 -0.514 0.613 0.641 

Region1:Group1 -0.241 0.156 -0.567 0.0643 -1.55 0.128 0.131 

Region2:Group1 -0.118 0.156 -0.418 0.187 -0.755 0.454 0.44 

Region3:Group1 -0.0414 0.156 -0.368 0.24 -0.266 0.792 0.784 
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Region1:Group2 0.444 0.156 0.142 0.756 2.84 0.00629 ** 0.00491 ** 

Region2:Group2 0.0465 0.156 -0.25 0.319 0.298 0.767 0.773 

Region3:Group2 -0.0387 0.156 -0.354 0.275 -0.248 0.805 0.809 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.417 0.646 0.421 0.969 55 4.23E-07 *** R2M/R2C 0.311 / 0.69 

Residual 0.341 0.584 0.461 0.682 45 AIC/BIC 241 / 275 
Total Porosity 

(%) 
Lambda = 0.275 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.176 -0.311 0.355 0 1 0.993 

Region1 0.022 0.103 -0.183 0.235 0.214 0.831 0.831 

Region2 -0.634 0.103 -0.845 -0.418 -6.17 1E-07 *** 0.000175 *** 

Region3 0.155 0.103 -0.0376 0.361 1.5 0.138 0.149 

Group1 -0.181 0.249 -0.736 0.346 -0.727 0.477 0.467 

Group2 -0.0326 0.249 -0.586 0.461 -0.131 0.897 0.92 

Region1:Group1 -0.191 0.145 -0.471 0.11 -1.31 0.195 0.195 

Region2:Group1 -0.194 0.145 -0.507 0.104 -1.33 0.189 0.203 

Region3:Group1 0.00688 0.145 -0.249 0.282 0.0473 0.962 0.968 

Region1:Group2 0.388 0.145 0.0925 0.692 2.67 0.0101 * 0.00947 ** 

Region2:Group2 0.113 0.145 -0.187 0.398 0.775 0.442 0.445 

Region3:Group2 -0.0187 0.145 -0.32 0.274 -0.129 0.898 0.902 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.575 0.758 0.511 1.11 66 5.20E-10 *** R2M/R2C 0.219 / 0.734 

Residual 0.296 0.544 0.428 0.64 34 AIC/BIC 234 / 268 
Cortical 
Volume 

Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.108 -0.228 0.217 0 1 0.977 

Region1 1.19 0.0646 1.06 1.32 18.3 0 *** 0.000175 *** 

Region2 -0.777 0.0646 -0.907 -0.653 -12 0 *** 0.000175 *** 

Region3 -0.748 0.0646 -0.866 -0.61 -11.6 0 *** 0.000175 *** 

Group1 -0.212 0.153 -0.52 0.0532 -1.38 0.183 0.187 

Group2 0.0309 0.153 -0.245 0.361 0.202 0.843 0.855 

Region1:Group1 -0.129 0.0914 -0.3 0.0563 -1.41 0.164 0.158 

Region2:Group1 0.145 0.0914 -0.0464 0.33 1.59 0.118 0.113 

Region3:Group1 -0.0378 0.0914 -0.205 0.156 -0.414 0.681 0.674 

Region1:Group2 0.0619 0.0914 -0.107 0.249 0.678 0.501 0.495 

Region2:Group2 -0.0818 0.0914 -0.261 0.108 -0.895 0.375 0.364 

Region3:Group2 0.0581 0.0914 -0.109 0.259 0.636 0.528 0.519 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 
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Sample 0.217 0.466 0.296 0.681 65 1.06E-09 *** R2M/R2C 0.68 / 0.888 

Residual 0.117 0.342 0.267 0.397 35 AIC/BIC 157 / 191 

Pore Volume Lambda = 0.15 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.16 -0.303 0.322 0 1 0.995 

Region1 0.456 0.0941 0.278 0.628 4.85 0.000011 *** 0.000175 *** 

Region2 -0.811 0.0941 -0.995 -0.618 -8.61 0 *** 0.000175 *** 

Region3 -0.164 0.0941 -0.357 0.00954 -1.74 0.0874 . 0.0916 . 

Group1 -0.239 0.226 -0.657 0.168 -1.06 0.304 0.324 

Group2 -0.00938 0.226 -0.509 0.4 
-

0.0416 
0.967 0.967 

Region1:Group1 -0.197 0.133 -0.447 0.109 -1.48 0.144 0.149 

Region2:Group1 -0.104 0.133 -0.356 0.158 -0.785 0.436 0.438 

Region3:Group1 -0.0253 0.133 -0.28 0.217 -0.19 0.85 0.87 

Region1:Group2 0.341 0.133 0.0726 0.596 2.56 0.0132 * 0.014 * 

Region2:Group2 0.0531 0.133 -0.195 0.309 0.399 0.692 0.686 

Region3:Group2 0.017 0.133 -0.246 0.305 0.127 0.899 0.92 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.474 0.688 0.484 1.01 65.6 6.79E-10 *** R2M/R2C 0.341 / 0.774 

Residual 0.248 0.498 0.398 0.575 34.4 AIC/BIC 226 / 260 
Cortical 
Surface 

Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.122 -0.251 0.237 0 1 0.968 

Region1 1 0.0577 0.897 1.12 17.4 0 *** 0.000175 *** 

Region2 -0.46 0.0577 -0.582 -0.348 -7.98 0 *** 0.000175 *** 

Region3 -1.03 0.0577 -1.14 -0.925 -17.8 0 *** 0.000175 *** 

Group1 -0.214 0.173 -0.572 0.118 -1.24 0.23 0.231 

Group2 0.0136 0.173 -0.315 0.379 0.0787 0.938 0.945 

Region1:Group1 0.0176 0.0815 -0.132 0.202 0.216 0.83 0.819 

Region2:Group1 0.0494 0.0815 -0.115 0.201 0.606 0.547 0.567 

Region3:Group1 0.0622 0.0815 -0.113 0.225 0.763 0.449 0.451 

Region1:Group2 -0.00255 0.0815 -0.162 0.159 
-

0.0312 
0.975 0.967 

Region2:Group2 -0.0333 0.0815 -0.192 0.121 -0.409 0.685 0.673 

Region3:Group2 -0.0311 0.0815 -0.192 0.152 -0.381 0.705 0.692 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.29 0.538 0.387 0.796 75.7 1.16E-13 *** R2M/R2C 0.635 / 0.911 

Residual 0.0931 0.305 0.245 0.355 24.3 AIC/BIC 149 / 183 

Pore Surface Lambda = 0.425 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 
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(Intercept) 0 0.186 -0.386 0.352 0 1 0.982 

Region1 0.468 0.0838 0.303 0.632 5.59 8E-07 *** 0.000175 *** 

Region2 -0.576 0.0838 -0.739 -0.406 -6.87 0 *** 0.000175 *** 

Region3 -0.142 0.0838 -0.325 0.0414 -1.69 0.0968 . 0.0965 . 

Group1 -0.335 0.263 -0.871 0.189 -1.27 0.219 0.238 

Group2 0.128 0.263 -0.392 0.655 0.487 0.632 0.653 

Region1:Group1 -0.111 0.119 -0.357 0.129 -0.936 0.353 0.37 

Region2:Group1 -0.0906 0.119 -0.313 0.154 -0.765 0.448 0.433 

Region3:Group1 0.0356 0.119 -0.205 0.254 0.3 0.765 0.775 

Region1:Group2 0.288 0.119 0.0715 0.508 2.43 0.0186 * 0.0175 * 

Region2:Group2 0.0269 0.119 -0.206 0.281 0.227 0.821 0.795 

Region3:Group2 -0.00613 0.119 -0.246 0.245 
-

0.0518 
0.959 0.948 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.677 0.823 0.59 1.2 77.5 1.64E-14 *** R2M/R2C 0.217 / 0.824 

Residual 0.197 0.443 0.349 0.514 22.5 AIC/BIC 213 / 247 
Intersection 

Surface 
Lambda = 0.1 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.143 -0.277 0.28 0 1 0.998 

Region1 -0.0311 0.115 -0.28 0.19 -0.27 0.788 0.791 

Region2 -0.885 0.115 -1.11 -0.655 -7.69 0 *** 0.000175 *** 

Region3 0.387 0.115 0.157 0.612 3.36 0.00143 ** 0.0014 ** 

Group1 -0.0745 0.202 -0.522 0.294 -0.37 0.716 0.719 

Group2 -0.0477 0.202 -0.446 0.368 -0.237 0.816 0.813 

Region1:Group1 -0.158 0.163 -0.448 0.122 -0.972 0.335 0.342 

Region2:Group1 -0.185 0.163 -0.486 0.121 -1.14 0.26 0.255 

Region3:Group1 0.156 0.163 -0.176 0.468 0.956 0.343 0.345 

Region1:Group2 0.527 0.163 0.235 0.816 3.24 0.00207 ** 0.000351 *** 

Region2:Group2 -0.0332 0.163 -0.339 0.255 -0.204 0.839 0.844 

Region3:Group2 -0.0367 0.163 -0.333 0.28 -0.226 0.822 0.814 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.334 0.578 0.355 0.865 47.4 1.49E-05 *** R2M/R2C 0.355 / 0.661 

Residual 0.371 0.609 0.486 0.696 52.6 AIC/BIC 247 / 281 
Pore Surface: 
PoreVolume 

Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.13 -0.237 0.273 0 1 0.984 

Region1 -0.25 0.103 -0.461 -0.0274 -2.41 0.0193 * 0.0242 * 

Region2 0.945 0.103 0.736 1.14 9.13 0 *** 0.000175 *** 

Region3 0.107 0.103 -0.119 0.314 1.03 0.307 0.308 
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Group1 -0.139 0.184 -0.534 0.217 -0.753 0.461 0.485 

Group2 0.306 0.184 -0.0533 0.676 1.66 0.114 0.12 

Region1:Group1 0.268 0.146 -0.0426 0.559 1.83 0.0727 . 0.0768 . 

Region2:Group1 0.0176 0.146 -0.313 0.268 0.121 0.904 0.914 

Region3:Group1 0.138 0.146 -0.149 0.383 0.945 0.349 0.357 

Region1:Group2 -0.279 0.146 -0.565 0.00801 -1.91 0.0618 . 0.0656 . 

Region2:Group2 -0.0649 0.146 -0.357 0.237 -0.443 0.659 0.65 

Region3:Group2 0.0055 0.146 -0.309 0.265 0.0376 0.97 0.952 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.281 0.53 0.33 0.791 48.4 9.69E-06 *** R2M/R2C 0.461 / 0.722 

Residual 0.3 0.547 0.439 0.641 51.6 AIC/BIC 214 / 248 
Pore Surface: 

Cortical 
Volume 

Lambda = 0.525 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.203 -0.374 0.416 0 1 0.998 

Region1 -0.0786 0.0886 -0.262 0.0912 -0.887 0.379 0.39 

Region2 -0.274 0.0886 -0.45 -0.0774 -3.09 0.00315 ** 0.00456 ** 

Region3 0.263 0.0886 0.0832 0.429 2.97 0.0044 ** 0.00386 ** 

Group1 -0.269 0.286 -0.844 0.301 -0.938 0.361 0.391 

Group2 0.121 0.286 -0.455 0.666 0.423 0.677 0.717 

Region1:Group1 -0.0496 0.125 -0.275 0.185 -0.396 0.694 0.691 

Region2:Group1 -0.215 0.125 -0.454 0.0372 -1.71 0.0921 . 0.0884 . 

Region3:Group1 0.0773 0.125 -0.184 0.304 0.617 0.54 0.551 

Region1:Group2 0.281 0.125 0.0225 0.531 2.24 0.0289 * 0.0267 * 

Region2:Group2 0.0975 0.125 -0.181 0.359 0.778 0.44 0.445 

Region3:Group2 -0.0394 0.125 -0.283 0.19 -0.314 0.755 0.754 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.807 0.898 0.613 1.3 78.6 4.67E-15 *** R2M/R2C 0.0963 / 0.806 

Residual 0.22 0.469 0.373 0.546 21.4 AIC/BIC 217 / 251 

Pore Thickness Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.134 -0.294 0.278 0 1 0.98 

Region1 0.0803 0.109 -0.13 0.294 0.737 0.464 0.459 

Region2 -0.818 0.109 -1.03 -0.589 -7.5 0 *** 0.000175 *** 

Region3 -0.13 0.109 -0.353 0.0865 -1.19 0.239 0.226 

Group1 0.147 0.189 -0.236 0.561 0.778 0.447 0.47 

Group2 -0.308 0.189 -0.701 0.068 -1.63 0.121 0.132 

Region1:Group1 -0.309 0.154 -0.642 0.0297 -2.01 0.0496 * 0.0533 . 

Region2:Group1 -0.066 0.154 -0.328 0.233 -0.428 0.67 0.678 

Region3:Group1 -0.0581 0.154 -0.356 0.225 -0.377 0.707 0.704 
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Region1:Group2 0.311 0.154 7.13E-05 0.619 2.02 0.0486 * 0.0502 . 

Region2:Group2 0.0783 0.154 -0.23 0.369 0.508 0.613 0.619 

Region3:Group2 -0.0476 0.154 -0.355 0.244 -0.309 0.759 0.749 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.292 0.54 0.34 0.837 46.8 1.93E-05 *** R2M/R2C 0.423 / 0.693 

Residual 0.332 0.577 0.443 0.668 53.2 AIC/BIC 221 / 255 
Pore 

Separation 
Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.191 -0.374 0.418 0 1 0.974 

Region1 0.488 0.0939 0.302 0.669 5.2 3.1E-06 *** 0.000175 *** 

Region2 -0.268 0.0939 -0.428 -0.098 -2.85 0.00616 ** 0.00632 ** 

Region3 -0.341 0.0939 -0.517 -0.156 -3.63 0.000621 *** 0.0014 ** 

Group1 0.286 0.27 -0.211 0.817 1.06 0.304 0.313 

Group2 -0.171 0.27 -0.659 0.349 -0.635 0.533 0.533 

Region1:Group1 0.0208 0.133 -0.23 0.28 0.157 0.876 0.871 

Region2:Group1 0.207 0.133 -0.0591 0.483 1.56 0.125 0.132 

Region3:Group1 -0.121 0.133 -0.392 0.165 -0.909 0.367 0.36 

Region1:Group2 -0.258 0.133 -0.514 0.026 -1.94 0.0573 . 0.0544 . 

Region2:Group2 -0.00654 0.133 -0.281 0.242 
-

0.0492 
0.961 0.948 

Region3:Group2 0.107 0.133 -0.145 0.357 0.807 0.423 0.419 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.702 0.838 0.596 1.24 74 6.57E-13 *** R2M/R2C 0.157 / 0.781 

Residual 0.247 0.497 0.385 0.583 26 AIC/BIC 217 / 251 

Pore Tb.N Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.203 -0.356 0.405 0 1 0.995 

Region1 -0.0898 0.0875 -0.266 0.0952 -1.03 0.31 0.295 

Region2 -0.0416 0.0875 -0.212 0.125 -0.475 0.637 0.648 

Region3 0.269 0.0875 0.0971 0.452 3.07 0.00332 ** 0.00421 ** 

Group1 -0.308 0.287 -0.873 0.263 -1.07 0.298 0.305 

Group2 0.243 0.287 -0.325 0.809 0.848 0.408 0.43 

Region1:Group1 0.036 0.124 -0.23 0.304 0.29 0.773 0.772 

Region2:Group1 -0.255 0.124 -0.505 0.00619 -2.06 0.0445 * 0.04 * 

Region3:Group1 0.113 0.124 -0.145 0.358 0.909 0.367 0.363 

Region1:Group2 0.192 0.124 -0.0757 0.437 1.55 0.126 0.133 

Region2:Group2 0.156 0.124 -0.0709 0.406 1.26 0.213 0.207 

Region3:Group2 -0.0372 0.124 -0.249 0.222 -0.3 0.765 0.774 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 
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Sample 0.812 0.901 0.635 1.29 79.1 2.47E-15 *** R2M/R2C 0.0962 / 0.811 

Residual 0.215 0.463 0.367 0.54 20.9 AIC/BIC 212 / 246 
Degree of 

Anisotropy 
Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.167 -0.349 0.324 0 1 0.998 

Region1 0.362 0.111 0.152 0.58 3.25 0.002 ** 0.0014 ** 

Region2 -0.74 0.111 -0.966 -0.542 -6.65 0 *** 0.000175 *** 

Region3 -0.0753 0.111 -0.285 0.132 -0.676 0.502 0.509 

Group1 0.0516 0.237 -0.373 0.562 0.218 0.83 0.838 

Group2 -0.0316 0.237 -0.526 0.402 -0.134 0.895 0.889 

Region1:Group1 -0.117 0.157 -0.476 0.197 -0.74 0.463 0.45 

Region2:Group1 -0.247 0.157 -0.565 0.0403 -1.57 0.123 0.127 

Region3:Group1 -0.0228 0.157 -0.337 0.3 -0.145 0.886 0.916 

Region1:Group2 0.131 0.157 -0.21 0.442 0.83 0.41 0.406 

Region2:Group2 0.204 0.157 -0.0818 0.536 1.3 0.2 0.191 

Region3:Group2 0.0565 0.157 -0.243 0.351 0.359 0.721 0.738 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.501 0.708 0.482 1.04 59.1 4.52E-08 *** R2M/R2C 0.237 / 0.688 

Residual 0.347 0.589 0.475 0.678 40.9 AIC/BIC 231 / 265 

Pore Fractal Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.201 -0.416 0.365 0 1 0.986 

Region1 -0.0597 0.0864 -0.227 0.102 -0.691 0.492 0.486 

Region2 -0.215 0.0864 -0.383 -0.0399 -2.49 0.0157 * 0.0147 * 

Region3 0.26 0.0864 0.111 0.438 3.01 0.00401 ** 0.00386 ** 

Group1 -0.358 0.285 -0.955 0.141 -1.26 0.225 0.239 

Group2 0.167 0.285 -0.433 0.704 0.586 0.565 0.598 

Region1:Group1 -0.0578 0.122 -0.287 0.178 -0.473 0.638 0.651 

Region2:Group1 -0.193 0.122 -0.455 0.0608 -1.58 0.12 0.121 

Region3:Group1 0.0617 0.122 -0.17 0.283 0.505 0.615 0.614 

Region1:Group2 0.293 0.122 0.0425 0.534 2.4 0.0199 * 0.0204 * 

Region2:Group2 0.0105 0.122 -0.223 0.231 0.0861 0.932 0.918 

Region3:Group2 -0.00953 0.122 -0.234 0.234 -0.078 0.938 0.92 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) 

p-value Sig. 
Model 
Test 

Model Fit 

Sample 0.8 0.894 0.627 1.26 79.3 1.98E-15 *** R2M/R2C 0.11 / 0.816 

Residual 0.209 0.457 0.359 0.528 20.7 AIC/BIC 210 / 244 
Number of 

Pores 
Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.201 -0.42 0.386 0 1 0.981 
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Region1 0.404 0.077 0.265 0.552 5.25 2.7E-06 *** 0.000175 *** 

Region2 -0.0327 0.077 -0.182 0.123 -0.425 0.673 0.67 

Region3 -0.167 0.077 -0.323 -0.0242 -2.16 0.0348 * 0.0389 * 

Group1 -0.378 0.284 -0.925 0.195 -1.33 0.2 0.215 

Group2 0.295 0.284 -0.247 0.848 1.04 0.313 0.33 

Region1:Group1 -0.0735 0.109 -0.274 0.125 -0.676 0.502 0.505 

Region2:Group1 -0.0906 0.109 -0.291 0.118 -0.832 0.409 0.391 

Region3:Group1 0.193 0.109 -0.0465 0.403 1.78 0.0811 . 0.0768 . 

Region1:Group2 0.243 0.109 0.0325 0.461 2.23 0.0297 * 0.0263 * 

Region2:Group2 -0.0679 0.109 -0.293 0.13 -0.624 0.535 0.528 

Region3:Group2 -0.127 0.109 -0.337 0.086 -1.17 0.248 0.241 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.807 0.899 0.663 1.33 83 1.25E-17 *** R2M/R2C 0.138 / 0.853 

Residual 0.166 0.407 0.329 0.465 17 AIC/BIC 198 / 232 

Pore Density Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.199 -0.374 0.441 0 1 0.999 

Region1 -0.206 0.0773 -0.355 -0.0457 -2.66 0.0102 * 0.0137 * 

Region2 0.387 0.0773 0.227 0.531 5.01 6.3E-06 *** 0.000175 *** 

Region3 0.231 0.0773 0.09 0.397 2.99 0.00415 ** 0.00246 ** 

Group1 -0.27 0.281 -0.836 0.287 -0.96 0.35 0.36 

Group2 0.256 0.281 -0.28 0.822 0.911 0.374 0.389 

Region1:Group1 0.0363 0.109 -0.172 0.245 0.332 0.741 0.74 

Region2:Group1 -0.243 0.109 -0.43 -0.0303 -2.22 0.0306 * 0.0344 * 

Region3:Group1 0.238 0.109 0.014 0.451 2.18 0.0337 * 0.0351 * 

Region1:Group2 0.138 0.109 -0.0751 0.336 1.27 0.211 0.209 

Region2:Group2 0.023 0.109 -0.209 0.256 0.21 0.834 0.812 

Region3:Group2 -0.12 0.109 -0.325 0.0998 -1.1 0.276 0.264 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.786 0.886 0.619 1.26 82.4 2.73E-17 *** R2M/R2C 0.154 / 0.851 

Residual 0.167 0.409 0.319 0.478 17.6 AIC/BIC 198 / 232 

Euler number Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.2 -0.442 0.381 0 1 0.976 

Region1 0.237 0.0819 0.0904 0.399 2.9 0.00542 ** 0.00491 ** 

Region2 0.109 0.0819 -0.0402 0.271 1.33 0.19 0.186 

Region3 -0.138 0.0819 -0.29 0.00545 -1.68 0.0986 . 0.0888 . 

Group1 -0.389 0.283 -0.962 0.183 -1.38 0.186 0.204 

Group2 0.365 0.283 -0.194 0.902 1.29 0.213 0.214 
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Region1:Group1 -0.00403 0.116 -0.214 0.207 
-

0.0348 
0.972 0.984 

Region2:Group1 -0.154 0.116 -0.387 0.0747 -1.33 0.189 0.188 

Region3:Group1 0.223 0.116 -0.00935 0.467 1.92 0.0596 . 0.0674 . 

Region1:Group2 0.18 0.116 -0.0279 0.384 1.55 0.126 0.134 

Region2:Group2 -0.0811 0.116 -0.333 0.138 -0.7 0.487 0.488 

Region3:Group2 -0.124 0.116 -0.339 0.104 -1.07 0.291 0.315 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.793 0.891 0.637 1.29 80.9 2.56E-16 *** R2M/R2C 0.132 / 0.834 

Residual 0.188 0.433 0.344 0.511 19.1 AIC/BIC 204 / 238 

Connectivity Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.185 -0.398 0.368 0 1 0.992 

Region1 0.69 0.0897 0.508 0.887 7.69 0 *** 0.000175 *** 

Region2 -0.342 0.0897 -0.524 -0.167 -3.81 0.000358 *** 0.000351 *** 

Region3 -0.196 0.0897 -0.377 -0.018 -2.18 0.0334 * 0.0351 * 

Group1 -0.273 0.262 -0.767 0.257 -1.04 0.311 0.327 

Group2 0.0756 0.262 -0.435 0.576 0.289 0.776 0.81 

Region1:Group1 -0.213 0.127 -0.447 0.0578 -1.68 0.0984 . 0.0993 . 

Region2:Group1 0.0708 0.127 -0.176 0.313 0.558 0.579 0.583 

Region3:Group1 0.0866 0.127 -0.181 0.347 0.683 0.498 0.491 

Region1:Group2 0.333 0.127 0.0671 0.581 2.62 0.0113 * 0.0112 * 

Region2:Group2 -0.0241 0.127 -0.282 0.244 -0.19 0.85 0.849 

Region3:Group2 -0.108 0.127 -0.346 0.138 -0.851 0.398 0.418 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.665 0.815 0.586 1.2 74.7 3.32E-13 *** R2M/R2C 0.204 / 0.798 

Residual 0.225 0.475 0.375 0.544 25.3 AIC/BIC 211 / 245 
Connectivity 

density 
Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.208 -0.419 0.398 0 1 0.987 

Region1 0.299 0.0808 0.147 0.469 3.7 0.000506 *** 0.000175 *** 

Region2 -0.134 0.0808 -0.287 0.0226 -1.65 0.104 0.102 

Region3 0.0954 0.0808 -0.0734 0.248 1.18 0.243 0.249 

Group1 -0.229 0.294 -0.779 0.4 -0.78 0.446 0.456 

Group2 0.0382 0.294 -0.59 0.655 0.13 0.898 0.894 

Region1:Group1 -0.127 0.114 -0.341 0.0985 -1.11 0.27 0.269 

Region2:Group1 0 0.114 -0.238 0.228 0 1 0.988 

Region3:Group1 0.0763 0.114 -0.145 0.298 0.668 0.507 0.505 

Region1:Group2 0.293 0.114 0.0709 0.508 2.56 0.0133 * 0.0133 * 

Region2:Group2 0.0382 0.114 -0.193 0.278 0.334 0.74 0.728 
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Region3:Group2 -0.114 0.114 -0.343 0.114 -1 0.321 0.312 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) 

p-value Sig. 
Model 
Test 

Model Fit 

Sample 0.859 0.927 0.639 1.35 82.5 2.64E-17 *** R2M/R2C 0.0847 / 0.839 

Residual 0.183 0.427 0.332 0.494 17.5 AIC/BIC 204 / 238 
SD Pore 

Thickness 
Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.14 -0.267 0.269 0 1 0.995 

Region1 -0.00816 0.108 -0.207 0.194 
-

0.0757 
0.94 0.941 

Region2 -0.839 0.108 -1.03 -0.617 -7.78 0 *** 0.000175 *** 

Region3 0.0492 0.108 -0.169 0.255 0.456 0.65 0.667 

Group1 0.191 0.197 -0.207 0.578 0.966 0.347 0.349 

Group2 -0.366 0.197 -0.777 0.0438 -1.85 0.0801 . 0.0881 . 

Region1:Group1 -0.264 0.153 -0.56 0.0585 -1.73 0.0887 . 0.0958 . 

Region2:Group1 0.0186 0.153 -0.264 0.316 0.122 0.903 0.929 

Region3:Group1 -0.0446 0.153 -0.334 0.262 -0.292 0.771 0.778 

Region1:Group2 0.283 0.153 -0.00408 0.596 1.85 0.0694 . 0.0789 . 

Region2:Group2 -0.0435 0.153 -0.367 0.245 -0.285 0.777 0.798 

Region3:Group2 -0.0907 0.153 -0.386 0.196 -0.594 0.555 0.554 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.328 0.572 0.347 0.864 50.1 4.44E-06 *** R2M/R2C 0.399 / 0.7 

Residual 0.326 0.571 0.44 0.664 49.9 AIC/BIC 221 / 255 
SD Pore 

Separation 
Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.145 -0.282 0.313 0 1 0.987 

Region1 0.776 0.12 0.543 1.05 6.46 0 *** 0.000175 *** 

Region2 -0.687 0.12 -0.955 -0.465 -5.72 5E-07 *** 0.000175 *** 

Region3 -0.352 0.12 -0.578 -0.132 -2.93 0.00497 ** 0.00491 ** 

Group1 0.00366 0.206 -0.375 0.402 0.0178 0.986 0.994 

Group2 0.0792 0.206 -0.337 0.451 0.385 0.705 0.73 

Region1:Group1 -0.0868 0.17 -0.401 0.235 -0.511 0.612 0.618 

Region2:Group1 0.227 0.17 -0.108 0.548 1.34 0.187 0.188 

Region3:Group1 -0.0415 0.17 -0.356 0.3 -0.244 0.808 0.789 

Region1:Group2 -0.201 0.17 -0.557 0.143 -1.18 0.241 0.255 

Region2:Group2 -0.0852 0.17 -0.431 0.216 -0.502 0.618 0.629 

Region3:Group2 0.226 0.17 -0.171 0.585 1.33 0.188 0.193 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.343 0.586 0.373 0.908 45.9 2.71E-05 *** R2M/R2C 0.32 / 0.632 

Residual 0.404 0.636 0.504 0.735 54.1 AIC/BIC 234 / 268 
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Avg. Pore 
volume 

Lambda = -0.875 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.118 -0.249 0.219 0 1 0.987 

Region1 0.317 0.103 0.143 0.512 3.07 0.00331 ** 0.00351 ** 

Region2 -1.08 0.103 -1.29 -0.884 -10.4 0 *** 0.000175 *** 

Region3 -0.0354 0.103 -0.243 0.171 -0.343 0.733 0.709 

Group1 0.0988 0.167 -0.224 0.457 0.591 0.562 0.558 

Group2 -0.268 0.167 -0.604 0.0714 -1.6 0.126 0.138 

Region1:Group1 -0.114 0.146 -0.41 0.167 -0.779 0.439 0.458 

Region2:Group1 -0.0215 0.146 -0.294 0.26 -0.147 0.883 0.901 

Region3:Group1 -0.234 0.146 -0.539 0.0363 -1.6 0.115 0.122 

Region1:Group2 0.176 0.146 -0.122 0.468 1.2 0.234 0.231 

Region2:Group2 0.105 0.146 -0.197 0.397 0.722 0.474 0.473 

Region3:Group2 0.066 0.146 -0.232 0.331 0.452 0.653 0.669 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.219 0.467 0.274 0.723 42.3 0.000111 *** R2M/R2C 0.516 / 0.721 

Residual 0.298 0.546 0.433 0.646 57.7 AIC/BIC 227 / 261 
Avg. Pore 

surface 
Lambda = -1.225 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.118 -0.254 0.225 0 1 0.988 

Region1 0.325 0.106 0.112 0.518 3.07 0.00337 ** 0.00421 ** 

Region2 -1.07 0.106 -1.28 -0.867 -10.1 0 *** 0.000175 *** 

Region3 -0.0281 0.106 -0.25 0.191 -0.265 0.792 0.788 

Group1 0.0607 0.167 -0.258 0.43 0.364 0.72 0.728 

Group2 -0.232 0.167 -0.589 0.119 -1.39 0.182 0.192 

Region1:Group1 -0.0312 0.15 -0.319 0.254 -0.209 0.836 0.824 

Region2:Group1 -0.0423 0.15 -0.334 0.245 -0.282 0.779 0.761 

Region3:Group1 -0.289 0.15 -0.586 0.00605 -1.93 0.0588 . 0.0586 . 

Region1:Group2 0.118 0.15 -0.188 0.399 0.789 0.434 0.441 

Region2:Group2 0.16 0.15 -0.0915 0.464 1.07 0.291 0.296 

Region3:Group2 0.133 0.15 -0.143 0.429 0.887 0.379 0.376 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) 

p-value Sig. 
Model 
Test 

Model Fit 

Sample 0.214 0.463 0.269 0.73 40.6 0.000208 *** R2M/R2C 0.506 / 0.707 

Residual 0.314 0.56 0.448 0.648 59.4 AIC/BIC 222 / 256 
Avg. 

Orientation 
theta 

Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.145 -0.28 0.275 0 1 0.991 

Region1 0.485 0.079 0.318 0.627 6.14 1E-07 *** 0.000175 *** 
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Region2 0.844 0.079 0.695 1 10.7 0 *** 0.000175 *** 

Region3 -0.406 0.079 -0.566 -0.246 -5.14 3.9E-06 *** 0.000175 *** 

Group1 0.0211 0.206 -0.386 0.431 0.103 0.919 0.94 

Group2 -0.0137 0.206 -0.417 0.421 
-

0.0667 
0.948 0.962 

Region1:Group1 0.0846 0.112 -0.129 0.295 0.757 0.452 0.454 

Region2:Group1 0.0265 0.112 -0.207 0.238 0.237 0.813 0.799 

Region3:Group1 -0.0647 0.112 -0.29 0.175 -0.58 0.565 0.558 

Region1:Group2 0.0162 0.112 -0.232 0.275 0.145 0.885 0.883 

Region2:Group2 -0.0861 0.112 -0.316 0.14 -0.771 0.444 0.427 

Region3:Group2 -0.0153 0.112 -0.262 0.213 -0.137 0.892 0.9 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.4 0.632 0.442 0.905 69.6 3.26E-11 *** R2M/R2C 0.466 / 0.838 

Residual 0.175 0.418 0.331 0.487 30.4 AIC/BIC 189 / 223 
Avg. 

Orientation phi Lambda = 4.425 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.153 -0.321 0.294 0 1 0.991 

Region1 0.657 0.123 0.427 0.908 5.35 1.9E-06 *** 0.000175 *** 

Region2 0.156 0.123 -0.0923 0.393 1.27 0.21 0.205 

Region3 -0.718 0.123 -0.933 -0.471 -5.85 3E-07 *** 0.000175 *** 

Group1 -0.0547 0.216 -0.462 0.376 -0.253 0.803 0.818 

Group2 0.261 0.216 -0.223 0.669 1.21 0.243 0.256 

Region1:Group1 0.182 0.174 -0.153 0.53 1.05 0.3 0.294 

Region2:Group1 0.107 0.174 -0.234 0.443 0.618 0.539 0.54 

Region3:Group1 -0.161 0.174 -0.486 0.232 -0.926 0.358 0.36 

Region1:Group2 -0.101 0.174 -0.446 0.234 -0.583 0.562 0.551 

Region2:Group2 -0.11 0.174 -0.445 0.273 -0.634 0.529 0.51 

Region3:Group2 0.132 0.174 -0.242 0.466 0.761 0.45 0.428 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.387 0.622 0.379 0.925 47.8 1.24E-05 *** R2M/R2C 0.27 / 0.619 

Residual 0.422 0.65 0.516 0.755 52.2 AIC/BIC 241 / 275 
Avg. Pore 
thickness 

Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.123 -0.247 0.246 0 1 0.978 

Region1 -0.761 0.0968 -0.951 -0.537 -7.86 0 *** 0.000175 *** 

Region2 -0.408 0.0968 -0.588 -0.221 -4.21 9.65E-05 *** 0.000175 *** 

Region3 0.0156 0.0968 -0.176 0.215 0.161 0.873 0.864 

Group1 0.106 0.175 -0.232 0.489 0.606 0.552 0.563 

Group2 -0.0734 0.175 -0.46 0.278 -0.42 0.679 0.704 
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Region1:Group1 0.136 0.137 -0.113 0.42 0.991 0.326 0.342 

Region2:Group1 0.0076 0.137 -0.279 0.279 0.0555 0.956 0.963 

Region3:Group1 -0.265 0.137 -0.566 -0.0313 -1.93 0.0585 . 0.066 . 

Region1:Group2 -0.185 0.137 -0.453 0.0771 -1.35 0.181 0.195 

Region2:Group2 0.0902 0.137 -0.188 0.344 0.659 0.513 0.519 

Region3:Group2 0.244 0.137 0.00141 0.535 1.78 0.0802 . 0.0853 . 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) 
ICC 
(%) p-value Sig. 

Model 
Test Model Fit 

Sample 0.255 0.505 0.352 0.738 49.2 6.68E-06 *** R2M/R2C 0.516 / 0.754 

Residual 0.262 0.512 0.406 0.592 50.8 AIC/BIC 205 / 239 
Avg. Pore 

Major 
diameter 

Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.156 -0.328 0.29 0 1 0.983 

Region1 0.147 0.0941 -0.0166 0.318 1.57 0.123 0.121 

Region2 -0.689 0.0941 -0.862 -0.481 -7.32 0 *** 0.000175 *** 

Region3 -0.299 0.0941 -0.488 -0.135 -3.17 0.00248 ** 0.00456 ** 

Group1 0.219 0.22 -0.211 0.71 0.997 0.332 0.345 

Group2 -0.18 0.22 -0.62 0.284 -0.818 0.424 0.432 

Region1:Group1 0.232 0.133 -0.0509 0.497 1.74 0.0869 . 0.0895 . 

Region2:Group1 -0.0326 0.133 -0.279 0.234 -0.245 0.807 0.822 

Region3:Group1 -0.387 0.133 -0.661 -0.11 -2.91 0.00525 ** 0.00596 ** 

Region1:Group2 -0.161 0.133 -0.427 0.0925 -1.21 0.231 0.225 

Region2:Group2 0.184 0.133 -0.098 0.446 1.38 0.172 0.164 

Region3:Group2 0.264 0.133 0.0152 0.526 1.99 0.0521 . 0.0502 . 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.447 0.669 0.443 0.982 64.3 1.71E-09 *** R2M/R2C 0.364 / 0.773 

Residual 0.248 0.498 0.404 0.59 35.7 AIC/BIC 210 / 244 
Avg. Pore 
Sphericity 

Lambda = None 

Fixed Factor Estimate Std.Error CI (2.5%) CI (97.5%) t p-value Sig. pMCMC Sig. 

(Intercept) 0 0.166 -0.315 0.327 0 1 0.986 

Region1 -0.791 0.115 -0.985 -0.55 -6.9 0 *** 0.000175 *** 

Region2 0.391 0.115 0.149 0.597 3.41 0.00124 ** 0.00105 ** 

Region3 0.0713 0.115 -0.159 0.3 0.622 0.537 0.555 

Group1 0.0709 0.235 -0.362 0.506 0.302 0.766 0.759 

Group2 0.0289 0.235 -0.412 0.503 0.123 0.904 0.91 

Region1:Group1 -0.0118 0.162 -0.329 0.315 
-

0.0728 
0.942 0.931 

Region2:Group1 0.249 0.162 -0.0892 0.573 1.54 0.13 0.143 

Region3:Group1 -0.0205 0.162 -0.342 0.33 -0.126 0.9 0.893 

Region1:Group2 -0.0605 0.162 -0.371 0.265 -0.373 0.71 0.72 
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Region2:Group2 -0.252 0.162 -0.567 0.0494 -1.55 0.126 0.127 

Region3:Group2 -0.0317 0.162 -0.361 0.294 -0.196 0.846 0.866 

Random Factor Estimate Std.Error CI (2.5%) CI (97.5%) ICC 
(%) 

p-value Sig. Model 
Test 

Model Fit 

Sample 0.488 0.698 0.467 1.01 57 1.47E-07 *** R2M/R2C 0.232 / 0.67 

Residual 0.368 0.607 0.486 0.699 43 AIC/BIC 234 / 268 

Tibial Regions: Post-Hoc Tests for Significant Fixed Effects 

Cortical Fractal 
Interaction 

Contrast 
Comparison p-value Sig. 

Cohen's 
D 

Effect 
Group 

Power 

Region Anterior < Lateral 0.851 0.249 Medium 51% 

Region Anterior < Medial 0.0378 * 0.853 Large 

Region Anterior < Posterior 0.784 0.29 Medium 

Region Lateral < Medial 0.216 0.605 Medium 

Region Lateral < Posterior 0.999 0.0412 Small 

Region Medial > Posterior 0.273 0.563 Medium 

Region | Group Anterior Control < Fentanyl 0.128 1.82 Large 34% 

Region | Group Anterior Control < Morphine 0.592 0.627 Medium 

Region | Group Anterior Fentanyl > Morphine 0.313 1.19 Large 

Region | Group Lateral Control < Fentanyl 0.171 1.63 Large 

Region | Group Lateral Control < Morphine 0.122 1.85 Large 

Region | Group Lateral Fentanyl < Morphine 0.849 0.222 Medium 

Region | Group Medial Control < Fentanyl 0.497 0.796 Medium 

Region | Group Medial Control < Morphine 0.549 0.701 Medium 

Region | Group Medial Fentanyl > Morphine 0.935 0.0953 Small 

Region | Group Posterior Control < Fentanyl 0.851 0.22 Medium 

Region | Group Posterior Control < Morphine 0.42 0.946 Large 

Region | Group Posterior Fentanyl < Morphine 0.535 0.727 Medium 

Group | Region Control Anterior > Lateral 0.858 0.096 Small 

Group | Region Control Anterior < Medial 0.0331 * 1.17 Large 

Group | Region Control Anterior < Posterior 0.186 0.716 Medium 

Group | Region Control Lateral < Medial 0.0216 * 1.27 Large 

Group | Region Control Lateral < Posterior 0.134 0.812 Large 

Group | Region Control Medial > Posterior 0.401 0.453 Medium 

Group | Region Fentanyl Anterior > Lateral 0.596 0.285 Medium 

Group | Region Fentanyl Anterior < Medial 0.783 0.148 Small 

Group | Region Fentanyl Anterior > Posterior 0.105 0.882 Large 

Group | Region Fentanyl Lateral < Medial 0.421 0.433 Medium 

Group | Region Fentanyl Lateral > Posterior 0.269 0.597 Medium 

Group | Region Fentanyl Medial > Posterior 0.0593 . 1.03 Large 

Group | Region Morphine Anterior < Lateral 0.0396 * 1.13 Large 
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Group | Region Morphine Anterior < Medial 0.0239 * 1.24 Large 

Group | Region Morphine Anterior < Posterior 0.058 . 1.04 Large 

Group | Region Morphine Lateral < Medial 0.83 0.116 Small 

Group | Region Morphine Lateral > Posterior 0.864 0.0921 Small 

Group | Region Morphine Medial > Posterior 0.699 0.208 Medium 

Number Closed Pores 
Interaction 

Contrast Comparison p-value Sig. 
Cohen's 

D 
Effect 
Group 

Power 

Region Anterior > Lateral 0.0169 * 0.949 Large 47% 

Region Anterior > Medial 0.00014 
8 

*** 1.42 Large 

Region Anterior > Posterior 5.34E-05 *** 1.51 Large 

Region Lateral > Medial 0.428 0.472 Medium 

Region Lateral > Posterior 0.274 0.563 Medium 

Region Medial > Posterior 0.991 0.0909 Small 

Region | Group Anterior Control < Fentanyl 0.0653 . 2.46 Large 42% 

Region | Group Anterior Control < Morphine 0.435 1.01 Large 

Region | Group Anterior Fentanyl > Morphine 0.266 1.45 Large 

Region | Group Lateral Control < Fentanyl 0.199 1.69 Large 

Region | Group Lateral Control < Morphine 0.179 1.77 Large 

Region | Group Lateral Fentanyl < Morphine 0.951 0.08 Small 

Region | Group Medial Control < Fentanyl 0.478 0.919 Large 

Region | Group Medial Control < Morphine 0.672 0.547 Medium 

Region | Group Medial Fentanyl > Morphine 0.773 0.372 Medium 

Region | Group Posterior Control < Fentanyl 0.196 1.7 Large 

Region | Group Posterior Control < Morphine 0.29 1.38 Large 

Region | Group Posterior Fentanyl > Morphine 0.805 0.319 Medium 

Group | Region Control Anterior > Lateral 0.0841 . 0.941 Large 

Group | Region Control Anterior > Medial 0.166 0.75 Medium 

Group | Region Control Anterior > Posterior 0.0127 * 1.38 Large 

Group | Region Control Lateral < Medial 0.723 0.19 Small 

Group | Region Control Lateral > Posterior 0.416 0.438 Medium 

Group | Region Control Medial > Posterior 0.245 0.628 Medium 

Group | Region Fentanyl Anterior > Lateral 0.0022 ** 1.72 Large 

Group | Region Fentanyl Anterior > Medial 7.34E-05 *** 2.3 Large 

Group | Region Fentanyl Anterior > Posterior 
0.00018 

7 
*** 2.14 Large 

Group | Region Fentanyl Lateral > Medial 0.285 0.577 Medium 

Group | Region Fentanyl Lateral > Posterior 0.429 0.426 Medium 

Group | Region Fentanyl Medial < Posterior 0.779 0.151 Small 

Group | Region Morphine Anterior > Lateral 0.728 0.187 Small 

Group | Region Morphine Anterior > Medial 0.0269 * 1.22 Large 

Group | Region Morphine Anterior > Posterior 0.0638 . 1.01 Large 
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Group | Region Morphine Lateral > Medial 0.0595 . 1.03 Large 

Group | Region Morphine Lateral > Posterior 0.129 0.824 Large 

Group | Region Morphine Medial < Posterior 0.703 0.205 Medium 

Number Open Pores 
Interaction 

Contrast 
Comparison p-value Sig. Cohen's 

D 
Effect 
Group 

Power 

Region Anterior > Lateral 1.54E-05 *** 1.62 Large 51% 

Region Anterior > Medial 0.0146 * 0.965 Large 

Region Anterior > Posterior 0.00666 ** 1.05 Large 

Region Lateral < Medial 0.16 0.654 Medium 

Region Lateral < Posterior 0.265 0.569 Medium 

Region Medial > Posterior 0.992 0.0858 Small 

Region | Group Anterior Control < Fentanyl 0.177 1.69 Large 38% 

Region | Group Anterior Control > Morphine 0.974 0.0393 Small 

Region | Group Anterior Fentanyl > Morphine 0.167 1.73 Large 

Region | Group Lateral Control < Fentanyl 0.234 1.48 Large 

Region | Group Lateral Control < Morphine 0.323 1.22 Large 

Region | Group Lateral Fentanyl > Morphine 0.833 0.258 Medium 

Region | Group Medial Control < Fentanyl 0.782 0.339 Medium 

Region | Group Medial Control < Morphine 0.966 0.0525 Small 

Region | Group Medial Fentanyl > Morphine 0.815 0.287 Medium 

Region | Group Posterior Control < Fentanyl 0.582 0.676 Medium 

Region | Group Posterior Control < Morphine 0.338 1.18 Large 

Region | Group Posterior Fentanyl < Morphine 0.679 0.507 Medium 

Group | Region Control Anterior > Lateral 
0.00052 

6 
*** 1.97 Large 

Group | Region Control Anterior > Medial 0.311 0.547 Medium 

Group | Region Control Anterior > Posterior 0.0405 * 1.12 Large 

Group | Region Control Lateral < Medial 0.0101 * 1.42 Large 

Group | Region Control Lateral < Posterior 0.118 0.849 Large 

Group | Region Control Medial > Posterior 0.287 0.575 Medium 

Group | Region Fentanyl Anterior > Lateral 0.00015 
2 

*** 2.18 Large 

Group | Region Fentanyl Anterior > Medial 
0.00082 

1 
*** 1.89 Large 

Group | Region Fentanyl Anterior > Posterior 0.0002 *** 2.13 Large 

Group | Region Fentanyl Lateral < Medial 0.598 0.283 Medium 

Group | Region Fentanyl Lateral < Posterior 0.933 0.0454 Small 

Group | Region Fentanyl Medial > Posterior 0.658 0.238 Medium 

Group | Region Morphine Anterior > Lateral 0.19 0.71 Medium 

Group | Region Morphine Anterior > Medial 0.398 0.455 Medium 

Group | Region Morphine Anterior < Posterior 0.851 0.101 Small 

Group | Region Morphine Lateral < Medial 0.635 0.255 Medium 

Group | Region Morphine Lateral < Posterior 0.135 0.811 Large 
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Group | Region Morphine Medial < Posterior 0.303 0.556 Medium 

Closed Pore Density 
Interaction 

Contrast 
Comparison p-value Sig. 

Cohen's 
D 

Effect 
Group 

Power 

Region Anterior < Lateral 4.14E-05 *** 1.53 Large 44% 

Region Anterior < Medial 0.0143 * 0.967 Large 

Region Anterior > Posterior 0.263 0.57 Medium 

Region Lateral > Medial 0.268 0.566 Medium 

Region Lateral > Posterior 0 *** 2.1 Large 

Region Medial > Posterior 3.96E-05 *** 1.54 Large 

Region | Group Anterior Control < Fentanyl 0.215 1.62 Large 47% 

Region | Group Anterior Control < Morphine 0.809 0.311 Medium 

Region | Group Anterior Fentanyl > Morphine 0.314 1.31 Large 

Region | Group Lateral Control < Fentanyl 0.14 1.94 Large 

Region | Group Lateral Control < Morphine 0.149 1.9 Large 

Region | Group Lateral Fentanyl > Morphine 0.973 0.0442 Small 

Region | Group Medial Control < Fentanyl 0.687 0.518 Medium 

Region | Group Medial Control > Morphine 0.954 0.0743 Small 

Region | Group Medial Fentanyl > Morphine 0.645 0.593 Medium 

Region | Group Posterior Control < Fentanyl 0.285 1.39 Large 

Region | Group Posterior Control < Morphine 0.45 0.974 Large 

Region | Group Posterior Fentanyl > Morphine 0.747 0.415 Medium 

Group | Region Control Anterior < Lateral 0.0987 . 0.898 Large 

Group | Region Control Anterior < Medial 0.00842 ** 1.46 Large 

Group | Region Control Anterior > Posterior 0.186 0.716 Medium 

Group | Region Control Lateral < Medial 0.296 0.564 Medium 

Group | Region Control Lateral > Posterior 0.00387 ** 1.61 Large 

Group | Region Control Medial > Posterior 0.00015 
2 

*** 2.18 Large 

Group | Region Fentanyl Anterior < Lateral 0.0264 * 1.22 Large 

Group | Region Fentanyl Anterior < Medial 0.5 0.363 Medium 

Group | Region Fentanyl Anterior > Posterior 0.0831 . 0.944 Large 

Group | Region Fentanyl Lateral > Medial 0.115 0.857 Large 

Group | Region Fentanyl Lateral > Posterior 0.00016 
6 

*** 2.16 Large 

Group | Region Fentanyl Medial > Posterior 0.0178 * 1.31 Large 

Group | Region Morphine Anterior < Lateral 2.22E-05 *** 2.48 Large 

Group | Region Morphine Anterior < Medial 0.0489 * 1.08 Large 

Group | Region Morphine Anterior > Posterior 0.923 0.0517 Small 

Group | Region Morphine Lateral > Medial 0.0111 * 1.41 Large 

Group | Region Morphine Lateral > Posterior 1.59E-05 *** 2.53 Large 

Group | Region Morphine Medial > Posterior 0.0393 * 1.13 Large 

Open Pore Density Interaction 
Contrast 

Comparison p-value Sig. Cohen's 
D 

Effect 
Group 

Power 
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Region Anterior < Lateral 0.176 0.639 Medium 45% 

Region Anterior < Medial 
0.00013 

8 
*** 1.43 Large 

Region Anterior < Posterior 0.986 0.106 Small 

Region Lateral < Medial 0.0631 . 0.788 Medium 

Region Lateral > Posterior 0.321 0.532 Medium 

Region Medial > Posterior 0.00044 *** 1.32 Large 

Closed Porosity (%) Interaction 
Contrast 

Comparison p-value Sig. Cohen's 
D 

Effect 
Group 

Power 

Region Anterior < Lateral 0.898 0.215 Medium 45% 

Region Anterior < Medial 0.0277 * 0.891 Large 

Region Anterior < Posterior 0.00908 ** 1.02 Large 

Region Lateral < Medial 0.139 0.676 Medium 

Region Lateral < Posterior 0.0563 . 0.803 Large 

Region Medial < Posterior 0.976 0.127 Small 

Open Porosity (%) 
Interaction 

Contrast Comparison p-value Sig. 
Cohen's 

D 
Effect 
Group 

Power 

Region Anterior > Lateral 1.1E-06 *** 1.84 Large 58% 

Region Anterior > Medial 0.931 0.186 Small 

Region Anterior < Posterior 0.373 0.502 Medium 

Region Lateral < Medial 1.02E-05 *** 1.66 Large 

Region Lateral < Posterior 0 *** 2.34 Large 

Region Medial < Posterior 0.129 0.688 Medium 

Region | Group Anterior Control < Fentanyl 0.278 0.897 Large 48% 

Region | Group Anterior Control < Morphine 0.811 0.197 Small 

Region | Group Anterior Fentanyl > Morphine 0.396 0.7 Medium 

Region | Group Lateral Control < Fentanyl 0.901 0.103 Small 

Region | Group Lateral Control < Morphine 0.635 0.391 Medium 

Region | Group Lateral Fentanyl < Morphine 0.726 0.288 Medium 

Region | Group Medial Control > Fentanyl 0.683 0.336 Medium 

Region | Group Medial Control < Morphine 0.511 0.541 Medium 

Region | Group Medial Fentanyl < Morphine 0.289 0.877 Large 

Region | Group Posterior Control > Fentanyl 0.0308 * 1.82 Large 

Region | Group Posterior Control > Morphine 0.848 0.157 Small 

Region | Group Posterior Fentanyl < Morphine 0.0475 * 1.66 Large 

Group | Region Control Anterior > Lateral 0.0257 * 1.41 Large 

Group | Region Control Anterior < Medial 0.81 0.148 Small 

Group | Region Control Anterior < Posterior 0.0122 * 1.6 Large 

Group | Region Control Lateral < Medial 0.0142 * 1.56 Large 

Group | Region Control Lateral < Posterior 9.6E-06 *** 3.01 Large 

Group | Region Control Medial < Posterior 0.0224 * 1.45 Large 

Group | Region Fentanyl Anterior > Lateral 0.00072 
7 

*** 2.21 Large 
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Group | Region Fentanyl Anterior > Medial 0.0838 . 1.08 Large 

Group | Region Fentanyl Anterior > Posterior 0.0737 . 1.12 Large 

Group | Region Fentanyl Lateral < Medial 0.0739 . 1.12 Large 

Group | Region Fentanyl Lateral < Posterior 0.0841 . 1.08 Large 

Group | Region Fentanyl Medial > Posterior 0.95 0.0385 Small 

Group | Region Morphine Anterior > Lateral 0.053 . 1.22 Large 

Group | Region Morphine Anterior < Medial 0.427 0.493 Medium 

Group | Region Morphine Anterior < Posterior 0.0486 * 1.24 Large 

Group | Region Morphine Lateral < Medial 0.00749 ** 1.71 Large 

Group | Region Morphine Lateral < Posterior 0.00019 
6 

*** 2.46 Large 

Group | Region Morphine Medial < Posterior 0.229 0.749 Medium 

Total Porosity (%) 
Interaction 

Contrast 
Comparison p-value Sig. 

Cohen's 
D 

Effect 
Group 

Power 

Region Anterior > Lateral 0.00146 ** 1.21 Large 54% 

Region Anterior < Medial 0.858 0.244 Medium 

Region Anterior < Posterior 0.0576 . 0.8 Medium 

Region Lateral < Medial 
0.00010 

7 
*** 1.45 Large 

Region Lateral < Posterior 2E-07 *** 2.01 Large 

Region Medial < Posterior 0.284 0.556 Medium 

Region | Group Anterior Control < Fentanyl 0.236 1.11 Large 45% 

Region | Group Anterior Control < Morphine 0.6 0.488 Medium 

Region | Group Anterior Fentanyl > Morphine 0.504 0.622 Medium 

Region | Group Lateral Control < Fentanyl 0.462 0.685 Medium 

Region | Group Lateral Control < Morphine 0.326 0.917 Large 

Region | Group Lateral Fentanyl < Morphine 0.803 0.231 Medium 

Region | Group Medial Control > Fentanyl 0.979 0.0245 Small 

Region | Group Medial Control < Morphine 0.504 0.621 Medium 

Region | Group Medial Fentanyl < Morphine 0.488 0.646 Medium 

Region | Group Posterior Control > Fentanyl 0.12 1.47 Large 

Region | Group Posterior Control < Morphine 0.719 0.334 Medium 

Region | Group Posterior Fentanyl < Morphine 0.0584 . 1.8 Large 

Group | Region Control Anterior > Lateral 0.0519 . 1.17 Large 

Group | Region Control Anterior < Medial 0.352 0.554 Medium 

Group | Region Control Anterior < Posterior 0.00477 ** 1.74 Large 

Group | Region Control Lateral < Medial 0.00499 ** 1.73 Large 

Group | Region Control Lateral < Posterior 8.2E-06 *** 2.91 Large 

Group | Region Control Medial < Posterior 0.0501 . 1.18 Large 

Group | Region Fentanyl Anterior > Lateral 0.00905 ** 1.6 Large 

Group | Region Fentanyl Anterior > Medial 0.33 0.58 Medium 

Group | Region Fentanyl Anterior > Posterior 0.16 0.84 Large 

2018-DU-BX-0188 Final Technical Report 
October 2021 

This resource was prepared by the author(s) using Federal funds provided by the U.S. 
Department of Justice. Opinions or points of view expressed are those of the author(s) and do not 

necessarily reflect the official position or policies of the U.S. Department of Justice.

346 



 
 

           

           

           

           

           

           

           

      
 

    

           

 
 

       

         

         

         

         

         

         

  
 

   
  

 

         

         

         

         

         

    
 

    

           

           

           

           

           

           

           

           

           

           

           

           

           

           

           

Group | Region Fentanyl Lateral < Medial 0.0904 . 1.02 Large 

Group | Region Fentanyl Lateral < Posterior 0.205 0.757 Medium 

Group | Region Fentanyl Medial > Posterior 0.661 0.26 Medium 

Group | Region Morphine Anterior > Lateral 0.213 0.744 Medium 

Group | Region Morphine Anterior < Medial 0.249 0.688 Medium 

Group | Region Morphine Anterior < Posterior 0.00965 ** 1.58 Large 

Group | Region Morphine Lateral < Medial 0.0186 * 1.43 Large 

Group | Region Morphine Lateral < Posterior 
0.00023 

2 
*** 2.33 Large 

Group | Region Morphine Medial < Posterior 0.135 0.896 Large 

Cortical Volume 
Interaction 

Contrast Comparison p-value Sig. 
Cohen's 

D 
Effect 
Group 

Power 

Region Anterior > Lateral 0 *** 5.74 Large 30% 

Region Anterior > Medial 0 *** 5.65 Large 

Region Anterior > Posterior 0 *** 2.47 Large 

Region Lateral < Medial 0.992 0.0859 Small 

Region Lateral < Posterior 0 *** 3.27 Large 

Region Medial < Posterior 0 *** 3.18 Large 

Pore Volume Interaction 
Contrast 

Comparison p-value Sig. Cohen's 
D 

Effect 
Group 

Power 

Region Anterior > Lateral 0 *** 2.54 Large 60% 

Region Anterior > Medial 
0.00097 

3 
*** 1.24 Large 

Region Anterior < Posterior 0.977 0.125 Small 

Region Lateral < Medial 
0.00055 

2 
*** 1.3 Large 

Region Lateral < Posterior 0 *** 2.67 Large 

Region Medial < Posterior 0.00025 
6 

*** 1.37 Large 

Region | Group Anterior Control < Fentanyl 0.114 1.5 Large 44% 

Region | Group Anterior Control < Morphine 0.3 0.971 Large 

Region | Group Anterior Fentanyl > Morphine 0.572 0.527 Medium 

Region | Group Lateral Control < Fentanyl 0.542 0.57 Medium 

Region | Group Lateral Control < Morphine 0.393 0.799 Medium 

Region | Group Lateral Fentanyl < Morphine 0.806 0.229 Medium 

Region | Group Medial Control < Fentanyl 0.799 0.237 Medium 

Region | Group Medial Control < Morphine 0.394 0.797 Medium 

Region | Group Medial Fentanyl < Morphine 0.548 0.56 Medium 

Region | Group Posterior Control > Fentanyl 0.204 1.19 Large 

Region | Group Posterior Control < Morphine 0.443 0.718 Medium 

Region | Group Posterior Fentanyl < Morphine 0.0456 * 1.91 Large 

Group | Region Control Anterior > Lateral 0.00148 ** 2.08 Large 

Group | Region Control Anterior > Medial 0.171 0.863 Large 

Group | Region Control Anterior < Posterior 0.0838 . 1.1 Large 
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Group | Region Control Lateral < Medial 0.0549 . 1.22 Large 

Group | Region Control Lateral < Posterior 4.3E-06 *** 3.18 Large 

Group | Region Control Medial < Posterior 0.00267 ** 1.96 Large 

Group | Region Fentanyl Anterior > Lateral 1.12E-05 *** 3.01 Large 

Group | Region Fentanyl Anterior > Medial 0.00122 ** 2.12 Large 

Group | Region Fentanyl Anterior > Posterior 0.013 * 1.6 Large 

Group | Region Fentanyl Lateral < Medial 0.159 0.887 Large 

Group | Region Fentanyl Lateral < Posterior 0.027 * 1.41 Large 

Group | Region Fentanyl Medial < Posterior 0.401 0.527 Medium 

Group | Region Morphine Anterior > Lateral 0.00063 
7 

*** 2.26 Large 

Group | Region Morphine Anterior > Medial 0.101 1.04 Large 

Group | Region Morphine Anterior < Posterior 0.181 0.842 Large 

Group | Region Morphine Lateral < Medial 0.0552 . 1.22 Large 

Group | Region Morphine Lateral < Posterior 6.9E-06 *** 3.1 Large 

Group | Region Morphine Medial < Posterior 0.00384 ** 1.88 Large 

Cortical Surface 
Interaction 

Contrast Comparison p-value Sig. 
Cohen's 

D 
Effect 
Group 

Power 

Region Anterior > Lateral 0 *** 4.8 Large 26% 

Region Anterior > Medial 0 *** 6.66 Large 

Region Anterior > Posterior 0.00000 
6 

*** 1.7 Large 

Region Lateral > Medial 9E-07 *** 1.86 Large 

Region Lateral < Posterior 0 *** 3.1 Large 

Region Medial < Posterior 0 *** 4.96 Large 

Pore Surface 
Interaction 

Contrast Comparison p-value Sig. 
Cohen's 

D 
Effect 
Group 

Power 

Region Anterior > Lateral 0 *** 2.35 Large 39% 

Region Anterior > Medial 0.00024 
3 

*** 1.37 Large 

Region Anterior > Posterior 0.387 0.494 Medium 

Region Lateral < Medial 0.013 * 0.979 Large 

Region Lateral < Posterior 9E-07 *** 1.86 Large 

Region Medial < Posterior 0.0301 * 0.881 Large 

Region | Group Anterior Control < Fentanyl 0.0909 . 1.97 Large 42% 

Region | Group Anterior Control < Morphine 0.405 0.953 Large 

Region | Group Anterior Fentanyl > Morphine 0.373 1.02 Large 

Region | Group Lateral Control < Fentanyl 0.295 1.2 Large 

Region | Group Lateral Control < Morphine 0.276 1.25 Large 

Region | Group Lateral Fentanyl < Morphine 0.965 0.0497 Small 

Region | Group Medial Control < Fentanyl 0.509 0.754 Medium 

Region | Group Medial Control < Morphine 0.408 0.948 Large 

Region | Group Medial Fentanyl < Morphine 0.865 0.194 Small 
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Region | Group Posterior Control < Fentanyl 0.984 0.0228 Small 
Region | Group 

Posterior Control < Morphine 0.263 1.29 Large 

Region | Group Posterior Fentanyl < Morphine 0.271 1.27 Large 

Group | Region Control Anterior > Lateral 
0.00030 

6 
*** 2.25 Large 

Group | Region Control Anterior > Medial 0.065 . 1.1 Large 

Group | Region Control Anterior > Posterior 0.909 0.0673 Small 

Group | Region Control Lateral < Medial 0.0534 . 1.15 Large 

Group | Region Control Lateral < Posterior 
0.00044 

1 
*** 2.19 Large 

Group | Region Control Medial < Posterior 0.0826 . 1.03 Large 

Group | Region Fentanyl Anterior > Lateral 3.4E-06 *** 3.03 Large 

Group | Region Fentanyl Anterior > Medial 
0.00021 

2 
*** 2.32 Large 

Group | Region Fentanyl Anterior > Posterior 0.00107 ** 2.02 Large 

Group | Region Fentanyl Lateral < Medial 0.232 0.705 Medium 

Group | Region Fentanyl Lateral < Posterior 0.0904 . 1.01 Large 

Group | Region Fentanyl Medial < Posterior 0.608 0.301 Medium 

Group | Region Morphine Anterior > Lateral 0.00149 ** 1.95 Large 

Group | Region Morphine Anterior > Medial 0.0638 . 1.11 Large 

Group | Region Morphine Anterior < Posterior 0.647 0.269 Medium 

Group | Region Morphine Lateral < Medial 0.152 0.849 Large 

Group | Region Morphine Lateral < Posterior 0.00036 
1 

*** 2.22 Large 

Group | Region Morphine Medial < Posterior 0.0223 * 1.37 Large 

Intersection Surface 
Interaction 

Contrast 
Comparison p-value Sig. 

Cohen's 
D 

Effect 
Group 

Power 

Region Anterior > Lateral 
0.00018 

2 
*** 1.4 Large 51% 

Region Anterior < Medial 0.13 0.686 Medium 

Region Anterior < Posterior 0.0218 * 0.919 Large 

Region Lateral < Medial 1E-07 *** 2.09 Large 

Region Lateral < Posterior 0 *** 2.32 Large 

Region Medial < Posterior 0.874 0.233 Medium 

Region | Group Anterior Control < Fentanyl 0.0657 . 1.46 Large 38% 

Region | Group Anterior Control < Morphine 1 0.000305 Small 

Region | Group Anterior Fentanyl > Morphine 0.0658 . 1.46 Large 

Region | Group Lateral Control < Fentanyl 0.657 0.347 Medium 

Region | Group Lateral Control < Morphine 0.399 0.66 Medium 

Region | Group Lateral Fentanyl < Morphine 0.688 0.313 Medium 

Region | Group Medial Control > Fentanyl 0.71 0.29 Medium 

Region | Group Medial Control > Morphine 0.963 0.0364 Small 

Region | Group Medial Fentanyl < Morphine 0.745 0.254 Medium 
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Region | Group Posterior Control > Fentanyl 0.147 1.14 Large 

Region | Group Posterior Control < Morphine 0.637 0.369 Medium 

Region | Group Posterior Fentanyl < Morphine 0.0567 . 1.51 Large 

Group | Region Control Anterior > Lateral 0.118 1.02 Large 

Group | Region Control Anterior < Medial 0.0708 . 1.18 Large 

Group | Region Control Anterior < Posterior 0.0152 * 1.61 Large 

Group | Region Control Lateral < Medial 0.00116 ** 2.2 Large 

Group | Region Control Lateral < Posterior 
0.00014 

2 
*** 2.63 Large 

Group | Region Control Medial < Posterior 0.51 0.426 Medium 

Group | Region Fentanyl Anterior > Lateral 0.00161 ** 2.13 Large 

Group | Region Fentanyl Anterior > Medial 0.381 0.566 Medium 

Group | Region Fentanyl Anterior > Posterior 0.127 0.994 Large 

Group | Region Fentanyl Lateral < Medial 0.018 * 1.56 Large 

Group | Region Fentanyl Lateral < Posterior 0.082 . 1.14 Large 

Group | Region Fentanyl Medial > Posterior 0.508 0.427 Medium 

Group | Region Morphine Anterior > Lateral 0.578 0.359 Medium 

Group | Region Morphine Anterior < Medial 0.0798 . 1.15 Large 

Group | Region Morphine Anterior < Posterior 0.00324 ** 1.98 Large 

Group | Region Morphine Lateral < Medial 0.0227 * 1.5 Large 

Group | Region Morphine Lateral < Posterior 0.00060 
8 

*** 2.34 Large 

Group | Region Morphine Medial < Posterior 0.201 0.831 Large 

Pore Surface: 
PoreVolume 

Interaction 
Contrast 

Comparison p-value Sig. 
Cohen's 

D 
Effect 
Group 

Power 

Region Anterior < Lateral 0 *** 2.18 Large 54% 

Region Anterior < Medial 0.163 0.651 Medium 

Region Anterior > Posterior 0.00982 ** 1.01 Large 

Region Lateral > Medial 4.26E-05 *** 1.53 Large 

Region Lateral > Posterior 0 *** 3.19 Large 

Region Medial > Posterior 9.6E-06 *** 1.66 Large 

Pore Surface: Cortical 
Volume 

Interaction 
Contrast Comparison p-value Sig. 

Cohen's 
D 

Effect 
Group 

Power 

Region Anterior > Lateral 0.536 0.417 Medium 50% 

Region Anterior < Medial 0.0966 . 0.729 Medium 

Region Anterior < Posterior 0.655 0.358 Medium 

Region Lateral < Medial 0.00266 ** 1.15 Large 

Region Lateral < Posterior 0.0699 . 0.774 Medium 

Region Medial > Posterior 0.626 0.372 Medium 

Region | Group Anterior Control < Fentanyl 0.265 1.32 Large 46% 

Region | Group Anterior Control < Morphine 0.804 0.292 Medium 

Region | Group Anterior Fentanyl > Morphine 0.382 1.03 Large 

Region | Group Lateral Control < Fentanyl 0.222 1.45 Large 
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Region | Group Lateral Control < Morphine 0.237 1.41 Large 

Region | Group Lateral Fentanyl > Morphine 0.967 0.0479 Small 

Region | Group Medial Control < Fentanyl 0.731 0.404 Medium 

Region | Group Medial Control < Morphine 0.641 0.549 Medium 

Region | Group Medial Fentanyl < Morphine 0.902 0.145 Small 

Region | Group Posterior Control > Fentanyl 0.788 0.315 Medium 

Region | Group Posterior Control < Morphine 0.48 0.834 Large 

Region | Group Posterior Fentanyl < Morphine 0.332 1.15 Large 

Group | Region Control Anterior > Lateral 0.141 0.83 Large 

Group | Region Control Anterior < Medial 0.0958 . 0.942 Large 

Group | Region Control Anterior < Posterior 0.224 0.684 Medium 

Group | Region Control Lateral < Medial 0.00238 ** 1.77 Large 

Group | Region Control Lateral < Posterior 0.00867 ** 1.51 Large 

Group | Region Control Medial > Posterior 0.645 0.258 Medium 

Group | Region Fentanyl Anterior > Lateral 0.214 0.699 Medium 

Group | Region Fentanyl Anterior < Medial 0.969 0.0214 Small 

Group | Region Fentanyl Anterior > Posterior 0.0913 . 0.955 Large 

Group | Region Fentanyl Lateral < Medial 0.2 0.721 Medium 

Group | Region Fentanyl Lateral > Posterior 0.647 0.256 Medium 

Group | Region Fentanyl Medial > Posterior 0.0844 . 0.977 Large 

Group | Region Morphine Anterior < Lateral 0.61 0.285 Medium 

Group | Region Morphine Anterior < Medial 0.0354 * 1.2 Large 

Group | Region Morphine Anterior < Posterior 0.0316 * 1.23 Large 

Group | Region Morphine Lateral < Medial 0.106 0.914 Large 

Group | Region Morphine Lateral < Posterior 0.0962 . 0.941 Large 

Group | Region Morphine Medial < Posterior 0.961 0.0271 Small 

Pore Thickness 
Interaction 

Contrast 
Comparison p-value Sig. Cohen's 

D 
Effect 
Group 

Power 

Region Anterior > Lateral 3.16E-05 *** 1.56 Large 51% 

Region Anterior > Medial 0.641 0.364 Medium 

Region Anterior < Posterior 
0.00027 

2 
*** 1.36 Large 

Region Lateral < Medial 0.00166 ** 1.19 Large 

Region Lateral < Posterior 0 *** 2.92 Large 

Region Medial < Posterior 4.3E-06 *** 1.73 Large 

Region | Group Anterior Control < Fentanyl 0.697 0.287 Medium 44% 

Region | Group Anterior Control < Morphine 0.45 0.558 Medium 

Region | Group Anterior Fentanyl < Morphine 0.713 0.272 Medium 

Region | Group Lateral Control > Fentanyl 0.466 0.539 Medium 

Region | Group Lateral Control < Morphine 0.874 0.117 Small 

Region | Group Lateral Fentanyl < Morphine 0.375 0.656 Medium 

Region | Group Medial Control > Fentanyl 0.298 0.771 Medium 
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Region | Group Medial Control < Morphine 0.676 0.308 Medium 

Region | Group Medial Fentanyl < Morphine 0.148 1.08 Large 

Region | Group Posterior Control > Fentanyl 0.00563 ** 2.13 Large 

Region | Group Posterior Control > Morphine 0.233 0.887 Large 

Region | Group Posterior Fentanyl < Morphine 0.0959 . 1.25 Large 

Group | Region Control Anterior > Lateral 0.0383 * 1.14 Large 

Group | Region Control Anterior < Medial 0.894 0.0715 Small 

Group | Region Control Anterior < Posterior 7.3E-06 *** 2.65 Large 

Group | Region Control Lateral < Medial 0.028 * 1.21 Large 

Group | Region Control Lateral < Posterior 0 *** 3.79 Large 

Group | Region Control Medial < Posterior 1.16E-05 *** 2.58 Large 

Group | Region Fentanyl Anterior > Lateral 
0.00055 

9 
*** 1.96 Large 

Group | Region Fentanyl Anterior > Medial 0.0705 . 0.986 Large 

Group | Region Fentanyl Anterior < Posterior 0.665 0.233 Medium 

Group | Region Fentanyl Lateral < Medial 0.0737 . 0.975 Large 

Group | Region Fentanyl Lateral < Posterior 
0.00013 

8 
*** 2.19 Large 

Group | Region Fentanyl Medial < Posterior 0.0265 * 1.22 Large 

Group | Region Morphine Anterior > Lateral 0.0047 ** 1.58 Large 

Group | Region Morphine Anterior > Medial 0.74 0.179 Small 

Group | Region Morphine Anterior < Posterior 0.0279 * 1.21 Large 

Group | Region Morphine Lateral < Medial 0.0115 * 1.4 Large 

Group | Region Morphine Lateral < Posterior 
0.00000 

3 
*** 2.78 Large 

Group | Region Morphine Medial < Posterior 0.0122 * 1.39 Large 

Pore Separation 
Interaction 

Contrast Comparison p-value Sig. 
Cohen's 

D 
Effect 
Group 

Power 

Region Anterior > Lateral 4.76E-05 *** 1.52 Large 43% 

Region Anterior > Medial 8.6E-06 *** 1.67 Large 

Region Anterior > Posterior 0.0897 . 0.74 Medium 

Region Lateral > Medial 0.963 0.148 Small 

Region Lateral < Posterior 0.066 . 0.782 Medium 

Region Medial < Posterior 0.0199 * 0.93 Large 

Pore Tb.N 
Interaction 

Contrast 
Comparison p-value Sig. Cohen's 

D 
Effect 
Group 

Power 

Region Anterior < Lateral 0.987 0.104 Small 56% 

Region Anterior < Medial 0.0696 . 0.775 Medium 

Region Anterior > Posterior 0.987 0.103 Small 

Region Lateral < Medial 0.144 0.671 Medium 

Region Lateral > Posterior 0.907 0.207 Medium 

Region Medial > Posterior 0.0309 * 0.878 Large 

Region | Group Anterior Control < Fentanyl 0.203 1.53 Large 44% 
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Region | Group Anterior Control < Morphine 0.843 0.234 Medium 

Region | Group Anterior Fentanyl > Morphine 0.279 1.29 Large 

Region | Group Lateral Control < Fentanyl 0.0878 . 2.08 Large 

Region | Group Lateral Control < Morphine 0.192 1.57 Large 

Region | Group Lateral Fentanyl > Morphine 0.666 0.51 Medium 

Region | Group Medial Control < Fentanyl 0.465 0.867 Large 

Region | Group Medial Control < Morphine 0.736 0.399 Medium 

Region | Group Medial Fentanyl > Morphine 0.692 0.469 Medium 

Region | Group Posterior Control < Fentanyl 0.807 0.289 Medium 

Region | Group Posterior Control < Morphine 0.393 1.02 Large 

Region | Group Posterior Fentanyl < Morphine 0.539 0.728 Medium 

Group | Region Control Anterior > Lateral 0.332 0.523 Medium 

Group | Region Control Anterior < Medial 0.0843 . 0.94 Large 

Group | Region Control Anterior < Posterior 0.928 0.0485 Small 

Group | Region Control Lateral < Medial 0.00836 ** 1.46 Large 

Group | Region Control Lateral < Posterior 0.289 0.572 Medium 

Group | Region Control Medial > Posterior 0.101 0.891 Large 

Group | Region Fentanyl Anterior < Lateral 0.961 0.0263 Small 

Group | Region Fentanyl Anterior < Medial 0.603 0.28 Medium 

Group | Region Fentanyl Anterior > Posterior 0.0302 * 1.19 Large 

Group | Region Fentanyl Lateral < Medial 0.638 0.253 Medium 

Group | Region Fentanyl Lateral > Posterior 0.0269 * 1.22 Large 

Group | Region Fentanyl Medial > Posterior 0.00811 ** 1.47 Large 

Group | Region Morphine Anterior < Lateral 0.136 0.809 Large 

Group | Region Morphine Anterior < Medial 0.0436 * 1.1 Large 

Group | Region Morphine Anterior < Posterior 0.126 0.831 Large 

Group | Region Morphine Lateral < Medial 0.583 0.295 Medium 

Group | Region Morphine Lateral < Posterior 0.967 0.0219 Small 

Group | Region Morphine Medial > Posterior 0.611 0.273 Medium 

Degree of Anisotropy 
Interaction 

Contrast Comparison p-value Sig. 
Cohen's 

D 
Effect 
Group 

Power 

Region Anterior > Lateral 8E-07 *** 1.87 Large 37% 

Region Anterior > Medial 0.0885 . 0.742 Medium 

Region Anterior < Posterior 0.957 0.157 Small 

Region Lateral < Medial 0.00315 ** 1.13 Large 

Region Lateral < Posterior 1E-07 *** 2.03 Large 

Region Medial < Posterior 0.0261 * 0.898 Large 

Pore Fractal Interaction 
Contrast 

Comparison p-value Sig. Cohen's 
D 

Effect 
Group 

Power 

Region Anterior > Lateral 0.689 0.341 Medium 54% 

Region Anterior < Medial 0.119 0.699 Medium 

Region Anterior < Posterior 0.951 0.164 Small 
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Region Lateral < Medial 0.00744 ** 1.04 Large 

Region Lateral < Posterior 0.367 0.505 Medium 

Region Medial > Posterior 0.318 0.534 Medium 

Region | Group Anterior Control < Fentanyl 0.115 1.92 Large 38% 

Region | Group Anterior Control < Morphine 0.496 0.812 Large 

Region | Group Anterior Fentanyl > Morphine 0.356 1.1 Large 

Region | Group Lateral Control < Fentanyl 0.187 1.59 Large 

Region | Group Lateral Control < Morphine 0.0974 . 2.02 Large 

Region | Group Lateral Fentanyl < Morphine 0.718 0.429 Medium 

Region | Group Medial Control < Fentanyl 0.406 0.992 Large 

Region | Group Medial Control < Morphine 0.426 0.951 Large 

Region | Group Medial Fentanyl > Morphine 0.972 0.0414 Small 

Region | Group Posterior Control < Fentanyl 0.939 0.0904 Small 

Region | Group Posterior Control < Morphine 0.396 1.02 Large 

Region | Group Posterior Fentanyl < Morphine 0.438 0.925 Large 

Group | Region Control Anterior > Lateral 0.239 0.637 Medium 

Group | Region Control Anterior < Medial 0.078 . 0.96 Large 

Group | Region Control Anterior < Posterior 0.193 0.705 Medium 

Group | Region Control Lateral < Medial 0.00422 ** 1.6 Large 

Group | Region Control Lateral < Posterior 0.0151 * 1.34 Large 

Group | Region Control Medial > Posterior 0.635 0.255 Medium 

Group | Region Fentanyl Anterior > Lateral 0.0784 . 0.959 Large 

Group | Region Fentanyl Anterior < Medial 0.946 0.0366 Small 

Group | Region Fentanyl Anterior > Posterior 0.0408 * 1.12 Large 

Group | Region Fentanyl Lateral < Medial 0.068 . 0.996 Large 

Group | Region Fentanyl Lateral > Posterior 0.764 0.162 Small 

Group | Region Fentanyl Medial > Posterior 0.0349 * 1.16 Large 

Group | Region Morphine Anterior < Lateral 0.288 0.574 Medium 

Group | Region Morphine Anterior < Medial 0.0445 * 1.1 Large 

Group | Region Morphine Anterior < Posterior 0.095 . 0.908 Large 

Group | Region Morphine Lateral < Medial 0.33 0.526 Medium 

Group | Region Morphine Lateral < Posterior 0.534 0.335 Medium 

Group | Region Morphine Medial > Posterior 0.722 0.191 Small 

Number of Pores 
Interaction 

Contrast 
Comparison p-value Sig. Cohen's 

D 
Effect 
Group 

Power 

Region Anterior > Lateral 0.00548 ** 1.07 Large 42% 

Region Anterior > Medial 
0.00018 

4 
*** 1.4 Large 

Region Anterior > Posterior 6.54E-05 *** 1.49 Large 

Region Lateral > Medial 0.712 0.329 Medium 

Region Lateral > Posterior 0.525 0.422 Medium 

Region Medial > Posterior 0.99 0.0929 Small 
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Region | Group Anterior Control < Fentanyl 0.0729 . 2.43 Large 45% 

Region | Group Anterior Control < Morphine 0.495 0.897 Large 

Region | Group Anterior Fentanyl > Morphine 0.248 1.53 Large 

Region | Group Lateral Control < Fentanyl 0.2 1.71 Large 

Region | Group Lateral Control < Morphine 0.191 1.74 Large 

Region | Group Lateral Fentanyl < Morphine 0.979 0.0351 Small 

Region | Group Medial Control < Fentanyl 0.51 0.866 Large 

Region | Group Medial Control < Morphine 0.706 0.495 Medium 

Region | Group Medial Fentanyl > Morphine 0.777 0.372 Medium 

Region | Group Posterior Control < Fentanyl 0.227 1.61 Large 

Region | Group Posterior Control < Morphine 0.292 1.39 Large 

Region | Group Posterior Fentanyl > Morphine 0.871 0.213 Medium 

Group | Region Control Anterior > Lateral 0.042 * 1.11 Large 

Group | Region Control Anterior > Medial 0.169 0.745 Medium 

Group | Region Control Anterior > Posterior 0.0123 * 1.38 Large 

Group | Region Control Lateral < Medial 0.493 0.369 Medium 

Group | Region Control Lateral > Posterior 0.614 0.271 Medium 

Group | Region Control Medial > Posterior 0.236 0.64 Medium 

Group | Region Fentanyl Anterior > Lateral 0.00115 ** 1.84 Large 

Group | Region Fentanyl Anterior > Medial 
0.00006 

7 
*** 2.31 Large 

Group | Region Fentanyl Anterior > Posterior 0.00012 
6 

*** 2.21 Large 

Group | Region Fentanyl Lateral > Medial 0.379 0.474 Medium 

Group | Region Fentanyl Lateral > Posterior 0.488 0.373 Medium 

Group | Region Fentanyl Medial < Posterior 0.85 0.101 Small 

Group | Region Morphine Anterior > Lateral 0.621 0.266 Medium 

Group | Region Morphine Anterior > Medial 0.0364 * 1.15 Large 

Group | Region Morphine Anterior > Posterior 0.103 0.887 Large 

Group | Region Morphine Lateral > Medial 0.105 0.881 Large 

Group | Region Morphine Lateral > Posterior 0.25 0.621 Medium 

Group | Region Morphine Medial < Posterior 0.629 0.26 Medium 

Pore Density 
Interaction 

Contrast 
Comparison p-value Sig. Cohen's 

D 
Effect 
Group 

Power 

Region Anterior < Lateral 
0.00010 

7 
*** 1.45 Large 51% 

Region Anterior < Medial 0.00562 ** 1.07 Large 

Region Anterior > Posterior 0.367 0.505 Medium 

Region Lateral > Medial 0.61 0.38 Medium 

Region Lateral > Posterior 3E-07 *** 1.95 Large 

Region Medial > Posterior 2.61E-05 *** 1.57 Large 

Region | Group Anterior Control < Fentanyl 0.241 1.53 Large 42% 

Region | Group Anterior Control < Morphine 0.891 0.177 Small 
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Region | Group Anterior Fentanyl > Morphine 0.298 1.36 Large 

Region | Group Lateral Control < Fentanyl 0.143 1.93 Large 

Region | Group Lateral Control < Morphine 0.166 1.82 Large 

Region | Group Lateral Fentanyl > Morphine 0.932 0.11 Small 

Region | Group Medial Control < Fentanyl 0.752 0.408 Medium 

Region | Group Medial Control > Morphine 0.89 0.178 Small 

Region | Group Medial Fentanyl > Morphine 0.65 0.586 Medium 

Region | Group Posterior Control < Fentanyl 0.333 1.26 Large 

Region | Group Posterior Control < Morphine 0.464 0.949 Large 

Region | Group Posterior Fentanyl > Morphine 0.809 0.312 Medium 

Group | Region Control Anterior < Lateral 0.157 0.767 Medium 

Group | Region Control Anterior < Medial 0.00505 ** 1.56 Large 

Group | Region Control Anterior > Posterior 0.214 0.672 Medium 

Group | Region Control Lateral < Medial 0.142 0.796 Medium 

Group | Region Control Lateral > Posterior 0.00945 ** 1.44 Large 

Group | Region Control Medial > Posterior 0.00010 
7 

*** 2.23 Large 

Group | Region Fentanyl Anterior < Lateral 0.0334 * 1.17 Large 

Group | Region Fentanyl Anterior < Medial 0.418 0.436 Medium 

Group | Region Fentanyl Anterior > Posterior 0.083 . 0.944 Large 

Group | Region Fentanyl Lateral > Medial 0.177 0.73 Medium 

Group | Region Fentanyl Lateral > Posterior 0.00022 
9 

*** 2.11 Large 

Group | Region Fentanyl Medial > Posterior 0.0125 * 1.38 Large 

Group | Region Morphine Anterior < Lateral 3.46E-05 *** 2.41 Large 

Group | Region Morphine Anterior < Medial 0.0279 * 1.21 Large 

Group | Region Morphine Anterior < Posterior 0.851 0.101 Small 

Group | Region Morphine Lateral > Medial 0.0282 * 1.21 Large 

Group | Region Morphine Lateral > Posterior 6.56E-05 *** 2.31 Large 

Group | Region Morphine Medial > Posterior 0.0431 * 1.11 Large 

Euler number 
Interaction 

Contrast 
Comparison p-value Sig. Cohen's 

D 
Effect 
Group 

Power 

Region Anterior > Lateral 0.771 0.297 Medium 50% 

Region Anterior > Medial 0.0343 * 0.865 Large 

Region Anterior > Posterior 0.00826 ** 1.03 Large 

Region Lateral > Medial 0.266 0.568 Medium 

Region Lateral > Posterior 0.0954 . 0.731 Medium 

Region Medial > Posterior 0.952 0.163 Small 

Connectivity 
Interaction 

Contrast Comparison p-value Sig. 
Cohen's 

D 
Effect 
Group 

Power 

Region Anterior > Lateral 0 *** 2.17 Large 40% 

Region Anterior > Medial 8E-07 *** 1.87 Large 

Region Anterior > Posterior 2.5E-06 *** 1.78 Large 
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Region Lateral < Medial 0.752 0.307 Medium 

Region Lateral < Posterior 0.572 0.399 Medium 

Region Medial < Posterior 0.991 0.0915 Small 

Region | Group Anterior Control < Fentanyl 0.0873 . 1.89 Large 39% 

Region | Group Anterior Control < Morphine 0.272 1.19 Large 

Region | Group Anterior Fentanyl > Morphine 0.519 0.695 Medium 

Region | Group Lateral Control < Fentanyl 0.619 0.535 Medium 

Region | Group Lateral Control < Morphine 0.49 0.744 Medium 

Region | Group Lateral Fentanyl < Morphine 0.845 0.209 Medium 

Region | Group Medial Control < Fentanyl 0.762 0.325 Medium 

Region | Group Medial Control < Morphine 0.428 0.854 Large 

Region | Group Medial Fentanyl < Morphine 0.622 0.529 Medium 

Region | Group Posterior Control < Fentanyl 0.856 0.195 Small 

Region | Group Posterior Control < Morphine 0.277 1.18 Large 

Region | Group Posterior Fentanyl < Morphine 0.362 0.984 Large 

Group | Region Control Anterior > Lateral 0.00473 ** 1.58 Large 

Group | Region Control Anterior > Medial 0.0248 * 1.23 Large 

Group | Region Control Anterior > Posterior 0.0279 * 1.21 Large 

Group | Region Control Lateral < Medial 0.527 0.341 Medium 

Group | Region Control Lateral < Posterior 0.495 0.367 Medium 

Group | Region Control Medial < Posterior 0.96 0.0267 Small 

Group | Region Fentanyl Anterior > Lateral 1.2E-06 *** 2.93 Large 

Group | Region Fentanyl Anterior > Medial 2.8E-06 *** 2.79 Large 

Group | Region Fentanyl Anterior > Posterior 1.4E-06 *** 2.9 Large 

Group | Region Fentanyl Lateral < Medial 0.808 0.131 Small 

Group | Region Fentanyl Lateral < Posterior 0.96 0.0271 Small 

Group | Region Fentanyl Medial > Posterior 0.847 0.104 Small 

Group | Region Morphine Anterior > Lateral 0.00039 
2 

*** 2.02 Large 

Group | Region Morphine Anterior > Medial 0.00485 ** 1.57 Large 

Group | Region Morphine Anterior > Posterior 0.0265 * 1.22 Large 

Group | Region Morphine Lateral < Medial 0.403 0.451 Medium 

Group | Region Morphine Lateral < Posterior 0.139 0.802 Large 

Group | Region Morphine Medial < Posterior 0.514 0.351 Medium 

Connectivity density 
Interaction 

Contrast Comparison p-value Sig. 
Cohen's 

D 
Effect 
Group 

Power 

Region Anterior > Lateral 0.00961 ** 1.01 Large 35% 

Region Anterior > Medial 0.42 0.476 Medium 

Region Anterior > Posterior 0.00049 
4 

*** 1.31 Large 

Region Lateral < Medial 0.316 0.536 Medium 

Region Lateral > Posterior 0.77 0.298 Medium 
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Region Medial > Posterior 0.0444 * 0.833 Large 

Region | Group Anterior Control < Fentanyl 0.22 1.61 Large 46% 

Region | Group Anterior Control < Morphine 0.491 0.893 Large 

Region | Group Anterior Fentanyl > Morphine 0.581 0.714 Medium 

Region | Group Lateral Control < Fentanyl 0.581 0.714 Medium 

Region | Group Lateral Control < Morphine 0.491 0.893 Large 

Region | Group Lateral Fentanyl < Morphine 0.89 0.179 Small 

Region | Group Medial Control < Fentanyl 0.89 0.179 Small 

Region | Group Medial Control < Morphine 0.491 0.893 Large 

Region | Group Medial Fentanyl < Morphine 0.581 0.714 Medium 

Region | Group Posterior Control > Fentanyl 1 0 Small 

Region | Group Posterior Control < Morphine 0.337 1.25 Large 

Region | Group Posterior Fentanyl < Morphine 0.337 1.25 Large 

Group | Region Control Anterior > Lateral 0.187 0.714 Medium 

Group | Region Control Anterior < Medial 1 0 Small 

Group | Region Control Anterior > Posterior 0.101 0.893 Large 

Group | Region Control Lateral < Medial 0.187 0.714 Medium 

Group | Region Control Lateral > Posterior 0.74 0.179 Small 

Group | Region Control Medial > Posterior 0.101 0.893 Large 

Group | Region Fentanyl Anterior > Lateral 0.00401 ** 1.61 Large 

Group | Region Fentanyl Anterior > Medial 0.00994 ** 1.43 Large 

Group | Region Fentanyl Anterior > Posterior 1.99E-05 *** 2.5 Large 

Group | Region Fentanyl Lateral < Medial 0.74 0.179 Small 

Group | Region Fentanyl Lateral > Posterior 0.101 0.893 Large 

Group | Region Fentanyl Medial > Posterior 0.0501 . 1.07 Large 

Group | Region Morphine Anterior > Lateral 0.187 0.714 Medium 

Group | Region Morphine Anterior < Medial 1 0 Small 

Group | Region Morphine Anterior > Posterior 0.321 0.536 Medium 

Group | Region Morphine Lateral < Medial 0.187 0.714 Medium 

Group | Region Morphine Lateral < Posterior 0.74 0.179 Small 

Group | Region Morphine Medial > Posterior 0.321 0.536 Medium 

SD Pore Thickness 
Interaction 

Contrast 
Comparison p-value Sig. 

Cohen's 
D 

Effect 
Group 

Power 

Region Anterior > Lateral 0.0001 *** 1.46 Large 40% 

Region Anterior < Medial 0.988 0.101 Small 

Region Anterior < Posterior 
0.00016 

2 
*** 1.41 Large 

Region Lateral < Medial 3.22E-05 *** 1.56 Large 

Region Lateral < Posterior 0 *** 2.87 Large 

Region Medial < Posterior 
0.00048 

3 
*** 1.31 Large 

SD Pore Separation 
Interaction 

Contrast 
Comparison p-value Sig. Cohen's 

D 
Effect 
Group 

Power 
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Region Anterior > Lateral 0 *** 2.3 Large 38% 

Region Anterior > Medial 2.5E-06 *** 1.77 Large 

Region Anterior > Posterior 0.0544 . 0.807 Large 

Region Lateral < Medial 0.328 0.528 Medium 

Region Lateral < Posterior 6.41E-05 *** 1.5 Large 

Region Medial < Posterior 0.0143 * 0.967 Large 

Avg. Pore volume 
Interaction 

Contrast Comparison p-value Sig. 
Cohen's 

D 
Effect 
Group 

Power 

Region Anterior > Lateral 0 *** 2.55 Large 49% 

Region Anterior > Medial 0.168 0.646 Medium 

Region Anterior < Posterior 0.0313 * 0.877 Large 

Region Lateral < Medial 5E-07 *** 1.91 Large 

Region Lateral < Posterior 0 *** 3.43 Large 

Region Medial < Posterior 4.71E-05 *** 1.52 Large 

Avg. Pore surface 
Interaction 

Contrast 
Comparison p-value Sig. Cohen's 

D 
Effect 
Group 

Power 

Region Anterior > Lateral 0 *** 2.5 Large 54% 

Region Anterior > Medial 0.186 0.63 Medium 

Region Anterior < Posterior 0.0547 . 0.806 Large 

Region Lateral < Medial 9E-07 *** 1.87 Large 

Region Lateral < Posterior 0 *** 3.3 Large 

Region Medial < Posterior 
0.00012 

4 
*** 1.44 Large 

Avg. Orientation theta 
Interaction 

Contrast 
Comparison p-value Sig. Cohen's 

D 
Effect 
Group 

Power 

Region Anterior < Lateral 0.0362 * 0.859 Large 26% 

Region Anterior > Medial 0 *** 2.13 Large 

Region Anterior > Posterior 0 *** 3.37 Large 

Region Lateral > Medial 0 *** 2.99 Large 

Region Lateral > Posterior 0 *** 4.23 Large 

Region Medial > Posterior 0.00104 ** 1.24 Large 

Avg. Orientation phi 
Interaction 

Contrast Comparison p-value Sig. 
Cohen's 

D 
Effect 
Group 

Power 

Region Anterior > Lateral 0.0716 . 0.771 Medium 26% 

Region Anterior > Medial 0 *** 2.12 Large 

Region Anterior > Posterior 0.00244 ** 1.15 Large 

Region Lateral > Medial 
0.00033 

6 
*** 1.35 Large 

Region Lateral > Posterior 0.602 0.384 Medium 

Region Medial < Posterior 0.0152 * 0.961 Large 

Avg. Pore thickness 
Interaction 

Contrast Comparison p-value Sig. 
Cohen's 

D 
Effect 
Group 

Power 

Region Anterior < Lateral 0.127 0.689 Medium 39% 

Region Anterior < Medial 5.09E-05 *** 1.52 Large 
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Region Anterior < Posterior 0 *** 3.74 Large 

Region Lateral < Medial 0.0468 * 0.826 Large 

Region Lateral < Posterior 0 *** 3.05 Large 

Region Medial < Posterior 0 *** 2.22 Large 

Avg. Pore Major 
diameter 

Interaction 
Contrast 

Comparison p-value Sig. Cohen's 
D 

Effect 
Group 

Power 

Region Anterior > Lateral 7.8E-06 *** 1.68 Large 63% 

Region Anterior > Medial 0.0267 * 0.896 Large 

Region Anterior < Posterior 0.00020 
5 

*** 1.39 Large 

Region Lateral < Medial 0.0656 . 0.783 Medium 

Region Lateral < Posterior 0 *** 3.07 Large 

Region Medial < Posterior 0 *** 2.29 Large 

Region | Group Anterior Control > Fentanyl 0.0847 . 1.59 Large 45% 

Region | Group Anterior Control > Morphine 0.216 1.13 Large 

Region | Group Anterior Fentanyl < Morphine 0.608 0.464 Medium 

Region | Group Lateral Control > Fentanyl 0.685 0.367 Medium 

Region | Group Lateral Control > Morphine 0.403 0.759 Medium 

Region | Group Lateral Fentanyl > Morphine 0.664 0.392 Medium 

Region | Group Medial Control < Fentanyl 0.575 0.506 Medium 

Region | Group Medial Control < Morphine 0.577 0.505 Medium 

Region | Group Medial Fentanyl > Morphine 0.999 0.00157 Small 

Region | Group Posterior Control > Fentanyl 0.0583 . 1.76 Large 

Region | Group Posterior Control > Morphine 0.442 0.697 Medium 

Region | Group Posterior Fentanyl < Morphine 0.245 1.06 Large 

Group | Region Control Anterior > Lateral 0.00012 
5 

*** 2.21 Large 

Group | Region Control Anterior > Medial 
0.00019 

3 
*** 2.14 Large 

Group | Region Control Anterior < Posterior 0.0182 * 1.3 Large 

Group | Region Control Lateral < Medial 0.896 0.0705 Small 

Group | Region Control Lateral < Posterior 0 *** 3.51 Large 

Group | Region Control Medial < Posterior 0 *** 3.44 Large 

Group | Region Fentanyl Anterior > Lateral 0.0709 . 0.985 Large 

Group | Region Fentanyl Anterior > Medial 0.938 0.0414 Small 

Group | Region Fentanyl Anterior < Posterior 0.038 * 1.14 Large 

Group | Region Fentanyl Lateral < Medial 0.0832 . 0.943 Large 

Group | Region Fentanyl Lateral < Posterior 
0.00021 

4 
*** 2.12 Large 

Group | Region Fentanyl Medial < Posterior 0.0318 * 1.18 Large 

Group | Region Morphine Anterior > Lateral 0.00112 ** 1.84 Large 

Group | Region Morphine Anterior > Medial 0.348 0.507 Medium 

Group | Region Morphine Anterior < Posterior 0.00203 ** 1.73 Large 
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Group | Region Morphine Lateral < Medial 0.0157 * 1.33 Large 

Group | Region Morphine Lateral < Posterior 0 *** 3.57 Large 

Group | Region Morphine Medial < Posterior 0.00010 
4 

*** 2.24 Large 

Avg. Pore Sphericity 
Interaction 

Contrast Comparison p-value Sig. 
Cohen's 

D 
Effect 
Group 

Power 

Region Anterior < Lateral 3E-07 *** 1.95 Large 28% 

Region Anterior < Medial 0.00014 
7 

*** 1.42 Large 

Region Anterior < Posterior 1.1E-06 *** 1.85 Large 

Region Lateral > Medial 0.33 0.527 Medium 

Region Lateral > Posterior 0.987 0.103 Small 

Region Medial < Posterior 0.521 0.424 Medium 

Tibial Regions: All Directional Trends 

Cortical Fractal Trends 

Region Medial > Posterior > Lateral > Anterior 

Group Fentanyl > Morphine > Control 

Region | Group Anterior Fentanyl > Morphine > Control 

Region | Group Lateral Morphine > Fentanyl > Control 

Region | Group Medial Fentanyl > Morphine > Control 

Region | Group Posterior Morphine > Fentanyl > Control 

Group | Region Control Medial > Posterior > Anterior > Lateral 

Group | Region Fentanyl Medial > Anterior > Lateral > Posterior 

Group | Region Morphine Medial > Lateral > Posterior > Anterior 

Number Closed Pores Trends 

Region Anterior > Lateral > Medial > Posterior 

Group Fentanyl > Morphine > Control 

Region | Group Anterior Fentanyl > Morphine > Control 

Region | Group Lateral Morphine > Fentanyl > Control 

Region | Group Medial Fentanyl > Morphine > Control 

Region | Group Posterior Fentanyl > Morphine > Control 

Group | Region Control Anterior > Medial > Lateral > Posterior 

Group | Region Fentanyl Anterior > Lateral > Posterior > Medial 

Group | Region Morphine Anterior > Lateral > Posterior > Medial 

Number Open Pores Trends 

Region Anterior > Medial > Posterior > Lateral 

Group Fentanyl > Morphine > Control 

Region | Group Anterior Fentanyl > Control > Morphine 

Region | Group Lateral Fentanyl > Morphine > Control 

Region | Group Medial Fentanyl > Morphine > Control 

Region | Group Posterior Morphine > Fentanyl > Control 
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Group | Region Control Anterior > Medial > Posterior > Lateral 

Group | Region Fentanyl Anterior > Medial > Posterior > Lateral 

Group | Region Morphine Posterior > Anterior > Medial > Lateral 

Closed Pore Density Trends 

Region Lateral > Medial > Anterior > Posterior 

Group Fentanyl > Morphine > Control 

Region | Group Anterior Fentanyl > Morphine > Control 

Region | Group Lateral Fentanyl > Morphine > Control 

Region | Group Medial Fentanyl > Control > Morphine 

Region | Group Posterior Fentanyl > Morphine > Control 

Group | Region Control Medial > Lateral > Anterior > Posterior 

Group | Region Fentanyl Lateral > Medial > Anterior > Posterior 

Group | Region Morphine Lateral > Medial > Anterior > Posterior 

Open Pore Density Trends 

Region Medial > Lateral > Posterior > Anterior 

Group Fentanyl > Morphine > Control 

Region | Group Anterior Fentanyl > Control > Morphine 

Region | Group Lateral Fentanyl > Morphine > Control 

Region | Group Medial Control > Fentanyl > Morphine 

Region | Group Posterior Morphine > Fentanyl > Control 

Group | Region Control Medial > Anterior > Lateral > Posterior 

Group | Region Fentanyl Medial > Lateral > Anterior > Posterior 

Group | Region Morphine Medial > Lateral > Posterior > Anterior 

Closed Porosity (%) Trends 

Region Posterior > Medial > Lateral > Anterior 

Group Morphine > Fentanyl > Control 

Region | Group Anterior Fentanyl > Morphine > Control 

Region | Group Lateral Morphine > Fentanyl > Control 

Region | Group Medial Fentanyl > Morphine > Control 

Region | Group Posterior Morphine > Control > Fentanyl 

Group | Region Control Posterior > Medial > Anterior > Lateral 

Group | Region Fentanyl Medial > Lateral > Posterior > Anterior 

Group | Region Morphine Posterior > Medial > Lateral > Anterior 

Open Porosity (%) Trends 

Region Posterior > Anterior > Medial > Lateral 

Group Morphine > Control > Fentanyl 

Region | Group Anterior Fentanyl > Morphine > Control 

Region | Group Lateral Morphine > Fentanyl > Control 

Region | Group Medial Morphine > Control > Fentanyl 

Region | Group Posterior Control > Morphine > Fentanyl 

Group | Region Control Posterior > Medial > Anterior > Lateral 
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Group | Region Fentanyl Anterior > Medial > Posterior > Lateral 

Group | Region Morphine Posterior > Medial > Anterior > Lateral 

Total Porosity (%) Trends 

Region Posterior > Medial > Anterior > Lateral 

Group Morphine > Fentanyl > Control 

Region | Group Anterior Fentanyl > Morphine > Control 

Region | Group Lateral Morphine > Fentanyl > Control 

Region | Group Medial Morphine > Control > Fentanyl 

Region | Group Posterior Morphine > Control > Fentanyl 

Group | Region Control Posterior > Medial > Anterior > Lateral 

Group | Region Fentanyl Anterior > Medial > Posterior > Lateral 

Group | Region Morphine Posterior > Medial > Anterior > Lateral 

Cortical Volume Trends 

Region Anterior > Posterior > Medial > Lateral 

Group Morphine > Fentanyl > Control 

Region | Group Anterior Morphine > Fentanyl > Control 

Region | Group Lateral Morphine > Fentanyl > Control 

Region | Group Medial Morphine > Fentanyl > Control 

Region | Group Posterior Morphine > Fentanyl > Control 

Group | Region Control Anterior > Posterior > Lateral > Medial 

Group | Region Fentanyl Anterior > Posterior > Medial > Lateral 

Group | Region Morphine Anterior > Posterior > Medial > Lateral 

Pore Volume Trends 

Region Posterior > Anterior > Medial > Lateral 

Group Morphine > Fentanyl > Control 

Region | Group Anterior Fentanyl > Morphine > Control 

Region | Group Lateral Morphine > Fentanyl > Control 

Region | Group Medial Morphine > Fentanyl > Control 

Region | Group Posterior Morphine > Control > Fentanyl 

Group | Region Control Posterior > Anterior > Medial > Lateral 

Group | Region Fentanyl Anterior > Posterior > Medial > Lateral 

Group | Region Morphine Posterior > Anterior > Medial > Lateral 

Cortical Surface Trends 

Region Anterior > Posterior > Lateral > Medial 

Group Morphine > Fentanyl > Control 

Region | Group Anterior Morphine > Fentanyl > Control 

Region | Group Lateral Morphine > Fentanyl > Control 

Region | Group Medial Morphine > Fentanyl > Control 

Region | Group Posterior Morphine > Fentanyl > Control 

Group | Region Control Anterior > Posterior > Lateral > Medial 

Group | Region Fentanyl Anterior > Posterior > Lateral > Medial 
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Group | Region Morphine Anterior > Posterior > Lateral > Medial 

Pore Surface Trends 

Region Anterior > Posterior > Medial > Lateral 

Group Morphine > Fentanyl > Control 

Region | Group Anterior Fentanyl > Morphine > Control 

Region | Group Lateral Morphine > Fentanyl > Control 

Region | Group Medial Morphine > Fentanyl > Control 

Region | Group Posterior Morphine > Fentanyl > Control 

Group | Region Control Anterior > Posterior > Medial > Lateral 

Group | Region Fentanyl Anterior > Posterior > Medial > Lateral 

Group | Region Morphine Posterior > Anterior > Medial > Lateral 

Intersection Surface Trends 

Region Posterior > Medial > Anterior > Lateral 

Group Morphine > Fentanyl > Control 

Region | Group Anterior Fentanyl > Morphine > Control 

Region | Group Lateral Morphine > Fentanyl > Control 

Region | Group Medial Control > Morphine > Fentanyl 

Region | Group Posterior Morphine > Control > Fentanyl 

Group | Region Control Posterior > Medial > Anterior > Lateral 

Group | Region Fentanyl Anterior > Medial > Posterior > Lateral 

Group | Region Morphine Posterior > Medial > Anterior > Lateral 

Pore Surface:PoreVolume Trends 

Region Lateral > Medial > Anterior > Posterior 

Group Fentanyl > Control > Morphine 

Region | Group Anterior Control > Fentanyl > Morphine 

Region | Group Lateral Fentanyl > Morphine > Control 

Region | Group Medial Fentanyl > Control > Morphine 

Region | Group Posterior Fentanyl > Morphine > Control 

Group | Region Control Lateral > Medial > Anterior > Posterior 

Group | Region Fentanyl Lateral > Medial > Posterior > Anterior 

Group | Region Morphine Lateral > Medial > Anterior > Posterior 

Pore Surface:Cortical Volume Trends 

Region Medial > Posterior > Anterior > Lateral 

Group Morphine > Fentanyl > Control 

Region | Group Anterior Fentanyl > Morphine > Control 

Region | Group Lateral Fentanyl > Morphine > Control 

Region | Group Medial Morphine > Fentanyl > Control 

Region | Group Posterior Morphine > Control > Fentanyl 

Group | Region Control Medial > Posterior > Anterior > Lateral 

Group | Region Fentanyl Medial > Anterior > Lateral > Posterior 

Group | Region Morphine Posterior > Medial > Lateral > Anterior 
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Pore Thickness Trends 

Region Posterior > Anterior > Medial > Lateral 

Group Morphine > Control > Fentanyl 

Region | Group Anterior Morphine > Fentanyl > Control 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Morphine > Control > Fentanyl 

Region | Group Posterior Control > Morphine > Fentanyl 

Group | Region Control Posterior > Medial > Anterior > Lateral 

Group | Region Fentanyl Posterior > Anterior > Medial > Lateral 

Group | Region Morphine Posterior > Anterior > Medial > Lateral 

Pore Separation Trends 

Region Anterior > Posterior > Lateral > Medial 

Group Control > Morphine > Fentanyl 

Region | Group Anterior Control > Morphine > Fentanyl 

Region | Group Lateral Control > Fentanyl > Morphine 

Region | Group Medial Control > Fentanyl > Morphine 

Region | Group Posterior Control > Fentanyl > Morphine 

Group | Region Control Anterior > Posterior > Lateral > Medial 

Group | Region Fentanyl Posterior > Anterior > Medial > Lateral 

Group | Region Morphine Anterior > Posterior > Medial > Lateral 

Pore Tb.N Trends 

Region Medial > Lateral > Anterior > Posterior 

Group Fentanyl > Morphine > Control 

Region | Group Anterior Fentanyl > Morphine > Control 

Region | Group Lateral Fentanyl > Morphine > Control 

Region | Group Medial Fentanyl > Morphine > Control 

Region | Group Posterior Morphine > Fentanyl > Control 

Group | Region Control Medial > Posterior > Anterior > Lateral 

Group | Region Fentanyl Medial > Lateral > Anterior > Posterior 

Group | Region Morphine Medial > Posterior > Lateral > Anterior 

Degree of Anisotropy Trends 

Region Posterior > Anterior > Medial > Lateral 

Group Control > Morphine > Fentanyl 

Region | Group Anterior Fentanyl > Morphine > Control 

Region | Group Lateral Fentanyl > Morphine > Control 

Region | Group Medial Control > Fentanyl > Morphine 

Region | Group Posterior Control > Morphine > Fentanyl 

Group | Region Control Posterior > Anterior > Medial > Lateral 

Group | Region Fentanyl Anterior > Posterior > Medial > Lateral 

Group | Region Morphine Posterior > Anterior > Medial > Lateral 

Pore Fractal Trends 
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Region Medial > Posterior > Anterior > Lateral 

Group Morphine > Fentanyl > Control 

Region | Group Anterior Fentanyl > Morphine > Control 

Region | Group Lateral Morphine > Fentanyl > Control 

Region | Group Medial Fentanyl > Morphine > Control 

Region | Group Posterior Morphine > Fentanyl > Control 

Group | Region Control Medial > Posterior > Anterior > Lateral 

Group | Region Fentanyl Medial > Anterior > Lateral > Posterior 

Group | Region Morphine Medial > Posterior > Lateral > Anterior 

Number of Objects Trends 

Region Anterior > Lateral > Medial > Posterior 

Group Fentanyl > Morphine > Control 

Region | Group Anterior Fentanyl > Morphine > Control 

Region | Group Lateral Morphine > Fentanyl > Control 

Region | Group Medial Fentanyl > Morphine > Control 

Region | Group Posterior Fentanyl > Morphine > Control 

Group | Region Control Anterior > Medial > Lateral > Posterior 

Group | Region Fentanyl Anterior > Lateral > Posterior > Medial 

Group | Region Morphine Anterior > Lateral > Posterior > Medial 

Pore Density Trends 

Region Lateral > Medial > Anterior > Posterior 

Group Fentanyl > Morphine > Control 

Region | Group Anterior Fentanyl > Morphine > Control 

Region | Group Lateral Fentanyl > Morphine > Control 

Region | Group Medial Fentanyl > Control > Morphine 

Region | Group Posterior Fentanyl > Morphine > Control 

Group | Region Control Medial > Lateral > Anterior > Posterior 

Group | Region Fentanyl Lateral > Medial > Anterior > Posterior 

Group | Region Morphine Lateral > Medial > Posterior > Anterior 

Euler number Trends 

Region Anterior > Lateral > Medial > Posterior 

Group Fentanyl > Morphine > Control 

Region | Group Anterior Fentanyl > Morphine > Control 

Region | Group Lateral Fentanyl > Morphine > Control 

Region | Group Medial Fentanyl > Morphine > Control 

Region | Group Posterior Fentanyl > Morphine > Control 

Group | Region Control Anterior > Medial > Lateral > Posterior 

Group | Region Fentanyl Anterior > Lateral > Posterior > Medial 

Group | Region Morphine Lateral > Anterior > Posterior > Medial 

Connectivity Trends 

Region Anterior > Posterior > Medial > Lateral 
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Group Morphine > Fentanyl > Control 

Region | Group Anterior Fentanyl > Morphine > Control 

Region | Group Lateral Morphine > Fentanyl > Control 

Region | Group Medial Morphine > Fentanyl > Control 

Region | Group Posterior Morphine > Fentanyl > Control 

Group | Region Control Anterior > Posterior > Medial > Lateral 

Group | Region Fentanyl Anterior > Medial > Posterior > Lateral 

Group | Region Morphine Anterior > Posterior > Medial > Lateral 

Connectivity density Trends 

Region Anterior > Medial > Lateral > Posterior 

Group Morphine > Fentanyl > Control 

Region | Group Anterior Fentanyl > Morphine > Control 

Region | Group Lateral Morphine > Fentanyl > Control 

Region | Group Medial Morphine > Fentanyl > Control 

Region | Group Posterior Morphine > Control > Fentanyl 

Group | Region Control Medial > Anterior > Lateral > Posterior 

Group | Region Fentanyl Anterior > Medial > Lateral > Posterior 

Group | Region Morphine Medial > Anterior > Posterior > Lateral 

SD Pore Thickness Trends 

Region Posterior > Medial > Anterior > Lateral 

Group Control > Morphine > Fentanyl 

Region | Group Anterior Morphine > Control > Fentanyl 

Region | Group Lateral Control > Morphine > Fentanyl 

Region | Group Medial Morphine > Control > Fentanyl 

Region | Group Posterior Control > Morphine > Fentanyl 

Group | Region Control Posterior > Medial > Anterior > Lateral 

Group | Region Fentanyl Posterior > Anterior > Medial > Lateral 

Group | Region Morphine Posterior > Medial > Anterior > Lateral 

SD Pore Separation Trends 

Region Anterior > Posterior > Medial > Lateral 

Group Fentanyl > Control > Morphine 

Region | Group Anterior Morphine > Control > Fentanyl 

Region | Group Lateral Control > Fentanyl > Morphine 

Region | Group Medial Fentanyl > Control > Morphine 

Region | Group Posterior Fentanyl > Morphine > Control 

Group | Region Control Anterior > Posterior > Medial > Lateral 

Group | Region Fentanyl Anterior > Posterior > Medial > Lateral 

Group | Region Morphine Anterior > Posterior > Medial > Lateral 

Avg. Pore volume Trends 

Region Posterior > Anterior > Medial > Lateral 

Group Morphine > Control > Fentanyl 
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Region | Group Anterior Morphine > Fentanyl > Control 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Morphine > Control > Fentanyl 

Region | Group Posterior Control > Morphine > Fentanyl 

Group | Region Control Posterior > Anterior > Medial > Lateral 

Group | Region Fentanyl Anterior > Posterior > Medial > Lateral 

Group | Region Morphine Posterior > Anterior > Medial > Lateral 

Avg. Pore surface Trends 

Region Posterior > Anterior > Medial > Lateral 

Group Morphine > Control > Fentanyl 

Region | Group Anterior Morphine > Fentanyl > Control 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Morphine > Fentanyl > Control 

Region | Group Posterior Control > Morphine > Fentanyl 

Group | Region Control Posterior > Anterior > Medial > Lateral 

Group | Region Fentanyl Anterior > Posterior > Medial > Lateral 

Group | Region Morphine Posterior > Anterior > Medial > Lateral 

Avg. Orientation theta Trends 

Region Lateral > Anterior > Medial > Posterior 

Group Control > Morphine > Fentanyl 

Region | Group Anterior Control > Fentanyl > Morphine 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Morphine > Fentanyl > Control 

Region | Group Posterior Fentanyl > Control > Morphine 

Group | Region Control Lateral > Anterior > Medial > Posterior 

Group | Region Fentanyl Lateral > Anterior > Medial > Posterior 

Group | Region Morphine Lateral > Anterior > Medial > Posterior 

Orientation phi Trends 

Region Anterior > Lateral > Posterior > Medial 

Group Fentanyl > Control > Morphine 

Region | Group Anterior Fentanyl > Control > Morphine 

Region | Group Lateral Fentanyl > Control > Morphine 

Region | Group Medial Fentanyl > Morphine > Control 

Region | Group Posterior Fentanyl > Morphine > Control 

Group | Region Control Anterior > Lateral > Posterior > Medial 

Group | Region Fentanyl Anterior > Lateral > Posterior > Medial 

Group | Region Morphine Anterior > Lateral > Posterior > Medial 

Avg. Pore thickness Trends 

Region Posterior > Medial > Lateral > Anterior 

Group Control > Morphine > Fentanyl 

Region | Group Anterior Control > Morphine > Fentanyl 

2018-DU-BX-0188 Final Technical Report 
October 2021 

This resource was prepared by the author(s) using Federal funds provided by the U.S. 
Department of Justice. Opinions or points of view expressed are those of the author(s) and do not 

necessarily reflect the official position or policies of the U.S. Department of Justice.

368 



 
 

       

        

        

        

        

        

     

       

      

        

       

        

        

         

         

         

  

      

     

        

        

       

       

        

        

        

 

 

 

Region | Group Lateral Control > Fentanyl > Morphine 

Region | Group Medial Fentanyl > Morphine > Control 

Region | Group Posterior Control > Morphine > Fentanyl 

Group | Region Control Posterior > Medial > Lateral > Anterior 

Group | Region Fentanyl Posterior > Medial > Lateral > Anterior 

Group | Region Morphine Posterior > Medial > Lateral > Anterior 

Avg. Pore Major diameter Trends 

Region Posterior > Anterior > Medial > Lateral 

Group Control > Morphine > Fentanyl 

Region | Group Anterior Control > Morphine > Fentanyl 

Region | Group Lateral Control > Fentanyl > Morphine 

Region | Group Medial Fentanyl > Morphine > Control 

Region | Group Posterior Control > Morphine > Fentanyl 

Group | Region Control Posterior > Anterior > Medial > Lateral 

Group | Region Fentanyl Posterior > Anterior > Medial > Lateral 

Group | Region Morphine Posterior > Anterior > Medial > Lateral 

Sphericity Trends 

Region Lateral > Posterior > Medial > Anterior 

Group Control > Fentanyl > Morphine 

Region | Group Anterior Control > Morphine > Fentanyl 

Region | Group Lateral Control > Morphine > Fentanyl 

Region | Group Medial Control > Fentanyl > Morphine 

Region | Group Posterior Fentanyl > Control > Morphine 

Group | Region Control Lateral > Posterior > Medial > Anterior 

Group | Region Fentanyl Posterior > Lateral > Medial > Anterior 

Group | Region Morphine Lateral > Posterior > Medial > Anterior 
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Appendix XXIV: Femoral Histology Descriptive Statistics 

Whole-Section Morphometry by Drug Treatment Group 

Control Control Control Fentanyl Fentanyl Fentanyl Morphine Morphine Morphine 

Mean Median SD Mean Median SD Mean Median SD 

% Cortical 
Area 

55.5 54.9 4.84 57.6 58.1 2.69 55 54.7 2.77 

% Marrow 
Area 

44.5 45.1 4.84 42.4 41.9 2.69 45 45.3 2.77 

% Remodeling 
Area 

18.6 18.5 2.95 17.1 17 0.565 21 20.6 1.44 

a.Rm.Cr/CA 
(a.Rm.Cr. 
OPD.CA) 
(#/mm^2) 

7.72 7.64 0.601 7.34 7.9 1.55 10.8 11.3 2.64 

a.Rm.Cr/RA 
(a.Rm.Cr. 
OPD.RA) 
(#/mm^2) 

23.6 23.9 4.93 24.7 25.6 4.86 28.1 28.7 6.57 

Ac.F.C 
(#/mm^2/year) 120 114 43.4 101 85.4 40.4 141 135 43.7 

Ac.F.I 
(#/mm^2/year) 119 113 36.9 103 87.5 38.8 143 143 54.1 

Ac.F.I.dL 
(#/mm^2/year) 173 170 44.6 122 116 28.3 198 195 70.9 

a.Rm.Cr 182 182 14.8 180 176 33.1 269 278 75.2 

C.On Mean 
Area (um^2) 16300 16300 3410 11700 12600 3580 12100 11100 2110 

C.On Mean 
Aspect Ratio 

1.65 1.67 0.0805 1.64 1.64 0.123 1.59 1.6 0.0417 

C.On Mean 
Circularity 

0.674 0.677 0.0376 0.715 0.712 0.0369 0.703 0.699 0.0291 

C.On Mean 
Roundness 

0.658 0.657 0.0138 0.67 0.664 0.0339 0.672 0.666 0.0181 

C.On Mean 
Solidity 

0.919 0.918 0.0223 0.933 0.933 0.017 0.933 0.934 0.0124 

C.On Mean 
Wall 

Thickness 
(W.Th.C) 

(um) 

35.9 39.4 9.22 36 39 6.42 36.7 36.6 2.09 

C.On/CA 
(C.On. 

OPD.CA) 
(#/mm^2) 

3.71 3.8 0.397 3.24 3.27 0.587 4.86 5.06 1.18 

C.On/RA 
(C.On. 

OPD.RA) 
(#/mm^2) 

11.3 11.6 2.51 10.9 10.6 1.87 12.7 12.5 3.32 

Combined 
Mean Inner 
Label (um) 

41.6 40.1 6.34 42.4 44.7 8.36 40.5 38.6 8.42 

Combined 
Mean Label 

(um) 
41.6 40.3 5.16 41.3 42.3 7.81 40.5 39.5 6.37 
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Control Control Control Fentanyl Fentanyl Fentanyl Morphine Morphine Morphine 

Mean Median SD Mean Median SD Mean Median SD 

Complete 
Osteon Count 

(C.On) 
87.8 86.5 11.2 79.8 76.5 13.6 122 128 32.7 

Cortical Area 
(mm^2) 23.7 24.5 2.72 24.9 25.1 3.2 24.9 24.5 1.11 

dL.On Mean 
Area (um^2) 17300 17700 3290 14100 15000 3470 12900 11600 3220 

dL.On Mean 
Aspect Ratio 

1.65 1.67 0.0989 1.54 1.49 0.113 1.56 1.57 0.0697 

dL.On Mean 
Circularity 

0.668 0.665 0.0428 0.715 0.718 0.0155 0.7 0.699 0.0406 

dL.On Mean 
Inner Label 

(um) 
61.6 63 9.3 51.9 46.7 13.2 56.5 53 10.7 

dL.On Mean 
Roundness 

0.652 0.64 0.0256 0.691 0.709 0.0409 0.681 0.677 0.0292 

dL.On Mean 
Solidity 

0.918 0.918 0.0221 0.938 0.938 0.0126 0.932 0.931 0.0165 

dL.On Mean 
Wall 

Thickness 
(W.Th.dL) 

(um) 

38.6 41.7 9.04 42.1 41.9 4.63 39 38.4 2.6 

dL.On/CA 
(dL.On 

.OPD.CA) 
(#/mm^2) 

2.26 2.19 0.165 1.63 1.24 0.862 2.81 2.92 0.556 

dL.On/RA 
(dL.On. 

OPD.RA) 
(#/mm^2) 

6.9 7.36 1.35 5.42 4.18 2.61 7.34 7.16 1.47 

Double-
Labeled 

Osteon Count 
(dL.On) 

53.8 54 7.93 38.8 32.5 14.9 70 74 14.8 

Es.MS/BS (%) 48.1 56.1 20.9 42 50.9 28.1 34.3 31 20.3 

F.On Mean 
Area (um^2) 4190 4280 1570 2700 2670 745 2620 2160 1170 

F.On Mean 
Aspect Ratio 

1.82 1.81 0.182 1.8 1.82 0.204 1.83 1.79 0.197 

F.On Mean 
Circularity 

0.757 0.765 0.0259 0.755 0.743 0.0444 0.748 0.754 0.0379 

F.On Mean 
Roundness 

0.644 0.636 0.0274 0.65 0.646 0.0386 0.639 0.65 0.0422 

F.On Mean 
Solidity 

0.937 0.939 0.00757 0.925 0.922 0.0221 0.926 0.932 0.0199 

F.On/CA 
(F.On. 

OPD.CA) 
(#/mm^2) 

3.77 3.68 0.33 3.74 4.26 1.13 5.53 5.79 1.62 

F.On/RA 
(F.On. 

OPD.RA) 
(#/mm^2) 

11.5 11.6 2.55 12.5 14 3.55 14.4 14.5 3.68 

Forming 
Osteon Count 

(F.On) 
88.8 88 4.65 91 96.5 23.6 138 142 45.2 
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Control Control Control Fentanyl Fentanyl Fentanyl Morphine Morphine Morphine 

Mean Median SD Mean Median SD Mean Median SD 

Imax (mm^4) 90.1 86.8 20.4 94.1 96.8 23.1 102 98 9.98 

Imin (mm^4) 156 150 40 161 168 28.2 169 158 33.3 

Marrow Area 
(mm^2) 19.2 17.9 4.08 18.3 18.5 1.85 20.5 20.1 2.9 

Mean Pore 
Area (um^2) 795 787 54.8 619 643 57.5 581 488 230 

Mean Pore 
Aspect Ratio 

2.42 2.36 0.191 2.49 2.37 0.291 2.34 2.26 0.272 

Mean Pore 
Circularity 

0.635 0.631 0.0328 0.616 0.628 0.0417 0.664 0.678 0.0688 

Mean Pore 
Max Feret 

Diameter (um) 
42.5 43 2.62 40.3 40.4 1.63 38.4 36.7 6.49 

Mean Pore 
Min Feret 

Diameter (um) 
20.3 21.2 1.83 19 19 0.735 18.3 17.1 2.91 

Mean Pore 
Perimeter 

(um) 
108 110 6.86 103 103 3.77 96.9 92.3 16.4 

Mean Pore 
Roundness 

0.54 0.546 0.023 0.532 0.549 0.0412 0.552 0.558 0.0389 

Mean Pore 
Solidity 

0.851 0.848 0.0183 0.839 0.846 0.0176 0.864 0.869 0.0368 

On.MAR.C 
(Combined 

Labels) 
(um/day) 

2.97 2.88 0.369 2.95 3.02 0.558 2.89 2.82 0.455 

On.MAR.I 
(Inner Labels) 

(um/day) 
2.97 2.86 0.453 3.03 3.19 0.597 2.89 2.76 0.601 

On.MAR.I.dL 
(dL Inner 
Labels) 

(um/day) 

4.4 4.5 0.665 3.71 3.34 0.942 4.03 3.79 0.767 

σf C (days) 12.1 12.1 3.1 12.6 12.1 3.92 12.8 13 1.26 

σf I (days) 12 12.2 2.58 12.3 11.4 3.98 13 13.1 1.94 

σf dL (days) 8.06 8.17 1.28 9.96 9.73 2.19 9.26 9.45 1.19 

Parabolic 
Index (Y) 0.245 0.247 0.00612 0.244 0.243 0.00379 0.247 0.247 0.00283 

Percent 
Porosity (%) 2.02 1.81 0.726 1.45 1.38 0.297 1.81 1.54 0.669 

Pore Density 
CA (1/mm^2) 25.4 22.8 8.57 23.6 23.6 5.43 31.5 31.6 0.836 

Pore Density 
RA (1/mm^2) 74.2 75.1 13.7 79.2 79.7 14.7 82.6 82.5 7.35 

Remodeling 
Area (mm^2) 8.09 7.62 2.35 7.35 7.42 0.62 9.53 9.54 0.992 

Rs.N/CA 
(Rs.N. 

OPD.CA) 
(#/mm^2) 

0.242 0.246 0.058 0.371 0.422 0.194 0.368 0.369 0.146 

Rs.N/RA 
(Rs.N. 

OPD.RA) 
(#/mm^2) 

0.722 0.735 0.133 1.26 1.48 0.658 0.978 1.03 0.41 
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Control Control Control Fentanyl Fentanyl Fentanyl Morphine Morphine Morphine 

Mean Median SD Mean Median SD Mean Median SD 

Single-
Labeled 

Osteon Count 
(sL.On) 

27.2 28 8.77 37.8 38 23.3 45.8 44.5 18.2 

sL.On Mean 
Area (um^2) 9020 9000 736 8160 7890 2580 8360 8290 916 

sL.On Mean 
Aspect Ratio 

1.61 1.6 0.0646 1.81 1.8 0.282 1.63 1.63 0.0934 

sL.On Mean 
Circularity 

0.707 0.703 0.0195 0.695 0.71 0.0994 0.721 0.723 0.0217 

sL.On Mean 
Roundness 

0.677 0.679 0.0141 0.63 0.64 0.0784 0.665 0.662 0.0331 

sL.On Mean 
Solidity 

0.932 0.933 0.019 0.919 0.928 0.0487 0.941 0.944 0.00886 

sL.On Mean 
Wall 

Thickness 
(W.Th.sL) 

(um) 

27.6 30.2 8.37 27.5 26.8 7.35 31 32 2.81 

sL.On/CA 
(sL.On. 

OPD.CA) 
(#/mm^2) 

1.15 1.23 0.346 1.46 1.46 0.851 1.82 1.82 0.658 

sL.On/RA 
(sL.On. 

OPD.RA) 
(#/mm^2) 

3.5 3.57 1.27 5.02 5 3 4.8 4.78 1.83 

T.On / Rs.N 32.3 32.1 7.38 31.9 15.3 35.5 31.3 24.6 14.3 

T.On Mean 
Area (um^2) 10200 10000 2210 7000 7080 2270 7110 6230 2050 

T.On Mean 
Aspect Ratio 

1.73 1.71 0.103 1.72 1.77 0.129 1.72 1.68 0.123 

T.On Mean 
Circularity 

0.716 0.721 0.0239 0.737 0.728 0.0399 0.726 0.732 0.0314 

T.On Mean 
Roundness 

0.651 0.651 0.012 0.659 0.649 0.0296 0.653 0.665 0.0278 

T.On Mean 
Solidity 

0.929 0.93 0.0122 0.93 0.928 0.0182 0.929 0.934 0.0162 

T.On/CA 
(T.On. 

OPD.CA) 
(#/mm^2) 

7.48 7.36 0.576 6.98 7.54 1.59 10.4 11 2.57 

T.On/RA 
(T.On. 

OPD.RA) 
(#/mm^2) 

22.8 23.2 4.85 23.4 24.6 4.94 27.1 27.8 6.27 

tL.On Mean 
Area (um^2) 33300 31700 13400 12900 12100 14900 30800 31500 9390 

tL.On Mean 
Aspect Ratio 

1.77 1.71 0.172 0.92 0.86 1.07 1.68 1.72 0.18 

tL.On Mean 
Circularity 

0.647 0.611 0.149 0.318 0.309 0.368 0.597 0.603 0.0322 

tL.On Mean 
Inner Label 

(um) 
21.7 20 6.06 9.8 8.81 11.4 24.5 24.9 7.3 
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Control Control Control Fentanyl Fentanyl Fentanyl Morphine Morphine Morphine 

Mean Median SD Mean Median SD Mean Median SD 

tL.On Mean 
Outer Label 

(um) 
41.5 43 6.63 15.9 15.8 18.3 40.4 39 9.4 

tL.On Mean 
Roundness 

0.625 0.616 0.0337 0.292 0.278 0.337 0.62 0.606 0.0696 

tL.On Mean 
Solidity 

0.893 0.883 0.0659 0.453 0.443 0.523 0.885 0.882 0.0103 

tL.On Mean 
Wall 

Thickness 
(W.Th.tL) 

(um) 

37.2 40.2 21.1 24.1 21.3 28.2 53 52.8 8.42 

tL.ON/CA 
(tL.On. 

OPD.CA) 
(#/mm^2) 

0.297 0.322 0.197 0.14 0.0885 0.182 0.231 0.216 0.0676 

tL.ON/RA 
(tL.On. 

OPD.RA) 
(#/mm^2) 

0.926 0.924 0.701 0.461 0.312 0.585 0.608 0.533 0.198 

Total Area 
(mm^2) 42.9 41.3 5.71 43.1 44.4 4.46 45.3 44.2 3.81 

Total Osteon 
Count (T.On) 176 177 13.3 171 169 32.3 260 270 72.4 

Total Pore 
Area (um^2) 487000 415000 214000 356000 333000 56400 452000 392000 167000 

Total Pore 
Number 612 554 257 576 570 75 782 778 30 

Triple-Labeled 
Osteon Count 

(tL.On) 
6.75 8 4.03 3.25 2.5 3.95 5.75 5.5 1.71 

Rs.N 5.75 5.5 1.71 9.5 11.5 5.07 9.25 9 4.03 

Zpol (mm^3) 52500000 50500000 9570000 55200000 57600000 8990000 57400000 56000000 4480000 
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Regional Morphometry 

A A A L L L M M M P P P 

Mean Med SD Mean Med SD Mean Med SD Mean Med SD 

a.Rm.Cr/ 
CA 

(a.Rm.Cr. 
OPD.CA) 
(#/mm^2) 

9.15 8.68 3.86 5.22 4.41 2.9 8.73 8.23 3.42 10.5 10.7 3.22 

a.Rm.Cr/ 
RA 

(a.Rm.Cr. 
OPD.RA) 
(#/mm^2) 

28.1 29 9.93 21.9 21.7 9.31 25.9 24.1 9.03 24.4 25.3 5.13 

Ac.F.C 
(#/mm^2/y 

ear) 
86.9 83.6 46.1 47.3 36.9 41.1 75.7 76.3 32 95.9 97.4 48.2 

Ac.F.I 
(#/mm^2/y 

ear) 
77.5 76.3 35.1 41.3 35.3 33.8 66.4 60.1 27.8 85.8 89.3 43.4 

Ac.F.I.dL 
(#/mm^2/y 

ear) 
80.5 78.6 35.5 45.5 38.4 36.5 70.3 64.7 28.8 84.8 88 36.5 

a.Rm.Cr 64 62.5 25.7 27.3 23 16.7 46.9 47 19.4 72.3 69.5 25.2 

C.On Mean 
Area 

(um^2) 
12200 

1240 
0 

4760 9790 
993 

0 
1900 15000 14500 6520 13800 14500 3230 

C.On Mean 
Aspect 
Ratio 

1.64 1.65 0.137 1.56 1.49 
0.20 

4 
1.67 1.6 0.198 1.59 1.58 

0.13 
3 

C.On Mean 
Circularity 

0.703 0.694 0.0606 0.749 
0.73 

7 
0.05 
93 

0.685 0.682 0.0526 0.697 0.705 
0.04 
74 

C.On Mean 
Roundness 

0.666 0.653 0.0372 0.681 
0.68 

3 
0.06 
35 

0.652 0.665 0.0608 0.679 0.686 
0.04 
71 

C.On Mean 
Solidity 

0.928 0.932 0.0245 0.952 0.95 
0.02 
52 

0.924 0.924 0.0223 0.927 0.934 
0.02 
62 

C.On Mean 
Wall 

Thickness 
(W.Th.C) 

(um) 

33.8 34.2 6.94 34 34.7 8.33 37 38.6 10.9 37.5 40.3 6.44 

C.On/CA 
(C.On. 

OPD.CA) 
(#/mm^2) 

4.28 4.24 1.88 2.2 2.12 1.4 4.09 4.23 1.69 4.73 5.14 1.7 

C.On/RA 
(C.On. 

OPD.RA) 
(#/mm^2) 

13.2 14.7 5.21 8.92 8.44 4.77 12.1 12.2 5.16 11 12.5 3.16 

Combined 
Mean Inner 
Label (um) 

24.3 22.6 6.22 21.3 20.6 5.54 23.4 22.9 6.25 24.6 21.4 8.1 

Combined 
Mean 

Label (um) 
26.3 23.8 6.4 23.6 23 5.84 26.6 26.6 7.85 27.1 26.8 7.07 

Complete 
Osteon 
Count 
(C.On) 

30 31 12.6 11.6 10 7.87 22.2 22 10.2 32.5 32 12.3 
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A A A L L L M M M P P P 

Mean Med SD Mean Med SD Mean Med SD Mean Med SD 

Cortical 
Area 

(mm^2) 
7.13 7.15 0.731 5.15 5.24 

0.70 
4 

5.32 5.25 0.517 6.89 6.81 
0.65 

4 

dL.On 
Mean Area 

(um^2) 
14000 

1340 
0 

4080 11000 
106 
00 

2080 15800 15100 5200 14900 15600 3620 

dL.On 
Mean 

Aspect 
Ratio 

1.59 1.59 0.112 1.56 1.48 
0.21 

9 
1.64 1.64 0.176 1.57 1.55 

0.17 
6 

dL.On 
Mean 

Circularity 
0.695 0.692 0.0585 0.741 

0.74 
8 

0.06 
34 

0.682 0.679 0.0485 0.694 0.694 
0.05 
04 

dL.On 
Mean Inner 
Label (um) 

25.3 23.3 6.49 23.2 21.2 5.43 24.7 23.1 6.54 24.8 23.5 5.46 

dL.On 
Mean 

Roundness 
0.671 0.668 0.0373 0.672 

0.68 
8 

0.07 
84 

0.656 0.659 0.0595 0.682 0.689 
0.06 
67 

dL.On 
Mean 

Solidity 
0.927 0.927 0.0254 0.951 

0.95 
2 

0.02 
59 

0.926 0.927 0.0244 0.928 0.936 
0.02 

3 

dL.On 
Mean Wall 
Thickness 
(W.Th.dL) 

(um) 

38.5 39.3 5.05 36.2 38.6 10.1 40.1 40.1 10.1 40.6 40.8 5.36 

dL.On/CA 
(dL.On. 

OPD.CA) 
(#/mm^2) 

2.3 2.51 1.25 1.2 
0.91 

4 
0.85 

8 
2.39 2.22 1.34 2.79 2.87 1.08 

dL.On/RA 
(dL.On. 

OPD.RA) 
(#/mm^2) 

6.91 7.95 3.22 4.92 4.19 3.06 6.98 6.51 3.85 6.53 6.44 2.35 

Double-
Labeled 
Osteon 
Count 

(dL.On) 

16 17 8.24 6.25 4.5 4.69 12.9 13 7.48 19 19 6.8 

F.On Mean 
Area 

(um^2) 
3200 2070 2040 2010 

149 
0 

1740 3540 2410 3080 3380 3070 1340 

F.On Mean 
Aspect 
Ratio 

1.7 1.68 0.159 1.78 1.74 
0.31 

1 
1.89 1.83 0.284 1.91 1.84 

0.31 
7 

F.On Mean 
Circularity 

0.774 0.768 0.0348 0.775 
0.77 

6 
0.04 
81 

0.735 0.741 0.0443 0.736 0.748 
0.06 
06 

F.On Mean 
Roundness 

0.668 0.665 0.0376 0.664 
0.65 

2 
0.06 
31 

0.622 0.633 0.0519 0.626 0.632 
0.05 
64 

F.On Mean 
Solidity 

0.938 0.937 0.0139 0.94 
0.93 

6 
0.01 

9 
0.92 0.925 0.0279 0.923 0.93 

0.03 
28 

F.On/CA 
(F.On. 

OPD.CA) 
(#/mm^2) 

4.57 4.24 2.22 2.83 2.32 1.45 4.32 3.73 1.96 5.29 4.76 1.81 

F.On/RA 
(F.On. 14 13.8 5.56 12.3 11.5 5.22 12.9 12.1 5.16 12.3 11.6 2.92 
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A A A L L L M M M P P P 

Mean Med SD Mean Med SD Mean Med SD Mean Med SD 

OPD.RA) 
(#/mm^2) 
Forming 
Osteon 
Count 
(F.On) 

31.8 31.5 14.8 14.7 12 8.29 22.9 19 10.4 36.7 35 14.6 

Mean Pore 
Area 

(um^2) 
671 735 251 510 493 172 696 643 247 690 653 203 

Mean Pore 
Aspect 
Ratio 

2.31 2.24 0.281 2.67 2.58 
0.48 

2 
2.39 2.3 0.278 2.43 2.39 

0.20 
2 

Mean Pore 
Circularity 

0.651 0.651 0.0523 0.618 
0.59 

5 
0.07 
44 

0.644 0.65 0.0598 0.632 0.624 
0.04 
23 

Mean Pore 
Max Feret 
Diameter 

(um) 

38.9 40.6 6.1 39.1 38.9 5.04 42.2 41.5 5.08 40.9 41.6 4.89 

Mean Pore 
Min Feret 
Diameter 

(um) 

19.2 19.5 2.75 17.6 17.8 2.42 19.9 19.3 2.46 19.3 19.8 2.57 

Mean Pore 
Perimeter 

(um) 
99.6 102 15.8 97.9 97.6 12 108 106 12.1 104 106 12.7 

Mean Pore 
Roundness 

0.559 0.574 0.0371 0.519 
0.51 

7 
0.06 
41 

0.548 0.553 0.0401 0.531 0.532 
0.02 
73 

Mean Pore 
Solidity 

0.857 0.856 0.0273 0.844 
0.83 

4 
0.03 
54 

0.853 0.86 0.0305 0.849 0.846 
0.02 
26 

On.MAR.C 
(Combined 

Labels) 
(um/day) 

1.88 1.7 0.457 1.68 1.64 
0.41 

7 
1.9 1.9 0.561 1.94 1.91 

0.50 
5 

On.MAR.I 
(Inner 

Labels) 
(um/day) 

1.74 1.61 0.444 1.52 1.47 
0.39 

6 
1.67 1.63 0.446 1.76 1.53 

0.57 
9 

On.MAR.I. 
dL (dL 
Inner 

Labels) 
(um/day) 

1.81 1.67 0.464 1.66 1.52 
0.38 

8 
1.77 1.65 0.467 1.77 1.68 0.39 

σf C (days) 18.6 17.2 4.87 21.4 20.7 7.68 19.9 19 5.01 20.7 19.6 6.6 

σf I (days) 20.1 19.3 5.35 23.3 21.8 7.72 22.7 23 6.24 23.1 21.5 7.34 

σf dL 
(days) 19.2 19.1 4.49 21.4 20.1 7.34 21.2 22.2 4.83 21.9 21.1 5.61 

Percent 
Porosity 

(%) 
1.85 1.83 0.916 0.912 

0.79 
9 

0.51 
1 

1.86 1.77 0.692 2.24 2.01 
0.88 

8 

Pore 
Density CA 
(1/mm^2) 

27.6 30.8 10.3 17.4 16.6 5.82 28 24.3 9.92 32.4 31.5 6.8 

Pore 
Density RA 
(1/mm^2) 

83.6 86.3 19.3 74.2 71.8 9.3 81.9 79.6 15 76.3 77.4 12.3 

RA/CA 
(%) 0.327 0.338 0.0902 0.239 0.23 

0.08 
43 

0.341 0.319 0.0992 0.426 0.419 
0.06 
96 
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A A A L L L M M M P P P 

Mean Med SD Mean Med SD Mean Med SD Mean Med SD 

Remodelin 
g Area 
(mm^2) 

2.3 2.41 0.615 1.26 1.19 
0.55 

8 
1.81 1.81 0.512 2.95 2.83 

0.67 
1 

Rs.N/CA 
(Rs.N. 

OPD.CA) 
(#/mm^2) 

0.3 0.271 0.287 0.197 
0.08 

5 
0.33 

5 
0.325 0.36 0.277 0.453 0.375 

0.29 
3 

Rs.N/RA 
(Rs.N. 

OPD.RA) 
(#/mm^2) 

0.906 0.805 0.834 0.685 
0.25 

4 
0.92 

3 
0.979 0.905 0.836 1.1 0.829 

0.75 
1 

Single-
Labeled 
Osteon 
Count 

(sL.On) 

12.7 13.5 6.87 4.92 4 4.01 7.83 7.5 6.18 11.5 10 7.55 

sL.On 
Mean Area 

(um^2) 
7520 6560 3790 5560 

575 
0 

3640 8600 8930 3990 9660 10800 2610 

sL.On 
Mean 

Aspect 
Ratio 

1.72 1.66 0.282 1.29 1.45 
0.65 

7 
1.46 1.56 0.514 1.55 1.54 

0.16 
5 

sL.On 
Mean 

Circularity 
0.715 0.717 0.0742 0.629 

0.73 
7 

0.29 
9 

0.653 0.692 0.22 0.705 0.714 
0.08 
68 

sL.On 
Mean 

Roundness 
0.654 0.65 0.0751 0.579 

0.66 
2 

0.28 
3 

0.617 0.651 0.211 0.688 0.692 
0.05 
51 

sL.On 
Mean 

Solidity 
0.934 0.942 0.0261 0.794 

0.95 
1 

0.37 
2 

0.854 0.93 0.271 0.92 0.946 
0.07 
11 

sL.On 
Mean Wall 
Thickness 
(W.Th.sL) 

(um) 

25.4 25.2 9.04 23.6 26.9 12.6 27.9 32.8 12.8 31.5 30.3 7.79 

sL.On/CA 
(sL.On. 

OPD.CA) 
(#/mm^2) 

1.77 2.07 0.924 0.909 
0.85 

2 
0.69 

4 
1.43 1.45 1.09 1.64 1.35 

0.99 
8 

sL.On/RA 
(sL.On. 

OPD.RA) 
(#/mm^2) 

5.74 6.16 3.3 3.62 4.61 2.26 4.25 4.29 3.38 3.77 3.42 1.99 

T.On / 
Rs.N 

39.5 26.2 34.2 21 21 13 26.8 25.5 13.3 33.8 26.1 24 

T.On Mean 
Area 

(um^2) 
7680 7420 3440 5210 

544 
0 

2000 9200 8180 5530 8280 8980 2260 

T.On Mean 
Aspect 
Ratio 

1.67 1.64 0.114 1.7 1.71 0.21 1.77 1.76 0.176 1.76 1.75 
0.16 

4 

T.On Mean 
Circularity 

0.738 0.73 0.0444 0.761 
0.75 

6 
0.04 
51 

0.713 0.712 0.0418 0.718 0.727 
0.04 
64 

T.On Mean 
Roundness 

0.667 0.669 0.027 0.667 
0.66 

2 
0.05 
16 

0.639 0.645 0.0357 0.651 0.656 0.04 
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A A A L L L M M M P P P 

Mean Med SD Mean Med SD Mean Med SD Mean Med SD 

T.On Mean 
Solidity 

0.933 0.934 0.0156 0.944 
0.94 

3 
0.01 
78 

0.922 0.917 0.0197 0.925 0.932 
0.02 
32 

T.On/CA 
(T.On. 

OPD.CA) 
(#/mm^2) 

8.85 8.34 3.88 5.02 4.32 2.7 8.41 7.99 3.23 10 10.3 3.25 

T.On/RA 
(T.On. 

OPD.RA) 
(#/mm^2) 

27.2 27.1 10.1 21.2 21 8.96 25 23.1 8.48 23.3 24.6 5.23 

tL.On 
Mean Area 

(um^2) 
14300 5000 19400 8010 0 

1050 
0 

20700 19100 20600 19000 23600 
1350 

0 

tL.On 
Mean 

Aspect 
Ratio 

0.817 0.668 0.87 0.635 0 
0.80 

2 
1.02 1.43 0.926 1.42 1.66 

0.91 
5 

tL.On 
Mean 

Circularity 
0.296 0.24 0.318 0.296 0 

0.37 
2 

0.363 0.558 0.326 0.448 0.56 
0.28 

6 

tL.On 
Mean Inner 
Label (um) 

10.5 5.31 11.9 6.2 0 8.03 12.8 13.6 12.5 18.6 16.4 16.1 

tL.On 
Mean 
Outer 

Label (um) 

17.7 11 19.3 14.8 0 19.5 24 26.1 23.2 26.5 29.8 18.5 

tL.On 
Mean 

Roundness 
0.317 0.254 0.338 0.281 0 

0.35 
7 

0.362 0.562 0.323 0.442 0.536 
0.27 

7 

tL.On 
Mean 

Solidity 
0.436 0.394 0.458 0.388 0 

0.48 
1 

0.521 0.843 0.461 0.668 0.86 
0.40 

6 

tL.On 
Mean Wall 
Thickness 
(W.Th.tL) 

(um) 

24.2 19 26.4 16.7 0 23.4 32.2 46.3 29.3 30.3 37.4 22.2 

tL.ON/CA 
(tL.On. 

OPD.CA) 
(#/mm^2) 

0.204 0.07 0.271 0.0837 0 
0.10 

6 
0.267 0.195 0.318 0.303 0.204 

0.29 
7 

tL.ON/RA 
(tL.On. 

OPD.RA) 
(#/mm^2) 

9.57E 
-09 

3.13E 
-09 

1.37E-
08 

6.29E-
09 

0 
9.11 
E-09 

1.39E-
08 

7.33E-
09 

1.96E-
08 

1.18E-
08 

8.99E 
-09 

1.17 
E-08 

Total 
Osteon 
Count 
(T.On) 

61.8 62.5 25.7 26.2 22.5 15.4 45.2 45.5 18.4 69.2 68.5 25.3 

Total Pore 
Area 

(um^2) 

12900 
0 

1150 
00 

64500 48400 
381 
00 

3190 
0 

10000 
0 

94900 39500 
15400 

0 
13600 

0 
6340 

0 

Total Pore 
Number 193 216 66.7 91.6 87 39.4 148 142 49.5 224 210 57.5 

Triple-
Labeled 
Osteon 

1.33 0.5 1.72 0.417 0 
0.51 

5 
1.5 1 1.83 2 1.5 1.86 
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A A A L L L M M M P P P 

Mean Med SD Mean Med SD Mean Med SD Mean Med SD 

Count 
(tL.On) 
Rs.N 2.17 2 2.08 1.08 0.5 1.98 1.75 2 1.48 3.17 2.5 2.12 
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Regional Morphometry by Drug Treatment Group 

Control Group by Region 

A A A L L L M M M P P P 

Mean Med SD Mean Med SD Mean Med SD Mean Med SD 

a.Rm.Cr/ 
CA 
(a.Rm.Cr. 
OPD.CA) 
(#/mm^2) 8.84 8.33 1.35 5.3 5.2 1.08 6.79 6.65 1.31 9.13 9.36 1.49 
a.Rm.Cr/ 
RA 
(a.Rm.Cr. 
OPD.RA) 
(#/mm^2) 26.5 24.7 7.31 26.7 24.7 8.27 21.8 22 4.35 21.3 22.3 4.82 
Ac.F.C 
(#/mm^2/y 
ear) 97 82 49.5 63.4 38.4 52.2 67.2 64.4 19.4 100 103 49 
Ac.F.I 
(#/mm^2/y 
ear) 83.4 76.3 31 50.4 38.4 33.2 60.9 54.3 21.2 93.7 110 44.5 
Ac.F.I.dL 
(#/mm^2/y 
ear) 86.7 78.6 17.8 56.7 38.4 41.1 65.6 60.2 18.4 89.5 95 37.4 

a.Rm.Cr 61 61 1.15 25.2 24 4.27 35.2 35 7.37 60.8 61 9.95 
C.On 
Mean Area 
(um^2) 16100 15500 4460 

1020 
0 9930 786 19200 18900 8530 16400 

1690 
0 1210 

C.On 
Mean 
Aspect 
Ratio 1.66 1.66 0.187 1.52 1.49 0.108 1.66 1.66 0.141 1.68 1.7 0.107 
C.On 
Mean 
Circularity 0.667 0.663 0.0468 0.736 

0.72 
8 0.0475 0.662 0.668 0.0456 0.67 0.673 

0.044 
4 

C.On 
Mean 
Roundness 0.661 0.647 0.0413 0.685 

0.68 
3 0.0277 0.648 0.646 0.0485 0.653 0.658 

0.049 
5 

C.On 
Mean 
Solidity 0.915 0.914 0.0239 0.946 

0.94 
3 0.0239 0.919 0.924 0.0213 0.913 0.917 

0.034 
1 

C.On 
Mean Wall 
Thickness 
(W.Th.C) 
(um) 35.7 38.1 7.94 28.9 32.8 11.7 39.1 42.9 16.8 35.4 36.9 7.81 
C.On/CA 
(C.On. 
OPD.CA) 
(#/mm^2) 4.69 4.6 0.628 2.1 2.12 0.45 3.35 3.5 0.913 4.2 4.38 1.15 
C.On/RA 
(C.On. 
OPD.RA) 
(#/mm^2) 14 14 3.65 10.8 9.21 4.29 10.7 10.7 2.97 9.82 9.88 3.19 
Combined 
Mean 23.2 21.4 4.62 21.9 21.2 4.51 25.3 25.6 6.26 28.5 26.8 11.6 
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A A A L L L M M M P P P 

Mean Med SD Mean Med SD Mean Med SD Mean Med SD 

Inner 
Label (um) 
Combined 
Mean 
Label (um) 26.3 25.1 6.81 25.9 26.3 4.52 28.4 31.2 7.47 29.9 29.8 7.32 
Complete 
Osteon 
Count 
(C.On) 32.5 31 3.7 10 10 1.63 17.5 19 5.26 27.8 28.5 6.6 
Cortical 
Area 
(mm^2) 7 7.33 0.875 4.85 4.96 0.805 5.18 5.28 0.33 6.7 6.78 0.848 
dL.On 
Mean Area 
(um^2) 17100 17500 3410 

1190 
0 

1200 
0 2300 18200 19000 5930 17500 

1720 
0 1880 

dL.On 
Mean 
Aspect 
Ratio 1.62 1.65 0.138 1.56 1.49 0.174 1.64 1.65 0.183 1.68 1.66 0.131 
dL.On 
Mean 
Circularity 0.667 0.664 0.0525 0.705 

0.69 
1 0.0671 0.673 0.668 0.05 0.664 0.659 

0.032 
8 

dL.On 
Mean 
Inner 
Label (um) 25.1 25.1 5.69 24.1 24.1 4.29 27.8 30.5 6.94 27.2 27.2 5.58 
dL.On 
Mean 
Roundness 0.665 0.655 0.041 0.678 0.69 0.0368 0.655 0.652 0.0505 0.636 0.639 

0.053 
9 

dL.On 
Mean 
Solidity 0.913 0.91 0.0244 0.932 

0.92 
7 0.0341 0.924 0.927 0.0217 0.917 0.916 

0.022 
8 

dL.On 
Mean Wall 
Thickness 
(W.Th.dL) 
(um) 39.1 41.2 7.37 29.4 36.1 16.3 40 42.9 15.1 38.9 40.3 5.75 
dL.On/CA 
(dL.On. 
OPD.CA) 
(#/mm^2) 2.76 2.71 0.349 1.03 

0.91 
4 0.401 2.52 2.76 1.13 2.5 2.57 0.652 

dL.On/RA 
(dL.On. 
OPD.RA) 
(#/mm^2) 8.24 8.75 1.86 5.42 4.19 3.28 7.91 7.77 3.43 5.86 6.05 1.88 
Double-
Labeled 
Osteon 
Count 
(dL.On) 19.2 19 2.99 4.75 4.5 0.957 13.2 15 6.18 16.5 16.5 3.7 
F.On 
Mean Area 
(um^2) 4780 5460 1920 2640 1630 2770 5270 3600 5080 4100 3570 1650 
F.On 
Mean 
Aspect 
Ratio 1.64 1.64 0.127 1.83 1.74 0.257 2.07 1.95 0.358 1.82 1.81 0.196 
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A A A L L L M M M P P P 

Mean Med SD Mean Med SD Mean Med SD Mean Med SD 

F.On 
Mean 
Circularity 0.77 0.768 

0.0052 
1 0.784 

0.78 
8 0.0618 0.714 0.708 0.0414 0.756 0.762 

0.047 
6 

F.On 
Mean 
Roundness 0.681 0.678 0.0313 0.641 

0.63 
9 0.0346 0.596 0.609 0.0541 0.639 0.635 

0.030 
5 

F.On 
Mean 
Solidity 0.94 0.938 

0.0066 
3 0.946 

0.94 
9 0.0245 0.925 0.925 0.0201 0.938 0.938 

0.015 
3 

F.On/CA 
(F.On. 
OPD.CA) 
(#/mm^2) 3.89 3.76 1.16 3.03 2.8 0.841 3.2 3.26 0.774 4.67 4.55 0.406 
F.On/RA 
(F.On. 
OPD.RA) 
(#/mm^2) 11.7 10.2 4.77 15.1 15.8 4.32 10.2 10.1 2.23 10.9 11.6 1.99 
Forming 
Osteon 
Count 
(F.On) 26.5 27.5 4.65 14.5 13.5 3.87 16.5 16.5 3.7 31.2 31.5 4.57 
Mean Pore 
Area 
(um^2) 864 870 146 618 660 195 839 784 288 792 841 157 
Mean Pore 
Aspect 
Ratio 2.32 2.21 0.281 2.59 2.58 0.377 2.41 2.42 0.122 2.45 2.41 0.15 
Mean Pore 
Circularity 0.651 0.651 0.0356 0.63 

0.62 
6 0.0501 0.629 0.629 0.0273 0.626 0.622 

0.036 
2 

Mean Pore 
Max Feret 
Diameter 
(um) 42 41.8 1.81 40.1 39.8 3.97 44.6 44.3 5.38 42.9 44.6 5.23 
Mean Pore 
Min Feret 
Diameter 
(um) 20.9 21.3 2.26 18.8 20 2.62 20.8 20.6 2.07 20.3 21.5 2.75 
Mean Pore 
Perimeter 
(um) 108 108 6.89 101 102 10.4 113 113 13.1 109 113 12.7 
Mean Pore 
Roundness 0.558 0.566 0.0293 0.533 

0.53 
5 0.0524 0.538 0.541 0.0179 0.528 0.535 

0.017 
2 

Mean Pore 
Solidity 0.858 0.857 0.0184 0.852 0.85 0.0231 0.851 0.852 0.0155 0.845 0.838 

0.023 
2 

On.MAR. 
C 
(Combined 
Labels) 
(um/day) 1.88 1.79 0.486 1.85 1.88 0.323 2.03 2.23 0.534 2.14 2.13 0.523 
On.MAR.I 
(Inner 
Labels) 
(um/day) 1.66 1.53 0.33 1.56 1.52 0.322 1.81 1.83 0.447 2.03 1.92 0.827 
On.MAR.I 
.dL (dL 
Inner 
Labels) 
(um/day) 1.8 1.79 0.407 1.72 1.72 0.307 1.99 2.18 0.495 1.95 1.94 0.398 
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A A A L L L M M M P P P 

Mean Med SD Mean Med SD Mean Med SD Mean Med SD 

σf C 
(days) 20.1 20.5 7.06 15.8 17.5 6.36 18.7 18 5.4 17.6 15.8 7.1 

σf I (days) 21.9 21.8 5.56 18 20.2 5.67 21.5 21.3 8.37 19.9 17.4 10.1 
σf dL 
(days) 20 19.3 2.77 16.5 18.4 5.78 19.2 19.3 5.66 18.7 17.1 5.8 
Percent 
Porosity 
(%) 2.24 2.26 0.778 0.891 

0.79 
9 0.369 2.14 2.05 1.09 2.54 2.22 0.931 

Pore 
Density 
CA 
(1/mm^2) 25.8 24.6 7.84 14.5 14.7 3.03 26.4 19.4 15.6 32.4 31.2 10.2 
Pore 
Density 
RA 
(1/mm^2) 74.2 74.8 14.7 70.4 68.4 4.49 77.4 73.9 14.7 74 72.6 19.3 
RA/CA 
(%) 0.343 0.329 0.0539 0.205 

0.21 
7 0.0354 0.326 0.27 0.123 0.437 0.41 0.081 

Remodelin 
g Area 
(mm^2) 2.43 2.43 0.604 1.01 1.07 0.304 1.69 1.43 0.634 2.97 2.69 0.892 
Rs.N/CA 
(Rs.N. 
OPD.CA) 
(#/mm^2) 0.269 0.271 0.217 0.163 

0.19 
4 0.114 0.244 0.211 0.287 0.261 0.254 0.132 

Rs.N/RA 
(Rs.N. 
OPD.RA) 
(#/mm^2) 0.729 0.824 0.529 0.849 

0.84 
5 0.7 0.902 0.793 1.06 0.587 0.553 0.258 

Single-
Labeled 
Osteon 
Count 
(sL.On) 11 10 5.1 4.75 4 2.36 2.5 2 1.73 9 9 4.4 
sL.On 
Mean Area 
(um^2) 8330 7410 2860 7390 7090 2290 11300 11200 2670 10300 

1130 
0 2600 

sL.On 
Mean 
Aspect 
Ratio 1.74 1.71 0.246 1.5 1.52 0.0754 1.54 1.57 0.258 1.5 1.53 0.181 
sL.On 
Mean 
Circularity 0.692 0.696 0.0505 0.753 

0.75 
2 0.0326 0.669 0.638 0.106 0.708 0.715 

0.083 
7 

sL.On 
Mean 
Roundness 0.646 0.631 0.0409 0.686 

0.67 
8 0.0399 0.674 0.651 0.122 0.702 0.681 

0.071 
4 

sL.On 
Mean 
Solidity 0.933 0.943 0.0243 0.957 

0.95 
4 0.0152 0.913 0.918 0.0486 0.924 0.94 

0.058 
9 

sL.On 
Mean Wall 
Thickness 
(W.Th.sL) 
(um) 25.2 27.9 8.08 28.7 31.7 10.7 27.1 25.7 14.9 29.6 28.5 9.28 
sL.On/CA 
(sL.On. 1.58 1.56 0.69 0.959 

0.92 
5 0.359 0.5 0.379 0.383 1.33 1.35 0.594 
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A A A L L L M M M P P P 

Mean Med SD Mean Med SD Mean Med SD Mean Med SD 

OPD.CA) 
(#/mm^2) 
sL.On/RA 
(sL.On. 
OPD.RA) 
(#/mm^2) 4.78 4.69 2.43 4.67 4.88 1.38 1.7 1.06 1.54 3.04 2.86 1.37 
T.On / 
Rs.N 33.6 29 20.1 24.5 23.5 4.04 24.6 21.5 14.8 41.8 37.8 22.7 
T.On 
Mean Area 
(um^2) 11000 10800 2540 5680 5100 2350 12600 11600 7640 9840 9690 1090 
T.On 
Mean 
Aspect 
Ratio 1.65 1.62 0.138 1.69 1.67 0.112 1.87 1.77 0.207 1.75 1.76 

0.086 
9 

T.On 
Mean 
Circularity 0.713 0.706 0.0231 0.766 

0.75 
5 0.049 0.687 0.681 0.0444 0.717 0.731 

0.041 
5 

T.On 
Mean 
Roundness 0.67 0.671 0.0198 0.663 

0.65 
7 0.0134 0.62 0.633 0.0363 0.646 0.646 

0.035 
6 

T.On 
Mean 
Solidity 0.927 0.928 0.0103 0.947 

0.94 
2 0.0205 0.922 0.917 0.0165 0.927 0.935 

0.020 
7 

T.On/CA 
(T.On. 
OPD.CA) 
(#/mm^2) 8.58 7.92 1.53 5.13 4.98 0.998 6.55 6.17 1.36 8.87 8.98 1.48 
T.On/RA 
(T.On. 
OPD.RA) 
(#/mm^2) 25.7 23.9 7.83 25.8 24.2 7.67 20.9 21.2 3.56 20.8 21.9 4.83 
tL.On 
Mean Area 
(um^2) 25600 19600 27900 8760 7920 10200 20500 18500 23900 21100 

2680 
0 

1420 
0 

tL.On 
Mean 
Aspect 
Ratio 1.07 1.4 0.72 0.764 

0.68 
8 0.891 0.938 0.888 1.09 1.6 1.9 1.14 

tL.On 
Mean 
Circularity 0.465 0.553 0.33 0.403 

0.37 
8 0.467 0.288 0.278 0.333 0.413 0.518 0.285 

tL.On 
Mean 
Inner 
Label (um) 16.1 17.6 13.4 7.67 6.97 8.93 10.3 9.49 12 22.1 17.2 23.1 
tL.On 
Mean 
Outer 
Label (um) 27.3 32.6 20.9 21.8 19.7 25.4 22 17.8 26.4 25.2 29.8 17.7 
tL.On 
Mean 
Roundness 0.535 0.691 0.359 0.33 

0.29 
8 0.385 0.303 0.288 0.351 0.438 0.539 0.303 

tL.On 
Mean 
Solidity 0.662 0.841 0.447 0.482 

0.47 
4 0.557 0.443 0.433 0.511 0.637 0.83 0.426 

tL.On 
Mean Wall 37.1 41.2 27.5 14.6 6.52 21.3 27.2 22.1 32.5 21.8 23.2 18.9 
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A A A L L L M M M P P P 

Mean Med SD Mean Med SD Mean Med SD Mean Med SD 

Thickness 
(W.Th.tL) 
(um) 
tL.ON/CA 
(tL.On. 
OPD.CA) 
(#/mm^2) 0.343 0.336 0.327 0.114 

0.09 
61 0.135 0.327 0.194 0.436 0.368 0.289 0.398 

tL.ON/RA 
(tL.On. 
OPD.RA) 
(#/mm^2) 

1.69E-
08 

1.41E-
08 

1.74E-
08 

1.1E-
08 

7.85 
E-09 

1.37E-
08 

1.83E-
08 

6.35E-
09 

2.87E-
08 

1.53E-
08 

1.2E-
08 

1.7E-
08 

Total 
Osteon 
Count 
(T.On) 59 58 2 24.5 23.5 4.04 34 33.5 7.53 59 58.5 9.83 
Total Pore 
Area 
(um^2) 

15700 
0 

14700 
0 62700 

4460 
0 

3610 
0 24800 

11200 
0 

11100 
0 57700 

17300 
0 

1360 
00 

8280 
0 

Total Pore 
Number 182 178 67.7 71.8 73 24.9 137 106 80.2 221 198 92.3 
Triple-
Labeled 
Osteon 
Count 
(tL.On) 2.25 2.5 2.06 0.5 0.5 0.577 1.75 1 2.36 2.25 2 2.22 

Rs.N 2 2 1.63 0.75 1 0.5 1.25 1 1.5 1.75 1.5 0.957 
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Fentanyl Group by Region 

A A A L L L M M M P P P 

Mean Med SD Mean Med SD Mean Med SD Mean Med SD 

a.Rm.Cr/ 
CA 

(a.Rm.Cr. 
OPD.CA) 
(#/mm^2) 8.68 9.79 4.67 2.62 2.6 1.2 8.06 9.08 3.36 8.81 8.75 2.5 
a.Rm.Cr/ 

RA 
(a.Rm.Cr. 
OPD.RA) 
(#/mm^2) 29 32.2 10.4 14.6 12.3 8.1 25.7 28.4 7.41 22.6 22.7 3.92 

Ac.F.C 
(#/mm^2/y 

ear) 65.3 76.1 29.1 13.9 7.21 15.8 62.4 64.3 41.1 65.4 67.8 36.3 
Ac.F.I 

(#/mm^2/y 
ear) 61.4 69.8 26.3 14.1 7.21 16.3 59.7 64.3 37 59.6 56.2 33.3 

Ac.F.I.dL 
(#/mm^2/y 

ear) 61.8 70.5 26.5 15.3 7.21 18.7 60.3 64.3 37.9 63.6 64.2 31.6 

a.Rm.Cr 61 72.5 29.1 14 13 8.12 43.8 52.5 19.2 61.5 59 17.1 
C.On Mean 

Area 
(um^2) 11400 

1150 
0 2980 8830 

986 
0 2760 12300 

137 
00 4810 12300 

1380 
0 3990 

C.On Mean 
Aspect 

Ratio 1.64 1.63 0.137 1.52 1.41 0.329 1.79 1.8 0.263 1.55 1.57 0.194 
C.On Mean 
Circularity 0.729 0.721 0.0657 0.776 

0.80 
5 0.0862 0.694 

0.70 
5 0.0706 0.723 0.728 0.0587 

C.On Mean 
Roundness 0.672 0.668 0.0436 0.702 

0.72 
2 0.105 0.62 

0.62 
2 0.0796 0.7 0.688 0.0612 

C.On Mean 
Solidity 0.94 0.942 0.0277 0.958 

0.97 
4 0.0389 0.922 

0.93 
1 0.0315 0.936 0.946 0.0279 

C.On Mean 
Wall 

Thickness 
(W.Th.C) 

(um) 36.3 36.9 6.8 37.3 37.2 7.84 32.2 32 8.84 38.4 41.1 8.41 
C.On/CA 

(C.On. 
OPD.CA) 
(#/mm^2) 3.77 4.1 2.08 0.987 

0.68 
4 0.966 3.4 4.11 2.02 4.14 4.11 1.79 

C.On/RA 
(C.On. 

OPD.RA) 
(#/mm^2) 12.7 13.7 5.03 4.72 4.95 3.2 10.5 12.2 5.93 10.5 10.4 3.38 
Combined 

Mean Inner 
Label (um) 25.7 22.2 10.5 19.8 18.3 7.29 22.9 21.8 6.81 19.7 19 1.61 
Combined 

Mean 
Label (um) 26.7 22.7 9.57 19.7 18.1 7.32 23.8 21.8 8.43 21.5 21.5 2.98 

Complete 
Osteon 
Count 

(C.On) 26.5 30.5 12.9 5.5 3.5 5.92 19 21.5 12.2 28.8 29.5 11.6 
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A A A L L L M M M P P P 

Mean Med SD Mean Med SD Mean Med SD Mean Med SD 

Cortical 
Area 

(mm^2) 7.38 7.43 0.923 5.15 5.37 0.894 5.33 5.25 0.747 7.02 7.1 0.687 
dL.On 

Mean Area 
(um^2) 12700 

1270 
0 1140 10400 

986 
0 2810 16200 

164 
00 5110 13800 

1470 
0 4120 

dL.On 
Mean 

Aspect 
Ratio 1.54 1.53 0.0698 1.51 1.41 0.297 1.73 1.69 0.199 1.49 1.44 0.262 

dL.On 
Mean 

Circularity 0.724 0.716 0.0547 0.781 
0.80 

5 0.0664 0.678 
0.68 

1 0.0651 0.724 0.723 0.0557 
dL.On 

Mean Inner 
Label (um) 25.8 22.2 10.4 20.4 19.5 7.23 23.1 21.8 7.18 21.7 19.4 5.16 

dL.On 
Mean 

Roundness 0.689 0.684 0.0203 0.685 
0.72 

2 0.121 0.615 0.63 0.0611 0.721 0.718 0.0915 
dL.On 
Mean 

Solidity 0.943 0.939 0.0231 0.968 
0.97 

2 0.0179 0.923 
0.92 

7 0.0365 0.939 0.946 0.0233 
dL.On 

Mean Wall 
Thickness 

(W.Th.dL) 
(um) 40.8 40.4 1.57 41.7 41.5 2.9 40.7 43.9 10.5 42.5 41.5 7.38 

dL.On/CA 
(dL.On. 

OPD.CA) 
(#/mm^2) 1.84 1.42 1.64 0.433 

0.42 
5 0.206 1.21 1.12 0.944 2.54 1.99 1.75 

dL.On/RA 
(dL.On. 

OPD.RA) 
(#/mm^2) 5.92 4.66 4.23 2.29 2.4 0.82 3.85 3.58 2.78 6.32 5.03 3.7 

Double-
Labeled 
Osteon 
Count 

(dL.On) 12.5 10.5 9.68 2.25 2 1.26 6.75 5.5 5.85 17.2 15 10.3 
F.On Mean 

Area 
(um^2) 2010 1720 941 1150 

121 
0 423 3150 

338 
0 1130 3170 3240 801 

F.On Mean 
Aspect 

Ratio 1.7 1.67 0.196 1.59 1.53 0.329 1.76 1.73 0.121 2.04 2.02 0.495 
F.On Mean 
Circularity 0.781 0.772 0.0363 0.786 

0.77 
8 0.0398 0.762 

0.76 
2 0.0267 0.711 0.703 0.0904 

F.On Mean 
Roundness 0.671 0.669 0.0338 0.712 

0.69 
4 0.0726 0.642 0.65 0.0237 0.607 0.603 0.0916 

F.On Mean 
Solidity 0.94 0.936 0.0114 0.941 0.94 0.021 0.924 

0.92 
7 0.0241 0.907 0.905 0.0483 

F.On/CA 
(F.On. 

OPD.CA) 
(#/mm^2) 4.46 4.94 2.53 1.6 1.65 0.449 4.39 4.42 1.86 4.05 4.2 0.867 
F.On/RA 

(F.On. 14.8 16.1 5.52 9.76 7.97 6.22 14.4 15.1 4.44 10.5 11.1 1.5 
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A A A L L L M M M P P P 

Mean Med SD Mean Med SD Mean Med SD Mean Med SD 

OPD.RA) 
(#/mm^2) 

Forming 
Osteon 
Count 
(F.On) 31.2 36.5 15.6 8.25 8 2.99 23.2 23.5 9.74 28.2 27 5.74 

Mean Pore 
Area 

(um^2) 646 651 231 372 371 74.8 604 607 178 665 653 60.2 
Mean Pore 

Aspect 
Ratio 2.44 2.5 0.341 2.8 2.58 0.726 2.42 2.32 0.281 2.5 2.45 0.258 

Mean Pore 
Circularity 0.619 0.629 0.0438 0.586 

0.58 
7 0.0874 0.632 0.65 0.054 0.615 0.605 0.0334 

Mean Pore 
Max Feret 
Diameter 

(um) 39.9 39.9 4.93 36.9 39.6 5.63 40.5 41.2 3.17 41.3 41.6 1.76 
Mean Pore 
Min Feret 
Diameter 

(um) 19.2 19.5 1.68 16.2 16.8 1.92 19 18.8 2.32 19.5 19.8 1.03 
Mean Pore 
Perimeter 

(um) 102 102 12 93.3 98.2 12.5 104 104 6.48 105 106 4 
Mean Pore 
Roundness 0.545 0.551 0.0529 0.507 

0.51 
7 0.0914 0.544 

0.55 
9 0.0471 0.523 0.52 0.0301 

Mean Pore 
Solidity 0.841 0.848 0.0213 0.825 

0.82 
5 0.0294 0.845 

0.85 
6 0.0259 0.838 0.837 0.0137 

On.MAR.C 
(Combined 

Labels) 
(um/day) 1.91 1.62 0.684 1.41 1.29 0.523 1.7 1.56 0.602 1.54 1.54 0.213 

On.MAR.I 
(Inner 

Labels) 
(um/day) 1.84 1.59 0.747 1.42 1.31 0.521 1.64 1.56 0.486 1.41 1.36 0.115 

On.MAR.I. 
dL (dL 

Inner 
Labels) 

(um/day) 1.84 1.59 0.74 1.46 1.39 0.516 1.65 1.56 0.513 1.55 1.39 0.369 
σf C 

(days) 19.9 19.7 4.23 28.1 28.9 7.58 19.7 18.4 5.12 25.1 23.9 5.69 

σf I (days) 21.3 19.7 6.75 28 28.6 7.7 20.1 19.2 4.79 27.3 28.2 5.76 
σf dL 
(days) 21.2 19.7 6.46 27.4 27.3 8.37 20 19 4.86 25.3 24.3 6.66 

Percent 
Porosity 

(%) 1.57 1.52 1.04 0.566 
0.51 

7 0.253 1.49 1.59 0.378 1.94 1.88 0.226 
Pore 

Density 
CA 

(1/mm^2) 23.2 23.8 12.4 14.8 14 4.28 25.2 23.1 5.46 29.2 28.2 3.87 
Pore 

Density 
RA 

(1/mm^2) 79.5 78.8 21.1 80 81.8 14.5 85.7 81.8 22.5 76.6 76.1 11.8 
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A A A L L L M M M P P P 

Mean Med SD Mean Med SD Mean Med SD Mean Med SD 

RA/CA 
(%) 0.278 0.306 0.0915 0.197 

0.17 
2 0.0957 0.301 

0.31 
9 0.0572 0.385 0.389 0.048 

Remodelin 
g Area 

(mm^2) 1.99 2.1 0.504 1.03 
0.76 

1 0.624 1.62 1.77 0.433 2.7 2.72 0.37 
Rs.N/CA 

(Rs.N. 
OPD.CA) 
(#/mm^2) 0.444 0.34 0.399 0.0425 0 0.085 0.264 

0.29 
1 0.216 0.618 0.686 0.336 

Rs.N/RA 
(Rs.N. 

OPD.RA) 
(#/mm^2) 1.5 1.37 1.09 0.127 0 0.254 0.807 

0.85 
2 0.668 1.65 1.98 0.869 

Single-
Labeled 
Osteon 
Count 

(sL.On) 13 12 8.49 3 1.5 4.24 11.8 14 8.22 10 8.5 7.96 
sL.On 

Mean Area 
(um^2) 9280 7470 4550 3010 

145 
0 4310 5260 

522 
0 4320 9770 

1080 
0 3280 

sL.On 
Mean 

Aspect 
Ratio 1.82 1.79 0.391 0.82 0.62 1 1.26 1.49 0.884 1.61 1.57 0.207 

sL.On 
Mean 

Circularity 0.709 0.713 0.109 0.375 
0.32 

5 0.441 0.562 
0.70 

3 0.381 0.688 0.74 0.141 
sL.On 
Mean 

Roundness 0.632 0.638 0.117 0.35 
0.29 

3 0.415 0.499 
0.62 

6 0.34 0.682 0.692 0.0469 
sL.On 
Mean 

Solidity 0.93 0.931 0.0407 0.466 
0.44 

3 0.54 0.71 
0.93 

2 0.474 0.892 0.94 0.115 
sL.On 

Mean Wall 
Thickness 
(W.Th.sL) 

(um) 29.6 26.4 12 12.8 12.8 14.8 21.8 26.1 15.5 31.5 33.6 10.1 
sL.On/CA 

(sL.On. 
OPD.CA) 
(#/mm^2) 1.77 1.75 1.1 0.512 

0.25 
9 0.721 2.11 2.49 1.49 1.37 1.18 1.04 

sL.On/RA 
(sL.On. 

OPD.RA) 
(#/mm^2) 6.3 5.36 3.66 2.3 2.29 2.66 6.43 7.53 4.53 3.58 3.42 2.46 

T.On / 
Rs.N 30.8 16.6 33 13.8 13 7.72 27.8 21 18.2 23.7 10.6 28.3 

T.On Mean 
Area 

(um^2) 6360 6550 1270 3800 
313 

0 2080 6700 
565 

0 3940 7630 8320 2390 
T.On Mean 

Aspect 
Ratio 1.68 1.69 0.107 1.62 1.68 0.282 1.76 1.75 0.166 1.78 1.86 0.264 

T.On Mean 
Circularity 0.758 0.762 0.0371 0.772 

0.77 
6 0.061 0.741 

0.73 
4 0.0295 0.718 0.715 0.072 
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A A A L L L M M M P P P 

Mean Med SD Mean Med SD Mean Med SD Mean Med SD 

T.On Mean 
Roundness 0.672 0.673 0.0237 0.694 

0.67 
1 0.0787 0.64 

0.64 
2 0.0349 0.655 0.636 0.0614 

T.On Mean 
Solidity 0.94 0.941 0.0153 0.943 

0.94 
6 0.0262 0.925 

0.92 
8 0.025 0.922 0.925 0.034 

T.On/CA 
(T.On. 

OPD.CA) 
(#/mm^2) 8.24 9.04 4.54 2.58 2.6 1.13 7.79 8.75 3.22 8.19 8.14 2.59 
T.On/RA 

(T.On. 
OPD.RA) 
(#/mm^2) 27.5 29.8 10.3 14.5 12.1 8.15 24.9 27.1 7.01 20.9 21.4 4.28 

tL.On 
Mean Area 

(um^2) 6810 0 13600 2890 0 5780 12100 0 24200 8830 7060 10600 
tL.On 
Mean 

Aspect 
Ratio 0.47 0 0.941 0.451 0 0.902 0.551 0 1.1 0.837 0.78 0.971 
tL.On 
Mean 

Circularity 0.17 0 0.34 0.132 0 0.264 0.14 0 0.28 0.337 0.314 0.391 
tL.On 

Mean Inner 
Label (um) 4.28 0 8.56 4.01 0 8.02 7.8 0 15.6 8.22 7.38 9.59 

tL.On 
Mean 
Outer 

Label (um) 7.29 0 14.6 4.27 0 8.54 10.7 0 21.3 15.6 14.3 18.2 
tL.On 
Mean 

Roundness 0.137 0 0.274 0.139 0 0.278 0.137 0 0.274 0.309 0.281 0.36 
tL.On 
Mean 

Solidity 0.234 0 0.469 0.216 0 0.432 0.205 0 0.41 0.469 0.456 0.542 
tL.On 

Mean Wall 
Thickness 
(W.Th.tL) 

(um) 14.4 0 28.8 8.04 0 16.1 12.1 0 24.2 23 21 26.7 
tL.ON/CA 

(tL.On. 
OPD.CA) 
(#/mm^2) 0.161 0 0.321 0.0425 0 0.085 0.0795 0 0.159 0.226 0.13 0.305 

tL.ON/RA 
(tL.On. 

OPD.RA) 
(#/mm^2) 

7.72E-
09 0 

1.54E-
08 

2.12E-
09 0 

4.24E-
09 

4.22E-
09 0 

8.45E-
09 

9.25E-
09 

6E-
09 

1.19E-
08 

Total 
Osteon 
Count 

(T.On) 57.8 67 27.9 13.8 13 7.72 42.2 50 18.3 57 55.5 16.8 
Total Pore 

Area 
(um^2) 

11100 
0 

1030 
00 70900 29400 

227 
00 16100 80700 

846 
00 27500 

13500 
0 

1340 
00 12300 

Total Pore 
Number 163 170 72.8 77 66 30.8 133 126 24.2 203 202 6.85 
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A A A L L L M M M P P P 

Mean Med SD Mean Med SD Mean Med SD Mean Med SD 

Triple-
Labeled 
Osteon 
Count 

(tL.On) 1 0 2 0.25 0 0.5 0.5 0 1 1.5 1 1.91 

Rs.N 3.25 2.5 2.87 0.25 0 0.5 1.5 1.5 1.29 4.5 5 2.65 
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Morphine Group by Region 

A A A L L L M M M P P P 

Mean Med SD Mean Med SD Mean Med SD Mean Med SD 

a.Rm.Cr/ 
CA 

(a.Rm.Cr. 
OPD.CA) 
(#/mm^2) 9.93 9.53 5.45 7.74 8.12 3.28 11.3 11 3.89 13.5 12.4 3.37 
a.Rm.Cr/ 

RA 
(a.Rm.Cr. 
OPD.RA) 
(#/mm^2) 28.9 31.6 13.9 24.4 24.4 8.6 30.3 29 13.3 29.3 29.5 2.89 

Ac.F.C 
(#/mm^2/ 

year) 98.4 110 59.6 64.5 57.1 31.4 97.4 86.5 27.1 122 142 51.3 
Ac.F.I 

(#/mm^2/ 
year) 87.6 103 48.3 59.4 49.8 36.1 78.5 68.7 27 104 110 48.8 

Ac.F.I.dL 
(#/mm^2/ 

year) 93 107 53.7 64.6 57.2 31.3 85 81.9 28.7 101 105 38.7 

a.Rm.Cr 70 68 38.7 42.8 43.5 19.6 61.8 62 21.6 94.8 81.5 30.5 
C.On 
Mean 
Area 

(um^2) 9040 9320 4420 10300 10100 1800 13400 12200 4870 12800 12200 2770 
C.On 
Mean 

Aspect 
Ratio 1.61 1.62 0.115 1.63 1.64 0.15 1.55 1.56 0.134 1.55 1.55 

0.034 
7 

C.On 
Mean 

Circularit 
y 0.712 0.701 

0.064 
5 0.735 0.732 

0.041 
8 0.699 0.686 

0.044 
8 0.698 0.705 

0.030 
4 

C.On 
Mean 

Roundnes 
s 0.666 0.671 

0.037 
2 0.655 0.651 

0.038 
8 0.687 0.676 

0.042 
8 0.683 0.687 

0.020 
8 

C.On 
Mean 

Solidity 0.93 0.928 
0.021 

3 0.953 0.95 
0.011 

7 0.93 0.924 
0.017 

1 0.933 0.936 
0.011 

9 
C.On 
Mean 
Wall 

Thickness 
(W.Th.C) 

(um) 29.2 30.9 5.1 35.8 35.9 1.83 39.6 39.6 5.54 38.7 39.2 3.41 
C.On/CA 

(C.On. 
OPD.CA) 
(#/mm^2) 4.38 4.78 2.77 3.5 3.66 1.34 5.51 5.63 1.22 5.85 5.96 1.87 
C.On/RA 

(C.On. 
OPD.RA) 
(#/mm^2) 13 14.8 7.72 11.3 11.3 4.42 14.9 14.4 6.1 12.7 14 2.96 
Combined 

Mean 23.9 23.3 2.64 22.3 22.6 5.88 21.8 20 6.98 25.6 25.5 7.15 
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A A A L L L M M M P P P 

Mean Med SD Mean Med SD Mean Med SD Mean Med SD 

Inner 
Label 
(um) 

Combined 
Mean 
Label 
(um) 26 25.3 3.43 25.1 25.2 4.57 27.6 27.4 9.1 29.9 32.4 7.6 

Complete 
Osteon 
Count 

(C.On) 31 34 19.4 19.2 21 7.63 30.2 29 8.88 41 39 15.1 
Cortical 

Area 
(mm^2) 7.01 6.91 0.466 5.45 5.39 0.352 5.44 5.25 0.52 6.96 6.89 0.546 

dL.On 
Mean 
Area 

(um^2) 12200 11900 5360 10800 10600 1110 13100 11400 4510 13500 12200 3760 
dL.On 
Mean 

Aspect 
Ratio 1.61 1.6 0.131 1.6 1.51 0.228 1.54 1.54 0.127 1.54 1.53 

0.048 
9 

dL.On 
Mean 

Circularit 
y 0.693 0.694 0.068 0.736 0.748 

0.043 
3 0.695 0.685 

0.039 
6 0.693 0.707 

0.051 
9 

dL.On 
Mean 
Inner 
Label 
(um) 25.1 23.3 3.79 25.2 25.2 4.57 23.3 22.1 6.19 25.5 24.6 5.53 

dL.On 
Mean 

Roundnes 
s 0.658 0.654 

0.048 
1 0.654 0.685 0.076 0.699 0.709 

0.043 
9 0.689 0.689 

0.009 
84 

dL.On 
Mean 

Solidity 0.925 0.919 
0.025 

2 0.953 0.952 
0.010 

5 0.93 0.927 
0.018 

5 0.929 0.935 
0.023 

5 
dL.On 
Mean 
Wall 

Thickness 
(W.Th.dL 

) (um) 35.5 37.1 4.12 37.6 37.8 1.06 39.7 39.2 5.77 40.5 40.6 3.01 
dL.On/CA 

(dL.On. 
OPD.CA) 
(#/mm^2) 2.31 2.41 1.55 2.15 2.11 0.682 3.44 3.54 1.03 3.34 3.51 0.445 

dL.On/RA 
(dL.On. 

OPD.RA) 
(#/mm^2) 6.57 8.16 3.58 7.06 6.73 2.68 9.17 9.28 3.76 7.42 7.27 1.18 

Double-
Labeled 
Osteon 
Count 

(dL.On) 16.2 17 10.8 11.8 12 3.69 18.8 20 6.02 23.2 23 3.69 
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A A A L L L M M M P P P 

Mean Med SD Mean Med SD Mean Med SD Mean Med SD 

F.On 
Mean 
Area 

(um^2) 2820 1850 2290 2260 1950 1260 2200 1940 995 2860 2190 1470 
F.On 
Mean 

Aspect 
Ratio 1.75 1.71 0.172 1.91 1.9 0.325 1.83 1.79 0.287 1.87 1.87 0.222 
F.On 
Mean 

Circularit 
y 0.77 0.774 

0.054 
6 0.756 0.735 

0.048 
4 0.729 0.734 

0.056 
1 0.74 0.741 0.04 

F.On 
Mean 

Roundnes 
s 0.653 0.65 

0.050 
1 0.639 0.634 

0.059 
8 0.628 0.631 

0.070 
1 0.631 0.636 

0.040 
2 

F.On 
Mean 

Solidity 0.933 0.938 
0.022 

2 0.932 0.93 0.012 0.91 0.908 
0.040 

9 0.925 0.926 
0.027 

4 
F.On/CA 

(F.On. 
OPD.CA) 
(#/mm^2) 5.36 4.53 2.97 3.85 3.87 1.83 5.37 4.92 2.63 7.14 6.44 2.01 
F.On/RA 

(F.On. 
OPD.RA) 
(#/mm^2) 15.5 16.2 7.04 12 10.9 4.83 14.2 12.6 7.64 15.5 15.4 2.09 

Forming 
Osteon 
Count 
(F.On) 37.8 32.5 21.3 21.2 20.5 10.8 29 27.5 13.6 50.5 43.5 18.4 
Mean 

Pore Area 
(um^2) 501 419 259 540 572 150 643 553 257 612 535 316 

Mean 
Pore 

Aspect 
Ratio 2.17 2.12 0.209 2.62 2.61 0.386 2.35 2.2 0.431 2.35 2.32 0.215 
Mean 
Pore 

Circularit 
y 0.682 0.691 

0.065 
1 0.638 0.644 

0.089 
9 0.671 0.687 

0.089 
5 0.656 0.659 

0.053 
9 

Mean 
Pore Max 

Feret 
Diameter 

(um) 34.9 33.5 8.54 40.3 37.6 6.03 41.5 40.7 6.61 38.3 35.8 6.51 
Mean 

Pore Min 
Feret 

Diameter 
(um) 17.4 16.5 3.42 17.8 18.4 2.48 19.8 18.6 3.22 18.2 17.4 3.59 

Mean 
Pore 

Perimeter 
(um) 88.6 85.1 21.4 99.4 93.1 14.7 106 103 16.4 96.2 89.7 17.3 

Mean 
Pore 0.572 0.581 

0.030 
4 0.517 0.526 

0.059 
1 0.562 0.567 

0.053 
9 0.543 0.54 

0.035 
4 
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A A A L L L M M M P P P 

Mean Med SD Mean Med SD Mean Med SD Mean Med SD 

Roundnes 
s 

Mean 
Pore 

Solidity 0.871 0.872 
0.036 

8 0.856 0.857 
0.049 

3 0.862 0.871 
0.048 

1 0.864 0.864 
0.025 

8 
On.MAR. 

C 
(Combine 
d Labels) 
(um/day) 1.86 1.81 0.245 1.8 1.8 0.326 1.97 1.96 0.65 2.14 2.32 0.543 

On.MAR. 
I (Inner 
Labels) 

(um/day) 1.71 1.67 0.189 1.59 1.61 0.42 1.56 1.43 0.499 1.83 1.82 0.511 
On.MAR. 

I.dL (dL 
Inner 

Labels) 
(um/day) 1.79 1.67 0.271 1.8 1.8 0.326 1.66 1.58 0.442 1.82 1.76 0.395 

σf C 
(days) 15.7 16.1 1.72 20.4 20.3 3.75 21.3 19.7 5.67 19.2 17.2 5.93 

σf I 
(days) 17.2 16.8 3.29 23.9 22.1 7.75 26.5 27.3 4.49 22.1 21.3 4.88 
σf dL 
(days) 16.4 16 2.88 20.4 20.2 3.72 24.4 25.2 2.97 21.7 22.5 2.9 

Percent 
Porosity 

(%) 1.73 1.58 1.04 1.28 1.15 0.645 1.97 1.94 0.356 2.23 1.92 1.32 
Pore 

Density 
CA 

(1/mm^2) 33.9 35.7 9.42 22.9 20.7 6.04 32.4 32.6 6.94 35.5 35.2 4.85 
Pore 

Density 
RA 

(1/mm^2) 97.2 99.3 17.8 72.2 71.8 4.32 82.7 81.9 7.84 78.4 77.4 5.16 
RA/CA 

(%) 0.359 0.385 0.117 0.314 0.296 
0.064 

8 0.396 0.37 0.106 0.455 0.437 
0.072 

8 
Remodeli 

ng Area 
(mm^2) 2.49 2.56 0.76 1.73 1.54 0.465 2.12 1.94 0.423 3.19 2.94 0.743 

Rs.N/CA 
(Rs.N. 

OPD.CA) 
(#/mm^2) 0.187 0.152 0.224 0.386 0.182 0.557 0.466 0.36 0.337 0.48 0.361 0.313 
Rs.N/RA 

(Rs.N. 
OPD.RA) 
(#/mm^2) 0.484 0.405 0.574 1.08 0.708 1.38 1.23 0.905 0.933 1.08 0.883 0.706 

Single-
Labeled 
Osteon 
Count 

(sL.On) 14 16.5 8.29 7 7.5 4.97 9.25 9 2.87 15.5 14.5 9.68 
sL.On 
Mean 
Area 

(um^2) 4950 5390 3180 6270 6610 3330 9270 8770 2710 8950 9750 2520 
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A A A L L L M M M P P P 

Mean Med SD Mean Med SD Mean Med SD Mean Med SD 

sL.On 
Mean 

Aspect 
Ratio 1.59 1.62 0.204 1.54 1.48 0.367 1.58 1.63 0.202 1.55 1.5 0.127 

sL.On 
Mean 

Circularit 
y 0.743 0.739 

0.062 
3 0.759 0.764 

0.052 
6 0.728 0.716 

0.052 
1 0.72 0.714 

0.013 
6 

sL.On 
Mean 

Roundnes 
s 0.685 0.67 

0.056 
9 0.699 0.686 0.126 0.677 0.66 

0.072 
3 0.68 0.685 

0.058 
5 

sL.On 
Mean 

Solidity 0.94 0.942 
0.013 

5 0.958 0.955 
0.011 

7 0.938 0.934 
0.012 

4 0.945 0.946 
0.005 

07 
sL.On 
Mean 
Wall 

Thickness 
(W.Th.sL) 

(um) 21.4 23.9 6.83 29.2 28.9 3.88 34.9 35.6 4.9 33.3 33.3 5.1 
sL.On/CA 

(sL.On. 
OPD.CA) 
(#/mm^2) 1.97 2.3 1.16 1.26 1.4 0.863 1.68 1.71 0.372 2.2 2.22 1.25 
sL.On/RA 

(sL.On. 
OPD.RA) 
(#/mm^2) 6.14 6.16 4.34 3.87 4.25 2.42 4.62 4.63 1.98 4.68 5.25 2.17 

T.On / 
Rs.N 54.2 43.2 48.5 24.8 18 20.9 28 30 9.33 36 30.8 24 
T.On 
Mean 
Area 

(um^2) 5630 5140 3510 6160 6240 827 8330 7470 3720 7350 6720 2600 
T.On 
Mean 

Aspect 
Ratio 1.69 1.68 0.126 1.78 1.76 0.228 1.7 1.67 0.154 1.74 1.71 0.142 
T.On 
Mean 

Circularit 
y 0.744 0.736 

0.062 
7 0.744 0.745 

0.027 
2 0.711 0.699 

0.040 
7 0.719 0.716 

0.031 
5 

T.On 
Mean 

Roundnes 
s 0.659 0.654 0.04 0.645 0.65 

0.041 
9 0.656 0.659 0.036 0.652 0.666 0.028 

T.On 
Mean 

Solidity 0.931 0.933 
0.021 

1 0.942 0.943 
0.006 

24 0.92 0.92 
0.022 

5 0.927 0.927 
0.019 

1 
T.On/CA 

(T.On. 
OPD.CA) 
(#/mm^2) 9.74 9.31 5.54 7.36 7.46 3.04 10.9 10.6 3.58 13 11.8 3.44 
T.On/RA 

(T.On. 
OPD.RA) 
(#/mm^2) 28.4 31 14.3 23.3 22.2 8.62 29.1 28.2 12.5 28.3 28.1 3.1 
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A A A L L L M M M P P P 

Mean Med SD Mean Med SD Mean Med SD Mean Med SD 

tL.On 
Mean 
Area 

(um^2) 10500 10300 12100 12400 12000 14300 29400 26600 14200 27200 29500 11000 
tL.On 
Mean 

Aspect 
Ratio 0.906 0.829 1.05 0.691 0.564 0.825 1.57 1.58 0.184 1.82 1.86 0.347 
tL.On 
Mean 

Circularit 
y 0.252 0.242 0.292 0.352 0.336 0.407 0.661 0.661 

0.092 
5 0.593 0.56 0.143 

tL.On 
Mean 
Inner 
Label 
(um) 11.2 10 13 6.92 4.28 9.09 20.3 18.7 8.48 25.6 27.1 9.92 

tL.On 
Mean 
Outer 
Label 
(um) 18.4 18 21.3 18.3 17 21.2 39.3 39.6 16.3 38.6 38.3 15.9 

tL.On 
Mean 

Roundnes 
s 0.279 0.254 0.325 0.374 0.305 0.447 0.648 0.638 

0.069 
4 0.578 0.572 0.111 

tL.On 
Mean 

Solidity 0.411 0.397 0.476 0.467 0.456 0.54 0.916 0.916 
0.041 

5 0.899 0.882 
0.056 

3 
tL.On 
Mean 
Wall 

Thickness 
(W.Th.tL) 

(um) 21.3 21.2 24.5 27.6 26.3 32 57.3 55 9.15 46 52.3 15.5 
tL.ON/CA 

(tL.On. 
OPD.CA) 
(#/mm^2) 0.108 

0.074 
1 0.136 

0.094 
5 

0.091 
2 0.109 0.394 0.289 0.289 0.314 0.231 0.239 

tL.ON/RA 
(tL.On. 

OPD.RA) 
(#/mm^2) 

4.07E 
-09 

3.13E 
-09 

4.94E 
-09 

5.72E 
-09 

5.55E 
-09 

6.62E 
-09 

1.92E 
-08 

1.28E 
-08 

1.79E 
-08 

1.08E 
-08 

8.99E 
-09 

6.41E 
-09 

Total 
Osteon 
Count 

(T.On) 68.8 66.5 39.4 40.5 42.5 17.7 59.2 60 20.1 91.5 77 31.1 
Total Pore 

Area 
(um^2) 

11900 
0 

10800 
0 68400 71300 61700 40700 

10800 
0 99800 29400 

15300 
0 

14000 
0 82200 

Total Pore 
Number 234 246 53.4 126 108 41.8 174 172 24.3 248 236 46.5 

Triple-
Labeled 
Osteon 
Count 

(tL.On) 0.75 0.5 0.957 0.5 0.5 0.577 2.25 1.5 1.89 2.25 1.5 1.89 

Rs.N 1.25 1 1.5 2.25 1 3.3 2.5 2 1.73 3.25 2.5 1.89 
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Appendix XXV: Histology ANOVA for Whole-Section Femur 

Whole-Section Femur: ANOVA Results 

Variable Test Effect df Sumsq Meansq F 
P-

Value 
Sig 2ηp ωp² Effect 

Size 
Pwr 

Ps.MS/BS 
(%) 

Kruskal-
Wallis 

Group 2 4.19 0.123 0.244 Large 0.518 

Es.MS/BS 
(%) ANOVA Group 2 384 192 0.352 0.712 0.073 -0.121 

Very 
Small 0.05 

Lambda 
= None 

Residuals 9 4910 545 

Total Area 
(mm^2) ANOVA Group 2 14.7 7.34 0.329 0.728 0.068 -0.126 

Very 
Small 0.05 

Lambda 
= None 

Residuals 9 201 22.3 

Marrow Area 
(mm^2) ANOVA Group 2 9.93 4.97 0.523 0.61 0.104 -0.086 

Very 
Small 0.05 

Lambda 
= None 

Residuals 9 85.5 9.5 

Cortical Area 
(mm^2) ANOVA Group 2 3.49 1.74 0.277 0.764 0.058 -0.137 

Very 
Small 0.05 

Lambda 
= None 

Residuals 9 56.7 6.3 

Remodeling 
Area (mm^2) ANOVA Group 2 9.84 4.92 2.14 0.174 0.322 0.16 Large 0.603 

Lambda 
= None 

Residuals 9 20.7 2.3 

% Cortical 
Area 

ANOVA Group 2 14.9 7.46 0.584 0.577 0.115 -0.074 
Very 
Small 0.05 

Lambda 
= None 

Residuals 9 115 12.8 

% Marrow 
Area 

ANOVA Group 2 14.9 7.46 0.584 0.577 0.115 -0.074 
Very 
Small 0.05 

Lambda 
= None 

Residuals 9 115 12.8 

% 
Remodeling 

Area 
ANOVA Group 2 31.8 15.9 4.3 0.0489 * 0.489 0.355 Large 0.975 

Lambda 
= None 

Residuals 9 33.3 3.7 

Parabolic 
Index (Y) ANOVA Group 2 2.09E-05 1.04E-05 0.524 0.609 0.104 -0.086 

Very 
Small 0.05 

Lambda 
= None 

Residuals 9 0.000179 1.99E-05 

Imin (mm^4) ANOVA Group 2 385 193 0.165 0.85 0.035 -0.162 
Very 
Small 0.05 

Lambda 
= None 

Residuals 9 10500 1170 

Imax 
(mm^4) ANOVA Group 2 275 138 0.394 0.685 0.08 -0.112 

Very 
Small 0.05 
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Variable Test Effect df Sumsq Meansq F 
P-

Value 
Sig 2ηp ωp² Effect 

Size 
Pwr 

Lambda 
= None 

Residuals 9 3150 350 

Zpol (mm^3) ANOVA Group 2 
4.91 
E+13 

2.46 
E+13 

0.383 0.692 0.078 -0.115 
Very 
Small 0.05 

Lambda 
= None 

Residuals 9 
5.77 
E+14 

6.41 
E+13 

Percent 
Porosity (%) ANOVA Group 2 0.0902 0.0451 1.39 0.298 0.236 0.061 Medium 0.239 

Lambda 
= -2.17 

Residuals 9 0.292 0.0325 

Pore Density 
CA 

(1/mm^2) 
ANOVA Group 2 136 67.9 1.97 0.196 0.304 0.139 Medium 0.529 

Lambda 
= None 

Residuals 9 311 34.5 

Pore Density 
RA 

(1/mm^2) 

Kruskal-
Wallis 

Group 2 0.731 0.694 
-

0.141 
Large 0.125 

Total Pore 
Number ANOVA Group 2 96800 48400 2.01 0.19 0.308 0.144 Large 0.547 

Lambda 
= None 

Residuals 9 217000 24100 

Total Pore 
Area (um^2) ANOVA Group 2 

3.64 
E+10 

1.82 
E+10 

0.71 0.517 0.136 -0.051 
Very 
Small 0.05 

Lambda 
= None 

Residuals 9 
2.31 
E+11 

2.56 
E+10 

Mean Pore 
Area (um^2) 

Kruskal-
Wallis 

Group 2 4.19 0.123 0.244 Large 0.416 

Mean Pore 
Perimeter 

(um) 
ANOVA Group 2 255 128 1.16 0.356 0.205 0.026 Small 0.122 

Lambda 
= None 

Residuals 9 991 110 

Mean Pore 
Circularity 

ANOVA Group 2 0.00461 0.0023 0.914 0.435 0.169 -0.014 
Very 
Small 0.05 

Lambda 
= None 

Residuals 9 0.0227 0.00252 

Mean Pore 
Max Feret 
Diameter 

(um) 

ANOVA Group 2 33 16.5 0.957 0.42 0.175 -0.007 
Very 
Small 0.05 

Lambda 
= None 

Residuals 9 155 17.2 

Mean Pore 
Min Feret 
Diameter 

(um) 

ANOVA Group 2 7.97 3.99 0.968 0.416 0.177 -0.005 
Very 
Small 0.05 

Lambda 
= None 

Residuals 9 37.1 4.12 

Mean Pore 
Aspect Ratio 

ANOVA Group 2 5.99 E-05 0.00003 0.629 0.555 0.123 -0.066 
Very 
Small 0.05 
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Variable Test Effect df Sumsq Meansq F 
P-

Value 
Sig 2ηp ωp² Effect 

Size 
Pwr 

Lambda 
= -4.72 

Residuals 9 0.000429 4.77 E-05 

Mean Pore 
Roundness ANOVA Group 2 0.000796 0.000398 0.319 0.735 0.066 -0.128 

Very 
Small 0.05 

Lambda 
= None 

Residuals 9 0.0112 0.00125 

Mean Pore 
Solidity ANOVA Group 2 0.00131 0.000655 0.983 0.411 0.179 -0.003 

Very 
Small 0.05 

Lambda 
= None 

Residuals 9 0.006 0.000667 

Total Osteon 
Count 
(T.On) 

ANOVA Group 2 20000 9980 4.63 0.0414 * 0.507 0.377 Large 0.985 

Lambda 
= None 

Residuals 9 19400 2160 

Complete 
Osteon 
Count 
(C.On) 

ANOVA Group 2 3930 1960 4.27 0.0497 * 0.487 0.353 Large 0.974 

Lambda 
= None 

Residuals 9 4140 460 

Forming 
Osteon 
Count 
(F.On) 

ANOVA Group 2 6320 3160 3.61 0.0705 . 0.445 0.303 Large 0.933 

Lambda 
= None 

Residuals 9 7860 874 

Single-
Labeled 
Osteon 
Count 

(sL.On) 

ANOVA Group 2 689 344 1.09 0.377 0.195 0.014 Small 0.0869 

Lambda 
= None 

Residuals 9 2850 316 

Double- 
Labeled 
Osteon 
Count 

(dL.On) 

ANOVA Group 2 1950 977 5.79 0.0241 * 0.563 0.444 Large 0.997 

Lambda 
= None 

Residuals 9 1520 169 

Triple-
Labeled 
Osteon 
Count 
(tL.On) 

ANOVA Group 2 26 13 1.12 0.367 0.2 0.02 Small 0.104 

Lambda 
= None 

Residuals 9 104 11.6 

dL.On Mean 
Inner Label 

(um) 
ANOVA Group 2 188 93.8 0.749 0.5 0.143 -0.044 

Very 
Small 0.05 

401 
2018-DU-BX-0188 Final Technical Report 
October 2021 

This resource was prepared by the author(s) using Federal funds provided by the U.S. 
Department of Justice. Opinions or points of view expressed are those of the author(s) and do not 

necessarily reflect the official position or policies of the U.S. Department of Justice.



 
 

            

 
           

 
 

 
            

 
           

 
 

 
            

 
           

 

 
           

  

 
           

 
 

 
           

  

 
           

 
 

 

 

    
         

  

 
   

 
 
 

       

 
 

 

 

           
  

 
           

 
 

 

 

           
  

 
           

 
 

 
 

 

    
 

 
        

 
   

          

Variable Test Effect df Sumsq Meansq F 
P-

Value 
Sig 2ηp ωp² Effect 

Size 
Pwr 

Lambda 
= None 

Residuals 9 1130 125 

tL.On Mean 
Inner Label 

(um) 
ANOVA Group 2 364000 182000 2.31 0.155 0.34 0.18 Large 0.669 

Lambda 
= 2 

Residuals 9 707000 78600 

tL.On Mean 
Outer Label 

(um) 
ANOVA Group 2 23000000 11500000 4.65 0.041 * 0.508 0.378 Large 0.985 

Lambda 
=  2.22 

Residuals 9 22300000 2480000 

Combined 
Mean Inner 
Label (um) 

ANOVA Group 2 7.56 3.78 0.0627 0.94 0.014 -0.185 
Very 
Small 0.05 

Lambda 
= None 

Residuals 9 542 60.3 

Combined 
Mean Label 

(um) 
ANOVA Group 2 2.63 1.31 0.0308 0.97 0.007 -0.193 

Very 
Small 0.05 

Lambda 
= None 

Residuals 9 385 42.7 

C.On Mean 
Wall 

Thickness 
(W.Th.C) 

(um) 

ANOVA Group 2 
2.21 
E+21 

1.1 E+21 0.337 0.723 0.07 -0.124 
Very 
Small 0.05 

Lambda 
=  6.92 

Residuals 9 
2.95 
E+22 

3.28 
E+21 

sL.On Mean 
Wall 

Thickness 
(W.Th.sL) 

(um) 

ANOVA Group 2 30.7 15.3 0.349 0.715 0.072 -0.122 
Very 
Small 0.05 

Lambda 
= None 

Residuals 9 396 44 

dL.On Mean 
Wall 

Thickness 
(W.Th.dL) 

(um) 

ANOVA Group 2 28.6 14.3 0.39 0.688 0.08 -0.113 
Very 
Small 0.05 

Lambda 
= None 

Residuals 9 330 36.6 

tL.On Mean 
Wall 

Thickness 
(W.Th.tL) 

(um) 

ANOVA Group 2 
1.13 
E+10 

5.67 
E+09 

1.67 0.242 0.27 0.1 Medium 0.383 

Lambda 
=  2.92 

Residuals 9 
3.06 
E+10 

3.4 E+09 
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Variable Test Effect df Sumsq Meansq F 
P-

Value 
Sig 2ηp ωp² Effect 

Size 
Pwr 

T.On Mean 
Area (um^2) ANOVA Group 2 26200000 13100000 2.76 0.116 0.38 0.227 Large 0.8 

Lambda 
= None 

Residuals 9 42700000 4740000 

T.On Mean 
Circularity 

ANOVA Group 2 0.000878 0.000439 0.418 0.67 0.085 -0.107 
Very 
Small 0.05 

Lambda 
= None 

Residuals 9 0.00945 0.00105 

T.On Mean 
Aspect Ratio 

ANOVA Group 2 0.00032 0.00016 0.0113 0.989 0.003 -0.197 
Very 
Small 0.05 

Lambda 
= None 

Residuals 9 0.127 0.0141 

T.On Mean 
Roundness ANOVA Group 2 0.000143 7.15 E-05 0.12 0.888 0.026 -0.172 

Very 
Small 0.05 

Lambda 
= None 

Residuals 9 0.00537 0.000597 

T.On Mean 
Solidity ANOVA Group 2 4.26 E-06 2.13 E-06 0.00862 0.991 0.002 -0.198 

Very 
Small 0.05 

Lambda 
= None 

Residuals 9 0.00222 0.000247 

C.On Mean 
Area (um^2) ANOVA Group 2 53700000 26800000 2.79 0.114 0.382 0.229 Large 0.805 

Lambda 
= None 

Residuals 9 86700000 9630000 

C.On Mean 
Circularity 

ANOVA Group 2 0.0036 0.0018 1.49 0.276 0.249 0.076 Medium 0.293 

Lambda 
= None 

Residuals 9 0.0109 0.00121 

C.On Mean 
Aspect Ratio 

ANOVA Group 2 0.0091 0.00455 0.583 0.578 0.115 -0.075 
Very 
Small 0.05 

Lambda 
= None 

Residuals 9 0.0703 0.00781 

C.On Mean 
Roundness ANOVA Group 2 0.000486 0.000243 0.438 0.658 0.089 -0.103 

Very 
Small 0.05 

Lambda 
= None 

Residuals 9 0.00499 0.000555 

C.On Mean 
Solidity ANOVA Group 2 0.0121 0.00605 0.765 0.493 0.145 -0.041 

Very 
Small 0.05 

Lambda 
=  9.93 

Residuals 9 0.0712 0.00791 

F.On Mean 
Area (um^2) ANOVA Group 2 6310000 3150000 2.15 0.172 0.324 0.161 Large 0.607 

Lambda 
= None 

Residuals 9 13200000 1460000 

F.On Mean 
Circularity 

ANOVA Group 2 0.000202 0.000101 0.0742 0.929 0.016 -0.182 
Very 
Small 0.05 

Lambda 
= None 

Residuals 9 0.0122 0.00136 

F.On Mean 
Aspect Ratio 

ANOVA Group 2 0.00208 0.00104 0.0275 0.973 0.006 -0.193 
Very 
Small 0.05 
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Variable Test Effect df Sumsq Meansq F 
P-

Value 
Sig 2ηp ωp² Effect 

Size 
Pwr 

Lambda 
= None 

Residuals 9 0.34 0.0378 

F.On Mean 
Roundness ANOVA Group 2 0.00023 0.000115 0.0857 0.919 0.019 -0.18 

Very 
Small 0.05 

Lambda 
= None 

Residuals 9 0.0121 0.00134 

F.On Mean 
Solidity ANOVA Group 2 0.000365 0.000183 0.582 0.578 0.115 -0.075 

Very 
Small 0.05 

Lambda 
= None 

Residuals 9 0.00282 0.000314 

sL.On Mean 
Area (um^2) ANOVA Group 2 

5.33 
E+08 

2.67 
E+08 

0.26 0.777 0.055 -0.141 
Very 
Small 0.05 

Lambda 
=  1.3 

Residuals 9 
9.23 
E+09 

1.03 
E+09 

sL.On Mean 
Circularity 

ANOVA Group 2 0.00133 0.000666 0.186 0.833 0.04 -0.157 
Very 
Small 0.05 

Lambda 
= None 

Residuals 9 0.0322 0.00357 

sL.On Mean 
Aspect Ratio 

ANOVA Group 2 0.000236 0.000118 0.557 0.591 0.11 -0.08 
Very 
Small 0.05 

Lambda 
= -7.45 

Residuals 9 0.00191 0.000212 

sL.On Mean 
Roundness ANOVA Group 2 6.84E-05 3.42E-05 0.333 0.725 0.069 -0.125 

Very 
Small 0.05 

Lambda 
=  9.9 

Residuals 9 0.000924 0.000103 

sL.On Mean 
Solidity ANOVA Group 2 0.00103 0.000513 0.547 0.597 0.108 -0.082 

Very 
Small 0.05 

Lambda 
= None 

Residuals 9 0.00843 0.000937 

dL.On Mean 
Area (um^2) ANOVA Group 2 41500000 20800000 1.88 0.209 0.294 0.127 Medium 0.485 

Lambda 
= None 

Residuals 9 99700000 11100000 

dL.On Mean 
Circularity 

ANOVA Group 2 0.000715 0.000358 1.48 0.277 0.248 0.075 Medium 0.289 

Lambda 
=  9.32 

Residuals 9 0.00217 0.000241 

dL.On Mean 
Aspect Ratio 

ANOVA Group 2 0.0269 0.0135 1.47 0.279 0.247 0.073 Medium 0.282 

Lambda 
= None 

Residuals 9 0.0823 0.00914 

dL.On Mean 
Roundness ANOVA Group 2 0.00324 0.00162 1.53 0.269 0.253 0.081 Medium 0.312 

Lambda 
= None 

Residuals 9 0.00954 0.00106 

dL.On Mean 
Solidity ANOVA Group 2 0.000771 0.000386 1.26 0.33 0.219 0.041 Small 0.17 

Lambda 
= None 

Residuals 9 0.00276 0.000306 
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Variable Test Effect df Sumsq Meansq F 
P-

Value 
Sig 2ηp ωp² Effect 

Size 
Pwr 

tL.On Mean 
Area (um^2) ANOVA Group 2 9.9 E+08 

4.95 
E+08 

3.02 0.099 . 0.402 0.252 Large 0.855 

Lambda 
= None 

Residuals 9 
1.47 
E+09 

1.64 
E+08 

tL.On Mean 
Circularity 

ANOVA Group 2 0.098 0.049 1.58 0.258 0.26 0.088 Medium 0.338 

Lambda 
=  2.2 

Residuals 9 0.279 0.031 

tL.On Mean 
Aspect Ratio 

ANOVA Group 2 77.4 38.7 0.605 0.567 0.119 -0.07 
Very 
Small 0.05 

Lambda 
=  4.6 

Residuals 9 576 64 

tL.On Mean 
Roundness ANOVA Group 2 0.0123 0.00616 2.9 0.107 0.392 0.24 Large 0.83 

Lambda 
=  4.88 

Residuals 9 0.0191 0.00212 

tL.On Mean 
Solidity ANOVA Group 2 0.117 0.0583 1.09 0.375 0.196 0.016 Small 0.0925 

Lambda 
=  7.42 

Residuals 9 0.479 0.0533 

Unlabeled 
Resorption 

Space Count 
(Rs.N) 

ANOVA Group 2 35.2 17.6 1.18 0.352 0.207 0.029 Small 0.131 

Lambda 
= None 

Residuals 9 134 14.9 

Active 
Remodeling 

Centers 
(a.Rm.Cr) 

ANOVA Group 2 20700 10300 4.44 0.0455 * 0.497 0.365 Large 0.98 

Lambda 
= None 

Residuals 9 20900 2330 

a.Rm.Cr/CA 
(a.Rm.Cr. 
OPD.CA) 
(#/mm^2) 

ANOVA Group 2 28.1 14.1 4.34 0.048 * 0.491 0.357 Large 0.976 

Lambda 
= None 

Residuals 9 29.2 3.24 

T.On/CA 
(T.On. 

OPD.CA) 
(#/mm^2) 

ANOVA Group 2 27.7 13.8 4.39 0.0467 * 0.494 0.361 Large 0.978 

Lambda 
= None 

Residuals 9 28.4 3.15 

C.On/CA 
(C.On. 

OPD.CA) 
(#/mm^2) 

ANOVA Group 2 5.62 2.81 4.45 0.0454 * 0.497 0.365 Large 0.98 

Lambda 
= None 

Residuals 9 5.69 0.632 
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Variable Test Effect df Sumsq Meansq F 
P-

Value 
Sig 2ηp ωp² Effect 

Size 
Pwr 

F.On/CA 
(F.On. 

OPD.CA) 
(#/mm^2) 

ANOVA Group 2 8.43 4.21 3.14 0.0922 . 0.411 0.263 Large 0.875 

Lambda 
= None 

Residuals 9 12.1 1.34 

sL.On/CA 
(sL.On. 

OPD.CA) 
(#/mm^2) 

ANOVA Group 2 0.899 0.449 1.06 0.387 0.19 0.009 
Very 
Small 0.0732 

Lambda 
= None 

Residuals 9 3.83 0.426 

dL.On/CA 
(dL.On. 

OPD.CA) 
(#/mm^2) 

ANOVA Group 2 2.79 1.4 3.88 0.061 . 0.463 0.324 Large 0.953 

Lambda 
= None 

Residuals 9 3.24 0.36 

tL.ON/CA 
(tL.On. 

OPD.CA) 
(#/mm^2) 

ANOVA Group 2 0.0499 0.0249 0.981 0.412 0.179 -0.003 
Very 
Small 0.05 

Lambda 
= None 

Residuals 9 0.229 0.0254 

Rs.N/CA 
(Rs.N. 

OPD.CA) 
(#/mm^2) 

ANOVA Group 2 0.0438 0.0219 1.05 0.39 0.189 0.008 
Very 
Small 0.0705 

Lambda 
= None 

Residuals 9 0.188 0.0209 

a.Rm.Cr/RA 
(a.Rm.Cr. 
OPD.RA) 
(#/mm^2) 

ANOVA Group 2 43.7 21.9 0.72 0.513 0.138 -0.049 
Very 
Small 0.05 

Lambda 
= None 

Residuals 9 273 30.4 

T.On/RA 
(T.On. 

OPD.RA) 
(#/mm^2) 

ANOVA Group 2 42.5 21.3 0.731 0.508 0.14 -0.047 
Very 
Small 0.05 

Lambda 
= None 

Residuals 9 262 29.1 

C.On/RA 
(C.On. 

OPD.RA) 
(#/mm^2) 

ANOVA Group 2 7.63 3.81 0.548 0.596 0.109 -0.081 
Very 
Small 0.05 

Lambda 
= None 

Residuals 9 62.6 6.95 

F.On/RA 
(F.On. ANOVA Group 2 16.5 8.25 0.758 0.496 0.144 -0.042 

Very 
Small 0.05 

406 
2018-DU-BX-0188 Final Technical Report 
October 2021 

This resource was prepared by the author(s) using Federal funds provided by the U.S. 
Department of Justice. Opinions or points of view expressed are those of the author(s) and do not 

necessarily reflect the official position or policies of the U.S. Department of Justice.



 
 

            

 

 
           

 

 

           
  

 
           

 

 

            

 
           

 

 

           
  

 
           

 

            

 
           

            
  

 
           

 
            

  

 
           

            
  

 
           

 
            

  

 
           

  
 

            

 
           

              
  

Variable Test Effect df Sumsq Meansq F 
P-

Value 
Sig 2ηp ωp² Effect 

Size 
Pwr 

OPD.RA) 
(#/mm^2) 

Lambda 
= None 

Residuals 9 97.9 10.9 

sL.On/RA 
(sL.On. 

OPD.RA) 
(#/mm^2) 

ANOVA Group 2 5.39 2.7 0.581 0.579 0.114 -0.075 
Very 
Small 0.05 

Lambda 
= None 

Residuals 9 41.8 4.65 

dL.On/RA 
(dL.On. 

OPD.RA) 
(#/mm^2) 

ANOVA Group 2 8.12 4.06 1.12 0.367 0.2 0.02 Small 0.104 

Lambda 
= None 

Residuals 9 32.5 3.61 

tL.ON/RA 
(tL.On. 

OPD.RA) 
(#/mm^2) 

ANOVA Group 2 0.451 0.226 0.775 0.489 0.147 -0.039 
Very 
Small 0.05 

Lambda 
= None 

Residuals 9 2.62 0.291 

Rs.N/RA 
(Rs.N. 

OPD.RA) 
(#/mm^2) 

ANOVA Group 2 0.584 0.292 1.42 0.292 0.239 0.065 Medium 0.253 

Lambda 
= None 

Residuals 9 1.86 0.206 

T.On / Rs.N ANOVA Group 2 0.00579 0.0029 0.74 0.504 0.141 -0.045 
Very 
Small 0.05 

Lambda 
= -0.3 

Residuals 9 0.0352 0.00391 

On.MAR.I.dL 
(um/day) ANOVA Group 2 0.957 0.478 0.749 0.5 0.143 -0.044 

Very 
Small 0.05 

Lambda 
= None 

Residuals 9 5.75 0.639 

On.MAR.I 
(um/day) ANOVA Group 2 0.0386 0.0193 0.0627 0.94 0.014 -0.185 

Very 
Small 0.05 

Lambda 
= None 

Residuals 9 2.77 0.308 

On.MAR.C 
(um/day) ANOVA Group 2 0.0134 0.0067 0.0308 0.97 0.007 -0.193 

Very 
Small 0.05 

Lambda 
= None 

Residuals 9 1.96 0.218 

σf dL 

(days) 
ANOVA Group 2 7.36 3.68 1.41 0.294 0.238 0.064 Medium 0.249 

Lambda 
= None 

Residuals 9 23.5 2.61 

σf I  (days) ANOVA Group 2 1.92 0.961 0.11 0.897 0.024 -0.174 
Very 
Small 0.05 
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Variable Test Effect df Sumsq Meansq F 
P-

Value 
Sig 2ηp ωp² Effect 

Size 
Pwr 

Lambda 
= None 

Residuals 9 78.7 8.74 

σf C (days) ANOVA Group 2 1.21 0.605 0.0684 0.934 0.015 -0.184 
Very 
Small 0.05 

Lambda 
= None 

Residuals 9 79.6 8.85 

Ac.F.I.dL 
(#/mm^2/ 

year) 
ANOVA Group 2 12200 6120 2.35 0.151 0.343 0.183 Large 0.679 

Lambda 
= None 

Residuals 9 23500 2610 

Ac.F.I 
(#/mm^2/ 

year) 
ANOVA Group 2 3270 1640 0.846 0.46 0.158 -0.026 

Very 
Small 0.05 

Lambda 
= None 

Residuals 9 17400 1930 

Ac.F.C 
(#/mm^2/ 

year) 
ANOVA Group 2 3160 1580 0.874 0.45 0.163 -0.021 

Very 
Small 0.05 

Lambda 
= None 

Residuals 9 16300 1810 
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Whole-Section Femur: Tukey HSD Post-Hoc Comparisons for Significant Main Effects 

Variable Contrast Estimate ConfLow ConfHigh 
P-value 

Adj Sig 

% Remodeling Area Control > Fentanyl -1.54 -5.34 2.25 0.518 

Control < Morphine 2.41 -1.38 6.21 0.232 

Fentanyl < Morphine 3.96 0.16 7.75 0.0416 * 

Total Osteon Count (T.On) Control > Fentanyl -5.75 -97.4 85.9 0.983 

Control < Morphine 83.5 -8.16 175 0.0736 . 

Fentanyl < Morphine 89.2 -2.41 181 0.0561 . 

Complete Osteon Count (C.On) Control > Fentanyl -8 -50.3 34.3 0.86 

Control < Morphine 33.8 -8.6 76.1 0.12 

Fentanyl < Morphine 41.8 -0.595 84.1 0.0532 . 
Double-Labeled Osteon Count 

(dL.On) Control > Fentanyl -15 -40.6 10.6 0.282 

Control < Morphine 16.2 -9.39 41.9 0.234 

Fentanyl < Morphine 31.2 5.61 56.9 0.0193 * 

tL.On Mean Outer Label (um) Control > Fentanyl -3000 -6110 108 0.0581 . 

Control > Morphine -124 -3230 2980 0.993 

Fentanyl < Morphine 2880 -232 5980 0.0692 . 
Active Remodeling Centers 

(a.Rm.Cr) Control > Fentanyl -2 -97.2 93.2 0.998 

Control < Morphine 87 -8.2 182 0.0727 . 

Fentanyl < Morphine 89 -6.2 184 0.0664 . 

a.Rm.Cr.OPD.CA (#/mm^2) Control > Fentanyl -0.377 -3.93 3.18 0.953 

Control < Morphine 3.04 -0.512 6.59 0.0933 . 

Fentanyl < Morphine 3.42 -0.135 6.97 0.059 . 

T.On.OPD.CA (#/mm^2) Control > Fentanyl -0.505 -4.01 3 0.916 

Control < Morphine 2.94 -0.565 6.45 0.1 

Fentanyl < Morphine 3.44 -0.0605 6.95 0.0539 . 

C.On.OPD.CA (#/mm^2) Control > Fentanyl -0.478 -2.05 1.09 0.683 

Control < Morphine 1.15 -0.417 2.72 0.156 

Fentanyl < Morphine 1.63 0.0607 3.2 0.0423 * 
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Whole-Section Femur: All Directional Trends 

Factor Trend 

Ps.MS/BS (%) Fentanyl > Control > Morphine 

Es.MS/BS (%) Control > Fentanyl > Morphine 

Total Area (mm^2) Morphine > Fentanyl > Control 

Marrow Area (mm^2) Morphine > Control > Fentanyl 

Cortical Area (mm^2) Fentanyl > Morphine > Control 

Remodeling Area (mm^2) Morphine > Control > Fentanyl 

% Cortical Area Fentanyl > Control > Morphine 

% Marrow Area Morphine > Control > Fentanyl 

% Remodeling Area Morphine > Control > Fentanyl 

Parabolic Index (Y) Morphine > Control > Fentanyl 

Imin (mm^4) Morphine > Fentanyl > Control 

Imax (mm^4) Morphine > Fentanyl > Control 

Zpol (mm^3) Morphine > Fentanyl > Control 

Percent Porosity (%) Control > Morphine > Fentanyl 

Pore Density CA (1/mm^2) Morphine > Control > Fentanyl 

Pore Density RA (1/mm^2) Morphine > Fentanyl > Control 

Total Pore Number Morphine > Control > Fentanyl 

Total Pore Area (um^2) Control > Morphine > Fentanyl 

Mean Pore Area (um^2) Control > Fentanyl > Morphine 

Mean Pore Perimeter (um) Control > Fentanyl > Morphine 

Mean Pore Circularity Morphine > Control > Fentanyl 

Mean Pore Max Feret Diameter (um) Control > Fentanyl > Morphine 

Mean Pore Min Feret Diameter (um) Control > Fentanyl > Morphine 

Mean Pore Aspect Ratio Fentanyl > Control > Morphine 

Mean Pore Roundness Morphine > Control > Fentanyl 

Mean Pore Solidity Morphine > Control > Fentanyl 

Total Osteon Count (T.On) Morphine > Control > Fentanyl 

Complete Osteon Count (C.On) Morphine > Control > Fentanyl 

Forming Osteon Count (F.On) Morphine > Fentanyl > Control 

Single-Labeled Osteon Count (sL.On) Morphine > Fentanyl > Control 

Double-Labeled Osteon Count (dL.On) Morphine > Control > Fentanyl 

Triple-Labeled Osteon Count (tL.On) Control > Morphine > Fentanyl 

dL.On Mean Inner Label (um) Control > Morphine > Fentanyl 

tL.On Mean Inner Label (um) Morphine > Control > Fentanyl 

tL.On Mean Outer Label (um) Control > Morphine > Fentanyl 
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Factor Trend 

Combined Mean Inner Label (um) Fentanyl > Control > Morphine 

Combined Mean Label (um) Control > Fentanyl > Morphine 

C.On Mean Wall Thickness (W.Th.C) (um) Morphine > Fentanyl > Control 

sL.On Mean Wall Thickness (W.Th.sL) (um) Morphine > Control > Fentanyl 

dL.On Mean Wall Thickness (W.Th.dL) (um) Fentanyl > Morphine > Control 

tL.On Mean Wall Thickness (W.Th.tL) (um) Morphine > Control > Fentanyl 

T.On Mean Area (um^2) Control > Morphine > Fentanyl 

T.On Mean Circularity Fentanyl > Morphine > Control 

T.On Mean Aspect Ratio Control > Morphine > Fentanyl 

T.On Mean Roundness Fentanyl > Morphine > Control 

T.On Mean Solidity Fentanyl > Morphine > Control 

C.On Mean Area (um^2) Control > Morphine > Fentanyl 

C.On Mean Circularity Fentanyl > Morphine > Control 

C.On Mean Aspect Ratio Control > Fentanyl > Morphine 

C.On Mean Roundness Morphine > Fentanyl > Control 

C.On Mean Solidity Fentanyl > Morphine > Control 

F.On Mean Area (um^2) Control > Fentanyl > Morphine 

F.On Mean Circularity Control > Fentanyl > Morphine 

F.On Mean Aspect Ratio Morphine > Control > Fentanyl 

F.On Mean Roundness Fentanyl > Control > Morphine 

F.On Mean Solidity Control > Morphine > Fentanyl 

sL.On Mean Area (um^2) Control > Morphine > Fentanyl 

sL.On Mean Circularity Morphine > Control > Fentanyl 

sL.On Mean Aspect Ratio Fentanyl > Morphine > Control 

sL.On Mean Roundness Control > Morphine > Fentanyl 

sL.On Mean Solidity Morphine > Control > Fentanyl 

dL.On Mean Area (um^2) Control > Fentanyl > Morphine 

dL.On Mean Circularity Fentanyl > Morphine > Control 

dL.On Mean Aspect Ratio Control > Morphine > Fentanyl 

dL.On Mean Roundness Fentanyl > Morphine > Control 

dL.On Mean Solidity Fentanyl > Morphine > Control 

tL.On Mean Area (um^2) Control > Morphine > Fentanyl 

tL.On Mean Circularity Control > Morphine > Fentanyl 

tL.On Mean Aspect Ratio Control > Morphine > Fentanyl 

tL.On Mean Roundness Control > Morphine > Fentanyl 

tL.On Mean Solidity Control > Morphine > Fentanyl 

Unlabeled Resorption Space Count (Rs.N) Fentanyl > Morphine > Control 

Active Remodeling Centers (a.Rm.Cr) (T.On + Rs.N) Morphine > Control > Fentanyl 

a.Rm.Cr/CA (a.Rm.Cr.OPD.CA) (#/mm^2) Morphine > Control > Fentanyl 

T.On/CA (T.On.OPD.CA) (#/mm^2) Morphine > Control > Fentanyl 
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Factor Trend 

C.On/CA (C.On.OPD.CA) (#/mm^2) Morphine > Control > Fentanyl 

F.On/CA (F.On.OPD.CA) (#/mm^2) Morphine > Control > Fentanyl 

sL.On/CA (sL.On.OPD.CA) (#/mm^2) Morphine > Fentanyl > Control 

dL.On/CA (dL.On.OPD.CA) (#/mm^2) Morphine > Control > Fentanyl 

tL.ON/CA (tL.On.OPD.CA) (#/mm^2) Control > Morphine > Fentanyl 

Rs.N/CA (Rs.N.OPD.CA) (#/mm^2) Fentanyl > Morphine > Control 

a.Rm.Cr/RA (a.Rm.Cr.OPD.RA) (#/mm^2) Morphine > Fentanyl > Control 

T.On/RA (T.On.OPD.RA) (#/mm^2) Morphine > Fentanyl > Control 

C.On/RA (C.On.OPD.RA) (#/mm^2) Morphine > Control > Fentanyl 

F.On/RA (F.On.OPD.RA) (#/mm^2) Morphine > Fentanyl > Control 

sL.On/RA (sL.On.OPD.RA) (#/mm^2) Fentanyl > Morphine > Control 

dL.On/RA (dL.On.OPD.RA) (#/mm^2) Morphine > Control > Fentanyl 

tL.ON/RA (tL.On.OPD.RA) (#/mm^2) Control > Morphine > Fentanyl 

Rs.N/RA (Rs.N.OPD.RA) (#/mm^2) Fentanyl > Morphine > Control 

T.On / Rs.N Control > Fentanyl > Morphine 

On.MAR.I.dL (dL Inner Labels) (um/day) Control > Morphine > Fentanyl 

On.MAR.I (Inner Labels) (um/day) Fentanyl > Control > Morphine 

On.MAR.C (Combined Labels) (um/day) Control > Fentanyl > Morphine 

Osteon Formation Time (W.Th.C / On.MAR.I.dL) (days) Fentanyl > Morphine > Control 

Osteon Formation Time (W.Th.C / On.MAR.I) (days) Morphine > Fentanyl > Control 

Osteon Formation Time (W.Th.C / On.MAR.C) (days) Morphine > Fentanyl > Control 

Ac.F.I.dL ((C.On.OPD.CA/OFT.I.dL)*365) (#/mm^2/year) Morphine > Control > Fentanyl 

Ac.F.I ((C.On.OPD.CA/OFT.I)*365) (#/mm^2/year) Morphine > Control > Fentanyl 

Ac.F.C ((C.On.OPD.CA/OFT.C)*365) (#/mm^2/year) Morphine > Control > Fentanyl 
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Appendix XXVI: Histology Linear Mixed Model for Regional Femur 

Regional Femur: LMM Fixed Effects and Random Effects 

Cortical Area (mm^2) Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 6.12 0.181 5.76 6.49 33.8 0 
** 
* 

0.975 

Region1 1.01 0.0878 0.824 1.18 11.5 0 
** 
* 

0.000175 *** 

Region2 -0.973 0.0878 -1.15 -0.793 -11.1 0 
** 
* 

0.000175 *** 

Region3 -0.806 0.0878 -0.954 -0.635 -9.18 0 
** 
* 

0.000175 *** 

Group1 -0.191 0.256 -0.703 0.337 -0.744 0.476 0.491 

Group2 0.0968 0.256 -0.401 0.61 0.378 0.714 0.729 

Region1:Group1 0.0594 0.124 -0.187 0.312 0.479 0.636 0.647 

Region2:Group1 -0.111 0.124 -0.369 0.121 -0.896 0.378 0.354 

Region3:Group1 0.0577 0.124 -0.185 0.317 0.465 0.646 0.638 

Region1:Group2 0.152 0.124 -0.101 0.422 1.23 0.23 0.209 

Region2:Group2 -0.0999 0.124 -0.346 0.152 -0.805 0.428 0.444 

Region3:Group2 -0.0837 0.124 -0.333 0.168 -0.674 0.506 0.492 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.363 0.602 0.356 1.02 74.6 
2.67E-

07 
** 
* 

R2M / 
R2C 

0.636 / 
0.908 

Residual 0.123 0.351 0.244 0.43 25.4 NA AIC/BIC 111 / 
138 

Remodeling Area 
(mm^2) Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 2.08 0.109 1.85 2.29 19 0 
** 
* 

0.996 

Region1 0.222 0.13 -0.0228 0.479 1.71 0.0991 . 0.102 

Region2 -0.823 0.13 -1.08 -0.565 -6.34 9E-07 
** 
* 

0.000175 *** 

Region3 -0.27 0.13 -0.509 0.00136 -2.08 0.0471 * 0.0551 . 

Group1 -0.0577 0.155 -0.351 0.248 -0.373 0.718 0.724 

Group2 -0.244 0.155 -0.547 0.0655 -1.58 0.15 0.152 

Region1:Group1 0.182 0.183 -0.194 0.547 0.99 0.331 0.323 

Region2:Group1 -0.189 0.183 -0.536 0.151 -1.03 0.311 0.306 

Region3:Group1 -0.0648 0.183 -0.449 0.279 -0.353 0.727 0.715 

Region1:Group2 -0.0643 0.183 -0.4 0.304 -0.351 0.729 0.729 

Region2:Group2 0.0202 0.183 -0.37 0.353 0.11 0.913 0.922 

Region3:Group2 0.0559 0.183 -0.323 0.431 0.305 0.763 0.768 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

2018-DU-BX-0188 Final Technical Report 
October 2021 

This resource was prepared by the author(s) using Federal funds provided by the U.S. 
Department of Justice. Opinions or points of view expressed are those of the author(s) and do not 

necessarily reflect the official position or policies of the U.S. Department of Justice.

413 



 
 

        
 

 
 

         
 

           

    
        

          

          

          

          

          

          

          

          

          

          

          

          

    
        

        
 

 
 

        
 

            

    
        

          

          

          

          

          

          

          

          

          

          

          

          

    
        

        
 

 
 

         
 

Sample 0.0763 0.276 0 0.54 22.1 0.141 
R2M / 
R2C 

0.572 / 
0.666 

Residual 0.269 0.519 0.364 0.624 77.9 NA AIC/BIC 123 / 
150 

RA/CA (%) Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 0.333 0.0131 0.308 0.36 25.4 0 
** 
* 

0.995 

Region1 -0.00639 0.0202 -0.0444 0.0336 -0.316 0.754 0.747 

Region2 -0.0942 0.0202 -0.134 -0.0541 -4.67 
7.37E-

05 
** 
* 

0.000175 *** 

Region3 0.00803 0.0202 -0.0292 0.0502 0.398 0.694 0.696 

Group1 -0.00522 0.0185 -0.0395 0.0296 -0.281 0.785 0.801 

Group2 -0.0427 0.0185 -0.0806 -0.0044 -2.3 0.0467 * 0.0607 . 

Region1:Group1 0.022 0.0285 -0.0365 0.0789 0.769 0.448 0.431 

Region2:Group1 -0.029 0.0285 -0.0829 0.024 -1.02 0.319 0.302 

Region3:Group1 -0.00976 0.0285 -0.0695 0.0437 -0.342 0.735 0.715 

Region1:Group2 -0.006 0.0285 -0.0581 0.0513 -0.21 0.835 0.837 

Region2:Group2 0.0013 0.0285 -0.0594 0.053 0.0456 0.964 0.968 

Region3:Group2 0.00296 0.0285 -0.0561 0.0612 0.104 0.918 0.916 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.00044 0.0209 0 0.0625 6.33 0.657 
R2M / 
R2C 

0.47 / 
0.503 

Residual 0.00651 0.0807 0.0566 0.0968 93.7 NA AIC/BIC -
1.38182 

Percent Porosity (%) Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 1.71 0.165 1.37 2.05 10.4 2.6E-06 
** 
* 

0.993 

Region1 0.133 0.157 -0.163 0.444 0.845 0.406 0.39 

Region2 -0.802 0.157 -1.11 -0.49 -5.1 
0.00002 

3 
** 
* 

0.000175 *** 

Region3 0.149 0.157 -0.142 0.477 0.946 0.352 0.36 

Group1 0.236 0.233 -0.207 0.702 1.01 0.339 0.354 

Group2 -0.324 0.233 -0.778 0.141 -1.39 0.198 0.221 

Region1:Group1 0.154 0.222 -0.301 0.598 0.694 0.493 0.485 

Region2:Group1 -0.257 0.222 -0.677 0.156 -1.16 0.258 0.246 

Region3:Group1 0.0365 0.222 -0.429 0.453 0.164 0.871 0.882 

Region1:Group2 0.0483 0.222 -0.358 0.494 0.217 0.83 0.835 

Region2:Group2 -0.0213 0.222 -0.495 0.382 -0.0959 0.924 0.922 

Region3:Group2 -0.0512 0.222 -0.511 0.403 -0.23 0.819 0.816 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.228 0.477 0.176 0.845 36.5 0.0178 * 
R2M / 
R2C 

0.34 / 
0.581 

Residual 0.395 0.629 0.441 0.757 63.5 NA AIC/BIC 141 / 
167 
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Pore Density CA 
(1/mm^2) Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 26.3 1.66 22.9 29.6 15.9 1E-07 
** 
* 

0.979 

Region1 1.27 1.74 -2.01 4.73 0.732 0.471 0.46 

Region2 -8.97 1.74 -12.4 -5.5 -5.15 
2.04E-

05 
** 
* 

0.000175 *** 

Region3 1.67 1.74 -1.55 5.31 0.958 0.346 0.358 

Group1 -1.59 2.34 -6 3.07 -0.68 0.513 0.527 

Group2 -3.23 2.34 -7.75 1.44 -1.38 0.201 0.21 

Region1:Group1 -0.264 2.46 -5.31 4.65 -0.107 0.915 0.932 

Region2:Group1 -1.32 2.46 -5.98 3.25 -0.537 0.596 0.592 

Region3:Group1 0.0118 2.46 -5.15 4.63 
0.0047 

7 
0.996 0.998 

Region1:Group2 -1.17 2.46 -5.67 3.78 -0.473 0.64 0.645 

Region2:Group2 0.668 2.46 -4.58 5.13 0.271 0.788 0.813 

Region3:Group2 0.416 2.46 -4.68 5.45 0.169 0.867 0.869 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 20.8 4.56 0.686 8.39 30 0.0499 * 
R2M / 
R2C 

0.39 / 
0.573 

Residual 48.5 6.97 4.89 8.39 70 NA AIC/BIC 313 / 
339 

Pore Density RA 
(1/mm^2) Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 79 3.21 72.4 85.5 24.6 0 
** 
* 

0.985 

Region1 4.62 2.72 -0.507 10 1.7 0.101 0.105 

Region2 -4.84 2.72 -10.2 0.567 -1.78 0.0863 . 0.0888 . 

Region3 2.91 2.72 -2.11 8.6 1.07 0.293 0.299 

Group1 -5.03 4.54 -13.5 3.85 -1.11 0.297 0.33 

Group2 1.42 4.54 -7.53 10.5 0.313 0.761 0.769 

Region1:Group1 -4.41 3.84 -12.3 3.26 -1.15 0.262 0.258 

Region2:Group1 1.24 3.84 -6.03 8.38 0.323 0.749 0.746 

Region3:Group1 0.461 3.84 -7.59 7.67 0.12 0.905 0.911 

Region1:Group2 -5.58 3.84 -12.6 2.14 -1.45 0.159 0.149 

Region2:Group2 4.37 3.84 -3.82 11.3 1.14 0.266 0.27 

Region3:Group2 2.36 3.84 -5.59 10.2 0.613 0.545 0.556 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 94.1 9.7 4.27 16.7 44.3 0.00419 ** 
R2M / 
R2C 

0.186 / 
0.547 

Residual 118 10.9 7.63 13.1 55.7 NA AIC/BIC 349 / 
375 

Total Pore Number Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 
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(Intercept) 164 11.2 141 187 14.7 1E-07 
** 
* 

0.999 

Region1 29.1 10.6 9.05 50.2 2.73 0.0109 * 0.0119 * 

Region2 -72.6 10.6 -93.4 -51.5 -6.83 2E-07 
** 
* 

0.000175 *** 

Region3 -16.4 10.6 -36.1 5.85 -1.54 0.135 0.144 

Group1 -11.2 15.9 -41.3 20.5 -0.704 0.499 0.515 

Group2 -20.2 15.9 -51 11.4 -1.27 0.235 0.254 

Region1:Group1 0.333 15 -30.5 30.3 0.0221 0.982 0.963 

Region2:Group1 -8.67 15 -37.1 19.3 -0.576 0.569 0.56 

Region3:Group1 0.333 15 -31.2 28.6 0.0221 0.982 0.986 

Region1:Group2 -9.92 15 -37.4 20.3 -0.659 0.516 0.514 

Region2:Group2 5.58 15 -26.5 32.9 0.371 0.714 0.732 

Region3:Group2 5.08 15 -26 35.8 0.338 0.738 0.74 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 1050 32.5 12 57.5 36.8 0.017 * 
R2M / 
R2C 

0.52 / 
0.697 

Residual 1810 42.6 29.9 51.2 63.2 NA AIC/BIC 445 / 
471 

Total Pore Area 
(um^2) Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 108000 11600 84000 132000 9.34 6.3E-06 
** 
* 

0.993 

Region1 21300 10400 1610 41900 2.04 0.0514 . 0.0533 . 

Region2 -59400 10400 -79800 -38700 -5.7 4.7E-06 
** 
* 

0.000175 *** 

Region3 -7740 10400 -27000 14100 -0.742 0.464 0.471 

Group1 13800 16300 -17300 46000 0.843 0.421 0.437 

Group2 -18800 16300 -50700 13800 -1.15 0.28 0.295 

Region1:Group1 14100 14800 -16200 43500 0.953 0.349 0.339 

Region2:Group1 -17600 14800 -45500 9810 -1.19 0.243 0.227 

Region3:Group1 -2120 14800 -33000 25500 -0.144 0.887 0.876 

Region1:Group2 778 14800 -26200 30400 0.0527 0.958 0.965 

Region2:Group2 -262 14800 -31700 26500 -0.0177 0.986 0.981 

Region3:Group2 -677 14800 -31200 29500 -0.0459 0.964 0.957 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 1.17E+0 
9 

34100 13700 59700 40.1 0.00949 ** 
R2M / 
R2C 

0.39 / 
0.635 

Residual 1.74E+0 
9 

41700 29300 50200 59.9 NA AIC/BIC 942 / 
968 

Mean Pore Area 
(um^2) Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 641 37 565 712 17.3 0 
** 
* 

0.996 

Region1 29.2 47.1 -59.6 123 0.619 0.541 0.531 
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Region2 -132 47.1 -224 -38 -2.79 0.00944 ** 0.0109 * 

Region3 54.2 47.1 -32.9 153 1.15 0.261 0.267 

Group1 137 52.3 38 243 2.62 0.0279 * 0.0284 * 

Group2 -69.5 52.3 -171 34.8 -1.33 0.216 0.232 

Region1:Group1 56.8 66.7 -79.8 190 0.852 0.402 0.39 

Region2:Group1 -29 66.7 -155 94.8 -0.435 0.667 0.664 

Region3:Group1 7.03 66.7 -133 132 0.105 0.917 0.924 

Region1:Group2 45.3 66.7 -76.5 179 0.679 0.503 0.499 

Region2:Group2 -68.3 66.7 -210 52.6 -1.02 0.315 0.315 

Region3:Group2 -22 66.7 -160 114 -0.329 0.744 0.734 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 7510 86.7 0 182 17.4 0.239 
R2M / 
R2C 

0.301 / 
0.423 

Residual 35600 189 132 227 82.6 NA AIC/BIC 547 / 
573 

Mean Pore Perimeter 
(um) Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 102 2.96 96 108 34.5 0 
** 
* 

0.987 

Region1 -2.55 2.4 -7.07 2.2 -1.06 0.297 0.308 

Region2 -4.23 2.4 -8.91 0.542 -1.76 0.0892 . 0.0884 . 

Region3 5.37 2.4 0.946 10.4 2.24 0.0334 * 0.0351 * 

Group1 5.57 4.19 -2.27 13.8 1.33 0.216 0.236 

Group2 -0.858 4.19 -9.22 7.61 -0.205 0.842 0.868 

Region1:Group1 2.8 3.39 -4.14 9.57 0.827 0.415 0.403 

Region2:Group1 -2.42 3.39 -8.83 3.88 -0.714 0.481 0.474 

Region3:Group1 -0.369 3.39 -7.47 5.99 -0.109 0.914 0.904 

Region1:Group2 3.54 3.39 -2.66 10.3 1.04 0.306 0.322 

Region2:Group2 -3.8 3.39 -11 2.34 -1.12 0.272 0.275 

Region3:Group2 -2.36 3.39 -9.37 4.57 -0.696 0.492 0.487 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 82.3 9.07 4.16 15.5 47.2 0.00228 ** 
R2M / 
R2C 

0.205 / 
0.58 

Residual 92 9.59 6.73 11.6 52.8 NA AIC/BIC 340 / 
367 

Mean Pore Circularity Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 0.636 0.0156 0.604 0.668 40.9 0 
** 
* 

1 

Region1 0.0144 0.00736 
0.00053 

8 
0.029 1.96 0.0607 . 0.06 . 

Region2 -0.0184 0.00736 -0.0328 -0.0038 -2.51 0.0186 * 0.0182 * 

Region3 0.00789 0.00736 
-

0.00571 
0.0233 1.07 0.293 0.298 
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Group1 -0.00207 0.022 -0.0446 0.0398 -0.0941 0.927 0.924 

Group2 -0.0233 0.022 -0.0705 0.0224 -1.06 0.318 0.333 

Region1:Group1 0.00278 0.0104 -0.0185 0.0235 0.267 0.791 0.774 

Region2:Group1 0.0143 0.0104 
-

0.00542 
0.0336 1.37 0.182 0.185 

Region3:Group1 -0.0126 0.0104 -0.0344 0.00691 -1.21 0.236 0.24 

Region1:Group2 -0.00844 0.0104 -0.0275 0.0124 -0.811 0.424 0.42 

Region2:Group2 -0.00871 0.0104 -0.0309 0.0102 -0.837 0.41 0.397 

Region3:Group2 0.0114 0.0104 -0.0101 0.0327 1.1 0.283 0.282 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.00269 0.0518 0.0284 0.0843 75.6 1.6E-07 
** 
* 

R2M / 
R2C 

0.15 / 
0.793 

Residual 0.00087 0.0294 0.0206 0.0355 24.4 NA AIC/BIC 1.64851 
5 

Mean Pore Max Feret 
Diameter (um) Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 40.3 1.18 37.8 42.6 34.1 0 
** 
* 

0.987 

Region1 -1.33 0.982 -3.18 0.616 -1.35 0.187 0.191 

Region2 -1.17 0.982 -3.09 0.781 -1.19 0.243 0.234 

Region3 1.93 0.982 0.111 3.98 1.96 0.0604 . 0.0621 . 

Group1 2.12 1.67 -1.01 5.39 1.27 0.236 0.262 

Group2 -0.6 1.67 -3.91 2.76 -0.359 0.728 0.748 

Region1:Group1 0.964 1.39 -1.88 3.73 0.693 0.494 0.485 

Region2:Group1 -1.17 1.39 -3.8 1.41 -0.844 0.406 0.395 

Region3:Group1 0.245 1.39 -2.67 2.85 0.176 0.861 0.872 

Region1:Group2 1.55 1.39 -0.987 4.34 1.12 0.274 0.285 

Region2:Group2 -1.57 1.39 -4.53 0.951 -1.13 0.269 0.273 

Region3:Group2 -1.06 1.39 -3.94 1.78 -0.764 0.452 0.452 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 12.9 3.59 1.59 6.18 45.5 0.00329 ** 
R2M / 
R2C 

0.185 / 
0.556 

Residual 15.4 3.93 2.76 4.74 54.5 NA AIC/BIC 276 / 
302 

Mean Pore Min Feret 
Diameter (um) Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 19 0.569 17.8 20.1 33.4 0 
** 
* 

0.984 

Region1 0.189 0.466 -0.688 1.11 0.407 0.687 0.678 

Region2 -1.41 0.466 -2.32 -0.481 -3.02 0.00544 ** 0.00702 ** 

Region3 0.898 0.466 0.0372 1.87 1.93 0.0645 . 0.0653 . 

Group1 1.2 0.805 -0.307 2.77 1.49 0.17 0.185 

Group2 -0.521 0.805 -2.12 1.1 -0.647 0.533 0.556 
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Region1:Group1 0.515 0.659 -0.834 1.83 0.782 0.441 0.434 

Region2:Group1 0.0215 0.659 -1.22 1.24 0.0326 0.974 0.973 

Region3:Group1 -0.278 0.659 -1.66 0.957 -0.422 0.676 0.669 

Region1:Group2 0.569 0.659 -0.635 1.89 0.863 0.396 0.402 

Region2:Group2 -0.904 0.659 -2.31 0.29 -1.37 0.181 0.178 

Region3:Group2 -0.334 0.659 -1.7 1.01 -0.506 0.617 0.617 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 3.02 1.74 0.782 2.98 46.5 0.00266 ** 
R2M / 
R2C 

0.224 / 
0.585 

Residual 3.47 1.86 1.31 2.25 53.5 NA AIC/BIC 222 / 
248 

Mean Pore Aspect 
Ratio 

Lambda = -2.65 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) -0.1 0.00742 -0.114 -0.0849 -13.5 3E-07 
** 
* 

0.993 

Region1 -0.0153 0.00478 -0.0241 -0.0055 -3.2 0.00348 ** 0.00491 ** 

Region2 0.0168 0.00478 0.00749 0.0262 3.53 0.00153 ** 0.00105 ** 

Region3 -0.00428 0.00478 -0.0137 0.00594 -0.896 0.378 0.38 

Group1 0.00233 0.0105 -0.0167 0.0228 0.222 0.829 0.861 

Group2 0.00703 0.0105 -0.0142 0.0283 0.67 0.52 0.526 

Region1:Group1 0.000919 0.00676 -0.0117 0.0134 0.136 0.893 0.901 

Region2:Group1 -0.00538 0.00676 -0.0181 0.00642 -0.796 0.433 0.441 

Region3:Group1 0.0037 0.00676 -0.0101 0.016 0.547 0.589 0.61 

Region1:Group2 0.00706 0.00676 
-

0.00706 
0.0199 1.04 0.306 0.323 

Region2:Group2 -0.00271 0.00676 -0.0144 0.011 -0.401 0.692 0.688 

Region3:Group2 -0.00336 0.00676 -0.0154 0.0109 -0.497 0.623 0.627 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.00057 0.0239 0.0129 0.0397 60.6 
6.29E-

05 
** 
* 

R2M / 
R2C 

0.182 / 
0.68 

Residual 0.00037 0.0191 0.0137 0.0229 39.4 NA AIC/BIC 73.3 / 
99.5 

Mean Pore Roundness Lambda = 3.925 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 0.092 0.007 0.0791 0.106 13.1 4E-07 
** 
* 

0.989 

Region1 0.012 0.00455 0.00357 0.0213 2.63 0.0139 * 0.013 * 

Region2 -0.00976 0.00455 -0.0187 -0.00087 -2.14 0.0412 * 0.0382 * 

Region3 0.00496 0.00455 
-

0.00402 
0.0147 1.09 0.286 0.287 

Group1 -0.00171 0.0099 -0.0197 0.0176 -0.172 0.867 0.882 

Group2 -0.00467 0.0099 -0.0247 0.0153 -0.471 0.649 0.652 

Region1:Group1 0.00048 0.00644 -0.0115 0.0124 0.0746 0.941 0.951 

Region2:Group1 0.00782 0.00644 
-

0.00436 
0.0191 1.21 0.236 0.248 
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Region3:Group1 -0.00734 0.00644 -0.0205 0.00441 -1.14 0.264 0.269 

Region1:Group2 -0.00308 0.00644 -0.0165 0.00919 -0.478 0.636 0.629 

Region2:Group2 0.00141 0.00644 
-

0.00971 
0.0145 0.219 0.828 0.843 

Region3:Group2 0.00216 0.00644 
-

0.00928 
0.0157 0.335 0.74 0.729 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.0005 0.0225 0.0121 0.0375 60.2 
7.56E-

05 
** 
* 

R2M / 
R2C 

0.129 / 
0.655 

Residual 0.00033 0.0182 0.0131 0.0219 39.8 NA AIC/BIC 1.56102 
8 

Mean Pore Solidity Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 0.851 0.00781 0.835 0.867 109 0 
** 
* 

1 

Region1 0.00613 0.00356 
-

0.00057 
0.0132 1.72 0.096 . 0.0982 . 

Region2 -0.00629 0.00356 -0.0132 0.000786 -1.77 0.0884 . 0.0874 . 

Region3 0.0018 0.00356 
-

0.00477 
0.00923 0.506 0.617 0.621 

Group1 0.00106 0.011 -0.0203 0.022 0.0957 0.926 0.945 

Group2 -0.0135 0.011 -0.0371 0.00942 -1.22 0.253 0.269 

Region1:Group1 0.000344 0.00503 
-

0.00995 
0.0104 0.0684 0.946 0.925 

Region2:Group1 0.00689 0.00503 
-

0.00262 
0.0162 1.37 0.182 0.186 

Region3:Group1 -0.0025 0.00503 -0.013 0.00693 -0.497 0.623 0.611 

Region1:Group2 -0.00209 0.00503 -0.0113 0.00799 -0.416 0.68 0.679 

Region2:Group2 -0.00595 0.00503 -0.0167 0.00316 -1.18 0.247 0.249 

Region3:Group2 0.00581 0.00503 
-

0.00458 
0.0161 1.16 0.258 0.253 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.00068 0.0261 0.0143 0.0423 77.3 
7.19E-

08 
** 
* 

R2M / 
R2C 

0.146 / 
0.804 

Residual 0.0002 0.0142 0.00998 0.0171 22.7 NA AIC/BIC 1.28121 
6 

Total Osteon Count 
(T.On) Lambda = 0.525 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 7.56 0.263 7.04 8.1 28.7 0 
** 
* 

0.998 

Region1 0.959 0.384 0.25 1.75 2.5 0.019 * 0.0165 * 

Region2 -2.21 0.384 -2.97 -1.46 -5.76 
0.00000 

4 
** 
* 

0.000175 *** 

Region3 -0.314 0.384 -1.07 0.509 -0.816 0.422 0.42 

Group1 -0.388 0.372 -1.11 0.31 -1.04 0.324 0.359 

Group2 -0.749 0.372 -1.48 0.009 -2.01 0.0749 . 0.0902 . 

Region1:Group1 0.376 0.543 -0.638 1.38 0.693 0.494 0.502 

Region2:Group1 0.393 0.543 -0.634 1.34 0.724 0.475 0.491 
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Region3:Group1 -0.516 0.543 -1.63 0.475 -0.95 0.351 0.353 

Region1:Group2 0.38 0.543 -0.755 1.42 0.699 0.49 0.515 

Region2:Group2 -0.758 0.543 -1.7 0.342 -1.4 0.174 0.177 

Region3:Group2 0.469 0.543 -0.495 1.61 0.864 0.395 0.398 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.24 0.489 0 1.27 9.2 0.521 
R2M / 
R2C 

0.538 / 
0.58 

Residual 2.36 1.54 1.1 1.82 90.8 NA AIC/BIC 380 / 
406 

Complete Osteon 
Count (C.On) Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 24.1 1.55 21.3 27 15.6 1E-07 
** 
* 

0.998 

Region1 5.92 2.59 1.04 11 2.28 0.0304 * 0.026 * 

Region2 -12.5 2.59 -17.6 -7.35 -4.83 
4.86E-

05 
** 
* 

0.000175 *** 

Region3 -1.83 2.59 -6.62 3.58 -0.708 0.485 0.481 

Group1 -2.15 2.19 -6.1 1.88 -0.98 0.353 0.4 

Group2 -4.15 2.19 -8.23 0.357 -1.89 0.0908 . 0.116 

Region1:Group1 4.65 3.66 -2.86 12 1.27 0.215 0.192 

Region2:Group1 0.562 3.66 -6.36 7.37 0.154 0.879 0.875 

Region3:Group1 -2.6 3.66 -10.3 4.26 -0.711 0.483 0.461 

Region1:Group2 0.646 3.66 -6.05 8 0.176 0.861 0.86 

Region2:Group2 -1.94 3.66 -9.74 4.7 -0.529 0.601 0.582 

Region3:Group2 0.896 3.66 -6.68 8.38 0.245 0.809 0.805 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 1.92 1.39 0 7.57 1.76 0.898 
R2M / 
R2C 

0.466 / 
0.475 

Residual 107 10.4 7.27 12.3 98.2 NA AIC/BIC 333 / 
359 

Forming Osteon 
Count (F.On) Lambda = 0.25 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 2.21 0.0427 2.12 2.29 51.6 0 
** 
* 

1 

Region1 0.124 0.0494 0.0326 0.225 2.51 0.0185 * 0.0193 * 

Region2 -0.298 0.0494 -0.394 -0.201 -6.03 
0.00000 

2 
** 
* 

0.000175 *** 

Region3 -0.054 0.0494 -0.151 0.0517 -1.09 0.284 0.29 

Group1 -0.0628 0.0604 -0.18 0.0595 -1.04 0.326 0.344 

Group2 -0.0953 0.0604 -0.21 0.0322 -1.58 0.149 0.153 

Region1:Group1 -0.00384 0.0698 -0.134 0.125 -0.055 0.957 0.951 

Region2:Group1 0.0963 0.0698 -0.0357 0.218 1.38 0.179 0.2 

Region3:Group1 -0.0816 0.0698 -0.224 0.0458 -1.17 0.253 0.259 

Region1:Group2 0.0655 0.0698 -0.0804 0.198 0.938 0.357 0.382 
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Region2:Group2 -0.135 0.0698 -0.255 0.00661 -1.93 0.0642 . 0.0649 . 

Region3:Group2 0.109 0.0698 -0.0146 0.256 1.57 0.129 0.129 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.0122 0.11 0 0.218 23.8 0.115 
R2M / 
R2C 

0.534 / 
0.645 

Residual 0.039 0.197 0.142 0.236 76.2 NA AIC/BIC 336 / 
363 

Single-Labeled 
Osteon Count (sL.On) Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 9.23 1.28 6.57 11.8 7.19 
5.15E-

05 
** 
* 

0.992 

Region1 3.44 1.27 1.04 5.96 2.7 0.0117 * 0.014 * 

Region2 -4.31 1.27 -6.8 -1.78 -3.39 0.00215 ** 0.00316 ** 

Region3 -1.4 1.27 -3.74 1.26 -1.1 0.282 0.289 

Group1 -2.42 1.82 -5.85 1.21 -1.33 0.216 0.243 

Group2 0.208 1.82 -3.32 3.84 0.115 0.911 0.919 

Region1:Group1 0.75 1.8 -2.93 4.34 0.417 0.68 0.667 

Region2:Group1 2.25 1.8 -1.15 5.59 1.25 0.221 0.224 

Region3:Group1 -2.92 1.8 -6.68 0.455 -1.62 0.116 0.116 

Region1:Group2 0.125 1.8 -3.16 3.73 0.0695 0.945 0.953 

Region2:Group2 -2.12 1.8 -5.95 1.13 -1.18 0.248 0.252 

Region3:Group2 3.71 1.8 -0.0101 7.38 2.06 0.0489 * 0.0488 * 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 13.3 3.65 1.17 6.54 34 0.027 * 
R2M / 
R2C 

0.298 / 
0.537 

Residual 25.9 5.09 3.57 6.12 66 NA AIC/BIC 291 / 
317 

Double-Labeled 
Osteon Count 

(dL.On) 
Lambda = 0.8 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 7.77 0.432 6.98 8.7 18 0 
** 
* 

0.981 

Region1 1.2 0.749 -0.183 2.74 1.6 0.118 0.116 

Region2 -3.61 0.749 -5.08 -2.15 -4.82 
2.61E-

05 
** 
* 

0.000175 *** 

Region3 -0.261 0.749 -1.74 1.34 -0.348 0.73 0.728 

Group1 0.05 0.612 -1.13 1.14 0.0817 0.935 0.965 

Group2 -2 0.612 -3.26 -0.789 -3.27 0.0024 ** 0.0126 * 

Region1:Group1 1.62 1.06 -0.358 3.58 1.53 0.135 0.122 

Region2:Group1 -0.741 1.06 -2.74 1.11 -0.699 0.489 0.494 

Region3:Group1 0.221 1.06 -1.94 2.15 0.208 0.836 0.85 

Region1:Group2 0.298 1.06 -1.92 2.32 0.281 0.78 0.788 

Region2:Group2 -0.285 1.06 -2.11 1.86 -0.269 0.789 0.775 

Region3:Group2 -1.13 1.06 -3.01 1.1 -1.06 0.294 0.293 
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Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0 0 0 2.1 0 1 
R2M / 
R2C 

0.508 / 
0.508 

Residual 8.98 3 2.15 3.53 100 NA AIC/BIC 296 / 
323 

Triple-Labeled 
Osteon Count (tL.On) Lambda = 0.55 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 0.852 0.136 0.582 1.13 6.27 
0.00014 

6 
** 
* 

0.981 

Region1 -0.0272 0.206 -0.408 0.396 -0.132 0.896 0.877 

Region2 -0.435 0.206 -0.839 -0.0319 -2.11 0.0445 * 0.0379 * 

Region3 0.0849 0.206 -0.322 0.527 0.411 0.684 0.686 

Group1 0.175 0.192 -0.191 0.533 0.911 0.386 0.418 

Group2 -0.338 0.192 -0.722 0.0422 -1.76 0.112 0.134 

Region1:Group1 0.322 0.292 -0.223 0.863 1.1 0.279 0.271 

Region2:Group1 -0.0917 0.292 -0.643 0.418 -0.314 0.756 0.756 

Region3:Group1 -0.14 0.292 -0.736 0.393 -0.479 0.636 0.635 

Region1:Group2 0.0496 0.292 -0.56 0.606 0.17 0.866 0.881 

Region2:Group2 0.172 0.292 -0.332 0.763 0.588 0.562 0.569 

Region3:Group2 -0.232 0.292 -0.751 0.382 -0.796 0.433 0.437 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.0511 0.226 0 0.653 6.97 0.623 
R2M / 
R2C 

0.205 / 
0.26 

Residual 0.682 0.826 0.591 0.975 93 NA AIC/BIC 200 / 
226 

dL.On Mean Inner 
Label (um) Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 24.5 1.43 21.6 27.3 17.2 0 
** 
* 

0.992 

Region1 0.8 1.11 -1.3 3.01 0.718 0.479 0.466 

Region2 -1.3 1.11 -3.48 0.91 -1.17 0.252 0.243 

Region3 0.198 1.11 -1.86 2.52 0.177 0.86 0.855 

Group1 1.54 2.02 -2.25 5.49 0.761 0.466 0.505 

Group2 -1.77 2.02 -5.84 2.36 -0.876 0.404 0.449 

Region1:Group1 -1.73 1.57 -4.96 1.41 -1.1 0.281 0.28 

Region2:Group1 -0.669 1.57 -3.65 2.26 -0.425 0.674 0.669 

Region3:Group1 1.53 1.57 -1.77 4.48 0.973 0.339 0.333 

Region1:Group2 2.23 1.57 -0.642 5.39 1.42 0.167 0.175 

Region2:Group2 -1.05 1.57 -4.41 1.8 -0.67 0.509 0.5 

Region3:Group2 0.154 1.57 -3.1 3.37 0.0978 0.923 0.92 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 19.5 4.42 2.09 7.52 49.6 0.00134 ** 
R2M / 
R2C 

0.0982 / 
0.545 
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Residual 19.8 4.45 3.12 5.37 50.4 NA AIC/BIC 286 / 
312 

tL.On Mean Inner 
Label (um) Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 12 2.09 7.86 16.2 5.76 
0.00027 

4 
** 
* 

0.999 

Region1 -1.51 2.89 -6.96 4.22 -0.523 0.605 0.604 

Region2 -5.85 2.89 -11.5 -0.098 -2.02 0.0531 . 0.0502 . 

Region3 0.771 2.89 -4.57 6.81 0.267 0.792 0.793 

Group1 2.01 2.96 -3.67 7.86 0.678 0.515 0.54 

Group2 -5.97 2.96 -11.9 0.0196 -2.02 0.0744 . 0.08 . 

Region1:Group1 3.61 4.09 -4.77 11.8 0.882 0.386 0.371 

Region2:Group1 -0.54 4.09 -8.27 7.05 -0.132 0.896 0.898 

Region3:Group1 -4.5 4.09 -13.1 3.16 -1.1 0.281 0.287 

Region1:Group2 -0.284 4.09 -7.75 7.92 -0.0695 0.945 0.945 

Region2:Group2 3.78 4.09 -4.92 11.2 0.924 0.363 0.371 

Region3:Group2 0.951 4.09 -7.5 9.3 0.233 0.818 0.818 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 19.1 4.37 0 10.2 12.5 0.389 
R2M / 
R2C 

0.243 / 
0.338 

Residual 134 11.6 8.11 13.9 87.5 NA AIC/BIC 344 / 
370 

tL.On Mean Outer 
Label (um) Lambda = 1.45 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 108 16.4 75.2 142 6.57 
0.00010 

3 
** 
* 

0.974 

Region1 -18.5 27 -68.3 36.8 -0.687 0.498 0.495 

Region2 -32.1 27 -85 20.6 -1.19 0.244 0.237 

Region3 23.5 27 -29.7 81.2 0.87 0.392 0.368 

Group1 18.9 23.2 -25.5 62.3 0.813 0.437 0.495 

Group2 -62.9 23.2 -109 -17.8 -2.71 0.0241 * 0.027 * 

Region1:Group1 33.1 38.1 -38.2 104 0.867 0.394 0.393 

Region2:Group1 24.8 38.1 -47.2 91.4 0.651 0.52 0.527 

Region3:Group1 -27.6 38.1 -105 42 -0.723 0.476 0.466 

Region1:Group2 6.78 38.1 -72.9 79.4 0.178 0.86 0.873 

Region2:Group2 2.47 38.1 -63.4 79.7 0.0647 0.949 0.963 

Region3:Group2 -10.7 38.1 -78.4 69.5 -0.281 0.781 0.773 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 325 18 0 78.7 2.72 0.844 
R2M / 
R2C 

0.226 / 
0.248 

Residual 11600 108 76.7 127 97.3 NA AIC/BIC 378 / 
404 

Combined Mean 
Inner Label (um) Lambda = None 
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Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 23.4 1.45 20.4 26.4 16.1 1E-07 
** 
* 

0.992 

Region1 0.903 1.35 -1.64 3.58 0.668 0.51 0.501 

Region2 -2.05 1.35 -4.69 0.641 -1.52 0.141 0.15 

Region3 -0.0422 1.35 -2.54 2.78 -0.0312 0.975 0.987 

Group1 1.34 2.06 -2.56 5.43 0.652 0.531 0.55 

Group2 -1.36 2.06 -5.35 2.75 -0.659 0.526 0.554 

Region1:Group1 -2.41 1.91 -6.33 1.4 -1.26 0.218 0.221 

Region2:Group1 -0.782 1.91 -4.4 2.77 -0.409 0.686 0.684 

Region3:Group1 0.65 1.91 -3.36 4.24 0.34 0.736 0.74 

Region1:Group2 2.77 1.91 -0.723 6.61 1.45 0.159 0.173 

Region2:Group2 -0.165 1.91 -4.24 3.3 -0.0864 0.932 0.929 

Region3:Group2 0.912 1.91 -3.04 4.82 0.477 0.637 0.645 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 18 4.25 1.62 7.48 38.2 0.0134 * 
R2M / 
R2C 

0.115 / 
0.453 

Residual 29.2 5.41 3.79 6.51 61.8 NA AIC/BIC 297 / 
323 

Combined Mean 
Label (um) Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 25.9 1.38 23 28.6 18.7 0 
** 
* 

0.998 

Region1 0.424 1.44 -2.29 3.28 0.294 0.771 0.768 

Region2 -2.33 1.44 -5.15 0.539 -1.62 0.118 0.122 

Region3 0.71 1.44 -1.95 3.73 0.492 0.626 0.633 

Group1 1.72 1.95 -1.96 5.61 0.882 0.4 0.409 

Group2 -2.98 1.95 -6.75 0.929 -1.53 0.161 0.175 

Region1:Group1 -1.75 2.04 -5.93 2.32 -0.857 0.399 0.411 

Region2:Group1 0.577 2.04 -3.28 4.37 0.283 0.779 0.775 

Region3:Group1 0.0894 2.04 -4.18 3.91 0.0438 0.965 0.973 

Region1:Group2 3.34 2.04 -0.39 7.43 1.64 0.113 0.122 

Region2:Group2 -0.875 2.04 -5.22 2.82 -0.429 0.671 0.662 

Region3:Group2 0.16 2.04 -4.06 4.33 0.0785 0.938 0.938 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 14.6 3.82 0.686 7 30.5 0.0462 * 
R2M / 
R2C 

0.157 / 
0.414 

Residual 33.3 5.77 4.05 6.94 69.5 NA AIC/BIC 299 / 
325 

C.On Mean Wall 
Thickness (W.Th.C) 

(um) 
Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 
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(Intercept) 35.6 2.01 31.4 39.5 17.7 0 
** 
* 

0.988 

Region1 -1.78 1.42 -4.45 1.03 -1.26 0.22 0.223 

Region2 -1.56 1.42 -4.33 1.26 -1.1 0.281 0.273 

Region3 1.4 1.42 -1.21 4.36 0.99 0.331 0.334 

Group1 -0.771 2.85 -6.1 4.66 -0.271 0.792 0.805 

Group2 0.502 2.85 -5.35 6.45 0.177 0.864 0.877 

Region1:Group1 2.74 2 -1.37 6.73 1.37 0.183 0.174 

Region2:Group1 -4.31 2 -8.1 -0.585 -2.15 0.0407 * 0.0347 * 

Region3:Group1 2.9 2 -1.3 6.66 1.45 0.159 0.156 

Region1:Group2 2.05 2 -1.61 6.07 1.02 0.315 0.324 

Region2:Group2 2.8 2 -1.46 6.44 1.4 0.173 0.178 

Region3:Group2 -5.28 2 -9.42 -1.19 -2.63 0.0138 * 0.0123 * 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 40.5 6.37 3.13 10.7 55.8 
0.00028 

1 
** 
* 

R2M / 
R2C 

0.146 / 
0.622 

Residual 32.1 5.67 3.98 6.83 44.2 NA AIC/BIC 305 / 
331 

sL.On Mean Wall 
Thickness (W.Th.sL) 

(um) 
Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 27.1 2.21 22.5 31.6 12.3 6E-07 
** 
* 

0.998 

Region1 -1.68 2.05 -5.53 2.37 -0.822 0.418 0.424 

Region2 -3.51 2.05 -7.51 0.559 -1.72 0.0976 . 0.0996 . 

Region3 0.815 2.05 -2.96 5.09 0.399 0.693 0.699 

Group1 0.555 3.12 -5.36 6.76 0.178 0.863 0.888 

Group2 -3.18 3.12 -9.25 3.06 -1.02 0.335 0.364 

Region1:Group1 -0.79 2.89 -6.72 4.98 -0.273 0.787 0.8 

Region2:Group1 4.6 2.89 -0.867 9.98 1.59 0.123 0.123 

Region3:Group1 -1.41 2.89 -7.47 4.01 -0.488 0.629 0.619 

Region1:Group2 7.38 2.89 2.1 13.2 2.55 0.0167 * 0.0158 * 

Region2:Group2 -7.6 2.89 -13.8 -2.36 -2.63 0.014 * 0.013 * 

Region3:Group2 -2.95 2.89 -8.93 2.96 -1.02 0.317 0.317 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 41.7 6.46 2.48 11.4 38.4 0.013 * 
R2M / 
R2C 

0.242 / 
0.533 

Residual 66.9 8.18 5.74 9.85 61.6 NA AIC/BIC 326 / 
353 

dL.On Mean Wall 
Thickness (W.Th.dL) 

(um) 
Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 38.9 1.93 34.8 42.6 20.1 0 
** 
* 

0.989 
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Region1 -0.389 1.4 -3.02 2.38 -0.279 0.782 0.775 

Region2 -2.64 1.4 -5.36 0.141 -1.89 0.0698 . 0.0698 . 

Region3 1.25 1.4 -1.33 4.17 0.895 0.379 0.385 

Group1 -1.99 2.73 -7.1 3.28 -0.73 0.484 0.516 

Group2 2.55 2.73 -3.04 8.23 0.935 0.374 0.403 

Region1:Group1 2.66 1.97 -1.38 6.6 1.35 0.189 0.176 

Region2:Group1 -4.79 1.97 -8.53 -1.13 -2.43 0.0221 * 0.02 * 

Region3:Group1 1.88 1.97 -2.26 5.58 0.95 0.35 0.347 

Region1:Group2 -0.234 1.97 -3.84 3.73 -0.118 0.907 0.909 

Region2:Group2 2.88 1.97 -1.32 6.46 1.46 0.155 0.161 

Region3:Group2 -2.01 1.97 -6.09 2.03 -1.02 0.319 0.317 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 36.9 6.07 2.98 10.2 54.2 
0.00043 

2 
** 
* 

R2M / 
R2C 

0.144 / 
0.608 

Residual 31.2 5.58 3.92 6.73 45.8 NA AIC/BIC 303 / 
330 

tL.On Mean Wall 
Thickness (W.Th.tL) 

(um) 
Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 25.9 4.23 17.2 34.1 6.12 
0.00017 

6 
** 
* 

0.992 

Region1 -1.62 5.52 -12 9.31 -0.294 0.771 0.766 

Region2 -9.12 5.52 -19.9 1.85 -1.65 0.11 0.114 

Region3 6.34 5.52 -3.85 17.9 1.15 0.26 0.267 

Group1 -0.695 5.98 -12.3 11.3 -0.116 0.91 0.915 

Group2 -11.5 5.98 -23.2 0.43 -1.92 0.0868 . 0.0923 . 

Region1:Group1 13.6 7.8 -2.42 29.1 1.74 0.0935 . 0.0804 . 

Region2:Group1 -1.48 7.8 -16.2 13 -0.19 0.851 0.848 

Region3:Group1 -4.33 7.8 -20.7 10.3 -0.555 0.583 0.571 

Region1:Group2 1.62 7.8 -12.6 17.3 0.208 0.837 0.845 

Region2:Group2 2.79 7.8 -13.8 16.9 0.358 0.723 0.741 

Region3:Group2 -8.6 7.8 -24.7 7.34 -1.1 0.28 0.278 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 92.8 9.63 0 20.8 16 0.277 
R2M / 
R2C 

0.256 / 
0.375 

Residual 487 22.1 15.5 26.6 84 NA AIC/BIC 392 / 
418 

T.On Mean Area 
(um^2) Lambda = 0.175 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 4.7 0.0693 4.56 4.84 67.8 0 
** 
* 

0.985 

Region1 0.0144 0.0739 -0.122 0.166 0.195 0.847 0.863 

Region2 -0.273 0.0739 -0.418 -0.129 -3.69 
0.00098 

9 
** 
* 

0.00105 ** 
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Region3 0.134 0.0739 -0.012 0.292 1.81 0.0816 . 0.0849 . 

Group1 0.223 0.098 0.0397 0.418 2.28 0.0486 * 0.0604 . 

Group2 -0.165 0.098 -0.351 0.0466 -1.68 0.127 0.141 

Region1:Group1 0.15 0.105 -0.0453 0.344 1.43 0.163 0.158 

Region2:Group1 -0.147 0.105 -0.344 0.0359 -1.4 0.172 0.178 

Region3:Group1 0.0469 0.105 -0.167 0.238 0.449 0.657 0.681 

Region1:Group2 0.0741 0.105 -0.144 0.273 0.709 0.484 0.516 

Region2:Group2 -0.089 0.105 -0.27 0.123 -0.851 0.402 0.419 

Region3:Group2 -0.0789 0.105 -0.265 0.141 -0.755 0.457 0.469 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.0357 0.189 0.0268 0.358 29 0.0573 . R2M / 
R2C 

0.365 / 
0.549 

Residual 0.0874 0.296 0.212 0.354 71 NA AIC/BIC 744 / 
771 

T.On Mean 
Circularity 

Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 0.732 0.00898 0.714 0.75 81.5 0 
** 
* 

0.993 

Region1 0.00576 0.00968 -0.0125 0.0249 0.596 0.556 0.549 

Region2 0.0282 0.00968 0.00934 0.0475 2.92 0.007 ** 0.00737 ** 

Region3 -0.0195 0.00968 -0.0374 0.000713 -2.02 0.0538 . 0.0604 . 

Group1 -0.0115 0.0127 -0.0354 0.0137 -0.908 0.388 0.42 

Group2 0.0145 0.0127 -0.0101 0.0396 1.14 0.283 0.302 

Region1:Group1 -0.0135 0.0137 -0.0415 0.0138 -0.983 0.334 0.34 

Region2:Group1 0.0171 0.0137 
-

0.00878 
0.0425 1.25 0.222 0.22 

Region3:Group1 -0.0145 0.0137 -0.0432 0.0112 -1.06 0.3 0.309 

Region1:Group2 0.00484 0.0137 -0.0202 0.0323 0.354 0.726 0.735 

Region2:Group2 -0.00317 0.0137 -0.0323 0.0216 -0.231 0.819 0.808 

Region3:Group2 0.0131 0.0137 -0.0152 0.0411 0.959 0.346 0.36 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.00059 0.0244 
0.00072 

8 
0.0454 28.2 0.0626 . R2M / 

R2C 
0.226 / 
0.446 

Residual 0.0015 0.0387 0.0272 0.0466 71.8 NA AIC/BIC 1.73802 
8 

T.On Mean Aspect 
Ratio 

Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 1.73 0.0371 1.65 1.8 46.6 0 
** 
* 

0.993 

Region1 -0.0514 0.0357 -0.119 0.0195 -1.44 0.162 0.167 

Region2 -0.0265 0.0357 -0.0964 0.0446 -0.742 0.465 0.452 

Region3 0.0475 0.0357 -0.0186 0.122 1.33 0.195 0.2 

Group1 0.0136 0.0524 -0.0856 0.118 0.259 0.801 0.821 
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Group2 -0.0168 0.0524 -0.119 0.0877 -0.32 0.756 0.763 

Region1:Group1 -0.0342 0.0506 -0.138 0.0667 -0.676 0.505 0.525 

Region2:Group1 -0.0216 0.0506 -0.117 0.0723 -0.427 0.673 0.671 

Region3:Group1 0.0799 0.0506 -0.026 0.175 1.58 0.126 0.129 

Region1:Group2 0.0176 0.0506 -0.0748 0.119 0.348 0.73 0.74 

Region2:Group2 -0.0589 0.0506 -0.167 0.0328 -1.16 0.254 0.259 

Region3:Group2 -0.0012 0.0506 -0.106 0.102 -0.0236 0.981 0.978 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.0114 0.107 0.0385 0.189 35.7 0.0204 * 
R2M / 
R2C 

0.116 / 
0.432 

Residual 0.0204 0.143 0.1 0.172 64.3 NA AIC/BIC 34.4 / 
60.6 

T.On Mean 
Roundness 

Lambda = -2.475 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) -2.88 0.0792 -3.04 -2.72 -36.4 0 
** 
* 

0.995 

Region1 0.138 0.0935 -0.0343 0.33 1.48 0.151 0.163 

Region2 0.1 0.0935 -0.083 0.283 1.07 0.293 0.285 

Region3 -0.188 0.0935 -0.372 0.0125 -2.01 0.0549 . 0.0579 . 

Group1 -0.0563 0.112 -0.272 0.169 -0.503 0.627 0.618 

Group2 0.077 0.112 -0.136 0.311 0.687 0.509 0.515 

Region1:Group1 0.0981 0.132 -0.149 0.343 0.742 0.465 0.478 

Region2:Group1 0.0648 0.132 -0.185 0.296 0.49 0.628 0.645 

Region3:Group1 -0.17 0.132 -0.441 0.071 -1.29 0.209 0.218 

Region1:Group2 -0.0233 0.132 -0.3 0.229 -0.176 0.862 0.845 

Region2:Group2 0.14 0.132 -0.0884 0.408 1.06 0.299 0.303 

Region3:Group2 -0.0503 0.132 -0.285 0.228 -0.38 0.707 0.704 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.0403 0.201 0 0.402 22.4 0.137 
R2M / 
R2C 

0.162 / 
0.349 

Residual 0.14 0.374 0.269 0.448 77.6 NA AIC/BIC 1.64215 
7 

T.On Mean Solidity Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 0.931 0.00443 0.922 0.94 210 0 
** 
* 

0.993 

Region1 0.00174 0.00413 
-

0.00604 
0.00993 0.422 0.677 0.668 

Region2 0.0127 0.00413 0.00462 0.0209 3.07 0.00482 ** 0.00526 ** 

Region3 -0.00894 0.00413 -0.0166 -0.0003 -2.16 0.0395 * 0.046 * 

Group1 -0.00035 0.00627 -0.0122 0.0121 -0.0562 0.956 0.965 

Group2 0.00129 0.00627 -0.0109 0.0138 0.205 0.842 0.847 

Region1:Group1 -0.00525 0.00584 -0.0172 0.00641 -0.898 0.377 0.381 
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Region2:Group1 0.00338 0.00584 
-

0.00767 
0.0142 0.578 0.568 0.564 

Region3:Group1 -0.00019 0.00584 -0.0124 0.0108 -0.0324 0.974 0.971 

Region1:Group2 0.00561 0.00584 
-

0.00506 
0.0173 0.961 0.345 0.355 

Region2:Group2 -0.00239 0.00584 -0.0148 0.00821 -0.408 0.686 0.677 

Region3:Group2 0.00147 0.00584 -0.0106 0.0134 0.252 0.803 0.803 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.00017 0.0129 0.00493 0.0228 38.6 0.0138 * 
R2M / 
R2C 

0.155 / 
0.476 

Residual 0.00027 0.0165 0.0116 0.0199 61.4 NA AIC/BIC 1.27523 
9 

C.On Mean Area 
(um^2) Lambda = 0.35 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 26.9 0.7 25.6 28.3 38.4 0 
** 
* 

1 

Region1 -0.451 0.577 -1.52 0.733 -0.781 0.442 0.448 

Region2 -2.08 0.577 -3.21 -0.947 -3.59 0.00128 ** 0.00105 ** 

Region3 1.47 0.577 0.336 2.71 2.55 0.0166 * 0.0165 * 

Group1 2.01 0.989 0.17 3.94 2.03 0.0724 . 0.0835 . 

Group2 -1.1 0.989 -3.04 0.89 -1.11 0.297 0.329 

Region1:Group1 1.05 0.817 -0.477 2.56 1.28 0.21 0.203 

Region2:Group1 -1.53 0.817 -3.08 -0.109 -1.88 0.0711 . 0.0754 . 

Region3:Group1 0.601 0.817 -1.07 2.09 0.736 0.468 0.484 

Region1:Group2 0.784 0.817 -0.922 2.34 0.96 0.346 0.366 

Region2:Group2 0.0883 0.817 -1.32 1.74 0.108 0.915 0.93 

Region3:Group2 -0.724 0.817 -2.17 0.993 -0.887 0.383 0.405 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 4.54 2.13 1.01 3.68 46 0.00297 ** 
R2M / 
R2C 

0.334 / 
0.64 

Residual 5.33 2.31 1.66 2.77 54 NA AIC/BIC 756 / 
782 

C.On Mean 
Circularity 

Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 0.708 0.0101 0.688 0.728 70.4 0 
** 
* 

0.997 

Region1 -0.00561 0.0126 -0.0294 0.0194 -0.445 0.66 0.659 

Region2 0.0407 0.0126 0.0161 0.0658 3.23 0.00326 ** 0.00351 ** 

Region3 -0.0234 0.0126 -0.0467 0.00295 -1.86 0.0744 . 0.0853 . 

Group1 -0.0249 0.0142 -0.0519 0.00396 -1.75 0.115 0.132 

Group2 0.0222 0.0142 -0.0054 0.0506 1.56 0.154 0.165 

Region1:Group1 -0.0113 0.0178 -0.0479 0.0243 -0.635 0.531 0.551 

Region2:Group1 0.0119 0.0178 -0.0218 0.045 0.667 0.511 0.508 

Region3:Group1 0.00175 0.0178 -0.0356 0.0352 0.098 0.923 0.931 
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Region1:Group2 0.0045 0.0178 -0.0281 0.0403 0.252 0.803 0.804 

Region2:Group2 0.00483 0.0178 -0.0332 0.0372 0.271 0.789 0.815 

Region3:Group2 -0.0132 0.0178 -0.0501 0.0232 -0.741 0.465 0.463 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.00058 0.024 0 0.0498 18.5 0.213 
R2M / 
R2C 

0.255 / 
0.393 

Residual 0.00255 0.0505 0.0354 0.0607 81.5 NA AIC/BIC 2.37172 
8 

C.On Mean Aspect 
Ratio 

Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 1.61 0.0252 1.57 1.66 64 0 
** 
* 

0.999 

Region1 0.0254 0.0437 -0.0569 0.112 0.582 0.564 0.55 

Region2 -0.0573 0.0437 -0.143 0.0297 -1.31 0.198 0.192 

Region3 0.0542 0.0437 -0.0266 0.146 1.24 0.223 0.224 

Group1 0.0172 0.0357 -0.0504 0.0835 0.481 0.633 0.68 

Group2 0.0109 0.0357 -0.0544 0.0814 0.306 0.761 0.771 

Region1:Group1 0.00589 0.0618 -0.121 0.129 0.0953 0.925 0.902 

Region2:Group1 -0.0504 0.0618 -0.167 0.0644 -0.816 0.42 0.402 

Region3:Group1 -0.0228 0.0618 -0.152 0.0931 -0.37 0.714 0.694 

Region1:Group2 -0.00619 0.0618 -0.119 0.118 -0.1 0.921 0.921 

Region2:Group2 -0.0485 0.0618 -0.18 0.0636 -0.784 0.438 0.42 

Region3:Group2 0.109 0.0618 -0.0186 0.235 1.77 0.0856 . 0.0811 . 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0 0 0 0.126 0 1 
R2M / 
R2C 

0.162 / 
0.162 

Residual 0.0306 0.175 0.123 0.208 100 NA AIC/BIC 38.3 / 
64.5 

C.On Mean 
Roundness 

Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 0.669 0.00783 0.655 0.685 85.5 0 
** 
* 

0.996 

Region1 -0.00307 0.0136 -0.0286 0.0238 -0.226 0.822 0.81 

Region2 0.0113 0.0136 -0.0152 0.0383 0.836 0.408 0.401 

Region3 -0.0177 0.0136 -0.0427 0.0107 -1.3 0.201 0.207 

Group1 -0.00762 0.0111 -0.0286 0.013 -0.688 0.496 0.553 

Group2 0.00427 0.0111 -0.016 0.0261 0.386 0.702 0.73 

Region1:Group1 0.00213 0.0192 -0.0372 0.0404 0.111 0.912 0.889 

Region2:Group1 0.0121 0.0192 -0.0241 0.0478 0.633 0.531 0.525 

Region3:Group1 0.0036 0.0192 -0.0366 0.0396 0.188 0.852 0.859 

Region1:Group2 0.0013 0.0192 -0.0338 0.0398 0.0676 0.947 0.953 

Region2:Group2 0.0174 0.0192 -0.0235 0.0522 0.906 0.371 0.378 

Region3:Group2 -0.0359 0.0192 -0.0755 0.00333 -1.87 0.0697 . 0.0681 . 
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Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0 0 0 0.0392 0 1 
R2M / 
R2C 

0.153 / 
0.153 

Residual 0.00294 0.0543 0.0381 0.0645 100 NA AIC/BIC 2.32994 
9 

C.On Mean Solidity Lambda = 4.425 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 0.74 0.0166 0.708 0.774 44.6 0 
** 
* 

0.994 

Region1 -0.0163 0.0191 -0.0516 0.0228 -0.856 0.4 0.402 

Region2 0.0702 0.0191 0.0327 0.107 3.67 0.00104 ** 0.000702 *** 

Region3 -0.0337 0.0191 -0.0714 0.00717 -1.76 0.089 . 0.0968 . 

Group1 -0.0334 0.0235 -0.0787 0.0141 -1.42 0.188 0.203 

Group2 0.0233 0.0235 -0.0213 0.0728 0.992 0.347 0.371 

Region1:Group1 -0.0114 0.027 -0.0619 0.0386 -0.424 0.675 0.683 

Region2:Group1 0.00809 0.027 -0.043 0.0553 0.3 0.767 0.772 

Region3:Group1 0.0167 0.027 -0.0385 0.066 0.618 0.542 0.562 

Region1:Group2 0.0159 0.027 -0.0405 0.0674 0.589 0.561 0.586 

Region2:Group2 0.00255 0.027 -0.0441 0.0572 0.0944 0.925 0.941 

Region3:Group2 -0.0255 0.027 -0.0735 0.0313 -0.945 0.353 0.372 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.00184 0.0429 0 0.0847 24 0.112 
R2M / 
R2C 

0.244 / 
0.425 

Residual 0.00584 0.0764 0.0549 0.0915 76 NA AIC/BIC 1.34289 
4 

F.On Mean Area 
(um^2) Lambda = -0.075 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) -0.557 0.00447 -0.566 -0.548 -125 0 
** 
* 

0.995 

Region1 0.00308 0.00545 
-

0.00698 
0.0143 0.566 0.576 0.585 

Region2 -0.0193 0.00545 -0.03 -0.00866 -3.54 0.00146 ** 0.0014 ** 

Region3 0.00557 0.00545 
-

0.00517 
0.0172 1.02 0.316 0.315 

Group1 0.011 0.00632 
-

0.00119 
0.0236 1.74 0.116 0.124 

Group2 -0.00714 0.00632 -0.0192 0.00579 -1.13 0.288 0.287 

Region1:Group1 0.00945 0.00771 
-

0.00494 
0.0237 1.23 0.231 0.228 

Region2:Group1 -0.0063 0.00771 -0.0209 0.00715 -0.818 0.421 0.436 

Region3:Group1 -0.00054 0.00771 -0.0163 0.0135 -0.0698 0.945 0.933 

Region1:Group2 -0.00726 0.00771 -0.0234 0.00742 -0.942 0.355 0.361 

Region2:Group2 -0.00877 0.00771 -0.0221 0.00683 -1.14 0.265 0.278 

Region3:Group2 0.00978 0.00771 
-

0.00391 
0.026 1.27 0.215 0.225 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 
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Sample 0.00012 0.011 0 0.0225 20 0.174 
R2M / 
R2C 

0.304 / 
0.445 

Residual 0.00048 0.0218 0.0157 0.0261 80 NA AIC/BIC 712 / 
739 

F.On Mean 
Circularity 

Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 0.755 0.00993 0.734 0.774 76.1 0 
** 
* 

0.998 

Region1 0.0187 0.0104 
-

0.00082 
0.0393 1.81 0.0821 . 0.0849 . 

Region2 0.0203 0.0104 
4.91E-

05 
0.0409 1.96 0.0606 . 0.0523 . 

Region3 -0.0199 0.0104 -0.039 0.0018 -1.92 0.0659 . 0.0726 . 

Group1 0.00112 0.014 -0.0253 0.0291 0.0798 0.938 0.935 

Group2 0.00505 0.014 -0.022 0.0331 0.359 0.728 0.745 

Region1:Group1 -0.00492 0.0147 -0.035 0.0243 -0.336 0.74 0.757 

Region2:Group1 0.00767 0.0147 -0.0201 0.0349 0.523 0.605 0.592 

Region3:Group1 -0.0223 0.0147 -0.053 0.00517 -1.52 0.139 0.137 

Region1:Group2 0.00263 0.0147 -0.0242 0.032 0.179 0.859 0.865 

Region2:Group2 0.00547 0.0147 -0.0257 0.0321 0.373 0.712 0.73 

Region3:Group2 0.0219 0.0147 
-

0.00838 
0.0519 1.5 0.146 0.144 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.00075 0.0274 0.00484 0.0503 30.4 0.0466 * 
R2M / 
R2C 

0.205 / 
0.447 

Residual 0.00172 0.0415 0.0291 0.0499 69.6 NA AIC/BIC 1.87333 
3 

F.On Mean Aspect 
Ratio 

Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 1.82 0.0593 1.69 1.94 30.6 0 
** 
* 

0.986 

Region1 -0.12 0.0537 -0.222 -0.0139 -2.24 0.0334 * 0.0312 * 

Region2 -0.0416 0.0537 -0.147 0.0652 -0.775 0.445 0.438 

Region3 0.0686 0.0537 -0.0306 0.181 1.28 0.213 0.218 

Group1 0.0227 0.0839 -0.137 0.189 0.27 0.793 0.808 

Group2 -0.0449 0.0839 -0.209 0.123 -0.535 0.605 0.624 

Region1:Group1 -0.083 0.0759 -0.239 0.0685 -1.09 0.284 0.286 

Region2:Group1 0.0359 0.0759 -0.108 0.177 0.473 0.64 0.631 

Region3:Group1 0.162 0.0759 0.00285 0.304 2.13 0.0422 * 0.0463 * 

Region1:Group2 0.053 0.0759 -0.0858 0.205 0.698 0.491 0.491 

Region2:Group2 -0.144 0.0759 -0.306 -0.00642 -1.9 0.0685 . 0.0632 . 

Region3:Group2 -0.0837 0.0759 -0.241 0.0714 -1.1 0.28 0.284 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.0307 0.175 0.07 0.307 40 0.00971 ** 
R2M / 
R2C 

0.204 / 
0.522 
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Residual 0.0461 0.215 0.151 0.259 60 NA AIC/BIC 64.9 / 
91.1 

F.On Mean 
Roundness 

Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 0.645 0.0108 0.622 0.667 59.5 0 
** 
* 

0.997 

Region1 0.0231 0.0109 0.00259 0.0447 2.12 0.0432 * 0.0446 * 

Region2 0.0191 0.0109 
-

0.00218 
0.0408 1.75 0.0908 . 0.0832 . 

Region3 -0.0228 0.0109 -0.0429 -4.8E-05 -2.09 0.0457 * 0.0498 * 

Group1 -0.0056 0.0153 -0.0346 0.025 -0.365 0.723 0.731 

Group2 0.0129 0.0153 -0.0168 0.0436 0.839 0.423 0.42 

Region1:Group1 0.0185 0.0154 -0.013 0.0492 1.2 0.24 0.234 

Region2:Group1 -0.0171 0.0154 -0.0463 0.0115 -1.11 0.276 0.266 

Region3:Group1 -0.0205 0.0154 -0.0527 0.00842 -1.33 0.195 0.199 

Region1:Group2 -0.0104 0.0154 -0.0385 0.0205 -0.673 0.507 0.505 

Region2:Group2 0.0348 0.0154 0.00205 0.0628 2.26 0.0319 * 0.0302 * 

Region3:Group2 0.00692 0.0154 -0.0249 0.0384 0.45 0.657 0.658 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.00094 0.0306 0.00878 0.0551 33.1 0.0312 * 
R2M / 
R2C 

0.246 / 
0.495 

Residual 0.0019 0.0436 0.0306 0.0524 66.9 NA AIC/BIC 2.01945 
5 

F.On Mean Solidity Lambda = 9.975 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 0.501 0.0241 0.455 0.55 20.8 0 
** 
* 

0.99 

Region1 0.031 0.027 -0.0189 0.0865 1.15 0.261 0.268 

Region2 0.0478 0.027 -0.0052 0.101 1.77 0.0886 . 0.0884 . 

Region3 -0.051 0.027 -0.104 0.00682 -1.89 0.0699 . 0.0775 . 

Group1 0.0322 0.034 -0.0332 0.101 0.945 0.369 0.388 

Group2 -0.00628 0.034 -0.0706 0.0665 -0.185 0.858 0.851 

Region1:Group1 -0.0213 0.0382 -0.0927 0.0496 -0.556 0.583 0.594 

Region2:Group1 0.00897 0.0382 -0.0633 0.0757 0.235 0.816 0.817 

Region3:Group1 -0.0139 0.0382 -0.092 0.0559 -0.363 0.719 0.719 

Region1:Group2 0.0167 0.0382 -0.0632 0.0895 0.437 0.666 0.686 

Region2:Group2 0.0138 0.0382 -0.0523 0.0912 0.36 0.722 0.736 

Region3:Group2 0.0222 0.0382 -0.0457 0.103 0.58 0.567 0.561 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.00402 0.0634 0 0.124 25.6 0.0913 . R2M / 
R2C 

0.153 / 
0.369 

Residual 0.0117 0.108 0.0777 0.129 74.4 NA AIC/BIC 1.33592 
7 

sL.On Mean Area 
(um^2) Lambda = None 
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Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 7830 626 6520 9050 12.5 5E-07 
** 
* 

0.993 

Region1 -314 719 -1670 1110 -0.437 0.666 0.67 

Region2 -2280 719 -3680 -846 -3.17 0.00382 ** 0.00491 ** 

Region3 766 719 -562 2270 1.07 0.296 0.308 

Group1 1480 885 -187 3240 1.67 0.128 0.14 

Group2 -1010 885 -2740 768 -1.14 0.285 0.28 

Region1:Group1 -670 1020 -2750 1360 -0.659 0.516 0.536 

Region2:Group1 354 1020 -1570 2240 0.348 0.73 0.73 

Region3:Group1 1200 1020 -934 3110 1.18 0.249 0.261 

Region1:Group2 2760 1020 903 4800 2.71 0.0114 * 0.0133 * 

Region2:Group2 -1540 1020 -3710 306 -1.51 0.142 0.139 

Region3:Group2 -2340 1020 -4440 -261 -2.3 0.0294 * 0.0291 * 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 2630000 1620 0 3110 24.1 0.11 
R2M / 
R2C 

0.347 / 
0.504 

Residual 8280000 2880 2020 3460 75.9 NA AIC/BIC 745 / 
771 

sL.On Mean 
Circularity 

Lambda = 4.425 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 0.238 0.0212 0.196 0.281 11.2 1.4E-06 
** 
* 

0.978 

Region1 0.00552 0.0309 -0.0515 0.0689 0.179 0.859 0.876 

Region2 0.0131 0.0309 -0.0475 0.0735 0.423 0.675 0.662 

Region3 -0.0139 0.0309 -0.0748 0.0522 -0.45 0.656 0.659 

Group1 -0.00823 0.03 -0.0666 0.0481 -0.274 0.79 0.792 

Group2 -0.0218 0.03 -0.0807 0.0396 -0.727 0.486 0.516 

Region1:Group1 -0.0337 0.0437 -0.115 0.0472 -0.771 0.447 0.459 

Region2:Group1 0.0459 0.0437 -0.0367 0.122 1.05 0.303 0.314 

Region3:Group1 -0.0209 0.0437 -0.11 0.0589 -0.478 0.636 0.641 

Region1:Group2 0.0269 0.0437 -0.0644 0.11 0.616 0.543 0.565 

Region2:Group2 -0.0688 0.0437 -0.144 0.0197 -1.57 0.127 0.132 

Region3:Group2 0.0214 0.0437 -0.0562 0.113 0.49 0.628 0.613 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.00158 0.0398 0 0.103 9.37 0.513 
R2M / 
R2C 

0.0856 / 
0.171 

Residual 0.0153 0.124 0.0885 0.146 90.6 NA AIC/BIC 37.5 / 
63.7 

sL.On Mean Aspect 
Ratio 

Lambda = 2.225 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 2.77 0.186 2.43 3.17 14.9 0 
** 
* 

0.979 
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Region1 0.672 0.323 0.0757 1.33 2.08 0.0447 * 0.0449 * 

Region2 -0.484 0.323 -1.12 0.147 -1.5 0.143 0.133 

Region3 -0.119 0.323 -0.756 0.572 -0.369 0.714 0.715 

Group1 0.0242 0.264 -0.487 0.496 0.0917 0.927 0.942 

Group2 -0.0229 0.264 -0.568 0.498 -0.087 0.931 0.936 

Region1:Group1 0.0467 0.457 -0.806 0.893 0.102 0.919 0.927 

Region2:Group1 0.162 0.457 -0.701 0.959 0.355 0.725 0.729 

Region3:Group1 0.00195 0.457 -0.931 0.835 
0.0042 

7 
0.997 0.989 

Region1:Group2 0.542 0.457 -0.412 1.41 1.19 0.243 0.255 

Region2:Group2 -0.639 0.457 -1.43 0.285 -1.4 0.17 0.175 

Region3:Group2 -0.163 0.457 -0.974 0.797 -0.358 0.723 0.716 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0 0 0 0.907 0 1 
R2M / 
R2C 

0.155 / 
0.155 

Residual 1.67 1.29 0.928 1.52 100 NA AIC/BIC 106 / 
132 

sL.On Mean 
Roundness 

Lambda = 3.175 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 0.283 0.02 0.247 0.326 14.2 0 
** 
* 

0.979 

Region1 -0.0124 0.0346 -0.0763 0.0586 -0.358 0.722 0.709 

Region2 -0.00644 0.0346 -0.0743 0.0612 -0.186 0.853 0.848 

Region3 -0.00906 0.0346 -0.0773 0.065 -0.262 0.795 0.791 

Group1 0.0177 0.0283 -0.0371 0.0683 0.626 0.536 0.601 

Group2 -0.0474 0.0283 -0.106 0.0084 -1.68 0.102 0.162 

Region1:Group1 -0.0357 0.049 -0.127 0.055 -0.728 0.471 0.479 

Region2:Group1 0.0109 0.049 -0.0816 0.0964 0.223 0.825 0.82 

Region3:Group1 0.019 0.049 -0.0811 0.108 0.387 0.701 0.714 

Region1:Group2 0.0296 0.049 -0.0726 0.123 0.605 0.549 0.566 

Region2:Group2 -0.0528 0.049 -0.137 0.0463 -1.08 0.288 0.293 

Region3:Group2 -0.0131 0.049 -0.1 0.0899 -0.267 0.791 0.787 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0 0 0 0.0973 0 1 
R2M / 
R2C 

0.109 / 
0.109 

Residual 0.0192 0.138 0.0994 0.163 100 NA AIC/BIC 36.1 / 
62.3 

sL.On Mean Solidity Lambda = 9.975 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 0.509 0.0391 0.435 0.588 13 4E-07 
** 
* 

0.986 

Region1 0.0142 0.048 -0.0743 0.113 0.297 0.769 0.784 

Region2 0.0183 0.048 -0.0756 0.112 0.382 0.705 0.692 

Region3 -0.0355 0.048 -0.13 0.0671 -0.74 0.466 0.471 
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Group1 0.0182 0.0553 -0.0881 0.128 0.329 0.75 0.778 

Group2 -0.0838 0.0553 -0.19 0.0287 -1.52 0.164 0.175 

Region1:Group1 -0.0282 0.0678 -0.155 0.0974 -0.416 0.681 0.686 

Region2:Group1 0.102 0.0678 -0.0267 0.22 1.5 0.146 0.159 

Region3:Group1 -0.052 0.0678 -0.191 0.0717 -0.767 0.45 0.458 

Region1:Group2 0.0739 0.0678 -0.0678 0.203 1.09 0.286 0.304 

Region2:Group2 -0.166 0.0678 -0.283 -0.0288 -2.45 0.0211 * 0.0193 * 

Region3:Group2 0.06 0.0678 -0.0604 0.203 0.885 0.384 0.393 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.00914 0.0956 0 0.196 19.9 0.182 
R2M / 
R2C 

0.17 / 
0.335 

Residual 0.0368 0.192 0.138 0.23 80.1 NA AIC/BIC 48.4 / 
74.6 

dL.On Mean Area 
(um^2) Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 13900 884 12100 15700 15.8 1E-07 
** 
* 

0.993 

Region1 26 645 -1190 1300 0.0404 0.968 0.965 

Region2 -2910 645 -4170 -1630 -4.51 
0.00011 

4 
** 
* 

0.000175 *** 

Region3 1910 645 716 3260 2.96 0.00639 ** 0.00632 ** 

Group1 2220 1250 -125 4640 1.77 0.11 0.125 

Group2 -680 1250 -3240 1910 -0.544 0.6 0.608 

Region1:Group1 879 912 -990 2700 0.964 0.344 0.329 

Region2:Group1 -1390 912 -3120 303 -1.53 0.139 0.12 

Region3:Group1 156 912 -1760 1870 0.171 0.865 0.874 

Region1:Group2 -601 912 -2270 1230 -0.659 0.516 0.513 

Region2:Group2 60 912 -1880 1710 0.0658 0.948 0.951 

Region3:Group2 1020 912 -870 2880 1.11 0.275 0.278 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 7700000 2780 1360 4680 53.6 
0.00049 

8 
** 
* 

R2M / 
R2C 

0.316 / 
0.683 

Residual 6660000 2580 1810 3110 46.4 NA AIC/BIC 745 / 
771 

dL.On Mean 
Circularity 

Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 0.703 0.0105 0.681 0.723 67 0 
** 
* 

0.989 

Region1 -0.00822 0.0119 -0.0307 0.0154 -0.69 0.496 0.498 

Region2 0.0378 0.0119 0.0145 0.0615 3.17 0.00374 ** 0.00421 ** 

Region3 -0.0205 0.0119 -0.0425 0.00442 -1.72 0.097 . 0.107 

Group1 -0.0256 0.0148 -0.0536 0.00385 -1.73 0.118 0.125 

Group2 0.0242 0.0148 
-

0.00482 
0.0538 1.63 0.138 0.153 
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Region1:Group1 -0.00198 0.0169 -0.0365 0.0316 -0.118 0.907 0.927 

Region2:Group1 -0.0103 0.0169 -0.0422 0.021 -0.612 0.546 0.542 

Region3:Group1 0.0168 0.0169 -0.0185 0.0484 0.998 0.327 0.328 

Region1:Group2 0.00514 0.0169 -0.0257 0.039 0.305 0.763 0.773 

Region2:Group2 0.0166 0.0169 -0.0193 0.0471 0.984 0.334 0.346 

Region3:Group2 -0.0281 0.0169 -0.063 0.00636 -1.67 0.107 0.109 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.00075 0.0274 0 0.0524 24.8 0.0999 . R2M / 
R2C 

0.263 / 
0.447 

Residual 0.00227 0.0477 0.0335 0.0574 75.2 NA AIC/BIC 2.22429 
9 

dL.On Mean Aspect 
Ratio 

Lambda = -0.8 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) -0.696 0.0102 -0.716 -0.675 -68.2 0 
** 
* 

0.959 

Region1 0.00397 0.0143 -0.0224 0.0332 0.278 0.783 0.798 

Region2 -0.0137 0.0143 -0.0417 0.0141 -0.963 0.344 0.35 

Region3 0.0168 0.0143 -0.0113 0.0474 1.18 0.249 0.248 

Group1 0.0134 0.0144 -0.0145 0.0415 0.927 0.378 0.41 

Group2 -0.0108 0.0144 -0.039 0.0183 -0.748 0.474 0.512 

Region1:Group1 -0.00555 0.0202 -0.0432 0.0318 -0.275 0.785 0.786 

Region2:Group1 -0.00971 0.0202 -0.0478 0.0255 -0.481 0.634 0.648 

Region3:Group1 -0.0115 0.0202 -0.0527 0.0253 -0.57 0.574 0.578 

Region1:Group2 -0.00465 0.0202 -0.0468 0.0338 -0.23 0.819 0.801 

Region2:Group2 -0.0107 0.0202 -0.0456 0.0301 -0.532 0.599 0.597 

Region3:Group2 0.0402 0.0202 0.00437 0.0826 1.99 0.0566 . 0.0519 . 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.00043 0.0208 0 0.0493 11.7 0.417 
R2M / 
R2C 

0.148 / 
0.248 

Residual 0.00326 0.0571 0.0408 0.0677 88.3 NA AIC/BIC 40 / 66.2 

dL.On Mean 
Roundness 

Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 0.67 0.00991 0.651 0.691 67.6 0 
** 
* 

1 

Region1 0.000304 0.0148 -0.0276 0.0297 0.0205 0.984 0.981 

Region2 0.0019 0.0148 -0.0271 0.0314 0.128 0.899 0.902 

Region3 -0.014 0.0148 -0.0413 0.017 -0.941 0.355 0.355 

Group1 -0.012 0.014 -0.0381 0.0148 -0.859 0.412 0.446 

Group2 0.0072 0.014 -0.0215 0.0357 0.514 0.62 0.647 

Region1:Group1 0.00642 0.021 -0.0365 0.0482 0.306 0.762 0.744 

Region2:Group1 0.0173 0.021 -0.0223 0.0563 0.827 0.415 0.409 

Region3:Group1 0.0105 0.021 -0.0334 0.0498 0.501 0.62 0.608 
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Region1:Group2 0.011 0.021 -0.0273 0.0531 0.525 0.604 0.604 

Region2:Group2 0.00598 0.021 -0.0387 0.044 0.285 0.778 0.803 

Region3:Group2 -0.0487 0.021 -0.0921 -0.0059 -2.32 0.0279 * 0.026 * 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.0003 0.0173 0 0.0481 7.85 0.582 
R2M / 
R2C 

0.173 / 
0.238 

Residual 0.00352 0.0593 0.0416 0.0712 92.1 NA AIC/BIC 3.44859 
8 

dL.On Mean Solidity Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 0.933 0.00502 0.923 0.943 186 0 
** 
* 

0.98 

Region1 -0.00605 0.00493 -0.0153 0.00371 -1.23 0.23 0.24 

Region2 0.0181 0.00493 0.00846 0.0279 3.67 0.00105 ** 0.00175 ** 

Region3 -0.00733 0.00493 -0.0164 0.00297 -1.49 0.148 0.158 

Group1 -0.0114 0.00709 -0.0248 0.00276 -1.61 0.142 0.171 

Group2 0.0102 0.00709 -0.0036 0.0243 1.43 0.185 0.207 

Region1:Group1 -0.00268 0.00697 -0.017 0.0112 -0.385 0.703 0.722 

Region2:Group1 -0.00758 0.00697 -0.0207 0.00537 -1.09 0.286 0.277 

Region3:Group1 0.0101 0.00697 
-

0.00445 
0.0232 1.46 0.157 0.158 

Region1:Group2 0.0055 0.00697 
-

0.00723 
0.0195 0.79 0.436 0.443 

Region2:Group2 0.00676 0.00697 
-

0.00807 
0.0194 0.971 0.34 0.349 

Region3:Group2 -0.0127 0.00697 -0.0272 0.00149 -1.83 0.0784 . 0.0796 . 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.0002 0.0143 0.0048 0.0256 33.9 0.0247 * 
R2M / 
R2C 

0.278 / 
0.527 

Residual 0.00039 0.0197 0.0138 0.0237 66.1 NA AIC/BIC 1.32281 
6 

tL.On Mean Area 
(um^2) Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 15500 2500 10900 20400 6.19 
0.00016 

1 
** 
* 

0.994 

Region1 -1200 4030 -8800 6780 -0.299 0.767 0.757 

Region2 -7490 4030 -15400 528 -1.86 0.0741 . 0.0649 . 

Region3 5150 4030 -2290 13600 1.28 0.212 0.21 

Group1 3480 3540 -3110 10100 0.983 0.351 0.391 

Group2 -7840 3540 -14900 -558 -2.21 0.0542 . 0.0695 . 

Region1:Group1 7850 5700 -3830 19200 1.38 0.18 0.158 

Region2:Group1 -2730 5700 -13500 7850 -0.479 0.635 0.627 

Region3:Group1 -3670 5700 -15600 7020 -0.644 0.525 0.504 

Region1:Group2 354 5700 -10100 11800 0.062 0.951 0.956 

Region2:Group2 2710 5700 -9420 13000 0.476 0.638 0.648 
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Region3:Group2 -694 5700 -12500 11000 -0.122 0.904 0.904 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 1030000 
0 

3210 0 11900 3.81 0.785 
R2M / 
R2C 

0.213 / 
0.243 

Residual 2.6E+08 16100 11300 19200 96.2 NA AIC/BIC 863 / 
889 

tL.On Mean 
Circularity 

Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 0.351 0.0501 0.253 0.452 7 
6.33E-

05 
** 
* 

0.999 

Region1 -0.0546 0.077 -0.2 0.098 -0.709 0.484 0.48 

Region2 -0.055 0.077 -0.205 0.0982 -0.714 0.481 0.461 

Region3 0.0124 0.077 -0.13 0.173 0.161 0.873 0.864 

Group1 0.0417 0.0708 -0.0891 0.175 0.589 0.57 0.595 

Group2 -0.156 0.0708 -0.3 -0.00941 -2.2 0.0554 . 0.0653 . 

Region1:Group1 0.128 0.109 -0.0955 0.345 1.17 0.252 0.234 

Region2:Group1 0.0661 0.109 -0.14 0.268 0.606 0.549 0.54 

Region3:Group1 -0.117 0.109 -0.345 0.0875 -1.07 0.293 0.291 

Region1:Group2 0.0301 0.109 -0.169 0.249 0.276 0.784 0.787 

Region2:Group2 -0.00802 0.109 -0.24 0.189 -0.0737 0.942 0.937 

Region3:Group2 -0.0675 0.109 -0.293 0.155 -0.619 0.541 0.526 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.00637 0.0798 0 0.239 6.29 0.656 
R2M / 
R2C 

0.209 / 
0.258 

Residual 0.0949 0.308 0.216 0.369 93.7 NA AIC/BIC 81.3 / 
107 

tL.On Mean Aspect 
Ratio 

Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 0.974 0.15 0.673 1.27 6.49 
0.00011 

3 
** 
* 

0.998 

Region1 -0.157 0.21 -0.552 0.259 -0.747 0.462 0.459 

Region2 -0.338 0.21 -0.748 0.0791 -1.61 0.119 0.12 

Region3 0.0478 0.21 -0.34 0.487 0.228 0.822 0.816 

Group1 0.121 0.212 -0.285 0.536 0.571 0.582 0.6 

Group2 -0.396 0.212 -0.823 0.0344 -1.87 0.0946 . 0.102 

Region1:Group1 0.137 0.297 -0.472 0.728 0.46 0.649 0.638 

Region2:Group1 0.00753 0.297 -0.554 0.559 0.0254 0.98 0.98 

Region3:Group1 -0.204 0.297 -0.826 0.353 -0.688 0.498 0.484 

Region1:Group2 0.0499 0.297 -0.493 0.645 0.168 0.868 0.869 

Region2:Group2 0.212 0.297 -0.42 0.75 0.714 0.482 0.498 

Region3:Group2 -0.0737 0.297 -0.688 0.533 -0.248 0.806 0.802 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 
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Sample 0.0939 0.306 0 0.734 11.8 0.417 
R2M / 
R2C 

0.2 / 
0.294 

Residual 0.705 0.84 0.589 1.01 88.2 NA AIC/BIC 155 / 
181 

tL.On Mean 
Roundness 

Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 0.351 0.0544 0.24 0.457 6.44 
0.00011 

9 
** 
* 

0.994 

Region1 -0.0334 0.0719 -0.169 0.109 -0.465 0.646 0.645 

Region2 -0.0695 0.0719 -0.21 0.0735 -0.967 0.342 0.341 

Region3 0.0118 0.0719 -0.121 0.162 0.165 0.87 0.861 

Group1 0.0509 0.0769 -0.0992 0.205 0.661 0.525 0.545 

Group2 -0.17 0.0769 -0.321 -0.0163 -2.21 0.0543 . 0.0586 . 

Region1:Group1 0.167 0.102 -0.0411 0.37 1.64 0.112 0.0972 . 

Region2:Group1 -0.0017 0.102 -0.194 0.187 -0.0167 0.987 0.987 

Region3:Group1 -0.111 0.102 -0.324 0.0802 -1.09 0.287 0.295 

Region1:Group2 -0.0101 0.102 -0.196 0.194 -0.0989 0.922 0.923 

Region2:Group2 0.0278 0.102 -0.189 0.212 0.274 0.786 0.812 

Region3:Group2 -0.0554 0.102 -0.266 0.152 -0.545 0.59 0.587 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.0148 0.122 0 0.267 15.2 0.3 
R2M / 
R2C 

0.222 / 
0.341 

Residual 0.0827 0.288 0.202 0.346 84.8 NA AIC/BIC 79 / 105 

tL.On Mean Solidity Lambda = 6.725 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 0.286 0.0417 0.21 0.376 6.86 0 
** 
* 

0.982 

Region1 -0.0648 0.0722 -0.198 0.0833 -0.898 0.375 0.369 

Region2 -0.0168 0.0722 -0.158 0.124 -0.232 0.818 0.807 

Region3 -0.00027 0.0722 -0.143 0.154 -0.0038 0.997 0.992 

Group1 0.0232 0.0589 -0.091 0.129 0.393 0.696 0.753 

Group2 -0.124 0.0589 -0.246 -0.00722 -2.1 0.043 * 0.086 . 

Region1:Group1 0.119 0.102 -0.0716 0.308 1.17 0.251 0.234 

Region2:Group1 0.103 0.102 -0.0896 0.282 1.01 0.318 0.318 

Region3:Group1 -0.0868 0.102 -0.295 0.0995 -0.85 0.401 0.395 

Region1:Group2 0.0647 0.102 -0.149 0.259 0.634 0.53 0.547 

Region2:Group2 -0.0528 0.102 -0.229 0.154 -0.517 0.608 0.602 

Region3:Group2 -0.0963 0.102 -0.278 0.118 -0.943 0.352 0.359 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0 0 0 0.203 0 1 
R2M / 
R2C 

0.225 / 
0.225 

Residual 0.0834 0.289 0.207 0.34 100 NA AIC/BIC 105 / 
131 

Rs.N Lambda = None 
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Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 2.04 0.279 1.53 2.57 7.32 
4.48E-

05 
** 
* 

1 

Region1 0.125 0.47 -0.76 1.06 0.266 0.792 0.784 

Region2 -0.958 0.47 -1.88 -0.0237 -2.04 0.0513 . 0.0432 * 

Region3 -0.292 0.47 -1.16 0.691 -0.621 0.54 0.536 

Group1 -0.604 0.395 -1.31 0.118 -1.53 0.16 0.213 

Group2 0.333 0.395 -0.398 1.14 0.845 0.42 0.467 

Region1:Group1 0.438 0.664 -0.924 1.76 0.658 0.516 0.497 

Region2:Group1 0.271 0.664 -0.986 1.51 0.408 0.687 0.669 

Region3:Group1 0.104 0.664 -1.29 1.35 0.157 0.877 0.883 

Region1:Group2 0.75 0.664 -0.464 2.08 1.13 0.269 0.269 

Region2:Group2 -1.17 0.664 -2.58 0.038 -1.76 0.0905 . 0.0772 . 

Region3:Group2 -0.583 0.664 -1.96 0.774 -0.878 0.388 0.374 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.0509 0.226 0 1.37 1.42 0.918 
R2M / 
R2C 

0.272 / 
0.282 

Residual 3.53 1.88 1.32 2.23 98.6 NA AIC/BIC 210 / 
236 

a.Rm.Cr Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 52.6 3.48 45.7 59.6 15.1 1E-07 
** 
* 

1 

Region1 11.4 4.77 2.36 20.8 2.38 0.0246 * 0.0242 * 

Region2 -25.3 4.77 -34.6 -15.8 -5.31 
1.34E-

05 
** 
* 

0.000175 *** 

Region3 -5.73 4.77 -14.5 4.24 -1.2 0.24 0.248 

Group1 -7.08 4.92 -16.6 2.68 -1.44 0.184 0.206 

Group2 -7.58 4.92 -17.4 2.36 -1.54 0.158 0.162 

Region1:Group1 4.08 6.75 -9.74 17.5 0.605 0.55 0.541 

Region2:Group1 5 6.75 -7.76 17.5 0.741 0.465 0.462 

Region3:Group1 -4.58 6.75 -18.7 8.07 -0.679 0.503 0.489 

Region1:Group2 4.58 6.75 -7.75 18.1 0.679 0.503 0.5 

Region2:Group2 -5.75 6.75 -20.1 6.48 -0.852 0.402 0.391 

Region3:Group2 4.42 6.75 -9.54 18.2 0.655 0.518 0.528 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 54.3 7.37 0 16.9 13 0.373 
R2M / 
R2C 

0.512 / 
0.576 

Residual 364 19.1 13.4 23 87 NA AIC/BIC 380 / 
407 

a.Rm.Cr/CA 
(a.Rm.Cr. OPD.CA) 

(#/mm^2) 
Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 
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(Intercept) 8.39 0.504 7.38 9.43 16.7 0 
** 
* 

0.997 

Region1 0.757 0.736 -0.63 2.22 1.03 0.313 0.303 

Region2 -3.17 0.736 -4.61 -1.71 -4.31 
0.00019 

5 
** 
* 

0.000351 *** 

Region3 0.337 0.736 -1.02 1.88 0.458 0.65 0.654 

Group1 -0.878 0.713 -2.22 0.498 -1.23 0.249 0.288 

Group2 -1.35 0.713 -2.8 0.0857 -1.89 0.0907 . 0.0986 . 

Region1:Group1 0.572 1.04 -1.56 2.65 0.55 0.587 0.571 

Region2:Group1 0.953 1.04 -1.02 2.89 0.915 0.368 0.358 

Region3:Group1 -1.06 1.04 -3.24 0.894 -1.02 0.318 0.316 

Region1:Group2 0.88 1.04 -1.02 2.97 0.845 0.405 0.408 

Region2:Group2 -1.25 1.04 -3.46 0.642 -1.2 0.242 0.24 

Region3:Group2 0.675 1.04 -1.48 2.8 0.648 0.522 0.529 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.878 0.937 0 2.47 9.19 0.521 
R2M / 
R2C 

0.428 / 
0.48 

Residual 8.68 2.95 2.07 3.54 90.8 NA AIC/BIC 245 / 
271 

T.On/CA (T.On. 
OPD.CA) (#/mm^2) Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 8.07 0.487 7.11 9.08 16.6 0 
** 
* 

0.994 

Region1 0.776 0.73 -0.6 2.22 1.06 0.297 0.292 

Region2 -3.05 0.73 -4.48 -1.6 -4.18 
0.00027 

5 
** 
* 

0.000351 *** 

Region3 0.331 0.73 -1.02 1.86 0.454 0.654 0.656 

Group1 -0.794 0.688 -2.07 0.521 -1.15 0.279 0.318 

Group2 -1.37 0.688 -2.78 0.0265 -2 0.0771 . 0.0849 . 

Region1:Group1 0.519 1.03 -1.6 2.58 0.503 0.619 0.604 

Region2:Group1 0.902 1.03 -1.05 2.82 0.874 0.39 0.38 

Region3:Group1 -1.06 1.03 -3.23 0.873 -1.03 0.312 0.312 

Region1:Group2 0.759 1.03 -1.13 2.83 0.735 0.468 0.465 

Region2:Group2 -1.07 1.03 -3.27 0.804 -1.03 0.31 0.305 

Region3:Group2 0.759 1.03 -1.38 2.87 0.735 0.469 0.477 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.711 0.843 0 2.36 7.69 0.589 
R2M / 
R2C 

0.417 / 
0.461 

Residual 8.53 2.92 2.05 3.51 92.3 NA AIC/BIC 244 / 
270 

C.On/CA (C.On. 
OPD.CA) (#/mm^2) Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 3.82 0.227 3.4 4.26 16.8 0 
** 
* 

0.998 

Region1 0.457 0.394 -0.285 1.24 1.16 0.253 0.249 
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Region2 -1.63 0.394 -2.4 -0.843 -4.13 
0.00020 

4 
** 
* 

0.000351 *** 

Region3 0.262 0.394 -0.465 1.08 0.665 0.51 0.511 

Group1 -0.24 0.321 -0.849 0.357 -0.748 0.459 0.524 

Group2 -0.749 0.321 -1.34 -0.114 -2.33 0.0255 * 0.0558 . 

Region1:Group1 0.645 0.557 -0.495 1.76 1.16 0.254 0.232 

Region2:Group1 0.146 0.557 -0.907 1.18 0.262 0.795 0.784 

Region3:Group1 -0.497 0.557 -1.66 0.546 -0.893 0.378 0.366 

Region1:Group2 0.24 0.557 -0.777 1.36 0.432 0.669 0.665 

Region2:Group2 -0.461 0.557 -1.65 0.548 -0.829 0.413 0.394 

Region3:Group2 0.0607 0.557 -1.09 1.2 0.109 0.914 0.912 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0 0 0 1.14 0 1 
R2M / 
R2C 

0.405 / 
0.405 

Residual 2.48 1.57 1.1 1.87 100 NA AIC/BIC 197 / 
223 

F.On/CA (F.On. 
OPD.CA) (#/mm^2) Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 4.25 0.325 3.57 4.87 13.1 4E-07 
** 
* 

0.999 

Region1 0.319 0.387 -0.41 1.09 0.824 0.417 0.406 

Region2 -1.42 0.387 -2.18 -0.655 -3.68 0.00102 ** 0.0014 ** 

Region3 0.0697 0.387 -0.645 0.878 0.18 0.858 0.852 

Group1 -0.553 0.46 -1.43 0.355 -1.2 0.26 0.278 

Group2 -0.625 0.46 -1.53 0.294 -1.36 0.208 0.205 

Region1:Group1 -0.126 0.547 -1.25 0.965 -0.23 0.82 0.839 

Region2:Group1 0.757 0.547 -0.278 1.77 1.38 0.178 0.183 

Region3:Group1 -0.566 0.547 -1.71 0.46 -1.03 0.31 0.313 

Region1:Group2 0.519 0.547 -0.48 1.62 0.949 0.351 0.364 

Region2:Group2 -0.607 0.547 -1.77 0.385 -1.11 0.277 0.283 

Region3:Group2 0.698 0.547 -0.433 1.82 1.28 0.213 0.213 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.672 0.82 0 1.61 21.9 0.144 
R2M / 
R2C 

0.369 / 
0.507 

Residual 2.39 1.55 1.09 1.86 78.1 NA AIC/BIC 202 / 
228 

sL.On/CA (sL.On. 
OPD.CA) (#/mm^2) Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 1.44 0.185 1.05 1.81 7.77 
0.00002 

8 
** 
* 

0.985 

Region1 0.336 0.186 -0.0145 0.705 1.81 0.082 . 0.0856 . 

Region2 -0.528 0.186 -0.892 -0.158 -2.84 0.00857 ** 0.0109 * 

Region3 -0.0069 0.186 -0.351 0.382 -0.0371 0.971 0.98 
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Group1 -0.344 0.262 -0.837 0.178 -1.31 0.221 0.253 

Group2 0.0049 0.262 -0.501 0.529 0.0187 0.985 0.997 

Region1:Group1 0.152 0.263 -0.387 0.677 0.578 0.568 0.563 

Region2:Group1 0.394 0.263 -0.104 0.883 1.5 0.146 0.152 

Region3:Group1 -0.587 0.263 -1.14 -0.0927 -2.23 0.0344 * 0.033 * 

Region1:Group2 -0.00819 0.263 -0.489 0.52 -0.0311 0.975 0.976 

Region2:Group2 -0.402 0.263 -0.963 0.0755 -1.53 0.139 0.136 

Region3:Group2 0.677 0.263 0.132 1.21 2.57 0.016 * 0.0161 * 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.272 0.522 0.145 0.94 32.9 0.0321 * 
R2M / 
R2C 

0.266 / 
0.507 

Residual 0.555 0.745 0.523 0.896 67.1 NA AIC/BIC 152 / 
179 

dL.On/CA (dL.On. 
OPD.CA) (#/mm^2) Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 2.17 0.15 1.89 2.46 14.5 2E-07 
** 
* 

0.997 

Region1 0.131 0.258 -0.354 0.641 0.509 0.615 0.593 

Region2 -0.968 0.258 -1.47 -0.455 -3.76 
0.00083 

7 
** 
* 

0.00105 ** 

Region3 0.216 0.258 -0.26 0.754 0.839 0.409 0.404 

Group1 0.0294 0.212 -0.356 0.42 0.139 0.892 0.905 

Group2 -0.667 0.212 -1.05 -0.247 -3.15 0.0118 * 0.0165 * 

Region1:Group1 0.428 0.364 -0.318 1.15 1.17 0.25 0.223 

Region2:Group1 -0.205 0.364 -0.894 0.471 -0.563 0.578 0.56 

Region3:Group1 0.103 0.364 -0.66 0.786 0.283 0.78 0.779 

Region1:Group2 0.205 0.364 -0.461 0.935 0.562 0.579 0.566 

Region2:Group2 -0.105 0.364 -0.88 0.555 -0.289 0.775 0.757 

Region3:Group2 -0.516 0.364 -1.27 0.228 -1.42 0.168 0.159 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.00354 0.0595 0 0.742 0.333 0.981 
R2M / 
R2C 

0.42 / 
0.422 

Residual 1.06 1.03 0.723 1.22 99.7 NA AIC/BIC 166 / 
192 

tL.ON/CA (tL.On. 
OPD.CA) (#/mm^2) Lambda = 0.6 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 0.301 0.0488 0.204 0.401 6.15 
0.00016 

8 
** 
* 

0.975 

Region1 -0.0211 0.0752 -0.16 0.133 -0.281 0.781 0.769 

Region2 -0.142 0.0752 -0.289 0.00479 -1.89 0.0696 . 0.0642 . 

Region3 0.0501 0.0752 -0.098 0.211 0.667 0.51 0.488 

Group1 0.0737 0.0691 -0.0576 0.203 1.07 0.314 0.346 

Group2 -0.124 0.0691 -0.263 0.0154 -1.79 0.107 0.126 
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Region1:Group1 0.0968 0.106 -0.102 0.294 0.91 0.371 0.368 

Region2:Group1 -0.0268 0.106 -0.228 0.159 -0.252 0.803 0.798 

Region3:Group1 -0.0448 0.106 -0.262 0.149 -0.422 0.677 0.673 

Region1:Group2 0.036 0.106 -0.186 0.238 0.338 0.738 0.748 

Region2:Group2 0.0515 0.106 -0.132 0.267 0.484 0.632 0.647 

Region3:Group2 -0.101 0.106 -0.29 0.122 -0.953 0.349 0.357 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.00603 0.0777 0 0.235 6.25 0.658 
R2M / 
R2C 

0.191 / 
0.242 

Residual 0.0904 0.301 0.215 0.355 93.7 NA AIC/BIC 69.5 / 
95.7 

Rs.N/CA (Rs.N. 
OPD.CA) (#/mm^2) Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 0.319 0.0428 0.239 0.402 7.44 0 
** 
* 

0.999 

Region1 -0.0188 0.0742 -0.159 0.128 -0.253 0.802 0.79 

Region2 -0.122 0.0742 -0.267 0.026 -1.64 0.11 0.102 

Region3 0.00598 0.0742 -0.131 0.161 0.0807 0.936 0.931 

Group1 -0.0845 0.0606 -0.199 0.0281 -1.4 0.171 0.262 

Group2 0.0235 0.0606 -0.0873 0.143 0.388 0.7 0.742 

Region1:Group1 0.0533 0.105 -0.162 0.263 0.508 0.615 0.595 

Region2:Group1 0.0503 0.105 -0.148 0.245 0.479 0.635 0.616 

Region3:Group1 0.00378 0.105 -0.216 0.201 0.036 0.971 0.977 

Region1:Group2 0.121 0.105 -0.071 0.331 1.15 0.258 0.256 

Region2:Group2 -0.178 0.105 -0.402 0.0119 -1.7 0.0979 . 0.0863 . 

Region3:Group2 -0.0838 0.105 -0.301 0.131 -0.799 0.43 0.414 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0 0 0 0.214 0 1 
R2M / 
R2C 

0.219 / 
0.219 

Residual 0.0881 0.297 0.208 0.353 100 NA AIC/BIC 76.4 / 
103 

a.Rm.Cr/RA 
(a.Rm.Cr. OPD.RA) 

(#/mm^2) 
Lambda = 0.75 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 11.1 0.583 9.97 12.3 19 0 
** 
* 

0.996 

Region1 0.976 0.587 -0.107 2.18 1.66 0.108 0.12 

Region2 -1.13 0.587 -2.28 0.0142 -1.93 0.0643 . 0.0688 . 

Region3 0.297 0.587 -0.859 1.55 0.507 0.616 0.617 

Group1 -0.276 0.824 -1.8 1.36 -0.336 0.745 0.741 

Group2 -0.747 0.824 -2.32 1.02 -0.906 0.388 0.4 

Region1:Group1 -0.176 0.83 -1.73 1.36 -0.212 0.834 0.834 

Region2:Group1 1.99 0.83 0.422 3.44 2.4 0.0236 * 0.0239 * 
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Region3:Group1 -1.04 0.83 -2.73 0.476 -1.25 0.222 0.23 

Region1:Group2 1.04 0.83 -0.696 2.62 1.25 0.222 0.239 

Region2:Group2 -1.88 0.83 -3.32 -0.203 -2.27 0.0315 * 0.0305 * 

Region3:Group2 0.702 0.83 -0.771 2.45 0.846 0.405 0.409 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 2.7 1.64 0.465 3.04 32.9 0.0323 * 
R2M / 
R2C 

0.211 / 
0.47 

Residual 5.51 2.35 1.69 2.81 67.1 NA AIC/BIC 313 / 
339 

T.On/RA (T.On. 
OPD.RA) (#/mm^2) Lambda = 0.625 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 7.21 0.321 6.6 7.86 22.5 0 
** 
* 

0.993 

Region1 0.533 0.334 -0.0838 1.22 1.6 0.122 0.135 

Region2 -0.606 0.334 -1.26 0.0468 -1.81 0.081 . 0.0811 . 

Region3 0.169 0.334 -0.49 0.884 0.505 0.617 0.618 

Group1 -0.108 0.454 -0.954 0.79 -0.239 0.817 0.811 

Group2 -0.449 0.454 -1.32 0.533 -0.99 0.348 0.358 

Region1:Group1 -0.0845 0.473 -0.967 0.791 -0.179 0.86 0.861 

Region2:Group1 1.08 0.473 0.183 1.9 2.28 0.0309 * 0.033 * 

Region3:Group1 -0.604 0.473 -1.57 0.259 -1.28 0.212 0.216 

Region1:Group2 0.515 0.473 -0.473 1.42 1.09 0.286 0.306 

Region2:Group2 -0.978 0.473 -1.79 -0.0214 -2.07 0.0482 * 0.0456 * 

Region3:Group2 0.463 0.473 -0.376 1.46 0.98 0.336 0.35 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.79 0.889 0.2 1.67 30.7 0.045 * 
R2M / 
R2C 

0.202 / 
0.446 

Residual 1.79 1.34 0.96 1.6 69.3 NA AIC/BIC 313 / 
339 

C.On/RA (C.On. 
OPD.RA) (#/mm^2) Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 11.3 0.793 9.72 12.9 14.2 2E-07 
** 
* 

0.997 

Region1 1.92 1.08 -0.108 4.06 1.78 0.0856 . 0.0835 . 

Region2 -2.39 1.08 -4.49 -0.244 -2.22 0.0354 * 0.0347 * 

Region3 0.759 1.08 -1.23 3.01 0.704 0.487 0.493 

Group1 0.0268 1.12 -2.16 2.26 0.0239 0.981 0.998 

Group2 -1.7 1.12 -3.93 0.558 -1.52 0.163 0.174 

Region1:Group1 0.78 1.52 -2.34 3.82 0.512 0.613 0.604 

Region2:Group1 1.81 1.52 -1.07 4.64 1.19 0.246 0.245 

Region3:Group1 -1.38 1.52 -4.57 1.48 -0.905 0.374 0.372 

Region1:Group2 1.17 1.52 -1.61 4.23 0.768 0.449 0.453 

Region2:Group2 -2.5 1.52 -5.74 0.267 -1.64 0.113 0.107 
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Region3:Group2 0.173 1.52 -2.98 3.29 0.114 0.91 0.91 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 2.91 1.71 0 3.85 13.5 0.354 
R2M / 
R2C 

0.229 / 
0.333 

Residual 18.6 4.31 3.02 5.19 86.5 NA AIC/BIC 273 / 
300 

F.On/RA (F.On. 
OPD.RA) (#/mm^2) Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 12.9 1.04 10.7 15 12.3 6E-07 
** 
* 

0.989 

Region1 1.11 0.915 -0.612 2.92 1.22 0.235 0.238 

Region2 -0.583 0.915 -2.37 1.24 -0.637 0.53 0.517 

Region3 0.0318 0.915 -1.66 1.94 0.0348 0.973 0.962 

Group1 -0.89 1.47 -3.68 2 -0.604 0.561 0.582 

Group2 -0.529 1.47 -3.42 2.4 -0.359 0.728 0.74 

Region1:Group1 -1.39 1.29 -4.04 1.19 -1.08 0.291 0.292 

Region2:Group1 3.69 1.29 1.25 6.09 2.85 0.00819 ** 0.00772 ** 

Region3:Group1 -1.8 1.29 -4.51 0.621 -1.4 0.174 0.175 

Region1:Group2 1.31 1.29 -1.05 3.91 1.01 0.319 0.332 

Region2:Group2 -2 1.29 -4.75 0.347 -1.54 0.134 0.13 

Region3:Group2 1.98 1.29 -0.695 4.62 1.53 0.137 0.135 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 9.71 3.12 1.3 5.41 42 0.00658 ** 
R2M / 
R2C 

0.167 / 
0.517 

Residual 13.4 3.66 2.57 4.4 58 NA AIC/BIC 270 / 
296 

sL.On/RA (sL.On. 
OPD.RA) (#/mm^2) Lambda = 0.725 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 2.75 0.325 2.14 3.42 8.44 
1.43E-

05 
** 
* 

0.998 

Region1 0.686 0.252 0.222 1.2 2.73 0.0111 * 0.0123 * 

Region2 -0.377 0.252 -0.87 0.114 -1.5 0.145 0.138 

Region3 -0.104 0.252 -0.6 0.435 -0.412 0.684 0.686 

Group1 -0.327 0.46 -1.17 0.554 -0.711 0.495 0.529 

Group2 0.0504 0.46 -0.872 0.976 0.11 0.915 0.929 

Region1:Group1 -0.0601 0.356 -0.724 0.599 -0.169 0.867 0.869 

Region2:Group1 0.991 0.356 0.319 1.61 2.79 0.00961 ** 0.00982 ** 

Region3:Group1 -0.924 0.356 -1.65 -0.275 -2.6 0.015 * 0.0123 * 

Region1:Group2 0.225 0.356 -0.518 0.902 0.632 0.533 0.559 

Region2:Group2 -0.907 0.356 -1.52 -0.187 -2.55 0.0168 * 0.0182 * 

Region3:Group2 0.856 0.356 0.224 1.6 2.41 0.0232 * 0.0242 * 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 
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Sample 1.02 1.01 0.513 1.73 50.1 0.00118 ** 
R2M / 
R2C 

0.209 / 
0.605 

Residual 1.01 1.01 0.723 1.21 49.9 NA AIC/BIC 227 / 
253 

dL.On/RA (dL.On. 
OPD.RA) (#/mm^2) Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 6.34 0.458 5.48 7.26 13.8 2E-07 
** 
* 

0.995 

Region1 0.573 0.721 -0.785 2 0.795 0.433 0.409 

Region2 -1.41 0.721 -2.82 0.0212 -1.96 0.0604 . 0.0568 . 

Region3 0.642 0.721 -0.69 2.15 0.89 0.381 0.378 

Group1 0.523 0.648 -0.695 1.71 0.807 0.44 0.477 

Group2 -1.74 0.648 -3.05 -0.399 -2.69 0.0249 * 0.0305 * 

Region1:Group1 0.805 1.02 -1.28 2.84 0.789 0.437 0.416 

Region2:Group1 -0.0245 1.02 -1.95 1.87 -0.024 0.981 0.984 

Region3:Group1 0.414 1.02 -1.72 2.33 0.406 0.688 0.678 

Region1:Group2 0.756 1.02 -1.11 2.8 0.742 0.465 0.456 

Region2:Group2 -0.896 1.02 -3.07 0.953 -0.879 0.387 0.37 

Region3:Group2 -1.39 1.02 -3.5 0.697 -1.36 0.185 0.181 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.436 0.66 0 2.17 4.98 0.722 
R2M / 
R2C 

0.278 / 
0.314 

Residual 8.32 2.88 2.02 3.45 95 NA AIC/BIC 242 / 
268 

tL.ON/RA (tL.On. 
OPD.RA) (#/mm^2) Lambda = 0.55 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 2.95E-05 4.9E-06 
1.99E-

05 
3.96E-05 6.03 

0.00019 
5 

** 
* 

0.979 

Region1 -2.7E-06 
7.69E-

06 
-1.7E-05 1.31E-05 -0.348 0.73 0.716 

Region2 -9.2E-06 
7.69E-

06 
-2.4E-05 5.8E-06 -1.2 0.241 0.236 

Region3 5.22E-06 
7.69E-

06 
-9.9E-06 2.17E-05 0.679 0.503 0.481 

Group1 8.96E-06 
6.93E-

06 
-4.2E-06 0.000022 1.29 0.228 0.25 

Group2 -1.2E-05 
6.93E-

06 
-2.6E-05 1.54E-06 -1.8 0.106 0.125 

Region1:Group1 8.6E-06 
1.09E-

05 
-1.2E-05 2.87E-05 0.791 0.436 0.433 

Region2:Group1 1.15E-06 
1.09E-

05 
-1.9E-05 2.01E-05 0.106 0.917 0.906 

Region3:Group1 -5.6E-06 
1.09E-

05 
-2.8E-05 1.42E-05 -0.515 0.611 0.613 

Region1:Group2 4.1E-06 
1.09E-

05 
-1.9E-05 2.48E-05 0.377 0.709 0.72 

Region2:Group2 1.22E-06 
1.09E-

05 
-1.8E-05 2.32E-05 0.112 0.912 0.927 

Region3:Group2 -9E-06 
1.09E-

05 
-2.8E-05 1.38E-05 -0.83 0.414 0.424 
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Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0 0.00001 0 2.35E-05 NaN 0.713 
R2M / 
R2C 

0.152 / 
0.196 

Residual 0 0.00003 
2.19E-

05 
3.63E-05 NaN NA AIC/BIC 1.02702 

7 
Rs.N/RA (Rs.N. 

OPD.RA) (#/mm^2) Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 0.918 0.123 0.689 1.15 7.49 
3.74E-

05 
** 
* 

0.997 

Region1 -0.0127 0.202 -0.393 0.387 -0.0629 0.95 0.944 

Region2 -0.233 0.202 -0.627 0.168 -1.16 0.257 0.243 

Region3 0.0603 0.202 -0.312 0.482 0.299 0.767 0.769 

Group1 -0.152 0.173 -0.467 0.171 -0.874 0.405 0.456 

Group2 0.103 0.173 -0.232 0.46 0.592 0.568 0.607 

Region1:Group1 -0.0254 0.285 -0.609 0.543 -0.0892 0.93 0.943 

Region2:Group1 0.316 0.285 -0.223 0.845 1.11 0.278 0.264 

Region3:Group1 0.0755 0.285 -0.522 0.61 0.265 0.793 0.794 

Region1:Group2 0.496 0.285 -0.0255 1.07 1.74 0.0936 . 0.0902 . 

Region2:Group2 -0.66 0.285 -1.27 -0.143 -2.32 0.0284 * 0.02 * 

Region3:Group2 -0.274 0.285 -0.864 0.308 -0.961 0.345 0.334 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.0178 0.134 0 0.591 2.67 0.847 
R2M / 
R2C 

0.203 / 
0.224 

Residual 0.65 0.806 0.566 0.961 97.3 NA AIC/BIC 149 / 
176 

T.On / Rs.N Lambda = -0.175 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) -0.579 0.01 -0.597 -0.557 -57.6 0 
** 
* 

0.986 

Region1 0.0182 0.0174 -0.0139 0.0539 1.05 0.302 0.296 

Region2 -0.0288 0.0174 -0.0628 0.00518 -1.65 0.107 0.1 

Region3 0.003 0.0174 -0.0313 0.0402 0.173 0.864 0.864 

Group1 0.0165 0.0142 -0.011 0.0419 1.16 0.253 0.307 

Group2 -0.0317 0.0142 -0.061 -0.00361 -2.23 0.0321 * 0.0544 . 

Region1:Group1 -0.0114 0.0246 -0.0574 0.0341 -0.465 0.645 0.654 

Region2:Group1 0.0184 0.0246 -0.0281 0.0613 0.749 0.459 0.476 

Region3:Group1 -0.0288 0.0246 -0.0791 0.016 -1.17 0.249 0.251 

Region1:Group2 0.0027 0.0246 -0.0487 0.0495 0.11 0.913 0.926 

Region2:Group2 -0.0105 0.0246 -0.053 0.0392 -0.429 0.671 0.669 

Region3:Group2 0.032 0.0246 -0.0117 0.0837 1.3 0.201 0.208 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0 0 0 0.0489 0 1 
R2M / 
R2C 

0.19 / 
0.19 
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Residual 0.00484 0.0696 0.05 0.0819 100 NA AIC/BIC 393 / 
419 

On.MAR.I.dL 
(um/day) Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 1.75 0.102 1.54 1.95 17.2 0 
** 
* 

0.992 

Region1 0.0571 0.0795 -0.0927 0.215 0.718 0.479 0.466 

Region2 -0.0931 0.0795 -0.248 0.065 -1.17 0.252 0.243 

Region3 0.0141 0.0795 -0.133 0.18 0.177 0.86 0.855 

Group1 0.11 0.144 -0.161 0.392 0.761 0.466 0.505 

Group2 -0.126 0.144 -0.417 0.168 -0.876 0.404 0.449 

Region1:Group1 -0.124 0.112 -0.354 0.1 -1.1 0.281 0.28 

Region2:Group1 -0.0478 0.112 -0.26 0.161 -0.425 0.674 0.669 

Region3:Group1 0.109 0.112 -0.126 0.32 0.973 0.339 0.333 

Region1:Group2 0.16 0.112 -0.0458 0.385 1.42 0.167 0.175 

Region2:Group2 -0.0753 0.112 -0.315 0.129 -0.67 0.509 0.5 

Region3:Group2 0.011 0.112 -0.222 0.241 0.0978 0.923 0.92 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.0995 0.315 0.149 0.537 49.6 0.00134 ** 
R2M / 
R2C 

0.0982 / 
0.545 

Residual 0.101 0.318 0.223 0.383 50.4 NA AIC/BIC 95.8 / 
122 

On.MAR.I (um/day) Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 1.67 0.104 1.46 1.88 16.1 1E-07 
** 
* 

0.992 

Region1 0.0645 0.0966 -0.117 0.256 0.668 0.51 0.501 

Region2 -0.146 0.0966 -0.335 0.0458 -1.52 0.141 0.15 

Region3 -0.00301 0.0966 -0.181 0.199 -0.0312 0.975 0.987 

Group1 0.0957 0.147 -0.183 0.388 0.652 0.531 0.55 

Group2 -0.0968 0.147 -0.382 0.197 -0.659 0.526 0.554 

Region1:Group1 -0.172 0.137 -0.452 0.1 -1.26 0.218 0.221 

Region2:Group1 -0.0558 0.137 -0.314 0.198 -0.409 0.686 0.684 

Region3:Group1 0.0464 0.137 -0.24 0.303 0.34 0.736 0.74 

Region1:Group2 0.198 0.137 -0.0516 0.472 1.45 0.159 0.173 

Region2:Group2 -0.0118 0.137 -0.303 0.236 -0.0864 0.932 0.929 

Region3:Group2 0.0651 0.137 -0.217 0.344 0.477 0.637 0.645 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.0921 0.303 0.116 0.534 38.2 0.0134 * 
R2M / 
R2C 

0.115 / 
0.453 

Residual 0.149 0.386 0.271 0.465 61.8 NA AIC/BIC 107 / 
133 

On.MAR.C (um/day) Lambda = None 

2018-DU-BX-0188 Final Technical Report 
October 2021 

This resource was prepared by the author(s) using Federal funds provided by the U.S. 
Department of Justice. Opinions or points of view expressed are those of the author(s) and do not 

necessarily reflect the official position or policies of the U.S. Department of Justice.

451 



 
 

    
        

          

          

          

          

          

          

          

          

          

          

          

          

    
        

        
 

 
 

         
 

            

    
        

          

          

          

          

          

          

          

          

          

          

          

          

    
        

        
 

 
 

         
 

            

    
        

          

          

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 1.85 0.0987 1.64 2.05 18.7 0 
** 
* 

0.998 

Region1 0.0303 0.103 -0.164 0.234 0.294 0.771 0.768 

Region2 -0.166 0.103 -0.368 0.0385 -1.62 0.118 0.122 

Region3 0.0507 0.103 -0.14 0.266 0.492 0.626 0.633 

Group1 0.123 0.14 -0.14 0.401 0.882 0.4 0.409 

Group2 -0.213 0.14 -0.482 0.0664 -1.53 0.161 0.175 

Region1:Group1 -0.125 0.146 -0.423 0.166 -0.857 0.399 0.411 

Region2:Group1 0.0412 0.146 -0.234 0.312 0.283 0.779 0.775 

Region3:Group1 0.00639 0.146 -0.299 0.28 0.0438 0.965 0.973 

Region1:Group2 0.238 0.146 -0.0278 0.531 1.64 0.113 0.122 

Region2:Group2 -0.0625 0.146 -0.373 0.202 -0.429 0.671 0.662 

Region3:Group2 0.0114 0.146 -0.29 0.309 0.0785 0.938 0.938 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 0.0745 0.273 0.049 0.5 30.5 0.0462 * 
R2M / 
R2C 

0.157 / 
0.414 

Residual 0.17 0.412 0.289 0.496 69.5 NA AIC/BIC 109 / 
135 

σf dL (days) Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 20.9 0.98 18.9 22.8 21.4 0 
** 
* 

0.981 

Region1 -1.72 1.14 -3.87 0.544 -1.51 0.144 0.148 

Region2 0.487 1.14 -1.74 2.76 0.427 0.673 0.67 

Region3 0.256 1.14 -1.85 2.64 0.224 0.824 0.824 

Group1 -2.32 1.39 -4.94 0.445 -1.68 0.128 0.138 

Group2 2.54 1.39 -0.187 5.32 1.83 0.1 0.0993 . 

Region1:Group1 3.12 1.61 -0.186 6.34 1.93 0.0638 . 0.0579 . 

Region2:Group1 -2.56 1.61 -5.61 0.437 -1.59 0.124 0.109 

Region3:Group1 0.292 1.61 -3.09 3.32 0.181 0.858 0.868 

Region1:Group2 -0.572 1.61 -3.52 2.67 -0.354 0.726 0.729 

Region2:Group2 3.4 1.61 -0.0418 6.32 2.1 0.0449 * 0.0435 * 

Region3:Group2 -3.71 1.61 -7.05 -0.41 -2.3 0.0296 * 0.0319 * 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 6.3 2.51 0 4.84 23.2 0.123 
R2M / 
R2C 

0.277 / 
0.445 

Residual 20.8 4.57 3.2 5.5 76.8 NA AIC/BIC 280 / 
307 

σf I (days) Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 22.3 1.23 19.7 24.7 18.2 0 
** 
* 

0.996 

Region1 -2.17 1.43 -4.86 0.669 -1.51 0.142 0.146 
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Region2 0.995 1.43 -1.8 3.84 0.695 0.493 0.485 

Region3 0.379 1.43 -2.26 3.37 0.265 0.793 0.796 

Group1 -1.99 1.73 -5.26 1.48 -1.14 0.282 0.295 

Group2 1.87 1.73 -1.54 5.35 1.08 0.309 0.308 

Region1:Group1 3.76 2.02 -0.389 7.79 1.86 0.0743 . 0.0695 . 

Region2:Group1 -3.31 2.02 -7.13 0.451 -1.63 0.114 0.0982 . 

Region3:Group1 0.778 2.02 -3.46 4.57 0.384 0.704 0.701 

Region1:Group2 -0.685 2.02 -4.38 3.38 -0.338 0.738 0.744 

Region2:Group2 2.81 2.02 -1.5 6.48 1.39 0.176 0.185 

Region3:Group2 -4.43 2.02 -8.62 -0.297 -2.19 0.0374 * 0.0375 * 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 9.87 3.14 0 6.06 23.1 0.124 
R2M / 
R2C 

0.211 / 
0.394 

Residual 32.8 5.72 4.02 6.89 76.9 NA AIC/BIC 297 / 
323 

σf C (days) Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 20.1 1.14 17.8 22.4 17.7 0 
** 
* 

0.999 

Region1 -1.56 1.18 -3.78 0.781 -1.32 0.198 0.205 

Region2 1.29 1.18 -1.02 3.64 1.09 0.285 0.287 

Region3 -0.236 1.18 -2.42 2.23 -0.2 0.843 0.847 

Group1 -2.09 1.61 -5.13 1.13 -1.29 0.228 0.243 

Group2 3.07 1.61 -0.0366 6.3 1.9 0.0894 . 0.0926 . 

Region1:Group1 3.6 1.67 0.183 6.93 2.16 0.04 * 0.0333 * 

Region2:Group1 -3.59 1.67 -6.75 -0.485 -2.15 0.0408 * 0.0365 * 

Region3:Group1 0.917 1.67 -2.58 4.05 0.549 0.587 0.587 

Region1:Group2 -1.73 1.67 -4.78 1.62 -1.03 0.31 0.305 

Region2:Group2 3.62 1.67 0.0652 6.65 2.17 0.0391 * 0.0365 * 

Region3:Group2 -3.3 1.67 -6.75 0.113 -1.98 0.0585 . 0.0614 . 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 10 3.17 0.646 5.79 31 0.0426 * 
R2M / 
R2C 

0.267 / 
0.494 

Residual 22.3 4.72 3.31 5.68 69 NA AIC/BIC 285 / 
311 

Ac.F.I.dL 
(#/mm^2/year) Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 70.3 6.69 56.3 83.5 10.5 2.4E-06 
** 
* 

0.978 

Region1 10.2 6.96 -2.92 24 1.47 0.154 0.159 

Region2 -24.7 6.96 -38.3 -10.9 -3.56 0.00141 ** 0.0014 ** 

Region3 0.0397 6.96 -12.8 14.6 0.0057 0.995 0.982 

Group1 4.35 9.46 -13.5 23.2 0.46 0.656 0.669 
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Group2 -20 9.46 -38.3 -1.07 -2.12 0.0634 . 0.0751 . 

Region1:Group1 1.86 9.84 -18.3 21.5 0.189 0.852 0.83 

Region2:Group1 6.8 9.84 -11.8 25.1 0.691 0.496 0.491 

Region3:Group1 -9.04 9.84 -29.7 9.41 -0.919 0.366 0.367 

Region1:Group2 1.32 9.84 -16.7 21.1 0.134 0.894 0.898 

Region2:Group2 -10.2 9.84 -31.1 7.64 -1.04 0.309 0.311 

Region3:Group2 10 9.84 -10.3 30.1 1.02 0.316 0.328 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 344 18.5 3.54 33.9 30.7 0.0445 * 
R2M / 
R2C 

0.307 / 
0.52 

Residual 774 27.8 19.5 33.5 69.3 NA AIC/BIC 413 / 
439 

Ac.F.I (#/mm^2/year) Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 67.7 7.03 53.1 81.7 9.63 4.9E-06 
** 
* 

0.986 

Region1 9.73 7.24 -3.91 24.1 1.34 0.19 0.198 

Region2 -26.5 7.24 -40.6 -12.1 -3.66 0.00109 ** 0.0014 ** 

Region3 -1.37 7.24 -14.7 13.8 -0.189 0.851 0.855 

Group1 4.36 9.95 -14.4 24.2 0.439 0.671 0.68 

Group2 -19 9.95 -38.2 0.899 -1.91 0.0879 . 0.0965 . 

Region1:Group1 1.57 10.2 -19.4 22 0.154 0.879 0.858 

Region2:Group1 4.74 10.2 -14.6 23.7 0.463 0.647 0.637 

Region3:Group1 -9.81 10.2 -31.3 9.38 -0.959 0.346 0.348 

Region1:Group2 2.98 10.2 -15.7 23.5 0.292 0.773 0.78 

Region2:Group2 -8.15 10.2 -29.9 10.4 -0.796 0.433 0.427 

Region3:Group2 12.4 10.2 -8.8 33.3 1.21 0.238 0.24 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 384 19.6 4.31 35.7 31.4 0.0401 * 
R2M / 
R2C 

0.302 / 
0.522 

Residual 838 28.9 20.3 34.8 68.6 NA AIC/BIC 416 / 
442 

Ac.F.C 
(#/mm^2/year) Lambda = None 

Fixed Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) t p-value Sig pMCMC Sig 

(Intercept) 76.5 7.65 60.5 91.2 10 3.6E-06 
** 
* 

0.989 

Region1 10.5 8.95 -6.41 28.2 1.17 0.253 0.26 

Region2 -29.2 8.95 -46.7 -11.4 -3.26 0.00301 ** 0.00351 ** 

Region3 -0.768 8.95 -17.3 17.9 -0.0858 0.932 0.935 

Group1 5.58 10.8 -14.9 27.2 0.516 0.619 0.632 

Group2 -24.7 10.8 -46 -2.99 -2.28 0.0483 * 0.0481 * 

Region1:Group1 4.54 12.7 -21.4 29.8 0.359 0.723 0.717 

Region2:Group1 10.6 12.7 -13.4 34.1 0.835 0.411 0.411 
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Region3:Group1 -14.1 12.7 -40.6 9.67 -1.11 0.276 0.287 

Region1:Group2 3.1 12.7 -20 28.5 0.245 0.808 0.812 

Region2:Group2 -8.7 12.7 -35.7 14.2 -0.687 0.498 0.492 

Region3:Group2 11.5 12.7 -14.7 37.3 0.905 0.374 0.387 

Random Factor Estimate 
Std. 

Error 
CI 

(2.5%) 
CI 

(97.5%) 
ICC 
(%) p-value Sig 

Model 
Test 

Model 
Fit 

Sample 382 19.5 0 37.8 22.9 0.128 
R2M / 
R2C 

0.309 / 
0.468 

Residual 1280 35.8 25.1 43.1 77.1 NA AIC/BIC 429 / 
455 
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Regional Femur: Post-Hoc Tests for Significant Fixed Effects 

Cortical Area 
(mm^2) Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Anterior > Lateral 5.63E-13 *** 5.636394 Large 100% 

Region Anterior > Medial 4.47E-12 *** 5.159157 Large 

Region Lateral < Posterior 1.03E-11 *** 4.975593 Large 

Region Medial < Posterior 1.00E-10 *** 4.498356 Large 

Remodeling 
Area (mm^2) Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Anterior > Lateral 0.000204 *** 2.01311 Large 100% 

Region Anterior < Posterior 0.023713 * 1.251913 Large 

Region Lateral < Medial 0.065476 . 1.066047 Large 

Region Lateral < Posterior 7.89E-08 *** 3.265023 Large 

Region Medial < Posterior 6.09E-05 *** 2.198976 Large 

RA/CA (%) Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Anterior > Lateral 0.058156 . 1.088727 Large 100% 

Region Anterior < Posterior 0.027373 * 1.22664 Large 

Region Lateral < Medial 0.021711 * 1.267314 Large 

Region Lateral < Posterior 2.87E-05 *** 2.315367 Large 

Region Medial < Posterior 0.071848 . 1.048053 Large 

Group Fentanyl < Morphine 0.047669 * 1.123637 Large 62% 

Percent Porosity 
(%) Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Anterior > Lateral 0.005843 ** 1.487467 Large 100% 

Region Lateral < Medial 0.004999 ** 1.512756 Large 

Region Lateral < Posterior 0.000112 *** 2.104676 Large 

Pore Density 
CA (1/mm^2) Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Anterior > Lateral 0.0065 ** 1.470098 Large 100% 

Region Lateral < Medial 0.004583 ** 1.526793 Large 

Region Lateral < Posterior 8.28E-05 *** 2.151806 Large 

Total Pore 
Number Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Anterior > Lateral 1.77E-05 *** 2.390373 Large 100% 

Region Anterior > Medial 0.064508 . 1.068914 Large 

Region Lateral < Medial 0.015856 * 1.321459 Large 

Region Lateral < Posterior 1.93E-07 *** 3.114728 Large 

Region Medial < Posterior 0.000847 *** 1.793269 Large 

Total Pore Area 
(um^2) Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Anterior > Lateral 0.00034 *** 1.934344 Large 100% 

Region Lateral < Medial 0.025506 * 1.239117 Large 

Region Lateral < Posterior 7.45E-06 *** 2.525082 Large 

Region Medial < Posterior 0.019497 * 1.285965 Large 
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Mean Pore Area 
(um^2) Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Lateral < Medial 0.098138 . 0.985979 Large 84% 

Mean Pore 
Perimeter (um) Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Lateral < Medial 0.091019 . 1.001222 Large 87% 

Mean Pore 
Circularity 

Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Anterior > Lateral 0.050414 . 1.115655 Large 76% 

Mean Pore Min 
Feret Diameter 

(um) 
Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Lateral < Medial 0.025769 * 1.237305 Large 90% 

Mean Pore 
Aspect Ratio 

Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Anterior < Lateral 0.001728 ** 1.681996 Large 95% 

Region Lateral > Medial 0.053206 . 1.105545 Large 

Mean Pore 
Roundness 

Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Anterior > Lateral 0.032986 * 1.193379 Large 78% 

Region Anterior > Posterior 0.070687 . 1.051225 Large 

T.On Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Anterior > Lateral 0.000146 *** 2.064309 Large 100% 

Region Lateral < Medial 0.025929 * 1.236214 Large 

Region Lateral < Posterior 1.13E-05 *** 2.46036 Large 

Region Medial < Posterior 0.027762 * 1.224146 Large 

C.On Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Anterior > Lateral 0.000937 *** 1.777678 Large 100% 

Region Lateral < Medial 0.078936 . 1.029605 Large 

Region Lateral < Posterior 0.000196 *** 2.018992 Large 

Region Medial < Posterior 0.096507 . 0.989386 Large 

F.On Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Anterior > Lateral 9.31E-05 *** 2.133814 Large 100% 

Region Lateral < Medial 0.02624 * 1.234117 Large 

Region Lateral < Posterior 3.14E-06 *** 2.661384 Large 

Region Medial < Posterior 0.008437 ** 1.427267 Large 

Group | Region Control Anterior > Lateral 0.029361 * 1.62686 Large 63% 

Group | Region Control Anterior > Medial 0.078435 . 1.293442 Large 

Group | Region Control Lateral < Posterior 0.005793 ** 2.118969 Large 

Group | Region Control Medial < Posterior 0.017745 * 1.785551 Large 

Group | Region Fentanyl Anterior > Lateral 0.000133 *** 3.147674 Large 

Group | Region Fentanyl Lateral < Medial 0.001661 ** 2.470213 Large 

Group | Region Fentanyl Lateral < Posterior 0.000136 *** 3.140633 Large 

Group | Region Morphine Anterior > Lateral 0.029357 * 1.626906 Large 

Group | Region Morphine Lateral < Posterior 0.000652 *** 2.72455 Large 
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Group | Region Morphine Medial < Posterior 0.015565 * 1.825829 Large 

Region | Group Lateral Fentanyl < Morphine 0.01209 * 2.159971 Large 

Region | Group Medial Control < Morphine 0.095903 . 1.391141 Large 

Region | Group Posterior Control < Morphine 0.087074 . 1.431419 Large 

Region | Group Posterior Fentanyl < Morphine 0.039252 * 1.743887 Large 

sL.On Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Anterior > Lateral 0.004662 ** 1.524044 Large 98% 

Region Lateral < Posterior 0.018544 * 1.294618 Large 

Group | Region Control Anterior > Lateral 0.093576 . 1.229068 Large 53% 

Group | Region Control Anterior > Medial 0.025535 * 1.671532 Large 

Group | Region Control Medial < Posterior 0.081809 . 1.278231 Large 

Group | Region Fentanyl Anterior > Lateral 0.009756 ** 1.966509 Large 

Group | Region Fentanyl Lateral < Medial 0.021855 * 1.720695 Large 

Group | Region Fentanyl Lateral < Posterior 0.062038 . 1.376556 Large 

Group | Region Morphine Anterior > Lateral 0.062038 . 1.376556 Large 

Group | Region Morphine Lateral < Posterior 0.025535 * 1.671532 Large 

Group | Region Morphine Medial < Posterior 0.093576 . 1.229068 Large 

Region | Group Medial Control < Fentanyl 0.046259 * 1.81902 Large 

dL.On Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Anterior > Lateral 0.002813 ** 1.604948 Large 100% 

Region Lateral < Medial 0.049868 * 1.117693 Large 

Region Lateral < Posterior 0.000119 *** 2.095948 Large 

Group Fentanyl < Morphine 0.011879 * 1.316491 Large 94% 

tL.On Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Lateral < Posterior 0.099108 . 0.983974 Large 67% 

tL.On Mean 
Outer Label 

(um) 
Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Group Fentanyl < Morphine 0.061652 . 0.990729 Large 73% 

C.On Mean 
Wall Thickness 
(W.Th.C) (um) 

Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Group | Region Control Lateral < Medial 0.017209 * 1.794999 Large 92% 

Group | Region Morphine Anterior < Medial 0.015526 * 1.826605 Large 

Group | Region Morphine Anterior < Posterior 0.026287 * 1.662287 Large 

sL.On Mean 
Wall Thickness 
(W.Th.sL) (um) 

Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Group | Region Fentanyl Anterior > Lateral 0.007221 ** 2.055043 Large 90% 

Group | Region Fentanyl Lateral < Posterior 0.003283 ** 2.280761 Large 

Group | Region Morphine Anterior < Medial 0.027846 * 1.643881 Large 

Group | Region Morphine Anterior < Posterior 0.049921 * 1.4514 Large 

Region | Group Lateral Control > Fentanyl 0.040296 * 1.948381 Large 

Region | Group Lateral Fentanyl < Morphine 0.035223 * 2.005518 Large 
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Region | Group Medial Fentanyl < Morphine 0.087261 . 1.603159 Large 

dL.On Mean 
Wall Thickness 
(W.Th.dL) (um) 

Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Group | Region Control Anterior > Lateral 0.020723 * 1.737344 Large 64% 

Group | Region Control Lateral < Medial 0.012582 * 1.890432 Large 

Group | Region Control Lateral < Posterior 0.023678 * 1.695468 Large 

Region | Group Lateral Control < Fentanyl 0.049668 * 2.18912 Large 

tL.On Mean 
Wall Thickness 
(W.Th.tL) (um) 

Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Group | Region Morphine Anterior < Medial 0.028643 * 1.634818 Large 61% 

Group | Region Morphine Lateral < Medial 0.067685 . 1.345982 Large 

Region | Group Medial Control < Morphine 0.085787 . 1.365916 Large 

Region | Group Medial Fentanyl < Morphine 0.012052 * 2.048526 Large 

T.On Mean 
Area (um^2) Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Lateral < Medial 0.011504 * 1.375694 Large 97% 

Region Lateral < Posterior 0.01373 * 1.345911 Large 

T.On Mean 
Circularity 

Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Lateral > Medial 0.026267 * 1.233935 Large 82% 

Region Lateral > Posterior 0.053608 . 1.104126 Large 

T.On Mean 
Solidity 

Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Lateral > Medial 0.017062 * 1.308925 Large 82% 

Region Lateral > Posterior 0.054742 . 1.100183 Large 

C.On Mean 
Area (um^2) Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Lateral < Medial 0.004307 ** 1.536795 Large 98% 

Region Lateral < Posterior 0.013092 * 1.353948 Large 

Group | Region Control Anterior > Lateral 0.015804 * 1.821169 Large 73% 

Group | Region Control Lateral < Medial 0.001716 ** 2.461289 Large 

Group | Region Control Lateral < Posterior 0.009674 ** 1.968994 Large 

Group | Region Fentanyl Lateral < Posterior 0.087949 . 1.251876 Large 

Group | Region Morphine Anterior < Medial 0.024859 * 1.680054 Large 

Group | Region Morphine Anterior < Posterior 0.036416 * 1.556815 Large 

Region | Group Anterior Control > Morphine 0.015823 * 2.515044 Large 

Region | Group Medial Control > Fentanyl 0.058452 . 1.920095 Large 

C.On Mean 
Circularity 

Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Lateral > Medial 0.021254 * 1.271019 Large 79% 

Region Lateral > Posterior 0.075429 . 1.038543 Large 

C.On Mean 
Aspect Ratio 

Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Group | Region Fentanyl Lateral < Medial 0.038369 * 1.539597 Large 55% 

Group | Region Fentanyl Medial > Posterior 0.06237 . 1.374696 Large 
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Region | Group Medial Fentanyl > Morphine 0.065737 . 1.342088 Large 

C.On Mean 
Roundness 

Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Group | Region Fentanyl Lateral > Medial 0.041215 * 1.515868 Large 58% 

Group | Region Fentanyl Medial < Posterior 0.046389 * 1.476244 Large 

Region | Group Medial Fentanyl < Morphine 0.088377 . 1.238497 Large 

C.On Mean 
Solidity 

Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Anterior < Lateral 0.046134 * 1.132176 Large 83% 

Region Lateral > Medial 0.012682 * 1.359309 Large 

Region Lateral > Posterior 0.03525 * 1.181412 Large 

F.On Mean Area 
(um^2) Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Anterior > Lateral 0.079884 . 1.027248 Large 93% 

Region Lateral < Medial 0.043901 * 1.141346 Large 

Region Lateral < Posterior 0.011585 * 1.374519 Large 

F.On Mean 
Aspect Ratio 

Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Anterior < Posterior 0.093775 . 0.995206 Large 91% 

Group | Region Control Anterior < Medial 0.008139 ** 2.020011 Large 82% 

Group | Region Fentanyl Anterior < Posterior 0.035776 * 1.562637 Large 

Group | Region Fentanyl Lateral < Posterior 0.005904 ** 2.113464 Large 

Group | Region Fentanyl Medial < Posterior 0.072929 . 1.319519 Large 

F.On Mean 
Roundness 

Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Anterior > Medial 0.069622 . 1.054175 Large 95% 

Group | Region Control Anterior > Medial 0.010362 * 1.948598 Large 76% 

Group | Region Fentanyl Anterior > Posterior 0.048898 * 1.458435 Large 

Group | Region Fentanyl Lateral > Medial 0.031604 * 1.603073 Large 

Group | Region Fentanyl Lateral > Posterior 0.002109 ** 2.404323 Large 

Region | Group Lateral Control < Fentanyl 0.072161 . 1.617422 Large 

Region | Group Lateral Fentanyl > Morphine 0.064106 . 1.668505 Large 

sL.On Mean 
Area (um^2) Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Lateral < Medial 0.068392 . 1.05763 Large 96% 

Region Lateral < Posterior 0.00853 ** 1.425452 Large 

Group | Region Control Lateral < Medial 0.066752 . 1.35088 Large 88% 

Group | Region Fentanyl Anterior > Lateral 0.004738 ** 2.176689 Large 

Group | Region Fentanyl Anterior > Medial 0.058461 . 1.397208 Large 

Group | Region Fentanyl Lateral < Posterior 0.002581 ** 2.348149 Large 

Group | Region Fentanyl Medial < Posterior 0.035124 * 1.568669 Large 

Group | Region Morphine Anterior < Medial 0.043325 * 1.499202 Large 

Group | Region Morphine Anterior < Posterior 0.05986 . 1.389002 Large 

Region | Group Anterior Fentanyl > Morphine 0.07371 . 1.502996 Large 

Region | Group Lateral Control > Fentanyl 0.070323 . 1.521977 Large 
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Region | Group Medial Control > Fentanyl 0.014931 * 2.093377 Large 

Region | Group Medial Fentanyl < Morphine 0.09611 . 1.393415 Large 

sL.On Mean 
Solidity 

Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Group | Region Fentanyl Anterior > Lateral 0.093467 . 1.229499 Large 64% 

Region | Group Lateral Control > Fentanyl 0.020417 * 1.927082 Large 

Region | Group Lateral Fentanyl < Morphine 0.017361 * 1.981817 Large 

dL.On Mean 
Area (um^2) Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Anterior > Lateral 0.044908 * 1.137161 Large 99% 

Region Lateral < Medial 0.000529 *** 1.866165 Large 

Region Lateral < Posterior 0.005247 ** 1.504938 Large 

dL.On Mean 
Circularity 

Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Lateral > Medial 0.027888 * 1.223339 Large 79% 

Region Lateral > Posterior 0.098798 . 0.984613 Large 

dL.On Mean 
Aspect Ratio 

Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Group | Region Fentanyl Lateral < Medial 0.053466 . 1.427983 Large 51% 

Group | Region Fentanyl Medial > Posterior 0.03637 * 1.557227 Large 

Region | Group Posterior Control > Fentanyl 0.086849 . 1.326609 Large 

dL.On Mean 
Roundness 

Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Group | Region Fentanyl Anterior > Medial 0.088936 . 1.247789 Large 76% 

Group | Region Fentanyl Medial < Posterior 0.017449 * 1.790746 Large 

Region | Group Medial Fentanyl < Morphine 0.060742 . 1.426948 Large 

Region | Group Posterior Control < Fentanyl 0.058883 . 1.437908 Large 

dL.On Mean 
Solidity 

Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Anterior < Lateral 0.027596 * 1.225206 Large 90% 

Region Lateral > Medial 0.019057 * 1.289913 Large 

Region Lateral > Posterior 0.040383 * 1.156692 Large 

Group | Region Fentanyl Anterior < Lateral 0.079393 . 1.289067 Large 50% 

Group | Region Fentanyl Lateral > Medial 0.003292 ** 2.279974 Large 

Group | Region Fentanyl Lateral > Posterior 0.046481 * 1.475576 Large 

Group | Region Morphine Anterior < Lateral 0.056402 . 1.4096 Large 

Group | Region Morphine Lateral > Posterior 0.093805 . 1.228166 Large 

Region | Group Anterior Control < Fentanyl 0.095443 . 1.511101 Large 

Region | Group Lateral Control < Fentanyl 0.046728 * 1.823218 Large 

Rs.N Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Group | Region Fentanyl Anterior > Lateral 0.032281 * 1.596195 Large 77% 

Group | Region Fentanyl Lateral < Posterior 0.003518 ** 2.261276 Large 

Group | Region Fentanyl Medial < Posterior 0.032281 * 1.596195 Large 

Region | Group Posterior Control < Fentanyl 0.047247 * 1.463178 Large 

a.Rm.C Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 
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Region Anterior > Lateral 0.00037 *** 1.921446 Large 100% 

Region Lateral < Medial 0.080297 . 1.026227 Large 

Region Lateral < Posterior 2.17E-05 *** 2.358139 Large 

Region Medial < Posterior 0.014912 * 1.331912 Large 

a.Rm.Cr/CA 
(a.Rm.Cr. 
OPD.CA) 
(#/mm^2) 

Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Anterior > Lateral 0.014712 * 1.334197 Large 99% 

Region Lateral < Medial 0.033298 * 1.191684 Large 

Region Lateral < Posterior 0.000907 *** 1.782663 Large 

T.On/CA (T.On. 
OPD.CA) 
(#/mm^2) 

Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Anterior > Lateral 0.016918 * 1.310377 Large 98% 

Region Lateral < Medial 0.040059 * 1.158166 Large 

Region Lateral < Posterior 0.001443 ** 1.710218 Large 

C.On/CA 
(C.On. 

OPD.CA) 
(#/mm^2) 

Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Anterior > Lateral 0.015675 * 1.32341 Large 99% 

Region Lateral < Medial 0.031911 * 1.199322 Large 

Region Lateral < Posterior 0.002732 ** 1.609581 Large 

Group Fentanyl < Morphine 0.029875 * 1.103955 Large 83% 

F.On/CA (F.On. 
OPD.CA) 
(#/mm^2) 

Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Anterior > Lateral 0.047444 * 1.126976 Large 97% 

Region Lateral < Posterior 0.003079 ** 1.590553 Large 

sL.On/CA 
(sL.On. 

OPD.CA) 
(#/mm^2) 

Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Anterior > Lateral 0.039573 * 1.160395 Large 93% 

Group | Region Control Anterior > Medial 0.049734 * 1.452676 Large 75% 

Group | Region Fentanyl Anterior > Lateral 0.024167 * 1.688998 Large 

Group | Region Fentanyl Lateral < Medial 0.005243 ** 2.147655 Large 

Group | Region Morphine Lateral < Posterior 0.084105 . 1.268184 Large 

Region | Group Medial Control < Fentanyl 0.018449 * 2.164125 Large 

Region | Group Medial Control < Morphine 0.077677 . 1.582829 Large 

dL.On/CA 
(dL.On. 

OPD.CA) 
(#/mm^2) 

Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Anterior > Lateral 0.065233 . 1.066763 Large 98% 

Region Lateral < Medial 0.042066 * 1.149207 Large 

Region Lateral < Posterior 0.004174 ** 1.54184 Large 
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Group Fentanyl < Morphine 0.015314 * 1.265629 Large 94% 

Rs.N/CA (Rs.N. 
OPD.CA) 
(#/mm^2) 

Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Group | Region Fentanyl Anterior > Lateral 0.066195 . 1.35383 Large 73% 

Group | Region Fentanyl Lateral < Posterior 0.010669 * 1.939899 Large 

Region | Group Posterior Control < Fentanyl 0.097712 . 1.202248 Large 

a.Rm.Cr/RA 
(a.Rm.Cr. 
OPD.RA) 
(#/mm^2) 

Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Group | Region Fentanyl Anterior > Lateral 0.005347 ** 2.142013 Large 75% 

Group | Region Fentanyl Lateral < Medial 0.022593 * 1.71025 Large 

Group | Region Fentanyl Lateral < Posterior 0.080228 . 1.28529 Large 

Region | Group Lateral Control > Fentanyl 0.0411 * 1.850553 Large 

Region | Group Lateral Fentanyl < Morphine 0.091333 . 1.510566 Large 

T.On/RA (T.On. 
OPD.RA) 
(#/mm^2) 

Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Group | Region Fentanyl Anterior > Lateral 0.009674 ** 1.968994 Large 72% 

Group | Region Fentanyl Lateral < Medial 0.026647 * 1.657952 Large 

Region | Group Lateral Control > Fentanyl 0.043908 * 1.791688 Large 

C.On/RA 
(C.On. 

OPD.RA) 
(#/mm^2) 

Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Anterior > Lateral 0.091663 . 0.999803 Large 79% 

F.On/RA (F.On. 
OPD.RA) 
(#/mm^2) 

Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Group | Region Control Lateral > Medial 0.069913 . 1.334531 Large 82% 

Group | Region Fentanyl Anterior > Lateral 0.063613 . 1.367793 Large 

Group | Region Fentanyl Lateral < Medial 0.087172 . 1.255123 Large 

sL.On/RA 
(sL.On. 

OPD.RA) 
(#/mm^2) 

Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Anterior > Lateral 0.068688 . 1.056793 Large 96% 

Group | Region Control Anterior > Medial 0.027854 * 1.643788 Large 91% 

Group | Region Control Lateral > Medial 0.028886 * 1.632108 Large 

Group | Region Fentanyl Anterior > Lateral 0.004654 ** 2.181807 Large 

Group | Region Fentanyl Anterior > Posterior 0.081094 . 1.281406 Large 

Group | Region Fentanyl Lateral < Medial 0.008023 ** 2.024197 Large 

Region | Group Medial Control < Fentanyl 0.044377 * 2.1444 Large 

dL.On/RA 
(dL.On. 

OPD.RA) 
(#/mm^2) 

Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Group Fentanyl < Morphine 0.063595 . 1.025701 Large 85% 
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Rs.N/RA (Rs.N. 
OPD.RA) 
(#/mm^2) 

Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Group | Region Fentanyl Anterior > Lateral 0.02283 * 1.706964 Large 85% 

Group | Region Fentanyl Lateral < Posterior 0.012904 * 1.882809 Large 

Region | Group Anterior Fentanyl > Morphine 0.086303 . 1.264039 Large 

Region | Group Posterior Control < Fentanyl 0.075254 . 1.313055 Large 

σf dL(days) Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Group | Region Fentanyl Anterior < Lateral 0.066531 . 1.352048 Large 83% 

Group | Region Fentanyl Lateral > Medial 0.031279 * 1.606428 Large 

Group | Region Morphine Anterior < Medial 0.020619 * 1.738927 Large 

Region | Group Lateral Control < Fentanyl 0.006225 ** 2.368771 Large 

Region | Group Lateral Fentanyl > Morphine 0.067428 . 1.529324 Large 

Region | Group Posterior Control < Fentanyl 0.083182 . 1.444671 Large 

σf I (days) Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Group | Region Fentanyl Lateral > Medial 0.062649 . 1.373138 Large 82% 

Group | Region Fentanyl Medial < Posterior 0.088694 . 1.248789 Large 

Group | Region Morphine Anterior < Medial 0.030011 * 1.619798 Large 

Region | Group Lateral Control < Fentanyl 0.038556 * 1.742859 Large 

σf C (days) Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Group | Region Fentanyl Anterior < Lateral 0.020872 * 1.73511 Large 85% 

Group | Region Fentanyl Lateral > Medial 0.017635 * 1.787465 Large 

Region | Group Lateral Control < Fentanyl 0.004672 ** 2.618196 Large 

Region | Group Lateral Fentanyl > Morphine 0.065522 . 1.632303 Large 

Region | Group Posterior Control < Fentanyl 0.07278 . 1.587686 Large 

Ac.F.I.dL 
(#/mm^2/year) Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Anterior > Lateral 0.023229 * 1.255523 Large 91% 

Region Lateral < Posterior 0.009322 ** 1.410754 Large 

Ac.F.I 
(#/mm^2/year) Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Anterior > Lateral 0.023976 * 1.249985 Large 94% 

Region Lateral < Posterior 0.004248 ** 1.539037 Large 

Ac.F.C 
(#/mm^2/year) Interaction Contrast Comparison p-value Sig. Cohen's D Effect Group Power 

Region Anterior > Lateral 0.052764 . 1.107114 Large 89% 

Region Lateral < Posterior 0.012697 * 1.359112 Large 
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Regional Femur: All Directional Trends 

Cortical Area (mm^2) Trends 

Factor Contrast Trend 

Region NA Anterior > Posterior > Medial > Lateral 

Group NA Fentanyl > Morphine > Control 

Group | Region Cortical Anterior > Posterior > Medial > Lateral 

Group | Region Cortical Anterior > Posterior > Medial > Lateral 

Group | Region Cortical Anterior > Posterior > Lateral > Medial 

Region | Group Anterior Fentanyl > Morphine > Control 

Region | Group Lateral Morphine > Fentanyl > Control 

Region | Group Medial Morphine > Fentanyl > Control 

Region | Group Posterior Fentanyl > Morphine > Control 

Remodeling Area (mm^2) Trends 

Factor Contrast Trend 

Region NA Posterior > Anterior > Medial > Lateral 

Group NA Morphine > Control > Fentanyl 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Region | Group Anterior Morphine > Control > Fentanyl 

Region | Group Lateral Morphine > Fentanyl > Control 

Region | Group Medial Morphine > Control > Fentanyl 

Region | Group Posterior Morphine > Control > Fentanyl 

RA/CA (%) Trends 

Factor Contrast Trend 

Region NA Posterior > Medial > Anterior > Lateral 

Group NA Morphine > Control > Fentanyl 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Posterior > Medial > Anterior > Lateral 

Group | Region Cortical Posterior > Medial > Anterior > Lateral 

Region | Group Anterior Morphine > Control > Fentanyl 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Morphine > Control > Fentanyl 

Region | Group Posterior Morphine > Control > Fentanyl 

Percent Porosity (%) Trends 

Factor Contrast Trend 

Region NA Posterior > Medial > Anterior > Lateral 

Group NA Control > Morphine > Fentanyl 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 
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Group | Region Cortical Posterior > Medial > Anterior > Lateral 

Region | Group Anterior Control > Morphine > Fentanyl 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Control > Morphine > Fentanyl 

Region | Group Posterior Control > Morphine > Fentanyl 

Pore Density CA (1/mm^2) Trends 

Factor Contrast Trend 

Region NA Posterior > Medial > Anterior > Lateral 

Group NA Morphine > Control > Fentanyl 

Group | Region Cortical Posterior > Medial > Anterior > Lateral 

Group | Region Cortical Posterior > Medial > Anterior > Lateral 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Region | Group Anterior Morphine > Control > Fentanyl 

Region | Group Lateral Morphine > Fentanyl > Control 

Region | Group Medial Morphine > Control > Fentanyl 

Region | Group Posterior Morphine > Control > Fentanyl 

Pore Density RA (1/mm^2) Trends 

Factor Contrast Trend 

Region NA Anterior > Medial > Posterior > Lateral 

Group NA Morphine > Fentanyl > Control 

Group | Region Cortical Medial > Anterior > Posterior > Lateral 

Group | Region Cortical Medial > Lateral > Anterior > Posterior 

Group | Region Cortical Anterior > Medial > Posterior > Lateral 

Region | Group Anterior Morphine > Fentanyl > Control 

Region | Group Lateral Fentanyl > Morphine > Control 

Region | Group Medial Fentanyl > Morphine > Control 

Region | Group Posterior Morphine > Fentanyl > Control 

Total Pore Number Trends 

Factor Contrast Trend 

Region NA Posterior > Anterior > Medial > Lateral 

Group NA Morphine > Control > Fentanyl 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Region | Group Anterior Morphine > Control > Fentanyl 

Region | Group Lateral Morphine > Fentanyl > Control 

Region | Group Medial Morphine > Control > Fentanyl 

Region | Group Posterior Morphine > Control > Fentanyl 

Total Pore Area (um^2) Trends 

Factor Contrast Trend 

Region NA Posterior > Anterior > Medial > Lateral 
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Group NA Control > Morphine > Fentanyl 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Region | Group Anterior Control > Morphine > Fentanyl 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Control > Morphine > Fentanyl 

Region | Group Posterior Control > Morphine > Fentanyl 

Mean Pore Area (um^2) Trends 

Factor Contrast Trend 

Region NA Medial > Posterior > Anterior > Lateral 

Group NA Control > Morphine > Fentanyl 

Group | Region Cortical Anterior > Medial > Posterior > Lateral 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Medial > Posterior > Lateral > Anterior 

Region | Group Anterior Control > Fentanyl > Morphine 

Region | Group Lateral Control > Morphine > Fentanyl 

Region | Group Medial Control > Morphine > Fentanyl 

Region | Group Posterior Control > Fentanyl > Morphine 

Mean Pore Perimeter (um) Trends 

Factor Contrast Trend 

Region NA Medial > Posterior > Anterior > Lateral 

Group NA Control > Fentanyl > Morphine 

Group | Region Cortical Medial > Posterior > Anterior > Lateral 

Group | Region Cortical Posterior > Medial > Anterior > Lateral 

Group | Region Cortical Medial > Lateral > Posterior > Anterior 

Region | Group Anterior Control > Fentanyl > Morphine 

Region | Group Lateral Control > Morphine > Fentanyl 

Region | Group Medial Control > Morphine > Fentanyl 

Region | Group Posterior Control > Fentanyl > Morphine 

Mean Pore Circularity Trends 

Factor Contrast Trend 

Region NA Anterior > Medial > Posterior > Lateral 

Group NA Morphine > Control > Fentanyl 

Group | Region Cortical Anterior > Lateral > Medial > Posterior 

Group | Region Cortical Medial > Anterior > Posterior > Lateral 

Group | Region Cortical Anterior > Medial > Posterior > Lateral 

Region | Group Anterior Morphine > Control > Fentanyl 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Morphine > Fentanyl > Control 

Region | Group Posterior Morphine > Control > Fentanyl 
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Mean Pore Max Feret Diameter (um) Trends 

Factor Contrast Trend 

Region NA Medial > Posterior > Lateral > Anterior 

Group NA Control > Fentanyl > Morphine 

Group | Region Cortical Medial > Posterior > Anterior > Lateral 

Group | Region Cortical Posterior > Medial > Anterior > Lateral 

Group | Region Cortical Medial > Lateral > Posterior > Anterior 

Region | Group Anterior Control > Fentanyl > Morphine 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Control > Morphine > Fentanyl 

Region | Group Posterior Control > Fentanyl > Morphine 

Mean Pore Min Feret Diameter (um) Trends 

Factor Contrast Trend 

Region NA Medial > Posterior > Anterior > Lateral 

Group NA Control > Fentanyl > Morphine 

Group | Region Cortical Anterior > Medial > Posterior > Lateral 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Medial > Posterior > Lateral > Anterior 

Region | Group Anterior Control > Fentanyl > Morphine 

Region | Group Lateral Control > Morphine > Fentanyl 

Region | Group Medial Control > Morphine > Fentanyl 

Region | Group Posterior Control > Fentanyl > Morphine 

Mean Pore Aspect Ratio Trends 

Factor Contrast Trend 

Region NA Lateral > Posterior > Medial > Anterior 

Group NA Fentanyl > Control > Morphine 

Group | Region Cortical Lateral > Posterior > Medial > Anterior 

Group | Region Cortical Lateral > Posterior > Medial > Anterior 

Group | Region Cortical Lateral > Posterior > Medial > Anterior 

Region | Group Anterior Fentanyl > Control > Morphine 

Region | Group Lateral Fentanyl > Morphine > Control 

Region | Group Medial Control > Fentanyl > Morphine 

Region | Group Posterior Fentanyl > Control > Morphine 

Mean Pore Roundness Trends 

Factor Contrast Trend 

Region NA Anterior > Medial > Posterior > Lateral 

Group NA Morphine > Control > Fentanyl 

Group | Region Cortical Anterior > Lateral > Medial > Posterior 

Group | Region Cortical Anterior > Medial > Posterior > Lateral 

Group | Region Cortical Anterior > Medial > Posterior > Lateral 

Region | Group Anterior Morphine > Control > Fentanyl 
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Region | Group Lateral Control > Morphine > Fentanyl 

Region | Group Medial Morphine > Fentanyl > Control 

Region | Group Posterior Morphine > Control > Fentanyl 

Mean Pore Solidity Trends 

Factor Contrast Trend 

Region NA Anterior > Medial > Posterior > Lateral 

Group NA Morphine > Control > Fentanyl 

Group | Region Cortical Anterior > Lateral > Medial > Posterior 

Group | Region Cortical Medial > Anterior > Posterior > Lateral 

Group | Region Cortical Anterior > Posterior > Medial > Lateral 

Region | Group Anterior Morphine > Control > Fentanyl 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Morphine > Control > Fentanyl 

Region | Group Posterior Morphine > Control > Fentanyl 

Total Osteon Count (T.On) Trends 

Factor Contrast Trend 

Region NA Posterior > Anterior > Medial > Lateral 

Group NA Morphine > Control > Fentanyl 

Group | Region Cortical Anterior > Posterior > Medial > Lateral 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Region | Group Anterior Morphine > Control > Fentanyl 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Morphine > Fentanyl > Control 

Region | Group Posterior Morphine > Control > Fentanyl 

Complete Osteon Count (C.On) Trends 

Factor Contrast Trend 

Region NA Posterior > Anterior > Medial > Lateral 

Group NA Morphine > Control > Fentanyl 

Group | Region Cortical Anterior > Posterior > Medial > Lateral 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Region | Group Anterior Control > Morphine > Fentanyl 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Morphine > Fentanyl > Control 

Region | Group Posterior Morphine > Fentanyl > Control 

Forming Osteon Count (F.On) Trends 

Factor Contrast Trend 

Region NA Posterior > Anterior > Medial > Lateral 

Group NA Morphine > Control > Fentanyl 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 
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Group | Region Cortical Anterior > Posterior > Medial > Lateral 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Region | Group Anterior Morphine > Fentanyl > Control 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Morphine > Fentanyl > Control 

Region | Group Posterior Morphine > Control > Fentanyl 

Single-Labeled Osteon Count (sL.On) Trends 

Factor Contrast Trend 

Region NA Anterior > Posterior > Medial > Lateral 

Group NA Morphine > Fentanyl > Control 

Group | Region Cortical Anterior > Posterior > Lateral > Medial 

Group | Region Cortical Anterior > Medial > Posterior > Lateral 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Region | Group Anterior Morphine > Fentanyl > Control 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Fentanyl > Morphine > Control 

Region | Group Posterior Morphine > Fentanyl > Control 

Double-Labeled Osteon Count (dL.On) Trends 

Factor Contrast Trend 

Region NA Posterior > Anterior > Medial > Lateral 

Group NA Morphine > Control > Fentanyl 

Group | Region Cortical Anterior > Posterior > Medial > Lateral 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Posterior > Medial > Anterior > Lateral 

Region | Group Anterior Control > Morphine > Fentanyl 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Morphine > Control > Fentanyl 

Region | Group Posterior Morphine > Fentanyl > Control 

Triple-Labeled Osteon Count (tL.On) Trends 

Factor Contrast Trend 

Region NA Posterior > Medial > Anterior > Lateral 

Group NA Control > Morphine > Fentanyl 

Group | Region Cortical Anterior > Posterior > Medial > Lateral 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Medial > Posterior > Anterior > Lateral 

Region | Group Anterior Control > Morphine > Fentanyl 

Region | Group Lateral Control > Morphine > Fentanyl 

Region | Group Medial Morphine > Control > Fentanyl 

Region | Group Posterior Morphine > Control > Fentanyl 

dL.On Mean Inner Label (um) Trends 

Factor Contrast Trend 
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Region NA Anterior > Posterior > Medial > Lateral 

Group NA Control > Morphine > Fentanyl 

Group | Region Cortical Medial > Posterior > Anterior > Lateral 

Group | Region Cortical Anterior > Medial > Posterior > Lateral 

Group | Region Cortical Posterior > Lateral > Anterior > Medial 

Region | Group Anterior Fentanyl > Control > Morphine 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Control > Morphine > Fentanyl 

Region | Group Posterior Control > Morphine > Fentanyl 

tL.On Mean Inner Label (um) Trends 

Factor Contrast Trend 

Region NA Posterior > Medial > Anterior > Lateral 

Group NA Morphine > Control > Fentanyl 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Posterior > Medial > Anterior > Lateral 

Group | Region Cortical Posterior > Medial > Anterior > Lateral 

Region | Group Anterior Control > Morphine > Fentanyl 

Region | Group Lateral Control > Morphine > Fentanyl 

Region | Group Medial Morphine > Control > Fentanyl 

Region | Group Posterior Morphine > Control > Fentanyl 

tL.On Mean Outer Label (um) Trends 

Factor Contrast Trend 

Region NA Posterior > Medial > Anterior > Lateral 

Group NA Morphine > Control > Fentanyl 

Group | Region Cortical Anterior > Posterior > Medial > Lateral 

Group | Region Cortical Posterior > Medial > Anterior > Lateral 

Group | Region Cortical Medial > Posterior > Anterior > Lateral 

Region | Group Anterior Control > Morphine > Fentanyl 

Region | Group Lateral Control > Morphine > Fentanyl 

Region | Group Medial Morphine > Control > Fentanyl 

Region | Group Posterior Morphine > Control > Fentanyl 

Combined Mean Inner Label (um) Trends 

Factor Contrast Trend 

Region NA Posterior > Anterior > Medial > Lateral 

Group NA Control > Morphine > Fentanyl 

Group | Region Cortical Posterior > Medial > Anterior > Lateral 

Group | Region Cortical Anterior > Medial > Lateral > Posterior 

Group | Region Cortical Posterior > Anterior > Lateral > Medial 

Region | Group Anterior Fentanyl > Morphine > Control 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Control > Fentanyl > Morphine 
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Region | Group Posterior Control > Morphine > Fentanyl 

Combined Mean Label (um) Trends 

Factor Contrast Trend 

Region NA Posterior > Medial > Anterior > Lateral 

Group NA Control > Morphine > Fentanyl 

Group | Region Cortical Posterior > Medial > Anterior > Lateral 

Group | Region Cortical Anterior > Medial > Posterior > Lateral 

Group | Region Cortical Posterior > Medial > Anterior > Lateral 

Region | Group Anterior Fentanyl > Control > Morphine 

Region | Group Lateral Control > Morphine > Fentanyl 

Region | Group Medial Control > Morphine > Fentanyl 

Region | Group Posterior Control > Morphine > Fentanyl 

C.On Mean Wall Thickness (W.Th.C) (um) Trends 

Factor Contrast Trend 

Region NA Posterior > Medial > Lateral > Anterior 

Group NA Fentanyl > Morphine > Control 

Group | Region Cortical Medial > Anterior > Posterior > Lateral 

Group | Region Cortical Posterior > Lateral > Anterior > Medial 

Group | Region Cortical Medial > Posterior > Lateral > Anterior 

Region | Group Anterior Fentanyl > Control > Morphine 

Region | Group Lateral Fentanyl > Morphine > Control 

Region | Group Medial Morphine > Control > Fentanyl 

Region | Group Posterior Morphine > Fentanyl > Control 

sL.On Mean Wall Thickness (W.Th.sL) (um) Trends 

Factor Contrast Trend 

Region NA Posterior > Medial > Anterior > Lateral 

Group NA Morphine > Control > Fentanyl 

Group | Region Cortical Posterior > Lateral > Medial > Anterior 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Medial > Posterior > Lateral > Anterior 

Region | Group Anterior Fentanyl > Control > Morphine 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Morphine > Control > Fentanyl 

Region | Group Posterior Morphine > Fentanyl > Control 

dL.On Mean Wall Thickness (W.Th.dL) (um) Trends 

Factor Contrast Trend 

Region NA Posterior > Medial > Anterior > Lateral 

Group NA Fentanyl > Morphine > Control 

Group | Region Cortical Medial > Anterior > Posterior > Lateral 

Group | Region Cortical Posterior > Lateral > Anterior > Medial 

Group | Region Cortical Posterior > Medial > Lateral > Anterior 
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Region | Group Anterior Fentanyl > Control > Morphine 

Region | Group Lateral Fentanyl > Morphine > Control 

Region | Group Medial Fentanyl > Control > Morphine 

Region | Group Posterior Fentanyl > Morphine > Control 

tL.On Mean Wall Thickness (W.Th.tL) (um) Trends 

Factor Contrast Trend 

Region NA Medial > Posterior > Anterior > Lateral 

Group NA Morphine > Control > Fentanyl 

Group | Region Cortical Anterior > Medial > Posterior > Lateral 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Medial > Posterior > Lateral > Anterior 

Region | Group Anterior Control > Morphine > Fentanyl 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Morphine > Control > Fentanyl 

Region | Group Posterior Morphine > Fentanyl > Control 

T.On Mean Area (um^2) Trends 

Factor Contrast Trend 

Region NA Medial > Posterior > Anterior > Lateral 

Group NA Control > Morphine > Fentanyl 

Group | Region Cortical Medial > Anterior > Posterior > Lateral 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Medial > Posterior > Lateral > Anterior 

Region | Group Anterior Control > Fentanyl > Morphine 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Control > Morphine > Fentanyl 

Region | Group Posterior Control > Fentanyl > Morphine 

T.On Mean Circularity Trends 

Factor Contrast Trend 

Region NA Lateral > Anterior > Posterior > Medial 

Group NA Fentanyl > Morphine > Control 

Group | Region Cortical Lateral > Posterior > Anterior > Medial 

Group | Region Cortical Lateral > Anterior > Medial > Posterior 

Group | Region Cortical Anterior > Lateral > Posterior > Medial 

Region | Group Anterior Fentanyl > Morphine > Control 

Region | Group Lateral Fentanyl > Control > Morphine 

Region | Group Medial Fentanyl > Morphine > Control 

Region | Group Posterior Morphine > Fentanyl > Control 

T.On Mean Aspect Ratio Trends 

Factor Contrast Trend 

Region NA Medial > Posterior > Lateral > Anterior 

Group NA Control > Morphine > Fentanyl 
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Group | Region Cortical Medial > Posterior > Lateral > Anterior 

Group | Region Cortical Posterior > Medial > Anterior > Lateral 

Group | Region Cortical Lateral > Posterior > Medial > Anterior 

Region | Group Anterior Morphine > Fentanyl > Control 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Control > Fentanyl > Morphine 

Region | Group Posterior Fentanyl > Control > Morphine 

T.On Mean Roundness Trends 

Factor Contrast Trend 

Region NA Anterior > Lateral > Posterior > Medial 

Group NA Fentanyl > Morphine > Control 

Group | Region Cortical Anterior > Lateral > Posterior > Medial 

Group | Region Cortical Lateral > Anterior > Posterior > Medial 

Group | Region Cortical Anterior > Medial > Posterior > Lateral 

Region | Group Anterior Fentanyl > Control > Morphine 

Region | Group Lateral Fentanyl > Control > Morphine 

Region | Group Medial Morphine > Fentanyl > Control 

Region | Group Posterior Morphine > Fentanyl > Control 

T.On Mean Solidity Trends 

Factor Contrast Trend 

Region NA Lateral > Anterior > Posterior > Medial 

Group NA Fentanyl > Control > Morphine 

Group | Region Cortical Lateral > Posterior > Anterior > Medial 

Group | Region Cortical Lateral > Anterior > Medial > Posterior 

Group | Region Cortical Lateral > Anterior > Posterior > Medial 

Region | Group Anterior Fentanyl > Morphine > Control 

Region | Group Lateral Control > Fentanyl > Morphine 

Region | Group Medial Fentanyl > Control > Morphine 

Region | Group Posterior Morphine > Control > Fentanyl 

C.On Mean Area (um^2) Trends 

Factor Contrast Trend 

Region NA Medial > Posterior > Anterior > Lateral 

Group NA Control > Morphine > Fentanyl 

Group | Region Cortical Medial > Posterior > Anterior > Lateral 

Group | Region Cortical Posterior > Medial > Anterior > Lateral 

Group | Region Cortical Medial > Posterior > Lateral > Anterior 

Region | Group Anterior Control > Fentanyl > Morphine 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Control > Morphine > Fentanyl 

Region | Group Posterior Control > Morphine > Fentanyl 

C.On Mean Circularity Trends 
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Factor Contrast Trend 

Region NA Lateral > Anterior > Posterior > Medial 

Group NA Fentanyl > Morphine > Control 

Group | Region Cortical Lateral > Posterior > Anterior > Medial 

Group | Region Cortical Lateral > Anterior > Posterior > Medial 

Group | Region Cortical Lateral > Anterior > Medial > Posterior 

Region | Group Anterior Fentanyl > Morphine > Control 

Region | Group Lateral Fentanyl > Control > Morphine 

Region | Group Medial Morphine > Fentanyl > Control 

Region | Group Posterior Fentanyl > Morphine > Control 

C.On Mean Aspect Ratio Trends 

Factor Contrast Trend 

Region NA Medial > Anterior > Posterior > Lateral 

Group NA Control > Fentanyl > Morphine 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Medial > Anterior > Posterior > Lateral 

Group | Region Cortical Lateral > Anterior > Medial > Posterior 

Region | Group Anterior Control > Fentanyl > Morphine 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Fentanyl > Control > Morphine 

Region | Group Posterior Control > Morphine > Fentanyl 

C.On Mean Roundness Trends 

Factor Contrast Trend 

Region NA Lateral > Posterior > Anterior > Medial 

Group NA Fentanyl > Morphine > Control 

Group | Region Cortical Lateral > Anterior > Posterior > Medial 

Group | Region Cortical Lateral > Posterior > Anterior > Medial 

Group | Region Cortical Medial > Posterior > Anterior > Lateral 

Region | Group Anterior Fentanyl > Morphine > Control 

Region | Group Lateral Fentanyl > Control > Morphine 

Region | Group Medial Morphine > Control > Fentanyl 

Region | Group Posterior Fentanyl > Morphine > Control 

C.On Mean Solidity Trends 

Factor Contrast Trend 

Region NA Lateral > Anterior > Posterior > Medial 

Group NA Fentanyl > Morphine > Control 

Group | Region Cortical Lateral > Medial > Anterior > Posterior 

Group | Region Cortical Lateral > Anterior > Posterior > Medial 

Group | Region Cortical Lateral > Posterior > Anterior > Medial 

Region | Group Anterior Fentanyl > Morphine > Control 

Region | Group Lateral Fentanyl > Morphine > Control 

2018-DU-BX-0188 Final Technical Report 
October 2021 

This resource was prepared by the author(s) using Federal funds provided by the U.S. 
Department of Justice. Opinions or points of view expressed are those of the author(s) and do not 

necessarily reflect the official position or policies of the U.S. Department of Justice.

475 



 
 

        

        

    

   

      

      

         

        

         

        

        

       

       

    

   

      

     

        

        

        

       

       

        

        

    

   

      

      

        

        

        

        

        

        

        

    

   

      

     

        

        

Region | Group Medial Morphine > Fentanyl > Control 

Region | Group Posterior Fentanyl > Morphine > Control 

F.On Mean Area (um^2) Trends 

Factor Contrast Trend 

Region NA Posterior > Medial > Anterior > Lateral 

Group NA Control > Morphine > Fentanyl 

Group | Region Cortical Anterior > Posterior > Medial > Lateral 

Group | Region Cortical Posterior > Medial > Anterior > Lateral 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Region | Group Anterior Control > Morphine > Fentanyl 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Control > Fentanyl > Morphine 

Region | Group Posterior Control > Fentanyl > Morphine 

F.On Mean Circularity Trends 

Factor Contrast Trend 

Region NA Lateral > Anterior > Posterior > Medial 

Group NA Fentanyl > Control > Morphine 

Group | Region Cortical Lateral > Anterior > Posterior > Medial 

Group | Region Cortical Lateral > Anterior > Medial > Posterior 

Group | Region Cortical Anterior > Lateral > Posterior > Medial 

Region | Group Anterior Fentanyl > Control > Morphine 

Region | Group Lateral Fentanyl > Control > Morphine 

Region | Group Medial Fentanyl > Morphine > Control 

Region | Group Posterior Control > Morphine > Fentanyl 

F.On Mean Aspect Ratio Trends 

Factor Contrast Trend 

Region NA Posterior > Medial > Lateral > Anterior 

Group NA Control > Morphine > Fentanyl 

Group | Region Cortical Medial > Lateral > Posterior > Anterior 

Group | Region Cortical Posterior > Medial > Anterior > Lateral 

Group | Region Cortical Lateral > Posterior > Medial > Anterior 

Region | Group Anterior Morphine > Fentanyl > Control 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Control > Morphine > Fentanyl 

Region | Group Posterior Fentanyl > Morphine > Control 

F.On Mean Roundness Trends 

Factor Contrast Trend 

Region NA Anterior > Lateral > Posterior > Medial 

Group NA Fentanyl > Control > Morphine 

Group | Region Cortical Anterior > Lateral > Posterior > Medial 

Group | Region Cortical Lateral > Anterior > Medial > Posterior 
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Group | Region Cortical Anterior > Lateral > Posterior > Medial 

Region | Group Anterior Control > Fentanyl > Morphine 

Region | Group Lateral Fentanyl > Control > Morphine 

Region | Group Medial Fentanyl > Morphine > Control 

Region | Group Posterior Control > Morphine > Fentanyl 

F.On Mean Solidity Trends 

Factor Contrast Trend 

Region NA Lateral > Anterior > Posterior > Medial 

Group NA Control > Fentanyl > Morphine 

Group | Region Cortical Lateral > Anterior > Posterior > Medial 

Group | Region Cortical Lateral > Anterior > Medial > Posterior 

Group | Region Cortical Anterior > Lateral > Posterior > Medial 

Region | Group Anterior Control > Fentanyl > Morphine 

Region | Group Lateral Control > Fentanyl > Morphine 

Region | Group Medial Control > Fentanyl > Morphine 

Region | Group Posterior Control > Morphine > Fentanyl 

sL.On Mean Area (um^2) Trends 

Factor Contrast Trend 

Region NA Posterior > Medial > Anterior > Lateral 

Group NA Control > Morphine > Fentanyl 

Group | Region Cortical Medial > Posterior > Anterior > Lateral 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Medial > Posterior > Lateral > Anterior 

Region | Group Anterior Fentanyl > Control > Morphine 

Region | Group Lateral Control > Morphine > Fentanyl 

Region | Group Medial Control > Morphine > Fentanyl 

Region | Group Posterior Control > Fentanyl > Morphine 

sL.On Mean Circularity Trends 

Factor Contrast Trend 

Region NA Lateral > Anterior > Posterior > Medial 

Group NA Morphine > Control > Fentanyl 

Group | Region Cortical Lateral > Posterior > Anterior > Medial 

Group | Region Cortical Anterior > Posterior > Medial > Lateral 

Group | Region Cortical Lateral > Anterior > Medial > Posterior 

Region | Group Anterior Morphine > Fentanyl > Control 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Morphine > Fentanyl > Control 

Region | Group Posterior Morphine > Control > Fentanyl 

sL.On Mean Aspect Ratio Trends 

Factor Contrast Trend 

Region NA Anterior > Posterior > Medial > Lateral 
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Group NA Control > Morphine > Fentanyl 

Group | Region Cortical Anterior > Medial > Posterior > Lateral 

Group | Region Cortical Anterior > Posterior > Medial > Lateral 

Group | Region Cortical Anterior > Medial > Lateral > Posterior 

Region | Group Anterior Fentanyl > Control > Morphine 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Morphine > Control > Fentanyl 

Region | Group Posterior Fentanyl > Morphine > Control 

sL.On Mean Roundness Trends 

Factor Contrast Trend 

Region NA Posterior > Lateral > Medial > Anterior 

Group NA Morphine > Control > Fentanyl 

Group | Region Cortical Posterior > Medial > Lateral > Anterior 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Lateral > Anterior > Posterior > Medial 

Region | Group Anterior Morphine > Fentanyl > Control 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Control > Morphine > Fentanyl 

Region | Group Posterior Control > Fentanyl > Morphine 

sL.On Mean Solidity Trends 

Factor Contrast Trend 

Region NA Lateral > Anterior > Posterior > Medial 

Group NA Morphine > Control > Fentanyl 

Group | Region Cortical Lateral > Anterior > Posterior > Medial 

Group | Region Cortical Anterior > Posterior > Medial > Lateral 

Group | Region Cortical Lateral > Posterior > Anterior > Medial 

Region | Group Anterior Morphine > Fentanyl > Control 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Morphine > Fentanyl > Control 

Region | Group Posterior Morphine > Control > Fentanyl 

dL.On Mean Area (um^2) Trends 

Factor Contrast Trend 

Region NA Medial > Posterior > Anterior > Lateral 

Group NA Control > Fentanyl > Morphine 

Group | Region Cortical Medial > Posterior > Anterior > Lateral 

Group | Region Cortical Medial > Posterior > Anterior > Lateral 

Group | Region Cortical Posterior > Medial > Anterior > Lateral 

Region | Group Anterior Control > Fentanyl > Morphine 

Region | Group Lateral Control > Morphine > Fentanyl 

Region | Group Medial Control > Fentanyl > Morphine 

Region | Group Posterior Control > Fentanyl > Morphine 
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dL.On Mean Circularity Trends 

Factor Contrast Trend 

Region NA Lateral > Anterior > Posterior > Medial 

Group NA Fentanyl > Morphine > Control 

Group | Region Cortical Lateral > Medial > Anterior > Posterior 

Group | Region Cortical Lateral > Posterior > Anterior > Medial 

Group | Region Cortical Lateral > Medial > Posterior > Anterior 

Region | Group Anterior Fentanyl > Morphine > Control 

Region | Group Lateral Fentanyl > Morphine > Control 

Region | Group Medial Morphine > Fentanyl > Control 

Region | Group Posterior Fentanyl > Morphine > Control 

dL.On Mean Aspect Ratio Trends 

Factor Contrast Trend 

Region NA Medial > Anterior > Posterior > Lateral 

Group NA Control > Morphine > Fentanyl 

Group | Region Cortical Posterior > Medial > Anterior > Lateral 

Group | Region Cortical Medial > Anterior > Lateral > Posterior 

Group | Region Cortical Anterior > Lateral > Posterior > Medial 

Region | Group Anterior Control > Morphine > Fentanyl 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Fentanyl > Control > Morphine 

Region | Group Posterior Control > Morphine > Fentanyl 

dL.On Mean Roundness Trends 

Factor Contrast Trend 

Region NA Posterior > Lateral > Anterior > Medial 

Group NA Fentanyl > Morphine > Control 

Group | Region Cortical Lateral > Anterior > Medial > Posterior 

Group | Region Cortical Posterior > Anterior > Lateral > Medial 

Group | Region Cortical Medial > Posterior > Anterior > Lateral 

Region | Group Anterior Fentanyl > Control > Morphine 

Region | Group Lateral Fentanyl > Control > Morphine 

Region | Group Medial Morphine > Control > Fentanyl 

Region | Group Posterior Fentanyl > Morphine > Control 

dL.On Mean Solidity Trends 

Factor Contrast Trend 

Region NA Lateral > Posterior > Anterior > Medial 

Group NA Fentanyl > Morphine > Control 

Group | Region Cortical Lateral > Medial > Posterior > Anterior 

Group | Region Cortical Lateral > Anterior > Posterior > Medial 

Group | Region Cortical Lateral > Medial > Posterior > Anterior 

Region | Group Anterior Fentanyl > Morphine > Control 
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Region | Group Lateral Fentanyl > Morphine > Control 

Region | Group Medial Morphine > Control > Fentanyl 

Region | Group Posterior Fentanyl > Morphine > Control 

tL.On Mean Area (um^2) Trends 

Factor Contrast Trend 

Region NA Medial > Posterior > Anterior > Lateral 

Group NA Morphine > Control > Fentanyl 

Group | Region Cortical Anterior > Posterior > Medial > Lateral 

Group | Region Cortical Medial > Posterior > Anterior > Lateral 

Group | Region Cortical Medial > Posterior > Lateral > Anterior 

Region | Group Anterior Control > Morphine > Fentanyl 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Morphine > Control > Fentanyl 

Region | Group Posterior Morphine > Control > Fentanyl 

tL.On Mean Circularity Trends 

Factor Contrast Trend 

Region NA Posterior > Medial > Anterior > Lateral 

Group NA Morphine > Control > Fentanyl 

Group | Region Cortical Anterior > Posterior > Lateral > Medial 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Medial > Posterior > Lateral > Anterior 

Region | Group Anterior Control > Morphine > Fentanyl 

Region | Group Lateral Control > Morphine > Fentanyl 

Region | Group Medial Morphine > Control > Fentanyl 

Region | Group Posterior Morphine > Control > Fentanyl 

tL.On Mean Aspect Ratio Trends 

Factor Contrast Trend 

Region NA Posterior > Medial > Anterior > Lateral 

Group NA Morphine > Control > Fentanyl 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Posterior > Medial > Anterior > Lateral 

Group | Region Cortical Posterior > Medial > Anterior > Lateral 

Region | Group Anterior Control > Morphine > Fentanyl 

Region | Group Lateral Control > Morphine > Fentanyl 

Region | Group Medial Morphine > Control > Fentanyl 

Region | Group Posterior Morphine > Control > Fentanyl 

tL.On Mean Roundness Trends 

Factor Contrast Trend 

Region NA Posterior > Medial > Anterior > Lateral 

Group NA Morphine > Control > Fentanyl 

Group | Region Cortical Anterior > Posterior > Lateral > Medial 
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Group | Region Cortical Posterior > Lateral > Anterior > Medial 

Group | Region Cortical Medial > Posterior > Lateral > Anterior 

Region | Group Anterior Control > Morphine > Fentanyl 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Morphine > Control > Fentanyl 

Region | Group Posterior Morphine > Control > Fentanyl 

tL.On Mean Solidity Trends 

Factor Contrast Trend 

Region NA Posterior > Medial > Lateral > Anterior 

Group NA Morphine > Control > Fentanyl 

Group | Region Cortical Lateral > Anterior > Posterior > Medial 

Group | Region Cortical Posterior > Anterior > Lateral > Medial 

Group | Region Cortical Medial > Posterior > Lateral > Anterior 

Region | Group Anterior Control > Fentanyl > Morphine 

Region | Group Lateral Control > Morphine > Fentanyl 

Region | Group Medial Morphine > Control > Fentanyl 

Region | Group Posterior Morphine > Fentanyl > Control 

Unlabeled Resorption Space Count (Rs.N) Trends 

Factor Contrast Trend 

Region NA Posterior > Anterior > Medial > Lateral 

Group NA Fentanyl > Morphine > Control 

Group | Region Cortical Anterior > Posterior > Medial > Lateral 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Posterior > Medial > Lateral > Anterior 

Region | Group Anterior Fentanyl > Control > Morphine 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Morphine > Fentanyl > Control 

Region | Group Posterior Fentanyl > Morphine > Control 

Active Remodeling Centers (a.Rm.Cr) (T.On + Rs.N) Trends 

Factor Contrast Trend 

Region NA Posterior > Anterior > Medial > Lateral 

Group NA Morphine > Control > Fentanyl 

Group | Region Cortical Anterior > Posterior > Medial > Lateral 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Region | Group Anterior Morphine > Control > Fentanyl 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Morphine > Fentanyl > Control 

Region | Group Posterior Morphine > Fentanyl > Control 

a.Rm.Cr/CA (a.Rm.Cr.OPD.CA) (#/mm^2) Trends 

Factor Contrast Trend 
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Region NA Posterior > Anterior > Medial > Lateral 

Group NA Morphine > Control > Fentanyl 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Posterior > Medial > Anterior > Lateral 

Region | Group Anterior Morphine > Control > Fentanyl 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Morphine > Fentanyl > Control 

Region | Group Posterior Morphine > Control > Fentanyl 

T.On/CA (T.On.OPD.CA) (#/mm^2) Trends 

Factor Contrast Trend 

Region NA Posterior > Anterior > Medial > Lateral 

Group NA Morphine > Control > Fentanyl 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Anterior > Posterior > Medial > Lateral 

Group | Region Cortical Posterior > Medial > Anterior > Lateral 

Region | Group Anterior Morphine > Control > Fentanyl 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Morphine > Fentanyl > Control 

Region | Group Posterior Morphine > Control > Fentanyl 

C.On/CA (C.On.OPD.CA) (#/mm^2) Trends 

Factor Contrast Trend 

Region NA Posterior > Anterior > Medial > Lateral 

Group NA Morphine > Control > Fentanyl 

Group | Region Cortical Anterior > Posterior > Medial > Lateral 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Posterior > Medial > Anterior > Lateral 

Region | Group Anterior Control > Morphine > Fentanyl 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Morphine > Fentanyl > Control 

Region | Group Posterior Morphine > Control > Fentanyl 

F.On/CA (F.On.OPD.CA) (#/mm^2) Trends 

Factor Contrast Trend 

Region NA Posterior > Anterior > Medial > Lateral 

Group NA Morphine > Control > Fentanyl 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Anterior > Medial > Posterior > Lateral 

Group | Region Cortical Posterior > Medial > Anterior > Lateral 

Region | Group Anterior Morphine > Fentanyl > Control 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Morphine > Fentanyl > Control 
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Region | Group Posterior Morphine > Control > Fentanyl 

sL.On/CA (sL.On.OPD.CA) (#/mm^2) Trends 

Factor Contrast Trend 

Region NA Anterior > Posterior > Medial > Lateral 

Group NA Morphine > Fentanyl > Control 

Group | Region Cortical Anterior > Posterior > Lateral > Medial 

Group | Region Cortical Medial > Anterior > Posterior > Lateral 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Region | Group Anterior Morphine > Fentanyl > Control 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Fentanyl > Morphine > Control 

Region | Group Posterior Morphine > Fentanyl > Control 

dL.On/CA (dL.On.OPD.CA) (#/mm^2) Trends 

Factor Contrast Trend 

Region NA Posterior > Medial > Anterior > Lateral 

Group NA Morphine > Control > Fentanyl 

Group | Region Cortical Anterior > Medial > Posterior > Lateral 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Medial > Posterior > Anterior > Lateral 

Region | Group Anterior Control > Morphine > Fentanyl 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Morphine > Control > Fentanyl 

Region | Group Posterior Morphine > Fentanyl > Control 

tL.ON/CA (tL.On.OPD.CA) (#/mm^2) Trends 

Factor Contrast Trend 

Region NA Posterior > Medial > Anterior > Lateral 

Group NA Control > Morphine > Fentanyl 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Medial > Posterior > Anterior > Lateral 

Region | Group Anterior Control > Morphine > Fentanyl 

Region | Group Lateral Control > Morphine > Fentanyl 

Region | Group Medial Morphine > Control > Fentanyl 

Region | Group Posterior Morphine > Control > Fentanyl 

Rs.N/CA (Rs.N.OPD.CA) (#/mm^2) Trends 

Factor Contrast Trend 

Region NA Posterior > Medial > Anterior > Lateral 

Group NA Morphine > Fentanyl > Control 

Group | Region Cortical Anterior > Posterior > Medial > Lateral 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Posterior > Medial > Lateral > Anterior 
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Region | Group Anterior Fentanyl > Control > Morphine 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Morphine > Fentanyl > Control 

Region | Group Posterior Fentanyl > Morphine > Control 

a.Rm.Cr/RA (a.Rm.Cr.OPD.RA) (#/mm^2) Trends 

Factor Contrast Trend 

Region NA Anterior > Medial > Posterior > Lateral 

Group NA Morphine > Control > Fentanyl 

Group | Region Cortical Lateral > Anterior > Medial > Posterior 

Group | Region Cortical Anterior > Medial > Posterior > Lateral 

Group | Region Cortical Medial > Posterior > Anterior > Lateral 

Region | Group Anterior Fentanyl > Morphine > Control 

Region | Group Lateral Control > Morphine > Fentanyl 

Region | Group Medial Morphine > Fentanyl > Control 

Region | Group Posterior Morphine > Fentanyl > Control 

T.On/RA (T.On.OPD.RA) (#/mm^2) Trends 

Factor Contrast Trend 

Region NA Anterior > Medial > Posterior > Lateral 

Group NA Morphine > Control > Fentanyl 

Group | Region Cortical Lateral > Anterior > Medial > Posterior 

Group | Region Cortical Anterior > Medial > Posterior > Lateral 

Group | Region Cortical Medial > Posterior > Anterior > Lateral 

Region | Group Anterior Morphine > Fentanyl > Control 

Region | Group Lateral Control > Morphine > Fentanyl 

Region | Group Medial Morphine > Fentanyl > Control 

Region | Group Posterior Morphine > Fentanyl > Control 

C.On/RA (C.On.OPD.RA) (#/mm^2) Trends 

Factor Contrast Trend 

Region NA Anterior > Medial > Posterior > Lateral 

Group NA Morphine > Control > Fentanyl 

Group | Region Cortical Anterior > Lateral > Medial > Posterior 

Group | Region Cortical Anterior > Medial > Posterior > Lateral 

Group | Region Cortical Medial > Anterior > Posterior > Lateral 

Region | Group Anterior Control > Morphine > Fentanyl 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Morphine > Control > Fentanyl 

Region | Group Posterior Morphine > Fentanyl > Control 

F.On/RA (F.On.OPD.RA) (#/mm^2) Trends 

Factor Contrast Trend 

Region NA Anterior > Medial > Posterior > Lateral 

Group NA Morphine > Fentanyl > Control 
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Group | Region Cortical Lateral > Anterior > Posterior > Medial 

Group | Region Cortical Anterior > Medial > Posterior > Lateral 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Region | Group Anterior Morphine > Fentanyl > Control 

Region | Group Lateral Control > Morphine > Fentanyl 

Region | Group Medial Fentanyl > Morphine > Control 

Region | Group Posterior Morphine > Control > Fentanyl 

sL.On/RA (sL.On.OPD.RA) (#/mm^2) Trends 

Factor Contrast Trend 

Region NA Anterior > Medial > Posterior > Lateral 

Group NA Morphine > Fentanyl > Control 

Group | Region Cortical Anterior > Lateral > Posterior > Medial 

Group | Region Cortical Anterior > Medial > Posterior > Lateral 

Group | Region Cortical Anterior > Posterior > Medial > Lateral 

Region | Group Anterior Fentanyl > Morphine > Control 

Region | Group Lateral Control > Morphine > Fentanyl 

Region | Group Medial Fentanyl > Morphine > Control 

Region | Group Posterior Morphine > Fentanyl > Control 

dL.On/RA (dL.On.OPD.RA) (#/mm^2) Trends 

Factor Contrast Trend 

Region NA Medial > Anterior > Posterior > Lateral 

Group NA Morphine > Control > Fentanyl 

Group | Region Cortical Anterior > Medial > Posterior > Lateral 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Medial > Posterior > Lateral > Anterior 

Region | Group Anterior Control > Morphine > Fentanyl 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Morphine > Control > Fentanyl 

Region | Group Posterior Morphine > Fentanyl > Control 

tL.ON/RA (tL.On.OPD.RA) (#/mm^2) Trends 

Factor Contrast Trend 

Region NA Posterior > Medial > Anterior > Lateral 

Group NA Control > Morphine > Fentanyl 

Group | Region Cortical Anterior > Posterior > Medial > Lateral 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Medial > Posterior > Lateral > Anterior 

Region | Group Anterior Control > Fentanyl > Morphine 

Region | Group Lateral Control > Morphine > Fentanyl 

Region | Group Medial Morphine > Control > Fentanyl 

Region | Group Posterior Control > Morphine > Fentanyl 

Rs.N/RA (Rs.N.OPD.RA) (#/mm^2) Trends 
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Factor Contrast Trend 

Region NA Posterior > Medial > Anterior > Lateral 

Group NA Fentanyl > Morphine > Control 

Group | Region Cortical Medial > Lateral > Anterior > Posterior 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Medial > Posterior > Lateral > Anterior 

Region | Group Anterior Fentanyl > Control > Morphine 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Morphine > Control > Fentanyl 

Region | Group Posterior Fentanyl > Morphine > Control 

T.On / Rs.N Trends 

Factor Contrast Trend 

Region NA Anterior > Posterior > Medial > Lateral 

Group NA Control > Morphine > Fentanyl 

Group | Region Cortical Posterior > Anterior > Lateral > Medial 

Group | Region Cortical Medial > Anterior > Posterior > Lateral 

Group | Region Cortical Anterior > Posterior > Medial > Lateral 

Region | Group Anterior Morphine > Control > Fentanyl 

Region | Group Lateral Control > Morphine > Fentanyl 

Region | Group Medial Morphine > Fentanyl > Control 

Region | Group Posterior Control > Morphine > Fentanyl 

On.MAR.I.dL (dL Inner Labels) (um/day) Trends 

Factor Contrast Trend 

Region NA Anterior > Posterior > Medial > Lateral 

Group NA Control > Morphine > Fentanyl 

Group | Region Cortical Medial > Posterior > Anterior > Lateral 

Group | Region Cortical Anterior > Medial > Posterior > Lateral 

Group | Region Cortical Posterior > Lateral > Anterior > Medial 

Region | Group Anterior Fentanyl > Control > Morphine 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Control > Morphine > Fentanyl 

Region | Group Posterior Control > Morphine > Fentanyl 

On.MAR.I (Inner Labels) (um/day) Trends 

Factor Contrast Trend 

Region NA Posterior > Anterior > Medial > Lateral 

Group NA Control > Morphine > Fentanyl 

Group | Region Cortical Posterior > Medial > Anterior > Lateral 

Group | Region Cortical Anterior > Medial > Lateral > Posterior 

Group | Region Cortical Posterior > Anterior > Lateral > Medial 

Region | Group Anterior Fentanyl > Morphine > Control 

Region | Group Lateral Morphine > Control > Fentanyl 
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Region | Group Medial Control > Fentanyl > Morphine 

Region | Group Posterior Control > Morphine > Fentanyl 

On.MAR.C (Combined Labels) (um/day) Trends 

Factor Contrast Trend 

Region NA Posterior > Medial > Anterior > Lateral 

Group NA Control > Morphine > Fentanyl 

Group | Region Cortical Posterior > Medial > Anterior > Lateral 

Group | Region Cortical Anterior > Medial > Posterior > Lateral 

Group | Region Cortical Posterior > Medial > Anterior > Lateral 

Region | Group Anterior Fentanyl > Control > Morphine 

Region | Group Lateral Control > Morphine > Fentanyl 

Region | Group Medial Control > Morphine > Fentanyl 

Region | Group Posterior Control > Morphine > Fentanyl 

Osteon Formation Time (W.Th.C / On.MAR.I.dL) (days) Trends 

Factor Contrast Trend 

Region NA Posterior > Lateral > Medial > Anterior 

Group NA Fentanyl > Morphine > Control 

Group | Region Cortical Anterior > Medial > Posterior > Lateral 

Group | Region Cortical Lateral > Posterior > Anterior > Medial 

Group | Region Cortical Medial > Posterior > Lateral > Anterior 

Region | Group Anterior Fentanyl > Control > Morphine 

Region | Group Lateral Fentanyl > Morphine > Control 

Region | Group Medial Morphine > Fentanyl > Control 

Region | Group Posterior Fentanyl > Morphine > Control 

Osteon Formation Time (W.Th.C / On.MAR.I) (days) Trends 

Factor Contrast Trend 

Region NA Lateral > Posterior > Medial > Anterior 

Group NA Fentanyl > Morphine > Control 

Group | Region Cortical Anterior > Medial > Posterior > Lateral 

Group | Region Cortical Lateral > Posterior > Anterior > Medial 

Group | Region Cortical Medial > Lateral > Posterior > Anterior 

Region | Group Anterior Control > Fentanyl > Morphine 

Region | Group Lateral Fentanyl > Morphine > Control 

Region | Group Medial Morphine > Control > Fentanyl 

Region | Group Posterior Fentanyl > Morphine > Control 

Osteon Formation Time (W.Th.C / On.MAR.C) (days) Trends 

Factor Contrast Trend 

Region NA Lateral > Posterior > Medial > Anterior 

Group NA Fentanyl > Morphine > Control 

Group | Region Cortical Anterior > Medial > Posterior > Lateral 

Group | Region Cortical Lateral > Posterior > Anterior > Medial 
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Group | Region Cortical Medial > Lateral > Posterior > Anterior 

Region | Group Anterior Control > Fentanyl > Morphine 

Region | Group Lateral Fentanyl > Morphine > Control 

Region | Group Medial Morphine > Fentanyl > Control 

Region | Group Posterior Fentanyl > Morphine > Control 

Ac.F.I.dL ((C.On.OPD.CA/OFT.I.dL)*365) (#/mm^2/year) Trends 

Factor Contrast Trend 

Region NA Posterior > Anterior > Medial > Lateral 

Group NA Morphine > Control > Fentanyl 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Region | Group Anterior Morphine > Control > Fentanyl 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Morphine > Control > Fentanyl 

Region | Group Posterior Morphine > Control > Fentanyl 

Ac.F.I ((C.On.OPD.CA/OFT.I)*365) (#/mm^2/year) Trends 

Factor Contrast Trend 

Region NA Posterior > Anterior > Medial > Lateral 

Group NA Morphine > Control > Fentanyl 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Anterior > Medial > Posterior > Lateral 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Region | Group Anterior Morphine > Control > Fentanyl 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Morphine > Control > Fentanyl 

Region | Group Posterior Morphine > Control > Fentanyl 

Ac.F.C ((C.On.OPD.CA/OFT.C)*365) (#/mm^2/year) Trends 

Factor Contrast Trend 

Region NA Posterior > Anterior > Medial > Lateral 

Group NA Morphine > Control > Fentanyl 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Group | Region Cortical Posterior > Anterior > Medial > Lateral 

Region | Group Anterior Morphine > Control > Fentanyl 

Region | Group Lateral Morphine > Control > Fentanyl 

Region | Group Medial Morphine > Control > Fentanyl 

Region | Group Posterior Morphine > Control > Fentanyl 
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Appendix XXIX: Andronowski Lab Rabbit Daily Check Log 

Date: 4/16/19 
Personnel: JMA, Reed, Gina, Adam, Beth 
Notetaker: JMA 
Time In: 12:15 PM 

Tasks Performed (Dosing, Exercise, etc.): N/A - Acclimation 

Changes in Behavior (Lethargy, Hyperactivity, etc.): 

Health Concerns: Ear tattoos are scabbed over and ears somewhat bruised -- this is consistent for all 
animals. 

Vet Checks Requested?: N/A 

Any Additional Notes: 
- Arrival day! 
- Animals arrived at 11:45 A.M. 
- Unboxed the animals and weighed each one. 
- Spinach was provided for enrichment/since no rabbit diet is provided on day one. 
- Basic health checks performed. Looked for discharge from eyes/nose, brightness of eyes, 

condition of fur, any scratches on ears, and behavioral changes. 
- Ear tattoos are scabbed over and ears somewhat bruised -- this is consistent for all 

animals. 
- 01 appeared more stressed than the others. Sclera showing, rapid breathing, crouched in corner. 

Date: 4/17/19 
Personnel: JMA, Adam, Gina, Abbie 
Notetaker: JMA 
Time In: 8:10 AM 
Tasks Performed (Dosing, Exercise, etc.): N/A - Acclimation 

Temperature: 71.4 
Humidity: 43% 
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---------------------------------------------------------------------------------------------------------------------

Changes in Behavior (Lethargy, Hyperactivity, etc.): 

Health Concerns: #17, Left rear 1st digit inflammation 

Vet Checks Requested?: #17 for L 1st rear digit inflammation and overgrooming. Text message sent to 
Stan with photo. 

Any Additional Notes: 
- Issue with HVAC chiller being shut off overnight. Temperature jumped to 76 degrees in rabbit 

room with no alert. Facilities were notified. Dr. A to follow up. 
- Any leftover spinach removed, and new spinach provided. 
- 01 had minimal fecal output but his rapid breathing has subsided, did not consume all spinach and 

drank minimal water. 
- 08 had minimal fecal output and cecotropes fell through cage. 
- 10 had minimal fecal output. 
- 13 had normal fecal output (a large amount). 
- 14 is very active. 
- 15 appears to have water bottle leakage. 
- 16 low fecal output. 
- 17 no urine and minimal fecal output, minimal water consumed, minimal spinach/hay eaten. 

Appears somewhat stressed, elevated breathing, in corner of cage. 
- 20 minimal food intake, normal fecal and urine output. 
- Update: Beth contacted JMA and Adam at 12:10 P.M. and indicated that 17 was excessively 

grooming its left hind limb. JMA, Adam, Reed responded immediately to assess the animal. 
Found inflammation of first digit, some hair had been groomed away. 

- 17 also urinated and ate both rabbit diet/spinach. 

Date: 4/18/19 
Personnel: Tubo, Schuller, Andronowski 
Notetaker: Tubo 
Time In: 8:20 
Tasks Performed (Dosing, Exercise, etc.): N/A - Acclimation 

Temperature: 68.4 F 
Humidity: 47% 

Changes in Behavior (Lethargy, Hyperactivity, etc.): 09 was chewing the plastic in his pan, 11 was a 
little timid 

2018-DU-BX-0188 Final Technical Report 
October 2021 

This resource was prepared by the author(s) using Federal funds provided by the U.S. 
Department of Justice. Opinions or points of view expressed are those of the author(s) and do not 

necessarily reflect the official position or policies of the U.S. Department of Justice.

525 



 
 

  
 

 
 

  
 

    
   

 
  

  
    

 
 

  
 

 
 

  
   
  

 
  

 
  

  
 

  
 

  
   

 
   

 
  

 
   

 
 

 
 

 
 

 

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------

Health Concerns: 15 had signs of dried foreign brown material on cage pan and on tail (not fresh, it is 
old and dried), 17 fur chewed on rear left toe (contacted vet 4-17-19), 20 had minimal fecal output 
(attributed to stress from novel environment) 

Vet Checks Requested?: No 

Any Additional Notes: Enrichment given in the form of papaya tablets, spinach, and metal bowls. Most 
rabbits seem to like to play with the rabbit bowls. 

JMA 2:45 P.M. update: Rabbits 7,8,9,10,11,13,16,17,18,19,20 flipped their bowls and so the papaya 
tablets fell through the cage bottom. The UARV staff disposed of them. I gave each of these rabbits a new 
tablet in their food feeders. We should place the tablets in the food feeders from now on so they do not 
fall through. 

UARV staff also asked us to make sure we fill in the food enrichment log each day. The binder is on the 
cart with the others. 

Date: 4/19/19 
Personnel: Reed and JMA 
Notetaker: Reed 
Time In: 8:00 
Tasks Performed (Dosing, Exercise, etc.): N/A - Acclimation 

Temperature: 69.4 
Humidity: 58% 

Changes in Behavior (Lethargy, Hyperactivity, etc.): 
#11 still a little timid 
Health Concerns: 
#7 has weirdly shaped feces. Normal quantity, but seem small or weirdly shaped. 
#11 also has weirdly shaped feces. Same notes as #7. 
#20 has dark urine, still normal amounts. Also has dried feces on cage, not as much as #15. 

Vet Checks Requested?: N/A 

Any Additional Notes: Vet check completed for #17. Swollen posterior ⅔ of left rear 2nd digit. No 
treatments as of now. 
#15 drinking a lot. His water spilled through the night. Maybe just parched? 

Two fire alarms in the afternoon - 2:45 and 4:00 P.M. Rabbits seem stressed when we checked on them 
(frozen in cages). 
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Date: 4/20/19 
Personnel: Reed and Adam 
Notetaker: Reed 
Time In: 8:00 
Tasks Performed (Dosing, Exercise, etc.): Weighed all rabbits, Acclimation 

Temperature: 65.5 
Humidity: 45% 

Changes in Behavior (Lethargy, Hyperactivity, etc.): 
#5 and #7 and shedding, possibly stressed 

Health Concerns: 
More dried diarrhea on #15 and in #15’s cage than yesterday. Now dried diarrhea on his nose. 
Adam: do you think we should report this to Stan for a vet check? JMA 

#20 has cecotropes in cage that he didn’t eat. 

Vet Checks Requested?: N/A 

Any Additional Notes: #14 is the witchling. Ripped both gloves to shreds when removing for weighing. 
Aggressive. #17’s toe fur is growing back. 

Do you mean #17?! JMA - Yes. Adam and I were talking about #15 as I was writing this. Sorry. (RAD) 

Date: 4/21/19 
Personnel: Reed and Adam 
Notetaker: Reed 
Time In: 8:01 
Tasks Performed (Dosing, Exercise, etc.): Enrichment food, health checks. 

Temperature: 66.0 
Humidity: 43% 

Changes in Behavior (Lethargy, Hyperactivity, etc.): N/A 

Health Concerns: N/A 

Vet Checks Requested?: N/A 
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---------------------------------------------------------------------------------------------------------------------

Any Additional Notes: MacBook no longer working. Restarted itself overnight and it is trying to install 
updates which fail. Can use Reed’s old laptop if needed. Don’t believe pads were changed yesterday. 

#5 does not eat the papaya tablets. Just licks them and leaves them alone. 

Date: 4/22/19 
Personnel: JMA, Adam, Abbie 
Notetaker: JMA, Abbie filling in logs 
Time In: 8:00 A.M. 
Tasks Performed (Dosing, Exercise, etc.): First day of exercise, enrichment foods, health checks, nail 
trimming. 

Temperature: 65.5 
Humidity: 47.5 % 

Changes in Behavior (Lethargy, Hyperactivity, etc.): 
#11 still more timid than others. 

Health Concerns: 
Dried diarrhea on #15’s cage pan. Does not seem to be any worse than previous days, however. 

Vet Checks Requested?: No 

Any Additional Notes: 
A spreadsheet will be created today to track the weights of the animals over time. 
All rabbits seem to be shedding -- is consistent among the animals. Could be due to stress or temperature 
adjustment. 

Group 1: Animals 01-07. #01 placed at 8:20 A.M. and each rabbit followed about 4 minutes later. 
Dumbbells from their cages placed with them. 

All seem to be adjusting to the exercise pen and exploring, eating some shavings. #2 especially active, did 
try to jump out of the top once. #3 eats a lot of shavings, he also found a large stick in the shavings and 
we discarded this. 

Group 2: Animals 08-14. #08 placed at 9:10 A.M. Not as active as the group 1 rabbits. #10 almost fell 
asleep. 

Group 3: Animals 15-21. #15 placed at 10:00 A.M. Also not as active as group 1 rabbits. All are relaxed, 
just not moving around as much. 

Date: 4/23/19 
Personnel: Reed, Gina 
Notetaker: Reed, Gina filling in logs 
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Time In: 8:03 A.M. 
Tasks Performed (Dosing, Exercise, etc.): Health checks and enrichment food. UARV cleaning 
batteries. 

Temperature: 66.0 
Humidity: 53.0% 

Changes in Behavior (Lethargy, Hyperactivity, etc.): 
#11 still more timid than others. 

Health Concerns: 
Two spots of diarrhea on #15’s pad per Beth. Does not seem to be any worse than previous days, 
however. 
#1 and #5 have urine with high protein content. The type that congeals in the corners. 

Vet Checks Requested?: No 

Any Additional Notes: 
#4 Had a little bit of food leftover. Only about 10 pellets. 

#13 pushed new water bottle out of holder and shattered it on the floor. Reed cleaned up broken glass and 
mopped the water. Replaced with plastic bottle, may need more. Proceeded to knock it out 3 more times, 
it is now inside his cage. 

Beth also suggested extra water bottles in the exercise pens otherwise it is a restriction and we have to 
report it in a protocol change to USDA and IACUC. 
---------------------------------------------------------------------------------------------------------------------Date: 
4/24/19 
Personnel:  Adam, Abbie 
Notetaker: Abbie 
Time In: 8:00 A.M. 
Tasks Performed (Dosing, Exercise, etc.): Exercise, enrichment foods, health checks. 

Temperature: 67.0 
Humidity: 44.5 % 

Changes in Behavior (Lethargy, Hyperactivity, etc.):
 None 

Health Concerns: 
A lot of dried diarrhea on #15’s cage pan and noted diminished flesh condition and rough fur condition. 

Vet Checks Requested?: Yes, vet check on cage 
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Any Additional Notes: The following animals all had either a little (#03, 04, 05, 08, 10, 17) or a lot (#13, 
19, 21) of food left in their trough. 

Control: Animals- control group. #04 placed at 8:15 A.M. and each rabbit followed about 3 minutes later. 
Jingle balls placed in cages. 

Fentanyl: Animals-fentanyl group . #01 placed at 9:05 A.M. Animal #03 did attempt to jump out of the 
exercise pen one time. 

Morphine: Animals- morphine group. #08 placed at  9:55 A.M. Animal #12 sprayed urine out of the cage 
onto the floor. 

**NOTE: the same jingle balls were in the exercise pens for all three groups as the only enrichment 
device in the cage was a rattle. 

All rabbits acting normal in cages and playing with their toys, all rabbits water was transported to the 
exercise pen with them; however, none of them drank any of their water while in the exercise pens and 
the springs were difficult to use to attach water bottles to exercise pens. 

Date: 4/25/19 
Personnel:  Adam, Reed 
Notetaker: Adam (logs), Reed (PC) 
Time In: 8:00 A.M. 
Tasks Performed (Dosing, Exercise, etc.): Enrichment foods, health checks. 

Temperature: 65.5 
Humidity: 47.0 % 

Changes in Behavior (Lethargy, Hyperactivity, etc.):
 All rabbits a little timid after cages being changed into new arrangement (separated into groups and then 
re-arranged to correct mistake last night) 

Health Concerns: 
Animal #15 - ongoing diarrhea and diminished flesh and fur condition 

Vet Checks Requested?: 
Same as previous day - see Dr. Dannemiller’s email for details.  

Any Additional Notes: 
All rabbits given approximately ⅓ of a carrot as enrichment (first time this enrichment food has been 
administered) all rabbits expressed interest in this and are either eating or smelling the carrot (some are 
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also tossing it around like a toy). We will continue to monitor the intake of this novel enrichment food 
tomorrow. 

Date: 4/26/19 
Personnel:  Adam and Reed 
Notetaker: Reed (logs) and Adam (computer) 
Time In: 8:00 A.M. 
Tasks Performed (Dosing, Exercise, etc.): Exercise, enrichment foods, health checks. 

Temperature: 65.5 *F 
Humidity:  66% 

Changes in Behavior (Lethargy, Hyperactivity, etc.):
 Number 03 did seem a bit more lethargic than he has previously. Noted that he had almost a full serving 
of food remaining. We will monitor this closely. 

Health Concerns: 
04, 14, 15 are all exhibiting signs of diarrhea. (14 is very slight so we will watch him for now). 04 had a 
fair amount of soiling on his fur so we placed a vet check card in his cage as well as the recurring one in 
number 15’s cage. 

Vet Checks Requested?: 04 (as well as recurring 15) 

Any Additional Notes: 
Carrots seemed to be better received today compared to yesterday. Many rabbits now have orange stains 
on the fur from eating this. #06 repetitive sneezing with no substantive nasal discharge. 

Control: Placed #04 at 8:10 A.M. and each subsequent animal 1 minute after this. All animals showed 
signs of activity and enjoyed playing in the pen with jingle balls. Number 06 ate a fair amount of 
shavings. All animals exhibiting digging behaviors. 14 did drink a little from his water bottle.  

Morphine: Placed #21 at 9:05 A.M. and each subsequent animal 1 minute after this. Number 12 is very 
energetic when it comes to the playpen and tried to jump out once. 

Fentanyl: Placed #01 at 9:55 A.M. and each subsequent animal 1 minute after this. Number 02 attempted 
to jump out two times. Number 03 showed much more interest in moving than he did in his cage. Number 
13 very energetic and active 

Date: 4/27/19 
Personnel:  Gina and Abbie 
Notetaker: Gina 
Time In: 8:00 am 
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Tasks Performed (Dosing, Exercise, etc.): Exercise, enrichment foods, health checks. 

Temperature: 65.5 F 
Humidity: 45 % 

Changes in Behavior (Lethargy, Hyperactivity, etc.): 
N/A 

Health Concerns: 
04, 07, 10, 14, 15 are all exhibiting signs of diarrhea. (14 is very slight so we will watch him for now). 
Vet check cards still on 15 and 4. 

Vet Checks Requested?: 
4 and 15 - still in from previous day 
Any Additional Notes: 13 had low water, not sure if he knocked it down again or he has high water 
intake 

Control: 04 - low food intake and some diarrhea present, 06 - sneezing (as noted in previous days) and 
little food intake, 07 - little diarrhea, 14 - little food intake 

Fentanyl: 01 - little food intake, 13 - lots of food left and low water (possibly because of bottle leakage), 

Morphine: 10 - little food left, some diarrhea, 21 - little diarrhea 

Date: 4/28/19 
Personnel:  Reed and Abbie 
Notetaker: Abbie 
Time In: 8:00 am 
Tasks Performed (Dosing, Exercise, etc.): Enrichment foods, health checks. 

Temperature: 65.0 F 
Humidity: 45.0 % 

Changes in Behavior (Lethargy, Hyperactivity, etc.): 
N/A 

Health Concerns: 
15 still has ongoing diarrhea and 3 still is not eating very much. 

Vet Checks Requested?: 
4 and 15 - still in from previous day 
Any Additional Notes: 
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13’s water was empty, it leaked, we have made a note to the vivarium asking for a new bottle since this 
problem is ongoing 
Control:4,5 6 had lots of food left, 15 still has diarrhea 

Fentanyl: 1-lots of food left, 3- almost all food left, 13 has a medium amount of food left. 

Morphine: 10 lots of food left, 11 little food left 17 has a small amount of secatrop, 21 has a little food 
left 

Date: 4/29/19 
Personnel:  Reed, Abbie, JMA 
Notetaker: Abbie 
Time In: 8:00 am 
Tasks Performed (Dosing, Exercise, etc.): Exercise, Weighing, Enrichment foods, health checks. 

Temperature: 66.0 F 
Humidity: 45.0 % 

Changes in Behavior (Lethargy, Hyperactivity, etc.):
 #3 ate substantially more than the previous couple days. Still had food left, but not his entire ration. 

Lots of food left: 1, 4, 5, 6, 10, 14 
Little food left: 3, 13, 21 

17 had less than average fecal output, but doesn’t appear shockingly less. Monitor. 

Health Concerns: 
15 still has ongoing diarrhea and it appears to be more liquid now, 15 also has dark urine and 3 still is not 
eating very much. 

Vet Checks Requested?: 
4 and 15 - still in from previous day 

Any Additional Notes: 

Control: First rabbit went into exercise pen at 8:10, last rabbit in at 8:15 

Fentanyl: First rabbit into exercise pen at 9:40, last in at 9:45 

Morphine: First rabbit went into exercise pen at 8:55, last in at 9:00 

All rabbits acting normal in exercise pens and are still enjoying the jingle balls. 
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_______________________________________________________________ 

Date: 4/30/19 
Personnel:  Reed, Adam, Gina 
Notetaker: Reed 
Time In: 8:00 am 
Tasks Performed (Dosing, Exercise, etc.): Enrichment (kale), clipping, health checks 

Temperature: 65.5 F 
Humidity: 48.0 % 

Changes in Behavior (Lethargy, Hyperactivity, etc.): N/A 

Health Concerns: Ongoing #15 diarrhea, #3 still ate more than he has previously, but there is still a lot of 
food left in his trough. 

Vet Checks Requested?: Cathy requested one for #3 not eating. 

Any Additional Notes: Finished the rest of the kale, still have carrots and carrot tops. 

Control: The patch controls were shaved today 
Fentanyl: Animals were shaved today. #2 and #3 are not fans of the clippers. 
Morphine: none 

Date: 5/01/19 
Personnel:  Reed, Adam, Gina, Abbie, JMA *everyone present since it is the first dosing day. 
Notetaker: JMA 
Time In: 8:00 am 
Tasks Performed (Dosing, Exercise, etc.): Enrichment (carrots), clipping #15, health checks, first 
narcotic dosing day. 

Temperature: 66 F 
Humidity: 65.0 % 

Changes in Behavior (Lethargy, Hyperactivity, etc.): N/A 

Health Concerns: #15 ongoing diarrhea, #6 lower fecal output, #3 ate all pellets and enrichment and 
fecal output appears normal. 

#s 11, 2, 3, 20 appear most heavily sedated from the first treatments. Most notably 3 (fentanyl) and 11 
(morphine). All animals monitored by Beth’s team around noon, and Andronowski Lab at 2:00 and 4:00 
P.M. By 4:00, the animals seemed more alert. 
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_______________________________________________________________ 

Vet Checks Requested?: N/A 

Any Additional Notes: Still have carrots and carrot tops. Spinach and kale purchased by JMA and Adam 
today. Need more papaya tablets. 

#13 water bottle still leaking and he did not have water this morning. Bottle and sipper were replaced. 
Rabbit 2 jumping around has a lot of energy after patch placement, seems to not like it. 
Rabbit 3 began exhibiting effects such as lethargy aprox 20 minutes after patch placement. Rabbit 16 is 
also exhibiting some of this very relaxed behavior. 
Rabbit 10 exhibited a large amount of eflux from the injection. 
Rabbit 17 exhibited a small amount of eflux from the injection. 
#2 consistent chewing of tegaderm around patch. Decided to replace patch at 10:40. 
#18 patch control panicking during patch placement. Took 4 attempts to adhere tegaderm. Removed patch 
by noon. Will reapply tomorrow. 

We will shave all morphine and control rabbits tomorrow to ensure this does not happen again. 

Exercising: 

Control: First rabbit placed at 9:05. Activity level comparable to previous days. 
Fentanyl: First rabbit #1 in pen at 8:10. Exercising this group first since today is their first dosing day. 
Activity level comparable to previous days (since not dosed beforehand). 
Morphine: First rabbit placed at 9:55. Number 11 did exhibit less playing behavior than normal - unsure 
if this is due to the dosing or not. Number 08 is exhibiting the same type of behavior. Number 20 
exhibiting this behavior as well. All rabbits eventually exhibited behavior like this with the exception of 
10 and 17 who we believed did not receive the full dose. 

Date: 5/02/19 
Personnel:  Reed, Adam, JMA delivered food enrichment 
Notetaker: Adam 
Time In: 8:10 am 
Tasks Performed (Dosing, Exercise, etc.): Enrichment (Spinach), clipping #04, 05, 08, 10, 11, 12, 14, 
17, 20, 21, health checks, morphine dosing day, patch readministration. 

Temperature: 68 F 
Humidity: 61.5 % 

Changes in Behavior (Lethargy, Hyperactivity, etc.): Rabbits returned to normal behavior after 
departure from this yesterday (given first day of dosing). All morphine rabbits are very lethargic post-
dosing. 

Health Concerns: #15 ongoing diarrhea, #3 low fecal output. 
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_______________________________________________________________ 

#10, 17 appear most heavily sedated from their first full treatments. After about a half hour, they appear 
less heavily sedated. All animals exhibiting similar effects. 
#17 scratched a lot at his shaved area, leaving abrasions. 
#11 appears heavily sedated 

Vet Checks Requested?: N/A 

Any Additional Notes: Need more papaya tablets. 
Rabbit #02 had fentanyl patch readministered. All control tegaderm rabbits had this treatment 
readministered. All rabbits are now shaved. #2 is still annoyed by his patch. #18 still hates his tegaderm. 

UPDATE (4:30 PM) All rabbits appear to be back to normal activity and behavior. All the controls have 
removed their Tegaderm patches. #2 once again removed his patch and it was lying on the floor of his 
cage. Reed removed it and disposed of it in the biohazard bin. Reed then readministered another patch to 
#2 a bit closer to his neck, but still well in the shaved, scapular region and covered with Tegaderm. Cathy 
came in to check on the rabbits water saw 13 fling his sipper from side to side to dislodge it. 

Date: 5/03/19 
Personnel:  Gina, Adam 
Notetaker: Adam 
Time In: 8:35 am 
Tasks Performed (Dosing, Exercise, etc.): Enrichment (Spinach), health checks, morphine dosing day, 
patch readministration, exercise. 

Temperature: 66 F 
Humidity: 68.5 % 

Changes in Behavior (Lethargy, Hyperactivity, etc.): Rabbits returned to normal behavior after 
departure from this yesterday (given first day of dosing). All morphine rabbits are very lethargic post-
dosing. 

Health Concerns: #15 ongoing diarrhea, #3 low fecal output, #7 and #17 received ointment 
administration. 

Vet Checks Requested?: N/A 

Any Additional Notes: Rabbit #02 had fentanyl patch readministered because he had eaten most of his 
previous patch (we found about ½ of a patch in the cage). 

Exercising: 
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Control: #04 placed at 8:45 A.M. with each subsequent animal being placed approximately 1 minute 
after this. All rabbits seemed fairly active. Water and bone transferred from cage. 

Morphine: #08 placed at 9:45 A.M. with each rabbit placed around 1 minute after this. All rabbits very 
active and energetic. Water and bone transferred from cage. 

Fentanyl: #01 placed at 10:35 A.M. with each rabbit placed shortly after. All rabbits energetic and 
moving around except #02 who had just received patch readministration. Water and bone enrichment 
transferred from cage. #16 tried to escape one time. 

All Morphine rabbits appear very lethargic and exhibit slowed activity and breathing at 11:21 A.M. about 
one hour after dosing was complete.  

5:10 PM update: JMA went to NEOMED to retrieve rabbit jackets from Dr. Dannemiller. JMA and Reed 
placed jacket on number 2. He is not happy, but will control patch disturbance. Will need to monitor him. 

All other animals have returned to normal after dosing. 

Date: 5/04/19 
Personnel:  Gina, Adam 
Notetaker: Gina 
Time In: 8:00 AM 
Tasks Performed (Dosing, Exercise, etc.): Enrichment (kale and papaya tablets), health checks, 
morphine dosing day, fentanyl dosing day 

Temperature: 65.5 F 
Humidity: 55.5 % 

Changes in Behavior (Lethargy, Hyperactivity, etc.): 

Health Concerns: 05 and 11 did not receive water overnight (it leaked out), 

Vet Checks Requested?: N/A 

Any Additional Notes: 02 seems upset about the jacket (otherwise, behavior is normal) 

Exercising: no exercising 

Control: 05 had an empty bottle (appeared to leak overnight), 05 had a little food leftover 
Morphine: 11 had an empty bottle (appeared to leak overnight): 08, 10, 11, 17, 21 had most of their food 
leftover, 08 also did not eat the spinach enrichment food 
Rabbit #21 had a fair amount of eflux out of the injection site. All rabbits showing signs of sedation by 
approximately 20 minutes after dosing, maintained until we left the rabbit room. 
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---------------------------------------------------------------------------------------------------------------------

Fentanyl: 01, 02 had most of their food leftover 
All fentanyl rabbits were trying to scratch off the tegaderm so we put a vest on all of them. The rabbits do 
not appear to be showing the signs of sedation previously demonstrated on day one of dosing. 

Date: 5/05/19 
Personnel:  JMA, Abbie 
Notetaker: Abbie 
Time In: 8:00 AM 
Tasks Performed (Dosing, Exercise, etc.): Enrichment (kale and papaya tablets), health checks, 
morphine dosing day, saline controls 
Temperature: 66.5 F 
Humidity: 55.0% 

Changes in Behavior (Lethargy, Hyperactivity, etc.): 

Health Concerns: 01, 09, 05, and 20 did not receive water overnight (it leaked out), they started drinking 
a lot when it was refilled this morning. A buildup of food and water was also noted at the bottom of 01’s 
food trough, this is likely from the water leaking, it was cleaned with a cavi wipe. 09 has diarrhea and 15 
still has diarrhea. 20 did not eat his enrichment kale yesterday, it was replaced with a carrot today. 18 
managed to wiggle one leg out of his vest, we put the vest back on him properly. Rabbit 02 has low fecal 
output. Rabbits 02, and 03, have lots of food left from yesterday. Rabbit 16 seems nervous. 

Vet Checks Requested?: N/A 

Any Additional Notes: 

Exercising: no exercising 

Control: All vests were checked and zippers fixed if needed. 
Morphine: First injection given at 8:57, rabbits began showing effects such as slight sedation within 20 
minutes. 10 eflux noted upon dosing. 
Fentanyl: All vests checked and zippers fixed if needed. 

Date: 5/06/19 
Personnel: Gina, Adam 
Notetaker: Gina 
Time In: 8:00 AM 
Tasks Performed (Dosing, Exercise, etc.): Enrichment (carrot and papaya tablets), health checks, 
morphine dosing day, saline controls, exercise, weight checks 
Temperature: 66.0 F 
Humidity: 48.0% 
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Changes in Behavior (Lethargy, Hyperactivity, etc.): morphine rabbits very active in pens prior to 
dosing, 15 slipped out of vest (placed a new vest on him), 17 sprayed urine on the floor 

Health Concerns:. 

Vet Checks Requested?: N/A 

Any Additional Notes: 

Exercising: all rabbits exercised for 45 minutes, control group in at 8:30, morphine group in at 9:30, 
fentanyl group in at 10:20 

Control: 15 slipped front feet out of vest, all rabbits active and playing with shavings. 
Morphine: 17 sprayed urine on floor, all rabbits fairly active. 
Fentanyl: 09 diarrhea on vest, 19 right eye clear ophthalmic discharge and fur loss on rear left leg (vet 
check filled out), #s 02 and 03 both slipped a foot out of the vest in the exercise pen. All rabbits chewing 
on vests in pens and not really moving. 

Date: 5/07/19 
Personnel: Gina, Reed 
Notetaker: Reed 
Time In: 8:00 AM 
Tasks Performed (Dosing, Exercise, etc.): Enrichment (spinach and papaya tablets), health checks, 
morphine dosing day, saline controls, fentanyl patches 
Temperature: 66.0 F 
Humidity: 57.0% 

Changes in Behavior (Lethargy, Hyperactivity, etc.): All rabbits displaying normal behavior before 
dosing and the morphine group is exhibiting their usual post-dose lethargy. 

Health Concerns: #7 healing scratches nicely. Flaky scabs, but inflammation is down 

Vet Checks Requested?: N/A 

Exercising: N/A 

Any Additional Notes: 18 is VERY energetic in trying to get out of the vest and off table when 
reapplying patches. 18 was reshaved with the 40 blade to allow patch to stick better. 2 also is fighting us 
on 

Date: 5/08/19 
Personnel: Abbie, Adam 
Notetaker: Abbie 
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Time In: 8:00 AM 
Tasks Performed (Dosing, Exercise, etc.): Enrichment (spinach and papaya tablets), health checks, 
morphine dosing day, saline controls, and exercise. 
Temperature: 65.5 F 
Humidity: 44.5% 

Changes in Behavior (Lethargy, Hyperactivity, etc.): All rabbits displaying normal behavior before 
dosing and the morphine group is exhibiting their usual post-dose lethargy. 

Health Concerns: #02 and 19 water bottles empty, leaked again so springs seem to not help this issue.  

Vet Checks Requested?: N/A 

Exercising: all rabbits exercised for 45 minutes. First rabbit from control group placed at 8:05. First 
rabbit from morphine group placed at 8:55. First rabbit from fentanyl group placed at 10:00 A.M. 

Any Additional Notes: 
Control: #04, 06, 14, 18 had a little food left, #05 had minimal urine/fecal output, #15 still has diarrhea 

Ethernet port installed from 1:00-3:00 PM in 212. 

Morphine: #08, 10, 11, 12, 17, 20, 21 had a little food left, #08 and 21 also had low fecal output. Rabbit 
#10 does have some urine on his right side fur (dried) on the shoulder. He appears to have been sprayed 
by one of the other rabbits (perhaps while in the exercise pens). 
Fentanyl: #03 had a little food left 

Date: 5/09/19 
Personnel: Reed, Adam 
Notetaker: Adam 
Time In: 8:00 AM 
Tasks Performed (Dosing, Exercise, etc.): Enrichment (kale and papaya tablets), health checks, 
morphine dosing day, saline controls. 
Temperature: 67.0 F 
Humidity: 66.0% 

Changes in Behavior (Lethargy, Hyperactivity, etc.): 

Health Concerns: 19 still has ophthalmic discharge, no worse than previous days. 

Vet Checks Requested?: N/A 

Exercising: N/A 
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Any Additional Notes: 

Control: 5 had low fecal and lots of food left. 6 had slightly low fecal output. 14 had a lot of food and 
low fecal and urine output. Water bottle sipper was stuck and he couldn’t get water overnight. This was 
remedied with a spring today. 
Morphine: 8, 10 low fecal. 12 had no water overnight, the bottle is now lifted with a spring. 17 had 
slightly low fecal output 
Fentanyl: 2 had a leaky bottle, which has been fixed. 

Date: 5/10/19 
Personnel: Reed, Gina 
Notetaker: Reed 
Time In: 8:00 AM 
Tasks Performed (Dosing, Exercise, etc.): Enrichment (kale and papaya tablets), health checks, 
morphine dosing day, fentanyl,  saline controls, exercise 
Temperature: 65.5 F 
Humidity: 65.0% 

Changes in Behavior (Lethargy, Hyperactivity, etc.): No changes in behavior. Rabbits seem to prefer 
the new jackets, still chewing, but not as determined. 

Health Concerns: 19 still has ophthalmic discharge, no worse than previous days. 

Vet Checks Requested?: N/A 

Exercising: Controls: Placed at 8:30. Removed at 9:15… Morphine: Placed at 9:40. Removed at 10:25… 
Fentanyl: Placed at 10:45 

Any Additional Notes: 
Reed installed shelf for AVTECH system in afternoon. System working now. 

18 had many cecotropes in his cage that he didn’t eat 

---------------------------------------------------------------------------------------------------------------------Date: 
5/11/19 
Personnel: Reed, Gina 
Notetaker: Gina 
Time In: 8:00 AM 
Tasks Performed (Dosing, Exercise, etc.): Enrichment (spinach and papaya tablets), health checks, 
morphine dosing day, saline controls 
Temperature: 65.0 F 
Humidity: 43.5% 
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Changes in Behavior (Lethargy, Hyperactivity, etc.): No changes in behavior. Rabbits have been 
chewing the new vests (07, 01, 06, and 19 especially). The vests can slide if not tight enough underneath 
(exposing the patch). Rotated some of the vests 

Health Concerns: 19 still has ophthalmic discharge, no worse than previous days. 

Vet Checks Requested?: N/A 

Exercising: N/A 
Any Additional Notes: 
11 and 13 had empty bottles upon arrival. 13’s bottle was on the ground and 11’s leaked out. A lot of 
rabbits have been biting the sipper. Many bottles are completely full (indicating inability to drink). I 
(Gina) have noticed that the rabbits do not like kale (prefer spinach and carrot). Additionally, many do not 
eat the chow and eat the enrichment food right away. 

Date: 5/12/19 
Personnel: Reed, JMA 
Notetaker: JMA 
Time In: 8:00 AM 
Tasks Performed (Dosing, Exercise, etc.): Enrichment (spinach and papaya tablets), health checks, 
morphine dosing day, saline controls 

Temperature: 66 F 
Humidity: 53.5 % 

Changes in Behavior (Lethargy, Hyperactivity, etc.): No changes in behavior. Rabbits seem to prefer 
the new jackets, still chewing, but not as determined (except for #2) 

Health Concerns: 19 still has ophthalmic discharge, no worse than previous days. #3 slight opthalmic 
discharge. 15 still has diarrhea on cage pan. 

Vet Checks Requested?: N/A 

Any Additional Notes: 
#2 twisted new vest around and chewed it almost through. Patch still on animal but loosened around 
edges and not well adhered. Replaced his vest with a jacket from NEOMED and his fentanyl patch. 

#3 vest partially chewed. Should be replaced with a new one during fentanyl patch application tomorrow. 

Remnants of adhesive on fentanyl animals. Need to reshave application area. 

#4 and #11 water bottles completely empty overnight. Need to remedy this issue ASAP. 
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#10, 11, 17 had a lot of food leftover. #21 had a moderate amount. All morphine animals. 

Morphine animals exhibiting usual post-injection lethargy. 

Date: 5/13/19 
Personnel: Reed, Gina 
Notetaker: Gina 
Time In: 8:00 AM 
Tasks Performed (Dosing, Exercise, etc.): Enrichment (spinach and papaya tablets), health checks, 
morphine dosing day, saline controls, fentanyl, exercise, weighing 
Temperature: 65.5 F 
Humidity: 53.0% 

Changes in Behavior (Lethargy, Hyperactivity, etc.): N/A 

Health Concerns: 19 and 3 still have ophthalmic discharge, no worse than previous days. 

Vet Checks Requested?: N/A 

Exercising: Controls places at 8:10. Removed at 8:55. Morphine placed at 9:10, removed at 9:55. 
Fentanyl placed at 10:05, removed at 10:50. 

Any Additional Notes: 
No empty bottles today. 13 and 17 tried to jump out of exercise pens. All rabbits have very long nails, 
may need trimmed soon. All morphine rabbits took injections well, all are lounging but don’t seem too 
sedated. All the patch controls rubbed their patches off without removing the vests. All the fentanyl 
rabbits still had patches. Tried the new Tegaderm on the controls and smaller patches to see if this solves 
the problem. 

All fentanyl rabbits reshaved as best as possible.Gummed up fur made it difficult. 

Date: 5/14/19 
Personnel: JMA, Adam 
Notetaker: JMA 
Time In: 8:00 AM 

Tasks Performed (Dosing, Exercise, etc.): Enrichment (spinach and papaya tablets), health checks, 
morphine dosing day, saline controls 
Temperature: 66  F 
Humidity: 45.5 % 

Changes in Behavior (Lethargy, Hyperactivity, etc.): N/A 
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Health Concerns: #15 still exhibiting diarrhea and a messy cage pan, #19 still has watery eye discharge, 
consistent with the past week. #3 eye has cleared up. #2 nas chewed his fur around the forelimbs, but the 
area does not look irritated or inflamed. 

Vet Checks Requested?: N/A 

Any Additional Notes: 
Slightly low fecal output for #6, #9, #11, #18 
#21 quite low fecal output 
#20 dark urine colour 
#18 cecotropes fell through cage 
#3 and #19 had to be placed in jackets since they chewed through the straps of the Amazon vests. 

Rabbits erratic behaviour during calcein injections, especially the patch control animals. All have been 
difficult to handle, and some need to be held while injection is being administered. 

#3 panicked during calcein injection and kicked things off the table, was not happy. 

Date: 5/15/19 
Personnel: JMA, Adam 
Notetaker: Adam and JMA 
Time In: 8:00 AM 

Tasks Performed (Dosing, Exercise, etc.): Enrichment (spinach and papaya tablets), health checks, 
morphine dosing day, saline controls, calcein #2 dosing day 
Temperature: 66.0 F 
Humidity:  44.5 % 

Changes in Behavior (Lethargy, Hyperactivity, etc.): N/A 

Health Concerns: #19 ophthalmic discharge. #15 recurring diarrhea. 

Vet Checks Requested?: N/A 

Any Additional Notes: 

Most rabbits exhibited fluorescent orange urine following the calcein injections. This turned green in 
certain cases where the water bottles leaked. 
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Rabbit #06 had a fair amount of eflux of calcein during injection (due to large flinch) so we 
readministered 0.4mL of calcein on the contralateral side. Fur slightly stained orange. 

#7 did not tolerate calcein injection well -- flinched very hard and calcein was expelled. Tried a second 
injection of 0.6 mL and he also flinched and it was expelled. May not have much that was successfully 
injected for day 2 of calcein. Please check urine tomorrow to see if orange to assess dosage. Fur is also 
stained orange. 

#21 also fought calcein injection. Had to administer this in two parts, but there was minimal eflux. 

Remaining food for: #1 (little), 3 (little), 5 (little), 6 (little), 8 (little). 9 (little), 10 (little), 11 ( a lot) and 
papaya tablet, 16 (little), 17 (a lot), 20 (little), 21 (lots). 

Very low fecal output for #21, second day in a row. Keep an eye on this. 

Rabbits are also exhibiting signs of sexual maturity -- more aggression, urine spraying in the exercise 
pens, and #7 had an erection while we were administering injections. 

Exercise: Placed the first group at 8:15 A.M. starting with rabbit #04 
Placed the second group at 9:05 A.M. starting with rabbit #08 
Placed the third group at 10:00 A.M. starting with rabbit #01 
Transferred enrichment bowls instead of the rattles. Most rabbits seemed to enjoy the pens and played in 
the aspen, chewed it, etc. 

Date: 5/16/19 
Personnel: Abbie, Reed 
Notetaker: Abbie 
Time In: 8:05 AM 

Tasks Performed (Dosing, Exercise, etc.): Morphine dose, TD patches, saline controls, patch controls 

Temperature: 65.0 F 
Humidity:  55.0% 

Changes in Behavior (Lethargy, Hyperactivity, etc.): N/A 

Health Concerns: 3 and 19 both still have their ophthalmic discharge, but not worse than the previous 
days. The rubbing of fur from the vests appears no worse than previous. No irritated or inflamed skin on 
19 or 2 where the rubbing of the vest. Andronowski team was never informed where vet tape was going to 
be left for us to apply to these rabbits’ vests. Could not apply today for this reason. 

Vet Checks Requested?: N/A 
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Any Additional Notes: Attempted to shave the fentanyl rabbits where there was gummed up fur. It 
worked for a good number of them, however some got too stressed and fought so we had to stop before 
we could get all the old adhesive off. There was enough new fur to get the clippers underneath the 
gummed fur. 

All rabbits were a bit jumpy from needles, but no issues with administering the dose to them. Just more 
timid of the needles, likely due to the calcein injections the previous two days. Most rabbits have bright 
orange urine from the calcein. The rest appear to have little urine output. Noted in log book. 

Little food left: 1, 9, 12, 20 
Lot food left: 3, 10, 11, 17, 21 
Low fecal: 6, 17, 20, 21 

JMA: I figured they would be a little jumpy today with the needles post-calcein injection (especially the 
controls). Did #6/7 have orange urine? 
RAD: 6- somewhat orange. 7 VERY orange. 
Thanks, Reed! This is good because it indicates at least some dye was successfully injected (especially 7). 

Date: 5/17/19 
Personnel: Abbie, Adam 
Notetaker: Adam 
Time In: 8:00 AM 

Tasks Performed (Dosing, Exercise, etc.): Morphine dose, exercise, saline controls, enrichment foods 

Temperature: 66.0 F 
Humidity:  67.5% 

Changes in Behavior (Lethargy, Hyperactivity, etc.): 12 especially hyperactive today and is pacing. 

Health Concerns: 3 and 19 both still have their ophthalmic discharge, but not worse than the previous 
days. Andronowski team was never informed where vet tape was going to be left for us to apply to these 
rabbits’ vests and still could not be applied today for this reason. 

Rabbit 02 ingested his fentanyl patch and is displaying extreme lethargy as well as respiratory distress, 
elevated heart rate, and abdominal distension. Dr. Dannemiller was was called 6 times and a voicemail 
was left. Dr. Lou was contacted and advised that the rabbit is displaying signs of an overdose and it is 
unlikely he will survive and to euthanize the rabbit. JMA and Reed arrived by ~11:30. Upon calling Dr. 
Lou a second time to update that the rabbit’s health is slightly improving he advised to continue to 
observe the rabbit and if he worsens again to euthanize.  Dr. A made the decision to wait until Dr. 
Dannemiller calls us back and can do a physical assessment of the rabbit before proceeding with 
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euthanizing. After about 3 hours post injection rabbit 02 seems to be acting normal and is not exhibiting 
as great affects from the patch injection. His sclera is noted to be red, likely from stress. Treatment plan is 
to observe him and give him extra enrichment foods to increase intestinal motility. Dr. Dannemiller says 
that the amount of fentanyl ingested is not enough to be fatal. We will continue to observe rabbit 02 to 
make sure there is no intestinal blockage.  

We are also unable to access the drugs in the safe due to the safe battery likely being dead, for this reason 
morphine dosing was delayed today. Rabbits were dosed at 12:45pm. Dr. Bagatto brought the back-up 
key so we could open the safe until the battery can be replaced. 

Vet Checks Requested?: N/A 

Exercise: Placed the first group at 8:15 A.M. starting with rabbit #04 
Placed the second group at 9:00 A.M. starting with rabbit #08 
Placed the third group at 9:45 A.M. starting with rabbit #01  
Transferred enrichment bowls instead of the rattles. 

Any Additional Notes: 
15 still experiencing some diarrhea. 
Little food left:  05, 10,  11, 12, 16, 17, 21 
Lot food left: 08 
Low fecal 05, 06 

Date: 5/18/19 
Personnel: Gina, Reed 
Notetaker: Gina 
Time In: 8:00 AM 

Tasks Performed (Dosing, Exercise, etc.): Morphine dose, saline controls, enrichment foods, health 
checks 

Temperature: 65.5 F 
Humidity:  55.0% 

Changes in Behavior (Lethargy, Hyperactivity, etc.): N/A 

Health Concerns: Monitoring 2 for passing of patch. Nothing yet, but fecal output is normal as is 
behavior. 

Vet Checks Requested?: N/A 

Exercise: N/A 

Any Additional Notes: 
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15 still experiencing some diarrhea. 
Little food left: 5, 8, 9, 10, 12, 16, 17, 
Lot food left: 7, 11, 18, 20, 21 
Low fecal: 5, 6, 18 (slight) 
4 and 16 pulled the sippers out of their bottles and were without water overnight. We refilled and 
replaced. 
6 chewed the neck portion of his harness off, so we replaced with a new one. 

Date: 5/19/19 
Personnel: Adam, Reed 
Notetaker: Adam 
Time In: 8:00 AM 

Tasks Performed (Dosing, Exercise, etc.): Morphine dose, fentanyl dose, saline controls, enrichment 
foods, health checks 

Temperature: 67.0 F 
Humidity:  67.0% 

Changes in Behavior (Lethargy, Hyperactivity, etc.): N/A 

Health Concerns: Monitoring 2 for passing of patch. Nothing yet, but fecal output is normal as is 
behavior. 

Vet Checks Requested?: N/A 

Exercise: N/A 

Any Additional Notes: 
16 pulled his sipper out of his bottle and was without water overnight. Even with zip ties. 
Replaced harnesses with vests on rabbits 1 and 9 because they chewed through it. 
Replaced harnesses on 15 and 18 because they chewed through the neck straps. They are each wearing 
new pink vests. We are now out of replacement vests for the controls. All that’s left are the NEOMED 
jackets. 

All the fentanyl rabbits were reshaved. 

Date: 5/20/19 
Personnel: Adam, Gina 
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Notetaker: Adam 
Time In: 8:00 AM 

Tasks Performed (Dosing, Exercise, etc.): Morphine dose, saline controls, enrichment foods, health 
checks, weighing 

Temperature: 66.0 F 
Humidity:  65.0% 

Changes in Behavior (Lethargy, Hyperactivity, etc.): N/A 

Health Concerns: Recurring monitoring of #02 for passing of patch. Nothing yet, fecal output is normal, 
as is behavior. 

Vet Checks Requested?: N/A 

Exercise: 
Controls went in at 8:15 A.M. starting with rabbit #04. The enrichment bowls were transferred as toys for 
all rabbits. 
Morphine rabbits went in at 9:15 A.M. starting with rabbit #08. 
Fentanyl rabbits went in at 10:10 A.M. starting with rabbit #01. 

Any Additional Notes: 
New springs are here. We used these on the exercise pens and on some of the cages. No bottles had 
leaked. All rabbits same health condition as previous day. Still no patch remnants in #02 feces. Rabbit 
#03 posture has normalized some. Rabbit #20 was humping the table during dosing. Rabbit #08 sprayed 
out of his exercise pen on the floor. Rabbit #15 had escaped his vest so this was reattached. Rabbit #10 is 
still fairly aggressive when handled. We filled up the last pink slip for Morphine bottle #2, put this on 
Beth’s door and started a new slip. 

Some rust was noted on the morphine group battery at the top of the cage, and also on #8’s cage latch. 

JMA 1:00 P.M. update: Rabbit #2 is now able to remove the fentanyl patch from underneath the jacket. 
Cathy noted it to be off during pan cleaning. It appears he is chewing the forelimb holes enough to loosen 
the vest and then is somehow getting underneath it. Reed and I re-shaved the patch area and replaced the 
patch and secured vet wrap around the abdomen to add an additional layer. We also replaced his jacket 
for one that was not extensively chewed. Will need to monitor him closely until pillow collar arrives on 
5/21/19. 

AC unit was also installed by PFOC and seems to be lowering humidity/temp already. Will need to empty 
the water reservoir daily. 
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Date: 5/21/19 
Personnel: Abbie, Reed 
Notetaker: Reed 
Time In: 8:00 AM 

Tasks Performed (Dosing, Exercise, etc.): Morphine dose, saline controls, enrichment foods, health 
checks 

Temperature: 64.5 F 
Humidity:  44.0% 

Changes in Behavior (Lethargy, Hyperactivity, etc.): N/A 

Health Concerns: Recurring monitoring of #02 for passing of patch. Nothing yet, fecal output is normal, 
as is behavior. 

Vet Checks Requested?: N/A 

Exercise: N/A 

Any Additional Notes: Vet wrap is still on 2. He seems to be less irritated by it, or at least to have 
claimed defeat with it. All rabbits acting normally. Morphine rabbits calm, but not heavily sedated 
looking. 

Little food left: 10, 11, 20, 21 
Lot food left: 3 
Low fecal: 3 
Low urine: 11 

JMA afternoon update: Pillow collar arrived for #2 as did the extra jackets from Lomir. Reed and I placed 
the collar on #2 at 2:30 P.M. We observed him eating/drinking with the collar, even though he was 
displeased with it. We will observe him closely to make sure he continues to eat/drink, etc. 

Date: 5/22/19 
Personnel: Abbie, Adam 
Notetaker: Adam 
Time In: 8:00 AM 

Tasks Performed (Dosing, Exercise, etc.): Morphine dose, saline controls, enrichment foods, health 
checks, exercising, fentanyl dosing 

Temperature: 65.0 F 
Humidity:  45.5% 
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Changes in Behavior (Lethargy, Hyperactivity, etc.): N/A 

Health Concerns: 01 has an abrasion where his patch is usually placed, Dr. Lou has been contacted. The 
abrasion is approx an inch in length and is an open sore. 

Vet Checks Requested?: 01 for abrasion 

Exercise: Cage Card holders are still missing from all cages except pen #1. 
Controls: #04 placed at 8:10 A.M. 
Morphine: #08 placed at 9:00 A.M. (glass water bottles fall off exercise pens so thick/tight springs must 
be used.) 
Fentanyl: #02 placed at 9:50 A.M. (rabbit #01 originally not placed until 10:15 A.M. - removed at 11 
A.M.) 

JMA: I would inform Beth this morning about the missing card holders* 
ARL: I just slacked her, thank you 
Update: cage cards placed on pens at 8:40 

Rabbit #01 had an abrasion on the dorsal interscapular region. Consulted with Dr. Lou the attending 
veterinarian via text message and he advised to remove patch and treat with topical antibiotic ointment. 
We were instructed to keep the vest and all coverings off of the rabbit and leave this open to heal. Will 
check later in the day to ensure that this is not being subsequently scratched. Rabbit seems fine after being 
placed back into cage. 

Rabbit #03 is performing a strange behavior with his ears being pinned at the sides of his head and 
moving his head from side to side in a “scanning” manner. Adam performed a health check, removed 
jacket, looked in ears/genitals, palpated abdomen and all appears normal. 

Any Additional Notes: #02 does appear to have a slight bulge to his eyes. This is attributed likely to the 
collar administration. Attempted to remove feces from collar using cavi wipe. 

Low fecal: 03, 21,05,06, 08 
Little food left: 21,05,04,14,12,17 
Lots of food left: 03, 08, 10,11 

Date: 5/23/19 
Personnel: Abbie, JMA 
Notetaker: Abbie 
Time In: 8:00 AM 
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Tasks Performed (Dosing, Exercise, etc.): Morphine dose, saline controls, enrichment foods, and health 
checks. 
Temperature: 67.0 F 
Humidity:  69.0% at 8:00 A.M. after adjusting AC unit the humidity went down to 60% at 9:30. 

Changes in Behavior (Lethargy, Hyperactivity, etc.): Rabbit 19 urinates in his enrichment food bowl 
almost everyday. 

Health Concerns: 01’s abrasion is looking better than yesterday and seems to be healing well, we treated 
with ointment again today per Dr. Lou’s orders. A patch was able to be placed today above the abrasion 
and vet wrap was placed over the patch but not over the abrasion. No Jacket was placed on 01 so that the 
abrasion is able to be left open to air for additional healing. 
02 still has red eyes, likely from stress. 
15 still has his usual amount of ongoing diarrhea 
07’s vest was twisted, this may have been why he did not eat his usual amount, a new vest was placed on 
him and his behavior went back to normal. 
03 was observed to flop his ears around from side to side, looks somewhat dazed. We will continue to 
keep an eye on him. 
Little food left: 01, 03, 06, 10, 11, 14, 17, 21 
Lots of food left: 07 
Low fecal: 06, 21 
2cd vial of morphine finished off today, vial 3 was used to dose 20 and 21. 

Vet Checks Requested?: 01 for abrasion 

Exercise: N/A 

Date: 5/24/19 
Personnel: Adam, Reed 
Notetaker: Reed 
Time In: 8:00 AM 

Tasks Performed (Dosing, Exercise, etc.): Morphine dose, saline controls, enrichment foods, exercise, 
and health checks. 
Temperature: 67.0 F 
Humidity:  57.0 % 

Changes in Behavior (Lethargy, Hyperactivity, etc.): 2 kicked his collar off as we were removing him 
from the exercise pen. Reapplied the collar. He is not pleased, but it’s staying on so far. 
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Health Concerns: 3 has recurring low fecal output. We should monitor. #1’s abrasion is looking much 
better. Applied ointment and a new patch as he had curled it off himself. Re-vet taped and put him in a 
vest to deter chewing. 

Vet Checks Requested?: No new ones. 

Exercise: Controls placed at 8:10 A.M. beginning with #04, removed at 8:55. Morphine placed at 9:00 
A.M. beginning with #08. Removed at 9:45. Fentanyl placed at 9:55 A.M. beginning with #01. Removed 
at 10:40 

Additional Notes: 4 ripped the sipper out of his bottle and had no water overnight. Refilled at 8:05. 

Date: 5/25/19 
Personnel: Adam, JMA 
Notetaker: JMA 
Time In: 8:00 AM 

Tasks Performed (Dosing, Exercise, etc.): Morphine dose, saline controls, enrichment foods, fentanyl 
patches, and health checks. 
Temperature: 67.5 F 
Humidity:  66.5% 

Changes in Behavior (Lethargy, Hyperactivity, etc.): 

Health Concerns: 3’s behaviour appears normal today, and a higher fecal output. #1’s abrasion is 
looking much better. Applied ointment as per Dr. Lou. 

All fentanyl rabbits except 2 and 19 had very gummy fur and mild skin inflammation. Ointment applied 
to all others and patch adhered to an alternative area that was unaffected. 

#2 and 9 had dry and flaky skin underneath patch areas.Could be from lack of self grooming. 

Vet Checks Requested?: No new ones. 

Exercise: N/A 

Additional Notes: 4 pulled out rubber plunger around 8:30. Refilled at 8:35. #2 feces on collar, cleaned 
with cavi-wipe. 

2018-DU-BX-0188 Final Technical Report 
October 2021 

This resource was prepared by the author(s) using Federal funds provided by the U.S. 
Department of Justice. Opinions or points of view expressed are those of the author(s) and do not 

necessarily reflect the official position or policies of the U.S. Department of Justice.

553 



 
 

 
   

 
  

 
 

 
 

 
  

  
  

   
 

 
 

   
   

 
  

 
  

 
  

 
  

 
     

   
 

  
 

  
  

 
  

  
 

 
 

  
  
  

   

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------

Reshaved all controls/fentanyl animals and trimmed gummy hair as best as we could. 

A lot of food left: 3 
Little food left: 1, 6, 8, 9, 10, 11, 17, 21 
Low fecal: N/A 

Date: 5/26/19 
Personnel: Adam, Gina 
Notetaker: Adam 
Time In: 8:00 AM 

Tasks Performed (Dosing, Exercise, etc.): Morphine dose, saline controls, enrichment foods, and health 
checks. 
Temperature: 66.5 F 
Humidity:  71% 

Changes in Behavior (Lethargy, Hyperactivity, etc.): N/A 

Health Concerns: N/A 

Vet Checks Requested?: No new ones. 

Exercise: N/A 

Additional Notes: #04 pulled out rubber plunger overnight and had no access to water. Refilled at 8:10 
A.M. He did drink quite a bit of water right away.  

#07 unzipped his vest and had this completely off. We re-zipped this and made sure clips were fastened. 

Checked on the rabbits with ointment administration yesterday. All skin looks very good in condition. We 
trimmed some gummy hair off of each of the rabbits with this. 

A lot of food left: 03, 09, 
Little food left: 02,  05, 06, 10, 11, 16, 18, 21 
Low fecal: 03, 06 

Date: 5/27/19 
Personnel: JMA, Reed 
Notetaker: Both 
Time In: 8:00 AM 
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Tasks Performed (Dosing, Exercise, etc.): exercise, morphine, saline controls. 
Temperature: 64.5 
Humidity:  64.5% 

Changes in Behavior (Lethargy, Hyperactivity, etc.): 3 flattening ears and dragging cranial half of 
body against cage floor. Fur condition is not great. We created a vet check form and JMA will follow up 
with Stan. 

Health Concerns: 3 displaying unusual behavior. 

Vet Checks Requested?: Yes, for 3. 

Exercise: 
Controls weighed and went into pens at 8:10.  
Removed at 8:55. 
Morphine weighed and went into pens at 9:55. 
Fentanyl group weighed and placed at 10:05 

Additional Notes: 21’s papaya tablet fell through the bottom of the cage. 
3 has lost weight and continues to display a change in behavior. Changed his vest since he almost chewed 
through the new one. 

Date: 5/28/19 
Personnel: JMA, Reed, Adam, Abbie 
Notetaker: Reed/Abbie 
Time In: 8:00 AM 

Tasks Performed (Dosing, Exercise, etc.): 
Temperature: 66.5 F 
Humidity: 72.5% 

Changes in Behavior (Lethargy, Hyperactivity, etc.): 03 has diminished health and is acting lethargic 

Health Concerns: Rabbit 03 is diminished in flesh condition and very rough in coat condition suggesting 
poor overall health. Still demonstrating stress behaviors and diminished appetite as well as fecal output. 
He is receiving twice the normal amount of enrichment food per Dr. Dannemiller’s email response. All 
fentanyl rabbits received ointment on their red skin. 
15 still has ongoing diarrhea 
Little food left: 06, 08, 09, 11, 12, 13, 21, 03 
Low fecal: 05, 14 
Lots of food left: 17 
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Vet Checks Requested?: Dr. Dannemiller contacted yesterday via email and we requested that he come 
evaluate 03, however he responded this morning stating that he might be unavailable today. 

Exercise: N/A 

Additional Notes: Animals that had eflux after calcein dosing: 08, 15, 09 
All animals seem more lethargic then they have been recently post morphine dosing. 

New NEOMED vest for #19 since he chewed through the new Lomir one already. 

Date: 5/29/19 
Personnel: Adam,Abbie 
Notetaker: Adam/Abbie 
Time In: 8:00 AM 

Tasks Performed (Dosing, Exercise, etc.): Calcein, exercise, enrichment foods,health checks, morphine 
doses and saline controls. 
Temperature: 65F 
Humidity:  69.5% 

Changes in Behavior (Lethargy, Hyperactivity, etc.): 03 seems more lethargic than yesterday. Holding 
one ear up and one ear down and head is between two front legs laying on cage bottom. 

Health Concerns: 
04 and 05 did not have water when we arrived due to leaking, refilled at 8:20 A.M. 
01 still has very bulgy eyes. 

Vet Checks Requested?: 03 requested still waiting for Dr. Dannemiller to come on Thursday or Friday. 
01 requested today for ocular proptosis. 

Exercise:
 Control group placed at 8:15 starting with 04 
Morphine group placed at 9:05 starting with 08 
Fentanyl group placed at 9:55 starting with 01 
All rabbits had jingle ball, water bottle, and cage card moved to exercise pen. 

Additional Notes: 
Low fecal: 01, 03, 05, 06, 14, 16, 17, 21. 
Little food left: 08, 09, 10, 11, 12, 13, 17, 19, 21. 
Lots of food left: 16, 03. 
15 has ongoing diarrhea, 17 has a small amount of cecotropes on the cage floor. 

All control and morphine rabbits received full dose of calcein and had no efflux. 
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JMA spoke with Dr. Dannemiller at 10:15 A.M regarding rabbit #3. He prescribed 50-100 mL of sterile 
saline to be administered via SubC injection, and additional enrichment foods. He will also be coming to 
UA to do a health check between 4:00-6:00 P.M. today. 
Upon trying to inject 03 with the saline we pushed 30mL of saline however some efluxed out due to it 
being such a large volume transdermally, the rabbit probably got approx 20mL of saline. We tried three 
different sites to push the saline. A spot was shaved near the animals rear for one of the spots. This animal 
also had a large amount of calcein efflux. 

Rabbit #03 was re-weighed in the presence of Dr. Dannemiller and his new weight was 2.66 kg. 

Date: 5/30/19 
Personnel: Adam, Reed 
Notetaker: Adam 
Time In: 8:00 AM 

Tasks Performed (Dosing, Exercise, etc.): Enrichment foods, health checks, morphine dosing and saline 
controls 
Temperature: 66.5 F 
Humidity:  61.5% 

Changes in Behavior (Lethargy, Hyperactivity, etc.): 03 seems to be doing better today. He did flip the 
bowl with extra enrichment food over and spilled most of this through the bottom of the cage 

Health Concerns: N/A 

Vet Checks Requested?: 

Additional Notes: 
Low fecal: 1, 3 (Slightly), 5 
Little food left: 1, 3, 5, 11, 16, 17, 21 
Lots of food left: 
15 has ongoing diarrhea 
7 displayed a hunched posture for the duration of the time we observed him, could be due to the vest 

Trimmed nails on all morphine rabbits and saline control rabbits. 
Rabbit 17 does now have chewed hair again on his front paws. 

Date: 5/31/19 
Personnel: Adam, Reed 
Notetaker: Adam 
Time In: 8:00 AM 
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Tasks Performed (Dosing, Exercise, etc.): Enrichment foods, health checks, morphine dosing and saline 
controls, exercise, fentanyl dosing 
Temperature: 65.0 F 
Humidity:  61.0% 

Changes in Behavior (Lethargy, Hyperactivity, etc.): 03 seems to be doing better today, normal fecal 
output and food consumption. 07 still a little lethargic and displaying hunched posture. 

JMA: What is up with 07? Adam, can you give him a quick health assessment? Sometimes he twists 
himself up weirdly in his vest. 
He just seems overall very upset with the vest. We looked him over an found no abnormalities, he 
just seems depressed. Thank you! 

Health Concerns: N/A 

Vet Checks Requested?: 

Additional Notes: 
Control rabbits started at 8:10, removed at 8:55. Morphine rabbits placed at 9:05, removed at 9:50. 
Fentanyls placed at 10:00, removed at 10:50 

All control patch rabbits had nails trimmed and all morphine rabbits were re-shaved. 
All fentanyl rabbits reshaved. There was a small nick on rabbit #03 from attempting to remove the 
adhesive. 

We also did have one patch that was pulled up by the application of the tegaderm and this rabbit had to 
have a second patch applied. #16 was this rabbit.  

Low fecal: 07 
Little food left: 11, 13, 17, 21 
Lots of food left: 07 

Date: 6/1/19 
Personnel: Adam, Gina 
Notetaker: Adam 
Time In: 8:00 AM 

Tasks Performed (Dosing, Exercise, etc.): Enrichment foods, health checks, morphine dosing and saline 
controls 
Temperature: 65.0 F 
Humidity:  61.0% 

Changes in Behavior (Lethargy, Hyperactivity, etc.): #07  
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Health Concerns: 07 is very lethargic today and is not eating or drinking. He has very low fecal and 
urine output. We will put more enrichment food in his pen for him. I think that he is having the same type 
of symptoms as #03 when he was in the brunt of his issues. 

Vet Checks Requested?: #07 

Additional Notes: 
Low fecal: 07 (very low fecal and urine output), 16, 21 (slightly) 
Little food left: 01, 08, 10, 11, 17, 19, 21 
Lots of food left: 07, 13, 16 

Date: 6/2/19 
Personnel: Adam, Reed 
Notetaker: Adam 
Time In: 8:00 AM 

Tasks Performed (Dosing, Exercise, etc.): Enrichment foods, health checks, morphine dosing and saline 
controls 
Temperature: 65.5 F 
Humidity:  60.0% 

Changes in Behavior (Lethargy, Hyperactivity, etc.): 

Health Concerns: #07 has very low fecal output for the second day in a row. He was given a large 
amount of enrichment food yesterday to attempt to entice him to eat; however, this does not appear to 
have been touched. Upon inspection today, we observed a large abnormality in the gum tissue on this 
animal’s left lower lip and in the mouth surrounding lower left incisor. Documented and sent to veterinary 
staff. 

Vet Checks Requested?: 

Additional Notes: 
Low fecal: 05, 07 (very low) 
Little food left: 03, 05, 08, 09, 10, 11, 13, 16, 17, 20, 21 
Lots of food left: 07 

Date: 6/3/19 
Personnel: Adam, Gina, Mary Beth 
Notetaker: Adam 
Time In: 8:00 AM 
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Tasks Performed (Dosing, Exercise, etc.): Enrichment foods, health checks, morphine, fentanyl dosing 
and saline controls, exercise, weekly weights 
Temperature: 64.5 F 
Humidity:  44.5% 

Changes in Behavior (Lethargy, Hyperactivity, etc.): #07 has perked up, eaten his food, and passed 
normal amount of fecal output. 
Health Concerns: 

Vet Checks Requested?: 

Additional Notes: 
Low fecal: 
Little food left: 
Lots of food left: 

Exercise: 
Control: Starting with animal #04 placed at 8:10 A.M. Moved cage card, jingle ball, and water bottle 
with each rabbit. Animal #18 was chewing on the AC cord sticker. In future exercise sessions, make sure 
his cage is moved out from this.  
#12 chewed his jingle ball and there are rough edges. 
Morphine: Starting with animal #08 placed at 9:00 A.M. 
Fentanyl: Starting with animal #01 placed at 9:50 A.M. 

Rabbit #19 was very aggressive today. He did attempt to bite at the researchers. 
Handle with caution!! 

Update: #2 appears to have eaten his fentanyl patch as he was without one and the patch could not be 
located when researchers checked. He appeared more heavily sedated than usual after new patch 
placement. Two new collars and vet wrap were used to secure the new patch. AJS and JMA checked on 
#2 at 2:30 P.M. as per the UARV staff request. The tightness of the wrap was checked and adjusted. He 
appeared sedated but fine. 

Date: 6/4/19 
Personnel: Reed, MBC 
Notetaker: Reed 
Time In: 8:05 AM 

Tasks Performed (Dosing, Exercise, etc.): Enrichment foods, health checks, morphine, saline controls 
Temperature: 66.0 F 
Humidity:  46.5% 

Changes in Behavior (Lethargy, Hyperactivity, etc.): #1 has cecotropes that he didn’t eat. 
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Health Concerns: #7’s gums look like they’re healing from lesion. Fecal output was normal and ate all 
his chow. #2 still has patch on. Seems more docile, maybe still high from eating the other patch? Still 
behaving normally, grooming, eating, drinking, etc. 

JMA: Thank you! We should keep an eye on #2 today since his fecal is low/some food left. 

Vet Checks Requested?: N/A 

Additional Notes: 
Low fecal: 2, 14, 11 (slightly), 14, 17 (slightly) 
Little food left: 2, 3, 5, 11, 17, 20, 21 
Lots of food left: NO ONE! 

Date: 6/5/19 
Personnel:  Gina, Mary Beth 
Notetaker: Mary Beth 
Time In: 8:05 AM 

Tasks Performed (Dosing, Exercise, etc.): Enrichment foods (celery, papaya tablet), health checks, 
morphine dosing and saline controls, exercise 
Temperature: 65.0 F 
Humidity:  66.0% 

Changes in Behavior (Lethargy, Hyperactivity, etc.): None 

Health Concerns: #1 did not eat cecotropes again (same as yesterday 6/4); #15 has two small patches of 
diarrhea (same as 6/1 and 6/2) 

Vet Checks Requested?: None 

Additional Notes: 
Low fecal: #11, #14, #17, #21 
Little food left: #3, #5, #6, #10, #11, #17, #20, #21 
Lots of food left: None 

Exercise: 
Control: Starting with animal #04 placed at 8:40 A.M. Moved cage card, jingle ball, and water bottle 
with each rabbit. 
Morphine: Starting with animal #08 placed at 9:40 A.M. 
Fentanyl: Starting with animal #01 placed at 10:35 A.M. 
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#6 unzipped his jacket (zippers locked - they must have unzipped together) and ate the control patch -
replaced with new control patch 
Update - he started to unzip it in the exercise pen - jacket replaced with backpack NEOMED jacket to 
reduce ability to unzip 

#2 removed one pink collar by chewing off the plastic bobble. He chewed the bobble off the other but the 
second collar remained around his front legs. Fentanyl patch checked and is holding fined under the green 
vet wrap. Both bobbles were found in the fecal tray (probably just fell through, didn’t appear eaten or 
encased in feces) - one was too far back in the back left corner to retrieve. Both collars were replaced via 
velcro and their strings tied together over the collars. #2 behavior normal although disliked replacement 
of collars and stood on table, wanting to jump around. His eyes are bulging and red as previously. 
Replaced pink collar with large white collar. 
Update 10:33 am - after placement of white collar, #2 seems calm and his eyes are no longer bulging or 
red 

#19 chewed through neck strap on jacket - replaced with new jacket. Old jacket laundered to be returned. 
Fentanyl patch in place. 

Date: 6/6/19 
Personnel:  Reed, Adam 
Notetaker: Reed 
Time In: 8:05 AM 

Tasks Performed (Dosing, Exercise, etc.): Enrichment foods (spinach, papaya tablet, hay cube), health 
checks, morphine dosing and saline controls, fentanyl patches/control patches 

Temperature: 65.0 F 
Humidity:  63.5% 

Changes in Behavior (Lethargy, Hyperactivity, etc.): N/A 

Health Concerns: N/A 

Vet Checks Requested?: None 

Additional Notes: 
#2 has very dry skin whenever reapplying patches. Use the big tegaderm on him as it sticks better. Using 
the custom cut tegaderm, it doesn’t stick to to his skin and pulls the patch up so it has to be wasted. 

Low fecal: N/A 
Little food left: N/A 
Lots of food left: N/A 
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Date: 6/7/19 
Personnel:  JMA, MBC 
Notetaker: JMA 
Time In: 8:00 AM 

Tasks Performed (Dosing, Exercise, etc.): Enrichment foods (spinach, papaya tablet, hay cube), health 
checks, morphine dosing and saline controls, exercise 

Temperature: 63.5 F 
Humidity: 66.5 % 

Changes in Behavior (Lethargy, Hyperactivity, etc.): N/A 

Health Concerns: N/A 

Vet Checks Requested?: N/A 

Additional Notes: 
4, 5, 2 water bottles leaked but not to the point of being empty. 

We checked 2 to see if his patch is holding. He displaced his vet wrap and the patch, but it was still 
adhered. Patch replaced and vet wrap replaced as well. 

17 had some fur chewed off on his left front paw, similar to what was noted for him previously. 

19 still has opthalmic discharge. 

20 has two scrabs from past injections but these are healing. 

21 had papaya tablet left over from yesterday.  

Exercise: 

Controls in the pens at 8:15, removed at 9:00 
Morphine in the pens at 9:10 and removed at 9:55 
Fentanyl in the pens at 10:00 and removed at 10:45 

Little food left: 5, 6, 8, 10, 11, 15, 17, 21 
Lots of food left: None 
Slightly low fecal: 6, 17 
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Date: 6/8/19 
Personnel:  JMA, AJS 
Notetaker: JMA 
Time In: 8:00 AM 

Tasks Performed (Dosing, Exercise, etc.): Enrichment foods (spinach, papaya tablet, hay cube), health 
checks, morphine dosing and saline controls 

Temperature: 65.0  F 
Humidity:  60 % 

Changes in Behavior (Lethargy, Hyperactivity, etc.): N/A 

Health Concerns: N/A 

Vet Checks Requested?: N/A 

Additional Notes: 

#21 has a puncture injury from 06/07/19 from an attempted morphine injection. The area has a small 
contusion surround the site. Antibiotic ointment was administered. We will keep an eye on this. 

#2 and #3 patches are still on and vet wrap is secured. 

Morphine and saline control rabbits need to be reshaved prior to calcein 

Little food left: 9, 11, 15, 17 
Lots of food left: None. 
Low fecal: None. 

Date: 6/9/19 
Personnel:  Reed, Gina 
Notetaker: Reed 
Time In: 8:00 AM 

Tasks Performed (Dosing, Exercise, etc.): Enrichment foods (spinach, papaya tablet, raisins), health 
checks, morphine dosing and saline controls, fentanyl placement 

Temperature: 65.0  F 

2018-DU-BX-0188 Final Technical Report 
October 2021 

This resource was prepared by the author(s) using Federal funds provided by the U.S. 
Department of Justice. Opinions or points of view expressed are those of the author(s) and do not 

necessarily reflect the official position or policies of the U.S. Department of Justice.

564 



 
 

  
 
 

  
 

    

 
 

  
 

 
   

 
 

 
 

 
 

 
 

  
  
  

   
 

 
 

 
  

 
  

 
 

   
  

   
 

   
 

  
 

  

---------------------------------------------------------------------------------------------------------------------

Humidity:  61.5 % 

Changes in Behavior (Lethargy, Hyperactivity, etc.): N/A 

Health Concerns: 10 jumped out of GIna’s arms when putting back into cage, hit his head against back 
wall of his cage. Did a neurologic assessment, does not appear to be any damage. No trauma visible. No 
changes in behavior or gait. 

Vet Checks Requested?: N/A 

Additional Notes: All rabbits shaved in preparation for calcein dosing. #13’s patch was not well adhered 
again, tried to shave much closer to the skin this time and applied a patch. Unsure if he is getting his full 
dose. 

Little food left: 1, 2, 3, 5, 6, 8, 10, 11, 12, 14, 17, 20 
Lots of food left: 9, 21 
Low fecal: 11 (Slightly), 17 (slightly), 18 (slightly), 20 (slightly), 21 

Date: 6/10/19 
Personnel:  Mary Beth, Gina 
Notetaker: Mary Beth 
Time In: 8:05 AM 

Tasks Performed (Dosing, Exercise, etc.): Enrichment foods (raisin, dried apricot, papaya tablet), health 
checks, morphine dosing and saline controls, exercise, weighing 

Temperature: 65.5  F 
Humidity:  69.5 % 

Changes in Behavior (Lethargy, Hyperactivity, etc.): 

#21 bit Mary Beth (before even being touched) but did not break skin - did not want to be taken out of 
cage for exercise - had moderate amount of food left and slightly low fecal so maybe is constipated? 
JMA: He often does not eat all of his food/has low fecal. Please assess his puncture wound to make sure 
this is not worse -- could be a reason for a change in behaviour. 

#21’s puncture wound has healed, no blood or redness. 

Health Concerns: N/A 

Vet Checks Requested?: N/A 
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Exercise: 

Controls in the pens at 8:15, removed at 9:00 
Morphine in the pens at 9:05 and removed at 9:50 
Fentanyl in the pens at 9:50 and removed at 10:35 

Additional Notes: 

#1 Checked - patch in place, tegaderm replaced to prevent edges from curling up 
#2 Checked - patch and vet wrap in place 
#3 Checked - patch and vert wrap in place, ointment applied to vet wrap stuck to skin 
#9 Checked - patch in place,  tegaderm replaced to prevent edges from curling up 
#13 was reshaved and a new fentanyl patch (#113) was applied. His patch was not attached at all but still 
present underneath his jacket. Vet wrap was placed to secure it. 
#16 was reshaved and a new fentanyl patch (#112) applied. His patch was found to be half adhered during 
a check. 
#19 Checked - patch in place, tegaderm replaced to prevent edges from curling up 

Little food left: #2, #5, #9, #11, #15, #17, #19, #20, #21 
Lots of food left: #3 
Low fecal: #3 (slightly), #11 (slightly), #12 (slightly), #17 (slightly), #18 (slightly), #20 (slightly - did not 
eat some cecotropes), #21 (slightly) 

Date: 6/11/19 
Personnel:  Mary Beth, Reed, Adam 
Notetaker: Adam 
Time In: 8:00 AM 

Tasks Performed (Dosing, Exercise, etc.): Enrichment foods (dried apples, banana chips, papaya tablet), 
health checks, morphine dosing and saline controls, calcein injections, patch checks 

Temperature: 65.5  F 
Humidity:  51.5 % 

Changes in Behavior (Lethargy, Hyperactivity, etc.): 

Health Concerns: N/A 

Vet Checks Requested?: N/A 
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Additional Notes:  Abrasion on 21 completely healed. 6 was reshaved and new tegaderm applied. 10 
may have effluxed some of his calcein because he was fighting against us. Retained most of the his dose 
though. 3 fought the needle for calcein and effluxed a bit of his dose. 

Little Food Left: #11, 15 

Date: 6/12/19 
Personnel:  Mary Beth, JMA, Gina, Adam 
Notetaker: Mary Beth/JMA 
Time In: 8:00 AM 

Tasks Performed (Dosing, Exercise, etc.): Enrichment foods (toasted O’s, apricots, papaya tablet), 
health checks, morphine dosing and saline controls, calcein injections, patch application, exercise 

Temperature: 64.5 F 
Humidity:  47.5 % 

Changes in Behavior (Lethargy, Hyperactivity, etc.): 

Health Concerns: N/A 

Vet Checks Requested?: N/A 

Additional Notes: 

#1 did not eat his apple or apricot from previous enrichment 
#14 did not eat banana chips 
#17 had three banana chips left but ate most of his food 
#9 and #10 has bruised interscapular region and really fought the calcein injection 
#13 had to be poked multiple times prior to a successful calcein injection. Bruised area in interscapular 
region. Antibiotic ointment was applied to the area.  
#5 had slight calcein eflux 
#15’s abdomen feels slightly bloated, but not stiff. Fecal output normal (usual diarrhea) and he ate all of 
his food. 

Exercise: 

Controls went into exercise pens at 8:22 am and were removed at 9:07 am 
Morphine went into exercise pens at 9:15 am and were removed at 10:00 am 
Fentanyl rabbits 1,2,3,9 into exercise pens at 10:10 am and were removed at 10:55 am 
*Delay for the others due to patch placement and calcein injections 
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Fentanyl rabbit 13 in at 10:20 am, removed 11:05 
16 in at 10:33 am, removed at 11:18 
19 in at 10:41 am, removed at 11:25 

Date: 6/13/19 
Personnel:  Reed, Adam 
Notetaker: Reed 
Time In: 8:00 AM 

Tasks Performed (Dosing, Exercise, etc.): Enrichment foods (dried pineapple, banana chips, papaya 
tablet), health checks, morphine dosing and saline controls, patch checks 

Temperature: 65.5  F 
Humidity:  63.5 % 

Changes in Behavior (Lethargy, Hyperactivity, etc.): 

Health Concerns: N/A 

Vet Checks Requested?: N/A 

Additional Notes: 

Little Food Left: #01, 03, 05, 11, 13, 16, 17, 20, 21 
Lot of Food Left: #09 
Low Fecal: #03, 05, 09 (no fecal or urine), 11 

Date: 6/14/19 
Personnel:  Mary Beth, Reed 
Notetaker: Mary Beth 
Time In: 8:05 AM 

Tasks Performed (Dosing, Exercise, etc.): Enrichment foods (banana chips, apricots, papaya tablet), 
health checks, morphine dosing and saline controls, patch checks, exercise 

Temperature: 65.5 F 
Humidity:  47.5 % 

Changes in Behavior (Lethargy, Hyperactivity, etc.): 

Health Concerns: 
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#9 again barely consumed food or water, and has no urine and very low and small diameter feces output. 
However, behavior seems normal and he began eating enrichment foods immediately upon placement in 
bowl. 

JMA removed his vet wrap and checked to make sure he does not have infection, worsening of abrasions, 
etc. ← Done for #9. Bruising has healed and area is looking better. Gummy fur will need to be trimmed 
tomorrow. 

#11 and #16 seem to be in the same lot of food / low fecal / low urine state. However, it is not as low as 
previously (all had multiple discrete feces, just a lower amount) 

#15 seems less bloated than previous days, but not entirely without bloat. Couldn’t get a great 
examination because he was biting. 

Vet Checks Requested?: N/A 

Additional Notes: 

Little Food Left: #01, 05, 08, 10, 13, 14, 17, 20 
Lot of Food Left: #03, 09, 11, 16 
Low Fecal: #03, 05 (slightly), 09, 10 (slightly), 11, 13, 14 (slightly), 16, 17 (slightly), 18 (slightly), 20 
(slightly), 21 

Many rabbits seem to have low fecal today 
*Does anything seem different in the room? Is it warm/cold, noisy from construction? Any differences? 
No room changes 

#4 dumped water into cage overnight, without water for undetermined time. Water refilled immediately. 

#8 did not eat dried pineapple from yesterday (2 pieces) - all other rabbits consumed enrichment foods 

#9 Given extra enrichment food since he is not eating his regular food. 

Exercise: 

Controls went into exercise pens at 8:20 am and were removed at 9:05 am 
Morphine went into exercise pens at 9:15 am and were removed at 10:00 am 
Fentanyl rabbits into exercise pens at 10:05 am and were removed at 10:50 am 

Fentanyl Patch Checks: 

No patches needed to be replaced 

#1 - patch in place, no bruising or abrasion 
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#2 - patch in place. Margin of patch and vet wrap was red but skin not broken - antibiotic ointment 
applied 

#3 got totally out of his vest except the neck band and was chewing it, but fentanyl patch was intact under 
the vet wrap. 

#9 checked - patch in place, bruising coloration close to normal skin. Re-vet wrapped and the original vet 
wrap may have been tight 

#13 - patch in place, no bruising or abrasion 

#16 - patch in place, no bruising or abrasion 

#19 - patch in place, no bruising or abrasion 

Date: 6/15/19 
Personnel: Adam, MBC, Abbie 
Notetaker: Adam 
Time In: 8:00 AM 

Tasks Performed (Dosing, Exercise, etc.): Enrichment foods (celery, banana, papaya), health checks, 
morphine dosing and saline controls, fentanyl patch application, all patch animals shaved today. 

Temperature: 67.5  F 
Humidity:  55.5 % 

Changes in Behavior (Lethargy, Hyperactivity, etc.): 

Health Concerns: 07 has an abrasion under his tegaderm, likely from the calcein injection, ointment 
applied.18 also has an abrasion under tegaderm, ointment applied. 03 has matted fur on the sternal region, 
ointment applied. 

#09 evaluation: Fecal and urine output low but present and has a little food left. 09 Ate all of his 
enrichment food today within five minutes of it being given. Extensive health check revealed an empty 
stomach upon palpation. Abdomen is tender, no blockage present, gums/teeth look normal, no signs of 
malocclusion. 

#16 evaluation: Fecal and urine output are normal, but 16 has a small amount of food left. A right 
interscapular contusion adjacent to the patch and contusions under the patch have also been noted. 
Bilateral contusion adjacent to maxilla present. Fluorescent yellow discharge has also been noted on the 
back corner of the right eye. This is likely calcein mixed with the clear efflux of eye fluid. 
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---------------------------------------------------------------------------------------------------------------------

Animals have less vet wrap applied today in order to avoid contusions and abrasions. 
09 and 11 are heavily sedated today. 

Vet Checks Requested?: N/A 

Fentanyl Patch Checks: 

All patches replaced today for normal dosing 

#1 -  Patch replaced. Abrasions noted under patch, ointment applied. 

#2 - Patch replaced. Raw skin noted under patch, ointment applied. 

#3- Patch replaced. Abrasion noted under patch, ointment applied. 

#9- Patch replaced. Large contusion noted under where the patch was, he was chewing on his vet wrap 
and sliding it around which us what may have caused the contusion. 

#13 - Patch replaced. No abrasions noted but ointment applied to degum fur. 

#16 - Patch replaced. Contusions on and around patch sight, ointment applied. 

#19 - Patch replaced. No abrasions noted but ointment applied to degum fur. 

Additional Notes: 
Low Fecal: 03, 09, 11, 17 
Little Food Left: 03, 05, 08, 09, 10, 11, 14, 16, 17, 21 

Date: 6/16/19 
Personnel:  JMA, Abbie 
Notetaker: JMA 
Time In: 8:00 AM 

Tasks Performed (Dosing, Exercise, etc.): Enrichment foods (celery, apricot, papaya tablet), health 
checks, morphine dosing and saline controls 

Temperature: 66  F 
Humidity: 63.5 % 

Changes in Behavior (Lethargy, Hyperactivity, etc.): 
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Health Concerns: N/A 

Vet Checks Requested?: N/A 

Additional Notes: 

#1 and #2 water bottles switched again. Made another note for UARV staff. 
#14 did not eat his enrichment celery. 
#14 has gross mashed up hay cube in the corner (not feces) 
#9, 11, 16 still have lower fecal output and food left. Continue to monitor them. 
*Morphine #4 vial is almost empty. Will likely need a new one for tomorrow. JMA will request a second 
vial for safe. 

Morphine/saline rabbits need to be reshaved. Adam/Gina, can this be done tomorrow? 

Patch checks: 

#1 - chewed off some vet wrap around forelimb, this was trimmed back. Patch still adhered well. 
#2 - patch remains adhered. 
#3 - fully removed both his vest and the vet wrap. His patch remained adhered, but new tegaderm was 
applied. His jacket was reapplied, but we left the wrap off as he seems to fight more with this. 
#9 - trimmed vet wrap, patch remains adhered. 
#13 - patch was loose and there was hair regrowth. He was reshaved and a new patch was applied. He 
appears sedated. 
#16 - patch remains adhered. Vet wrap not surrounding forelimbs due to matted fur. 
#19 - patch adhered but not well on the sides. May need new patch applied tomorrow. A new tegaderm 
was applied. 

Little food: 3, 7, 8, 10, 17 
Lots of food: 9, 11, 16 
Low fecal: 9, 11 
Slightly low fecal: 5, 14, 17, 21 

Date: 6/17/19 
Personnel:  Adam, Gina 
Notetaker: Adam 
Time In: 8:00 AM 

Tasks Performed (Dosing, Exercise, etc.): Enrichment foods (toasted O’s, papaya tablets), health 
checks, morphine dosing and saline controls, exercise 

Temperature: 66  F 
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______________________________________________________________________ 

---------------------------------------------------------------------------------------------------------------------

Humidity: 67.5 % 

Changes in Behavior (Lethargy, Hyperactivity, etc.): Rabbit #01 peed right into his mouth and was 
drinking his urine. Very strange behavior that I have never seen before in rabbits. 

Rabbit #3 had a fit where he threw his enrichment bowl around the cage and tried to remove his vest. 
JMA was notified and she and MBC came to check this. Behavior had returned to normal by the time they 
arrived. 

Health Concerns: N/A 

Vet Checks Requested?: N/A 

Additional Notes: 
Exercise: 
Controls placed at 8:15 starting with #04.  
Morphine placed at 9:10 starting with #08. 
Fentanyl placed at 10:10 starting with #01. 

All patch rabbits checked and patches still adhered. Shaved morphine and saline rabbits. Re-fastened all 
vests and secured the snaps. Rabbit #03 received a new vest because he had chewed through the leg holes. 
We are going to come back up after the rabbit meeting and check him to make sure he is okay. 

Rabbits #15, 02, 09, and 03 had their vests unzipped when we came in. The snaps were not hooked 
together on the vests in the fentanyl group with the exception of rabbit #01. 

Yes, we did this on purpose for 2,3,9 thinking they may not be able to use the zippered connection to pull 
them off? But I guess this was worse! Now we know. 

Ahh, this makes sense. I am not sure how they keep getting these unzipped? It is very strange! 

Yes, and wasn’t a problem like this until recently! Not sure how to keep them in. 

We can try to zip and lock the clasps and see what happens. We could always remove vet wrap if this is 
potentially what is bothering them? But it wouldn’t explain why 15 is behaving like this. 

JMA - 06/18/19 -- let me know if there are issues with temp/humidity today. There were issues last 
night/early this morning with the chiller. Also, I did not receive notifications via our RoomAlert and this 
concerns me. Reed, can you check this today and make sure it is online? RAD - Checked both the unit 
itself and the website. Both would indicate the unit is online and working. 
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Date: 6/18/19 
Personnel:  Reed, MBC 
Notetaker: Both 
Time In: 8:05 AM 

Tasks Performed (Dosing, Exercise, etc.): Enrichment foods (toasted O’s, sunflower seeds, papaya 
tablets), health checks, morphine dosing, controls, patches 

Temperature: 66.0  F 
Humidity: 66.5 % 

*Humidity has been over our 65% set-point for ~two days. 

Changes in Behavior (Lethargy, Hyperactivity, etc.): N/A 

Health Concerns: N/A 

Vet Checks Requested?: N/A 

Additional Notes: 
Low fecal: #13, #21 
Lots of food left: #21 

#3 wriggled out of his vest and was chewing on his patch this morning. New vest applied and vet tape 
reapplied now that he’s chewing on the patch. 

#2 scratched himself when applying a new patch and gave himself a couple lacerations from his claws. 
We applied antibiotic ointment and applied a patch not over the new lacerations. 

#9 and #16 had pre-existing abrasions from previous patches, so we applied a new patch away from these 
abrasions and treated them with antibiotic ointment. 

RAD: Dr. A, we will need more patches (we have enough for one more patch day) and one more bottle of 
morphine in the safe (only one in the safe now that bottle 4 is empty). Could you please email Beth with 
the order? We also only have cheerios and sunflower seeds left for enrichment food. Enough for 
tomorrow, but we will need more. Not sure who wants to go get some. 

JMA: Thanks for letting me know. I sent an email to request 15 fentanyl patches/1 vial of morphine. 

Radio will not turn on. Power light is on, but no sound and no display. Switched to playing radio on the 
laptop in the room. Update: We got the radio to work. Not sure what the issue was. 

3:45 pm check (MBC): All patched rabbits still jacketed and seem calm; no chewing or scratching 
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Date: 6/19/19 
Personnel:  Adam, MBC 
Notetaker: Adam 
Time In: 8:00 AM 

Tasks Performed (Dosing, Exercise, etc.): Enrichment foods (toasted O’s, sunflower seeds, papaya 
tablets), health checks, morphine dosing, saline controls, exercise, patch checks 

Temperature: 65.5  F 
Humidity: 64.5 % 

Changes in Behavior (Lethargy, Hyperactivity, etc.): N/A 

Health Concerns: N/A 

Vet Checks Requested?: N/A 

Exercise: 

Control Rabbits placed at 8:15 starting with #04. 
Morphine Rabbits placed at 9:05 starting with #08. 
Fentanyl Rabbits placed at 10:05 starting with #01. 

Patch checks: 

#1 - Patch intact - vet wrap replaced - some hair / old patches trimmed 
#2 - Patch intact - vet wrap replaced - scratch healing well, ointment applied 
#3 - Patch and vet wrap intact 
#9 - Patch intact, vet wrap replaced, some hair / old patches trimmed - three old patch abrasions, ointment 
applied 
#13 - Patch intact, no vet wrap existing or applied. Crescent chips in teeth from chewing water bottle 
sipper and cage. Slight hair loss on nose. 
#16 - Patch intact, vet wrap intact. Some hair trimmed behind vet wrap. Health exam performed - teeth 
and gums healthy, no stomach abnormalities 
#19 - Patch intact, no vet wrap existing or applied 

Additional Notes: 

Rabbit #16 did not eat his enrichment food. 
Rabbit #18 nipped crook of arm above kevlar when carried to exercise pen 

Little Food Left: 05, 06, 08, 10, 11, 
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Lot of Food Left: 03, 09, 13, 16, 21 
Slightly Low Fecal: 05, 06, 08 
Very Low Fecal: 03, 09, 13, 16, 21 

All fentanyl rabbits appear to be behaving normally, with unexplained lack of appetite and fecal output 
reflecting this (except #01, 02, 19). We will keep them under close monitoring. Maybe they will be 
enticed to eat by exercising? 

Update: #13 and #16 had especially low fecal - we noticed #13 biting his water bottle sipper and banging 
it against the cage. Upon inspection, for both rabbits, the sipper needed to be pushed down in the bottle 
further for gravity to allow rabbits to drink freely. Lack of water may have contributed to low fecal output 
and reduced feeding. #3 and #9 also had low fecal, but not as low as #13 and #16, and their water bottles 
were normal. 

Thank you - Adam just left a note. Thanks. Were any bottles switched today? Or any other issues with 
them? I am emailing Beth. MBC: No water bottles switched today 

Date: 6/20/19 
Personnel:  Adam, Reed 
Notetaker: Reed 
Time In: 8:00 AM 

Tasks Performed (Dosing, Exercise, etc.): Enrichment foods (spinach, papaya tablets), health checks, 
morphine dosing, saline controls, patch checks 

Temperature: 67.0  F 
Humidity: 64.5 % 

Changes in Behavior (Lethargy, Hyperactivity, etc.): N/A 

Health Concerns: N/A 

Vet Checks Requested?: N/A 

Patch checks: 

Rabbits #02 and 09 received triple antibiotic ointment in attempts to treat abrasions. Rabbit #02 
lacerations look very good, almost completely healed. Rabbit #16 had loose vet wrap. We trimmed this 
and applied a new jacket since his old one was fairly chewed. All patches were adhered and no new 
patches were applied. 

Additional Notes: 
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Little Food Left: 09, 11, 16, 17, 21 

All morphine rabbits appear fairly sedated. They are exhibiting normal breathing and postural stability, 
but minimal activity and some do have eyes partly shut. 
JMA: If more sedated than usual, please keep an eye on them for a bit. 
We are doing this. I was planning to stay for about 20 more minutes or until they seem to be up and 
moving around. They were dosed around 9:00 

Update: 9:37 A.M. All morphine rabbits have been observed up and taking a few hops. Breathing rate is 
normal and all seem alert and healthy. Great, thanks! 

Adam: We think the fecal output was better on 13 and 16 but are not 100% sure because the cage batteries 
were changed out prior to our arrival in the room at 8:00 A.M. 

JMA: I will email Beth and ask, and request that they tell us if batteries need to be changed before 8 and 
if so the staff should fill in the fecal log.  

Adam: Thank you, it was also a little frustrating having to wait due to batteries in the doorway, etc. Only 
one more week! Other than this, all dosing went smoothly and everyone seems to be doing well. 

Date: 6/21/19 
Personnel:  Gina, MBC, JMA (to assist with patches) 
Notetaker: MBC and JMA 
Time In: 8:00 AM 

Tasks Performed (Dosing, Exercise, etc.): Enrichment foods (spinach/spring mix, papaya tablets), 
health checks, morphine dosing, saline controls, patch application 

Temperature: 65 F 
Humidity:  66% 

Changes in (Lethargy, Hyperactivity, etc.): N/A 

Health Concerns: N/A 

Vet Checks Requested?: N/A 

Exercise: 

Control rabbits put in at 8:25 and taken out at 9:10 
Morphine rabbits put in 9:18 at and taken out at 10:03 

2018-DU-BX-0188 Final Technical Report 
October 2021 

This resource was prepared by the author(s) using Federal funds provided by the U.S. 
Department of Justice. Opinions or points of view expressed are those of the author(s) and do not 

necessarily reflect the official position or policies of the U.S. Department of Justice.

577 



 
 

     
 

   
 

 
  

 
 

 
  

 
 

  
 

 
 

 
   
    

 
 

 
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  
 

 
 

 

Fentanyl rabbits put in at 10:10 and taken out at 10:55 - #19 in at 10:28 

Additional Notes: 

Little food left: #1, #5, #6, #9, #10, #16, #17 
Lot of food left: #21 
Low fecal: #5 (slightly), #14 (slightly), #17 (slightly), #21 (slightly) 

JMA assisted with patch application due to ongoing issues with gummy fur/poor skin condition. All 
animals reshaved and gummy hair trimmed back. Ointment applied to reddened skin as needed. 

#1 skin looks good, no abrasions. Sausage-style vet wrap applied. 
#2 abrasion from scratching almost fully healed. Ointment applied. Vet wrap applied, since tegaderm did 
not stick very well. 
#3 vet wrapped - very small scratch treated with ointment 
#9 has bad skin, gummy fur, redness, and is angry - just getting a sausage wrap due to agitation - he 
should be checked tomorrow 
#15 has bad skin - small abrasion treated with ointment 
#19 has gummy hair - abrasion treated with ointment 

#21 biting 

One CaviWipes container is empty and the other is also empty - we need more 

Syringe and Needle Count: 

Small Box 
Bag of 72 smaller (saline/morphine) syringes 
32 needles 
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Large Box 
100 (1 full box) needles 
100 (1 full box) needles 
Bag of 102 smaller (saline/morphine) syringes 
Bag of 92 smaller (saline/morphine) syringes 
Bag of larger (calcein) syringes 

Totals: 
232 needles 
226 smaller (saline/morphine) syringes 
82 larger (calcein) syringes) 

Minimum Needed for Remaining Study 
5 days remaining x 10 saline/morphine per day = 50 small syringes 
(2 calcein days x 21 rabbits) + 21 large syringes for fatal plus = 63 large syringes 
113 needles 

Date: 6/22/19 
Personnel:  Abbe, Reed 
Notetaker: Abbie 
Time In: 8:00 AM 

Tasks Performed (Dosing, Exercise, etc.): Enrichment foods (spinach, papaya tablets), health checks, 
morphine dosing, saline controls, patch checks 

Temperature: 65.5 F 
Humidity: 61.5 % 

Changes in Behavior (Lethargy, Hyperactivity, etc.): #9 a little lethargic. Was annoyed when I re-
vested him, but didn’t feel anything abnormal (bloating, fur quality, etc.) I think he’s just having a fit 
about the vet wrap. 

Health Concerns: #3 appears to be having the same ophthalmic discharge that #19 was having. 
Discharge is clear and there doesn’t appear to be a lot of fluid. Right eye does not appear cloudy or have 
any other abnormalities. Likely just irritated (allergies?). No change in behavior. 

Vet Checks Requested?: N/A 
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Patch checks: All animals’ patches intact. Only #9 unzipped his jacket, but the vet wrap was intact. Skin 
looks better, but not completely without redness and gummy fur. He was less irritated. 

Additional Notes:  A few logs were not filed out/filled out incorrectly,  UARV staff left some notes 
about this, as well as a note about leaving dirty bowls in the sink. Logs have been corrected. 

JMA: Can you guys let me know which logs were incorrect? 
Health check log. #11 was filled out twice, #16 wasn’t filled out at all. 

Little Food Left: #3, #11, #17, #19 
Lots of food left: #9, #13, #16, #21 
Low Fecal: #9, #13, #21 

Date: 6/23/19 
Personnel:  Abbie, MBC 
Notetaker: MBC 
Time In: 8:05 AM 

Tasks Performed (Dosing, Exercise, etc.): Enrichment foods (spinach, apricot, papaya tablets), health 
checks, morphine dosing, saline controls, patch checks 

Temperature: 63.5 F 
Humidity: 62.0 % 

Changes in Behavior (Lethargy, Hyperactivity, etc.): 

Health Concerns: 
#3-- eyes look fine today, no discharge noted.
 #9-- Skin around patch has greatly improved, much less red 

Vet Checks Requested?: N/A 

Patch checks: 
All fentanyl patches were checked and adhered with vet wrap covering (except #16, see below). None of 
the rabbits had significant abrasion or skin reddening around the patch area under the vet wrap. 

#3 unzipped jacket and it is hanging around the collar - vet wrap intact and unchewed. The jacket was in 
good condition so it was put back on. 

Additional vet wrap was added to #16 - his sausage had slipped down below the patch so that the patch 
was not covered. Cross-leg pieces were added. 
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#19 (control with orange vest) had no Tegaderm patch. His vest was chewed off around the neck, leaving 
only the buckled portion so the patch either fell off or was eaten. His hair had grown too much to adhere a 
patch so he was shaved, and a new Tegaderm patch applied. A new orange jacket was applied. 

Additional Notes: 

Little Food Left: #8, #9, #10, #12, #13, #16, #17 
Lots of food left: #11, #21 
Low Fecal: #13, #21 

Kevlar sleeves are missing - maybe they were laundered. Will check laundry room. Update: Kevlar 
sleeves being returned by UARV staff 

Enrichment foods - spinach is at half bag - do we want more fresh, or use up the dry food? 

#21 had low fecal and lots of food left - he was observed sucking his sipper without bubbling, and very 
high water level in the water bottle. We pushed sipper back down into the water bottle until it bubbled 
when touched on the end. He is now drinking a lot of water, so hopefully this should assist his digestion. 
It’s a good idea to check sippers if they appear to have not been used (~1 inch below top) 

All logs double checked by both individuals; no issues 

Date: 6/24/19 
Personnel:  Reed, MBC 
Notetaker: Reed 
Time In: 8:05 AM 

Tasks Performed (Dosing, Exercise, etc.): Enrichment foods (spinach, prune, papaya tablets), health 
checks, weighing, morphine dosing, saline controls, patches 

Temperature: 62.5 F 
Humidity: 72.0 % 
*JMA: The humidity has been very high today. Beth called Energy Systems and they switched us to the 
University Chiller (as opposed to the UARV specific chiller) without prior notification. She requested that 
it be switched back ASAP and remain on the UARV chiller for the remainder of the summer. 

Changes in Behavior (Lethargy, Hyperactivity, etc.): N/A 

Health Concerns: N/A 

Vet Checks Requested?: N/A 
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Exercise: Controls placed at 8:30, removed at 9:15 
Morphine placed at 9:40, removed at 10:25 
Fentanyl rabbits placed at 10:30, removed at 11:15 

Additional Notes: 

All animals consumed the totality of enrichment foods from yesterday. 

All control and fentanyl rabbits were shaved both in the patched region and at the nape of the neck (if 
needed) to prepare for calcein tomorrow. All rabbits had regions that could just be shaved to apply the 
patch - there was no extensive removal of gummy hair. The fentanyl rabbits were all very combative 
towards further removal of non-shavable gummy hair via scissors or pulling. 

The scratch on #2 was fully healed. Some ointment was applied to a more caudal region reddened from 
the collar/jacket rubbing. 

#3 had unzipped his jacket by pulling it against the grain, so it was difficult to rezip. His collar and front 
legs were in proper position. He had pulled on the vet wrap through the shoulder region and exposed the 
patch. We applied the new patch far enough back to only need to sausage wrap him. He seems to be 
getting out of the jacket partially through leveraging the cross-pieces on the shoulders, which he 
continually pulls on and chews. Hopefully by only placing a sausage wrap, he will not gain the leverage 
needed to unzip his jacket. Fortunately, #3 seems to have no interest in removing his patch, although he is 
frequently able to unzip it. 

Fentanyl rabbit skin was in much improved condition today. The only rabbit with a dark purple abrasion 
was #13, who had a bad abrasion under the patch removed today. We treated it with antibiotic ointment. 

All fentanyl rabbits were vet wrapped during the previous patch day, and this vet wrap was replaced in 
the same arrangement (except #3, who did not have shoulder crosspieces put on as he continues to pull on 
them). No control rabbits were vet wrapped. 

There were no observed issues with water bottle drippage or severely low fecal output today. 

Lots of food left: #21 
Low Fecal: #21 (slightly) 

Date: 6/25/19 
Personnel:  Reed, MBC, Adam 
Notetaker: Reed 
Time In: 8:05 AM 
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Good morning, Team! Good luck and let me know if you need anything. 

Tasks Performed (Dosing, Exercise, etc.): Enrichment foods (spinach, papaya tablets), health checks, 
morphine dosing, saline controls, calcein, patch checks 

Temperature: 65.0 F 
Humidity: 71.0 % 

Changes in Behavior (Lethargy, Hyperactivity, etc.): 

Health Concerns: 

Vet Checks Requested?: N/A 

Additional Notes: 

Little food left: 1, 5, 8, 9, 10, 11, 12, 14, 16, 
Lots of food left: 17, 19, 20, 21 
Low fecal: 19, 21 

Rabbit #07 chewed all hair off of his hind limbs. Most of the hair on the anterior aspect of both hind 
limbs. His legs are by no means completely bare. Maybe rubbed off from the rear leg loops of the vest? 

#1’s sipper was not in the stopper well, so he couldn’t get water and is a bit dehydrated. We fixed the 
sipper and tested it. He now has access to water again and is drinking normally. 

#3 scratched himself while administering calcein. Now has a small laceration lateral to the patch site. We 
applied ointment and re-vet wrapped him. 

#5 effluxed a few drops of calcein due to pulling his skin tight. 
#7 jerked while administering calcein and lost just the last bit of his dose. Will need to make sure he has 
full dose tomorrow. 
#9 being extremely difficult during calcein dosing, has an abrasion from fighting the injection. We 
applied ointment and re-vet wrapped him. We did administer a full dose with Adam doing his special 
hold. 
#13 also being difficult, required 3 jabs to get the full dose, effluxed a small amount. 
#16 had a small amount of efflux and is jumping like crazy. Highly agitated from the calcein injection. 
#19 effluxed a couple drops from jerking away from the needle. 

*If any of them lose a lot, please try a second time with the approximate dose that was efluxed. But do not 
try more than twice. RAD: Will do. JMA: Thank you. I know this is difficult and appreciate your efforts. 

Dehumidifier bucket was not emptied, nor was it draining itself so it was not running. We emptied the 
bucket and reattached the drain hose, hopefully this will help with the humidity issues in the room. 
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---------------------------------------------------------------------------------------------------------------------

JMA: Definitely leave a note for UARV staff regarding dehumidifier/sippers. I have already discussed the 
sipper issues with Beth and its importance. 

Patch Checks: 

All patches intact. #3, #19 needed re-vet wrapped due to chewing. 

Date: 6/26/19 
Personnel:  Adam, MBC 
Notetaker: Both 
Time In: 8:22 AM (after calcein preparation took a bit of extra time - we ran out of saline and had to get 
extra from Beth Kenaga) 

*Final day of experimental treatments* 

None of the rabbits had S-hooks on their cages when we came into the room this morning after 
enrichment devices were changed by UARV staff last night. Aspen bin was empty. Not all exercise 
pens had springs. 

I hope you told Beth this when you went to get saline -- if not, please do as this is unacceptable 
We did not, as we had not been up to the room. We had to get more saline for calcein preparation. I 
will let her know when we return the pink slips. 

Okay. I will email her now. Did any rabbits open cages or anything like that? 

Thankfully not, however, three of them did have poop on the S hook so we had to get new ones. 
Were they on the cages just not secured? Some were, but a lot were on the floor of the room or in 
the rabbit’s cages. Thank you -- I have emailed Beth. Also, Reed is on his way. See you around 10! 

Ok, thank you. Sounds good, hopefully your meeting goes well. 

Tasks Performed (Dosing, Exercise, etc.): Enrichment foods (spinach and papaya tablets), health 
checks, morphine dosing, saline controls, calcein, patch checks 

Temperature: 65.5 F 
Humidity: 67.0 % 

Changes in Behavior (Lethargy, Hyperactivity, etc.): 

Health Concerns: 
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---------------------------------------------------------------------------------------------------------------------

Vet Checks Requested?: 

Additional Notes: 
Little food left: 11, 20, 21 
Low fecal: 21 

#3 removed vet wrap but not patch. Wrap (sausage-style) was replaced. #3 had to be poked multiple times 
(4-5 times) due to jerking during the injections. Ointment was placed on the injection sites. 

S-hooks were not replaced on cages by UARV staff and were found on the room floor/floors of their 
cages. UARV staff was notified.  

Exercise: 

Exercise - Controls placed at 8:30 A.M. starting with rabbit #04 
Morphine placed at 9:30 starting with rabbit #8  and removed at 10:15 
Fentanyl placed at 10:21 starting with #1 and removed at 11:06 

Date: 6/27/19 
Personnel:  Abbie, Adam, JMA, MBC 
Notetaker: JMA 
Time In: 8:00 AM 

Euthanasia Day #1 

Tasks Performed (Dosing, Exercise, etc.): Enrichment foods (papaya tablets, spinach, toasted o’s), 
health checks, patch removal, euthanasia 

Temperature: 65.5 F 
Humidity: 71.5% 

Changes in Behavior (Lethargy, Hyperactivity, etc.): N/A 

Health Concerns: N/A 

Vet Checks Requested?: N/A 

Additional Notes: 

Rabbits #4,5,6,7,14 (controls) were euthanized between 8:00-11:00 A.M. in the UARV necropsy suite. 
Dissections of the left hindlimb followed in D410. 
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---------------------------------------------------------------------------------------------------------------------

Rabbits # 15,18 (controls),8,10,11,12 (morphine) were euthanized between 2:00-5:30 P.M. in the UARV 
necropsy suite. Dissections of the left hindlimb followed in D410. 

Adam and JMA removed fentanyl patches from all fentanyl rabbits, provided enrichment foods to the 
remaining rabbits, completed/corrected logs, took photographs of patch areas between 5:30-6:30 P.M. 

Dissection continued in D410 until 7:30 P.M. 

Date: 6/28/19 
Personnel:  Abbie, Adam, JMA, MBC 
Notetaker: JMA 
Time In: 8:00 A.M. 

Euthanasia Day #2 

Tasks Performed (Dosing, Exercise, etc.): Euthanasia 

Temperature:  F 
Humidity: 

Changes in Behavior (Lethargy, Hyperactivity, etc.): N/A 

Health Concerns: N/A 

Vet Checks Requested?: N/A 

Additional Notes: 

Rabbits #17,20,21(morphine), and 1,2 (fentanyl) were euthanized between 8:00-10:30 A.M. in the UARV 
necropsy suite. Dissections of the left hindlimb followed in D410. 

Rabbits # 3,9,13,16,19 (fentanyl) were euthanized between 1:30-4:00 P.M. in the UARV necropsy suite. 
Dissections of the left hindlimb followed in D410. 

2018-DU-BX-0188 Final Technical Report 
October 2021 

This resource was prepared by the author(s) using Federal funds provided by the U.S. 
Department of Justice. Opinions or points of view expressed are those of the author(s) and do not 

necessarily reflect the official position or policies of the U.S. Department of Justice.

586 





 
 

 
 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 

Slide clipped into place – coverslip facing up! 
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5. Adjust lamp brightness 

4. Adjust filter knobs 

a. Look at the right side of the 
microscope under the coarse 
adjustment knob 
b. LBD should be pushed in. 
This is a color balancing daylight 
filter 
c. ND6, ND25, and OP should not 
be pushed in. 
These are neutral density filters that 
limit light transmittance 

a. Make sure the button next to Pre-Set is not lit. If it is lit, press the button to remove the 
pre-set. This will allow you to adjust brightness intensity. 

b. On the right side of the microscope, adjust the brightness intensity knob for the lamp until 
the lamp voltage indicator for 9 lights up on the microscope body. This is the optimum 
brightness for photography with the LBD filter. 
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f. If you clicked inside the File Explorer window while Resize Images was running, nothing 
will be selected once it finishes. Search for (Small) in the File Explorer window, and you will 
be able to select only the Small images and move them to a subfolder labeled Small. 
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8. Camera Control (left) should have the following defaults: 
e. Exposure 

i. Region: Full Image 
ii. Sensitivity: ISO 400 
iii. Exposure Compensation: 0 

f. Resolution: 
i. Live/Movie: 680 x 512 - Any higher and the 

image will “seize” 
ii. Snapshot: 4080 x 3072 (Pixel Shift) 

g. Image Averaging 
i. Live unchecked 
ii. Snapshot unchecked 

h. DP71 
i. Live image quality: High 

9. Image Acquisition Settings 

b. Document: Snapshot 
a. Click the hand on camera icon under Camera Control 

i. Change Text to the image name in the format: NumberLF_Slide_Pol 
ii. E.g. 4LF_88um_Pol for Rabbit 4 Left femora, 88 um slide 

iii. Reset Counter Start to 0 and Counter digits to 4 
c. Saving: Snapshot 

i. File Type: .bmp (.tif does not save correctly) 
ii. Check: Close after save (keeps images from piling up in the window) 
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a. I recommend checking your settings (white balance and exposure) by keeping this box 
unchecked, take a test image, and look at it in the popup tab. Then delete that test image from 
the folder and check the box so your real images are not saved in the cellSens window. 

iii. Path: File path to a new folder on your external USB / Hard Drive (we will 
transfer images to a better computer for photomerging) 

d. Camera: General 
i. Bit depth: 10-bit RGB color 

ii. Mirror: Unchecked 
e. Camera: Adjustment (Keep Defaults) 

i. Gamma: 1 
ii. Sharpness: 2 

iii. Contrast: 2 
iv. Shading: Flatfield 

f. Camera: Color 
i. Copy the R, G, B values (from your white balance) to this spreadsheet: 

https://docs.google.com/spreadsheets/d/1bCUXlHeUb77umeDTyggK8aZp3Nm01Bjlow 
NvjxVjxyw/edit#gid=0 

ii. Copy the Black Balance value to the spreadsheet 
iii. Uncheck Device dependent white balance 

g. Click OK to exit 

2018-DU-BX-0188 Final Technical Report 
October 2021 

This resource was prepared by the author(s) using Federal funds provided by the U.S. 
Department of Justice. Opinions or points of view expressed are those of the author(s) and do not 

necessarily reflect the official position or policies of the U.S. Department of Justice.

610 

https://docs.google.com/spreadsheets/d/1bCUXlHeUb77umeDTyggK8aZp3Nm01Bjlow




 
 

 
    

   
 

 
 

   
   

    
   

    
      

  
   

 
 

  
 

    
    

 
    

    

2. In order to facilitate easy photomerging, you will start with the left side. 
a. Use the X-axis adjustor to move to the far left of the specimen (on screen – it is 

reversed on the stage) 
b. Check with the Y-axis adjustor up and down that you are at the very left edge of the 

sample 
c. Use the Y-axis adjustor to move to the very top left of the sample 

20. Hit F8 on the keyboard to take a snapshot 
a. This image will take a moment to expose and average, will briefly appear in the 

toolbar, and then will save to your folder and disappear. I recommend keeping a File 
Explorer window open of your folder to assure yourself that the image saved. 

21. Move down so that you have about 20-25% overlap with the previous image. Look for distinct 
structures (osteons, periosteum/endosteum, etc.) 

22. If needed, fine focus the new image, and then hit F8 again to snapshot the next image. However, 
try not to modify the fine focus unless the Haversian canals or secondary osteon cement lines 
look out of focus. 

23. Continue moving about 75-80% down, fine focus, F8 snapshot until you reach the bottom of the 
sample 

24. Now move to the right, leaving about 20-25% overlap with the previous column. Move the rest 
of the way down to the bottom of this new column (if needed). Then you’re your way up the 
column to the top in the same fashion. 

25. Continue in this serpentine fashion until you reach the marrow cavity at the top, denoted by a 
black space below your column. Now you will start on the top section. 
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1. You must have completed all microscope setup steps to proceed. Make sure the specimen is still 
in focus at 20x and that the aperture iris diaphragm is still at 70-80% 

2. Turn on the mercury lamp and reset the timer, which counts in fractions of hours 
a. The lamp must run at least 40 minutes (~0.7) once you turn it on 

i. Wait 5-10 minutes for it to stabilize before capturing images 
b. The lamp must rest at least 40 minutes after you turn it off, before more use 

3. Pull the reflected light analyzer out until it clicks into its “out” position 
4. Pull the linear polarizer out until it clicks into its “out” position 
5. Pull the DIC prism U-DICTS until it clicks into its “out” position 
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10. Turn the shutter from the black dot (off) to the white dot (on) 

Avoid photobleaching! Close the shutter when you are not actively imaging! 
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11. Adjust field iris and aperture iris 
a. Looking through the eyepiece, rotate the pull out the field iris diaphragm knob (FS) 

(on the right side of the microscope above the objectives) until the lighted space takes up 
70-80% of the field of view 

b. Pull the aperture iris diaphragm knob (AS) all the way out. This should reduce 
background fluorescence. 
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6. Camera Control (left) should have the following defaults: 
i. Exposure 

i. Region: Full Image 
ii. Sensitivity: ISO 400 
iii. Exposure Compensation: 0 

j. Resolution: 
i. Live/Movie: 680 x 512 

1. Any higher and the image will “seize” 
ii. Snapshot: 4080 x 3072 (Pixel Shift) 

k. Image Averaging 
i. Live unchecked 
ii. Snapshot unchecked 

l. DP71 
i. Live image quality: High 
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2. In order to facilitate easy photomerging, you will start with the left side. 
a. Use the X-axis adjustor to move to the far left of the specimen (on screen – it is 

reversed on the stage) 
b. Check with the Y-axis adjustor up and down that you are at the very left edge of the 

sample 
c. Use the Y-axis adjustor to move to the very top left of the sample 

31. Hit F8 on the keyboard to take a snapshot 
a. This image will take a moment to expose and average, will briefly appear in the 

toolbar, and then will save to your folder and disappear. I recommend keeping a File 
Explorer window open of your folder to assure yourself that the image saved. 

32. Move down so that you have about 20-25% overlap with the previous image. Look for distinct 
structures (osteons, periosteum/endosteum, etc.) 

33. If needed, fine focus the new image, and then hit F8 again to snapshot the next image. However, 
try not to modify the fine focus unless the Haversian canals or secondary osteon cement lines 
look out of focus. 

34. Continue moving about 75-80% down, fine focus, F8 snapshot until you reach the bottom of the 
sample 

35. Now move to the right, leaving about 20-25% overlap with the previous column. Move the rest 
of the way down to the bottom of this new column (if needed). Then you’re your way up the 
column to the top in the same fashion. 

36. Continue in this serpentine fashion until you reach the marrow cavity at the top, denoted by a 
black space below your column. Now you will start on the top section. 
a. Under Image Acquisition Settings, change the subfolder for saving to a new subfolder “Top” 
b. You can begin resizing the images from the “Left” folder at this point. 
c. In the top section, image only from the top of the bone to the marrow cavity in a serpentine 

fashion. 
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Photomerging: All Images 
I highly recommend that you mark on the slide label the direction the slide was facing (e.g. arrow towards 
the microscope) so that it is easy to replace if you miss a spot. 
Attempt First: Image Composite Editor 
Image composite editor is good at photomerging clear images, but you cannot adjust any of the 
components if they merge incorrectly. Try it first and see if you are lucky to have a clean merge. It will 
run very quickly. 
1. Move the hard drive with your resized images to FOOTE 
2. Open Image Composite Editor 
3. New Panorama from Images → Navigate to the Small folder of one of your four regions (Top, 

Bottom, Right, Left) 
4. Simple Panorama 

a. Camera Motion = Planar Motion 
b. Click Next 

5. If the stitching is successful, click next 
6. Crop: 

a. Do not use Auto Complete 
b. Select No Crop 
c. Click Next 

7. Export 
a. Image Size Scale = 100% 
b. Image File Format = Windows Bitmap 
c. Export to Disk → Save in desired file location 

8. If the image merges well (no distorted internal regions) but has large regions that are disconnected, 
try merging ½ or 1/3 of the images and then pasting the sections together in photoshop. Look for a 
clean top and bottom so you end your sub-section on a complete column. 

Attempt Second: Photoshop CS3 Photomerge 
Photoshop CS3 is old, but it allows you to move components that have incorrectly merged and “snap” 
them into place. It can only handle about 150 of the 200x images at a time. It may take several hours to 
overnight to run a whole region. 

1. Search for Adobe Bridge CS3 (not the most recent version) on FOOTE 
2. Navigate to the Small folder of one of your four regions (Top, Bottom, Right, Left) 
3. Select all images by clicking the first image, holding Shift, and clicking the last image. 
4. Tools → Photoshop → Photomerge 
5. Adobe Photoshop CS3 will open 
6. Select Layout option Interactive Layout 
7. Check box Blend Images Together 
8. Click OK 
9. Photomerge may take quite some time to run – leave it alone 
10. Manually fixing merge errors: 

a. Images that photoshop could not merge appear in the top panel. You can leave them in 
the panel if you don’t want them (e.g. completely white or black) and they will be 
deleted 

b. Zoom in and out using the mountain icon slider 
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c. To move an incorrectly merged image, just drag it to the correct location with your 
mouse. If it matches well, it should “snap” into place. You can also just leave it there to 
force it into place. 

d. Click OK when finished 

11. Image → Layer → Flatten Image 
12. Save As → Save as a BMP with default settings 

Combining The Four Regions in Photoshop 
1. This is easier in Photoshop 2019 or 2020 (on FOOTE) 
2. Open the first region using File → Open 
3. If you merged with Image Composite Editor, you will need to make the black background 

transparent 

a. On the left-side toolbar, hold down the eraser tool and select Magic Eraser Tool from 
the popup menu 

b. Click on the black background regions to make them transparent 
4. Expand canvas to accommodate the next region using Image → Canvas Size 
5. Repeat steps 3 and 4 for the next region, which will open in a new tab 
6. Go to the tab for the region you want to place, and select Edit → Copy 
7. Go to the tab for the region with the expanded canvas and select Edit → Paste. The region will paste 

as a new layer 
8. On the Layers panel, select the region you just pasted. Click Control – T to free transform, or use the 

Edit → Transform menu to rotate and flip the selected region 
9. Use the magnifying glass from the left-side tools panel to zoom in and make sure the regions fit well 

together 
10. Layer → Flatten Image to combine 
11. Crop excess white space out of the image using Image → Trim 
12. File → Save As and save the final image as a BMP (uncompressed) 
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I Missed a Spot! 
1. Make sure the microscope is set up for the appropriate imaging setup and the slide is in the same 

position on the stage 
2. In cellSens Entry: 

a. Image Acquisition: Camera Color, enter your recorded values for white balance (R, G, B) 
and black balance (if appropriate) 

b. Exposure: Enter your recorded value for exposure 
3. Navigate to the missed region using the landmarks on your photomerged image and re-take the 

image 
4. Resize the image to Small as before 
5. If you needed to take multiple images, merge them into a small region using Image Composite 

Editor or Photoshop CS3 
6. Paste and Flatten the small region onto your main photomerge as before. 
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1. Resize in Photoshop 

We previously resized in Windows File Explorer, but this creates a rim of light around photo edges that 
interferes with ICE. We will now resize in Photoshop using a custom macro. We are resizing to a quarter 
of original size (1020 x 736 pixels) to layer-based export from ICE and manual correction in photoshop 
How to set up the resize macro the first time in Photoshop 2020 (needs to be done if you are using a new 
computer or installation – it is already on FOOTE): 

1. Open any original-sized microscopic image in photoshop 
2. Go to Window --> Actions 
3. Select the + button to create a new action (I named mine ResizeQuarter) then click Record. The 

red button will be lit in the actions panel indicating you are recording. 
4. Select Image --> Image Size 
5. In the Image Size popup, change Width to 1020 pixels. The Height should automatically change 

to 768 pixels. Keep the other defaults (Resolution 300 Pixels/Inch, Resample Automatic). 
6. Click OK 
7. Click the white square stop button on the Actions panel to stop recording 
8. Now your macro should be available under File --> Automate --> Batch in the Action dropdown 

menu 

How to resize images after setting up the macro: 
1. Move the hard drive with the original-sized images to FOOTE 
2. Open Photoshop 2020 (search Photoshop in toolbar to find it) 

a. Note that Photoshop 2019 and CS3 are also installed 
3. File → New → Create → Accept defaults 
4. File → Automate → Batch 

a. Set: Default Actions 
b. Action: ResizeQuarter 
c. Source: Folder → Choose your Original folder 

i. Checkbox: Suppress File Open Options Dialogs 
ii. Note: It will show you the last folder you were in within photoshop – make 

sure you are in the correct folder 
d. Destination: Folder → Make a new output folder to hold the resized images (I have been 

calling it PSmall) 
i. Note: It will show you the last folder you were in within photoshop – make 

sure you are in the correct folder 
e. Leave all other defaults 
f. Click OK; images will automatically load, resize, save, and close in turn 
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Batch Processing Dialog in Photoshop 2019 
2. Photomerge Each Region 

2a. Image Composite Editor (ICE) 
If you get lucky, sometimes all images from your regions will merge into a single composite. You may 
try throwing images from all four regions in to ICE first (before merging individual regions) to see if 
this works. If this does not work, restrict the input to one region at a time. 
ICE Download: https://www.microsoft.com/en-us/research/product/computational-photography-
applications/image-composite-editor/ 

1. Install ICE if on a new computer (it is already on Foote) 
2. Search ICE in the toolbar to open Image Composite Editor 
3. Select New Panorama from Images 
4. In the Select Overlapping Images popup, select the photoshop resized version of one of your 

regional folders (e.g. Bottom Small) 
a. Ctrl + A to highlight all images 
b. Click Open 

5. If you want to try merging all regions, click Add Images and repeat step 4 to load the small 
versions of images from the other three regions 

6. Select Simple Panorama 
7. Under Camera Motion, change to Planar Motion 
8. Click Next and wait for ICE to run (it runs fairly quickly – usually a few minutes) 
9. Check the number of images merged at the bottom (e.g. “Stitched X of X Images”) 
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ICE could combine all Regions 
10. If you were merging multiple regions and they merged badly or missed many images: Click 

the New panorama icon in the upper left hand corner  and try combining only the regions 
that merged well (or try one region at a time) 

11. “2 Stitch” tab displays; do not select any settings; just click Next 
12. “3 Crop” tab displays; do not select any settings; just click Next 
13. “4 Export” tab displays; keep Image scale at default 100% 
14. If all images were merged: Export as TIFF file (single composite images) 

a. File format = TIFF Image 
b. Alpha = Check box to include Alpha channel 
c. Export to Disk = Save in new ICE subfolder for merged regions 

i. Call it by region name e.g. “Bottom” 
15. If some images are missing or just slightly incorrectly merged: Export as Photoshop layers for 

manual correction (the composite will be made of the layers of individual images) 
a. File format = Adobe Photoshop 
b. Layers = All layers 
c. Check box to Maximize compatibility 
d. Export to disk = Save in new ICE subfolder for merged regions to modify 

i. Denote it needs to be fixed in photoshop e.g. “BottomPS” 
e. Note that merges of multiple regions may be too large to export in Photoshop – in this 

case, merge the slightly incorrect region individually and export it for individual 
correction in photoshop 

16. If the individual region is very badly merged or has many images missing 
a. Redo by loading just half of the region (look for the natural break of the top or bottom of 

a column) and merging it alone. 
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i. To select a subset of images (e.g. try to photomerge only half of the region), click 
the first image you want, hold Shift, and click the last image you want. 

b. If this works, repeat with the other half 

Correcting ICE Merge Mistakes of Individual Images in Photoshop 
1. Open Photoshop 2020 
2. Use View → Uncheck “Extras” to turn off grid for greater visibility 
3. Drag and drop the .psd file exported from ICE, or File → Open 
4. Make sure Snap to Layer is activated under the top toolbar View → Snap. 

a. If you do not see a checkmark, click Snap  
b. Check Snap To and make sure only Layers is checked 

5. Scroll down to the bottom of the layers panel and click on the layer “Composite.” This is the 
composite image than cannot be modified. Right click → Delete Layer 

6. Expand Canvas Size: If you need to expand the size of the Canvas to accommodate missing or 
misaligned images, use Image → Canvas Size 

a. Anchor the current region in the corner or side opposing the corner/side you want to 
expand, using the arrow keys 

b. Ballpark how much you want to expand (e.g. double the width or height) – you will 
crop the excess later, so it’s fine to use more than you will need 

c. Click OK 

Anchoring a Canvas in the lower left corner to expand it to the top and right sides 

7. Manually Move Incorrectly Merged Images 

a. With the move tool selected from the left hand toolbar , click the misaligned 
image. It will be highlighted on the right-side Layers toolbar. 

2018-DU-BX-0188 Final Technical Report 
October 2021 

This resource was prepared by the author(s) using Federal funds provided by the U.S. 
Department of Justice. Opinions or points of view expressed are those of the author(s) and do not 

necessarily reflect the official position or policies of the U.S. Department of Justice.

631 



 
 

 
   

      
   

     
 

  
 

  
 

  
 

 
  

 
    

  
   

  
 

  
    

      
  

 
  
   
  

    
   
  

   
   
  
  

  
  

   
    

    
  

   
  

     
  

   
 

i. To move multiple connected images, use the move tool to draw a box around the 
connected images 

b. Use hotkeys Ctrl + Shift + ] on the keyboard (easier on the right side) to bring the 
selected image to the front, or use Layer → Arrange → Bring to Front 

c. Move the image / images to the larger section of the image that is correctly merged. 
Use visual similarly to match the image. 

i. If you’re not sure where an image goes, click on the incomplete region of the larger, 
correctly merged section. The layer will be selected on the Layer panel and you can 
check the number. Look for a free-floating or misaligned image with a similar 
number. 

d. Gently move the image towards the visual similarity on the larger, correctly merged 
image. When the visual similarities match, the moving image will “snap” or slightly 
settle into place 

i. Be aware that (especially on polarized images), images do sometimes incorrectly 
snap together if they are visually homogenous 

ii. If the visual similarity is not clear enough for the two images to be “snapped”, just 
manually move it into place 

8. Add Missing Adjacent Images 
a. Try this when a whole column or section of adjacent columns is missing, but you think 

they may merge to each other 
b. File → Scripts → Load Files into Stack 
c. In the Load Layers popup, Browse and select the adjacent missing images composing 

the column(s) from your photoshop resized folder of that region 
i. Click the first image you want, hold Shift, and click the last image you want. 

Only select images adjacent to each other. 
ii. Click OK. The file names appear in the Load Layers window 

iii. Check box for “Attempt to Automatically Align Source Images” 
iv. Click OK 

d. The mini-photomerge appears in a new tab at the top of the page. 
e. If the photomerge was successful, it will appear in whole on the page. 
f. If the photomerge was not successful, click the first Layer in the Layers pane, hold down 

shift, and click the last Layer in the layers pane to highlight them all 
i. Select Edit → Auto-Align Layers 

ii. In the Auto-Align Layers popup, click Reposition 
iii. Click OK and the mini-photomerge will be attempted 

g. Once the mini-photomerge is acquired, merge the layers down so they operate as a 
single layer 
i. Click the first Layer in the Layers pane, hold down shift, and click the last Layer in 

the layers pane to highlight them all 
ii. Merge them using hotkey Ctrl + E, or else select Layer → Merge Down. 

h. Copy the merged layer by clicking it then Ctrl + C 
i. Paste the merged layer onto your main photoshop tab using Ctrl + P 

9. Add Missing Isolated Images 
a. Try this if you need to paste one or more missing images that are not connected (or if the 

mini-photomerge in the previous step fails or excludes some images) 
b. Open a File Explorer window and navigate to your photoshop resized folder of that 

region. Identify the missing images. 
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i. You can click on an unfinished edge or section of the current photoshop image and 
it will be highlighted in the layers panel. Look at the number in the filename to see 
what adjacent number to select.   

c. In File Explorer, highlight the missing image you want to paste 
i. To highlight multiple disconnected images, click Ctrl and click each one in turn 

d. Drag and drop the select image(s) onto the Photoshop window 
e. You will need to click Enter for each pasted image, which appears in a single stack with 

a blue X over the top. The X is removed when all images have been pasted via the Enter 
key. 

f. If you pasted more than one image, move the pasted images out of a single stack with 

the move tool  and snap them to their correct location as before. 
10. (Only if Necessary) Merge Completed Sections: If there are one or more chunks of the image 

that are well-merged, but you keep accidentally moving them, you can lock them into a single 
layer so they will not be accidentally modified. I would only do this for internal regions you are 
sure are complete, because edge regions may not actually be aligned with the connecting images 
and you cannot undo this step. 

a. Select the move tool from the left hand toolbar 
b. Click and draw a box around the completed section you want to merge 
c. Use hotkey Ctrl + E, or else select Layer →Merge Down. Now this section will 

behave as a single layer 
11. Flattening and Exporting 

a. Image → Trim → Based on Transparent Pixels 
b. Layer → Flatten Image 
c. File → Save As → Save on Your Computer 
d. Change Save as Type to .tiff 
e. In the .tiff options popup, choose Image Compression = None. Leave all other defaults 

and click OK. 

2b. Photomerge with Interactive Layout in Photoshop CS6 – for images that won’t merge 
recognizably in ICE 
Photoshop CS6 is old, but it has an Interactive Layout feature that more easily allows you to move 
components that have incorrectly merged and “snap” them into place. It can only handle about 150 of the 
200x images at a time. It may randomly freeze during operation – in which case, move on to Photoshop 
2020. 

13. Search for Adobe Bridge CS6 (not the most recent version) on FOOTE 
14. Navigate to the photoshop resized folder of one of your four regions (Top, Bottom, Right, 

Left) 
15. Select all images with Ctrl+A. 

a. To select a subset of images (e.g. try to photomerge only half of the region), click the 
first image you want, hold Shift, and click the last image you want. 

16. Tools → Photoshop → Photomerge 
17. Adobe Photoshop CS6 will open 
18. Select Layout option Interactive Layout 
19. Check box Blend Images Together 
20. Click OK 
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21. Photomerge may take a while to run – leave it alone 
22. Manually fixing merge errors: 

a. Images that photoshop could not merge appear in the top panel. You can leave them in 
the panel if you don’t want them (e.g. completely white or black) and they will be 
deleted 

b. Zoom in and out using the mountain icon slider 
c. To move an incorrectly merged image, just drag it to the correct location with your 

mouse. If it matches well, it should “snap” into place. You can also just leave it there to 
force it into place. 

d. Be aware that images may be incorrectly merged behind other images – look for 
blurry merged regions and move the top image out of the way 

e. Click OK when finished 

23. Image → Layer → Flatten Image 
24. Save As → Save as a BMP with default settings 

2c. Photomerge with Reposition in Photoshop 2020 
If ICE badly merges images, and Photoshop CS6 freezes, you can photomerge a region or sub-region with 
a manual repositioning component in Photoshop 2020. Recent versions of photoshop do not include the 
Interactive Layout option. 

1. Search for Adobe Bridge 2020 on FOOTE 
2. Navigate to the photoshop resized folder of one of your four regions (Top, Bottom, Right, 

Left) 
3. Select all images with Ctrl+A. 

a. To select a subset of images (e.g. try to photomerge only half of the region), click the 
first image you want, hold Shift, and click the last image you want. 

4. Tools → Photoshop → Photomerge 
5. Adobe Photoshop 2020 will open 
6. In the Photomerge Popup, select Layout option Reposition 

a. UNCHECK box Blend Images Together 
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b. If the images blend together, the layers will separate along features within the image 
c. Click OK 
d. Wait for the photomerge to finish 

7. Use View → Uncheck “Extras” to turn off grid for greater visibility 
8. Manually Move Incorrectly Merged Images 

a. With the move tool selected from the left hand toolbar , click the misaligned image. 
It will be highlighted on the right-side Layers toolbar. 

i. To move multiple connected images, use the move tool to draw a box around the 
connected images 

b. Use hotkeys Ctrl + Shift + ] on the keyboard (easier on the right side) to bring the 
selected image to the front, or use Layer → Arrange → Bring to Front 

c. Move the image / images to the larger section of the image that is correctly merged. Use 
visual similarly to match the image. 

i. If you’re not sure where an image goes, click on the incomplete region of the 
larger, correctly merged section. The layer will be selected on the Layer panel 
and you can check the number. Look for a free-floating or misaligned image with 
a similar number. 

d. Gently move the image towards the visual similarity on the larger, correctly merged 
image. When the visual similarities match, the moving image will “snap” or slightly 
settle into place 

i. Be aware that (especially on polarized images), images do sometimes incorrectly 
snap together if they are visually homogenous 

ii. If the visual similarity is not clear enough for the two images to be “snapped”, 
just manually move it into place 

9. (Only if Necessary) Merge Completed Sections: If there are one or more chunks of the 
image that are well-merged, but you keep accidentally moving them, you can lock them into 
a single layer so they will not be accidentally modified. I would only do this for internal 
regions you are sure are complete, because edge regions may not actually be aligned with 
the connecting images and you cannot undo this step. 

a. Select the move tool from the left hand toolbar 
b. Click and draw a box around the completed section you want to merge 
c. Use hotkey Ctrl + E, or else select Layer →Merge Down. Now this section will behave 

as a single layer 
10. Flattening and Exporting 

a. Image → Trim → Based on Transparent Pixels 
b. Layer → Flatten Image 
c. File → Save As → Save on Your Computer 
d. Change Save as Type to .tiff 
e. In the .tiff options popup, choose Image Compression = None. Leave all other defaults 

and click OK. 

3. Combine Regions 

3a. Combine regions in Image Composite Editor 
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Sometime multiple regions will auto-merge in ICE. Follow the same protocol as ICE merging within 
regions. 

1. Search ICE in the toolbar on FOOTE to open Image Composite Editor 
2. Select New Panorama from Images 
3. In the Select Overlapping Images popup, select the folder containing all four of your 

photomerged regions 
a. Ctrl + A to highlight all images 
b. Click Open 

4. Select Simple Panorama 
5. Under Camera Motion, change to Planar Motion 
6. Click Next and wait for ICE to run (it runs fairly quickly – usually a few minutes) 
7. Check the number of images merged at the bottom (e.g. “Stitched X of X Images”) 
8. “2 Stitch” tab displays; do not select any settings; just click Next 
9. “3 Crop” tab displays; do not select any settings; just click Next 
10. 4 Export tab displays; keep Image scale at default 100% 
11. Export as TIFF file (single composite images) 

a. File format = TIFF Image 
b. Alpha = Check box to include Alpha channel 
c. Export to Disk = Save in new ICE subfolder for merged regions 

i. Call it by region names e.g. “LeftBottom” 
12. If not all regions combined (common with Pol images), we will do it in Photoshop (see below) 

ICE could combine the bottom and left regions, but not the top and right regions 
3b. What to do if there is NO complete auto-merge of DIC, Pol, or Flo 
In most cases, the DIC and/or Flo image will completely auto-merge. You can use this as a template for 
aligning regions on the other images. If you do not have a complete auto-merge of ANY image for a 
sample (DIC, Pol, or Flo), you will need to manually align one of them in Photoshop 2020. I recommend 
aligning the DIC image manually because it has the most reference structures and is most likely to at least 
partially have combined regions in ICE. 
1. Open Photoshop 2020 
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2. Use View → Uncheck “Extras” to turn off grid for greater visibility 
3. Open the first region (or ICE-merged regional composite) of the DIC image using File → Open. I 

like to open the Left side first. 
4. Expand canvas to accommodate the next region using Image → Canvas Size. Ballpark how much 

bigger the space will need to be and increase the pixels by that factor. It’s fine to oversize – we will 
trim later. 

5. From File Explorer, drag and drop the next adjacent region. It will appear with a blue X. Click Enter 
to paste. 

6. Click on the pasted Layer in the Layers panel and choose Convert to Layer 
7. Click on the region and press Ctrl + T to open free transform. Move the pasted region into place 

overlapping the existing region. 
a. ICE sometimes rotates layers slightly, so you may need to rotate the layer (look for the 

curved arrow when you move to the side of the image) 
8. Try to Auto-Align the regions tightly by holding Ctrl and clicking both layers in the Layers panel. 

Use Edit → Auto Align Layers and choose Reposition 
9. If Auto-Align layers doesn’t work due to insufficient overlap, just move the layers into place 

manually 
a. You can toggle layer transparency to assist in aligning layers by clicking on the layer in the 

Layers panel and reducing its Opacity. Just remember to put back to 100% before flattening 
the layers. 

b. It is okay if regions don’t perfectly align, as long as they are mostly aligned. 
10. Repeat steps 4 – 8 until all regions (and sub-regions) are aligned 
11. Get rid of color seams: ICE creates a brightness gradient for DIC images. Equalize this gradient by 

selecting all regions in the Layers panel and clicking Edit → Auto Blend Layers 
12. Flattening and Exporting 

a. Image → Trim → Based on Transparent Pixels 
b. Layer → Flatten Image 
c. File → Save As → Save on Your Computer 
d. Change Save as Type to .tiff 
e. In the .tiff options popup, choose Image Compression = None. Leave all other defaults and 

click OK. 
13. Save the finalized cross-section to cloud storage 

4. Align and Anatomically Orient DIC, Flo, and Pol in Photoshop 2020 

4a. Align Flo and Pol images with DIC image 
We want all three images to be as precisely aligned as possible, so that we can use Flo markers for the 
DIC and Pol structures. For this step, you will need at least one fully aligned cross-section. If you don’t, 
go back to step 3b and manually align the DIC cross-section. 
This SOP assumes that DIC and Flo are fully auto-merged (as is typical), and Pol is not fully merged, but 
you can also apply it to other variations. For example, you can use DIC to align the Flo regions, and then 
make a Flo overlay for the Pol regions. 

1. Open DIC image in Photoshop 2020 
a. Layer → Rename Layer → “DIC” 

2. Drag and drop Flo image. 
a. You must be resized on DIC for full size for Flo to drop into the middle; otherwise it will 

drop where you are zoomed 
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b. Layer → Rename Layer → “Flo” 
3. Because it is 100x, Flo needs to be resized.  

a. Ctrl+T to resize 
b. At top of screen, change W and H to 200% 

4. Next we will make a Flo overlay for DIC. Click the Flo layer and select Layer → Duplicate 
a. Select copied layer and Layer → Rename Layer → “Flo” 
b. Click copied layer and Layer → Rasterize → Layer 

5. Now we convert the copied Flo layer into an overlay 
a. Turn off visibility for original Flo and DIC layer in the layer panel by clicking the eye 

icon 
b. Select → Color Range 
c. Click on the black area in the middle of Flo 
d. Set fuzziness to 200 

e. Click the eyedropper minus icon 

Color Range Settings 
f. Click ok 
g. Black areas will now be highlighted. Backspace to delete them from Flo copy 
h. Select → Deselect 

6. Link the original and Flo layer copy together by selecting them both and clicking the  icon at 
the bottom of the layer panel. The same icon should appear next to both layers. Now the layers 
will transform in sync 

7. Move the Flo copy overlay to the top of the layer panel 
8. Turn on visibility for the Flo overlay and for DIC 
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Flo Overlay (left) Superimposed on DIC (right) 
9. DIC will be the base layer, which we do not move. We will superimpose Flo and eventually Pol 

on this layer. 
10. Click on the Flo overlay image to select. Ctrl + T to move and rotate 

a. First align the outer periosteal ring with the border of the DIC image. Then align the 
fluorescent overlays with cortical pores as closely as possible. 

b. Use hotkey Z to change to zoom tool so you can zoom in and out 
c. Use hand tool (hotkey H) to move around while zoomed 
d. You may need to very slightly scale the Flo overlay (due to imprecisions in 100x – 200x 

transition). Do this only after it is well-position, in case it does not exactly fit to DIC 
pores 

11. Typically, Pol images will not merge all in one piece. We will merge them piece by piece, 
checking against DIC and the finalized Flo overlay. 

a. Note: Even if two or more regions combine in ICE, they may not be merged correctly 
due to the similar patterning of polarized images. You may still need to load all four 
regions separately in photoshop if you can’t make them match the Flo and DIC overlays. 

b. Turn off the Flo layer but leave DIC layer on 
c. Drop the largest Pol piece onto DIC 
d. Set opacity of DIC layer to 50% - 60% and move it on top of the layer stack 
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e. Ctrl+T to move the Pol image into alignment with DIC image. You may need to slightly 
rotate the Pol Overlay 

f. Turn off DIC and turn on Flo overlay to check fit. 
g. Drop the next Pol piece onto DIC and repeat placement using steps a – g 
h. You may also need to toggle the opacity of adjacent Pol pieces 

50% Opacity DIC Superimposed on Pol (left) and Flo Superimposed on Pol (right) 
12. Merging Oriented Pol Layers 

a. Highlight all the components of the cross-section in the layers panel and Layer →
Duplicate Layers 

b. Highlight all of these copies and Layer → Rasterize → Layer 
c. Highlight all of the copied layers and Edit → Auto-Blend Layers → Panorama 

i. Check Seamless Tones and Colors 
ii. Uncheck Content aware fill transparent area 

d. Highlight all of the copied layers and Layer → Merge Layers 
e. Layer → Rename Layer → “Pol” 

13. Exporting Oriented Layers 
a. Turn on visibility only for the finalized DIC, Flo, and Pol layers 
b. If needed, set opacity back to 100% 

c. If any layers are unrasterized they will have this icon:  Rasterize with Layer →
Rasterize → Layer 

i. Note: If you get a blank image output, the image needs to be rasterized 
d. File → Export → Layers to Files 

i. Make a new destination folder like “Oriented” 
ii. Append Prefix with slide name (e.g. 18lf_91um_) 

iii. Check box for visible layers only 
iv. File Type: TIFF 
v. Image Compression: None 

e. Click Run 
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4b. Align all images anatomically 
1. Download the first ROI image from the micro-CT scan of the associated rabbit femoral midshaft 

a. Hard copies are located on FOOTE under FOOTE1 (D:) → Rabbit Opioid Scans Backup 
– Femur → (Sample Name) → Anatomical Rotation → Centerline Anatomical Tomo 
→ ROI 

b. Zipped copies are located on Andronowski Lab Data Storage → Rabbit Opioid Project 
→ microCT Scan Backup → Finalized Data Processing Backup → Femur Diaphysis →
(Sample Name) → ROI.7z 

i. https://drive.google.com/drive/u/1/folders/1uIEZTg1GiA4ZTRaQZQweGyG8Qf 
WV3phq 

ii. You will need to download the free software 7zip to extract these files: 
https://www.7-zip.org/ 

2. Open Photoshop 2020 
3. Use File → Open to load DIC image 

a. Click the lock icon on the layer panel to unlock DIC layer from the background 
b. Layer → Rename Layer → “DIC” 

4. Drag and drop Flo image. Press Enter to paste. 
a. Layer → Rename Layer → “Flo” 

5. Drag and drop Flo image. Press Enter to paste. 
a. Layer → Rename Layer → “Pol” 

6. Use File → Open to open the ROI in a new tab 
a. To crop to the bone boundaries, select Image → Trim → Based on top left pixel color 

7. Return to the tab with the DIC, Pol, and Flo images. 
a. Select all three images in the Layers panel with Ctrl + Click. 
b. Right click → Link layers (so that the images transform together) 
c. Use Image → Image Rotation to rotate to the same rough orientation as the ROI 

i. Stick to rotating the image by 90° increments and flipping horizontally or 
vertically. Arbitrary rotation will be completed in the next step. 
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Stack of Roughly Transformed Histological Images (Left) and ROI (Right) 
8. The micro-CT ROI is much smaller than the histological images. To find the pixel dimensions of 

the histological images, use Image → Image Size and record the Width and Height of the 
histological images. 

a. In this example for rabbit #18, the histological images are 15096 (W) x 19500 (H) after 
the rough transformation. The ROI is 1158 (W) x 1545 (H) after cropping. 

9. Switch to the ROI tab and go to Image → Image Size 
a. Type in the Width and Height from the histological images. Make sure that width and 

height are linked. The linked height may not exactly match the linked width. 
b. In this case, the ROI was resized to 14616 (W) x 19500 (H) 

10. On the ROI tab, use Select → All (or Ctrl + A) and Edit → Copy (or Ctrl + C) to copy the ROI. 
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a. Switch to the histological image tab and use Edit → Paste (or Ctrl + V) to paste the 
enlarged ROI as a new layer 

b. Grab and drag the ROI layer to the top of the layer stack if needed. The next layer down 
should be a solid histological image (either Pol or DIC) 

11. Reduce opacity of the ROI to about 50% 

12. Select one of the histological images and use Edit → Free Transform (or Ctrl + T) 
a. A blue box appears outside the image frame 
b. Move the mouse outside the blue box to be able to grab and rotate the histological 

image. Move the mouse inside the blue box to be able to grab and drag the histological 
image laterally. 

c. The histological image may not match the ROI exactly. Try to align the angle of the linea 
aspera (point at the bottom of the image) 

d. Press Enter to complete the transformation 

2018-DU-BX-0188 Final Technical Report 
October 2021 

This resource was prepared by the author(s) using Federal funds provided by the U.S. 
Department of Justice. Opinions or points of view expressed are those of the author(s) and do not 

necessarily reflect the official position or policies of the U.S. Department of Justice.

643 



 
 

 
    

   
  

  
  
   

   

13. If the histological image now reaches outside of the canvas, increase the canvas size using Image 
→ Canvas Size (or Alt + Ctrl + C) 

a. Keep the Anchor in the default center 
b. Increase Width and Height by several hundred pixels to accommodate the widened 

picture. It’s fine to overshoot – we will crop in the next step. 
c. Select OK 
d. Turn all layers off with the eye icon in the layer panel. Turn each histological layer on 

with the eye icon to check that it is fully inside the image Canvas. 
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14. To crop to the image boundaries if you overshot the enlargement, select all three histological 
images in the layer panel. 

a. Image → Trim → Based on transparent pixels 
15. Exporting Oriented Layers 

a. Turn on visibility only for the finalized DIC, Flo, and Pol layers 
b. File → Export → Layers to Files 

i. Make a new destination folder like “Anatomically Oriented” 
ii. Append Prefix with slide name (e.g. 18lf_91um_) 

iii. Check box for visible layers only 
iv. File Type: TIFF 
v. Image Compression: None 

c. Click Run 
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7. Click OK in the Wand tool tolerance popup to finalize the selection 
8. In most cases, the selection forms a ring around the off-white region external to the periosteum. 

In this case, Select Edit → Clear or press Backspace to clear the selected region, turning it black. 
a. If this turned the bone black, then the selection formed a ring around the periosteum 

itself. In this case, select Edit → Undo to revert, and then Edit → Clear Outside to turn 
the region outside of the selection black. 
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   9. If there are any remaining off-white regions external to the periosteum, click near those regions 
and repeat steps 5-8 
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14. I recommend saving a copy of the DIC image (e.g. Cleared Outside) in case you mess up the 
marrow clearing and have to restart. 

15. Repeat steps 5-12 for the endosteum (marrow cavity) 

16. After the DIC image is cleared, save a copy (e.g. 18LF_91um_DIC_Clear) using File → Save As 
→ TIFF 
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17. Keep the DIC image open in FIJI. Using the Wand tool with tolerance set to 0, click outside the 
bone to select the periosteum. Use hotkey “t” to add the periosteum to the ROI manager, which 
pops up automatically when “t” is pressed. 

18. Use Edit → Selection → Select None to clear the periosteum selection, or just click outside the 
periosteum selection on the image. The ROI remains in the ROI manager. 

19. Now click inside the bone to select the endosteum, and use “t” to add it to the ROI manager 

Selection of Periosteum (Left) and Endosteum (Right) 
20. Select the top ROI in the ROI manager. In the ROI Manager, select More 🡪 Save… and save this 

ROI as “(Sample Number)_TA” (e.g. 18LF_91um_TA) in the same folder as the anatomically 
oriented histological images. The TA stands for “Total Area” 

21. Select the bottom ROI in the ROI manager. In the ROI Manager, select More 🡪 Save… and save 
this ROI as “(Sample Number)_MA” (e.g. 18LF_91um_MA) in the same folder as the 
anatomically oriented histological images. The TA stands for “Marrow Area” 

22. Saving the ROIs will also change their names in the ROI manager 
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23. Close the DIC image. Keep the ROI manager open with the two loaded ROIs. You can always 
load the saved ROIs for a given image by dragging their saved .roi files from the folder onto 
ImageJ. 

24. Open the Fluorescence image using File → Open, or by dragging and dropping the image from 
its folder onto FIJI. 

25. Click on the new fluorescence image window to select it 
26. Click on the top ROI in the ROI manager (the periosteum or TA). It should appear on the 

fluorescence image. Use Edit → Clear Outside to clear outside the periosteum 
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27. Click on the bottom ROI in the ROI manager (the endosteum or MA). It should appear on the 
fluorescence image. 
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a. Use Edit → Clear to clear inside the endosteum 

28. Use Edit → Selection → Select None to clear selections from the fluorescence image 
After the fluorescence image is cleared, save a copy (e.g. 18LF_91um_Flo_Clear) using File → Save As 
→ TIFF 
Close the fluorescence image 
Open the polarized image using File → Open, or by dragging and dropping the image from its folder onto 
FIJI. Repeat steps 24 – 27 to clear inside and outside of the bone using the saved periosteum and 
endosteum ROIs. 
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Use Edit → Selection → Select None to clear selections from the polarized image 
After the polarized image is cleared, save a copy (e.g. 18LF_91um_Pol_Clear) using File → Save As →
TIFF 
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Appendix XXXII: Converting Dragonfly ROIs into ImageJ ROIs 

1. In Dragonfly, right-click the ROI → Extract ROIs 
2. Two new files will appear: one with the file name and an asterisk (e.g. Manual 1LF*) and one 

with the file name and ROI label 2 (e.g. Manual 1LF ROI label 2) 
3. Right-click the asterisked file (e.g. Manual 1LF*) → Export → ROI as Binary 
4. In the Save As popup, change Save as type to Tiff and give it an appropriate file name, such as 

“1LF_85um_RA”, where RA stands for “Remodeling Area” 
a. The Tiff file should be the white ROI on a black background 

5. Open ImageJ 
6. Drag and drop the saved ROI into ImageJ, or use File → Open 

7. Select the Wand tool: 
8. Click outside the white ROI. It will be selected in red, or whatever color is the default for ImageJ 

selections on your system 
9. On the keyboard, press “t” to add the outside to the ROI manager, or use Edit → Selection →

Add to Manager 
a. This will make the ROI Manager appear as a separate window 
b. Note that the ROI appears as a random number 

10. Clear the selection using Ctrl + Shift + A, or use Edit → Selection → Select None 
11. With the wand tool still selected, click inside the white ROI. It will be selected in red, or 

whatever color is the default for ImageJ selections on your system 
12. On the keyboard, press “t” to add the inside to the ROI manager, or use Edit → Selection → Add 

to Manager 
13. In the ROI Manager, click the first (outside) ROI, hold down Ctrl, and click the second (inside) 

ROI. This will cause them both to be highlighted. 
14. In the ROI Manager, select More → XOR 

15. Immediately press “t” on the keyboard. A new, combined third ROI will appear in the ROI 
manager. You can click on its numeric title to see it displayed on the image. 
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a. Note: In this image, line width has been increased to 75 pixels to make it visible for the 
screenshot 

16. Click on the numeric title of this combined ROI. Select More → Save 
17. In the Save Selection popup, choose an appropriate file name (e.g. 1LF_85um_RA) 

a. You can leave File Type as “All Files” – it will still save as a .roi file  
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18. Now the .roi file can be opened on top of any version (RA, DIC, Flo, Pol) of the oriented image 
for that sample by dragging and dropping it into ImageJ and then pressing “t” on the keyboard, or 
by using More → Open within ROI Manager 

2018-DU-BX-0188 Final Technical Report 
October 2021 

This resource was prepared by the author(s) using Federal funds provided by the U.S. 
Department of Justice. Opinions or points of view expressed are those of the author(s) and do not 

necessarily reflect the official position or policies of the U.S. Department of Justice.

659 



 
 

 
 

 
   

    
   

  
 

  
   

  
   

 
    

     
   

  
 

 
   

  
 

   
    

 
  

  

 
   

  
    

 

Appendix XXXIII: DIC Preprocess SOP 

First-Time Installation 
1. Make sure you have downloaded the FIJI installation of ImageJ: https://imagej.net/software/fiji/ 

a. Move the fiji-win64.zip download to a logical place (can be on the Desktop or elsewhere) 
b. Unzip via right-click → Extract All 

2. After unzipping, navigate to fiji-win64 → Fiji.app and click on the ImageJ-win64 application to 
open FIJI 

Start here if you already have FIJI downloaded: 
3. In FIJI, go to Help → Update… (note this is different than “Update ImageJ”) 

a. A progress bar will check for updates 
b. You may be asked to close and reopen ImageJ; if so call Help → Update… after you 

reopen ImageJ 
4. The ImageJ Updater window will pop up with a list of updates 

a. In the lower left corner, select “Manage update sites” 
b. In the Manage update sites popup window, check the box for “BoneJ” and the box for 

“BioVoxxel” then click Close 
c. Back in the main ImageJ Updater Site, the BoneJ update site should have been added. 

Select “Apply changes” 
d. Close and reopen ImageJ as prompted 

5. In FIJI, go to Help → Update ImageJ… and upgrade to the most recent version (v1.53k at the 
time of this SOP) 

a. The ImageJ-win64 application will close during upgrade 
b. Note that if you update ImageJ before applying package updates, it will revert to the 

original installation version 
6. Select your downloaded OsteoFlo_DICPreprocess.ijm file. Cut and paste into the folder fiji-

win64 → Fiji.app → macros → toolsets 

Every Time You Open a New Session of FIJI 
1. Open the ImageJ-win64 application 
2. In the FIJI toolbar, click on the >> arrow to the far right. Select OsteoFlo_DICPreprocess 

from the dropdown menu 
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3. You will be greeted by a popup that warns you that any active windows will be closed. Click OK. 
4. In the popup window “Load the Cleared DIC Image”, navigate to and click on the cleared, 

oriented DIC image, then click Open 
5. In the popup window “Select Output Location”, select the folder where the output image will be 

saved. It can be the same folder as the cleared, oriented DIC image if you like because this macro 
generates a subfolder. 

a. You will need to click into the folder where you want to save the output file and then 
click Select. Note that any individual files in that folder will not appear; the popup 
window will be blank unless it contains subfolders.  

6. The macro will run on its own for a length of time dependent on your system capabilities. 
a. It took about four minutes on my system 

7. You can see the progress statements for the High Pass filter in the ImageJ toolbar. 
a. You may see the Results window pop up periodically 
b. You will know the macro has finished when [Filename]_Preprocessing.tif is saved to the 

output subfolder “DIC Preprocessing” 
8. After the macro finishes running, your selected output location will contain the subfolder “DIC 

Preprocessing.” The contents of this folder should be: 
a. [Filename]_TA.roi 
b. [Filename]_CA.roi 
c. [Filename]_MA.roi 
d. [Filename]_Preprocessing.tif 

9. Upload the DIC Preprocessing folder to the Oriented Images folder for that sample 
10. Check the box for DIC Preprocessing for that sample on the Photomerge Tracker spreadsheet: 

https://docs.google.com/spreadsheets/d/1hiVpAoNIdxf6D WLi3GdNCEw5 aIAdImGGwzCdxv 
WVw/edit#gid=0 
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